About this Manual (W446):

This manual describes the operation of the CX-Programmer and consists of the following three parts.

- **Part 1: CX-Programmer**
  This part describes the CX-Programmer software that is a PLC Programming Device, and also provides the overall precautions and the version upgrades information.

- **Part 2: CX-Server PLC Tools**
  This part describes the CX-Server PLC Tools software, which is a collection of the following components: PLC Memory, IO Table, PLC Setup, Data Trace/Time Chart Monitor, PLC Error, Memory Card, PLC-Clock, and CX-Net Network Configuration (including Data Link Editor and Routing Table).

- **Part 3: CX-Server Runtime**
  This part describes the CX-Server software that is a communications middleware.

**Note:** References within each part are references to the pages or chapters within that part.

Related Manual

For details on the function block functions and ST programming, refer to the CX-Programmer Operation Manual Function Blocks and Structured Text (Cat. No. W447).

For details on the SFC programming functions, refer to the CX-Programmer Operation Manual SFC (Cat. No. W469).

For details on procedures for installing the CX-Programmer from the CX-One FA Integrated Tool Package, refer to the CX-One Setup Manual provided with CX-One.

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Model</th>
<th>Manual name</th>
<th>Contents</th>
</tr>
</thead>
</table>

⚠️ **WARNING:** Failure to read and understand the information provided in this manual may result in personal injury or death, damage to the product, or product failure. Please read each chapter in its entirety and be sure you understand the information provided in the chapter and related chapters before attempting any of the procedures or operations given.
Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your OMRON representative if you have any questions or comments.

Warranty and Limitations of Liability

<table>
<thead>
<tr>
<th>WARRANTY</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) The warranty period for the Software is one year from either the date of purchase or the date on which the Software is delivered to the specified location.</td>
</tr>
<tr>
<td>(2) If the User discovers a defect in the Software (i.e., substantial non-conformity with the manual), and returns it to OMRON within the above warranty period, OMRON will replace the Software without charge by offering media or downloading services from the Internet. And if the User discovers a defect in the media which is attributable to OMRON and returns the Software to OMRON within the above warranty period, OMRON will replace the defective media without charge. If OMRON is unable to replace the defective media or correct the Software, the liability of OMRON and the User's remedy shall be limited to a refund of the license fee paid to OMRON for the Software.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LIMITATIONS OF LIABILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) THE ABOVE WARRANTY SHALL CONSTITUTE THE USER'S SOLE AND EXCLUSIVE REMEDIES AGAINST OMRON AND THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL OMRON BE LIABLE FOR ANY LOST PROFITS OR OTHER INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF USE OF THE SOFTWARE.</td>
</tr>
<tr>
<td>(2) OMRON SHALL ASSUME NO LIABILITY FOR DEFECTS IN THE SOFTWARE BASED ON MODIFICATION OR ALTERATION OF THE SOFTWARE BY THE USER OR ANY THIRD PARTY.</td>
</tr>
<tr>
<td>(3) OMRON SHALL ASSUME NO LIABILITY FOR SOFTWARE DEVELOPED BY THE USER OR ANY THIRD PARTY BASED ON THE SOFTWARE OR ANY CONSEQUENCE THEREOF.</td>
</tr>
</tbody>
</table>
**Application Considerations**

<table>
<thead>
<tr>
<th>SUITABILITY FOR USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>THE USER SHALL NOT USE THE SOFTWARE FOR A PURPOSE THAT IS NOT DESCRIBED IN THE ATTACHED USER MANUAL.</td>
</tr>
</tbody>
</table>
## Disclaimers

### CHANGE IN SPECIFICATIONS

The software specifications and accessories may be changed at any time based on improvements or for other reasons.

### EXTENT OF SERVICE

The license fee of the Software does not include service costs, such as dispatching technical staff.

### ERRORS AND OMISSIONS

The information in this manual has been carefully checked and is believed to be accurate; however, no responsibility is assumed for clerical, typographical, or proofreading errors, or omissions.
Precautions

Intended Audience

This manual is intended for the following personnel, who must also have knowledge of electrical systems (an electrical engineer or the equivalent).

- Personnel in charge of installing FA systems.
- Personnel in charge of designing FA systems.
- Personnel in charge of managing FA systems and facilities.

General Precautions

The user must operate the product according to the performance specifications described in the operation manuals. Before using the product under conditions which are not described in the manual or applying the product to nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems, medical equipment, amusement machines, safety equipment, and other systems, machines, and equipment that may have a serious influence on lives and property if used improperly, consult your OMRON representative. Make sure that the ratings and performance characteristics of the product are sufficient for the systems, machines, and equipment, and be sure to provide the systems, machines, and equipment with double safety mechanisms.

This manual provides information for programming and operating the Unit. Be sure to read this manual before attempting to use the Unit and keep this manual close at hand for reference during operation.

⚠️ WARNING

It is extremely important that a PLC and all PLC Units be used for the specified purpose and under the specified conditions, especially in applications that can directly or indirectly affect human life. You must consult with your OMRON representative before applying a PLC System to the above-mentioned applications.

Safety Precautions

⚠️ WARNING

Confirm safety sufficiently before transferring I/O memory area status from the CX-Programmer to the PLC. The devices connected to Output Units may malfunction, regardless of the operating mode of the CPU Unit. Caution is required in respect to the following functions.

- Transferring from the CX-Programmer to real I/O (CIO Area) in the CPU Unit using the PLC Memory window.
- Transferring from file memory to real I/O (CIO Area) in the CPU Unit using the Memory Card window.
WARNING

Observe the following precautions when using the PLC Backup Tool.

- Sufficiently check the data that is selected for restoring before performing the next step. If the correct data is not restored, unexpected operation may occur in the controlled system after the data is restored.
- Some Special I/O Units and CPU Bus Units operate with parameters that are stored in the CPU Unit. If one of these Units is selected for backup, restrictions will be displayed in the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and always select the Special I/O Unit or CPU Bus Unit together with the CPU Unit when backing up or restoring data. If the data from both Units is not backed up or restored together, unexpected operation may occur in the controlled system.
- If there are any backup restrictions for the Units to which data is being restored, the restrictions will be displayed in the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and always take the required measures. If required measures are not taken, unexpected operation may occur in the controlled system after the data is restored.
- Forced status can be backed up, but it cannot be restored. If you restored data that contained forced status, use the CX-Programmer after restoring the data to force-set or force-reset bits as required. If required bits are not force-set or force-reset, differences in the forced status in memory may cause unexpected operation of the controlled system.
- Confirm that stopping PLC operation will not create any problems before restoring data during PLC operation. If the PLC stops at an unanticipated time, unexpected operation may occur in the controlled system.
- Always turn the power supply to the PLC OFF and then ON after restoring data. If the power supply is not turned OFF and then ON, memory in the PLC may not be updated to the restored data, which may cause unexpected operation of the controlled system.

Caution

Observe the following precaution when specifying a symbol or word address for an array variable index in a ladder program or when specifying a symbol for an array variable index in an ST program.

When using a symbol or address to indirectly specify the element number of an array variable, be sure that the resulting address is not outside the memory area that contains the first word in the array. For example, use a symbol comparison instruction or an IF statement to ensure that processing is performed only when the memory area is not exceeded. If an element number that exceeds the memory area is specified, data in another memory area will be read or written, possibly resulting in unexpected operation.

Caution

Observe the following precaution when specifying a symbol or word address for an offset in a ladder program.

When using a symbol or address to indirectly specify an offset for a memory address, be sure that the resulting address is not outside the memory area that contains original address. For example, use a symbol comparison instruction to ensure that processing is performed only when the memory area is not exceeded. If the final address (i.e., the original address plus the specified offset) exceeds the memory area, data in another memory area will be read or written, possibly resulting in unexpected operation.
⚠️ **Caution** Confirm safety at the destination node before transferring a program to another node or changing contents of the I/O memory area. Doing either of these without confirming safety may result in injury.

⚠️ **Caution** Execute online edit only after confirming that no adverse effects will be caused by extending the cycle time. Otherwise, the input signals may not be readable.

⚠️ **Caution** If synchronous unit operation is being used, perform online editing only after confirming that an increased synchronous processing time will not affect the operation of the main and slave axes.

⚠️ **Caution** Confirm safety sufficiently before monitoring power flow and present value status in the *Ladder Section* window or when monitoring present values in the *Watch* window. If force-set/reset or set/reset operations are inadvertently performed by pressing short-cut keys, the devices connected to Output Units may malfunction, regardless of the operating mode of the CPU Unit.

⚠️ **Caution** Caution is required when connecting peripheral devices, such as a personal computer, to the PLC when Units with non-isolated power supplies, such as the CS1W-CLK12/CLK52(-V1), that are connected to an external power supply are mounted to the PLC. If the 24-V side is grounded on the external power supply, a short will be created if the 0-V side of the peripheral device is grounded. When connecting peripheral devices, either ground the 0-V side of the external power supply or do not ground the external power supply at all.
Application Precaution

Observe the following precautions when using the CX-Programmer.

- Observe the following precautions before starting the CX-Programmer.
  - Exit all applications not directly related to the CX-Programmer. Particularly exit any software such as screen savers, virus checkers, email or other communications software, and schedulers or other applications that start up periodically or automatically.
  - Disable sharing hard disks, printers, or other devices with other computers on any network.
  - With some notebook computers, the RS-232C port is allocated to a modem or a infrared line by default. Following the instructions in documentation for your computer and enable using the RS-232C port as a normal serial port.
  - With some notebook computers, the default settings for saving energy do not supply the rated power to the RS-232C port. There may be both Windows settings for saving energy, as well as setting for specific computer utilities and BIOS. Following the instructions in documentation for your computer, disable all energy saving settings.
- Do not turn OFF the power supply to the PLC or disconnect the connecting cable while the CX-Programmer is online with the PLC. The computer may malfunction.
- With the CS/CJ-series PLCs, when creating an AUTOEXEC.IOM file from the CX-Programmer to automatically transfer data at startup, set the first write address to D20000 and be sure that the size of data written does not exceed the size of the DM Area. When the data file is read from the Memory Card at startup, data will be written in the CPU Unit starting at D20000 even if another address was set when the AUTOEXEC.IOM file was created. Also, if the DM Area is exceeded (which is possible when the CX-Programmer is used), the remaining data will be written to the EM Area. Refer to information on file operations in the CS/CJ-series Programming Manual for details.
- Confirm that no adverse effect will occur in the system before attempting any of the following. Not doing so may result in an unexpected operation. Changing the operating mode of the PLC.
  - Force-setting/force-resetting any bit in memory.
  - Changing the present value of any word or any set value in memory.
  - Check the user program for proper execution before actually running it on the Unit. Not checking the program may result in an unexpected operation.
- Precaution on Using Indirect DM and EM Addresses in Comparison Instructions:
  When indirect DM or EM addresses are used as operands in comparison instructions, the top portion of the comparison instruction will be displayed in yellow when it is being monitored. At that time the power flow will not be monitored to the right of such comparison instructions. The contact and coil status, and present values of operands in special instructions will be displayed normally.
• The user program and parameter area data in CS1-H CPU Units is backed up in the built-in flash memory. The BKUP indicator will light on the front of the CPU Unit when the backup operation is in progress. Do not turn OFF the power supply to the CPU Unit when the BKUP indicator is lit. The data will not be backed up if power is turned OFF.

To display the status of writing to flash memory on the CX-Programmer, place a checkmark by Display dialog to show PLC Memory Backup Status on the PLC properties and then select Windows | PLC Memory Backup Status from the Windows menu.

• Precaution in Changing the PLC Type

On the CX-Programmer, you can change the PLC (device) type or CPU type. When these are changed, however, only the data for the ladder program and the symbol tables are changed. The following data will be initialized and must be reset.

• PLC Setup
• Expansion instructions
• I/O tables
• PLC memory

Particularly the PLC Setup has a large impact on PLC system operation. Be careful to reset all require settings after changing the PLC type. If expansion instruction allocations are not reset, program errors could occur, preventing the PLC from running. Always restore the expansion instruction allocates to the previous settings after changing the PLC type.
Observe the following precautions when using the CX-Net.

- Do not change the operating mode of the CPU Unit without first confirming that operation of the controlled system will not be affected.
- Do not run the user program on the PLC until its operation has been checked sufficiently.
- The data link mode (manual setting or automatic setting) and data link method are determined according to the data link setting in the startup node. In the startup node, set a data link table in the case of manual setting and data link automatic setting parameters in the case of automatic setting. If the settings are incorrect, the data link will not start.
- Check the following items before starting data links. If incorrect data link tables or parameters are set, injury may result due to unexpected operation of the system. Even if the correct data link tables and parameters have been set, do not start or stop data links before verifying that there will be no adverse influence on the system.

  (1) Manually Set Data Links

  Check the data link tables in each node participating in the data link to see that they are correct.
  Be sure that data link tables are deleted from nodes that are not participating in the data links.

  (2) Automatically Set Data Links

  Be sure that the correct DM parameters have been set in the data link startup node.
  - CPU Bus Units will be automatically restarted when routing tables are transferred from a Programming Device to the CPU Unit. Resetting is required to use the new tables. Confirm that restarting the CPU Bus Units will not adversely affect system operation before transferring routing tables.
  - When Special I/O Unit or CPU Unit settings are performed in the I/O Table Window and then transferred from the PLC Memory Window, the following warning will be displayed if the allocated DM Area/CIO Area addresses set for Special I/O Units or CPU Bus Units in the I/O Table Window on the computer overlap with the PLC data table addresses. Unless the CPU Bus Unit or Special I/O Unit settings have been previously transferred to the CPU Unit and the allocated DM Area/CIO Area data in the PLC data table for Special I/O Units or CPU Bus Units is to be overwritten, always click the No Button, shift the address, and repeat the transfer procedure.
  - CPU Bus Unit and Special I/O Unit settings are not checked for logical consistency. Be very careful of the logical consisting of the overall settings when making any setting that affects other settings, e.g., settings that enable or disable other settings. Transfer the Special I/O Unit or CPU Bus Unit settings to the PLC and then start operation, being aware that any logical inconsistencies may produce unexpected operation.
  - For example, if one setting selects either user settings or default settings and is set to use the default settings, it will not automatically change to enable user settings even if the related user settings are made. To use the user settings, they will have to be enabled manually and specifically in the setting that selects either user settings or default settings.
Unit Versions of CS/CJ/CP-series CPU Units

Unit Versions

A “unit version” has been introduced to manage CPU Units in the CS/CJ/CP Series according to differences in functionality accompanying Unit upgrades. This applies to the CJ2, CS1-H, CJ1-H, CJ1M, CS1D, CP1H, CP1L, and CP1E CPU Units.

Notation of Unit Versions on Products

The unit version is given to the right of the lot number on the nameplate of the products for which unit versions are being managed, as shown below.

- CS1-H, CJ1-H, and CJ1M CPU Units (except for low-end models) manufactured on or before November 4, 2003 do not have a unit version given on the CPU Unit (i.e., the location for the unit version shown above is blank).
- The unit version of the CJ1-H-R CPU Units begins at version 4.0.
- The unit version of the CS1-H, CJ1-H, and CJ1M CPU Units, as well as the CS1D CPU Units for Single-CPU Systems, begins at version 2.0.
- The unit version of the CS1D CPU Units for Duplex-CPU Systems begins at version 1.1.
- The unit version of the CP1H/CP1L/CP1E CPU Units begins at version 1.0, except for the CP1H-Y@@@@@@, for which the unit version begins at version 1.1.
- CPU Units for which a unit version is not given are called Pre-Ver. @@ CPU Units, such as Pre-Ver. 2.0 CPU Units and Pre-Ver. 1.1 CPU Units.

Confirming Unit Versions with Support Software

CX-Programmer version 4.0 can be used to confirm the unit version using one of the following two methods.

- Using the PLC Information
- Using the Unit Manufacturing Information (This method can be used for Special I/O Units and CPU Bus Units as well.)

Note  CX-Programmer version 3.3 or lower cannot be used to confirm unit versions.

PLC Information

- If you know the device type and CPU type, select them in the Change PLC Dialog Box, go online, and select PLC - Edit - Information from the menus.
- If you don’t know the device type and CPU type, but are connected directly to the CPU Unit on a serial line, select PLC - Auto Online to go online, and then select PLC - Edit - Information from the menus.

In either case, the following PLC Information Dialog Box will be displayed.
Use the above display to confirm the unit version of the CPU Unit.

**Unit Manufacturing Information**

In the IO Table Window, right-click and select Unit Manufacturing information - CPU Unit.

The following Unit Manufacturing information Dialog Box will be displayed

Use the above display to confirm the unit version of the CPU Unit connected online.
Using the Unit Version Labels

The following unit version labels are provided with the CPU Unit.

These labels can be attached to the front of previous CPU Units to differentiate between CPU Units of different unit versions.

Unit Version Notation

In this manual, the unit version of a CPU Unit is given as shown in the following table.

<table>
<thead>
<tr>
<th>Product nameplate</th>
<th>CPU Units on which no unit version is given</th>
<th>Units on which a version is given (Ver. □□□)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Designating individual CPU Units (e.g., the CS1-H CPU Units)</td>
<td>Pre-Ver. 2.0 CS1-H CPU Units</td>
<td>CS1H-CPU67H CPU Unit Ver. □□□</td>
</tr>
<tr>
<td>Designating groups of CPU Units (e.g., the CS1-H CPU Units)</td>
<td>Pre-Ver. 2.0 CS1-H CPU Units</td>
<td>CS1-H CPU Units Ver. □□</td>
</tr>
<tr>
<td>Designating an entire series of CPU Units (e.g., the CS-series CPU Units)</td>
<td>Pre-Ver. 2.0 CS-series CPU Units</td>
<td>CS-series CPU Units Ver. □□</td>
</tr>
</tbody>
</table>
## Unit Versions and Lot Numbers

<table>
<thead>
<tr>
<th>Series</th>
<th>Model</th>
<th>Data of manufacture</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS Series</td>
<td>CS1 CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CS1-V CPU Units</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td></td>
<td>CS1-H CPU Units</td>
<td>CPU Units Ver. 1.1</td>
</tr>
<tr>
<td></td>
<td>CS1-D CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CS1-D CPU Units</td>
<td>CPU Units Ver. 3.0</td>
</tr>
<tr>
<td></td>
<td>CS1-D CPU Units for Single-CPU System</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td>CJ Series</td>
<td>CJ2 CPU Units</td>
<td>CPU Unit Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CJ1 CPU Units</td>
<td>CPU Unit Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CJ1-H CPU Units</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td></td>
<td>CJ1-H CPU Units (Ver. 3.0 or higher only)</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td></td>
<td>CJ1-M CPU Units</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td></td>
<td>CJ1-M CPU Units, low-end models</td>
<td>CPU Units Ver. 2.0</td>
</tr>
<tr>
<td>CP Series</td>
<td>CP1-H CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CP1-H CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CP1-L CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CP1-E CPU Units</td>
<td>CPU Units Ver. 1.0</td>
</tr>
<tr>
<td>Support Software</td>
<td>CX-One</td>
<td>Ver. 1.0</td>
</tr>
<tr>
<td></td>
<td>CX-Programmer</td>
<td>Ver. 3.2</td>
</tr>
</tbody>
</table>
**Function Support by Unit Version**

**CS1-H CPU Units (CS1-CP H)**

<table>
<thead>
<tr>
<th>Function</th>
<th>Unit version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pre-Ver. 2.0 CPU Units</td>
</tr>
<tr>
<td>Downloading and Uploading Individual Tasks</td>
<td>---</td>
</tr>
<tr>
<td>Improved Read Protection Using Passwords</td>
<td>---</td>
</tr>
<tr>
<td>Write Protection from FINS Commands Sent to CPU Units via Networks</td>
<td>---</td>
</tr>
<tr>
<td>Online Network Connections without I/O Tables</td>
<td>---</td>
</tr>
<tr>
<td>Communications through a Maximum of 8 Network Levels</td>
<td>---</td>
</tr>
<tr>
<td>Connecting Online to PLCs via NS-series PTs</td>
<td>OK from lot number 030201</td>
</tr>
<tr>
<td>Setting First Slot Words</td>
<td>OK for up to 8 groups</td>
</tr>
<tr>
<td>Automatic Transfers at Power ON without a Parameter File</td>
<td>---</td>
</tr>
<tr>
<td>Automatic Detection of I/O Allocation Method for Automatic Transfer at Power ON</td>
<td>---</td>
</tr>
<tr>
<td>Operation Start/End Times</td>
<td>---</td>
</tr>
</tbody>
</table>

**New Application Instructions**

<table>
<thead>
<tr>
<th>Instructions</th>
<th>Unit version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MILH, MILR, MILC</td>
<td>---</td>
</tr>
<tr>
<td>=DT, &lt;&gt;DT, &lt;DT, &lt;=DT, &gt;DT, &gt;=DT</td>
<td>---</td>
</tr>
<tr>
<td>BCMP2</td>
<td>---</td>
</tr>
<tr>
<td>GRY</td>
<td>OK from lot number 030201</td>
</tr>
<tr>
<td>TPO</td>
<td>---</td>
</tr>
<tr>
<td>DSW, TKY, HKY, MTR, 7SEG</td>
<td>---</td>
</tr>
<tr>
<td>EXPLT, EGATR, ESATR, ECHRD, ECHWR</td>
<td>---</td>
</tr>
<tr>
<td>Reading/ Writing CPU Bus Units with IORD/ IOWR</td>
<td>OK from lot number 030418</td>
</tr>
<tr>
<td>PRV2</td>
<td>---</td>
</tr>
</tbody>
</table>
### CS1D CPU Units

<table>
<thead>
<tr>
<th>Function</th>
<th>CS1D CPU Units for Duplex-CPU Systems (CS1D-CPU@@H)</th>
<th>CS1D CPU Units for Single-CPU Systems (CS1D-CPU@@S)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pre-Ver. 1.1 CPU Units</td>
<td>CPU Unit Ver. 1.1 or later</td>
</tr>
<tr>
<td>Functions unique to CS1D CPU Units</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplex CPU Units</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Online Unit Replacement</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Duplex Power Supply Units</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Duplex Controller Link Units</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Duplex Ethernet Units</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Downloading and Uploading Individual Tasks</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Improved Read Protection Using Passwords</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Write Protection from FINS Commands Sent to CPU Units via Networks</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Online Network Connections without I/O Tables</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Communications through a Maximum of 8 Network Levels</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Connecting Online to PLCs via NS-series PTs</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Setting First Slot Words</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Automatic Transfers at Power ON without a Parameter File</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Automatic Detection of I/O Allocation Method for Automatic Transfer at Power ON</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Operation Start/End Times</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>New Application Instructions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MILH, MILR, MILC</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>=DT, &lt;&gt;DT, &lt;DT, &lt;=DT, &gt;DT, &gt;=DT</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>BCMP2</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>GRY</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>TPO</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>DSW, TKY, HKY, MTR, 7SEG</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>EXPLT, EGATR, ESATR, ECHRD, ECHWR</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Reading/Writing CPU Bus Units with IORD/IOWR</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>PRV2</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
### CJ1-H/CJ1M CPU Units

<table>
<thead>
<tr>
<th>Function</th>
<th>Pre-Ver. 2.0 + CPU Units Ver. 2.0</th>
<th>Pre-Ver. 2.0 + CPU Units Ver. 2.0</th>
<th>Pre-Ver. 2.0 + CPU Units Ver. 2.0</th>
<th>Pre-Ver. 2.0 + CPU Units Ver. 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloading and Uploading Individual Tasks</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Improved Read Protection Using Passwords</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Write Protection from FINS Commands Sent to CPU Units via Networks</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Online Network Connections without I/O Tables</td>
<td>OK, but only if I/O table allocation at power ON is set</td>
<td>OK, but only if I/O table allocation at power ON is set</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Communications through a Maximum of 8 Network Levels</td>
<td>OK for up to 8 groups</td>
<td>OK for up to 64 groups</td>
<td>OK for up to 8 groups</td>
<td>OK for up to 64 groups</td>
</tr>
<tr>
<td>Connecting Online to PLCs via NS-series PTs</td>
<td>OK from lot number 030201</td>
<td>OK</td>
<td>OK from lot number 030201</td>
<td>OK</td>
</tr>
<tr>
<td>Setting First Slot Words</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Automatic Transfers at Power ON without a Parameter File</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Automatic Detection of I/O Allocation Method for Automatic Transfer at Power ON</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Operation Start/End Times</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>New Application Instructions</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>MILH, MIR, MILC</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>=DT, &lt;&gt;DT, &lt;DT, =&lt;DT, &gt;DT, &gt;=DT</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>BCM2P</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>GRY</td>
<td>OK from lot number 030201</td>
<td>OK</td>
<td>OK from lot number 030201</td>
<td>OK</td>
</tr>
<tr>
<td>TPO</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>DSW, TKY, HKY, MTR, 7SEG</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>EXPLT, EGATR, ESATR, ECHRD, ECHWR</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Reading/Writing CPU Bus Units with IORD/IOWR</td>
<td>---</td>
<td>OK</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>PRV2</td>
<td>---</td>
<td>---</td>
<td>OK, but only for models with built-in I/O</td>
<td>OK, but only for models with built-in I/O</td>
</tr>
</tbody>
</table>
## Functions Supported by Unit Version 3.0 or Later

### CS1-H CPU Units (CS1-H-CPU-H)

<table>
<thead>
<tr>
<th>Function</th>
<th>Pre-Ver. 2.0, Ver. 2.0</th>
<th>Ver. 3.0</th>
<th>Ver. 4.0 (See note.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function blocks (supported for CX-Programmer Ver. 5.0 or higher)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Serial Gateway (converting FINS commands to CompoWay/F commands at the built-in serial port)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Comment memory (in internal flash memory)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Expanded simple backup data</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td><strong>New application instructions</strong></td>
<td>TXDU(256), RXDU(255) (support no-protocol communications with Serial Communications Units with unit version 1.2 or later)</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Model conversion instructions: XFERC(565), DISTC(566), COLL(567), MOVBC(568), BCNTC(621)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Special function block instructions: GETID(286)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td><strong>Additional instruction functions</strong></td>
<td>TXD(235) and RXD(236) instructions (support no-protocol communications with Serial Communications Boards with unit version 1.2 or later)</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td><strong>New application instructions</strong></td>
<td>ASCII conversion instructions (NUMBER-TO-ASCII and ASCII-TO- NUMBER)</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Improved function block (FB) functions</strong></td>
<td>Online editing of function blocks</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Input-output variables are supported. (Input-output variables can be specified in arrays.)</td>
<td>---</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>The STRING data type and text-string processing functions are supported in ST language.</td>
<td>---</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td><strong>Using ST language programming in tasks</strong></td>
<td>---</td>
<td>---</td>
<td>OK with CX-Programmer Ver. 7.2 or higher</td>
</tr>
<tr>
<td><strong>Using SFC programming in tasks</strong></td>
<td>---</td>
<td>---</td>
<td>OK with CX-Programmer Ver. 7.2 or higher</td>
</tr>
</tbody>
</table>

**Note:** CX-Programmer version 7.0 or higher is required to use functions added for unit version 4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used.

### CS1D CPU Units

Unit version 3.0 (Ver. 3.0) is not supported.
## CJ1-H/CJ1M CPU Units (CJ1-H-CPU, CJ1M-CPU)

<table>
<thead>
<tr>
<th>Function</th>
<th>Pre-Ver. 2.0, Ver. 2.0</th>
<th>Ver. 3.0</th>
<th>Ver. 4.0 (See note.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function blocks (supported for CX-Programmer Ver. 5.0 or higher)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Serial Gateway (converting FINS commands to CompoWay/F commands at the built-in serial port)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Comment memory (in internal flash memory)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Expanded simple backup data</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Additional instruction functions</td>
<td>PRV(881) and PRV2(883) instructions: Added high-frequency calculation methods for calculating pulse frequency. (CJ1M CPU Units only)</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>New application instructions</td>
<td>TXDU(256), RXDU(255) (support no-protocol communications with Serial Communications Units with unit version 1.2 or later)</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Model conversion instructions: XFERC(565), DISTC(566), COLLC(567), MOVBC(568), BCNTC(621)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Special function block instructions: GETID(286)</td>
<td>---</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Additional instruction functions</td>
<td>TXD(235) and RXD(236) instructions (support no-protocol communications with Serial Communications Boards with unit version 1.2 or later)</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>New application instructions</td>
<td>ASCII conversion instructions (NUMBER-To-ASCII and ASCII-TO NUMBER)</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Improved function block (FB) functions</td>
<td>Online editing of function blocks</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Input-output variables are supported. (Input-output variables can be specified in arrays.)</td>
<td>---</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>The STRING data type and text-string processing functions are supported in ST language.</td>
<td>---</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>Using ST language programming in tasks</td>
<td>---</td>
<td>---</td>
<td>OK with CX-Programmer Ver. 7.2 or higher</td>
</tr>
<tr>
<td>Using SFC programming in tasks</td>
<td>---</td>
<td>---</td>
<td>OK with CX-Programmer Ver. 7.2 or higher</td>
</tr>
</tbody>
</table>

**Note:** CX-Programmer version 7.0 or higher is required to use functions added for unit version 4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used.
Functions Supported by Unit Version for CJ2 CPU Units (CJ2H-CPU6-EIP, CJ2H-CPU6-EIP)

Unit Version 1.2 or Later

CX-Programmer version 8.3 or higher must be used to enable using the functions added for unit version 1.2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Unit version</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM Area force-setting/resetting</td>
<td>Supported.</td>
</tr>
</tbody>
</table>

Unit Version 1.1 or Later

CX-Programmer version 8.1 or higher must be used to enable using the functions added for unit version 1.1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Unit version 1.1</th>
<th>Unit version 1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-speed interrupt function</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Decreased overhead time for interrupt tasks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum interval setting of 0.1 ms for Scheduled Interrupt Task</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing the minimum cycle time setting in MONITOR mode</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Synchronous unit operation</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>

Unit Version 1.0

All functions that are supported by unit version 4.0 or later of the CJ1 CPU Units are supported by unit version 1.0 of the CJ2 CPU Units.

CX-Programmer version 8.0 or higher must be used to enable using unit version 1.0 of the CJ2 CPU Units.
Functions Supported by Unit Version for CP-series CPU Units

Functions Supported by Unit Version 1.0 and 1.1

Functionality is the same as that for CS/CJ-series CPU Units with unit version 3.0. The functionality added for CS/CJ-series CPU Unit unit version 4.0 is not supported.

**CP1H CPU Units**

- CX-Programmer version 6.11 or higher is required to use CP1H-X/A with unit version 1.1 or 1.0.
- CX-Programmer version 6.20 or higher is required to use CP1H-Y with unit version 1.1.

<table>
<thead>
<tr>
<th>CPU Unit</th>
<th>CP1H CPU Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>CP1H-X/A</td>
<td>CP1H-XA (See note 1.)</td>
</tr>
<tr>
<td></td>
<td>CP1H-Y (See note 2.)</td>
</tr>
<tr>
<td>Function</td>
<td>Unit version</td>
</tr>
<tr>
<td>Pulse outputs</td>
<td>Allocated built-in I/O terminals</td>
</tr>
<tr>
<td>Special pulse output terminals</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note 1.** The unit version for the CP1H-XA begins at 1.0.
2. The unit version for the CP1H-Y begins at 1.1.
3. CX-Programmer version 7.11 or higher is required to use CP1L CPU Units with unit version 1.0.
Unit Versions and Programming Devices

CX-Programmer version 4.0 or higher must be used to enable using the functions added for CPU Unit Ver. 2.0. The following tables show the relationship between unit versions and CX-Programmer versions.

Unit Versions and Programming Devices for CJ2 CPU Units

<table>
<thead>
<tr>
<th>CPU Unit</th>
<th>Functions</th>
<th>Required Programming Device</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Ver. 7.1 or lower</td>
</tr>
<tr>
<td>CJ2H-CPU6::EIP Unit version 1.0</td>
<td>Functions for unit version 1.0</td>
<td>×</td>
</tr>
<tr>
<td>CJ2H-CPU6::EIP Unit version 1.1</td>
<td>Functions added for unit version 1.1</td>
<td>×</td>
</tr>
<tr>
<td>CJ2H-CPU6::EIP Unit version 1.2</td>
<td>Functions added for unit version 1.2</td>
<td>×</td>
</tr>
</tbody>
</table>

×: Cannot be used, Δ: Can be used except for new functions added for unit versions, ○: Can be used

Note 1. It is not necessary to upgrade the version of the CX-Programmer if functionality that was enhanced for the upgrade of the CPU Unit will not be used.

2. CX-Programmer version 8.1 or higher is required to use the functions added for unit version 1.1. The high-speed interrupt function and changing the minimum cycle time setting in MONITOR mode, however, are also supported by CX-Programmer version 8.02.

3. A Programming Console cannot be used with a CJ2H CPU Unit.

Unit Versions and Programming Devices for CPU Units Other Than CJ2 CPU Units

<table>
<thead>
<tr>
<th>CPU Unit</th>
<th>Functions</th>
<th>Required Programming Device</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Ver. 3.3</td>
</tr>
<tr>
<td>CS/CJ Series CPU Units, Unit Ver. 4.0</td>
<td>Functions added for unit version 4.0</td>
<td>Δ</td>
</tr>
<tr>
<td>CS/CJ Series CPU Units, Unit Ver. 3.0</td>
<td>Functions added for unit version 3.0</td>
<td>Δ</td>
</tr>
<tr>
<td>CS/CJ Series CPU Units, Unit Ver. 2.0</td>
<td>Functions added for unit version 2.0</td>
<td>Δ</td>
</tr>
<tr>
<td>CS1D CPU Units for Single-CPU Systems, Unit Ver. 2.0</td>
<td>Functions added for unit version 2.0</td>
<td>Δ</td>
</tr>
<tr>
<td>CS1D CPU Units for Duplex-CPU Systems, Unit Ver. 1.1</td>
<td>Functions added for unit version 1.1</td>
<td>Δ</td>
</tr>
</tbody>
</table>

×: Cannot be used, Δ: Can be used except for new functions added for unit versions, ○: Can be used

Note 1. As shown above, there is no need to upgrade to CX-Programmer version 4.0 as long as the functions added for unit version 2.0 or unit version 1.1 are not used.

2. CX-Programmer version 7.0 or higher is required to use functions added for unit version 4.0. Additional functions are supported if CX-Programmer version 7.2 or higher is used.

3. Unit version 4.2 of the CJ1H-CPU6::EIP-R is supported only by CX-Programmer version 8.0 or higher.

4. CX-Programmer version 8.0 or higher is required to use unit version 4.2 of the CJ1H-CPU6::EIP-R.
Unit Versions of CP-series CPU Units and Programming Devices

<table>
<thead>
<tr>
<th>CPU Unit</th>
<th>Model</th>
<th>Unit version</th>
<th>CX-Programmer version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP1H CPU Units</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP1H-X</td>
<td>Ver. 1.1</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>CP1H-XA</td>
<td>Ver. 1.0</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>CP1H-Y</td>
<td>Ver. 1.1</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>CP1L CPU Units</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP1L-M</td>
<td>Ver. 1.1</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>CP1L-L</td>
<td>Ver. 1.0</td>
<td>---</td>
<td>OK</td>
</tr>
<tr>
<td>CP1E CPU Units</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CP1E-E</td>
<td>Ver. 1.0</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>CP1E-N</td>
<td></td>
<td></td>
<td>OK</td>
</tr>
</tbody>
</table>

**Note 1.** Functionality of CP1H CPU Units with unit version 1.0 or 1.0 and CP1L CPU Units with unit version 1.0 is the same as that for CS/CJ-series CPU Units with unit version 3.0. The functionality added for CS/CJ-series CPU Unit unit version 4.0 is not supported.

**Note 2.** There is no need to upgrade to CX-Programmer as long as the upgraded functionality is not used.

Device Type Setting

The unit version does not affect the setting made for the device type on the CX-Programmer. Select the device type as shown in the following table regardless of the unit version of the CPU Unit.

<table>
<thead>
<tr>
<th>Series</th>
<th>CPU Unit group</th>
<th>CPU Unit model</th>
<th>Device type setting on CX-Programmer</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS Series</td>
<td>CS1-H CPU Units</td>
<td>CS1G-CPU[H]</td>
<td>CS1G-H</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CS1H-CPU[H]</td>
<td>CS1H-H</td>
</tr>
<tr>
<td></td>
<td>CS1D CPU Units for Duplex-CPU Systems</td>
<td>CS1D-CPU[H]</td>
<td>CS1D-H (or CS1H-H)</td>
</tr>
<tr>
<td></td>
<td>CS1D CPU Units for Single-CPU Systems</td>
<td>CS1D-CPU[S]</td>
<td>CS1D-S</td>
</tr>
<tr>
<td>CJ Series</td>
<td>CJ2 CPU Units</td>
<td>CJ2H-CPU6(-EIP)</td>
<td>CJ2H</td>
</tr>
<tr>
<td></td>
<td>CJ1-H CPU Units</td>
<td>CJ1G-CPU[H]</td>
<td>CJ1G-H</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJ1G-CPU[P]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJ1H-CPU[H-R]</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJ1H-CPU[H]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CJ1M CPU Units</td>
<td>CJ1M-CPU[H]</td>
<td>CJ1M</td>
</tr>
<tr>
<td>CP Series</td>
<td>CP1H CPU Units</td>
<td>CP1H-X</td>
<td>CP1H</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP1H-XA</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP1H-Y</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP1L CPU Units</td>
<td>CP1L-M</td>
<td>CP1L</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP1L-L</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CP1E CPU Units</td>
<td>CP1E-E</td>
<td>CP1E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP1E-N</td>
<td></td>
</tr>
</tbody>
</table>

**Note** Device types not supported by the CX-Programmer version that is being used will not be displayed on the pull-down list of the Device type Field.
## Troubleshooting Problems with Unit Versions on the CX-Programmer

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>After the above message is displayed, a compiling error will be displayed on the Compile Tab Page in the Output Window.</td>
<td>An attempt was made using CX-Programmer version 4.0 or higher to download a program containing instructions supported only by CPU Units Ver. 2.0 or later to a Pre-Ver. 2.0 CPU Units.</td>
<td>Check the program or change the CPU Unit being downloaded to a CPU Unit Ver. 2.0 or later.</td>
</tr>
<tr>
<td>&quot;????&quot; is displayed in a program transferred from the PLC to the CX-Programmer.</td>
<td>An attempt was made using CX-Programmer version 4.0 or higher to download a PLC Setup containing settings supported only by CPU Units Ver. 2.0 or later (i.e., not set to their default values) to a Pre-Ver. 2.0 CPU Units.</td>
<td>Check the settings in the PLC Setup or change the CPU Unit being downloaded to a CPU Unit Ver. 2.0 or later.</td>
</tr>
</tbody>
</table>

CX-Programmer version 3.3 or lower was used to upload a program containing instructions supported only by CPU Units Ver. 2.0 or later from a CPU Unit Ver. 2.0 or later. | The new instructions cannot be uploaded using CX-Programmer version 3.3 or lower. Use CX-Programmer version 4.0 or higher. |
PART 1:
CX-Programmer
Notice

OMRON products are manufactured for use according to proper procedures by a qualified operator and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed the information provided in them. Failure to heed precautions can result in injury to people or damage to the product.

⚠️ DANGER Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury. Additionally, there may be severe property damage.

⚠️ WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. Additionally, there may be severe property damage.

⚠️ Caution Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury, or property damage.

OMRON Product References

All OMRON products are capitalized in this manual. The word “Unit” is also capitalized when it refers to an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything else.
Visual Aids

The following headings appear in the left column of the manual to help you locate different types of information.

Indicates information of particular interest for efficient and convenient operation of the product.

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc.

shortcut Represents a shortcut on the Toolbar to one of the options available on the menu of the same window.

© OMRON, 2005

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of OMRON.

All copyright and trademarks acknowledged.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.
About this Part

This part describes the CX-Programmer application and its ability to create and maintain programs for use with OMRON SYSMAC CS/CJ/CP, CV and C PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the commercial manual for the device must be consulted.

This part contains the following chapters:

- **Precautions.** This portion describes general precautions for using the CX-Programmer (including CX-Server PLC Tools).
- **Version Upgrade Information.** This portion describes the changes that have been made from version 3.0 to version 3.1 of the CX-Programmer.
- **Chapter 1 Technical Specifications.** This chapter describes the CX-Programmer software in general terms and also provides details of the operating environment and minimum configuration necessary for the satisfactory operation of CX-Programmer.
- **Chapter 2 Quick Start Guide.** This chapter describes the basic features of CX-Programmer together with a simple tutorial for familiarization purposes.
- **Chapter 3 Project Reference.** This describes the features common to two or more parts of CX-Programmer.
- **Chapter 4 Reference.** This chapter introduces the features contained in the Project workspace and discusses their associated commands and features.
- **Chapter 5 Advanced Topics.** This chapter discusses the more advanced topics in relation to CX-Programmer.
- **Appendix A Toolbars and Keyboard Shortcuts.** This appendix summarizes the toolbar and keyboard shortcuts available from CX-Programmer.

A Glossary of Terms and Index are also provided.
## Functions Supported by the CX-Programmer Installed from the CX-One

### Starting Specialized Support Tools from the I/O Table Window

<table>
<thead>
<tr>
<th>Previous version</th>
<th>New version (CX-Programmer Installed from CX-One)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each CPU Bus Unit or Special I/O Unit's Programming Tool was started individually.</td>
<td>If the PLC model is set to the CS/CJ/CP-series, each Unit's Programming Tool (e.g., CX-Integrator, CX-Protocol, CX-Position, or CX-Process Tool) can be started directly from the Special I/O Unit or CPU Bus Unit in the I/O Table Window. When the Specialized Support Tool is started, the CX-Programmer can pass information such as the PLC model, Unit model, and online/offline status.</td>
</tr>
</tbody>
</table>

## Version 8.3 Upgrade Information

### Functionality Improved from Version 8.2 to 8.3

**Compatible PLC Models**

The functionality improvements are supported for CJ2H CPU Units with unit version 1.2 or later.

**TIMER and COUNTER Added as Symbol Data Types**

<table>
<thead>
<tr>
<th>Previous version (version 8.2)</th>
<th>New version (version 8.3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When defining timer numbers and counter numbers as symbols, the following three different symbols had to be registered in the symbols table.</td>
<td>TIMER and COUNTER symbols are supported so that all of the previous three types of symbols can be managed as one data type. (TIMER and COUNTER are supported only by CJ2H CPU Units with unit version 1.0 or later.)</td>
</tr>
<tr>
<td>1. Timer numbers and counter numbers specified in instruction operands had to be defined as NUMBER symbols.</td>
<td>TIMER: Can be used for 1) the timer number, 2) the Timer Completion Flag, and 3) the timer present value.</td>
</tr>
<tr>
<td>2. Timer and Counter Completion Flags had to be defined as BOOL symbols.</td>
<td>COUNTER: Can be used for 1) the counter number, 2) the Counter Completion Flag, and 3) the counter present value.</td>
</tr>
<tr>
<td>3. Timer and counter present values had to be defined as CHANNEL symbols.</td>
<td></td>
</tr>
</tbody>
</table>

Automatically assigning timer and counter numbers in ladder programs was not possible. Automatic address assignment and layout are supported for TIMER and COUNTER symbols. (TIMER and COUNTER are supported only by CJ2H CPU Units with unit version 1.0 or later.)

**Force-setting/resetting Bits in EM Area**

<table>
<thead>
<tr>
<th>Previous version (version 8.2)</th>
<th>New version (version 8.3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bits in the EM Area could be force-set/reset in CJ2H CPU Units only for specific EM Area banks for which automatic address assignment was used.</td>
<td>With CJ2H CPU Units with unit version 1.2 or later, PLC Memory Allocate EM Memory Settings can be used to specify the EM Area banks for which bits can be force-set/reset. (The first bank is specified and force-setting/resetting bits is possible in that bank and all banks following it.) This is called the EM Area force-setting/resetting function.</td>
</tr>
</tbody>
</table>
Searching for Symbol Names and Displaying Usage Locations from Cross-reference Pop-ups

<table>
<thead>
<tr>
<th>Previous version (version 8.2)</th>
<th>New version (version 8.3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching from cross-reference pop-ups was possible only for address specifications. (To search for symbols, you had to click the Browse button and search for symbol names from the Symbol Search Dialog Box.)</td>
<td>Symbol names can be specified directly in cross-reference pop-ups to display a list of locations that use the address of that symbol.</td>
</tr>
</tbody>
</table>

Version 8.2 Upgrade Information

Functionality Improved from Version 8.1 to 8.2

- **Connecting Online to the PLC through an NV-series PT**

<table>
<thead>
<tr>
<th>Previous version (version 8.1)</th>
<th>New version (version 8.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>It was not possible to connect online from the CX-Programmer through an NV-series PT to a PLC connected to the NV-series PT.</td>
<td>It is now possible to connect online from the CX-Programmer through an NV-series PT to a PLC connected to the NV-series PT.</td>
</tr>
</tbody>
</table>

*Functionality improved in version 8.21 over version 8.20.

- **CP1E CPU Unit Supported for Connecting Online to a PLC via an NS-series PT**

<table>
<thead>
<tr>
<th>Previous version (version 8.1)</th>
<th>New version (version 8.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a CP1E CPU Unit, it was not possible to connect online from the CX-Programmer through an NS-series PT to a PLC connected to the NS-series PT.</td>
<td>With a CP1E-□□□□□□□□□□ CPU Unit, it is now possible to connect online from the CX-Programmer through an NS-series PT to a PLC connected to the NS-series PT.</td>
</tr>
</tbody>
</table>

- **Compatible PLC Models**

  The functionality improvements are supported for CP-series CP1E CPU Units with unit version 1.0.

- **Online Connection to the PLC via an NS-series PT**

<table>
<thead>
<tr>
<th>Previous version (version 8.1)</th>
<th>New version (version 8.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>An online connection from the CX-Programmer through an NS-series PT to a PLC connected to the PT was not possible.</td>
<td>An online connection from the CX-Programmer through an NS-series PT to a PLC connected to the PT is possible when the PLC is connected to the PT using a serial connection, Ethernet connection, or Controller Link connection.</td>
</tr>
</tbody>
</table>
Version 8.1 Upgrade Information

Functionality Improved from Version 8.0 to 8.1

■ Compatible PLC Models
  The functionality improvements are supported for CJ-series CJ2 CPU Units (CJ2H-CPU6(-EIP)) with unit version 1.1.

■ Support for Synchronous Unit Operation
  Support has been added for the synchronous unit operation function for a combination of a CJ-series CJ2 CPU Unit (CJ2H-CPU6(-EIP)) with unit version 1.1 and CJ-series Position Control Units (CJ1W-NC4). Settings and monitoring are now possible for synchronous unit operation.

■ Improved Special I/O Unit and CPU Bus Unit Setup Functionality
  Multiple dialog boxes can now be opened simultaneously when setting CJ-series Position Control Unit (CJ1W-NC4) parameters. In addition, the CAM Data Creation Software (WS02-MOPC2) can be used to convert cam data in a CSV file into data that can be used by a Position Control Unit, and the data can be imported to the PLC memory component of the CX-Programmer.

■ Improved CS/CJ Data Tracing Function
  • Improved Trace Settings
    With support for the synchronous unit operation function of CJ2 CPU Units with unit version 1.1, tracing can now be executed for each synchronous cycle.
  • Improved Bit Graph Display
    Bit graphs are displayed according to screen size, and addresses are displayed beside the graphs.
OMRON PART 1: CX-Programmer

Version 8.0 Upgrade Information

Functionality Improved from Version 7.2 to 8.0
Support has been added for the following PLC models as part of the version 7.2 to version 7.3 upgrade.

■ Compatible PLC Models
  New CP-series CP1L CPU Units
  The CP-series CP1L CPU Units (CP1L-L10D□-□ and CP1L-M60D□-□) are supported.

The following functions have been added or improved as part of the upgrade from version 7.3 to 8.0.

■ Compatible PLC Models
  CJ-series CJ2 CPU Units
  The CJ-series CJ2 CPU Units (CJ2H-CPU6□-EIP) are supported.
  • EtherNet/IP
    Connection is possible to the CJ2H-CPU6□-EIP and EtherNet/IP Units.
  • New Ladder Programming Instructions
    The new instructions for the CJ2 CPU Units can be used, including the Tracking Instructions and Data Search/Sort Instructions.

■ Improved Data Trace Function
  Overhaul of Data Tracing Function for CS/CJ-series PLCs
  If a CJ2 CPU Unit is used, long-term continuous data tracing is possible.
  Operations have been improved, including zooming in and out of trace results graphs and adjusting offsets. Trace results can also be printed or saved as bit maps.

■ PLC Backups
  Data from the CPU Unit, Special I/O Units, and CPU Bus Units can be backed up as a batch from a personal computer. The backup data can be compared or restored as a batch, or the data for only selected Units can be restored.
OMRON

PART 1: CX-Programmer

■ Improvements in Programming

• Symbols in Array Variable Subscripts.

<table>
<thead>
<tr>
<th>Previous version (version 7.2)</th>
<th>New version (version 8.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbols could be used for array variable subscripts only inside function blocks.</td>
<td>With a CJ2 CPU Unit, symbols can be used for array variable subscripts in ladder diagram programming in tasks.</td>
</tr>
</tbody>
</table>

• Address Offsets

<table>
<thead>
<tr>
<th>Previous version (version 7.2)</th>
<th>New version (version 8.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a CJ2 CPU Unit, an offset value can be input to offset a specific bit or word address in ladder diagram programming.</td>
<td></td>
</tr>
</tbody>
</table>

• DM/EM Bit Addresses

<table>
<thead>
<tr>
<th>Previous version (version 7.2)</th>
<th>New version (version 8.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only word addresses could be used in the EM and DM Areas.</td>
<td>With a CJ2 CPU Unit, bit addresses can be specified in the EM and DM Areas.</td>
</tr>
</tbody>
</table>

■ Improvements to Online Functions

With a CJ2 CPU Unit, you can easily connect to a PLC on an EtherNet/IP network.

■ Improvements to Monitoring

When registering an array variable in the Watch Window, it is now possible to register and monitor a selected range of array elements.

■ Improvements to Symbol Tables

It is now possible to edit data items (i.e., arrange or delete) when copying and pasting variable table data via the clipboard from external applications. It is also possible to set the contents of symbol table data to be copied to the external application in advance using option settings.

■ Other Improvements

<table>
<thead>
<tr>
<th>Previous version (version 7.2)</th>
<th>New version (version 8.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The error log of the CPU Unit only displayed the error code.</td>
<td>In the error log of the CPU Unit, a code which gives more detailed information about the error is displayed in addition to the error code.</td>
</tr>
</tbody>
</table>
Version 7.2 Upgrade Information

Functionality Improved from Version 7.0 to Version 7.2
Support has been added for the following PLC models as part of the version 7.0 to version 7.10 upgrade.

- **Compatible PLC Models**
  The high-speed CJ1-H-R CPU Units (CJ1-CPUH-R) are supported.

Support has been added for the following PLC models as part of the upgrade from version 7.10 to 7.11.

- **Compatible PLC Models**
  The CP-series CP1L CPU Units (CP1L-M and CP1L-L) are supported.

The following functions have been added or improved as part of the upgrade from version 7.11 to 7.2.

- **Improved IEC 61131-3 Language Support**
  Support has been strengthened for the ST and SFC languages, which are IEC 61131-3 languages.
  Ladder, ST, and SFC programs can be combined freely, so the user program can be written in the language most appropriate for the required processing. Using the most appropriate language can reduce program development time and simplify programming.

  • **Support for ST Language Programming in Tasks**
    | Previous version (version 7.0) | New version (version 7.2) |
    |--------------------------------|---------------------------|
    | The ST language could be used only in function blocks. | The ST language can be used in programs other than function blocks. (ST programs can be allocated to tasks.) Different languages can be used in a single user program, which allows numerical processing and string processing to be written in ST programs, while other processing is written in ladder or SFC programs. **Note:** The ST language is supported only in CS/CJ-series CPU Units with unit version 4.0 or later. It is not supported in CP-series CPU Units. |

  • **Support for SFC Language Programming in Tasks**
    | Previous version (version 7.0) | New version (version 7.2) |
    |--------------------------------|---------------------------|
    | The SFC language could not be used. | The SFC language can be used in programs. (SFC programs can be allocated to tasks.) Different languages can be used in a single user program, which allows the overall system processing to be written in SFC programs, while other processing is written in ladder or ST programs. **Note:** The SFC language is supported only in CS/CJ-series CPU Units with unit version 4.0 or later. It is not supported in CP-series CPU Units. |
• **Support for Array Variables in Ladder, ST, and SFC Programs**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array variables could be used for internal variables and input-output variables in a function block's algorithm, but array variables could not be used in programs (tasks).</td>
<td>Array variables can be specified even in programs (tasks) written in ladder, ST, or SFC language. This feature allows multiple variables with the same data characteristics to be managed as a group.</td>
</tr>
</tbody>
</table>

• **Comparing Function Block Definitions**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function block definitions could not be compared.</td>
<td>Function block definitions can be compared in detail. This feature makes it easy to check for differences between the programs in function block definitions.</td>
</tr>
</tbody>
</table>

• **Comparison of Function Block Definitions, ST Programs, and Action Programs/Subcharts in SFC Programs**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST programs and SFC programs could not be compared.</td>
<td>ST programs and SFC programs can be compared. ST programs in an SFC program can also be compared in detail.</td>
</tr>
</tbody>
</table>

**PLC-PT Integrated Simulation**

The following improvements have been made to the simultaneous interactive debugging function (integrated simulation), which debugs operation between the CX-Programmer’s ladder program and NS-series PT touch panel test screens in the CX-Designer.

• **Starting Integrated Simulator from the CX-Programmer**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The integrated simulator could be started from the CX-Designer only; it could not be started from the CX-Programmer.</td>
<td>The integrated simulator can be started from the CX-Programmer (specifying a saved CX-Designer screen file). With this feature, it is possible to easily confirm the interaction between a ladder program being edited in the CX-Programmer and NS-series PT touch panel test screens.</td>
</tr>
</tbody>
</table>

• **Simulating the Occurrence of PLC Errors**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>During simulation, it was not possible to generate PLC system errors by manipulating the corresponding Auxiliary Area flags. (The system error flags were write-protected.) It was necessary to create ladder programming that generated errors using the FAL and FALS instructions, and check operation in the simulation.</td>
<td>PLC system errors can be generated during CX-Programmer ladder program simulation by selecting <em>Simulation - PLC Error Simulator</em> and writing the corresponding system error flags in the Auxiliary Area. With this feature, it is not necessary to create ladder programming to generate errors. Also, it is easy to check the operation of the ladder program and NS-series touch panel when PLC errors occur.</td>
</tr>
</tbody>
</table>

**Improvements to Symbol Tables**

• **Improved Interaction of the CX-Designer with Symbol Table Data**

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol tables could be copied and pasted from the CX-Programmer to the CX-Designer, but not the opposite direction. Consequently, when NS-series touch panel test screens were being edited in the CX-Designer and I/O comments were edited in the CX-Designer symbol table, it was necessary to write the data in Excel and transfer it to the CX-Programmer’s symbol table.</td>
<td>Symbol tables can be copied in pasted in both directions between the CX-Designer and CX-Programmer. This feature makes it easy to reflect changes to the CX-Designer’s symbol table, such as edited I/O comments, in the CX-Programmer’s symbol table.</td>
</tr>
</tbody>
</table>
• Support for the STRING Data Type in Ladder Programs and ST Programs

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The STRING data type could be used only in ST-language function blocks.</td>
<td>The STRING data type can be used in both ladder and ST languages, in both task programs and function blocks. The STRING data type supports ASCII characters between 1 and 255.</td>
</tr>
</tbody>
</table>

■ Improved Automatic Online Connection

• Added Automatic Detection of the Computer’s Serial Port

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When automatic online connection was performed from the computer’s serial port, it was not necessary for the user to set the PLC model because it was recognized automatically, but the serial port had to be set in advance.</td>
<td>It is not necessary for the user to select the computer’s serial port in advance. When automatic online connection is performed, the software automatically searches for computer serial ports that can be used. If the software finds a serial port that can be used for the online connection, the software automatically connects online from the detected port, and the serial port setting is also changed automatically.</td>
</tr>
</tbody>
</table>

■ Improved Conversion of C500/C120/C**P Programs

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs stored in C500, C120, or C**P-series PLCs could be uploaded and converted for use in CS/CJ/CP-series PLCs or CVM1/CV-series PLCs, but the DM and HR Area data could not be converted to PLC memory.</td>
<td>DM and HR Area data can also be converted to PLC memory. After conversion, it is now possible to select the CP1L as the PLC model.</td>
</tr>
<tr>
<td>A backup program and I/O memory (DM and HR Area data) file (extension .c5b) could be used to restore the program to a C500/C120/C**P-series PLC, but it could not be converted to a CX-Programmer project.</td>
<td>A backup program and I/O memory (DM and HR Area data) file (extension .c5b) can be converted to a CX-Programmer project for a CS/CJ/CP-series PLC or CVM1/CV-series PLC.</td>
</tr>
<tr>
<td>A program uploaded from a C500, C120, or C**P-series PLC could not be saved to a file in mnemonic-text format.</td>
<td>A program uploaded from a C500, C120, or C**P-series PLC can be saved to a file in mnemonic-text format. The saved file can be pasted as text in the CX-Programmer’s Statement List (mnemonic window), and displayed or printed in ladder format. This feature allows the program to be checked in the CX-Programmer before converting it to a CS/CJ/CP-series PLC or CVM1/CV-series PLC program.</td>
</tr>
</tbody>
</table>

■ Other Improvements

<table>
<thead>
<tr>
<th>Previous version (version 7.0)</th>
<th>New version (version 7.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CPU Unit’s production information could be displayed from the I/O table only.</td>
<td>The CPU Unit’s production information can be displayed from the Main Menu’s PLC Information Dialog Box.</td>
</tr>
<tr>
<td>When a CS1D Duplex System CPU Unit was being used, the CPU Unit’s Active/Standby status could not be displayed in the project directory tree.</td>
<td>When a CS1D Duplex System CPU Unit (CS1D-H) is being used, the CPU Unit’s Active/Standby status is displayed in the project directory tree.</td>
</tr>
</tbody>
</table>
Version 7.0 Upgrade Information

Functionality Improved from Version 6.1 to Version 7.0

- **Compatible PLC Models**
  The following PLC models have been added as compatible PLCs as part of the version 6.1 to version 7.0 upgrade.

- **CS/CJ Series CPU Units with unit version Ver. 4.0 and higher**
  Ver. 4.0 and higher CS/CJ Series CPU Units are supported.

- **CP Series CPU Units**
  The CP Series CPU Units (CP1H-Y) are supported.

- **Support for NSJ-M3D Controllers**
  The NSJ-M3D Controllers are supported.

**Ladder Program to Function Block Conversion Function**

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>To convert existing ladder programming to a function block, the ladder programming was copied and pasted into a function block definition. At that point, it was necessary to check the variables and addresses used in the program and manually register those variables and addresses while organizing the input variables, internal variables, and output variables.</td>
<td>Existing ladder program sections can be easily converted to function blocks by selecting the program circuits to be converted and selecting <strong>Function Block (ladder) generation</strong>. The function block definition is created automatically and the variables are allocated automatically based on the usage of the variables and addresses in the program.</td>
</tr>
</tbody>
</table>

**Online Editing of Function Blocks**

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A function block definition (algorithm and variable table) could not be edited while the PLC program was being executed. (The instance I/O parameters could be changed.)</td>
<td>A function block definition (algorithm and variable table) can be edited while the PLC program is being executed. (Instances cannot be added.) With this capability, it is possible to debug and edit the function block definitions themselves even if the PLC must operate 24 hours/day because there are devices that cannot be stopped. To edit a function block, select the function block definition in the Workspace and select <strong>FB Online Edit – Begin</strong> from the popup menu.</td>
</tr>
<tr>
<td>Note: Function block instances cannot be added.</td>
<td></td>
</tr>
<tr>
<td>Note: This function cannot be used for simulations on the CX-Simulator.</td>
<td></td>
</tr>
</tbody>
</table>

**STRING Data and Text-processing Functions Supported in ST-language Function Blocks**

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The STRING data type could not be used in the ST language. (See note.)</td>
<td>The STRING data type can be used as a data type in the ST language. With this capability, it is easy to set a variable containing text (ASCII) in another variable with a substitution operation (such as: a := ‘@READ’). In this case, it is not necessary to know the length of the ASCII text string.</td>
</tr>
<tr>
<td>Previous version (Ver. 6.1)</td>
<td>New version (Ver. 7.0)</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>There were no text-processing functions for the ST language. To process text for message displays and no-protocol communications in the ladder language, the user had to know the length of the ASCII string and execute instructions such as text-processing instructions, data conversion instructions, and serial communications instructions. <strong>Note:</strong> The user can input text strings can in I/O memory using the CX-Programmer’s PLC memory function, but it is necessary to know the data size in I/O memory.</td>
<td>Text-processing functions (extracting text, merging, searching, etc.) are supported for the ST language. With these functions, it is easy to create text strings and process displayed messages using ST language in a function block without knowing the actual ASCII codes.</td>
</tr>
</tbody>
</table>

### Support for Input-Output Variables

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input-output variables were not supported in function blocks. (Only input variables, internal variables, and output variables could be used.)</td>
<td>Input-output variables can be used in function blocks.</td>
</tr>
<tr>
<td>Input variables could not be specified as arrays.</td>
<td>Input-output variables can be specified as arrays.</td>
</tr>
<tr>
<td>Values are passed from input parameters to input variables.</td>
<td>Addresses (not values) are passed from input parameters to input variables. Consequently, array input-output variables can be used in the function blocks and large amounts of data can be passed easily to the function blocks through input parameters.</td>
</tr>
</tbody>
</table>

### Support for C500/C120/C**P Backup Function

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The programs in C500/C120/C**P PLCs could not be managed online from the CX-Programmer.</td>
<td>A program stored in a C500/C120/C<strong>P PLC can be uploaded and converted to a CS/CJ/CP Series program or CVM1/CV Series PLC program. If an instruction’s specifications are different, a comment is displayed to alert the user of the differences when the program is converted. To convert a program, select <strong>Tools – C500/C120/CxxP Support – Online PLC Program Conversion</strong>. Program and I/O memory data (DM and HR) stored in a C500/C120/C</strong>P PLC can be backed up. Later, the backed up program and I/O memory data can be restored to a C500/C120/C<strong>P PLC. To backup or restore the data, select <strong>Tools – C500/C120/CxxP Support – Backup from PLC</strong> or <strong>Tools – C500/C120/CxxP Support – Restore to PLC</strong>. Program and I/O memory data (DM and HR) stored in a specified file can be compared to the program and I/O memory data (DM and HR) in a C500/C120/C</strong>P PLC. To compare the data, select <strong>Tools – C500/C120/CxxP Support – Compare PLC and file</strong>.</td>
</tr>
</tbody>
</table>

### Improvements in Data Trace/Time Chart Monitoring

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.1)</th>
<th>New version (Ver. 7.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one word of data could be specified at the trace data for data tracing and timechart monitoring.</td>
<td>Up to eight words of data can be specified at the trace data for data tracing and timechart monitoring.</td>
</tr>
</tbody>
</table>
Version 6.1 Upgrade Information

- Functionality Improved from Version 6.0 to Version 6.1

- Compatible PLC Models
  The following PLC models have been added as compatible PLCs as part of the version 6.0 to version 6.1 upgrade:
  CP Series CP1H CPU Units  (CP1H-XA and CP1H-X)

- Support for NSJ-series NSJ Controllers
  The PLC model (“device type”) can be set to “NSJ” and the CPU type can be set to the G5D.

- Support for FQM1 Unit Version 3.0
  The new models of the FQM1 Flexible Motion Controller are now supported (i.e., the FQM1-CM002 Coordinator Module and the FQM1-MMA22/MMP22 Motion Control Modules).

- Ladder Program Simulation Function

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CX-Simulator could be used to execute a ladder program step (Step Run), execute steps continuously (Continuous Step Run), execute a single cycle (Scan Run), and set I/O break point conditions.</td>
<td>The Step Run, Continuous Step Run, Scan Run, and Set/Clear Break Point functions can be executed as CX-Programmer functions. All of these functions can be used with ladder programs and ladder/ST programs in function blocks. Note 1: The CX-Simulator Ver. 1.6 (sold separately) must be installed in order to use these functions. Note 2: I/O break conditions cannot be set.</td>
</tr>
</tbody>
</table>

- Improved Function Block Functions

- Monitoring ST Programs in Function Blocks

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The operation of ST programs within function block instances could not be monitored while monitoring the program online. (It was possible to check the contents of a function block definition’s program and monitor the I/O status of a function block instance’s ladder diagram.)</td>
<td>The status of a function block instance’s ST program can be monitored while monitoring the program. To monitor the ST program’s status, either double-click the function block instance or right-click the instance and select Monitor FB Instance from the pop-up menu. At this point, it is possible to change PVs and force-set/reset bits. Note: Online editing is not supported.</td>
</tr>
</tbody>
</table>
• Password Protection of Function Blocks

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
</table>
| The function block properties could be set to prevent the display of a function block definition's program. | The following two kinds of password protection can be set.  
• Password protection restricting both reading and writing.  
• Password protection restricting writing only. |

■ Starting the Switch Box Utility with PLC Information

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Switch Box Utility could be started from the CX-Programmer's Tools Menu, but the PLC model and communications settings could not be inherited in that case.</td>
<td>The Switch Box Utility can start with the PLC model and communications settings set in the CX-Programmer's project.</td>
</tr>
</tbody>
</table>

■ Saving the CPU Unit’s Error Log as a CSV File

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CPU Unit’s error log could not be saved.</td>
<td>The CPU Unit's error log can be saved as a CSV file. The data collected in these CSV files can be analyzed or printed later with programs such as MS Excel.</td>
</tr>
</tbody>
</table>

■ Displaying Current Consumption in the I/O Table Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The current consumption for the 5 V system could not be separated from the 26 V/24 V system in the I/O table window’s current consumption display. The total current consumption at the different voltages could not be separated. There was no total power consumption display.</td>
<td>The current consumption display in the I/O table window is divided into 5 V and 26 V/24 V system displays. A total power consumption display was also added.</td>
</tr>
</tbody>
</table>

■ Displaying Unit Versions in the I/O Table Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The I/O table window’s Unit profile information display showed only the model number and did not show the unit version.</td>
<td>The unit version was added to the I/O table window’s Unit profile information display in addition to the model number.</td>
</tr>
</tbody>
</table>

■ USB Supported as a Network Type

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
</table>
| USB was not available as a network type. | As part of the CP Series support upgrade, USB is supported as a network type for the connection between the computer and PLC. This improvement allows the computer’s USB port to be connected to the PLC’s USB port. In addition, if the computer supports automatic online USB connections, this function can be used.  
Note: This function can be used only with the CP Series PLCs, which are equipped with USB port. |

■ CP1H Memory Cassette Transfers and Flash Memory Backup Functions

<table>
<thead>
<tr>
<th>Previous version (Ver. 6.0)</th>
<th>New version (Ver. 6.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CP1H CPU Units were not supported.</td>
<td>When the PLC model is set to CP Series CP1H, it is possible to transfer and verify data between a Memory Cassette and the CP1H CPU Unit. The contents of Data Memory in the CPU Unit’s RAM can also be backed up to flash memory as initial values. (To access these functions, select PLC – Edit – Memory Cassette/DM.)</td>
</tr>
</tbody>
</table>
Version 6.0 Upgrade Information

- Functionality Improved from Version 5.0 to Version 6.0

- Installing the CX-Programmer from the Integrated CX-One Package

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CX-Programmer could be installed only independently.</td>
<td>The CX-Programmer can be installed as one of the functions of the integrated CX-One Software Package.</td>
</tr>
</tbody>
</table>

- Automatic Selection of Network Configuration Tool (CX-Integrator/CX-Net Startup)

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CX-Net started automatically when <strong>Tools – Network Configuration Tool</strong> was selected.</td>
<td>If the PLC model is set to the CS/CJ-series, the CX-Integrator starts when <strong>Tools – Network Settings</strong> is selected. If the PLC model is set to a model other than the CS/CJ-series, the CX-Net starts when <strong>Tools – Network Settings</strong> is selected.</td>
</tr>
</tbody>
</table>

- CX-Programmer Startup Method

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CX-Programmer could be started only from the <strong>Start Menu</strong>.</td>
<td>The CX-Programmer can also be started by right-clicking a PLC in the CX-Integrator’s Network Configuration Window and selecting <strong>Start Special Tool</strong> from the pop-up menu. Note: When the <strong>Start with Settings Inherited</strong> Option is selected, the CX-Programmer will start with the same online/offline status as the CX-Integrator and a new project will be created (i.e., inserted into the Network Configuration Window).</td>
</tr>
</tbody>
</table>

- Switch Box Utility Location and Startup Method

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Utility could be installed from the CX-Programmer’s Setup Disk as a separate program and started from the <strong>Start Menu</strong>.</td>
<td>The Switch Box Utility is handled as a Programming Device and it can be started from the Tools Menu. Note: The Switch Box Utility supports the PLC’s Debug operations. The Utility can be used to display I/O status of a user-specified address. A specified bit’s status can be Set/Reset or Force-Set/Reset from the keyboard and a specified word’s content can be changed. For details, refer to the Switch Box Utility’s online help program.</td>
</tr>
</tbody>
</table>

- Compatible PLC Models

- **FQM1-series Compatibility**
  The CX-Programmer now supports FQM1 Flexible Motion Controllers. An FQM1-CM Coordinator Module and FQM1-MMA/FQM1-MMP Motion Control Module can be selected as the PLC model.

  Note: After selecting the FQM1-CM as the PLC model, insert the FQM1-MMA or FQM1-MMP as the PLC.
OMRON

PART 1: CX-Programmer

Improved I/O Table Window (CS/CJ-series PLCs Only)

- Setting CPU Bus Unit and Special I/O Unit Parameters in the I/O Table Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CX-Programmer had to be online and only the following Communications Unit settings could be made from the I/O table window. 1. Software Switch Settings (for Controller Link Units, Ethernet Units, Serial Communication Boards/Units, etc.) 2. Unit Settings (Ethernet Units)</td>
<td>If the PLC model is set to the CS/CJ-series, parameters for Special I/O Units and CPU Bus Units (such as the allocated DM area and CPU Bus Unit System Settings) can be set offline without knowing the parameter addresses. The parameter data and I/O table can be downloaded (see note), uploaded, or compared with the actual PLC’s data. The parameter data can also be stored in a CX-Programmer project file (extension .CXP) or an individual Unit’s parameters can be stored as a file (extension .XML).</td>
</tr>
</tbody>
</table>

Note: When downloading PLC memory data from the computer to an actual PLC, a warning will be displayed if the PLC memory area addresses to be transferred from the computer overlap the addresses of the Special Unit settings in the computer’s I/O Table Window.

- Monitoring Additional Rack Information in the I/O Table Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Rack’s power supply status,</td>
<td>If the PLC model is set to the CS/CJ-series, each Rack’s power consumption and rack width (CJ-series only) is displayed offline in a dialog box. When the CX-Programmer is online, the CPU Unit’s front DIP Switch settings can be monitored in a dialog box.</td>
</tr>
</tbody>
</table>

Improved Data Trace and Time Chart Functions

- Storing Collected Data in CSV Files

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data collected with the Data Trace function or Time Chart Monitor function could be stored in specialized CX-Programmer (.cdt) files only.</td>
<td>Data collected with the Data Trace function or Time Chart Monitor function can be stored in standard CSV files, so the collected data can be analyzed/printed with programs such as Microsoft Excel.</td>
</tr>
</tbody>
</table>

Improved Function Block Functions

- Nesting Function Blocks

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A function block could not be called from another function block. (Nesting not supported.)</td>
<td>A function block can be called from another function block (nested). Up to 8 nesting levels are supported. The languages of the calling function block and called function block can be either ladder language or ST language. The nesting level relationship between function blocks can be displayed in a directory tree format. All nested function block definitions are stored in one Function Block Library file (.cxf extension).</td>
</tr>
</tbody>
</table>
• Monitoring Word and Bit Status of Ladder Programs in Function Blocks

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The I/O status of a function block instance’s ladder diagram could not be monitored while monitoring the program online. (It was only possible to check the program in the function block definition.)</td>
<td>The I/O status of a function block instance’s ladder diagram can be monitored while monitoring the program online. To monitor the I/O status, either double-click the function block instance or right-click the instance and select Monitor FB Ladder Instance from the pop-up menu. At this point, it will be possible to monitor the status of I/O bits and the content of words, change PVs, force-set/reset bits, and monitor differentiation (ON/OFF transitions) of bits. Note: Online editing is not supported and timer/counter SVs cannot be changed.</td>
</tr>
</tbody>
</table>

• Registering and Monitoring Function Block Instance Variables in a Watch Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 5.0)</th>
<th>New version (Ver. 6.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>To register a function block instance’s variable in a Watch Window, it was necessary to display the Watch Window, double-click the window, and select the desired variable from a pull-down list.</td>
<td>Multiple variables in a function block instance can be easily registered together in the Watch Window. The FB variables registration Dialog Box can be displayed with any of the following methods and the variables can be registered together in that Dialog Box. 1. Right-click the function block instance and select Register in Watch Window from the pop-up menu. 2. Select the desired function block instance in the program or variable table and either copy/paste or drag/drop the instance into the Watch Window. 3. Move the cursor to an empty line in the Watch Window and select Register in Watch Window from the pop-up menu.</td>
</tr>
</tbody>
</table>

• Other Improvements Related to Function Blocks

- The cross-reference pop-up function is supported in ladder programs within function blocks.
- The ST language help program can be started from the pop-up menu in ST Editor.
- A function block’s definitions can be opened just by double-clicking the function block instance.
- The cursor automatically moves down after a function block instance’s parameter input is confirmed.

■ Other Improvements

- Improvements to PLC Setup Downloading
  When the PLC Setup is downloaded to a PLC, the serial port related settings (Host Link Port Tab, Peripheral port Tab, and FINS Protection Tab settings) can be eliminated from the download. (This function allows the user to protect against overwriting from the CX-Programmer after using NT Link auto-detection from the CX-Integrator or making changes with a PLC parameter transfer.)
Version 5.0 Upgrade Information
The following tables outline the changes that have been made from version 4.0 to version 5.0 of the CX-Programmer.

- **Functionality Improved from Version 4.0 to Version 5.0**

**Compatible PLCs**
CX-Programmer version 5.0 supports the following PLCs:
- CS/CJ-series CPU Unit Ver. 3.0
- CJ-series CJ1H-CPU67H CPU Unit
  (Program capacity: 250K steps, I/O points: 2,560 points)

**Improvements to Functionality**

<table>
<thead>
<tr>
<th>Function Block (FB) Support (CS/CJ-series CPU Unit Ver. 3.0 or later)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Previous version (Ver. 4.0)</strong></td>
</tr>
<tr>
<td>Function blocks (FB) were not supported.</td>
</tr>
</tbody>
</table>

**Symbol Filtering Using Symbol Names and I/O Comments When Inputting Contacts, Coils, and Special Instruction Operands**

<table>
<thead>
<tr>
<th>Previous version (Ver. 4.0)</th>
<th>New version (Ver. 5.0)</th>
</tr>
</thead>
</table>
| Searches were possible only for symbol names of contacts and coils, and mnemonics of special instructions when inputting contacts, coils, or special instruction operands. | Searches and list displays are possible for text strings that are part of symbol names or I/O comments when inputting contacts, coils, or special instruction operands.  
  a) By entering a specific text string when inputting I/O contacts or operands, a list of address_comment or name_address_comment combinations that contain the specified text string in the symbol name or I/O comment is displayed in a drop-down list. The desired symbol can then be input by selecting it from the list.  
  b) In the same way, when inputting operands for special instructions, the Filter Symbol Button can be clicked to input a text string in the Filter Symbol Dialog Box to display a list of address_comment or name_address_comment combinations that contain the specified string in the symbol name or I/O comment in a drop-down list. The desired symbol can then be input by selecting it from the list. |
OMRON PART 1: CX-Programmer

<table>
<thead>
<tr>
<th>Previous version (Ver. 4.0)</th>
<th>New version (Ver. 5.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storing Comments, Symbol Names, Rung Comments, and Other Data in CPU Unit’s Comment Memory (CS/CJ-series CPU Unit Ver. 3.0 or Later)</strong></td>
<td></td>
</tr>
</tbody>
</table>
| The following common data could be stored in the Memory Card or EM file memory (Memory Card when both are available) by downloading projects from the CX-Programmer.  
  • Symbol tables (symbol names, comments, and automatic allocation area setting data: SYMBOLS.SYM)  
  • Comments (rung comments and other comments: COMMENTS.CMT)  
  • Program indexes (section names, section comments, and program comments) |
| When downloading projects using CS/CJ-series CPU Units with Ver. 3.0 or later, the Memory Card, EM file memory, or comment memory (in the CPU Unit’s flash memory) can be selected as the transfer destination for I/O comments, symbol names, rung comments, and other data.  
This enables data such as I/O comments, symbol names, and rung comments to be stored in the CPU Unit’s internal comment memory when a Memory Card or EM file memory are both not available. |

| **Inputting I/O Comments for Timer/Counter Numbers in Timer/Counter Instructions** |
| Previous version (Ver. 4.0) | New version (Ver. 5.0) |
| When inputting timer/counter instructions, I/O comments could not be input for timer/counter numbers (first operand) in the timer/counter instruction.  
I/O comments could be input for timer/counter Completion Flags, after which, these I/O comments were automatically displayed for the timer/counter numbers (first operand) of the timer/counter instructions. |
| When inputting timer/counter instructions using simple dialog mode selected in the Instruction Dialog Box, I/O comments can be input for the timer/counter number (first operand) in the timer/counter instruction. (The Completion Flag of the timer/counter instruction that corresponds to this number is automatically registered in the global symbol table.)  
Also, the … (three dots) button can be clicked in detailed dialog mode to display the Find Symbol Dialog and then input a new symbol name using the NUMBER data type for the timer/counter number (first operand) of the timer/counter instruction and the symbol comment. The NUMBER type symbol will be registered in the local symbol table and at the same time, the number of the timer/counter Completion Flag is registered in the global symbol table. |
### Online Connection to PLCs Connected Via Serial Gateway to Host Link FINS

<table>
<thead>
<tr>
<th>Previous version (Ver. 4.0)</th>
<th>New version (Ver. 5.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online connection to PLCs connected using a Serial Gateway to Host Link FINS was not supported.</td>
<td>Online connection is possible through the serial port of a Serial Communications Board/Unit (Ver. 1.2 or later) to PLCs connected using Host Link FINS via a Serial Gateway. In the Change PLC Dialog Box, specify serial port 1 or 2 of the Serial Communications Board/Unit (Ver. 1.2 or later) and the Host Link number of the destination PLC.</td>
</tr>
</tbody>
</table>

### Increased Data Link Capacity for Controller Link Networks and Areas 1 and 2 Can Use the Same Area for Data Links (CS/CJ-series Controller Link Units Unit Ver. 1.2 (Available Soon) or Later)

<table>
<thead>
<tr>
<th>Previous version (Ver. 4.0)</th>
<th>New version (Ver. 5.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A maximum of 12,000 send/receive words (total of Area 1 and Area 2) per node could be set when using Controller Link data links (manually set) with a CS/CJ-series Controller Link Unit.</td>
<td>Using a CS/CJ-series Controller Link Unit with Ver. 1.2 (available soon) or later, a maximum of 20,000 send/receive words per node (total of Area 1 and Area 2) can be set for nodes in Controller Link data links (manually set).</td>
</tr>
<tr>
<td>Area 1 and Area 2 had to be in different areas when using Controller Link data links (manually set) with a CS/CJ-series Controller Link Unit.</td>
<td>A CS/CJ-series Controller Link Unit Ver. 1.2 (available soon) or later and Controller Link data links (manually set) enables setting the same memory area for both Area 1 and Area 2, provided that the addresses are not the same. Example: The entire Data Link (i.e., Area 1 and Area 2) can be set in EM bank 0.</td>
</tr>
</tbody>
</table>

### Setting Local Network Tables (Using CX-Net Routing Tables) for the Serial Ports of Serial Communications Boards/Units (Ver. 1.2 or Later)

<table>
<thead>
<tr>
<th>Previous version (Ver. 4.0)</th>
<th>New version (Ver. 5.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following items could be displayed in the Unit directory of the SIOU Tab Page on the left of the routing table main view. The local network address could be set for the serial port of the CPU Unit and registered in the local network table by right-clicking and selecting <strong>Insert CPU SIOU</strong>. • Unit 252 (serial port) • Unit 253 (peripheral port)</td>
<td>The same function is now supported for the serial ports of Serial Communications Boards/Units (Ver. 1.2 or later). By right-clicking a device under the Unit directory and selecting <strong>Insert CPU SIOU</strong>, local network addresses can also be set for the serial ports of the Serial Communications Boards and Units to register them in the local network table.</td>
</tr>
</tbody>
</table>
Version 4.0 Upgrade Information

The following tables outline the changes that have been made from version 3.3 to version 4.0 of the CX-Programmer.

Functionality Improved from Version 3.3 to Version 4.0

Compatible PLCs

CX-Programmer Version 4.0 supports the following PLCs:

- CS/CJ-series CPU Unit Ver. 2.0 (including CJ1G-H Ver. 2.0, CJ1H-H Ver. 2.0, CJ1M Ver. 2.0 (see note 1), CS1G-H Ver. 2.0, and CS1D-S Ver. 2.0)
- CS1D-H CPU Unit Ver. 1.1

Note: 1. Includes CJ1M-CPU11/21.

2. Although previously “CS1H-H” was selected as the device type for CS1D CPU Units for Duplex-CPU Systems, CX-Programmer Version 4.0 allows selection of “CS1D-H.”

Network Compatibility

- Ethernet Connection Using TCP/IP

TCP/IP can be used instead of the earlier UDP/IP for Ethernet connections with a PLC to which a CS1W-ETN21 or CJ1W-ETN21 100Base-TX Ethernet Unit is mounted. Select Ethernet (FINS/TCP) as the network type.

- Settings for CS1D (Duplex) Ethernet Unit

Unit setting and PLC Setup settings are supported for the CS1D-ETN21D Duplex Ethernet Unit, enabling duplex operation for Ethernet. Refer to the CS1D-ETN21D Duplex Ethernet Unit Operation Manual (Cat. No. W430) for details on settings.

Improvements to Program Reusability

- Creating Files of Multiple Rungs or a Single Program Section as a File (Reusable File) for Saving/Reading

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reusing a part of the program (multiple rungs or a single section) enabled by moving or copying between two sections using the Section/Rung Manager Dialog Box. Parts of the program, however, could not be saved or read as files.</td>
<td>Parts of the program (single or multiple rungs, or a single program section) can be saved as a file (.cxr: text file) by selecting File – Reusable File – Save As. The file can then be read and inserted in a user-set location in the program of another project by selecting File – Reusable File – Add to Project. In the same way, specified variables in a symbol table can be saved as files, and then read and inserted in a symbol table of another project. Multiple reusable files can also be inserted all together in a specified order. The order used to insert multiple reusable files can also be saved in the list of reusable files added to the project. This allows the group of reusable files to be managed as a single unit of data.</td>
</tr>
</tbody>
</table>
Improvements to Program Editing Efficiency

- **Read Only Mode**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When editing a program offline, editing could not be prohibited.</td>
<td>Allowing ladder screen display only, and prohibiting program editing by mistake while offline is possible. Set the Offline Edit Mode to Read Only Mode in the Option Dialog Box to enable this function.</td>
</tr>
</tbody>
</table>
| When editing a program, an operation could be reversed (Undo), but all the edited parts could not be selected to be either applied (store) or cancelled. | After temporary editing of a specific rung, the user can select to utilize (store) or delete (cancel) the editing results. Select Read Only Mode Edit – Start Edit from the Edit Menu, and then perform either of the following steps after editing: 
  a) To apply the editing results, select Read Only Mode Edit – Store from the Edit Menu. The edited contents will be reflected in the program. 
  b) To not apply the editing results, select Read Only Mode Edit – Cancel from the Edit Menu. The edited contents will be deleted. Therefore, after editing rungs and writing and recording temporary changes, the changes can be selected to be either applied or deleted, enhancing program editing efficiency. |

Improvements to Program Development in Task Units

- **Downloading by Task (Program) (CS/CJ-series CPU Unit Ver. 2.0 or Later)**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When downloading a program to the PLC, only the whole user program could be downloaded. Note: Uploading in sections or tasks (program) was possible when using CS/CJ-, or CVM1/CV-series PLCs.</td>
<td>Programs can be downloaded to CS/CJ-series PLCs Ver. 2.0 or later, and downloading by task (program) instead of the whole user program is possible. Select Partial Transfer – Task Transfer to PLC from the PLC Menu, and download a specified single task or multiple tasks. This function enhances the efficiency of program development by multiple personnel. Particularly, by downloading to the PLC by task (program), only the parts to be changed are reflected in the PLC, resulting in fewer working errors.</td>
</tr>
</tbody>
</table>
### Confirming whether a Task (Program) Is Executing or Stopped (CS/CJ-series PLCs Only)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
</table>
| CS/CJ-series PLCs supported tasks, but the execution status could be confirmed for the whole program only and not for each task. | The following executing/stopped status is displayed for every task (see note) in the project space.  
- Running: Indicated as READY (execution enabled) or RUN (executing status).  
- Stopped: Indicated as INI (not executing status) or WAIT (standby status).  
This function improves debugging efficiency when using multiple tasks. |

Note: Cyclic tasks only. Interrupt tasks not included.

### Checking Whether the Same Address Is Being Used by Another Task (Program): Cross Reference Report Function (CS/CJ-series PLCs Only)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
</table>
| CS/CJ-series PLCs supported tasks, but they did not check whether the same address was being used by another task (program). | By selecting Duplicate usage over programs in the cross reference report function, a list can be checked for any bits/words that have been allocated an address already being used by another task (see note).  
This function can be used to easily check whether the same address is being used by another task (programmer) when two or more programmers are creating multiple tasks.  
Note: Cyclic tasks only (interrupt tasks not included). |

### Improvements to Password Protection

#### Password Protection for a Single User-set Task or Multiple Tasks (CS/CJ-series CPU Unit Ver. 2.0 or later)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
</table>
| Password protection (reading/editing prohibited) could be set. | Password protection (reading/editing prohibited) can be set for a user-set single task or multiple tasks (programs).  
This function provides security and prevents the loss of intellectual property for specific tasks (programs). |

#### Allowing/Prohibiting Creation of Program Files for File Memory (CS/CJ-series CPU Unit Ver. 2.0 or Later)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
</table>
| The user could use file memory operations to transfer program files (.OBJ) to a Memory Card, even if UM (user memory) read protection was set with a password. | When a password is registered for the whole user program or individual tasks, an optional setting can be selected at the same time to allow/prohibit creation (backup) of the program file (.OBJ).  
This function prevents copying of user programs to Memory Cards. |
• Allowing/Prohibiting Program Overwriting (CS/CJ-series CPU Unit Ver. 2.0 or Later)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwriting the user program in the CPU Unit was prohibited by turning ON pin 2 of the DIP switch. If pin 2 was turned OFF, however, overwriting was possible.</td>
<td>When a password is registered for the whole user program or individual tasks, an optional setting can be selected at the same time to allow/prohibit program overwriting. Set the option in the PLC properties. This function uses a password to prohibit overwriting of the program by a third party.</td>
</tr>
</tbody>
</table>

Improvements to I/O Table Editing Functions

• Specifying up to 64 Sets of Slot/Rack Start Addresses

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>For CS/CJ-series PLCs, up to eight sets, comprising rack/slot number and start address, could be set.</td>
<td>For CS/CJ-series PLCs Ver. 2.0 or later, up to 64 sets of rack/slot numbers and start addresses can be set.</td>
</tr>
</tbody>
</table>

Improvements to Unit Error Log Display

• Displaying Error Log for CPU Bus Units or Special I/O Units in the I/O Table

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The error log could not be displayed for Special I/O Units.</td>
<td>By selecting a CPU Bus Unit or Special I/O Unit in the I/O table tree and clicking the right mouse button to select the Unit Error Log Menu, the error log for the selected Unit can be displayed.</td>
</tr>
</tbody>
</table>

Improvements to Ladder Screen Display Functions

• Addition of Horizontal Display Mode for Instructions

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instructions could be displayed in vertical writing only.</td>
<td>Instructions on the right side of rungs, which were previously displayed vertically only, can now also be displayed horizontally. Enable this function by selecting Tools – Options, and then selecting Show output instructions horizontally in the Diagrams Tab Page (the default setting is OFF: previously used vertical display). By using the horizontal display mode, the number of instruction rungs that can be printed and displayed on one screen is increased, improving the readability of the program. At the same time, the number of printed pages can be reduced.</td>
</tr>
</tbody>
</table>
## Improvements to Comment Functions

### • Setting Multiple Comments (up to 16) for a Single Address, and Selecting a Label to Switch All the Comments

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single comment could be set for each address (symbol) only.</td>
<td>Multiple comments (up to 16) can be registered for a single address (symbol). By selecting the comment group to be displayed from the multiple comment groups (up to 16 groups), the comments on the ladder diagram screen can be changed all at once. This function allows multilingual development of a single program or attachment of comments according to the development step.</td>
</tr>
</tbody>
</table>

### • Importing and Editing Rung Comments

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>After uploading a program from a PLC that did not support rung comment data, the rung comments could not be reallocated. Even when programs were uploaded from PLCs that did not support rung comment data, if the program in the personal computer and actual PLC were different, the rung comments could not be reallocated.</td>
<td>By selecting Section/Rung Manager from the Program Menu, the rung comment data can be read (imported) from the project in the personal computer, and operations can be performed to move the data up and down. This function allows rung comments to be allocated to a program all at once after uploading the program under the following conditions, even if there is no comment file (COMMENTS.CMT) in the Memory Card/EM file memory. 1) When uploading programs from a C-series PLC or other PLC that cannot record rung comments. 2) When uploading programs from a CS/CJ-series, CVM1/CV-series, or C200HX/HG/HE-ZE PLC. When the uploaded programs are changed in the actual PLC using functions such as online editing, the position of the rung comment can be edited.</td>
</tr>
</tbody>
</table>
Displaying the Global/Local, Name, Address/Value, and Comment Fields for the Symbol at the Cursor Position below the Ladder Section Window (Symbol Bar)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>To display all comments, the font size, cell width, and other settings must be changed in the Appearance Tab settings, or detailed dialog mode must be used to check the comment display.</td>
<td>The global/local, name, address/value, and comment fields for the symbol at the cursor position are displayed in the symbol bar below the Ladder Section window. Enable this function by selecting Show symbol bar in the Diagrams Tab in the Options Dialog Box of the Tools Menu (the default setting is ON: display). Therefore, while increasing the program display density, the text in particularly long comments can be checked, thereby improving the readability of the program.</td>
</tr>
</tbody>
</table>

Improvements to Cross Reference Functions

Displaying/Printing Cross Reference Function Usage List with Comments

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The cross reference function usage list was displayed without comments.</td>
<td>The cross reference function usage list can be displayed with comments and the list can also be printed. Therefore, the user can check what the addresses mean when checking the number of times the addresses have been used. This thereby reduces the labor required for programming/debugging. This function can also be used to jump to the position of the rungs being used.</td>
</tr>
</tbody>
</table>

Displaying the Cross Reference Function Usage List for the Corresponding Address from the Ladder Screen

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The cross reference function only enabled the cross reference report to be selected from the display menu or a cross reference pop-up display to be selected from the display menu for the address at the cursor position.</td>
<td>By moving the cursor to an address in the ladder diagram and selecting Check usage including unused, the usage list (with comments) can be displayed starting with the selected address. This function enables the cross references to be checked for the address directly from the ladder display instead of from the cross reference report.</td>
</tr>
</tbody>
</table>
Printing Word Address Cross References

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing with cross reference information was possible for the cross references of output bits only (the rung number used by the output bit address was printed at the right of the coil).</td>
<td>Printing with cross reference information also includes the cross reference of the word address. Therefore, by viewing the printed program, information that is equivalent to that from the CX-Programmer’s cross reference function can be obtained even if a CX-Programmer is not onsite.</td>
</tr>
</tbody>
</table>

Improvements to Search Functions

Omitting Symbol Table from Search

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The search range included the ladder program and symbol table.</td>
<td>By deselecting Include symbol table, the search range includes the ladder program only. Therefore, unnecessary searches of symbol tables are omitted, thereby shortening the search time.</td>
</tr>
</tbody>
</table>

Specifying All the Search Targets

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search targets were split into addresses and comments, etc.</td>
<td>By selecting All (strings) as the search target, a search can be performed for all the search targets, including addresses, constants, numbers, mnemonics, symbol names, comments, rung comments, and other comments.</td>
</tr>
</tbody>
</table>

Mnemonic Function Code Input Not Required

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mnemonic searches required an asterisk * or parentheses () with function code inputs after the mnemonic search target.</td>
<td>Mnemonic searches do not require an asterisk * or parentheses () with function codes input after the mnemonic search target.</td>
</tr>
</tbody>
</table>

Improvements to Watch Window

Displaying PVs of Addresses in the Watch Window Sheet in Binary

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The PV for each address could be displayed in the specified data type only.</td>
<td>A new column has been added to the watch sheet that allows the PVs of addresses to always be displayed in binary regardless of the settings specified in Data Type/Format. 16 BIT (Binary, Channel) has also been added to the Data Type/Format Options, allowing values to be displayed in binary, even if the Binary column is hidden (except in the Timer/Counter Areas).</td>
</tr>
</tbody>
</table>
**Changing the PVs for DM/EM Areas in Bit Units**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PVs for DM/EM Area data could not be changed in bit units.</td>
<td>While online, when the binary display is selected in the <em>Set New Value</em> dialog that is displayed when the address in the watch window is clicked, the DM/EM Area data can be changed into PVs in bit units.</td>
</tr>
</tbody>
</table>

**Prevention of Leaving Set Forced Set/Reset Status**

**Checking the Forced Set/Reset Status when Changing from Online to Offline**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>After forced setting/resetting of a bit online, the forced set/reset status remained unchanged when online status was changed to offline status.</td>
<td>After forced setting/resetting of a bit online, a dialog box is displayed when status returns to offline to allow the forced set/reset status of addresses to be displayed. The forced set/reset status can also be cancelled. Enable this function by selecting <em>Tools – Options</em> and then selecting <em>Check forced status after online connection</em> in the PLCs Tab Page (the default setting is OFF: no confirmation). This function prevents going offline unprepared when the CPU Unit is still in forced set/reset status.</td>
</tr>
</tbody>
</table>

**Improvements to Printing Functions**

**Printing Ladder Programs as Shown on Screen**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder programs could not be printed as they were shown on the screen.</td>
<td>Sections of the ladder program can be printed separately as they are shown on the screen. Select to print the ladder screen in the page setting. The ladder screen can be printed as it is shown on the ladder screen. The program can also be printed at a smaller size (<em>Reduced size</em>), or a larger size (<em>Enlarged size</em>), instead of the standard size (<em>Normal size</em>).</td>
</tr>
</tbody>
</table>

**Improvements to Multi-interlock Display Functions**

**Displaying the Multi-interlock Status (CS/CJ-series CPU Unit Ver. 2.0 or Later)**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interlock instructions allowing nesting were not supported.</td>
<td>If the interlock instruction that allows nesting (multi interlock instruction) is used with a CS/CJ-series PLC Ver. 2.0 or later when performing online monitoring, the display will show which instruction segment is presently in interlock status using a tree-structure at the left of the ladder screen (multi-interlock map). By double-clicking the instruction in the multi-interlock map, the ladder view will jump to the display of the applicable rung.</td>
</tr>
</tbody>
</table>
CX-Net (CX-Server Network Configuration Tool)

- **Accessing up to Eight Network Levels (Set in the Routing Table)**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.3)</th>
<th>New version (Ver. 4.0)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINS commands could be used to access nodes up to three network levels away, including the local network.</td>
<td>If a CS/CJ-series PLC of Ver. 2.0 or later is used, FINS commands can be used to access nodes up to eight.</td>
</tr>
</tbody>
</table>
Version 3.3 Upgrade Information

The following tables outline the changes that have been made from version 3.2 to version 3.3 of the CX-Programmer.

- **CJ1M-CPU11/21 Support Added**

<table>
<thead>
<tr>
<th>Previous version (version 3.2)</th>
<th>New version (version 3.3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CJ1M-CPU11/21 was not supported.</td>
<td>The CJ1M-CPU11/21 is supported.</td>
</tr>
<tr>
<td></td>
<td>To use the CX-Programmer for the CJ1M-CPU11, set the Device Type to the CJ1M and the CPU Type to the CPU12. To use the CX-Programmer for the CJ1M-CPU21, set the Device Type to the CJ1M and the CPU Type to the CPU22.</td>
</tr>
</tbody>
</table>

Creating a CX-Programmer Project for the CJ1M-CPU11/21

1. On the initial CX-Programmer display, select **File – New** and then set the Device Type to the CJ1M in the Change PLC Dialog Box.

   ![Change PLC Dialog Box](image)

2. Click the **Settings** Button by the Device Type Field and set the CPU Type in the Device Type Settings Dialog Box as shown below.

   ![Device Type Settings Dialog Box](image)

   - **CJ1M-CPU11:** Set CPU12.
   - **CJ1M-CPU21:** Set CPU22.

Setting Table

<table>
<thead>
<tr>
<th>Item</th>
<th>CPU Unit Model</th>
<th>CJ1M-CPU11</th>
<th>CJ1M-CPU21</th>
</tr>
</thead>
<tbody>
<tr>
<td>CX-Programmer Ver. 3.3</td>
<td>Device Type</td>
<td>Set CJ1M</td>
<td>Set CPU12</td>
</tr>
<tr>
<td></td>
<td>CPU Type</td>
<td>Set CPU12</td>
<td>Set CPU22</td>
</tr>
</tbody>
</table>

There are some restrictions in using the CJ1M-CPU11/21 with the new version of CX-Programmer (version 3.3). These restrictions will be eliminated in the next version.
Function Restrictions when Using CX-Programmer Version 3.3 for the CJ1M-CPU11/21

<table>
<thead>
<tr>
<th>Restriction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program capacity: 5 Ksteps max.</td>
<td>Although the program capacity of the CJ1M-CPU12/22 is 10 Ksteps, the program capacity of the CJ1M-CPU11/21 is 5 Ksteps. A program containing more than 5 Ksteps can be written offline, but an error will occur when it is transferred. An error will also occur if a program transferred automatically when power is turned ON is larger than 5 Ksteps.</td>
</tr>
<tr>
<td>Subroutine numbers for subroutine instructions (SBS, GSBS, and MCR0): 0 to 255 only</td>
<td>Although the subroutine numbers for the CJ1M-CPU12/22 are 0 to 1023, the subroutine numbers for the CJ1M-CPU11/21 are 0 to 255. A program containing subroutine numbers higher than 255 can be written and can be transferred, but an error will occur when the program is executed.</td>
</tr>
<tr>
<td>Jump numbers for jump instructions (JMP, CJP, and CJPN): 0 to 255 only</td>
<td>Although the jump numbers for the CJ1M-CPU12/22 are 0 to 1023, the jump numbers for the CJ1M-CPU11/21 are 0 to 255. A program containing jump numbers higher than 255 can be written and can be transferred, but an error will occur when the program is executed.</td>
</tr>
<tr>
<td>Use only 1 scheduled interrupt.</td>
<td>Although the CJ1M-CPU12/22 support 2 scheduled interrupts, the CJ1M-CPU11/21 support only 1. Thus, only scheduled interrupt 0 can be used with the interrupt instructions (MSKR, CLI, and MSKR). A program containing schedule interrupt 1 can be written and can be transferred, but an error will occur when the program is executed.</td>
</tr>
<tr>
<td>Use only 1 PWM output.</td>
<td>Although the CJ1M-CPU12/22 support 2 PWM outputs, the CJ1M-CPU11/21 support only 1. Thus, only PWM output 0 can be used with the PWM instruction. A program containing PWM output 1 can be written and can be transferred, but an error will occur when the program is executed.</td>
</tr>
</tbody>
</table>

Note: The Stop CPU on Instruction Error Option in the PLC Setup can be selected to stop program execution by creating a fatal error when an instruction error is detected. Instruction errors include instruction processing errors (the ER Flag will turn ON), DM/EM indirect addressing BCD errors, and illegal access errors. This option can be used to check to see if instruction errors are occurring in unexpected places in the program.
Version 3.2 Upgrade Information

The following tables outline the changes that have been made from version 3.1 to version 3.2 of the CX-Programmer.

- **New Models for Automatically Set Data Links**

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>With automatically set data links, all nodes shared the same data using the common settings, i.e., the send size for each node was the same, and send/receive nodes were always in the order of node addresses.</td>
<td>With automatically set data links for Controller Link Networks, 1:N allocations are supported in which data communications are set individually for the master node and slave nodes. (The models that support this functionality are listed below.)</td>
</tr>
<tr>
<td>Any of the following four settings (data link patterns) can be used for automatic data links. Equality layout (previous method), common type, 1 to 1 type, or chain type</td>
<td>Applicable models: CS1W-CLK21-V1, 3G8F7-CLK21-EV1, CS1W-CLK12-V1, 3G8F7-CLK12-EV1, CS1W-CLK52-V1, 3G8F7-CLK52-EV1, CJ1W-CLK21-V1</td>
</tr>
<tr>
<td>Note: The 1:N allocations for automatic data links cannot be used with any other models. Refer to the Controller Link Operation Manual for details.</td>
<td></td>
</tr>
</tbody>
</table>

- **Automatic Setting Procedure for Controller Link Networks**

1. Go online with the PLC that is to be used as the polling node.

2. Select **Data Link – Setup** from the CX-Net. If on the local network (i.e., if the network address is 0), select **Controller Link** and click the OK Button. The Data Link Component Dialog Box will be displayed.

3. Select **Automatic Datalink Setup** from the Online Menu. Select **Controller Link** and click the OK Button. The **Automatic Datalink** Dialog Box will be displayed.

4. In the **Automatic Datalink Type** Box, select **Equality layout**, **Common type**, **1 to 1 type**, or **Chain type** and set the automatic data link areas as shown below.

- **Equality Layout (Previous Method)**

This is the previous automatic data link type where all nodes are allocated the same sizes of data links.

### Settings Common to All Automatic Data Link Types

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description of function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Generation Type</td>
<td>Select <strong>Automatic</strong>. (If Manual is selected, data links will be run using data link tables set separately.)</td>
</tr>
<tr>
<td>B</td>
<td>Power Up Run State</td>
<td>Select <strong>Start</strong> to automatically start data links when power is turned ON to the PLC.</td>
</tr>
<tr>
<td>C</td>
<td>Close</td>
<td>Closes the Automatic Datalink Dialog Box.</td>
</tr>
<tr>
<td>D</td>
<td>Read</td>
<td>Reads the settings from the PLC.</td>
</tr>
<tr>
<td>E</td>
<td>Write</td>
<td>Writes the settings to the PLC. (If the Power Up Run State is set to Start, the data links will start running when the settings are written to the PLC.)</td>
</tr>
<tr>
<td>F</td>
<td>Help</td>
<td>Displays help.</td>
</tr>
<tr>
<td>G</td>
<td>Automatic Datalink Type</td>
<td>Select the type of data links to be automatically set up from the following. Equality Layout (Previous method), Common Type (1:N settings), 1 to 1 Type (1:N settings), Chain Type (1:N settings)</td>
</tr>
<tr>
<td>H</td>
<td>Result</td>
<td>The status is displayed when the Read or Write Button is clicked.</td>
</tr>
</tbody>
</table>
Equality Layout Settings

<table>
<thead>
<tr>
<th>No.</th>
<th>Item Description of function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Area and Start Word for Area 1 Set the area and the start data link word to use for area 1.</td>
</tr>
<tr>
<td>2</td>
<td>Size of Area 1 Set the send size per node for area 1.</td>
</tr>
<tr>
<td>3</td>
<td>Area and Start Word for Area 2 Set the area and the start data link word to use for area 2.</td>
</tr>
<tr>
<td>4</td>
<td>Size of Area 2 Set the send size per node for area 2.</td>
</tr>
<tr>
<td>5</td>
<td>Nodes Set the nodes to participate in the data links.</td>
</tr>
<tr>
<td>6</td>
<td>Status start word Set the first word to store data link status. (If 0 words is set, the default area will be used.)</td>
</tr>
</tbody>
</table>

Features of Equality Layout
- The send data sizes is the same for all nodes for each area.
- Area 1 is selected from the bit-access areas (e.g., CIO Area) and area 2 is selected from word-access areas (e.g., DM Area).
- Data link areas are allocated in ascending order of node addresses.
- Data link participation can be specified for each node.
- The same data link areas are shared by all nodes participating in the data links.

Common Type Settings

<table>
<thead>
<tr>
<th>No.</th>
<th>Item Description of function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Area and Start Word for Area 1 Set the area and the start data link word to use for area 1.</td>
</tr>
<tr>
<td>2</td>
<td>Master size Set the area 1 send size for the master node.</td>
</tr>
<tr>
<td>3</td>
<td>Slave size Set the area 1 send size for the slave node.</td>
</tr>
<tr>
<td>4</td>
<td>Area and Start Word for Area 2 Set the area and the start data link word to use for area 2.</td>
</tr>
<tr>
<td>5</td>
<td>Master size Set the area 2 send size for the master node.</td>
</tr>
<tr>
<td>6</td>
<td>Slave size Set the area 2 send size for the slave node.</td>
</tr>
<tr>
<td>7</td>
<td>Nodes Set the nodes to participate in the data links.</td>
</tr>
<tr>
<td>8</td>
<td>Status start word Set the first word to store data link status. (If 0 words is set, the default area will be used.)</td>
</tr>
</tbody>
</table>

Features of Common Type 1:N Allocation
- Data communications are 1:1 between the master node and slave nodes.
- All slave nodes receive the data sent by the master node.
- The master node receives all data sent by the slaves. The reception size for the master node is thus the node send data size times the number of slave nodes.
- Slaves do not send or receive data with other slaves.
- Area 1 is selected from the bit-access areas (e.g., CIO Area) and area 2 is selected from word-access areas (e.g., DM Area).
- Data link areas are allocated in ascending order of node addresses.
- Data link participation can be specified for each node.
- The same area classification can be used for both Area 1 and Area 2, provided that the same addresses are not used (CS/CJ-series Controller Link Units with unit Ver. 1.2 or later).
• **1 to 1 Type**

**Features of 1 to 1 Type 1:N Allocation**
- Data communications are 1:1 between the master node and slave nodes.
- All slave nodes receive part of the data sent by the master node. In addition, each slave node receives unique data from the master node (see a to d in figure).
- The master node receives all data sent by the slaves. The data sizes are fixed for all nodes.
- Slaves do not send or receive data with other slaves.
- One area is selected from the bit-access areas (e.g., CIO Area) or word-access areas (e.g., DM Area).
- Data link areas are allocated in ascending order of node addresses.
- Data link participation can be specified for each node.

### Chain Type Settings

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description of function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Link Area and Start Word</td>
<td>Set the area and start data link word.</td>
</tr>
<tr>
<td>2</td>
<td>Master, Common Send Words</td>
<td>Set the send size of the data to send from the master node to all slave nodes. The same size of data is sent to all nodes.</td>
</tr>
<tr>
<td>3</td>
<td>Master, Individual Send Words</td>
<td>Set the send size for the master node to send individually to each slave node.</td>
</tr>
<tr>
<td>4</td>
<td>Slave, Send Words</td>
<td>Set the send size of the data sent from each slave node to the master node.</td>
</tr>
<tr>
<td>5</td>
<td>Nodes</td>
<td>Set the nodes participating in the data links.</td>
</tr>
<tr>
<td>6</td>
<td>Status start word</td>
<td>Set the start word to store data link status. (If 0 words is set, the default area will be used.)</td>
</tr>
</tbody>
</table>

### 1 to 1 Type Settings

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description of function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Link Area and Start Word</td>
<td>Set the area and start data link word.</td>
</tr>
<tr>
<td>2</td>
<td>Master, Common Send Words</td>
<td>Set the send size of the data to send from the master node to all slave nodes. The same size of data is sent to all nodes.</td>
</tr>
<tr>
<td>3</td>
<td>Master, Individual Send Words</td>
<td>Set the send size for the master node to send individually to each slave node.</td>
</tr>
<tr>
<td>4</td>
<td>Slave, Send Words</td>
<td>Set the send size of the data sent from each slave node to the master node.</td>
</tr>
<tr>
<td>5</td>
<td>Nodes</td>
<td>Set the nodes participating in the data links.</td>
</tr>
<tr>
<td>6</td>
<td>Status start word</td>
<td>Set the start word to store data link status. (If 0 words is set, the default area will be used.)</td>
</tr>
</tbody>
</table>
Features of Chain Type 1:N Allocation
- Data communications are 1:1 between the master node and slave nodes.
- All slave nodes receive part of the data sent by the master node (1a in figure).
- The master node receives all data sent by the slaves. The data sizes are fixed for all nodes.
- Each slave node receives data from the previous node and then sends data to the next node. Data is thus passed in ascending order of the nodes participating in the data link.
- One area is selected from the bit-access areas (e.g., CIO Area) or word-access areas (e.g., DM Area).
- Data link areas are allocated in ascending order of node addresses.
- Data link participation can be specified for each node.

5. Click the Write Button to transfer the automatic data link setting.

- Adding Nodes while Data Links Are Running

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data link tables could not be downloaded when data link were running.</td>
<td>Nodes can be added while data links are running if both the following Units/Boards and Repeater Units (CS1W-RPT01) are used.</td>
</tr>
<tr>
<td>Applicable Controller Link Units models:</td>
<td>Controller Support Boards</td>
</tr>
<tr>
<td>• CS1W-CLK21-V1</td>
<td>• 3G8F7-CLK21-V1 (-EV1)</td>
</tr>
<tr>
<td>• CS1W-CLK12-V1</td>
<td>• 3G8F7-CLK12-V1 (-EV1)</td>
</tr>
<tr>
<td>• CS1W-CLK52-V1</td>
<td>• 3G8F7-CLK52-V1 (-EV1)</td>
</tr>
<tr>
<td>• CJ1W-CLK21-V1</td>
<td></td>
</tr>
<tr>
<td>Note: Refer to the Controller Link Operation Manual for the procedure to add nodes and details on changing data link tables while data links are running.</td>
<td></td>
</tr>
</tbody>
</table>

- Up to 62 Nodes for Wired Controller Link Units

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only a maximum of 32 nodes could be used with Wired Controller Link Units.</td>
<td>A maximum of 62 nodes can now be used with Wired Controller Link Units.</td>
</tr>
<tr>
<td>Applicable models:</td>
<td></td>
</tr>
<tr>
<td>• CS1W-CLK21-V1</td>
<td>• CS1W-CLK21-V1</td>
</tr>
<tr>
<td>• CJ1W-CLK21-V1</td>
<td>• CJ1W-CLK21-V1</td>
</tr>
<tr>
<td>• 3G8F7-CLK21-V1 (-EV1)</td>
<td>• 3G8F7-CLK21-V1 (-EV1)</td>
</tr>
<tr>
<td>Note: A CS1W-RPT01 Repeater Unit must be purchased separately to use 62 Controller Link Units. Refer to the Controller Link Operation Manual for details.</td>
<td></td>
</tr>
</tbody>
</table>

- Displaying Data Link Table Information for Data Link Table Verification

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data link table verification results were displayed in a simple list in an Error List Dialog Box.</td>
<td>When inconsistencies are detected in data link verification, the number of inconsistent (failed) nodes is displayed, and both the data link settings within the selected PLC and those with the inconsistencies indicated between pointed parentheses (&lt;&gt;). (The size of the dialog box can be changed.) Also, if reading is not possible for verification, the reasons are displayed. The results can be pasted as text after clicking a Copy Button.</td>
</tr>
</tbody>
</table>

- 100Base-TX for Ethernet Units

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only 10Base-T and 10Base-5 were supported in Unit settings (CPU Bus Unit setups).</td>
<td>100Base-TX is also supported for Ethernet Unit in the Unit settings (CPU Bus Unit setups).</td>
</tr>
<tr>
<td>Applicable models: CS1W-ETN21, CJ1W-ETN21</td>
<td></td>
</tr>
</tbody>
</table>
## Importing DM/EM Data Files from Previous Support Software

<table>
<thead>
<tr>
<th>Previous version (version 3.1)</th>
<th>New version (version 3.2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM/EM data files created with the SYMAMC Support Software (SSS) or CV Support Software (CVSS) could not be imported from the PLC Memory Window. (Importing was possible only from the File Menu or the File Conversion Utility.)</td>
<td>DM/EM data files created with the SYMAMC Support Software (SSS) or CV Support Software (CVSS) can be imported from the PLC Memory Window. The following DM/EM data files can be imported.</td>
</tr>
<tr>
<td>Support Software</td>
<td>DM/EM data file type (file name extension)</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>SSS</td>
<td>.SP6</td>
</tr>
<tr>
<td></td>
<td>.SL4</td>
</tr>
<tr>
<td>CVSS</td>
<td>.DMD</td>
</tr>
<tr>
<td></td>
<td>.EDM</td>
</tr>
<tr>
<td></td>
<td>.IOM</td>
</tr>
<tr>
<td></td>
<td>.IOM</td>
</tr>
</tbody>
</table>
Version 3.1 Upgrade Information

The following tables outline the changes that have been made from version 3.0 to version 3.1 of the CX-Programmer.

**Program Editing Functions**

### Improvements to Global Replacement Operation

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes between normally open contacts and normally closed contacts could be performed only with the / key. They could not be performed globally.</td>
<td>If Change All is selected from the Edit menu and a checkmark is placed in the checkbox for Invert open/close bit before performing a global replacement for the PLC, all specified operands that are normally open contacts will be changed to normally closed contacts and all normally closed contacts will be changed to normally open contacts.</td>
</tr>
<tr>
<td>Global replacements for addresses applied to both the ladder programs and symbol data.</td>
<td>If the check box for symbols (including I/O comments) is cleared before an address is replaced globally, the symbols table and I/O comments will not be changed and only addresses in the ladder program will be changed.</td>
</tr>
<tr>
<td></td>
<td>If the check box for symbols (including I/O comments) is selected before an address is replaced globally, the replacement operation will be the same as the previous version.</td>
</tr>
</tbody>
</table>

### Drawing or Deleting a Connecting Line by Dragging from the Start Point to the End Point

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting lines could be input from the keyboard, icons, or menus. (They could not be input by dragging with the mouse.)</td>
<td>Connecting lines can be drawn by clicking the Line Connect Mode icon and then clicking the starting point and dragging to the end point. Connecting lines can also be deleted by dragging after clicking the Line Delete Mode icon.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A line can also be drawn by dragging on a line that is not connected on one end.</td>
</tr>
</tbody>
</table>

### Operand at the Cursor Position Appears as Default for Find or Replace Operations

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When performing a Find or Replace operation, the previous contents of the previous Find and Replace fields are displayed regardless of the position of the cursor.</td>
<td>When a Find or Replace operation is performed, the Bit Addresses, Addresses, Values, Symbol Names, or Mnemonics (i.e., in the Look at field for each) at the position of the cursor is displayed in the Find what field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the Look at field is a Symbol comments or Program comments, the Find what field will be blank.</td>
</tr>
</tbody>
</table>

### History of Previous Find or Replace Settings

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No history of previous settings was displayed for Find or Replace operations.</td>
<td>Histories of previous find and replace settings are displayed in pull-down menus for the Find what field and Replace with field</td>
</tr>
</tbody>
</table>

### Size Changes for Go to Commented Rung Window

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The size of the Go to Commented Rung window was fixed when jumping to rung comments. (This window was previously a dialog box.)</td>
<td>The size of the Go to Commented Rung window displayed when Edit</td>
</tr>
</tbody>
</table>
Guidance Displays for SYSMAC Support Software or SYSWIN Shortcut Keys

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortcut keys could be allocated for CX-Programmer functions for SYSMAC Support Software operations and SYSWIN operations, but guidance could not be displayed.</td>
<td>Guidance can be displayed for CX-Programmer functions for SYSMAC Support Software operations and SYSWIN operations by selecting Function Key Guidance from the View menu. The CX-Programmer shortcut key allocations for all keys can be displayed by selecting Information Window from the View menu.</td>
</tr>
</tbody>
</table>

- **Online Functions**

- **Monitor Functions**

**Display Form Setting for Operands for Special Instructions when Monitoring in Ladder Section Windows**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
</table>
| When monitoring on the Ladder Section window, the symbol data type was given priority as the display format for operands for special instructions. For example, the data type for the MOV instruction is CHANNEL, so the display was always 4-digit hexadecimal. The data type for MOVL is also CHANNEL so the display was always 8-digit hexadecimal. Also, for an unnamed symbol the data type is CHANNEL so the display was always 4-digit hexadecimal. | The display format for the present values of operands of special instructions when monitoring on the Ladder Section Window can be selected from the following data types. The same display format must be used globally. To select the display format, click the desired button or select Monitoring Data Type from the View menu. If none of the above display formats is selected, the default display formats will be as follows:
  - **Named symbol** will be monitored in the symbol data type.
  - **Unnamed symbol** will be monitored in the operand data type.
  - **Two-word operations**, such as for the MOVL instruction, will be monitored in 2-word hexadecimal.
  - For present values displayed in formats other than hexadecimal, “D” is attached for 2-word data and “L” is attached for 4-word data. |

**Improvement in Operation to Change PVs for Special Instructions**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Present values were changed from the menus.</td>
<td>Present values can be changed by pressing the Enter key on an operand that is being monitored, or by double-clicking it.</td>
</tr>
</tbody>
</table>

**Start Address Setting when Monitoring Present Values in I/O Memory**

(Continuous Address Monitoring)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The address to monitor in the PLC Memory Window could not be specified (either the screen had to be scrolled or individual addresses had to be monitored in Watch windows). Also, with floating-point or double-precision floating-point binary, monitoring was possible only from addresses divisible by 2 or 4.</td>
<td>The start address to be monitored can be specified to monitor consecutive addresses in the PLC Memory Window.</td>
</tr>
</tbody>
</table>
Monitoring Bit Status and Word Contents when Monitoring Present Values in I/O Memory

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit status displays in the PLC Memory Window had to be performed in word units.</td>
<td>When the binary word display format is selected for the PLC Memory Window, bit status is displayed both for individual bits and as hexadecimal word values.</td>
</tr>
</tbody>
</table>

Simple Transfer of Data to the PLC when Monitoring Present Values in I/O Memory

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>To transfer data changed in I/O memory while monitoring, the monitor status had to be cleared and then PLC</td>
<td>Individual cells being monitored in the PLC Memory Window can be selected and the Set Value command or the Set Value button can be used to display the Set Present Value dialog box. Data can be input into this dialog box for individual I/O memory address and then the OK Button can be clicked to directly change the value in the PLC. When binary values are being displayed, the menus and buttons can be used to Set, Reset, Force On, Force Off, or Force Cancel individual bits.</td>
</tr>
<tr>
<td>To PLC had to be selected, the range specified, and the transfer specified in the PLC Memory Window.</td>
<td></td>
</tr>
</tbody>
</table>

• Clear All Memory Areas Function

All Clear Operation for CPU Unit Memory (User Program, Parameter Area, and I/O Memory)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unless a memory error actually occurred in the PLC the CPU Unit memory clear operation (see note) could not be performed from the Error Log. Also there was no function (all clear) to initialize the CPU Unit memory. Note: The CX-Programmer had to be placed online, PLC</td>
<td>The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to initialize the CPU Unit by selecting Clear All Memory Areas from the CX-Programmer's PLC menu or selecting Clear All Memory Areas from the Options menu of the PLC Errors dialog box. These operations are possible even if a memory error has not occurred in the PLC (the same as they are for a Programming Console).</td>
</tr>
<tr>
<td>Edit Error Log had to be selected to display the Errors window, and then the Clear All Button had to be clicked.</td>
<td></td>
</tr>
</tbody>
</table>

• On-line Editing

Power Flow Monitoring during Online Editing

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power flow could not be monitored during online editing.</td>
<td>The power flow is displayed during online editing in monitoring status.</td>
</tr>
</tbody>
</table>

I/O Comment Changes during Online Editing

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes to I/O comments made during online editing could not be saved in the CPU Unit (see note). If changes were made, the symbol table file had to be transferred to file memory in a CS-, CJ-, CVM1, or CV-series PLC or to the I/O comment area in UM (user memory) in a C-series PLC. Note: New I/O comments could be added to the symbol table in CX-Programmer.</td>
<td>I/O comments can be changed during online editing in Ladder diagram view, in the Symbol Table, or in I/O Comment View. If I/O comments have been changed when online editing is ended, a confirmation message will appear asking if the symbol table file should be transferred to file memory in a CS-, CJ-, CVM1, or CV-series PLC or to the I/O comment area in the allocated UM (user memory) in a C-series PLC. <strong>Note 1:</strong> Symbol table names and addresses cannot be changed during online editing. <strong>Note 2:</strong> I/O comments with symbol names cannot be transferred to the I/O comment area in UM (User Memory) in C-series PLCs.</td>
</tr>
</tbody>
</table>
• Verification

Program Verification Offline or Online

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program verification was possible only between the current project and the PLC.</td>
<td>Program verification is possible offline between the current project and a closed project file. (Select Compare Program from the File menu and select the file to be compared.) The results of verification can be saved to a file in CSV format.</td>
</tr>
<tr>
<td>Added or omitted instructions were not displayed in verification results (if added or omitted instructions were encountered, the verification results for the rest of the program would show that the programs were completely different).</td>
<td>Verification results are displayed by section and mnemonic, including added or omitted instructions. Jumping is also possible from mnemonic verification results to the corresponding locations in ladder view.</td>
</tr>
</tbody>
</table>

Displaying Dialog Box for Verification or Transfer when Going Online

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nothing was displayed before going online.</td>
<td>If a checkmark is placed in the Prohibit the online operations until the PC and PLC data matches checkbox on the PLCs Tab Page that appears when Tools / Options is selected, an Online Action Dialog Box to select either verifying or transferring data will be displayed. Depending on the selection, before going online, the program will be verified between the CX-Programmer and the PLC, the program will be transferred to the PLC, or the program will be transferred from the PLC.</td>
</tr>
</tbody>
</table>

• Unit Online Replacement

Unit Online Replacement for CS1D or CVM1D PLCs

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit online replacement for CS1D or CVM1D CPU Units was possible only from a Programming Console and was not possible from the CX-Programmer. (C2000H I/O Unit online replacement was possible.)</td>
<td>With a CS1D or CVM1D CPU Unit, hot swapping (i.e., online replacement) is possible during operation for Basic I/O Units and, for the CS1D, Special I/O Units and CPU Bus Units as well. Open the I/O tables for the project, select the Unit to be replaced, and select Hot Swap from the Options menu. Click the Start Hot Swap Button, remove the old Unit, mount the new Unit and click the End Hot Swap Button. Perform this operation for each Unit to be replaced. Note: Online replacement is possible for a CS1D or CVM1D CPU Unit in any operating mode. Use the following settings in the Change PLC Dialog Box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CPU Unit being used</th>
<th>PLC type selection list</th>
<th>CPU Unit model</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS1D</td>
<td>CS1H-H</td>
<td>CPU65 or CPU67</td>
</tr>
<tr>
<td>CVM1D</td>
<td>CVM1-V2</td>
<td>CPU21</td>
</tr>
</tbody>
</table>
• **I/O Table Editing Functions**

**Specifying Slot Start Address when Editing I/O Tables for Slots Other than First Rack Slots**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>For CS- and CJ-series PLCs, the start address for each Rack could be set (but the start address could not be set for each slot).</td>
<td>For CS1-H, CJ1-H, CJ1M, and CS1D CPU Units in the CS- and CJ-series PLCs, Options</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When editing I/O tables, unit number, number of allocated unit numbers, number of input words, number of output words had to be set for Special I/O Units and CPU Bus Units, and the unit numbers and number of allocated unit numbers were displayed in the I/O Table window, but the number of input words and the number of output words were not displayed in the I/O Table window.</td>
<td>When editing I/O tables, the number of input words and number of output words are displayed in the I/O Table window for Special I/O Units and CPU Bus Units that have been set (Out: , In: ).</td>
</tr>
</tbody>
</table>

• **Other Changes**

**Data Transfer and Verification for a ROM Writer**

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
</table>
| Transfer and verification were not possible for a ROM Writer. | With the C-series PLCs, any of the following methods can be used for data transfer and verification with a ROM Writer.  
- Using the CX-Programmer, transfer the program from the computer to the ROM Writer.  
- Transfer program from the ROM Writer to a CX-Programmer project.  
- Verify programs between CX-Programmer and ROM Writer.  
- Create Intel Hex format files from CX-Programmer programs.  
- Input from an Intel Hex format file to the CX-Programmer project.  
**Note:** The data transferred for each PLC is listed below. |

<table>
<thead>
<tr>
<th>PLC</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1000H/2000H</td>
<td>Program, I/O tables, Sysmac NET data link tables, battery error detection method</td>
</tr>
<tr>
<td>C200H</td>
<td>Program, I/O tables, Fixed DM, battery error detection method</td>
</tr>
<tr>
<td>C200HS</td>
<td>Program, I/O tables, PLC Setup, Expansion DM, expansion instructions</td>
</tr>
<tr>
<td>CQM1, CQM1H</td>
<td>Program, PLC Setup, expansion instructions</td>
</tr>
<tr>
<td>C200HX/HG/HE (-Z)</td>
<td>Program, I/O tables, PLC Setup, Expansion DM, expansion instructions</td>
</tr>
</tbody>
</table>
# CX-Net (Network Configuration) Functions

## CX-Net

### Menus Changed

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit Status and Communications Unit Setup were on the PLC menu.</td>
<td>Operations for Communication units were separated from those for the PLCs and Unit Status/Error Log and Communications Unit Setup were moved to the Network menu.</td>
</tr>
<tr>
<td>Both Setup and Edit appeared on the Routing Tables and Data Link menus.</td>
<td>Setup and Edit were placed together on a Setup menu on the Routing Tables and Data Link menus. When Setup is selected online, the Routing Table or Data Link Component window is displayed. When Setup is selected offline, a dialog box with the following selections is displayed before the Routing Table or Data Link Component window is displayed. Routing tables: FINS Local, FINS Network, or SYSMAC NET Data links tables: Controller Link, SYSMAC LINK, SYSMAC NET</td>
</tr>
</tbody>
</table>

### Exporting Communications Unit Status and Error Log in CSV Format

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit status and the error log can be monitored in a window but cannot be saved as files. (The error log data must be read and then manipulated manually.)</td>
<td>Unit status and error log data for Communications Units (Controller Link Units and SYSMAC LINK Units) can be written to files in CSV format. This allows network errors to be analyzed from CSV files.</td>
</tr>
</tbody>
</table>

### Displaying Communications Unit Error Logs for C-series PLCs

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>For C-series PLCs, the error log displayed when PLC</td>
<td>Unit Status was selected was the CPU Unit error log. (A Communications Unit error log could not be read or cleared.)</td>
</tr>
</tbody>
</table>

### Save As Operation for CX-Net Projects

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>An open project could not be saved under a new file name. (The file name could be set only when a new project was created.</td>
<td>Select Save As from the Project menu to save a project open in CX-Net under any desired name.</td>
</tr>
</tbody>
</table>
• Data Links

Changes in Edit Node Window for Manually Set Data Link Tables

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the Edit Node window for manually set data link tables, the start and end address for</td>
<td>In the Edit Node window for manually set data link tables, the start address, end</td>
</tr>
<tr>
<td>refreshing (send and receive) with other nodes were displayed only for the local node.</td>
<td>address, and data size for refreshing (send and receive) with other nodes are</td>
</tr>
<tr>
<td></td>
<td>displayed for both the local node and the remote (partner) nodes.</td>
</tr>
<tr>
<td>Area 1 and area 2 could not be accessed simultaneously for manually set data link tables</td>
<td>Area 1 and area 2 can be accessed side-by-side for manually set data link tables in</td>
</tr>
<tr>
<td>in the Edit Node window.</td>
<td>the Edit Node window.</td>
</tr>
<tr>
<td>With manually set data link tables in the Edit Node window, an Area Specify dialog box</td>
<td>With manually set data link tables in the Edit Node window, values can be keyed</td>
</tr>
<tr>
<td>must be displayed to input values.</td>
<td>directly into the tables.</td>
</tr>
<tr>
<td></td>
<td>Also, a function bar that can be used to input values is displayed below with</td>
</tr>
<tr>
<td></td>
<td>window.</td>
</tr>
</tbody>
</table>

Reading and Writing Manually Set Data Link Tables in CSV Format

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data link tables could be read and written only as data link table files (binary files).</td>
<td>Manually set data link table can be read and written as CSV-format files.</td>
</tr>
<tr>
<td>Note: CSV-format files are created using the Excel template stored in the CD.</td>
<td></td>
</tr>
</tbody>
</table>

• Routing Tables

Registering CPU Unit Serial Ports (Peripheral and RS-232C) in a Local Network Table (Serial Expansion Routing Tables)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only the unit number and network address were set in the local network table in the routing</td>
<td>A CS/CJ-series CPU Unit serial port (peripheral or RS-232C) can be set in the local</td>
</tr>
<tr>
<td>tables for Communications Units.</td>
<td>network table in the routing tables instead of the Communications Unit’s unit number.</td>
</tr>
<tr>
<td></td>
<td>(Unit 252 (COMM) and Unit 253 (PRPHL))</td>
</tr>
<tr>
<td></td>
<td>This enables screen data to be sent from the NS-Designer (Ver. 3) via a network to</td>
</tr>
<tr>
<td></td>
<td>an NS-series PT connected to a serial port.</td>
</tr>
<tr>
<td></td>
<td>Refer to the PT user’s manual for details.</td>
</tr>
</tbody>
</table>

No Network Type Setting or Display for Routing Tables

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>When the local network table in the routing tables were set, the local network type and</td>
<td>The local network type is not set in the local network table in the routing tables for</td>
</tr>
<tr>
<td>the network type were displayed on the main view.</td>
<td>CS-, CJ-, and CV-series PLCs and the network type is not displayed on the main view.</td>
</tr>
</tbody>
</table>

Changes in Routing Table Operation

(Transferring Routing Tables from the Table View Tab Page)

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing table transfers and similar operations could not be performed from the Table View</td>
<td>Node changes, routing table transfers, and other operations are possible from the</td>
</tr>
<tr>
<td>tab page. (The OK button had to be clicked to return to the Main View tab page first.)</td>
<td>Table View tab page.</td>
</tr>
</tbody>
</table>
Detailed Information Displays when Verifying Routing Tables

<table>
<thead>
<tr>
<th>Previous version (Ver. 3.0)</th>
<th>New version (Ver. 3.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details were not displayed when verifying routing tables, making it difficult to find errors.</td>
<td>Detailed results are displayed after verifying routing tables.</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

Precautions............................................................................................................................................... vii

CHAPTER 1 Technical Specifications................................................................................................. 1
  CX-Programmer Software....................................................................................................................... 1
  About this Manual................................................................................................................................. 1
  CX-Programmer Features...................................................................................................................... 1
  System Requirements............................................................................................................................ 3
  Installing and Uninstalling the Software............................................................................................... 5
  Uninstalling the CX-Programmer.......................................................................................................... 13
  Uninstalling the CX-Server.................................................................................................................... 14
  Help and How to Access it..................................................................................................................... 17
  Technical Support............................................................................................................................... 18

CHAPTER 2 Quick Start Guide ............................................................................................................. 21
  Starting CX-Programmer...................................................................................................................... 21
  Licensing............................................................................................................................................. 21
  Introducing CX-Programmer Projects.................................................................................................. 22
  The CX-Programmer Environment...................................................................................................... 22
  Using CX-Programmer.......................................................................................................................... 28
  Summary............................................................................................................................................. 39

CHAPTER 3 Project Reference .............................................................................................................. 41
  Project Workspace................................................................................................................................ 41
  Program Sections.................................................................................................................................. 41
  Cross-Reference Report......................................................................................................................... 44
  Address Reference Tool......................................................................................................................... 45
  Output Window................................................................................................................................... 46
  Watch Window.................................................................................................................................... 46
  Options and Preferences....................................................................................................................... 48
  Finding and Replacing........................................................................................................................... 55
  Properties............................................................................................................................................ 60
  Using Microsoft Windows Features in CX-Programmer....................................................................... 61

CHAPTER 4 Reference ............................................................................................................................ 71
  PLCs and Projects................................................................................................................................. 71
  Symbols............................................................................................................................................... 72
  Program Editing.................................................................................................................................. 82
  Memory View....................................................................................................................................... 94
  Mnemonic Program Editing.................................................................................................................. 95
  Simulation............................................................................................................................................ 96
  Working On-line.................................................................................................................................. 97
  Flash ROM Backup.............................................................................................................................. 110
  Data Trace/Time Chart Monitoring..................................................................................................... 111
  CX-Net Network Configuration Tool.................................................................................................. 111
  IO Table............................................................................................................................................. 112

CHAPTER 5 Advanced Topics............................................................................................................... 113
  Writing More Maintainable Programs............................................................................................... 113
  Copying Information between Projects............................................................................................. 113
  Using CX-Programmer with Other Applications............................................................................... 114
  Converting Programs between PLC Types.......................................................................................... 117
  Applying a Password to the PLC Programs....................................................................................... 117

CHAPTER 6 Converting a C500/C120/C**P Program to CS/CJ/CP/CVM1 Format............................. 119
  C500/C120/C**P Program Conversion............................................................................................... 119
  C500/C120/C**P Program Backup...................................................................................................... 120
  Conversion Table for C500/C120/C**P Instructions.......................................................................... 121
CHAPTER 1
Technical Specifications

This chapter describes the CX-Programmer software in general terms and provides details of the operating environment and minimum configuration necessary for the satisfactory operation of CX-Programmer.

CX-Programmer Software

CX-Programmer is a PLC programming tool for the creation, testing and maintenance of programs associated with OMRON CS/CJ/CP-series PLCs, CV-series PLCs and C-series PLCs. It provides facilities for the support of PLC device and address information and for communications with OMRON PLCs and their supported network types.

CX-Programmer operates on IBM compatible personal computers with Pentium or better central processors, including Pentium II. It runs in a Microsoft Windows environment (Microsoft Windows 95, 98, Millennium, 2000, XP, NT4.0 with Service Pack 5 or later, or Vista).

About this Manual

This User Manual acts as a reference for CX-Programmer by describing its various concepts and abilities, and by leading the user through the basics of CX-Programmer programming. It also provides a detailed reference for all of the CX-Programmer functions.

Separate OMRON manuals describe the PLC programming structure and instruction set in detail. A separate OMRON manual describes the common features to PLC programming used by software other than CX-Programmer.

CX-Programmer comes with a context sensitive on-line help system which is designed to complement this manual and to provide a quick reference at any point while using CX-Programmer when the manual is not to hand. This general help system uses a fast ‘hypertext system’ which allows progressively more information about any topic to be obtained by selecting keywords within the descriptive text.

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows, and knows how to:

♦ Use the keyboard and mouse.
♦ Select options from Microsoft Windows menus.
♦ Operate dialog boxes.
♦ Locate, open and save data files.
♦ Edit, cut and paste text.
♦ Use the Microsoft Windows desktop environment.

If Microsoft Windows has not been used before, it is recommended that the reader spends some time working with it using the Microsoft documentation before using CX-Programmer.

This manual also assumes that a working knowledge of OMRON PLC devices has been obtained.

CX-Programmer Features

CX-Programmer is a support tool for the programming of OMRON PLCs and for maintenance of their device settings. It supersedes the OMRON applications SYSWIN and SYSMAC-CPT.

The following list describes important features that were present in CX-Programmer 2.1.

♦ Support for new PLCs – Full support has been added for the, CS1G-H, CS1H-H and CJ1G, CJ1G-H, CJ1H-H series PLCs and the D/S Gateway PLC (CPM2*-S*).
♦ Flash ROM backup – Flash ROM backup is supported for the PLCs incorporating this feature.
♦ Find and Replace – Enhanced and extended Find and Replace functionality. The GUI has been enhanced to include the scope of the search i.e. whether the Section, Global symbol and/or the Local symbol will be affected by the search.
Upload/Download – The Upload/Download functionality has been updated to include the CV/CVM1, CS1/CJ1, CJ1H/H-H and CS1G/H-H PLCs to avoid searching section markers on the initial dialog Upload.

The range of the Send/Recv instruction has been extended to include the PLCs CS1/CJ1, CS1G/H-H and CJ1G/H-H

Operation – The levels of operation have been extended to include Junior, Demo and Trial versions of the product.

Symbol Sorting – The symbol sort for number data types has been enhanced and is now sorted separately from other data types in the symbol table view.

Direct import file range extended to include CPT, SP1 and COD files.

Version 3.0 of CX-Programmer offers the following enhancements.

Support for new PLCs – Full support has been added for the CJ1M, and CS1D series PLCs.

Changed the sizes and positions of dialogs for editing Contact/Coil/Instruction, Find and Replace, and Commented Rung.

Auto Online, Work Online Simulator - Enhanced the online functionality making it easier to connect to PLCs and debug programs.

Combine and Split rungs - The combine and split functions have been added making it easy to add and divide rungs.

Watch Window - The watch window has been enhanced to enable addresses to be entered directly on the watch sheet.

Key Mapping - The data of Keyboard Mapping can be saved to a file (*.mac) and loaded into a CX-Programmer.

Section/Rung Manager - A function to edit a structure of Program is supported. Sections, Rungs and comments can be edited on this dialog.

I/O Comment view - A View to edit comments of addresses is now supported.

CX-Programmer supports the following PLCs.

<table>
<thead>
<tr>
<th>Series</th>
<th>Model</th>
<th>CPU Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP-Series</td>
<td>CP1H</td>
<td>X, XA</td>
</tr>
<tr>
<td>CP1L</td>
<td>M, L</td>
<td></td>
</tr>
<tr>
<td>CP1E</td>
<td>E, N</td>
<td></td>
</tr>
<tr>
<td>CJ-Series</td>
<td>CJ1G</td>
<td>CPU 44, CPU 45</td>
</tr>
<tr>
<td>CJJG-H</td>
<td>CPU 42, CPU 43, CPU 44, CPU 45</td>
<td></td>
</tr>
<tr>
<td>CJ-Series</td>
<td>CJ2H</td>
<td>CPU 64, CPU 65, CPU 66, CPU 67, CPU 68, CPU64-EIP, CPU65-EIP, CPU66-EIP, CPU67-EIP, CPU68-EIP</td>
</tr>
<tr>
<td>CJ-Series</td>
<td>CJ1M</td>
<td>CPU 11, CPU 12, CPU 13, CPU 21, CPU 22, CPU 23</td>
</tr>
<tr>
<td>CS-Series</td>
<td>CS1G</td>
<td>CPU 42, CPU 43, CPU 44, CPU 45</td>
</tr>
<tr>
<td>CS1G-H</td>
<td>CPU 42, CPU 43, CPU 44, CPU 45</td>
<td></td>
</tr>
<tr>
<td>CS-Series</td>
<td>CS1H</td>
<td>CPU 63, CPU 64, CPU 65, CPU 66, CPU 67</td>
</tr>
<tr>
<td>CS1H-H</td>
<td>CPU 63, CPU 64, CPU 65, CPU 66, CPU 67</td>
<td></td>
</tr>
<tr>
<td>CS-Series</td>
<td>CS1D-H</td>
<td>CPU 65, CPU 67</td>
</tr>
<tr>
<td>CS1D-S</td>
<td>CPU 42, CPU 44, CPU 65, CPU 67</td>
<td></td>
</tr>
<tr>
<td>CV-Series</td>
<td>CV1000</td>
<td>CPU 01</td>
</tr>
<tr>
<td>CV-Series</td>
<td>CV2000</td>
<td>CPU 01</td>
</tr>
<tr>
<td>CV-Series</td>
<td>CV500</td>
<td>CPU 01</td>
</tr>
<tr>
<td>CV-Series</td>
<td>CVM1</td>
<td>CPU 01, CPU 11</td>
</tr>
<tr>
<td>CV-Series</td>
<td>CVM1-V2</td>
<td>CPU 01, CPU 11, CPU 21</td>
</tr>
<tr>
<td>C-Series</td>
<td>C1000H</td>
<td>CPU 01</td>
</tr>
<tr>
<td>C-Series</td>
<td>C2000H</td>
<td>CPU 01</td>
</tr>
<tr>
<td>C-Series</td>
<td>C200H</td>
<td>CPU 01, CPU 02, CPU 03, CPU 11, CPU 21, CPU 22, CPU 23, CPU 31</td>
</tr>
</tbody>
</table>
### Series | Model | CPU Types
--- | --- | ---
C-Series | C200HE | CPU 11, CPU 32, CPU 42
C-Series | C200HE-Z | CPU 11, CPU 32, CPU 42
C-Series | C200HG | CPU 33, CPU 43, CPU 53, CPU 63
C-Series | C200HG-Z | CPU 33, CPU 43, CPU 53, CPU 63
C-Series | C200HS | CPU 01, CPU 03, CPU 21, CPU 23, CPU 31, CPU 33
C-Series | C200HX | CPU 34, CPU 44, CPU 54, CPU 64
C-Series | C200HX-Z | CPU 34, CPU 44, CPU 54, CPU 64, CPU 65, CPU 85
C-Series | CPM1 (CPM1A) | CPU 10, CPU 20, CPU 30, CPU 40
C-Series | CPM2*/CPM2*-S* | –
C-Series | CQM1 | CPU 11, CPU 21, CPU 41, CPU 42, CPU 43, CPU 44, CPU 45
C-Series | CQM1H | CPU 11, CPU 21, CPU 51, CPU 61
NSJ-Series | NSJ | G5D (Used for the NSJ5-TQ0*-G5D, NSJ5-SQ0*-G5D, NSJ8-TV0*-G5D, NSJ10-TV0*-G5D, and NSJ12-TS0*-G5D)
FQM-Series | FQM-CM | FQM1-CM001/002
FQM-MMA | FQM1-MMA21/22
FQM-MMP | FQM1-MMP21/22
IDSC | – | –
SRM1 | SRM1 | C01, C02
SRM1 | SRM1-V2 | C01, C02

**Note:** The CVM1-V1 PLC for types CPU01 and CPU11 cannot be specifically selected. Use the non-V2 types.

Refer to the *CX-Server PLC Tools User Manual* for information regarding available communication types.

### System Requirements

**Note:** CX-Programmer is not guaranteed to be compatible with computers running Windows emulation (for example, Apple Macintosh).

The following configurations are required for computers to use the CX-Programmer. These specifications apply when CX-Programmer is installed from the individual CX-Programmer CD-ROM.
Minimum System Requirements

- Installing the CX-Programmer from the Individual CX-Programmer CD-ROM

<table>
<thead>
<tr>
<th>Item</th>
<th>Microsoft Windows 2000 Service Pack 2 or later or Windows XP</th>
<th>Microsoft Windows Vista (See note 3.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>IBM PC/AT or compatible</td>
<td>IBM PC/AT or compatible computer that uses a processor recommended by Microsoft.</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium Class 330 MHz minimum</td>
<td>Processor recommended by Microsoft (1 GHz or faster recommended.)</td>
</tr>
<tr>
<td>RAM Memory</td>
<td>Program size of 30 Ksteps or less (See note 2.)</td>
<td>512 MB min. of memory is required. 1 GB or more is recommended.</td>
</tr>
<tr>
<td></td>
<td>128 MB min. (192 MB min. when CX-Simulator is also used.)</td>
<td>512 MB min. of memory is required. 1 GB or more is recommended.</td>
</tr>
<tr>
<td></td>
<td>Program size of 120 Ksteps or less (See note 2.)</td>
<td>256 MB min. (256 MB min. when CX-Simulator is also used.)</td>
</tr>
<tr>
<td></td>
<td>384 MB min. (384 MB min. when CX-Simulator is also used.)</td>
<td>384 MB min. (384 MB min. when CX-Simulator is also used.)</td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>550 MB minimum free space</td>
<td>550 MB minimum free space</td>
</tr>
<tr>
<td>Display</td>
<td>SVGA (800x600) or better</td>
<td>SVGA (800x600) or better</td>
</tr>
<tr>
<td>CD-ROM Drive</td>
<td>One drive min.</td>
<td>One drive min.</td>
</tr>
<tr>
<td>Communications Port</td>
<td>One RS-232C port min.</td>
<td>One RS-232C port min.</td>
</tr>
</tbody>
</table>

**Note 1:** The amount of memory (RAM) required depends on the size of the programs being created. The CX-Programmer operation may slow significantly if the memory requirements exceed the computer’s available memory.

**Note 2:** The program sizes assume that only one PLC is registered. If more than one PLC is registered in a project, the memory size of the computer must be increased by approximately 1 MB per 1 Kstep of PLC program.

**Note 3:** Some Help files cannot be accessed when CX-Programmer is used with Microsoft Windows Vista. These Help files can be accessed if the Help program for Windows Vista from Microsoft (WinHlp32.exe) is installed. For installation information, refer to the Microsoft homepage listed below or contact Microsoft Corporation. (The download page is automatically displayed when the Help file is opened when connected to the Internet.)

http://support.microsoft.com/kb/917607/en_us

- Installing the CX-Programmer from the CX-One Package CD-ROM

Refer to the CX-One Setup Manual (Cat. No. W463) for the conditions required if the CX-Programmer has been installed from the CX-One CD-ROM.
Installing and Uninstalling the Software

Software That Must Be Installed
The following software must be installed on the same computer to use the CX-Programmer.

1. CX-Programmer
2. CX-Server (the communications driver), including the CX-Server Driver Management Tool

Types of CX-Programmer
The CX-Programmer is available both on an independent CD-ROM and on the CX-One FA Integrated Tool Package. The contents of the CX-Programmer are the same in either case.

The installation procedure for the independent CD-ROM is provided here. Refer to the CX-One Setup Manual (W463, provided with the CX-One) for the installation procedure for the CX-One.

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Model</th>
<th>Manual name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>W463</td>
<td>CXONE-ALC-E</td>
<td>CX-One Setup Manual</td>
<td>An overview of the CX-One FA Integrated Tool Package and the CX-One installation procedure</td>
</tr>
</tbody>
</table>

Preparations for Installation

Note: If the CX-Programmer was previously installed from the CX-One and it’s necessary to install it from the individual CX-Programmer CD-ROM, always uninstall the CX-Programmer using the following procedure before installing it from its individual CD-ROM. The CX-Programmer will not operate properly if it is installed without first uninstalling it.

1, 2, 3…

1. Insert the CX-One installation disk 1 into the CD-ROM drive.
2. Select the Modify Option to enable modifying the Support Software that is installed.
3. In the Select Features Dialog Box, clear the selection of only the CX-Programmer. Do not change any other selections.
4. Continue by following the instructions in the dialog boxes to modify the installation and uninstall CX-Programmer.
5. Once the CX-Programmer uninstallation process has been completed, place the individual CD-ROM disk for the CX-Programmer into the CD-ROM drive and install the CX-Programmer. (See note.)

Note: If the version of the CX-Server bundled on the individual CX-Programmer CD-ROM is lower than the version of the CX-Server bundled with the CX-One, install only the CX-Programmer and NOT the CX-Server. (A message will be displayed if the version is lower.) If a version of CX-Server that is lower than the version with the CX-One is installed, the CX-One will not operate properly.
Uninstalling the Previous Version of CX-Programmer
Always uninstall the previous version of the CX-Programmer before installing the new version.

1, 2, 3…
1. Start Add/Remove Programs from the control panel.
2. Select CX-Programmer from the dialog box.
3. Click the Change/Remove Button. The CX-Programmer will be uninstalled.

Uninstalling the CX-Server PLC Tools
Also uninstall the CX-Server PLC Tools in the same way as for the previous version of the CX-Programmer before installing the new version of CX-Programmer.

Note: The Installer manages the version and driver for the CX-Server. If the CX-Server installed on the computer is old, the Installer will automatically update the CX-Server. If the CX-Server Driver Management Tool or the CX-Server is uninstalled from the control panel, it may no longer be possible to use certain Units. Do not uninstall the CX-Server Driver Management Tool or the CX-Server from the control panel.
Precautions for Installation

This section describes the procedures involved in the installation of CX-Programmer on a standard workstation running Microsoft Windows 2000 or XP.

♦ Close all programs running on Windows before starting the installation procedure.
♦ Do not stop the setup process in the middle. Copied files may remain in the installation directory.
♦ Do not turn OFF or reset the computer in the middle of the installation process. Computer data may become corrupted.
♦ On Windows 2000, or XP, the administrator or a user with administrator rights must perform the installation. Other users will not have sufficient write permissions and access errors will occur.
♦ With Windows 2000, always use service pack 2. The service pack can be confirmed by selecting Start - Settings - Control Panel - System. The service pack will be displayed under System on the General Tab Page of the System Properties Dialog Box. If a service pack is not displayed, no service pack has been installed. Refer to Microsoft’s website for service pack installation methods.
♦ It may be necessary to restart Windows after finishing the installation. If required, restart Windows according to the messages displayed by the Installer.

Note: Internet Explorer version 5.0 or higher must be installed in advance to use the CX-Server Installer. Install Internet Explorer version 5.0 in advance if it is not already installed.
Installing the CX-Programmer

1. Insert the CX-Programmer installation disk (CD-ROM) into the CD-ROM drive.

2. The setup program will start automatically and the Choose Setup Language Dialog Box will be displayed.

![Choose Setup Language Dialog Box](image)

The language of the operating system running on the computer will be selected automatically.

If the above dialog box is not displayed, double-click the CD-ROM driver from the Explorer to display it.

Select the language to be installed and click **OK** button. (See note.)

**Note:** The following languages can be selected: English, Italian, Spanish, German, French or Chinese.

3. A splash window for the CX-Programmer will be displayed, followed by the Setup Wizard.

![Setup Wizard](image)

Click the **Next** Button.

4. The **License Agreement** Dialog Box will be displayed.

![License Agreement](image)

Read the license agreement completely and if you accept all of the terms, select the **I accept the terms of the license agreement** Option and click the **Next** Button.
5. The User Information Dialog Box will be displayed.

![User Information Dialog Box]

The default names registered in the computer will be entered for the user name and company name. Enter the license number and click the Next Button. The license number is given on the Software License/Registration Card provided with the product.

6. The Choose Destination Location Dialog Box will be displayed.

![Choose Destination Location Dialog Box]

Select the destination location and click the Next Button. By default, the CX-Programmer will be installed in the following location: C:\Program Files\OMRON\CX-One\CX-Programmer\.

7. The Setup Type Dialog Box will be displayed.

![Setup Type Dialog Box]

Select the setup type to install.
Select the *Complete* or *Custom* Option and click the **Next** Button.

8. The Select Features Dialog Box will be displayed if *Custom* was selected.

![Select Features Dialog Box](image)

**Note:** The above dialog box will not be displayed if *Complete* is selected. Proceed to step 9.

Select the features to be installed and click the **Next** Button.

**Options**

- CX-Programmer
- Online Help
- OMRON FB Library
- CX-Server
- PLCTools

9. The Setup will install Smart FB Library to the following folder Dialog Box will be displayed.

![Setup Dialog Box](image)

Check the destination location and click the **Next** Button. By default, the Smart FB Library will be installed in `C:\Program Files\OMRON\CX-One\Lib\FBL\`. 
10. The *Select Program Folder* Dialog Box will be displayed. Specify the location to add a shortcut in the program folder of the Windows Start Menu and click the **Next** Button.

11. The *Ready to Install the Program* Dialog Box will be displayed. Click the **Install** Button.

The Installer will start the installation.

To check the installation settings, click the **Back** Button.

To cancel installation, click the **Cancel** Button.

12. If the CX-Server is already installed on the computer, the Installer will automatically check the CX-Server version and driver and update them as required. Depending on the version of CX-Server that was already installed, and confirmation dialog box may be displayed.
13. The following dialog box will be displayed when the Installer completes the installation. Click the **Finish** Button.

The following dialog box will be displayed if restarting the computer is required.

Select the desired option and click the **Finish** Button. If the **Yes, I want to restart my computer now** Option was selected, the computer will be restarted.

14. The Readme.txt file will be displayed after the computer is restarted.

**Note:** Always read the Readme.txt file before using the CX-Programmer.

15. The **Online Registration** Dialog Box will be displayed when the Readme.txt file is closed.

A wizard will be started and will connect to the OMRON CX-One Web if the **Register** Button is clicked. (See notes.)

**Note:** 1. If the **Exit** Button is clicked to cancel registration, the **Online Registration** Dialog Box will be displayed every time the CX-One Configuration Tool is started.

2. Online installation will not be possible if the computer is not connected to the Internet. Enter the required information on the registration card and mail it in.

This completes installation of the CX-Programmer.
Uninstalling the CX-Programmer

Use the following procedure to delete the CX-Programmer from the computer.

1, 2, 3…

1. Select **Start - Settings - Control Panel - Add/Remove Programs**. The Add/Remove Programs Dialog box will be displayed.
2. Select **CX-Programmer** from the dialog box.
3. Click the **Change/Remove Button**.

4. The CX-Programmer Installation Wizard will be displayed. Select the **Remove Option** and click the **Next Button**.

5. If deleting the CX-Programmer completely is selected, the following dialog box will be displayed. Click the **Yes Button** to start the Uninstaller that will delete the CX-Programmer.
6. When the uninstallation has been completed, the following dialog box will be displayed.

Uninstalling the CX-Server

Note 1. The Installer manages the version and driver for the CX-Server. If the CX-Server installed on the computer is old, the Installer will automatically update the CX-Server. If the CX-Server Driver Management Tool or the CX-Server is uninstalled from the control panel, it may no longer be possible to use certain Units. Do not uninstall the CX-Server Driver Management Tool or the CX-Server from the control panel.

2. Do not uninstall the CX-Server if there are other programs on the computer that use it as the communications driver, e.g., the CX-Motion. If the CX-Server is uninstalled, it will no longer be possible to use these other programs.

3. Do not uninstall the CX-Server while other programs that use it as the communications driver are running on the computer, e.g., the CX-Motion. The CX-Server may not uninstall properly if other programs are using it.

4. Always uninstall the CX-Server Driver Management Tool before uninstalling the CX-Server. If the CX-Server is uninstalled first, it may no longer be possible to uninstall the CX-Server Driver Management Tool properly.
1. Select Start - Settings - Control Panel - Add/Remove Programs. The Add/Remove Programs Dialog box will be displayed.

2. Select CX-Server Driver Management Tool from the dialog box.

3. Click the Change/Remove Button.

4. A confirmation dialog box will be displayed. Click the Yes Button.

The CX-Server Driver Management Tool will be uninstalled.

5. When the uninstallation has been completed, the following dialog box will be displayed. Click the Finish Button. The Add/Remove Programs Dialog Box will be displayed again.

6. In the same way, select CX-Server from the Add/Remove Programs Dialog Box, click the Change/Remove Button, and uninstall the CX-Server following the messages that appear on the screen.

7. Restart the computer when all programs have been uninstalled.
Installation Options

The following components can be installed individually during a custom installation when the CX-Programmer is being installed from the individual CX-Programmer CD-ROM.

♦ Online Help (selected by default)
♦ Function Block Library (selected by default)
♦ CX-Server (selected by default)
♦ PLC Tools (selected by default)
♦ NCF_European_DB (not selected by default)

Note: Refer to the CX-One Setup Manual for details on installing the CX-Programmer from the CX-One Package CD-ROM.

Entering a License Number

During the installation, a license number must be entered. The license number is supplied with the purchase of CX-Programmer. There are eight different license number types representing eight different modes of installation. Upgrade license numbers are available on request.

The eight installation modes are:

- **Full (1 User)**  
  Installation providing full functionality support for all PLCs.  
  The license is restricted to a single user installation.

- **Full (3 User)**  
  Installation providing full functionality support for all PLCs.  
  The license is restricted to a three-user installation.

- **Full (10 User)**  
  Installation providing full functionality support for all PLCs.  
  The license is restricted to a ten-user installation.

- **Multiple User**  
  Installation providing full functionality support for all PLCs.  
  The license is restricted to a multiple-user installation.

- **Junior**  
  Installation providing full functionality support for the junior range PLCs only CP1H, CP1L, CP1E, CPM1 (CPM1A), CPM2*, SRM1, SRM1-V2.  
  The license is restricted to a single-user installation.

- **Multiple User (Junior)**  
  Installation providing full functionality support for the junior range PLCs only CP1H, CP1L, CP1E, CPM1 (CPM1A), CPM2*, SRM1, SRM1-V2.  
  The license is restricted to a multiple-user installation.

- **Trial**  
  Installation providing full functionality support for all PLCs. Its use is limited to 30 days from time of installation.  
  The license is restricted to a single-user installation.

- **Demonstration**  
  Installation providing limited functionality support for all PLCs. Full system operation is provided but projects can not be saved or printed.

If no license number is entered then CX-Programmer is automatically installed in demonstration mode.

If CX-Server was included in the installation then on completion of the CX-Programmer installation a number of dialogs will prompt for information concerning the installation of CX-Server and its components.
Help and How to Access it

CX-Programmer comes with a detailed context-sensitive help system. At any time while using the software, it is possible to get help on the particular point that is currently being worked on, or on general aspects of CX-Programmer. This system is intended to complement the manual, by providing an on-line reference to specific functions of the software. The manual is designed to provide tutorial information and discuss the various facilities offered by CX-Programmer.

♦ Help topics (available from the Help menu);
♦ Instruction Reference (available from the Help menu and from the instruction entry dialog);
♦ Context sensitive help;
♦ About (available from the Help menu);
♦ Status Bar.

Help Topics

Select the Help Topics option on the Help menu. The Help system provides a standard look-up dialog under the Contents tab showing the contents of the CX-Programmer Help file. Double-click on an item to read the associated information.

Index

Use the following procedure to retrieve on-line help from the Index tab of the Help Topics dialog.

1. Select the Help Topics option from the Help menu.
2. Select the Index tab.
3. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field.
4. Select an entry in the second step field and select the Display pushbutton, or double-click on the index entry.
5. If an entry is linked to two or more topics, the names of the topics are displayed in the Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on the topic.

Find

Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog.

1. Select the Help Topics option from the Help menu.
2. Select the Find tab.
3. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field. Previous text queries can be retrieved by selecting from the drop-down list in the first step field.
4. Select a word that matches the query – some words may be automatically selected. More than one word can be selected by pressing Shift and selecting another word to extend the selection or by pressing Ctrl and selecting another word to add to the selection. The third step field is refreshed according to the word or words selected. The number of topics found is shown at the bottom of the dialog.
5. Select a topic from the third step field and select the Display pushbutton, or double-click on the topic from the third step field. Select the Clear pushbutton to restart the Find operation.

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to Microsoft Windows documentation for further information.

Instruction Reference

CX-Programmer supports additional help for CS/CJ/CP-series PLCs, CV-series PLCs and C-series PLCs. All valid instructions relating to PLC programming can be retrieved by selecting Instruction Reference from the Help menu, followed by either CS/CJ/CP-Series, CV-Series or C-Series. Individual help topics are displayed.
Keyboard Mapping Reference

CX-Programmer supports a function to customize the keyboard mapping, and provides default keyboard mapping files for CX-Programmer, SYSWIN and SYSMAC Support Software. A list of each keyboard mapping file is displayed.

**Note:** Guidance can be displayed for CX-Programmer functions for SYSMAC Support Software operations and SYSWIN operations by selecting Function Key Guidance from the View menu. The CX-Programmer shortcut key allocations for all keys can be displayed by selecting Information Window from the View menu.

Context Sensitive Help

CX-Programmer supports the use of context sensitive help. The relevant on-line help topic is provided automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 function key to retrieve context sensitive help. Some dialogs include a Help pushbutton when F1 cannot be accessed.

It is also possible to retrieve context sensitive help by selecting the Help button from the toolbar and selecting an area of the display to retrieve help.

About CX-Programmer

CX-Programmer includes an About button accessible from the toolbar. The About CX-Programmer dialog supplies technical reference information about the application such as version and copyright information. It also contains essential version number information that is required for obtaining technical support.

Status Bar

The status bar is displayed at the bottom of many of the CX-Programmer display and tool windows. It provides several helpful pieces of information while programming:

- **Instant Help.** A brief message appears in the status bar as menu commands and buttons are selected.
- **On-line Status.** This shows the on-line or off-line status of the PLC. If connection to a PLC is lost, the status bar will indicate this by flashing.
- **Network and Node number.** This shows the network number and the node number of the current PLC, which the cursor is pointing at. When connected to a simulator, Simulator will be displayed instead.
- **PLC Operating Mode.** When connected to a PLC, this shows the current PLC mode. Connection errors are also displayed here.
- **Connected PLC and CPU Type.** The currently connected PLC and associated CPU can always be referenced in the status bar.
- **PLC Cycle Time.** This shows the current cycle time of the PLC when connected.
- **Cursor Position.** This shows the position of the cursor within the program.
- **On-line Edit Buffer Size.** This shows the size remaining in the on-line edit buffer when connected to a PLC and editing on-line.
- **PLC memory backup.** This shows the status of the PLC memory backup.

The CX-Programmer status bar can be enabled and disabled by selecting the Status Bar option from the View menu.

Technical Support

If the installation instructions for this application have been followed (refer to Chapter 1 - Technical Specifications), no difficulties should be encountered. However, if there is a problem, contact Customer Services.

If a problem occurs, check that it does not relate to a fault outside CX-Programmer, for instance, with CX-Server components. Check the following:

- The computer is working correctly.
- The PLC is working correctly.
- The communications system is set up correctly.
The errors are cleared in the PLC.

When Customer Services need to be contacted, keep the following details to hand. A clear and concise description of the problem is required, together with the exact text of any error messages.

**Note:** Use the About dialog to obtain the version number of the application (the four-fielded version listed against the ‘CX-P.exe’ entry in the bottom list).

<table>
<thead>
<tr>
<th>Customer Services Request Form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version number of CX-Programmer:</strong></td>
</tr>
<tr>
<td><strong>Serial number of the software:</strong></td>
</tr>
<tr>
<td><strong>Operating system and version number:</strong></td>
</tr>
<tr>
<td><strong>Language of operating system:</strong></td>
</tr>
<tr>
<td><strong>PLC type, model and CPU details:</strong></td>
</tr>
<tr>
<td><strong>Type of communications in use:</strong></td>
</tr>
<tr>
<td><strong>Serial</strong></td>
</tr>
<tr>
<td><strong>SYSMAC LINK</strong></td>
</tr>
<tr>
<td><strong>SYSMAC NET</strong></td>
</tr>
<tr>
<td><strong>Controller Link</strong></td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
</tr>
<tr>
<td><strong>Toolbus</strong></td>
</tr>
<tr>
<td><strong>Nature of the problem:</strong></td>
</tr>
<tr>
<td><strong>Steps taken to reproduce problem:</strong></td>
</tr>
<tr>
<td><strong>Other comments:</strong></td>
</tr>
</tbody>
</table>

Refer to the *CX-Server PLC Tools User Manual* for support details regarding CX-Server components.
CHAPTER 2
Quick Start Guide

This chapter describes the basic features of CX-Programmer together with a simple tutorial for familiarization purposes; detail is to be found in Chapter 3 - Project Reference and Chapter 4 - Reference.

As this chapter proceeds, important concepts about CX-Programmer are introduced by this symbol.

Starting CX-Programmer

CX-Programmer is activated from the Start button in the Microsoft Windows taskbar. Once activated, CX-Programmer is displayed.

CX-Programmer provides the facility to create a project file in which as many PLCs as required can be included. For each PLC, ladder program(s), addressing and network details, pre-set PLC memory, IO table, expansion instructions (if applicable) and programming symbols can be defined.

Licensing

CX-Programmer uses a license number system in order to activate the program in one of four modes of operation. The license number for the mode of operation purchased is shown on the CD case.

Junior Mode
To use CX-Programmer in Junior mode, a license number is required. Using this mode provides full functionality but restricts programming to the CP1H, CP1L, CP1E, CPM1(CPM1A), CPM2*, SRM1 and SRM1-V2 PLCs only.

Trial Mode
A license number is required to run CX-Programmer in Trial mode. Full functionality is provided in this mode but operation is restricted to 30 days from the time installation.
Demo Mode
A license number is not required to run CX-Programmer in Demo mode. Full system operation is provided but projects cannot be saved or printed.

Full Version
To access the Full Version of CX-Programmer, the appropriate license number must be entered.

The license number may be input at the time of installation or later. To enter an upgrade license number or re-enter the existing number after installation, follow these steps:

1. Start CX-Programmer, as described above.
2. Click the help button in the toolbar or from the Help menu select the About CX-Programmer option.
3. In the ‘About CX-Programmer’ dialog click the License button.
4. A dialog is displayed that allows a new license number to be entered. Read the warning message, enter the appropriate license number and click OK.
5. When a correct license number is entered, CX-Programmer must be restarted to gain full functionality.

Introducing CX-Programmer Projects
The information within a CX-Programmer project consists of ladder program(s), operands, required PLC memory contents, IO tables, expansion instructions (if applicable) and symbols. Each CX-Programmer project file is separate and is a single document.

CX-Programmer can only open a single project at a time. However, it is possible to deal with many project files by using CX-Programmer at once.

A CX-Programmer project has a .CXP or .CXT file extension. (Normally the .CXP file is used, and is a compressed version of the .CXT file).

Once the project itself is created the desired PLC and symbol information can be defined. For a full discussion of PLCs, refer to the CX-Server - PLC Tools User Manual.

The CX-Programmer Environment
This chapter describes how to manipulate the different views of the main window. Use this chapter to develop an understanding with the layout of CX-Programmer and to customize it according to specific requirements.
The views available are controlled via the options supplied by the View menu.

**The project workspace.** Select the Toggle Project Workspace button from the toolbar to activate this view. Deselect the Toggle Project Workspace button from the toolbar to deactivate this view.

**The Output window.** Select the Toggle Output Window button from the toolbar to activate this view. Deselect the Toggle Output Window button from the toolbar to deactivate this view.

**The Watch window.** Select the Toggle Watch Window button from the toolbar to activate this view. Deselect the Toggle Watch Window button from the toolbar to deactivate this view.

**The Cross Reference Report.** Select the Cross Reference Report button from the toolbar to activate this view.

**The local symbol table.** Select the View Local Symbols button from the toolbar to activate this view.

**The Diagram Workspace.** Select the View Diagram button from the toolbar to activate this view.

**The Mnemonics view.** Select the View Mnemonics button from the toolbar to activate this view.

**The Address Reference tool.** Select the Show Address Reference Tool button from the toolbar to activate this view.

**The I/O Comment view.** Select the I/O Comment view button from the toolbar to activate this view.

**The Properties dialog.** Select the Show Properties button from the toolbar to activate this view.

**The Monitor in HEX.** Select the Monitor in HEX button from the toolbar to activate this function.

All windows in the CX-Programmer main window can be minimized, maximized or closed. Refer to standard *Microsoft Windows documentation* for further information.

Each window has an associated context menu obtained by clicking the right-mouse button. These options show the functions relevant to the point where the right-mouse button was pressed.
The status bar displays instant help, Network and Node numbers of current PLC, PLC on-line status, PLC mode, connected PLC and PLC type, PLC cycle time, on-line edit buffer size and current cursor position depending on which view is displayed.

To exit CX-Programmer, select Exit from the File menu.

Refer to Chapter 3 - Project Reference for further information.

**Project Workspace**

The project workspace displays the project as a hierarchical tree structure showing related PLC and program details. Select the Toggle Project Workspace button from the toolbar to activate this view. Deselect the Toggle Project Workspace button from the toolbar to deactivate this view.

A description of each object in the hierarchy and their associated context menus is provided as follows:

- **PLC.** Refer to the CX-Server PLC Tools User Manual for details.

- **Global Symbol Table.** Refer to Chapter –2 Introducing Symbols and the Symbol Table for details.

- **IO Table.** Refer to the CX-Server PLC Tools User Manual for details.

- **PLC Settings.** Refer to the CX-Server PLC Tools User Manual for details.

- **Memory Card.** Refer to the CX-Server PLC Tools User Manual for details. The Memory Card object can only be selected when the PLC is on-line.

- **Error Log.** Refer to the CX-Server PLC Tools User Manual for details. The Error Log object can only be selected when the PLC is on-line.

- **PLC Memory.** Refer to the CX-Server PLC Tools User Manual for details.

- **Program.** Refer to Chapter –2 Using CX-Program for details.

- **Local Symbol Table.** Refer to Chapter –2 Introducing Symbols and the Symbol Table for details.

- **Sections.** Refer to Chapter –3 Program Sections.

- **Collapse/Expand.** The hierarchy can be collapsed or expanded to show either a partial view or full view of the project workspace tree.

**Diagram Workspace**

The Diagram Workspace can display a Ladder program, the symbol table of that program, the Mnemonics view and the I/O Comment view. The details displayed depend upon the selection made in the project workspace.

When a new project is created or a new PLC added to a project, an empty Ladder program is automatically displayed on the right-hand side to the project workspace. The symbol table, the Mnemonics view and the I/O
Comment view must be explicitly selected to be displayed. All views can be opened at the same time and can be selected via options associated with the Window menu.

The Ladder program graphically represents the PLC power flow from left to right and the program sequence from top to bottom.

PLC program instructions can be entered as a graphical representation in Ladder form. Programs can be created, edited and monitored in this view.

Follow the examples provided to develop an understanding of the Diagram Workspace.

Select the View Diagram button from the toolbar. The Ladder program window is displayed in the Diagram Workspace.

The following items are standard features of the Ladder program area:

- **Cursor.** A rectangular block showing the current position within the rung. The location of the cursor is displayed in the status bar.

- **Rung.** A logical unit of a ladder program. A rung can encompass one or more rows and columns. All rungs are numbered.

- **Bus-bars.** The left bus-bar provides a graphical representation of the power supply bus-bar. The right bus-bar contains the output region: to align objects to the right bus-bar. The right bus-bar is selectable for display. If shown, the ladder rungs are justified so that the outputs of the rungs are organized along it.

- **Grid Dots.** Dots that display at the connection points of each cell. To display the grid, select the Grid button from the toolbar.

- **Rung Margin Area.** The area to the left of the Left bus-bar. The rung number and step number for each rung are shown here (rung number on the left).

- **Automatic Error Detection.** A bar is displayed to the left of the currently selected rung area. As elements and instructions are added to the rung, the additions are automatically checked to see if they are valid. The color of the bar indicates the validity of the program: red highlights an error, whilst green indicates a correct entry. In addition, elements of the text on the ladder are drawn in this error color if a problem exists.

The color and display preferences of the above features can be amended by selecting Options from the Tools menu.

More than one element in a rung can be selected by pressing the mouse button down on an element and, keeping the left-mouse button depressed, dragging a highlight over other elements in the rung. Selected elements can then be moved as a block.
The global/local, name, address/value, and I/O comment fields for the symbol at the cursor position can be displayed in the symbol bar below the Ladder Section window (CX-Programmer Ver. 4.0 or later). Enable this function by selecting Show symbol bar in the Diagrams Tab in the Options Dialog Box of the Tools Menu (the default setting is ON: display). Therefore, while increasing the program display density, the text in particularly long I/O comments can be checked, thereby improving the readability of the program.

Mnemonics View

The Mnemonics view is a formatted editor for programming in mnemonic instructions. This view is made up of a table of six columns containing the rung number, step number, instruction, operands, value and comment.

Mnemonic instructions are a ‘low-level’ view of a PLC program, whilst ladder is higher. Since the ladder program is just a higher-level representation of the mnemonic instructions, it is possible to type in mnemonics and see the ladder program update.

Select the View Mnemonics button from the toolbar. The Mnemonics view is displayed in the Diagram Workspace.

1. To program in mnemonics, open the mnemonic view and place the cursor on the desired instruction.
2. Press ENTER – this will enter the editing mode.
3. Edit or type the new instruction lines. A mnemonic instruction consists of an instruction name followed by a set of operands separated by spaces (e.g. ‘MOV #1 A2’).
4. Either press ENTER to move to the next line, or press ‘down’ or ‘up’ on the keyboard to move to another line – the updated line is still kept. The newly entered information is separated out over the columns in the table.
5. When finished with editing, press ‘Esc’ to come out of editing mode.

Whilst entering a program in the mnemonics view, the ladder view shows the instructions in the new rung as statement list. Once enough instructions have been entered to enable its drawing in ladder format it is redrawn.

Instructions can be transferred to and from the Mnemonics view using the standard Microsoft Windows Cut or Copy and paste functions. For example, it is possible to paste a large amount of program from a text editor. Refer to Chapter 3 - Project Reference for further information.

Introducing Symbols and the Symbol Table

PLC addresses, which are used as operands in a PLC program, can be assigned a symbolic name and/or a comment for the purpose of reference during programming. An address with a name or comment is known as a Symbol.

A symbol table is an editable list of symbol definitions – the names, addresses and comments. This list also provides information on the following:
- **Rack location.** If the address is contained within the PLC IO table, this shows the address’ rack location.
- **Usage.** If the address is contained within the PLC IO table, this shows the physical hardware type (i.e. ‘Input’ or ‘Output’) that is mapped to the address. If no hardware is mapped, ‘Work’ is shown, meaning that the symbol is for general use.
It is possible to indicate the physical format of the data that is stored at an address. This additional data typing facility enables CX-Programmer to check whether the address is used consistently within programs. In the symbol tables, an icon is shown next to a symbol that indicates its data type. The Data Type set is as follows:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Data Type Description</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>Address of a binary bit - a logical Boolean on or off state. This type is typically used for contacts or coils.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>CHANNEL</td>
<td>This is a special data type, for backward compatibility. It is an address (non-bit) to data of any type (unsigned or signed, one or more words), so can be used in place of any of the above data-types except NUMBER and BOOL. The data type is weak, and so checking is limited (e.g. CX-Programmer cannot check if the address is being used for BCD or binary values).</td>
<td>![Icon]</td>
</tr>
<tr>
<td>DINT</td>
<td>Address of a signed, double binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>INT</td>
<td>Address of a signed, single binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>LINT</td>
<td>Address of a signed, quad binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>NUMBER</td>
<td>A literal numeric value - not an address. The value can be signed, or floating point. NUMBERs are used for any literal value or for timer/counter identifiers (for TIM/CNT, only unsigned integer values are allowed). Floating point values are only suitable within IEEE REAL type operands. Note: When used as BCD number operands, the value is treated as if it were entered in decimal with a '#' on the front. E.g. using a NUMBER '#1234' is equivalent to typing '#1234' as the operand, so that the decimal interpretation is made of the value. The value of a NUMBER data type is assumed to be decimal, unless it is prefixed with '#' for a hexadecimal value. Note: NUMBERs entered in hexadecimal are converted to decimal for BCD operands (e.g. a NUMBER defined as '#10' will appear as '#16' for a BCD operand).</td>
<td>![Icon]</td>
</tr>
<tr>
<td>REAL</td>
<td>Address of a double word floating point value (IEEE format - use the UDINT type for the BCD, FDIV format).</td>
<td>![Icon]</td>
</tr>
<tr>
<td>LREAL</td>
<td>Address of a long word floating point value (IEEE format - use the ULINT type for the BCD format).</td>
<td>![Icon]</td>
</tr>
<tr>
<td>UDINT</td>
<td>Address of an unsigned, double binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>UDINT_BCD</td>
<td>Address of an unsigned, double BCD word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>UINT</td>
<td>Address of an unsigned, single binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>UINT_BCD</td>
<td>Address of an unsigned, single BCD word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>ULINT</td>
<td>Address of an unsigned, quad binary word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>ULINT_BCD</td>
<td>Address of an unsigned, quad BCD word.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>WORD</td>
<td>Address of a bit string of 16 bits.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>DWORD</td>
<td>Address of a bit string of 32 bits.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>LWORD</td>
<td>Address of a bit string of 64 bits.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>TIMER</td>
<td>Used for a timer number, Timer Completion Flag, or timer present value. Note: TIMERS can be used only for CJ2 CPU Units with unit version 1.0 or later and only with CX-Programmer version 8.3.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>COUNTER</td>
<td>Used for a counter number, Counter Completion Flag, or counter present value. Note: COUNTERs can be used only for CJ2 CPU Units with unit version 1.0 or later and only with CX-Programmer version 8.3.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>STRING</td>
<td>The data is handled as character strings. The size can be set between 1 and 255 characters.</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

Each program within a PLC has a ‘local’ symbol table that consists of symbols that are for use specifically in that program. Each PLC within a project has a ‘global’ symbol table that consists of symbols that can be used in any of its programs. When a PLC is added to a project, its global symbol table is filled with a pre-set list of symbols, dependant upon PLC type.
Each symbol name must be unique within its table. However, it is possible to use the same name in a local and a global table – in this case, the local symbol takes precedence over the global symbol of the same name.

The symbol table allows these names to be entered and edited directly. Each symbol name must be unique. Use the following procedure to activate the symbol tables.

1. Double-click on the symbol table object beneath the PLC in the project workspace. The global (i.e. PLC’s) symbol table is displayed containing global symbols.

2. Double-click on the symbol table object beneath a program in the project. The program’s local symbol table is displayed.

Using CX-Programmer

This chapter contains an example tutorial and also describes basic procedures that should be considered before performing any programming task on the computer and preparing ladder programs with CX-Programmer, and how to use the various tools to improve productivity. CX-Programmer offers many methods of working with its tools: in general, instructions are given for using the toolbar icon in the first instance.
The following tutorial has been based on a CS1H PLC. The choice of PLC made here affects a number of other parameters that may need to be set up. For example, the CV-series requires setting up the IO table, and using the Settings object in the Project hierarchy to establish specific PLC characteristics.

When planning a PLC programming project, various items need to be considered and set up within CX-Programmer before beginning to lay down program instructions. For example, it is important for CX-Programmer to know the model and configuration of the PLC to be programmed, so that it can establish the correct program checking and communications for that PLC. Programming should be targeted at the PLC that is to be used. It is possible to change the PLC type at any time - the program(s) are then converted. However, since the conversion may not be perfect, it is best to set the correct PLC type at the beginning.

Before programming, it is recommended that a checklist of the important program aspects be constructed, including its structure and PLC parameters. To start a new project in CX-Programmer, follow these steps in addition to the basic procedure outlined in your PLC programming manual:

<table>
<thead>
<tr>
<th>Step</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine PLC essential parameters</td>
<td>PLC series, PLC type, CPU (where applicable), communications interface, choice of editor and project type.</td>
</tr>
<tr>
<td>Determine allocation of PLC memory</td>
<td>Where applicable. For example, C-series PLCs require working out the balance required between program memory and expansion data memory.</td>
</tr>
<tr>
<td>Determine PLC setup parameters</td>
<td>PLC configuration data.</td>
</tr>
<tr>
<td>Create appropriate IO Table</td>
<td>List all related IO devices and addresses. Some C-series PLCs do not support this function.</td>
</tr>
<tr>
<td>Decide how to input and edit the program</td>
<td>CX-Programmer offers two languages: ladder and mnemonic. A mixture may be used.</td>
</tr>
</tbody>
</table>
PART 1: CX-Programmer
CHAPTER 2 – Quick Start Guide
OMRON

Starting a New Project

Once the project requirements have been worked out on paper, the first step is to create a project and define the device entries for that project. A project can have multiple PLCs. CS/CJ/CP-series PLCs are multi-tasking and can therefore have more than one program associated with them in the project; CV-series PLCs and C-series PLCs can only have one program associated with the device.

Note: To create a new project using only SFC or ST, use CX-Programmer Ver. 7.2 or higher. Select Tools – Options and set the Default Program Type in new PLC: on the PLCs Tab Page to SFC or ST to create an SFC or ST program from the beginning, instead of a ladder program.

Use the following procedure to create a new project.

I, 2, 3…

1. Select the New button from the toolbar.

2. Define the device entries for the project. Refer to the CX-Server PLC Tools User Manual for further information. For this tutorial, set the PLC type as CS1H with CPU type CPU67.

3. Save the project. Select the Save Project button from the toolbar. The Save CX-Programmer File dialog is displayed.

4. Type a valid file name in the File Name field. Select the Save pushbutton to save the new project. Select the Cancel pushbutton to abort the operation.

When a new PLC is added to a project, the following empty tables are created:

♦ Empty local symbol table;
♦ Global symbol table containing pre-set symbols;
♦ IO Table;
♦ PLC Memory data;
♦ PLC Settings data.

The project workspace is populated with the contents of the newly created project and a Ladder program is displayed in the Diagram Workspace ready for programming to begin.

A description of each object in the project hierarchy is provided in Chapter 4 - Reference.

Within the Ladder program, the current position is indicated by a highlighted rectangular block, known as the cursor. Using the mouse or the arrow keys, the cursor can be positioned at any point within the diagram. An element can be placed at the current cursor position by either selecting it from the Insert menu, selecting it from the toolbar or by pressing its assigned shortcut key. An element can be placed in any empty grid position, or may overwrite a horizontal element.
Inserting Programs

CS/CJ-series PLCs
ST or SFC can be selected as the program language when inserting programs.

When using CS/CJ-series PLCs, however, the CPU Unit of the PLC being used must be unit version 4.0 or higher.

Right-click Program in the project workspace to display the pop-up menu and select Insert Program – Ladder, Insert Program – Structured Text, or Insert Program – SFC.

Note: Setting Default Programs When Creating New Projects
The default program type is automatically set to ladder program for new projects. If a CS/CJ-series PLC is being used with CX-Programmer Ver. 7.2 or higher, the default program type for new projects can be changed to ST or SFC. Select Tools – Options and on the PLCs Tab Page of the Options Dialog Box, select one of the following three program types.

- Ladder
- ST
- SFC

PLCs Other Than CS/CJ-series PLCs
There is no sub-menu for selecting the programming language under the Insert Program option.

Right-click the program in the project workspace to display the pop-up menu. Select Insert Program.

Task Allocations of Programs
Task and program types depend on the PLC type, defined in the program properties.

Use the following procedure to change properties for a program at any time.

1. Click on the Program object in the project workspace.
2. Select the Show Properties button from the toolbar. The Program Properties dialog is displayed.
3. Select a Task type setting from the Task Type field. Since this program is written for a cyclic task, set this to ‘Cyclic Task 00’. The icon to the left of the program name changes to reflect the task type, and the task number is shown on the right of the program name.
4. Set the Operation Start setting so the program starts on PLC start-up.

Note: Programs that have their tasks assignment set to “unassigned” are effectively excluded from the project. This means that the program will not be compiled or downloaded to the PLC.
Writing a Program

The following program sequences a set of traffic lights. The sequence is a standard British sequence of the following order:

- Red light only;
- Red and Amber lights together;
- Green light only;
- Amber light only.

Writing a ladder program consists of:

- Creating symbols;
- Creating the ladder program;
- Compiling (automatically checking) the program;
- Transferring the program to and from a PLC;
- Comparing the program with the PLC program;
- Monitoring the program during execution;
- Performing an on-line edit (if necessary).

Creating Symbols

An important step in creating a Ladder Program is the definition of those PLC data areas that are to be referenced by the program. It is possible to skip this step, and use addresses directly within the program. It is better, however, to create symbolic names for the addresses so that the programs become more readable and maintainable.

Use the following procedure to create symbols.

1. Click in the Diagram Window and select the View Local Symbols button from the toolbar.
2. Select the New Symbol button from the toolbar. The Insert Symbol dialog is displayed.
3. Enter ‘AmberLight’ in the Name field.
4. Set the Address or value field to ‘10.01’.
5. Leave the Data type field set to ‘BOOL’ to indicate a bit (binary) value.
6. Type ‘Prepare to go / stop’ in the Comment field.
7. Select the OK pushbutton to proceed.

Repeat this procedure for each of the other entries in the following table:

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>Data Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>RedLight</td>
<td>10.00</td>
<td>BOOL</td>
<td>Stop.</td>
</tr>
<tr>
<td>GreenLight</td>
<td>10.02</td>
<td>BOOL</td>
<td>Go.</td>
</tr>
<tr>
<td>RedLightTimer</td>
<td>1</td>
<td>NUMBER</td>
<td>Timer for the red light period.</td>
</tr>
<tr>
<td>AmberLightTimer</td>
<td>2</td>
<td>NUMBER</td>
<td>Timer for the amber light period.</td>
</tr>
<tr>
<td>GreenLightTimer</td>
<td>3</td>
<td>NUMBER</td>
<td>Timer for the green light period.</td>
</tr>
<tr>
<td>AmberOnlyTimer</td>
<td>4</td>
<td>NUMBER</td>
<td>Timer for the amber only period.</td>
</tr>
<tr>
<td>RedTimerDone</td>
<td>T0001</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>AmberTimerDone</td>
<td>T0002</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>GreenTimerDone</td>
<td>T0003</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>AmberOnlyTimerDone</td>
<td>T0004</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>TimeInterval</td>
<td>48</td>
<td>NUMBER</td>
<td>Speed at which the sequence works (ticks).</td>
</tr>
</tbody>
</table>

Note: It is important to use the standard form of addresses in CX-Programmer. Depending upon their defined type, addresses may have two components – a channel and a bit number. In the
above example, the symbol ‘RedLight’ is defined as type ‘BOOL’. Entering the address ‘10’ is interpreted by CX-Programmer as ‘0.10’. If it had been intended as bit zero at address 50, it would have been necessary to enter it as ‘5000’ or (more easily) ‘50.00’.

Note: Symbols of NUMBER type have been used to indicate the timer numbers used in the PLC. Whilst it is possible to type numbers directly into the program ‘TIM’ instruction operands, it is more readable to define symbols that can have a name and comment. CX-Programmer allows numbers to be defined as symbols, as well as addresses.

Note: It is possible to create symbols whilst creating the PLC programs – when entering ladder contact/coil and instruction information. It is not necessary to use the symbol table to create symbols.

Creating a Ladder Program
A PLC can be programmed using either the Ladder or Mnemonic programming languages. The Ladder program is created in the Diagram View of the Diagram Window.

Use the following procedure to create a ladder program.

1, 2, 3…

1. Ensure the Ladder program is displayed in the Diagram Workspace.

2. Give the rung a comment by using the Properties box (move the cursor to the rung margin and access the properties box from the context menu.

   Note: A rung comment placeholder can be inserted into the compiled code (if the Include Comment Instructions property of the PLC is set), and the comment itself can then be saved to a file or file-card. All comments are saved in the project file.

3. Place a New Closed Contact at the start of the rung – select the New Closed Contact button from the toolbar and click in the top left cell. The New Closed Contact dialog is displayed.

4. Enter or select ‘AmberOnlyTimerDone’ from the combo and select the OK pushbutton. When a comment dialog is displayed, select the OK pushbutton again. Note that the rung margin now shows a red mark down its side. This is to indicate that the rung is incomplete – the marker bar shows whenever the rung has an error.

5. Place an Instruction by selecting the New PLC Instruction button from the toolbar and clicking next to the Contact. The New Instruction dialog is displayed.

6. Enter the instruction ‘TIM’ and the two operands, ‘RedLightTimer’ and ‘TimeInterval’, in the edit box with a space between each word.

   Note: The value of the symbol ‘RedLightTimer’ is used for the operand – the number ‘1’. In CX-Programmer, it is necessary to use a NUMBER for the first operand of a TIM/CNT instruction. It is not allowed to use a timer/counter address (i.e. T001 is not allowed).

7. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a comment dialog is displayed, select the OK pushbutton again. Note that the rung margin no longer shows a red mark down its side. There is no error within the rung.

8. Give the instruction a comment by using the Properties box (place the cursor over the instruction title and bring up the properties). Enter the text ‘Red light on only’ and press return.

9. Place a New Contact at the start of the next rung. (Either like before, or by moving the cursor to the start of the rung and using the Insert/Contact/Normally Open menu command, or by pressing the shortcut key displayed for that menu command – usually ‘C’). The New Contact dialog is displayed.

10. Enter or select ‘RedTimerDone’ from the combo and select the OK pushbutton. When a comment dialog is displayed, select the OK pushbutton again.

11. Place an instruction next to the Contact and display the New Instruction dialog. (Either like before, or by using the Insert/Instruction menu command, or by pressing the shortcut key for that command – usually ‘I’). Enter the instruction ‘TIM’ and the two operands, ‘AmberLightTimer’ and ‘TimeInterval’, in the Instruction edit box.

12. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a comment dialog is displayed, select the OK pushbutton again.
13. Give the instruction a comment of ‘Red and amber lights on together’.

14. Place a New Contact at the start of the next rung to display the New Contact dialog.

15. Select ‘AmberTimerDone’ from the combo and select the OK pushbutton. When a comment dialog is displayed, select the OK pushbutton again.

16. Place an instruction next to the Contact and display the New Instruction dialog. Enter the instruction ‘TIM’ and the two operands ‘GreenLightTimer’ and ‘TimeInterval’ in the edit box. When a comment dialog is displayed, select the OK pushbutton again.

17. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a comment dialog is displayed, select the OK pushbutton again.

18. Give the instruction the comment ‘Green light on only’.

19. Place a New Contact at the start of the next rung to display the New Contact dialog.

20. Select ‘GreenTimerDone’ from the combo and select the OK pushbutton. When a comment dialog is displayed, select the OK pushbutton again.

21. Place an instruction next to the Contact and display the New Instruction dialog. Enter the instruction ‘TIM’ and the two operands ‘AmberOnlyTimer’ and ‘TimeInterval’ in the edit box.

22. Select the OK pushbutton to accept the settings in the New Instruction dialog. When a comment dialog is displayed, select the OK pushbutton again.

23. Give the instruction a comment of ‘Amber light on only’.

The Ladder Program should resemble that illustrated (depending upon the display options chosen).

Use the following procedure to place an output for each of the traffic lights into the program.

1. Ensure the Ladder program is displayed in the Diagram Workspace.
2. Place a New Contact at the start of the next rung and assign it to symbol 'RedTimerDone' (select the symbol name from the combo on the New Contact dialog).

3. Place a New Closed Contact to the right of the Red and Amber Timer and assign it to symbol 'GreenTimerDone'.

4. Place a Coil by selecting the New Coil button from the toolbar next to the Green Light Timer. Select ‘RedLight’ from the combo and select the OK pushbutton.

5. On the next rung below, place a contact to the left. Assign it to use ‘AmberTimerDone’.

6. To the right of the contact, place a closed contact, and assign it to ‘GreenTimerDone’.

7. To the right of the second contact, place a coil and assign it to ‘RedLight’.

8. On the next rung, place a contact on the left, and assign it to ‘AmberTimerDone’.

9. To the right of the contact, place a closed contact and assign it to ‘GreenTimerDone’.

10. To the right of the second contact, place a coil and assign it to ‘AmberLight’.

11. Press return when the selected cell is on the right of the rung. This will create a new line.

12. Below the left ‘AmberTimerDone’ contact (but on the same rung), place a New Closed Contact and assign it to the symbol ‘RedTimerDone’.

13. Place a new Vertical by selecting the New Vertical button from the toolbar between the ‘GreenTimerDone’ Contact and the ‘AmberLight’ Coil. Connect this to the ‘RedTimerDone’ by placing New Horizontal connections to join to the Vertical by selecting the New Horizontal button from the toolbar.

Note: Connecting lines can be drawn by clicking the Line Connect Mode button and then clicking the starting point and dragging to the end point. Connecting lines can also be deleted by dragging after clicking the Line Delete Mode button. A line can also be drawn by dragging on a line that is not connected on one end.

14. Place a New Contact at the start of the next rung and assign it to symbol ‘GreenTimerDone’ via the New Contact dialog.

15. Place a Coil next to the contact and assign it to symbol ‘GreenLight’.

The output rungs of the Ladder program should resemble those shown below.

Instructions on the right side of rungs can now also be displayed horizontally (CX-Programmer Ver. 4.0 or later). Enable this function by selecting Tools – Options, and then selecting Show output instructions horizontally in the Diagrams Tab Page (the default setting is OFF: previously used vertical display). By using the horizontal display mode, the number of instruction rungs that can be printed and displayed on one screen is increased, improving the readability of the program. At the same time, the number of printed pages can be reduced.
Use the following procedure to examine the ladder program.

1, 2, 3…

1. Ensure the Ladder program is displayed in the Diagram Workspace.

2. Switch to symbol table by selecting the View Local Symbols button from the toolbar. Open the Address Reference Tool by selecting the Show Address Reference Tool button from the toolbar.

3. Examine each symbol’s usage in the program by selecting a symbol whilst displaying the Address Reference Tool, or moving around the diagram with the cursor.

The Ladder Program can also be viewed and edited in Mnemonics view. Block Programs can be entered in either Mnemonics view or by showing a rung in statement list within the ladder editor.

Select the View Mnemonics button from the toolbar to display the Mnemonics view. To enter mnemonics directly into the ladder editor, select Show as Statement List for the relevant rung.

Compiling the Program

The program undergoes continual verification during its creation and any subsequent editing; this applies to both on-line and offline programming. Errors appear in red in the ladder diagram. If a rung contains an error, a red line appears down the left-hand side of the Ladder rung. This can happen, for example, when has element has been placed on the diagram window but has not been assigned a symbol or address.

Use the following procedure to compile the program.

1, 2, 3…

1. To list any errors in the program, select the Compile Program button from the toolbar. The output (for example, compilation progress or error details) is displayed in the Compile tab of the Output Window.

Downloading the Program to a PLC

The project contains details of the type and model of the PLC for which the program is intended. Before a program can be downloaded, this information should be reviewed to ensure that it is correct and that it matches the PLC actually being used. The appropriate communications interface type should also be selected for the connected PLC. Other parameters, for example PLC Setup may need to be specified before connecting to the PLC and running a program. Refer to Chapter 4 - Reference and to the CX-Server PLC Tools User Manual concerning the definition of the project’s IO Table, PLC Settings, Memory Card and Error Log.

Use the following procedure to transfer the program to the PLC.

1, 2, 3…

1. Save the current project by selecting the Save Project button from the toolbar. If the project has not been saved before, the Save CX-Programmer File dialog is displayed. Enter a file name in the File name field and select the Save pushbutton to complete the save operation.

2. Connect to the PLC by selecting the Work On-line button from the toolbar. A confirmation dialog is displayed: select the Yes pushbutton to connect. Since ordinary editing is not allowed when on-line, the program becomes grayed.

3. Select the program object in the project workspace.

4. Set the PLC operating mode to Program by selecting the Program Mode button from the toolbar. If this step is ignored, CX-Programmer automatically places the PLC in this mode.

5. Select the Download button from the toolbar. The Download Options dialog is displayed.

6. Set the Programs field and select the OK pushbutton.

Programs can be downloaded to CS/CJ-series CPU Unit Ver. 2.0 or later, and downloading by task (program) instead of the whole user program is possible (CX-Programmer Ver. 4.0 or later). Select Partial Transfer – Task Transfer to PLC from the PLC Menu, and download a specified single task or multiple tasks. This function enhances the efficiency of program development by multiple personnel. Particularly, by downloading to the PLC by task (program), only the parts to be changed are reflected in the PLC, resulting in fewer working errors.
Uploading the Program from a PLC
Use the following procedure to transfer the program from the PLC.

1. Select the PLC object in the project workspace.
2. Select the **Upload** button from the toolbar. The Upload Options dialog is displayed.
3. Set the *Programs* field and select the **OK** pushbutton.

Comparing the Project Programs with the PLC Programs
A project program can be compared with the program in the PLC. Use the following procedure to compare the project program and the program on the PLC.

1. Select the PLC object in the project workspace.
2. Select the **Compare with PLC** button from the toolbar. The Compare Options dialog is displayed.
3. Set the *Programs* field and select the **OK** pushbutton. The Compare dialog is displayed.

Details regarding comparisons between computer and PLC programs are displayed in the Compile tab of the Output Window.

Offline Program Verification
Program verification is possible offline between the current project and a closed project file. (Select **Compare Program** from the **File** menu and select the file to be compared.) The results of verification can be saved to a file in CSV format.

Two methods can be used to display the comparison results.

- **Overview display**: Program lists are displayed of the compare programs.
- **Mnemonic display**: The specified program is displayed in mnemonic form with differences displayed in color.

The comparison results are displayed by section and mnemonic, including added or omitted instructions. You can also jump from the mnemonic comparison results to the corresponding position in ladder view. The comparison results can be saved in a file by selecting **Save As** from the **File** menu in the **Compare Result** dialog box. If the file is saved from the overview display, the comparison results for all programs will be saved in CSV format. If the file is saved from the mnemonic display, the comparison results for the currently displayed program will be saved in CSV format.

The following abbreviations will be displayed between program addresses and mnemonics and will be saved in the CSV file:

- *: Mismatch
- D: Difference
- M: Moved
- N: Missing

Monitoring a Program During Execution
Once the program has been downloaded, it can be monitored in the Diagram Workspace (which acts a mimic display) during execution. When CX-Programmer goes on-line to a PLC, the **Toggle PLC Monitoring** button also toggles on and starts to monitor the program. If the program is not monitored, use the following procedure to monitor the program.
1. Select the PLC object in the project workspace.

2. Select the **Toggle PLC Monitoring** button from the toolbar.

3. As the program executes, data and power-flow can be followed in the Ladder program; for example, connections are selected and values are incremented.

**Note:** Individual PLC data elements can be monitored via the Watch Window. This window allows monitoring of addresses from multiple PLCs at the same time.

**Note:** The values are monitored in a format according to the data-type of the symbol that is being used for the operand, or the data-type of the instruction operand itself. To always monitor in a single, hexadecimal format, turn on the **Monitor In Hex** option from the toolbar.

### On-line Edit

Although the downloaded program has been grayed to prevent direct editing, the Ladder program can be amended by explicitly selecting the On-line Edit feature.

It is usual to have the PLC operating in Monitor mode while using on-line editing functions. On-line editing is not possible in Run mode.

Use the following procedure to edit the program on-line.

1. Select the rungs to be edited by dragging the mouse and selecting the required rungs.

2. Select the **Compare with PLC** button from the toolbar to ensure that the edited area is the same as in the PLC.

3. Select the **On-line Edit Rungs** button from the toolbar. The background to the rung changes to show that it is now an editable area. The rungs outside this area cannot be altered but elements can be copied from these rungs into the editable rungs.

4. Edit the rungs as appropriate.

5. Select the **Go to online-edit rung** to go back to the top of the on-line editing rung.

6. When satisfied with the results, select the **Send On-line edit Changes** button from the toolbar. The editing is checked and transferred to the PLC.

7. Once these changes have been ‘sent’ to the PLC, the editable area becomes read-only once more. The on-line edit can be cancelled at any point prior to committing the changes by selecting the **Cancel On-line Edit** button from the toolbar.

**Note 1:** A symbol address or type cannot be edited on-line.

**Note 2:** I/O comments can be changed during online editing in Ladder diagram view, in the Symbol Table, or in I/O Comment View. If I/O comments have been changed when online editing is ended, a confirmation message will appear asking if the symbol table file should be transferred to file memory in a CS-, CJ-, CP-, CVM1, or CV-series PLC or to the I/O comment area in the allocated UM (user memory) in a C-series PLC.

Symbol table names and addresses cannot be changed during online editing.

I/O comments with symbol names cannot be transferred to the I/O comment area in UM (User Memory) in C-series PLCs.

### Attaching Comments

An attached comment is a comment associated with an element of a program (i.e. contact, coil or instruction). The comment is entered through the Properties dialog box of the element by selecting the **Properties** option from the context menu of the item.

When a comment has been entered against an element, a circle will appear at the top-right corner of the element. This circle contains a number that uniquely identifies the comment within the rung. The comment itself will appear to the right of the circle for output instructions (subject to the chosen ladder-information options), or it will appear in the Rung’s Annotation List.
Summary

In this chapter, the programmer has been introduced to the following concepts:

- Starting the CX-Programmer application.
- CX-Programmer and projects. The CX-Programmer environment, including the project workspace, Diagram Workspace, Mnemonics view and symbol tables.
- Getting started with CX-Programmer.
- Setting up a Ladder program.
- Writing a Ladder program.
CHAPTER 3
Project Reference

This chapter describes the different views available; the features common to the objects displayed in the Project Window and standard Microsoft Windows procedures that are also common to these components.

Project Workspace

The project workspace displays the project as a hierarchical tree structure showing related PLC and program details. Select the Toggle Project Workspace button from the toolbar to display the project workspace and remove the project workspace from the display.

A description of each object in the Project Tree Workspace and their associated context sensitive menus is provided in Chapter 4 - Reference.

Double clicking on an object opens it either in the Diagram Workspace or in a new window. Selecting an object and clicking the right-mouse button displays the associated context sensitive menu.

The hierarchy can be collapsed or expanded to show either a partial view or full view of the project tree.

More than one Ladder Diagram symbol table or Mnemonics View can be displayed. Select the appropriate window from the list of open windows from the Window menu.

Program Sections

For the easier management of large programs, a program can be divided into a number of definable, named sections. A section is like a chapter in a book – the PLC scans the sections in order.

A list of the sections in a program is displayed in the project workspace under the program name. There is also a section list view showing the Start and End steps, which can be opened in the workspace window by clicking on a program name.

It is possible to reorder and/or rename the sections from this list or from the project workspace. It is important to remember however that when reordering or deleting sections, keep the 'END' section at the end of the program.

Program sections can be reordered using the mouse to drag and drop sections up or down in the section list. When using the keyboard, the 'Move Up' or 'Move Down' commands from the context menu of a section on the project workspace are used.

Sections in a specific program can also be used to store frequently used algorithms that can then be copied to other programs, using a section as a kind of library.
Use the following procedures to insert, rename, move or delete a section in a program.

1, 2, 3…

1. **Inserting a new program section**
   
   (a) Select the program name in the Project tree.
   
   (b) Click the Insert pushbutton in the toolbar or from the Insert menu select Section. The new section will be added to the bottom of the section list before the ‘END’ section.
   
   Note that if previous sections have been renamed the new section will be named Section1, if not, it will be given the next section number.

2. **Renaming a program section**
   
   (a) Select the section to be renamed and click the right mouse button. From the context menu select Properties.
   
   (b) In the Properties dialog enter the new name for the section and then close the dialog. The new section name will be displayed in the section list.

3. **Moving a program section**
   
   (a) Select the program section to be moved, and from the Edit menu select Cut. Move to the location of the program (the program item on the project workspace) for the section to be placed, and select Paste from the Edit menu. Then using the mouse drag and drop the section in the appropriate position in the section list.
   
   (b) Instead of using the Edit commands, it is possible to drag and drop the section. Drag the section to the program item where it is required.
   
   Note that when the section is dropped, it will reposition its self immediately below the cursor. To drag a section to the top of the list, it must be dropped on the program item itself.
   
   A section may be moved to another program, or just within the same program, in which case it changes the execution sequence of the sections.
   
   (b) When using the keyboard the 'Move Up' or 'Move Down' commands from the context menu of a section in the project workspace are used. Each command will move the selected section up or down one position at a time.

4. **Copying a program section**
   
   (a) Select the section to be copied, and from the Edit menu select Copy. Move to the location of the program (the program item on the project workspace) for the copy to be placed, and select Paste from the edit menu.
(b) Instead of using the Edit commands, it is possible to drag and drop the section in a similar way to moving it. However, if the ‘Ctrl’ key is held down before dropping the section (on the program item), then a copy operation will take place.

5. Replacing a program section
(a) To replace a section, copy or move the required section on top of the one to be replaced. A confirmation is then requested.

6. Deleting a program section
(a) Select the section to be deleted, and from the Edit menu select Delete.

Section/Rung Manager
CX-Programmer allows all six functions described above to be done from the Section/Rung Manager dialog for sections and commented rungs of the programs.

Use the following procedure to edit the section and rung comments on the Section/Rung Manager dialog.

1, 2, 3…
1. Select the Section/Rung Manager button from the toolbar.
2. Select the program to be edited from the Program field.
3. All sections in the selected program are displayed on the Section field. The rung numbers and the rung comments of the selected section are displayed on the Rung Comment field.
4. Use the buttons on the right to edit rungs (i.e. Insert, Cut, Copy, Paste, and Delete). To edit the rung comment, select the rung and press the Edit Comment button.
5. Change the rung comment using the Edit Rung Comment dialog. Press the Enter key to close the dialog and to reflect the changes. To create a new paragraph, use the key combination Ctrl+Enter.
6. Select the section/s and use the buttons on the right of the dialog to edit them (i.e. Insert, Cut, Copy, Paste, and Delete). To edit the section name and/or comments, press the Rename button.
7. Change the section name and/or the comment using the Rename Section dialog. Press the Enter key to close the dialog and to reflect the changes. To create a new paragraph, use the key combination Ctrl+Enter.

By selecting Section/Rung Manager from the Program Menu, the rung comment data can be read (imported) from the project in the personal computer, and operations can be performed to move data up and down (CX-Programmer Ver. 4.0 or later). This function allows rung comments to be allocated to a program all at once after uploading the program under the following conditions, even if there is no comment file (COMMENTS.CMT) in the Memory Card/EM file memory.
1) When uploading programs from a C-series PLC or other CPU Unit that cannot record rung comments.

2) When uploading programs from a CS/CJ/CP-series, CVM1/CV-series, or C200HX/HG/HE-ZE CPU Unit. When the uploaded programs are changed in the actual CPU Unit using functions such as online editing, the position of the rung comment can be edited.

**Downloading/Uploading**

CX-Programmer can also use a PLC instruction to store the section markers in the PLC when the program is downloaded. This will allow CX-Programmer to upload a single section for online-editing. It will also allow CX-Programmer to upload the program complete with section breaks.

A single program section may be uploaded for online-editing (reducing the transfer time to a minimum). However, it may not be downloaded since it is only a program segment. To download a program section, it is necessary to copy it into a complete program.

**Cross-Reference Report**

The Cross-Reference Report allows the symbol usage within different memory areas to be examined. It can be used for checking the values being set by instructions when the program is not behaving as expected. It can also allow the programmer to make efficient use of memory resources.

Use the following procedure to generate a cross-reference report.

1. Select the **Cross-Reference Report** button from the toolbar to open the Cross-Reference Report.
2. Select a usage from the **Report type** field; either **Detailed Usage**, **Usage Overview with comments**, **Usage Overview Including Unused**, **Usage with Comments Including Unused**, or **Duplicate Usage Over Programs**.
3. Select an area from the **Memory Area** field. When changing options, reselect from the **Memory Area** field to refresh the report.
4. Select the **Generate** pushbutton to activate the report. In addition to the address report information, the amount of free program memory in the PLC is displayed in the **Free UM** field. The total program memory size of the PLC is displayed in the **Total UM** field.

The **Detailed Usage** option within the **Report type** field displays information about the usage of any address used within the PLC program(s). The program name, step number, instruction type, the start address of the operand and symbol details relating to each usage are shown.

The **Usage Overview** option within the **Report type** field displays an overall summary of the usage for the selected memory area, showing only the addresses that are in use. For each used address, a usage count is displayed. The ‘D’ symbol denotes that the address has a symbol assigned to it.

The **Usage Overview Including Unused** option within the **Report type** field displays the usage overview of the memory area, including addresses that are not used.

The cross reference function usage list can be displayed with I/O comments and the list can also be printed (CX-Programmer Ver. 4.0 or later). Therefore, the user can check what the addresses mean when checking the number of times the addresses have been used. This reduces the labor required for programming/debugging. This function can also be used to jump to the position of the rungs being used.
By moving the cursor to an address in the ladder diagram and selecting **Check usage including unused**, the usage list (with comments) can be displayed starting with the selected address (CX-Programmer Ver. 4.0 or later). This function enables the cross references to be checked for the address directly from the ladder display instead of from the cross reference report.

By selecting **Duplicate usage in programs** in the cross reference report function, a list can be checked for any bits/words that have been allocated an address already being used by another task (see note; CX-Programmer Ver. 4.0 or later). This function can be used to easily check whether the same address is being used by another task (programmer) when two or more programmers are creating multiple tasks. **Note:** Cyclic tasks only (interrupt tasks not included).

A cross-reference report can be printed. Use the following procedure to print a cross-reference report.

1. Select the **Cross-Reference Report** button from the toolbar to open the Cross-Reference Report.
2. Generate an appropriate cross-reference report.
3. Select the **Print** pushbutton. A standard Microsoft Windows Print dialog defines printer settings and allows print parameters to be entered.

### Address Reference Tool

The Address Reference Tool shows how and where a PLC address is used within the program set of a PLC.

Use the following procedure to use the Address Reference Tool.

1. Open a Ladder program by double-clicking the program object in the project workspace.
2. Select a cell in the Ladder program.
3. Select the **Address Reference Tool** button from the toolbar. The Address Reference Tool window is displayed in the Diagram Workspace. The Address Reference Tool displays a list of references made to the address selected in the Ladder program.
4. With the Address Reference Tool still open, another selection can be made in the Ladder program; the Address Reference Tool is refreshed accordingly.

The Address Reference Tool is displayed in front of other windows. Only one Address Reference Tool can be opened at a time. The window can be ‘docked’ within the main CX-Programmer window.

**Note:** It may be necessary to show the address reference tool in order to use the commands **Go to Next Output**, **Go to Next Input** and **Go to Next Address Reference**, depending upon the diagram options chosen (see page 32).
Output Window

The Output window is usually displayed at the foot of the main window. Select the Toggle Output Window button from the toolbar to display the Output window. Select the Toggle Output Window button from the toolbar or press an ESC key to remove the Output window from the display.

The Output Window has three different views:

- **Compile.** The Compile tab displays the output produced from program compilation. Selecting an error highlights the source of the problem in the Ladder Diagram. The Compile tab also displays other information, for example, warnings and connection messages.
- **Find Report.** The Find Report tab displays the output produced from a search of project files for a particular entry. Refer to Chapter – 3 Finding and Replacing.
- **Transfer.** The Transfer tab view displays the results of file or program loading.

To clear the view, select Clear from the context sensitive menu.

To go to the source of errors indicated in the Compile or Find Report tabs, double-click the message in the output window. It is also possible to use the Next Reference command from the Edit menu – this jumps to the location of the next message on the output window, whichever tab is on show. The location jumped to is highlighted in the Diagram Workspace. Note that is possible to quickly move through the location of the messages by continually using the Next Reference command.

**Note:** Whenever compilations, PLC conversions, find reports, or file loading is displayed on the Output window, it automatically opens to show the results even if the window is closed. To close the Output window, simply press the ESC key.

Watch Window

The Watch window allows the contents of specified PLC addresses in more than one PLC to be monitored at the same time. The Watch window is usually displayed at the foot of the main window. It displays the value of the contents of PLC memory during program execution. The watch window also supports drag and drop enabling elements from the ladder view or the symbol table to be dropped on to the watch window. Watched items can also be added directly on the sheets or via a dialog box, and can be grouped into different sheets.

Use the following procedure to use the Watch window.

1. Open the Watch window by selecting the Toggle Watch Window button from the toolbar View – Windows option.
2. Enter an address directly in the Address column on the watch sheet. Press the Enter key to set the address. Press Esc to cancel the address.
3. The **PLC name**, the **symbol name**, and/or the **data type/format** may be selected on the **Edit Dialog**. To display this dialog, double-click on the cell of the Watch window, or select **Edit** from the context sensitive menu. Select the **Browse** pushbutton to locate a symbol, if required. Note that a local symbol may be entered by typing in the program and symbol name, separated by a '.' character (this symbol 'path' is also shown in the watch window for local symbols).

4. Select the **OK** pushbutton to complete the operation. Select the **Cancel** pushbutton to abort the operation.

The PLC name is added to the Watch window. During program execution, the changing value of this address is displayed. Values can be set in this window to a specific value to test program execution. Watch items can be monitored either on the **Watch window** (for any number of watch items) or on the **Set New Value** dialog (for one watch item). On the **Set New Value** dialog, the value can be monitored in Binary number (except for data type: BOOL/ASCII and area type TIM/CNT). Each bit can be **Force Set/Reset/Cancel** and **Set/Reset**.

**Array Variable Monitoring**

To monitor an array variable in the Watch Window, it is possible to register the variable by dragging/dropping it directly from the symbol table to the Watch Window. All elements of the array variable can be monitored in the Watch Window.

**Displaying PVs of Addresses in the Watch Window Sheet in Binary**

The watch sheet includes a column that allows the PVs of addresses to always be displayed in binary regardless of the settings specified in **Data Type/Format**. **16 BIT (Binary, Channel)** can also be selected from the **Data Type/Format** Options, allowing values to be displayed in binary, even if the Binary column is hidden (except in the Timer/Counter Areas). (CX-Programmer Ver. 4.0 or later.)

**Changing the PVs for DM/EM Areas in Bit Units**

While online, when the binary display is selected in the **Set New Value** dialog that is displayed when the address in the watch window is clicked, the DM/EM Area data can be changed into PVs in bit units (CX-Programmer Ver. 4.0 or later).

**Pause Monitoring**

When pause monitoring is taking place, items in the watch window are monitored as normal until the trigger point is reached or the user triggers manually. At this time, the monitoring is stopped and the value field of all items within the watch window is cleared. When either monitoring or pause monitoring is re-started, the value field of all the items within the watch window is refreshed with the current value.

**Dragging and Dropping Items**

Symbols, ladder elements and symbol tables (from the project tree view) may be dragged and dropped into the watch window. These items may be dragged individually or in block form. It is not possible to drag elements into the watch window from the mnemonic editor, or entire sections from the project tree view. Items may not be dragged from the watch window i.e. it is only a drag and drop target and not a source.
It is not possible to view items that are of a Number type. Items that are of a Number type and are dropped into the watch window will not be displayed and an error message for each item is displayed in the transfer output window.

Pasting Items
Pasting items into the watch window is similar to the drag and drop mechanism. The items that may be pasted are symbols, ladder elements and symbol tables (from the project tree view).

It is not possible to view items that are of a Number type. Items that are of a Number type and are pasted into the watch window will not be displayed and an error message for each item in the transfer output window.

Items can be cut or copied within the watch window (i.e. cut or copy items to another sheet).

Differential Monitoring
It is possible to initiate differential monitoring from the PLC | Monitor option or from the watch window via a pop-up menu item. This will display a dialog where the user may select the type of transition trigger required for the currently selected item in the watch window. The dialog will then show a count of how many times this transition has occurred until the user closes the dialog.

This facility is only available when the PLC for the currently selected item is in run or monitor mode.

Options and Preferences
A number of options and preferences can be set by selecting Options from the Tools menu.

Diagrams
The Diagrams tab allows settings to be applied to the Diagram Workspace upon entry to CX-Programmer.

Use the following procedure to change the settings applied to the Diagram Workspace.

1, 2, 3...
1. Select the Diagrams tab within the Options dialog.
2. Set the Show rung and step numbers to view the rung and step numbers at the left of the ladder display, in the rung margin. Deselecting gives a smaller rung margin.
3. Setting the Show rung dividers will draw a line at the bottom of each rung, showing its boundary.
4. Setting the Show grid by default will place a dot pattern around each cell on the ladder diagram. This pattern can aid element placement, but may be removed for a clearer display.
5. If the Show rung annotation lists is set then the list of comments that are within the rung (both attached comments associated with particular elements within the rung, and unattached comments) will be listed below the rung comment. Note that this option can be quickly changed via the View Rung Annotations button on the toolbar.

6. Setting the Allow Address Referencing without Window option allows use of the Go to Input, Go to Output, Go to Next Address Reference and Go to Previous Jump Point commands when the address reference tool is not on show. If this option is not set, then the tool must be visible to use these commands. Note that when address referencing is active, a small delay may be experienced when moving around a diagram, depending upon the size of the PLC program.

7. Setting the Show actual I/O bit in XY will change the prefix of addresses ‘I:’ and ‘Q:’, which are mapped to either an input unit or an output unit, to ‘X:’ and ‘Y:’.

8. Setting Check duplicated output and TIM/CNT No. executes a check for an output and timer/counter, whether the address is already used in the program or not. The result may be displayed on the Output window.

9. Setting Synchronize ladder and mnemonic cursors allows the position of the cursor in the mnemonic view to move to the same step number as the cursor in the ladder view moves.

10. Selecting Tools – Options, and then selecting Show output instructions horizontally in the Diagrams Tab Page (the default setting is OFF: previously used vertical display) enables special instructions (except intermediate instructions) to be displayed horizontally (CX-Programmer Ver. 4.0 or later). By using the horizontal display mode, the number of instruction rungs that can be printed and displayed on one screen is increased, improving the readability of the program. At the same time, the number of printed pages can be reduced.

11. Selecting Show symbol bar in the Diagrams Tab in the Options Dialog Box of the Tools Menu (the default setting is ON: display) enables the global/local, name, address/value, and comment fields for the variable at the cursor position to be displayed in the symbol bar below the Ladder Section window (CX-Programmer Ver. 4.0 or later). This increases the program display density, while allowing the text in particularly long comments to be checked, thereby improving the readability of the program.

12. View to show when split – enables two different views to be shown within the editing window. It is possible to choose to see a part of the editing in mnemonic mode and the other in ladder, or to see the local symbol table of the program in one view.

13. Setting the Show right bus-bar will show the right bus-bar with the ladder rungs justified to fill the space between the left and right bus-bars. The output instructions will appear aligned along the right bus-bar, as long as the rung can be drawn within the number of cells to the right bus-bar. If the Expands to Widest Rung option is chosen, then the right bus-bar position for a section is automatically set to the widest rung in the program section. Note that this may result in slower performance on a large section when editing or adding rungs, since if a rung is expanded beyond the current width, the section will be reformatted.

If no right bus-bar is shown, the rungs are justified to the left, minimizing space.

14. Setting Show in simple dialog mode allows Contact, Coil or Instruction dialogs to open in small sizes. The Show with comment dialog option allows dialogs to display for entering comments in simple dialog mode.

15. Symbol filtering sets the target data of symbol filtering for the specified text string when inputting instruction operands.

- Name: Searches symbol names only.
- Comment: Searches I/O comments only.
- Both: Searches both symbol names and I/O comments.

16. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton to abort the operation.
The PLC tab provides a default PLC and CPU which appears when adding a new PLC to a project. Use the following procedure to change PLC preferences.

1. Select the PLC tab within the Options dialog.

2. Set the Confirm all operations affecting the PLC setting to receive a confirmation message for computer to PLC communications.

   If a checkmark is placed in the Prohibit the online operations until the PC and PLC data matches checkbox on the PLCs Tab Page that appears when Tools—Options is selected, an Online Action Dialog Box to select either verifying or transferring data will be displayed. Depending on the selection, before going online, the program will be verified between the CX-Programmer and the PLC, the program will be transferred to the PLC, or the program will be transferred from the PLC. Refer to Programming On-line in Chapter 4 of PART 1 for details.

3. Select Tools – Options and Confirm all operations affecting the PLC in the PLCs Tab Page (the default setting is OFF: no confirmation) to prevent going offline unprepared when the CPU Unit is still in forced set/reset status (CX-Programmer Ver. 4.0 or later). After forced setting/resetting of a bit online, a dialog box is displayed when status returns to offline to allow the forced set/reset status of addresses to be displayed. The forced set/reset status can also be cancelled.

4. Select the default PLC from the PLC Type field. When set CX-Programmer will show a confirmation dialog when an operation being carried out may affect the running of a PLC.

5. Select the default CPU from the CPU field. When a new PLC is created, these details will be used to initialize it. A PLC type and CPU combination may be selected, or the Use Current PLC button can be pressed, to set the details to that of the currently selected PLC in the project.

6. Set the Use Section marker instruction option to select whether, by default for a new PLC, section divisions are to be downloaded or not. If set, an extra instruction is hidden in the program for each section division. This allows upload options such as the upload of a single section. It also allows the section structure to be retained upon upload. If the option is turned off for a PLC, then the section structure will not be downloaded, and upload will not retain the structure.

   Note that this option can be enabled / disabled per PLC in the PLC properties dialog.

7. The Use Comments instruction option determines, by default for a new PLC, whether program comments (rung comments and annotations) are to include a CMT instruction in the PLC. CMT instructions are used during upload so that comments in a comment file can be linked back to the program properly. If this is not set for a PLC then it is not possible to upload comments, but compiled programs will be smaller since CMT instructions are not generated.

   Note that certain PLC types do not have CMT instructions, and this option will have no effect for those PLCs.

   Note that this option can be enabled / disabled per PLC in the PLC properties dialog.

8. Set the Default Program Type in new PLC option to set the default program type when creating new projects. The program type can be one of the following three options: Ladder, ST, or SFC.

9. Set the Automatically Transfer Program to Simulator option to allow program to be transferred automatically after on-line to the Simulator.

10. Set the Continuous Step Interval option to set the time for continuous step execution of individual steps by the Simulator. The setting range is 0 to 1000 × 100 ms (i.e., 0.0 to 100.0 s) and the default is 500 ms (i.e., 0.5 s).

11. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton to abort the operation.
Symbols

The Symbols tab allows settings to be applied to the symbol table during a work session. Use the following procedure to change Symbol preferences.

1. Select the Symbols tab within the Options dialog.
2. Check the Confirm changes in linked global symbols setting to ensure a confirmation dialog is displayed before changes are applied to global symbols.
3. Check the Paste rungs to another PLC with unaddressed symbols option to allow rungs to paste to another program with symbols unaddressed. The symbols will need to be addressed after copying to another program.
4. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton to abort the operation.

Auto Generation

The Automatically generate symbol names option determines whether ‘unnamed’ symbols (i.e. symbols that are created with an address and comment but no name) are automatically assigned symbol names using the “AutoGen_” prefix, or whether the symbol name is just left blank.

When the option is checked on the following rules apply:

1. When an ‘unnamed’ symbol is created it will automatically be assigned a name, based on the address (e.g. an ‘unnamed’ symbol with address 7.15 will be called “AutoGen_7_15”).
2. When the option is checked on it will be possible to reference “AutoGen_” symbols like any other symbols (Hence, using Find/Replace, Watch Window etc).

Appearance

The Appearance tab allows the colors and font displayed within the CX-Programmer environment to be customized.

Use the following procedure to change preferences associated with the CX-Programmer appearance.

1. Select the Appearance tab within the Options dialog.
2. Select the item to be changed from the Item field, or select the item to change in the sample diagram.
3. Select the color to be applied to the item. The Foreground and Background Color may be changed by clicking on the example color box, or using the ‘Custom...’ button. A sample of the result is displayed in the Sample field. Note that many items do not have both a foreground and background color.
4. Check the default option in order to use a suitable system color. These colors will change according to the ‘Appearance’ display settings of Windows.
Click the **Reset All** button to reset all the colors back to the system defaults.

Click the **Ladder Font** button to set the font used for the entire display of ladder programming windows, including rungs that are being shown in statement list in the ladder window. When a font is selected, the ladder display re-scales to use the new font.

Click the **Mnemonic Font** button to set the font used for the entire display of mnemonic programming windows.

Click the **ST Font** button to set the font used for the entire display of the Structured Text programming window.

Click the **SFC Font** button to set the font used for the entire display of the SFC programming window.

The **Cell Width** slider allows the width of the cells to be changed on the ladder window, giving more or less space for text to be displayed. Depending upon the typical size of symbol names, it may be necessary to change the horizontal size of the ladder cells to show them better. At its minimum setting, only a few characters are shown in a line, but a large number of cells can shown.

Click the **OK** pushbutton to apply the settings and close the dialog. Select the **Apply** pushbutton to change the settings but remain in the dialog. Select the **Cancel** pushbutton to abort the operation.

---

### Ladder Information

The elements of a ladder display - contacts, coils, instructions and instruction operands - can display a configurable set of information. The more information is displayed, the larger each cell of a ladder diagram becomes. Ideally, only the necessary information should be shown so that the maximum number of cells can be seen on the screen.

The name and comment parts of the operand information can be individually shown or hidden using the Show checkboxes.

![Options](image)

#### Name

When this option is selected it is possible to set the number of lines to be shown for a symbol name, and whether they are shown above or below the element (i.e. above or below a contact or coil).

#### Address

The **If name empty** option will only show the address of an operand if there is no symbol attached to the address, or if the symbol is unnamed. The **After name** option shows the address after the name, separated by a comma. The **Above** and **Below** options show the address on a separate line, above or below the element respectively.

#### Comment

When this option is selected it is possible to set the number of lines to be shown for a comment, and whether they are shown above or below the element (i.e. above or below a contact or coil).
Instructions
A range of options are given to determine the information and format of data within instructions.

The **Show data with** option allows a choice of where monitoring data will be shown within the operand box of an instruction. It can be shown below the name, address or comment of the symbol. It can also share the line of the name, address or comment, so that the monitoring data is shown before the information on the same line. This allows the size of the instruction box to be minimized.

**Show on right for output instructions**
A range of information can be shown on the right of output instructions (i.e. coils and right-hand instructions such as 'MOV').

The Symbol Comment of the symbol used within the operand can be shown. If this option is set, the comment is no longer shown inside an output instruction or coil cell.

The Attached Comment (comment property of the instruction element on the diagram) can be shown.

The Instruction Description (shorthand description of the instruction, the same as that shown in the Instruction dialog) can be shown.

The Operand Description (shorthand description of the operand purpose, the same as that shown in the Instruction dialog) can be shown.

Special instructions (except intermediate instructions) can also be displayed horizontally (CX-Programmer Ver. 4.0 or later). Enable this function by selecting **Tools – Options**, and then selecting **Show output instructions horizontally** in the Diagrams Tab Page (the default setting is OFF: previously used vertical display). By using the horizontal display mode, the number of instruction rungs that can be printed and displayed on one screen is increased, improving the readability of the program. At the same time, the number of printed pages can be reduced.

Note that it may not be possible to fit all of the requested information on the right of the instruction - the height of a cell is not determined by these choices. The 'Attached comment' is always shown first (i.e. highest priority), followed by the 'Symbol Comment' and then the descriptions.

**Show Program/Section Comments**
When the **Show option** is checked, every first rung in a section will show the Program Comments and Section Comments at the top of the ladder program. Double-click the comments to edit them.
General

The General tab provides settings that allow the CX-Programmer environment to be customized.

Use the following procedure to change the environment of CX-Programmer.

1. Select the General tab within the Options dialog.
2. Select the IME auto start option to use 2byte coded characters, if installed.
3. The Window Environment options to set the window style when project is created or opened.
   (a) When the Previous window environment option is selected, CX-Programmer will open a project using the settings of last saved.
   (b) When the Show ladder only option is selected, the project will be opened with only the ladder view, all the other windows will be hidden.
   (c) When the Show Window option is selected, a window to show when a project is opened can be set. The selections of windows are Workspace, Output, Watch, and Address Reference Tool.
4. Select Do not normalize rungs at compile for program verification to prevent verification errors due to normalization of rungs.
   When verifying CX-Programmer project files with programs in the PLC, if redundant mnemonic codes that were written using the previous support software or CX-Programmer are present in the PLC, a verification error may occur for the same program because the CX-Programmer normalizes redundant rungs in the project files when compiling programs. Select this option to prevent this type of error.
5. Set the Max. No. of Windows option to limit the number of windows to open.
6. Select the OK pushbutton to apply the settings and close the dialog. Select the Apply pushbutton to change the settings but remain in the dialog. Select the Cancel pushbutton to abort the operation.
SFC

It is possible to set the display settings for the SFC diagram editor. For details, refer to the *CX-Programmer Operation Manual SFC* (Cat. No. W469).

Magnification

The magnification level (i.e. zoom) of the Diagram view can be adjusted to display more or less information as required. If the diagram is zoomed out then the font becomes smaller and more diagram elements can be seen.

Use the following procedure to set magnification levels.

1. Open the Diagram Workspace.
2. Select the **Zoom In** button or the **Zoom Out** button from the toolbar to change the Diagram Workspace.
3. Select the **Zoom to Fit** button to change the size of the program width to the length of the Diagram view.

Finding and Replacing

CX-Programmer provides facilities for finding references to particular text, and replacing text with other text. There are also powerful replacement options, such as moving a range of addresses to another starting point. The Search and Replace functionality consists of two dialogs, depending on which operation is being executed. The Find dialog is opened from the **EDIT | Find** menu option or the key combination Ctrl+F. The Replace dialog is opened from the **EDIT | Replace** menu option or by pressing Ctrl+H.

It is possible to find and replace text from various places: the project workspace, diagram workspace (ladder or mnemonic views), a symbol table, and an I/O Comment view.

When using the Find and Replace feature from the project workspace, the operation searches the chosen object, including any objects within it. For example, when finding text from a program within the project workspace, the local symbol table for that program is also searched. When beginning a search from the project object itself, everything within the project is searched.

It is also possible to limit the search to a single program window, symbol table, or I/O Comment view by beginning the search when the relevant ladder, symbol table, or I/O comment window is active.

When **Change All** is selected from the Edit menu option, the Change All dialog to replace **Addresses** within the PLC will be opened. Enter the **Find what** and **Replace with** text as described in *Using Find and Replace* in this chapter, the replacement of the text will be applied throughout the entire PLC.
Rules for Finding

Symbols may only have their details replaced when in the symbol table. An attempt to replace a symbol name or address whilst in the Ladder View will result in the generation of a new contact that will appear in error. Symbol comments may only be replaced whilst in the Symbol Table, and so the option to replace comments are not allowed by disabling the replace buttons.

When doing a text search information will only be found in a step, regardless of whether it is being filtered from the view or not. For example in the Symbol Name is not being displayed but the symbol is found to have a match, the symbol will still be highlighted.

Tree searching is the same as a normal search, in so much as the same rules are applied to Address, Value and Text searching as if carried out in a single view. For each branch of the tree the following search criteria is applied.

- **Find in Project**: finds occurrences in all PLC’s, Symbol Tables and Programs.
- **Find in PLC**: finds occurrences in all Symbol Tables and Programs.
- **Find in Global Symbol Table**: finds occurrences in this Global Symbol Table only.
- **Find in Program**: finds occurrences in Local Symbol Table and all Sections.
- **Find in Local Symbol Table**: finds occurrences in this Local Symbol Table.
- **Find in Section**: finds occurrences in this Section.
- **Find in area**: finds occurrences in I/O Comment view.

Other find features supported include: Multi-byte character sets (MBCS), Multiple instances in a rung, Statement List (SL) – as standard Ladder View and while online to a PLC.

Find

The Find dialog allows various types of search to be carried out inside a window, from the project workspace and while online to a PLC. Select *How to Input* pushbutton to show examples.

Use the following procedure to execute a find.

1. 1. Select an object in the project workspace to begin the search.
2. 2. Select the *Find* button from the toolbar or select the Find option from the Edit menu.
3. 3. Select the required *Look At* entry from the drop-down list. This allows a choice to be made of the type of item being searched/replaced. The choices are as follows:
   - **All (strings)** – searches all the search targets, including addresses, constants, numbers, mnemonics, variable names, I/O comments, rung comments, and other comments. (CX-Programmer Ver. 4.0 or later.)
   - **Bit Addresses** – searches for addresses within program operands and symbols in the Bit unit. No period is needed to enter an address. This will not find CHANNEL addresses and values set into operands (such as ‘&’ or ‘#’ operands), but will find TIM/CNT numbers (by setting a T/C address).
   - **Addresses** – searches for addresses within program operands and symbols. This will not find values set into operands (such as ‘&’ or ‘#’ operands), but will find TIM/CNT numbers (by setting a T/C address).
Values – searches for numeric values within program operands and NUMBER data-type symbols. This also finds timer/counter numbers in TIM/CNT instructions.

Mnemonics – searches through a program by examining the entire statement list line of each step. Using this, it is possible to search for a combination of a particular instruction and operand together. It is possible to change the instruction.

Symbol Names – searches for names of program symbols (local and global).

Symbol Comments – searches for comments of program symbols (local and global).

Program Comments – searches for comments within a program. This includes the comment made against a rung, or its set of annotations (comments made against a particular element in the program, or comments from comment boxes in project files from previous versions of CX-Programmer).

4. Enter the text or item to be found in the Find What field. The pull-down list on the Find What field can be used to enter the contents used for previous find operations.

5. Select the search criteria from the available options.

   Note: By deselecting Include symbol table, the symbol table can be omitted from a search and the search range will include the ladder program only. This omits unnecessary searches of symbol tables, thereby shortening the search time. (CX-Programmer Ver. 4.0 or later.)

6. Select either the PLC or Current view to set the scope of the search. Click Find Next to begin the search. The result of the search is displayed in the box below Scope. This displays the match found, and where in the string it was found. The view also changes to where the result is located. Select Cancel to abort the operation.

7. Click Report instead to produce a report of all occurrences of the search. Once this report is generated, shown on the ‘Find Report’ tab of the output window, it is possible to move to a particular occurrence by double-clicking the report line.

   Note: During a search matches are described by a context descriptor string above the lower scope box. The information contained in this string will include Step, Operand, and Step Mnemonic information.

Using Find and Replace

Type of search
The search takes place within programs and symbol tables, depending upon the currently selected item on the Project Workspace or the currently selected window. If for example the focus is on the Project Workspace when the search is started then all searchable items within the workspace will be searched in tree order. When the search is started from a section, or from the tree set at either section or symbol table level then only that item will be searched. If the search is started at program level then only the local symbol table and the sections relating to that program level then only the local symbol table and the sections relating to that program are searched. When the search is started at PLC level then global, local and all sections will be searched. If the search is started at the project level than all PLCs and their global and local symbol tables and sections will be searched.

Note that if search is started when the focus is on the I/O Comment view, the search will occur only on this view.
Finding and Replacing Text

This applies to the 'Look At:' choices of 'Mnemonics', 'Symbol Names', 'Symbol Comments' and 'Program Comments'. Select How to Input pushbutton to show examples.

1. Select the Replace button from the toolbar or press Ctrl+H to open the Replace dialog.

2. In the Look At: field select the area to be searched. Select either 'Mnemonics', 'Symbol Names', 'Symbol Comments' or 'Program Comments'.

3. In the Find what field, enter the text to be searched for.

4. In the Replacement field, enter the replacement text.

The pull-down list on the Find What field can be used to enter the contents used for previous find operations, and the pull-down list on the Replace with field can be used to enter the contents used for previous replace operations.

5. Select either PLC or Current view to set the scope of the find and replace. Click Find Next to find and display the next assurance of the match, click Replace to replace the match or Replace All to replace all matches. The result of the find and replace is displayed in the box below Scope. The box displays the match found, and where in the string the match was found.

Note: The first click of the Replace button can also be used to find the next occurrence. Two clicks will find the next occurrence and perform the replace.

Normally, a match will only be found if text within the item matches exactly what is being searched for. Note, however, a 'wildcard' can be used of '*' to search for partial matches. The '*' wildcard indicates that any following characters are to be ignored in a single word when searching for a match. Note that the wildcard operates on each word separately. e.g. to search for mnemonic lines for the 'MOV(0221)' instruction where the second operand is D1, the following search can be made – "MOV* D1".

In addition, it is possible to search for 'Whole Word Only' - a match will only be found if an entire word matches the text typed. If this option is not selected, then a match will be found if a word contains the text typed, and any text may be in front or behind the 'Find What' text in the same word. For this search a match will normally be found regardless of case. If an exact match is required, select the 'Match case' option.

Wild Card Searching

A wildcard can be used in the search and replacement text. This will have the effect of using the text that the corresponding wildcard in the find string became. e.g. Using a ‘Find what’ of ‘ab*’ and a replace of ‘tr*’ will change ‘about’ into ‘trout’ and ‘abort’ into ‘trort’.

Mnemonics Searching

The Mnemonic search is the same as the normal text search, except it can be used to retrieve almost any information about the symbol or step it may be contained in (except rung comments). A Mnemonic search is able to retrieve all the information of Address, Value and Symbol Name searches. Matches found using a Mnemonic search though will only display information in the Mnemonic line of an Instruction Step, and will not track to the exact operand that the match may belong in.

The entire line of mnemonic is search so it is possible to specify any string that may occur in a mnemonic, e.g. an instruction followed by an operand.
**Rung Comment Searching**

Rung Comments are treated the same as any other text based search, but can not be accessed in the symbol table.

**Finding and Replacing Addresses**

This search and replace operates the same as for the 'Text' but applies only to the 'Look At' choice of 'Bit Addresses' and 'Addresses'.

The choice of 'Bit Addresses' is only available when searching and replacing for only addresses of BOOL type. No period is needed when entering the addresses in the 'Find What' field in this case. e.g. '1000' will search for address '10.00' only.

For the choice of 'Addresses', type in the address or addresses which are to be found in the 'Find What' field. A range of addresses may be input by using a dash ('-' or minus) between two addresses. e.g. 'A100-A200' will find addresses 'A100' 'A110' and 'A200'.

When a CHANNEL address has been entered, a choice of 'Include BOOLs' is available. If this is checked, then bit addresses within the channel will also be matched. e.g. If a 'find' of A100 is input, and 'Include BOOLs' is selected, then addresses 'A100', 'A100.00' and 'A100.15' will be matched.

**Moving Addresses**

It is possible to move a range of addresses. To do this, enter a range in the 'Find What' field, and enter a new start address for the start of the range in the 'Replace' field. Note that a dash must be included at the end of the 'Replace' field, indicating that a new range is given. e.g. 'Find What' of 'A100-A200' and 'Replace With' of 'B100-' will move the range of addresses 'A100-A200' inclusive to a new start address of 'B100'. 'A100' will move to 'B100', and 'A101' will move to 'B101' etc. If the 'Include BOOLs' option is selected, then bit addresses will be moved along with channel addresses (e.g. 'A100.0' will move to 'B100.0' etc), otherwise bit addresses will not be affected.

**Finding and Replacing Values**

This search and replace operates the same as for Text but applies only to the 'Look At' choice of 'Values'.

When operating on values, it is necessary to choose whether floating point or integer numbers are to be manipulated. Numbers used in program operands are either floating point or integer type. e.g. Numbers used in TIM/CNT instructions to indicate the timer/counter are integers. Any operand value starting '+', '-' or containing a decimal point is a floating point value. A value beginning in '#' is a hexadecimal integer value.

**Note:** BCD operands are shown in the programming windows with a '#' on the front, but are decimal values. When searching for a value in the find dialog, a '#' prefix means hexadecimal. Therefore, a find of '#10' will actually match a BCD operand of '#16'. A replacement of '#10' will actually show as '#16' back in the program display for a BCD operand.

It is possible to move a range of integers to a new starting point, using the same method as 'Moving Addresses'.

**Changing TIM/CNT Operands**

It is possible to change the first operand of a TIM/CNT instruction easily, at the same time as changing the address used for its status bit. To do this, use the 'Address' look-at type, and type in the address of the status bit/s to operate on (e.g. T0001). This will also find the first operand of a timer/counter instruction (e.g. If T0001 is looked for, then '1' will also be found in the TIM instructions).

Therefore, it is possible to change a range of TIM numbers to another offset.

**Finding and Replacing Symbols**

It is possible to perform a replace on 'Symbol Names' within a program, but this only updates the program, so that the new name is inserted as the operand. The replacement within the program does not affect the underlying symbol definition.

When a symbol name is updated in the symbol table, the programs using the symbol will also be updated to use the new name.

**Note:** It is not possible to change the definition of a symbol from within a program. i.e. A symbol's comment or name cannot be changed unless the replace is happening within the symbol table.

**Improvements to Global Replacement Operation**

Changes between normally open contacts and normally closed contacts can be performed for specified addresses using the Change All operation.
If *Change All* is selected from the *Edit* menu and a checkmark is placed in the checkbox for *Invert open/close bit* before performing a global replacement for the PLC, all specified operands that are normally open contacts will be changed to normally closed contacts and all normally closed contacts will be changed to normally open contacts.

**Note:** If the check box for symbols (including I/O comments) is cleared before an address is replaced globally, the symbols table and I/O comments will not be changed and only addresses in the ladder program will be changed. If the check box for symbols (including I/O comments) is selected before an address is replaced globally, the replacement operation will be the same as the previous version of the software (version 3.0).

**Finding and Replacing Symbols in the I/O Comment View**

Symbol comments can be searched and replaced on the I/O Comment view. Use the I/O Comment view to replace comments of TIM/CNT instructions (for both BOOL and CHANNEL types) and to update those changes to all symbol tables and programs.

**F3 Searching**

When the search dialog is closed search is possible using the F3 key. The same search criteria is used except that the search will never progress beyond the scope of the focus. Hence, a single view focus will never open another view whereas if the scope is a program level then the search will continue for the scope covered by that of a normal search.

**Note:** Mnemonic searches do not require an asterisk * or parentheses () with function codes input after the mnemonic search target (CX-Programmer Ver. 4.0 or later).

**Properties**

Each window or object in CX-Programmer has associated Properties that can be displayed. The method of displaying the tool is the same.

The following Properties are available:

- ♦ Project;
- ♦ PLC;
- ♦ Program;
- ♦ Section.

A Pin feature is available for all Properties. Select the **Pin** button from the Properties dialog to keep the dialog on top of other windows.

Use the following procedure to view properties.

1, 2, 3…

1. Select the required object from the project workspace.
2. Select the **Show Properties** button from the toolbar. The Properties dialog is displayed.

If another object or window is selected whilst a Properties dialog is open, the dialog changes appearance to reflect the properties for the newly selected item or area.

**Project Properties**

The Project Properties dialog allows the name of the project to be altered and a link to an external CX-Server file to be created.

Use the following procedure to view project properties.

1, 2, 3…

1. Select the Project object in the project workspace.
2. Select the **Show Properties** button from the toolbar. The Project Properties dialog is displayed.
3. Enter a name for the project in the **Name** field.
4. Select the **New File** pushbutton. The Create New CX-Server File dialog is displayed. Enter the file name in the **File name** field and select the **OK** pushbutton. The dialog closes and the CX-Server file name is now displayed in the **Path** field of the **General** tab in the Project Properties dialog.

5. To remove the link, select the **Unlink** pushbutton.

6. Apply a project comment in the **Comments** tab.

7. Select the **Close** button from the title bar to close the Project Properties dialog.

CX-Programmer supports a mechanism for sharing symbol definitions with other, compliant applications. This could allow, for example, the symbols declared within CX-Programmer to be linked to a SCADA package so that the definitions and changes of addresses are synchronized.

**Note:** The sharing is not active – changes in the shared symbols are not instantly broadcast to the other applications.

A CX-Server file is used as the medium for transferring symbol definitions between applications. Refer to **Chapter 5 - Advanced Topics** for details regarding linking symbols to CX-Server components.

### PLC Properties

The PLC Properties dialog allows a PLC’s settings to be configured and connected. Its connections can also be verified.

Use the following procedure to view PLC properties.

1. Select the PLC object in the project workspace.
2. Select the **Work On-line** button from the toolbar to connect to the PLC.
3. Select the **Show Properties** button from the toolbar. The PLC Properties dialog is displayed.
4. Select the **Verify** pushbutton to test the connection between PLC and computer against the information supplied in the **Name** and **Type** field. Select the **OK** pushbutton in the displayed confirmation dialog.
5. The PLC operating mode can be changed from within the PLC Properties dialog. Select the appropriate **Mode** setting and select the **Yes** pushbutton to confirm the operation. Select the **No** pushbutton to abort the operation.
6. Select the **Close** button from the title bar to close the PLC Properties dialog.

Password protection, displayed from the **Protection** tab of the PLC Properties dialog, is described in **Chapter 5 - Advanced Topics**.

### Program Properties

The Program Properties dialog allows a PLC name to be entered or amended and for tasking PLCs, allows their tasking type to be defined (CS/CJ/CP-series PLCs only). The icon to the left of the project workspace changes according to the task type selected. Cyclic tasks represent the main program. The task can also be set to start on start-up of the PLC.

Use the following procedure to change properties for a program at any time.

1. Click on the Program object in the project workspace.
2. Select the **Show Properties** button from the toolbar. The Program Properties dialog is displayed.
3. Select a Task type setting from the **Task Type** field. The icon to the left of the program name changes to reflect the task type.
4. Set the **Operation Start** setting so the program starts on PLC start-up.
5. Select the **Close** button from the title bar to close the PLC Properties dialog.

### Using Microsoft Windows Features in CX-Programmer

Standard Microsoft Windows procedures can be used within the CX-Programmer environment.
Opening and Saving Projects

Maintaining project files on disk is achieved in the same way as in other Microsoft Windows applications. Various types of file are used for CX-Programmer projects:

- `.CXP` - The project file itself;
- `.OPT` - A file containing the preferences for the project;
- `.BAK` - A backup copy of the project file;
- `.CXT` - A text-based format supported by CX-Programmer for both opening and saving. The .CXT file format is used for file conversions.
- `.MAC` - A file containing the keyboard mapping made on the Keyboard Mapping (Shortcut Keys) dialog.
- `.CXO` - A file containing the settings made on the Options dialog and the Watch window.

Opening and saving operations are similar to other Microsoft Windows applications; however, each time an existing project is opened it is recompiled (a progress marker is displayed during this loading and compilation process).

**Note:** LSS, project files require conversion to the correct format and must be imported via the File Conversion tool; refer to Chapter 5 - Advanced Topics for further information.

1. Select the **Open** button from the toolbar. The Open CX-Programmer File dialog is displayed.
2. Choose the file type that is to be imported in the Files of type field.
3. Select the file that is to be opened from the **File name** field, or type in the name. Note that the file type is determined by the suffix (i.e. the part of the name following the `.`).
4. Select the **Open** pushbutton to open the file. A progress indicator is displayed as the program(s) associated with the project are compiled.
5. Recently opened files can be opened directly from the **File** menu.
6. Select the **Close** command from the file menu to close an existing open project.

Select the **Save Project** button from the toolbar to save the project. This should be performed on a regular basis. Select the **Save As** option from the **File** menu to save an existing project with another name.

**SYSWIN/CVSS/SSS/CPT File Loading**

SYSWIN, CVSS, SSS, CPT project and library files can be directly opened from within CX-Programmer, by choosing the file types of `.SWP` or `.SWL`, `.COD`, `.SP1` and `.CPT` respectively in the ‘File Open’ dialog. In each case, a `.CXT` file is created in the same location as the original file, and CX-Programmer opens this.

It is not possible to save a CX-Programmer project as a SYSWIN, CVSS, SSS or CPT file.

**Printing Project Details**

Periodic hard copy printing may be necessary during project development. CX-Programmer provides printouts of the following items:

- Ladder programs;
- Global symbol tables;
- Local symbol tables;
- Cross Reference Tables;
- Cross Reference Reports;
- I/O Comment View;
- Function block programs.

Use the following procedure to print project details.

1. Select **Page Setup** from the **File** menu.
2. Select the **Margins** tab and enter the desired top, bottom and edge margins in the *Top* field, *Bottom* field, *Left* field, *Right* field, *Header* field and *Footer* field.

CX-Programmer _Page 62
3. Select the Header or Footer tab. Enter text in the Left, Center and Right fields. Predefined text can be entered by selecting the Insert Field pushbutton – Date, Time, Title, Filename, Page Number, etc.

4. Select the Pen and Paper tab and select the Set Font pushbutton to select the desired font in which the header and footer are to be printed.

5. Select the Print Setup pushbutton to correctly set up printer settings. Refer to the associated Printers Operating Manual for further information.

6. Select the Print Utility Settings tab and select the Print Utility Settings pushbutton to set the layout for printing ladder programs and Cross Reference Table. Press Help pushbutton on the Print Layout Settings dialog for more information.

7. Select the OK pushbutton and close the Print Layout Settings dialog.

8. Select the OK pushbutton of the Page Setup dialog to continue.

9. Select the Print Preview button from the toolbar, if required. The Preview dialog is displayed. The Target Print Rung dialog is displayed when ladder programs are print previewed or printed. Select the number of rungs to print/print preview. The following functions can be accessed.

   Select the Next Page pushbutton or Prev Page pushbutton to navigate through the pages of the printout.

   Select the Two Page pushbutton to view two pages of the printout at once. This pushbutton then changes to the One Page pushbutton to revert.

   Select the Zoom In or Zoom Out pushbuttons to magnify or expand the view of the printout.

   Select the Close pushbutton to close the dialog.

10. Select the Print button from the toolbar. A standard Microsoft Windows Print dialog defines printer settings and allows print parameters to be entered.

**Note:** The following printing functions are supported.

- Printing Ladder Programs as Shown on Screen

  Sections of the ladder program can be printed separately as they are shown on the screen. Select to print the ladder screen in the page setting. The ladder screen can be printed as it is shown on the ladder screen. The program can also be printed at a slightly smaller size (Reduced size), or a slightly larger size (Enlarged size), instead of the standard size (Normal size).

- Printing Word Address Cross-references

  Printing with cross-reference information also includes the cross-reference of the word address. Therefore, by viewing the printed program, information that is equivalent to that from the CX-Programmer’s cross-reference function can be obtained even if a CX-Programmer is not onsite.

**Manipulating Views**

Each view in the main window (including the windows displayed when an object in the Project tree has been opened) has an associated context sensitive menu, displayed by clicking the right-mouse button. Certain common options on these menus control the positioning and display of the associated view. There are restrictions on the positioning of some windows.

- **Float.** The selected window expands to full screen width. Select the Float option to expand the window.

- **Dock.** Moves the window left, right, to the top, or to the bottom. Select the Dock option to return the view to its previous size.

- **Hide.** All views can be hidden except the Diagram window (although all can be closed). Select the associated icon from the Toolbars option from the View menu to redisplay the view.

- **Expand All.** Expands the project hierarchy to show all components. This option is only available from the project workspace context sensitive menu (i.e. ensure that a component has not been selected).

Windows that have not been maximized display the following bar at the top or side of the window. Selecting these buttons allow the window to be moved or closed respectively.
Cut, Copy and Paste

A variety of items can be copied and pasted to different locations in a project, between projects or even applications:

Individual items can be copied, cut and pasted within, or between a Ladder program(s), Mnemonics view(s) and symbol tables: for example, text, contacts and coils.

- **Symbols.** Individual symbol entries can be copied/moved between symbols tables (both global and local) or a whole table can be copied/moved to another program by selecting the table and then selecting the program to be copied. Symbol entries can also be copied or moved as text to another application.

- **Programs / Sections.** A complete program or section can be copied to another PLC (or within the same PLC if multi-tasking) by selecting the program in the project workspace and then pasting it into the PLC. Individual aspects of a program can be copied by selecting an area from the Ladder Diagram and pasting into the Ladder Diagram of another program. When copying a program, the symbols used within it are also copied to the new location. If symbols of the same name are found in the local symbol table of the destination PLC / program, then they are left alone. Otherwise, the required symbols are added.

- **PLCs.** A complete PLC definition can be copied in the project tree by selecting a PLC, selecting the project name and performing a paste operation (all associated components of the PLC, for example IO Table and Memory are copied).

Standard Microsoft Windows drag and drop procedures can also be applied. CX-Programmer automatically prevents invalid drag and drop operations by displaying a ‘No Entry’ icon.

Use the following procedure to copy or move information within CX-Programmer.

1, 2, 3…

1. Select an item, or items, in a window. More than one item can often be selected by pressing Shift and selecting another item to extend the selection, or by pressing Ctrl and selecting another item to add to the selection.

2. Select the **Copy** button from the toolbar to copy the item, or the **Cut** button from the toolbar to move the item.

3. Select an area to move the items to (e.g. another window, or another place on the project workspace tree).

4. Select the **Paste** button from the toolbar to paste the item. A Paste operation can be performed several times without copying again.

Drag and Drop

In places where it is possible to perform a cut/copy/paste operation, it is usually possible to perform a drag/drop operation. Using the mouse, click on an item and hold the mouse button down. Drag the mouse to another location that is to receive the item, and release the mouse button. The item should be dropped.

The effect of the drop operation is shown by the mouse cursor. If a ‘+’ is shown at the bottom of the cursor, then the drop will have the effect of duplicating the item being dragged. If not, then the item will be moved.

Symbol References Drag/Drop

It is possible to drag symbols from the symbol tables into the ladder window. This has the effect of setting an operand of an instruction on the ladder window. When dragging into an empty cell, it is possible to create a new contact or coil with the given symbol as the operand. To create a coil, hold down ‘Shift’ at the time of the drop, otherwise a contact will be created.

It is possible to drag symbols into the watch window that will add references to them to the list of monitored addresses. A ladder element (contact/coil/instruction operand) may also be dropped into the watch window.

Undoing and Redoing an Operation

An item in the Diagram Workspace can be restored to an earlier state. Select the **Undo** button from the toolbar to undo the last action. Select the **Redo** button from the toolbar to re-apply an action.

**Note:** The action of going on-line and offline to/from a PLC empties the memory of undo operations for that PLC, so that it is not possible to undo operations that were made previously.
Deleting Items

Most items within a project can be deleted – although restrictions apply when the PLC is on-line. A project cannot be deleted. The following rules apply to deleting an object:

♦ If a PLC is deleted all associated items are deleted. Individual components (apart from the program(s)), for example an IO Table cannot be deleted separately.
♦ A PLC cannot be deleted if it is currently opened for communications or if it is acting as a gateway PLC.
♦ If a program is deleted, its associated (local) symbol table is deleted.
♦ A global or local symbol table cannot be deleted except as part of a PLC deletion (both types of table) or program deletion (local symbols).
♦ PLC pre-set symbols in the global symbol table cannot be deleted. Entries in the local symbol table can be deleted.
♦ All entries in the Ladder program and Mnemonics view can be deleted (provided the PLC is offline).

Use the following procedure to delete an object.

1, 2, 3…
1. Select the object in the project workspace or items in the Diagram Workspace.
2. Select Delete from the context sensitive menu. A confirmation dialog is displayed when deleting PLCs and programs.
3. Select the Yes pushbutton to confirm the deletion. Select the No pushbutton to abort the operation.

Renaming an Object

A number of objects in the project file can be renamed (unless the PLC is on-line):

♦ Project, Program, and Section. These can be renamed by simply typing a new name over the existing one in the project workspace tree. They can also be changed via their Properties dialog available from their context sensitive menu.
♦ PLC. The name of the PLC can be changed by entering a new name in the Change PLC dialog supplied by the CX-Server application, available from its context sensitive menu. Refer to the CX-Server PLC Tools User Manual for further information.
♦ Individual objects including symbols. These names can be changed by displaying the appropriate Edit dialog.

Note: CX-Server components, for example the IO Table, cannot be renamed.

Field Descriptions

The global and local symbols tables display information in tabular form. The fields are identified by column headers; these columns can be resized and information displayed according to preference.

To resize column width, select the required field division and drag to the desired width. The tabulated information can also be sorted by selecting the appropriate field division. The manner in which the information is displayed can be altered by selecting the appropriate icon.

Select the Large Icons button from the toolbar to display content as large icons.
Select the Small Icons button from the toolbar to display content as small icons.
Select the List button from the toolbar to display content as a list.
Select the Details button from the toolbar to display content with associated details.

Next Reference

The Next Reference command works with the Output Window. It jumps the program display to the point referred to on the next line of the output window.

The command works according to which tab the output window is showing (compile, find report or transfer).
Go To

The Go To options are available in Mnemonic and Ladder Diagram views and enable jumps to a required location in the program.

Rung / Step Number

It is possible to jump the display to show a particular location in a program or section. A location can be specified by either its rung or step number.

The Go To dialog allows a choice of specifying the rung or step number. The range of valid rung or step numbers is shown. Use the key combination Ctrl+G to display this dialog.

Note: When the dialog has been accessed from a program level (i.e. when viewing the program section list, or from the program level on the project workspace), it is possible to jump to any point within the whole program. However, since rung numbering is per section, only steps may be used for referencing in this case. The step range will show the entire range within the program.

The dialog also has a rung browse function, accessed from the Browse button. The browser lists the sections within the program and the commented rungs within each section. A rung may be chosen for viewing from this list.

When the dialog Go To button is pressed, the requested location is brought into view.

Commented Rung

The Commented Rung dialog shows a list of rungs within sections that have been given comment properties. Use the shortcut key L to display this dialog. The first line of a rung’s comment is shown in a numbered list (the numbers start from 1 and do not indicate the rung number).

A list of sections is given above (when the function is accessed from the program scope).
When a rung is chosen, the program section is immediately shown at the chosen position.

**Note:** The size of the Go to Commented Rung window displayed when Edit | Go to | Commented Rung is selected can be changed.

**Next Address Reference / Input / Output / Previous**

The address reference tool allows easy navigation to the location of other places in the program where an address has been used. These commands may be used when the address reference tool is on show, or even without it if the diagram options ‘Allow Address-Referencing without Window’ option is set.

When the diagram cursor is above a contact (or coil), it is possible to jump directly to a coil (or contact) that is using the same address. Use the ‘Space’ key to jump to the next coil (or contact) and ‘Shift’ + ‘Space’ key to jump backwards.

The **Go to Next Address Reference** command moves the selected line down one, so that the program shows the next reference of the current address. Use the shortcut key N to jump to the next address reference.

The **Go to Next Input** command moves the selected line on the tool to the next line referring to an input instruction (e.g. contact). If an input is not found on lines below the currently selected reference, then the search will begin at the top of the list.

The **Go to Next Output** command moves the selected line on the tool to the next line referring to an output instruction (e.g. coil, or ‘MOV’ instruction). If an output is not found on lines below the currently selected reference, then the search will begin at the top of the list.

The navigation tool remembers a history of the places that have been jumped from - the **Go to Previous Jump Point** command moves back to the last point from which a jump was made from. Use the shortcut key B to jump to the previous jump point.

**Select All**

Rather than selecting items in a window individually, it is possible to select the window and then Select All from the Edit menu.

**Toolbars – Viewing, Hiding and Customizing Toolbars**

The Customize dialog allows a set of toolbars to be chosen for display. It also allows new toolbars to be created. A full description of each toolbar is provided in *Appendix A, Toolbars and Keystrokes*.

Use the following procedure to add or remove a toolbar from the CX-Programmer environment.
1. Select Toolbars from the View menu. From the Toolbars dialog select the Toolbars tab.

2. Select the toolbars from the Toolbars: field to be viewed the toolbar in the CX-Programmer environment. Deselect the setting to remove the toolbar from the display.

3. Check the Show Tooltips setting to ON to display the tooltip associated with the toolbar buttons.

4. Check the Cool Look setting to ON to remove the box around each toolbar button.

5. Check the Large Buttons setting to ON to increase the size of the toolbar buttons.

6. Click the **OK** button to accept the settings or the **Cancel** button to abort the operation.

**Customizing a Toolbar**

Toolbars can be customized by dragging and dropping buttons from a selected category or from toolbar to toolbar.

Use the following procedure to add, remove or move toolbar buttons.

1. From the **View** menu select the **Toolbars** option, then from the Toolbars dialog select the **Commands** tab.
2. From the list of Categories select the type of buttons to be viewed. The buttons associated with that category are then displayed.

3. Click on the selected button and drag and drop it in the appropriate position in the selected toolbar.

4. To remove a button from a toolbar, select the category that contains the button to be removed then select the toolbar button and drag and drop it back to the button box.

5. To move a button from one toolbar to another, select the button to be moved then drag and drop it in position in the selected toolbar.

Creating a New Toolbar

New toolbars can be created and then customized by moving buttons from an existing toolbar or by adding buttons using the customizing feature. Toolbars created in this way can also be deleted. Note however that although all the buttons can be removed from a default toolbar the toolbar itself cannot be deleted.

Use the following procedure to create or delete a customized toolbar.

1, 2, 3…

1. Select Toolbar from the View menu. The Toolbars dialog is displayed.

2. Click the New button. This displays the New Toolbar dialog.

3. Enter a name for the new toolbar and click OK. The new toolbar will then be added to the list of toolbars and displayed on the screen. It can then be repositioned if necessary by dragging and dropping.

4. To move a button from an existing toolbar to the new one, select the button to be moved and drag and drop it in position in the new toolbar.

5. If a particular button is not visible click the Commands tab and from the list of Categories select the type of buttons to be viewed.

6. Click on the selected button and drag and drop it in position in the new toolbar.

7. To delete a customized toolbar select it from the list of toolbars and click the Delete button.
CHAPTER 4
Reference

This chapter introduces the objects contained in the project workspace and discusses their associated commands and features.

The following components, which are available either from the project hierarchy or from main menu, form part of the CX-Server software.

♦ PLC Memory. Refer to the Chapter on PLC Memory Components of the CX-Server PLC Tools User Manual;
♦ IO Table. Refer to the Chapter on IO Table Component of the CX-Server PLC Tools User Manual;
♦ PLC Settings. Refer to the Chapter on PLC Setup Component of the CX-Server PLC Tools User Manual;
♦ Data Trace/Time Chart Monitor. Refer to the Chapter on Data Trace/Time Chart Monitor Component of the CX-Server PLC Tools User Manual;
♦ Error Log. Refer to the Chapter on PLC Error Component of the CX-Server PLC Tools User Manual;
♦ Clock. Refer to the CX-Server PLC Tools User Manual.
♦ Memory Card. Refer to the Chapter on Memory Card Component of the CX-Server PLC Tools User Manual.

PLCs and Projects

A project file contains one or more PLCs that are (potentially) connected to the computer. These PLCs do not really have to be connected unless communications with them are to occur. A full description of the communications possibilities for C-series PLCs, CV-series PLCs and CS/CJ/CP-series PLCs is provided in the CX-Server PLC Tools User Manual.

The PLCs selected also affect which setup procedures need to be performed. For example, the CV-series and CS/CJ-series require setting up the IO Table via the IO Table object in the project workspace and using the PLC settings object to establish specific PLC characteristics.

Connection to the PLC requires the specification of the type of communications interface to be used to connect to the PLC. Two methods of communication are available: serial communications and network communications. Serial and network communications can be made using communication types although these are dependent upon the type of communicating PLC.

Adding a PLC to the Project

CX-Programmer supports multiple PLC and multiple program support. When a project is initially configured, it contains one PLC and one program. Additional PLCs and programs can be added.

Use the following procedure to add a PLC to a project.

1. Select the Project object in the project workspace.
2. From the Insert menu select PLC or right click on the project folder and select Insert PLC. The Change PLC dialog is displayed, part of the CX-Server application.
3. Set up the PLC as required. Refer to the CX-Server PLC Tools User Manual for further information.

The project workspace is updated with a new PLC entry plus its associated global symbol table, IO Table, Settings, Memory data and Program where applicable. An empty Ladder program is also displayed in the Diagram Workspace.

The initial project, program and PLC settings are made whilst the PLC is offline. In order to test the program, examine memory or monitor PLC operations, communications must first be established with the PLC. Refer to Chapter - 4 Working On-line.

Changing a PLC in a Project

To change a PLC, double-click on the PLC object in the project workspace. The Change PLC dialog is displayed. Refer to the CX-Server PLC Tools User Manual for further information.
Programs written for one type of PLC may not be fully compatible with another type of PLC. In this event, CX-Programmer attempts to change addresses and mnemonic instructions from the source PLC type to equivalent addresses and instructions on the new type of PLC. It is not possible to convert a program that contains errors. Any addresses and instructions that cannot be directly replaced are listed in the Compile tab of the Output window. Refer to Chapter 5 - Advanced Topics for further information.

Deleting a PLC from the Project

Use the following procedure to delete a PLC.

1. Select the PLC object in the project workspace.
2. Select Delete from the context sensitive menu. A confirmation dialog is displayed.
3. Select the Yes pushbutton to remove the PLC. Select the No pushbutton to abort the operation.

When a PLC is deleted, all associated information including the Ladder program/s are deleted from the project.

Symbols

Traditionally, PLC programmers have used numbers and addresses for operands within their programs. Without further documentation, the program becomes very difficult to read and maintain, since addresses have no obvious meaning.

Some packages have allowed the user to give comments to the addresses, so that the program has some readable documentation. CX-Programmer supports this feature.

However, it is more powerful to use symbolic programming, where names are used instead of addresses. A symbol is a named variable that can have an address or number. The name of the symbol is then used during programming. This helps the readability and maintainability of the program. For example, it is possible to change the address of a symbol, which changes the program to use the new address automatically.

Furthermore, CX-Programmer allows symbols to be defined for either a PLC or a program. This allows a programmer to keep the definitions of the symbols for a particular program private from other programs within the PLC. The symbols that are to be used in more than one program (global symbols) are then defined for the PLC. Program symbols (local symbols) are kept in a local symbol table. PLC symbols are kept in a global symbol table for the PLC.

Data Types

In addition to an address or number, a symbol has a data type. This describes the physical format of the data that is held within the symbol, including its size.

Since a symbol’s format is known, CX-Programmer is able to monitor the contents of the symbol in the correct way. More importantly, CX-Programmer checks that the symbol is not used in an inappropriate manner.

For example, a symbol can be defined with a data type of ‘UINt_BCD’, which means that the data within the address is unsigned, single word integer of BCD format. CX-Programmer checks that the symbol is used only for BCD type instructions, and issues a warning if it is not.

The available data types are listed below. An icon is associated with each type, which indicates the internal format of the type. The icon is shown in the symbol tables.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Signed</th>
<th>Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>1 bit</td>
<td>–</td>
<td>Binary</td>
<td>Address of a logical binary value (Bit). Used for contacts and coils.</td>
</tr>
<tr>
<td>CHANNEL</td>
<td>1 or more words</td>
<td>–</td>
<td>Any</td>
<td>Address of a non-bit value (i.e. a single word or longer value, unsigned or signed). This type is used for backward compatibility. If a non-bit address is given a comment, the resulting symbol is given a 'CHANNEL' type.</td>
</tr>
<tr>
<td>DINT</td>
<td>2 words</td>
<td>Yes</td>
<td>Binary</td>
<td>Address of a double integer</td>
</tr>
<tr>
<td>INT</td>
<td>1 word</td>
<td>Yes</td>
<td>Binary</td>
<td>Address of an integer</td>
</tr>
<tr>
<td>Name</td>
<td>Size</td>
<td>Signed</td>
<td>Format</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>--------</td>
<td>----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>LINT</td>
<td>4 words</td>
<td>Yes</td>
<td>Binary</td>
<td>Address of a long integer</td>
</tr>
<tr>
<td>NUMBER</td>
<td>–</td>
<td>Yes</td>
<td>Decimal</td>
<td>A literal value - not an address. 'NUMBER' type symbols can be used for numeric operands which are usually prefixed with '#', '&amp;', '+' or '-'. They can be used in BCD or binary instructions. For BCD usage, the value is treated as if entered in hex (e.g. the number '1234' has the same effect as entering '#1234' in the operand). A floating-point value can be entered (e.g. '3.1416'). An engineering format number can be entered (e.g. '-1.1e4'). A decimal value is assumed. A hexadecimal value can be entered using a prefix of '#'.</td>
</tr>
<tr>
<td>REAL</td>
<td>2 words</td>
<td>Yes</td>
<td>IEEE</td>
<td>Address of a floating-point number. The format is the 32-bit IEEE format. For the special OMRON floating point format (FDIV instruction) use the UDINT_BCD type.</td>
</tr>
<tr>
<td>LREAL</td>
<td>4 words</td>
<td>Yes</td>
<td>IEEE</td>
<td>Address of a floating-point number. The format is the 64-bit IEEE format.</td>
</tr>
<tr>
<td>UDINT</td>
<td>2 words</td>
<td>No</td>
<td>Binary</td>
<td>Address of an unsigned double integer</td>
</tr>
<tr>
<td>UDINT_BCD</td>
<td>2 words</td>
<td>No</td>
<td>BCD</td>
<td>Address of an unsigned double BCD integer</td>
</tr>
<tr>
<td>UINT</td>
<td>1 word</td>
<td>No</td>
<td>BCD</td>
<td>Address of an unsigned integer</td>
</tr>
<tr>
<td>UINT_BCD</td>
<td>1 word</td>
<td>No</td>
<td>BCD</td>
<td>Address of an unsigned BCD integer</td>
</tr>
<tr>
<td>ULINT</td>
<td>4 words</td>
<td>No</td>
<td>Binary</td>
<td>Address of an unsigned long integer</td>
</tr>
<tr>
<td>ULINT_BCD</td>
<td>4 words</td>
<td>No</td>
<td>BCD</td>
<td>Address of an unsigned long BCD integer</td>
</tr>
<tr>
<td>WORD</td>
<td>1 word</td>
<td>---</td>
<td>Any</td>
<td>Address of a bit string of 16 bits.</td>
</tr>
<tr>
<td>DWORD</td>
<td>2 words</td>
<td>---</td>
<td>Any</td>
<td>Address of a bit string of 32 bits.</td>
</tr>
<tr>
<td>LWORD</td>
<td>4 words</td>
<td>---</td>
<td>Any</td>
<td>Address of a bit string of 64 bits.</td>
</tr>
<tr>
<td>TIMER</td>
<td>Used for a timer number, Timer Completion Flag, or timer present value. Note: TIMERs can be used only for CJ2 CPU Units with unit version 1.0 or later and only with CX-Programmer version 8.3.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COUNTER</td>
<td>Used for a counter number, Counter Completion Flag, or counter present value. Note: COUNTERs can be used only for CJ2 CPU Units with unit version 1.0 or later and only with CX-Programmer version 8.3.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STRING</td>
<td>256 bytes (128 words)</td>
<td>---</td>
<td>ASCII</td>
<td>The data is handled as character strings. The size can be set between 1 and 255 characters.</td>
</tr>
</tbody>
</table>

Note 1: When structured text is used in a task program, the UINT-BCD, UDINT_BCD, ULINT_BCD, and CHANNEL data types are handled as follows (CX-Programmer Ver. 7.2 only):
- UINT BCD → WORD
- UDINT BCD → DWORD
- ULINT BCD → LWORD
- CHANNEL → WORD

2: NUMBER cannot be used in ST programs. An error will occur in the program check if this data type is used.

3: CX-Programmer Ver. 5.0 or higher

4: This data type is supported only by CX-Programmer Ver. 7.2 (CX-One Ver. 2.1) or higher.
Data Types and Timer/Counters

Information for a timer/counter on a PLC consists of three parts – a status bit, a pre-set-value and the current value. Different data-types are used to refer to these different parts. These three parts can set to different comments, but to set the same comment for all three parts, use I/O Comment view to input a comment - Refer to I/O Comment View in Chapter 4 Reference for further information. When there is no comment in the symbol with a NUMBER or a UINT data-type, the comment of the symbol with a BOOL data-type will be shown on the right of the right-busbar instead.

Note: When defining a timer number or counter number as a variable for PLCs other than CJ2 PLCs, use the previous method. (TIMER and COUNTER data types are supported only by CJ2H CPU Units.)

Specifying Arrays

Variables can be specified as arrays with CX-Programmer Ver. 7.2 or higher (see note).

Variables can be specified as any data type, excluding STRING and NUMBER.

Note: Only one-dimensional arrays are possible with CX-Programmer.

An array variable is specified if more than one variable of the same data type is being used and those variables are to be managed as a group.

Perform the following procedure to specify an array variable.

1. Enter the variable name in the New Variable or Edit Variable Dialog Box and click the Advance Settings Button. The Detailed Settings Dialog Box will be displayed.
2. Check the Array Variable checkbox in the array settings field and enter the maximum number of elements.

In ladder, ST, and SFC languages, the array variable name must be followed by the subscript in square brackets [ ].

For example, the variable name “PV” with three maximum elements would be specified as PV[0], PV[1], and PV[2] in the instruction operand.

Subscripts can be specified only by directly using numbers. Subscripts cannot be specified by using variables.

Using Subscripts with Array Variables on the CJ2

When using a CJ2 CPU Unit, the number of the element can be directly input using the subscript of an array variable in the ladder program. The number of the element can also be indirectly specified using a word address or symbol. The word address or symbol that indirectly specifies the number of the element is placed into brackets [ ] after the array variable name.

The format to specify the subscript of an array variable is as follows:

```
A[BI]
```

Subscript: Element number, word address, symbol
Array variable name

The above example specifies the element that is offset from start address (A) by the value specified by the subscript (B) (see note) based on the data type of the array variable.

An offset address cannot be used as an operand in an instruction for which immediate refreshing is specified.

Note: When setting a subscript for an array variable, do not specify a subscript that would cause the resulting address to be outside of the memory area that contains the first word in the array. Be particularly careful when using a word address or symbol to specify the subscript. Depending on the size of the subscript, the resulting address may exceed the memory area, causing unexpected operation.

Global Symbols

The PLC global symbol table is initially filled with some pre-set symbols, which depend upon the PLC type. For example, the symbol ‘P_1s’ (1 second pulse) is created for many PLC types. All pre-set symbols have the prefix ‘P_’ and they may not be removed or edited.

A global symbol table contains the PLC’s symbols – these symbols can be referenced by any program in the PLC. Any unnamed symbols (IO comment - just addresses given a comment) are contained within the global table - they may not be placed in a local symbol table.
Note: Global symbols are only global for a particular PLC. It is not possible to share symbol definitions between PLCs on the project workspace.

Local Symbols
These symbols are specific to a particular program, and cannot be referenced by any other. It is recommended that symbols are defined locally to a program unless the address is being used in multiple programs. This makes the project more manageable and maintainable.

A program’s local symbol table is created empty. The local symbol table can be viewed by selecting the View Local Symbol button from the toolbar.

It is possible to define a symbol at a local level with the same name as a symbol at global level. This is considered an override of the symbol definition. The program uses the symbol definition from its local level. This is a powerful feature, but can be achieved by mistake, so CX-Programmer issues a warning when validating symbols if this is done.

Network Symbols
Network symbols can be used to access I/O memory in the CPU Unit from external devices.

When a tag is used from an external device (e.g., host, PT, or Programming Device) to access I/O memory (e.g., tag data links using EtherNet/IP networks), the tag accesses I/O memory using a network symbol.

Network symbols are registered in the global symbol table. When the network symbol is registered, one of the following attributes is selected for the network symbol: Publication, Input, or Output. Network symbols can be used as global symbols when being used within a program in the PLC. Network symbols cannot be specified in the local symbol table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Address/value</th>
<th>Network symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Names used in EtherNet/IP networks must be within 48 characters in length.</td>
<td>Sets the data type of the global symbol.</td>
<td>Sets the address or value of the global symbol.</td>
<td>When “input” is selected, the symbol will be used as the input tag in the EtherNet/IP data link (cyclic communications).</td>
</tr>
<tr>
<td>Publication</td>
<td>Input</td>
<td>Output</td>
<td>Sets a network symbol that can be accessed from external devices.</td>
</tr>
</tbody>
</table>

Note: Network symbols can only be used with a CJ2H-CPU6-EIP. In ladder diagrams, network symbols are displayed using icons.

Copying and Pasting Symbols
It is possible to cut, copy and paste symbols from one symbol table to another. It is also possible to move symbols between tables by using drag/drop. Note that pre-set symbols can not be removed, but they may be overridden.

For advanced users, it is possible to paste symbols from another application into a symbol table. This can be done from any application that supports a text format – for example a spreadsheet. Refer to Chapter 5 - Advanced Topics for further information.

Use the following procedure to copy or move symbols.

1. Select a symbol, or symbols in the symbol table. More than one symbol can be selected by pressing Shift and selecting another item to extend the selection or by pressing Ctrl and selecting another item to add to the selection.
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar to move the item.
3. Select a symbol table to move the items.
4. Select the Paste button from the toolbar to paste the symbol or symbols. A Paste operation can be performed several times without copying again.

Note: If a program or part of a program (i.e. selected rungs or sections) are copied between programs, then the symbols used within the program are copied to the new program.
Validating Symbols

The **Validate Symbols** can be selected from the context sensitive menu. When **Validate Symbol (Selected Item)** is selected, the symbol table, where the cursor is, will be checked. **Validate Symbol (ALL)** will check all the symbol tables in the PLC, where the cursor is.

The option performs the following validation checks.

1. The data of each symbol in the selected symbol table outputs a warning message in the output window if any invalid symbols are found.
2. Each symbol for duplicate addresses, in the selected symbol table, and outputs a warning message (including the symbol names) in the output window if any are found.
3. To see if any symbols, in the selected local symbol table, are overriding symbols defined in the global symbol table and outputs a warning message in the output window if any are found.
4. To see if any duplicated symbol names are defined in the symbol tables, and if any are found they are output into the output window.
5. To see if any Auto-Allocated addresses have been created that do not have addresses assigned to them and if any are found they are output into the output window as an error.

Delete Unused Symbols

Any defined symbols in the symbol tables (both Global and Local) that are not used in the program, can be deleted by selecting **Delete Unused Symbols** from the menu. Select areas to delete symbols in the **Select area to delete** dialog. For symbols used in the Watch window, PLC Memory component, or Datatrace/Timechart Monitor component, will not be counted as used symbols. Therefore, these symbols will be deleted from the symbol tables.

Sharing Symbols with Other Applications

Some OMRON applications may be able to share symbol definitions with other packages. CX-Programmer supports this feature.

In order to allow sharing of symbols, it is necessary to link a CX-Server file with the project, which holds a copy of the desired symbols. This is set up using the Project Properties dialog. Once this is done, it is necessary to indicate which symbols are to be shared. Only global symbols may be linked with other applications. Refer to **Chapter 5 - Advanced Topics** for further information.

Adding Symbols

It is possible to add a symbol from several places – from the project workspace, within a symbol table or a program window. In each case, the Insert Symbol dialog is used.

Use the following procedure to add a symbol.

1. From the **Insert** menu select **Symbol** or right click on the symbols folder and select **Insert Symbol**. The New Symbol dialog is displayed.
2. Enter a symbol name.
3. Enter an address or value in the **Address or Value** field. For a value (NUMBER data type symbol), type in a decimal value, or prefix the value with a ‘#’ for hexadecimal. A positive or negative floating point value may also be entered. Leave the field blank if the address is to be automatically allocated.
4. Select a data type in the *Data Type* field. For a numeric value rather than address, select the data type ‘Number’.

5. Enter a comment, if required, in the *Comment* field.
   
   To specify an array, click the **Advanced Settings** Button and specify the array in the Advance Settings Dialog box that is displayed.

6. For global symbols, indicate whether to share the symbol definition with the project’s linked CX-Server file by setting the *Link the Definition to a CX-Server file field*.

7. Select the **OK** pushbutton to accept the settings. Select the **Cancel** pushbutton to abort the operation.

**Auto Generation of Symbols**

It is possible to create symbols without giving them a name, but certain restrictions apply:

- This can only be done in the Global Symbol table.
- An address and comment must be given.
- The data type must be BOOL or CHANNEL.

These are called unnamed symbols, and normally they would appear in the symbol table or ladder diagram with no name.

However, an option is provided to automatically generate a symbol name for unnamed symbols. The **Tools|Options|Symbols** dialog contains a checkbox marked ‘Automatically Generate Symbol Names’. If this option is selected then names are automatically generated for unnamed symbols, and these names have a standard format of *AutoGen_[Address]*, where ‘Address’ is replaced with the symbol’s address. If two or more symbols of this type have the same address, a (Copy Of #) is suffixed, where # is a unique number.

**Find and Replace**

If the ‘Automatically Generate Symbol Name’ option is selected then the ‘unnamed’ symbols can be found in a Find and Replace operation that searches for Symbol Names. If the checkbox is left unchecked symbols will not be found in the Find or Replace.

**Copying and Pasting**

When copying ladder objects and pasting to another ladder, the results depend upon the ‘Automatically Generate Symbol Name’ checkbox. If it is checked, then the auto-generated symbol name is pasted (but without the address). If it is unchecked, then the address only is pasted.
Data can be copied and pasted between CX-Programmer symbol tables and CX-Designer variable tables with CX-Programmer Ver. 7.2 (CX-One Ver. 2.1) or higher.

Unnamed Symbols
Unnamed symbols, like normal symbols, can be created in the Global Symbol Table, via the New Contact dialog (when a contact is entered on the Ladder) or via the Operand field of the Instruction dialog (when an Instruction is entered on the Ladder).

Editing Symbols
It is possible to edit symbols by double clicking symbols from the symbol table, or from an operand within a program. The dialog works in the same way as the Insert Symbol dialog.

When a symbol’s address or comment is altered, the program or programs using it automatically use the new address and show the new comment.

When a symbol is renamed, the program will automatically use the new name. If an override symbol is deleted, the program attaches to the global definition.

When a symbol is deleted from the symbol table any operands that are currently linked to that symbol will be re-linked to new symbols. The symbols are searched for using the order of precedence rule. If a new match is found then the operand will be linked to the new symbol. If however no match is found then the operand reverts to the physical address of the deleted symbol.

When copying symbol table data in CX-Programmer version 8.0 or higher, the items to be copied and the order of the data to be copied to the clipboard can be set.

Procedure
1. Select Tools – Options from the menu.
2. Click the Symbols Tab and set the copy order and items to be copied in the Type and order of symbol attributes copied onto clipboard Field.
Pasting Symbols with Errors

In the following example only two of the Symbols are correct the others are not, attempting to insert all these Symbols into a symbol table will generate errors.

AmberLight  BOOL  10.01  - Correct Symbol
AmberLight  BOOL  10.01  - Duplicate Name
AmberOnlyTimerDone  BOOL  T0004  - Correct Symbol
GreenLight  BOOL  999999  - Incorrect Address
GreenTimerDone  UNKNOWN  - Incorrect Type

The following error dialog will be displayed if the above symbols are pasted into the symbol table.

It is now possible to edit the Symbol entries to correct the errors. The new corrections will appear in the ‘New ?’ column or to mark them for deletion.
Selecting OK will commit the Symbols, with changes, to the Symbol Table for checking and inserting. Selecting Cancel will delete all the symbols in the error.

Removing Symbols
Symbols may be removed by deleting them from the symbol table.

Generally, when a symbol is removed, the program and programs using it then use the address or value of the removed symbol.

The exception is for symbols with automatically allocated addresses – in these cases, the program shows the name of the removed symbol in the places where it was used. It is then easy to see where an address needs to be assigned in the program.

If the removed symbol was an override of a global symbol, then the program uses the global symbol of the same name, which may have a different address or value.

Automatic Allocation
Automatic Allocation is a facility that enables symbols to be automatically assigned an address. This is useful for ‘work’ type symbols, where the actual address is not important, providing it is unique (i.e. it is not mapped to input or output hardware). To use this feature, it is necessary to set the memory ranges from which to allocate these addresses. Each PLC is set separately.

The main features of auto allocation are:
- Multiple address allocation areas
- Prioritizing address allocation areas
- Address allocation of symbols according to type
- Consideration of addresses that have already been used
- Different Auto allocation areas for each PLC
- It is available to both global and local symbols

Setting Up Automatic Allocation
The PLC Automatic Memory Allocation dialog is opened from the toolbar by selecting PLC | Automatic Allocation.

![PLC Automatic Memory Allocation dialog](image)

Use the following procedure to apply automatic allocation.

1. Select (tick) the Enable automatic allocation for this PLC option.
   A list of memory ranges may be entered for the PLC. The list is ordered, so that the first area in the list is allocated first.

2. Use the Add... button to add an area to the allocation list. A dialog is shown to input the details for the area:

3. Type in the Start address and Size (channels) to define the address range in the PLC for CX-Programmer to allocate from.
4. Choose one or more data types that are to be allocated in this area. By default, all applicable data types will be allocated from within this area. A restriction can be made, so that for example, a separate memory area can be set to allocate BOOLs and CHANNELs.

5. Use the **Remove** button to remove the selected allocation range from the list.

6. Use the **Move Up** and **Move Down** buttons to move a selected range up and down in the priority order for the PLC.

**Note:** CJ2 CPU Units, we recommend that you use the required number of banks from the highest bank numbers for automatic allocation.
- Either one or two automatic allocation areas can be set. Any area with continuous addresses is counted as one area. (For example, the addresses in E0_0 to E0_32767 and E1_0 to E1_32767 are continuous, and so they could be set together as one area.)
- To use force-setting/resetting, you must set words in the EM Area for which force-setting/resetting is supported. With CJ2H CPU Units with unit version 1.2 or later, **PLC - Memory Allocation - EM Memory Settings** can be used to specify the EM Area banks for which bits can be force-set/reset. (The first bank is specified and force-setting/resetting bits is possible in that bank and all banks following it.) This is called the EM Area force-setting/resetting function. Refer to the note on page 14 of CX-Server PLC Tools for details.
- Automatic allocation cannot be set if part of the EM Area is converted to trace memory or file memory using **PLC - Memory Allocation - EM Memory Settings**.

**Note:** With CJ-series CJ2 CPU Units, an error will occur if an address within the range set as the reserved PLC memory area for automatic PLC address allocation is input directly.
- The address will be displayed in red in the ladder view.
- In the program check, a message will be displayed indicating that an error occurred because operand x is out of range.

**Note:** The status of the EM Area is held when the power supply is turned back ON or the operating mode is changed. Be careful if you use BOOL data in the EM Area for inputs in the program.

### Allocation of Symbols
Symbols can be defined to use automatic allocation simply by leaving their addresses blank. CX-Programmer then allocates the symbol address during compilation. The actual address allocated is shown against the symbol, but the address is marked as “Auto” to show that the address has not been assigned by the user.

CX-Programmer allocates addresses within PLCs by trying to find space in the PLCs allocation areas (set as above). The areas are searched in order, and addresses are only allocated within a particular range if its data type is allowed within the range.

If automatic allocation is changed for a PLC (an allocation area is changed, or an area is removed), then all automatically-allocated addresses for the PLC are reallocated.

If automatic allocation is removed for the PLC (i.e. the Enable automatic allocation for this PLC option is removed), then any symbols that have been auto-allocated have their address removed.

### Adding and Editing Automatic Allocation Areas
Selecting the **Edit** or **Add** button on the Automatic Allocation dialog opens the Memory Range dialog. This dialog is used to either edit an existing auto allocation area or add a new one.
Enter the Start Address, the Size in channels (16 bit words) then select the Data types that can be allocated in that area. On pressing the OK button, the address range is checked for validity and an appropriate error message in a message box is displayed. On closing the message box the user is returned to this dialog and the first field that is considered to be in error.

Note that it is not possible to select types until the restricted radio button has been selected otherwise the type selection list box is grayed out. The type selection list box is a multiple selection list box.

**Limitations**

Timer/Counter memory areas are not available for address auto allocation.

It is not possible to have bit types in an area that is only word addressable.

The length of the address range must be less than or equal to the size of that memory area.

It is not possible to have auto allocation areas that overlap other areas.

The length of the address range must be greater than zero.

**Copying Auto Allocated Symbols**

When symbols are copied, any symbol with a fixed address is marked as being used if it occurs within an auto allocated area. Auto allocated symbols that are copied across from one PLC to another will be assigned new addresses within the auto allocation areas allowed on the PLC they are being transferred to. These symbols will be assigned in alphabetical order rather than the order that they are copied across, If they have been assigned an address by the PLC that they are being transferred from, they will not necessarily keep the same address.

**Instructions**

When contacts, coils, instructions and any symbols (auto allocated or not) are deleted, the address space they occupied is freed for use by other elements as and when they are entered. Existing symbols that are auto allocated but without an address are not updated and either needs to be re-entered or the auto allocation areas need to be edited. Automatically allocated symbols are only allocated addresses when they are first entered or when the auto allocation ranges are added/edited.

**Rules for Auto Allocation**

When the OK button is pressed and there are auto allocation areas to use, each of the programs is searched in the order it appears in the tree. Each program is searched first for contacts, coils and instructions with fixed addresses. If any of these fixed addresses are within an auto allocation area then those addresses are marked as used and cannot be further auto allocated to other symbols. After this, non auto allocated symbols (symbols with fixed addresses) within each program are checked. If any of these fixed symbols are within an auto allocation area, then those symbol addresses are marked as used and cannot be further auto allocated to other symbols. Finally, auto allocated symbols are allocated an address from the remaining addresses in an auto allocation area, whether they already have an address or not. The symbols are allocated according to their alphabetical order in the symbol table.

From then on, anytime that user enters a new contact, coil, instruction or symbol with a fixed address, then that address is immediately marked as being used if it occurs within an auto allocation area. Any symbols that the user enters that don’t have a fixed address are immediately auto allocated an address if available. The exception to this is if symbols are entered directly as operands in the instruction dialog. These symbols cannot be auto allocated. If these symbols are to be auto allocated they should entered either in the symbol table first, or by using the browse button on the instruction dialog.

When a program is developed by several people, the contents of the symbol table edited by one person may be overwritten by another person. It is therefore possible that consistency may not be maintained when automatic address allocation is used. It is best to have only the person managing the entire program edit the automatic address allocation data, and to have that person distribute the symbol table to other people. In addition, have only that person transfer the symbol table to the PLC.

**Program Editing**

A number of procedures can be performed from within the Ladder program but it depends upon whether an instruction, contact, coil, or workspace has been selected.

To view the Ladder program, select the View Diagram button from the toolbar.

The following elements can be selected from the Diagram toolbar and placed directly into the Ladder program.
New Open Contact. Once the Contact has been entered, the name or address for that contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information.

New Closed Contact. Once the Contact has been entered, the name or address for that contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information.

New Open Contact OR. Once the Contact has been entered, the name or address for that contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information.

New Closed Contact OR. Once the Contact has been entered, the name or address for that contact needs to be entered. Refer to Chapter – 4 Contact and Coil Editing for further information.

Vertical. The New Vertical button from the toolbar connects elements in the Ladder program vertically.

Horizontal. The New Horizontal button from the toolbar connects elements in the Ladder program horizontally.

Note: Connecting lines can be drawn by clicking the Line Connect Mode button and then clicking the starting point and dragging to the end point. Connecting lines can also be deleted by dragging after clicking the Line Delete Mode button. A line can also be drawn by dragging on a line that is not connected on one end.

New Open Coil. Once the Coil has been entered, the name or address for that contact needs to be entered, refer to Chapter – 4 Contact and Coil Editing for further information.

New Closed Coil. Once the Coil has been entered, the name or address for that contact needs to be entered, refer Chapter – 4 Contact and Coil Editing for further information.

Instruction. Once the graphical instruction has been placed on the diagram, the actual instruction must be selected, refer to Chapter – 4 Contact and Coil Editing for further information.

Note that both a rung and elements of a program can be given comments within the ladder display, by using Properties.

Use the following procedure to create a Ladder program.

1, 2, 3…
1. Select the PLC object in the project workspace.
2. From the Insert menu select the Program option to start a new program. A ladder editing window will open.
3. Select the Program object in the project workspace. Select the Program object once more so it becomes an editable field. Enter a name for the program.
4. Select one of the above objects from the Diagram toolbar and place on the Ladder program. The icon image remains selected until another element is clicked on the toolbar.
5. Items can be individually selected by selecting the Selection Mode button from the toolbar.
6. Rungs can be selected by clicking the rung margin within the Ladder program.

Some objects (excluding the rung and text comments, and the vertical and horizontals) have associated dialogs allowing address or instruction information to be entered. Double-click on the object to redisplay the Edit dialog, this is dependent upon the selection.

The Auto Error Detection bar to the left of the rung indicates the validity of the entries.

It is possible to design a network and get the geometry right before entering specific symbol or address information.

A Grid can be toggled on or off using by selecting the Grid button from the toolbar. When the Grid is on, dots are displayed at the connection points of each cell in the program.
Program steps (graphically represented) are entered in a row or ladder ‘rung’ between the left (power supply) and right (output) bus-bars.

Additional rows and columns can be inserted into the Ladder program via the Insert Row option and Insert Column option from the context sensitive menu. Rows and columns can also be removed by selecting Delete Row option and Delete Column option from the context sensitive menu.

By inserting Vertical Up or Vertical Down, rungs cannot be combined into one. To do this, select the rungs to be combined and select Combine from the context sensitive menu. When a rung needs to be divided, select Split from the context sensitive menu to divide the rung into two.

Allowing ladder screen display only, and prohibiting program editing while offline is possible (CX-Programmer Ver. 4.0 or later). Select Read Only Mode from the Edit Menu to enable this function.

After temporary editing of a specific rung (in temporary memory), the user can select to utilize (store) or delete (cancel) the editing results (CX-Programmer Ver. 4.0 or later). Select Read Only Mode – Start Edit from the Edit Menu, and then perform either of the following steps after editing.

a) To apply the editing results, select Read Only Mode – Store from the Edit Menu. The edited contents will be reflected in the program.

b) To not apply the editing results, select Read Only Mode – Cancel from the Edit Menu. The edited contents will be deleted. Therefore, after editing rungs and writing and recording temporary changes, the user can select to either apply or delete changes, enhancing program editing efficiency. (This function is similar to the SYSMAC Support Software store function.)

**Inserting a Program**

A program is set up when the project is initially configured. For CS/CJ/CP-series PLCs and CV-series PLCs, it is possible to add multiple programs.

Use the following procedure to insert a program.

1. To insert a new program, select the PLC object in the project workspace.
2. From the Insert menu select the Program - Ladder, Structured Text or SFC option. An empty Ladder, ST or SFC program is placed in the Diagram Workspace.
3. The task type associated with the program must be assigned (not for C-Series PLCs). Select the program object in the project workspace and select the Show Properties button from the toolbar. The Program Properties dialog is displayed.
4. From the General tab, select an option from the Task Type field.
5. Select the Close button from the title bar to close the Program Properties dialog.

The project is updated, showing a new program inserted at the bottom of the hierarchy together with an empty local symbol table. Task types available are as follows (the icon is displayed next to the Program object in the project workspace, and the task number is shown in brackets to the right).

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned</td>
<td></td>
</tr>
<tr>
<td>Interrupt</td>
<td></td>
</tr>
<tr>
<td>Power Off</td>
<td></td>
</tr>
<tr>
<td>Power On</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Task Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Interrupt</td>
<td></td>
</tr>
<tr>
<td>IO Interrupt</td>
<td></td>
</tr>
<tr>
<td>Cyclic Task</td>
<td></td>
</tr>
</tbody>
</table>

**Contact and Coil Editing**

The Edit Contact dialog or Edit Coil dialog allows the name or address of the contact or coil to be entered or selected from a list of global and local symbols. The name or address can also be defined as a new symbol from this dialog and inserted into the local or global symbol table.

The dialog can be displayed in two forms, either: simple dialog mode or detailed dialog mode. The default mode can be set in the Diagram tab in the Options dialog. To change the simple dialog mode to a detailed dialog mode, select Detail pushbutton.
Use the following procedure to edit contacts or coils in simple dialog mode.

1. Double-click on the required contact in the Ladder program. The Edit Contact dialog or Edit Coil dialog is displayed.
2. Enter a name or address for the contact or coil. This can be typed in directly or selected from the field.

**Note:** Check the Show with comment dialog option in the Diagram tab of the Options dialog to display a comment dialog. The dialog is displayed after the OK pushbutton is selected on the Contact or Coil dialog.
3. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to abort the operation.

**Note:** When inputting contacts or coils using CX-Programmer Ver.5.0 or later, symbols can be filtered by symbol name and I/O comment and displayed in a list. When inputting contacts or coils, a text string can be input to filter symbols for those with symbol names or I/O comments that contain the specified string. A list of the resulting symbols is displayed in address_comment or name_address_comment combinations in a drop-down list. The desired symbol can then be input by selecting it from the list. Use this function to increase input efficiency when inputting symbols or comments that have been input before. This function can be used in both Ladder Section Windows and the Function Block Editor.

**Example:**

Input temp in the Symbol/Address Input field.

Click the button on the right of the field to display the following drop-down list of all symbols and addresses that contain “temp” in either the symbol name or I/O comment.

For example, select the item at the bottom of the list temp_alarm02, W0.05, The lower part of a device A temperature error (70 degrees min) to simply input the symbol named temp_alarm02.
Symbol Filtering Targets

Target Symbol Table: Provides the symbols/addresses registered in the global symbol table and the local symbol table for the current program.

Note: When a symbol with the same symbol name is registered in both the local symbol table and global symbol table, only the symbol registered in the local symbol table will be displayed in the drop-down list.

Target Symbol (Data Type): The I/O Contact Dialog Box shows the contacts (i.e., BOOL type symbols).

Target Data: Select Tools – Options, and select the target data for filtering text strings from the following options in the Symbol filtering field of the Diagrams Tab (the default is to filter (search) both symbol names and I/O comments.)

- Name: Only symbol names are searched.
- Comment: Only I/O comments are searched.
- Both: Both symbol names and I/O comments are searched (default).

Use the following procedure to edit contacts or coils in detailed dialog mode.

1, 2, 3…

1. Double-click on the required contact in the Ladder program. The Edit Contact dialog or Edit Coil dialog is displayed.

2. Enter a name or address for the contact or coil. This can be typed in directly or selected from the field. Select the Edit Symbol pushbutton to amend an existing symbol if required.

To enter a symbol with an automatically allocated address, enter the name and leave the address empty. To enter an unnamed symbol, enter an address and a comment.

3. The Differentiation status of the operand bit can be set to prevent it from being turned ON for more than one cycle after the execution condition goes from ON to OFF (Down) or OFF to ON (Up). Select the Up option for OFF to ON or the Down option for ON to OFF.

4. Select the Immediate Refresh option if the operand is to be updated as soon as the instruction has been executed.

5. When adding a new symbol, select Global to add a symbol to the PLCs symbol table. Select Link to the CX-Server file to share the symbol definition with other applications (named, global symbols only).

6. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to abort the operation.

Note: The Differentiation option and Immediate Refresh setting can also be set from the contact or coil context sensitive menu by selecting the element in the Ladder program and clicking the right-mouse button. A symbol is placed in the Ladder program to indicate that these options have been set: ‘!’ for Immediate refresh, ‘^’ for Differentiate up; ‘v’ for Differentiate down.

Invert (NOT)
The Invert (NOT) setting allows the normal state of a contact or coil (open or closed) to be reversed. Select Invert (NOT) from the context sensitive menu, whilst the contact or coil is selected.

Forced Bits
The state of an address can be ‘forced’ regardless of its physical state. This is useful when testing certain conditions or rungs in the Ladder program. A bit can be forced on (value changed to 1) or forced off (value changed to 0), the value of the bit can also be cleared. The following rules apply:

- ♦ Bit references that are read-only cannot be forced;
- ♦ Word references may not be forced.
Forcing is only allowed when the PLC is in Debug or Monitor mode (not Run mode).

Use the following procedure to force bits.

1. Obtain the Ladder program and select the element to be forced.
2. Select Force from the context sensitive menu, followed by On, Off or Cancel.

Select Force from the context sensitive menu, followed by Cancel All to cancel all forced bits so that current values are free to be changed by the PLC program.

Once an element has been forced, a symbol is placed in the Ladder program to indicate that its status has been forced.

- **Set.** Set is available from the contact or coil context sensitive menu. The bit can be set to 1 or 0 by selecting the Set option from the contact or coil context sensitive menu followed by Value, To 1 or To 0.
- **Differentiate.** Differentiate is available from the contact or coil context sensitive menu, performing the same functions as that within the Edit Contact dialog. Select Differentiate from the context sensitive menu, followed by Up or Down.
- **Immediate.** Immediate Refresh is available from the contact or coil context sensitive menu, performing the same functions as that within the Edit Contact dialog. Select Immediate Refresh from the context sensitive menu.
- **Differential Monitor.** Differential Monitor is for bits that are not accessible for conventional monitoring (for instance, values changing too rapidly), but which can be monitored via the Differential Monitor dialog. The dialog permits the selection of a particular bit to monitor, whether it is monitored against its falling or rising edge, and whether sound should be used when the bit value changes.

Use the following procedure to apply the differential monitor.

1. Select the Program object in the project workspace to display the Ladder program in the Diagram Workspace.
2. Select the Work On-line button from the toolbar. A confirmation message is displayed: select the Yes pushbutton to connect to the PLC.
3. Select the Run Mode button from the toolbar. Differential monitoring can only be accomplished in this PLC operating modes and Monitor mode.
4. Select the contact or coil to monitor.
5. Select the Differential Monitor button from the toolbar. The Differential Monitor dialog is displayed.
6. The address associated with the contact or coil selection is displayed in the Address field. Select an Edge option.
7. Select the Sound setting to retrieve audio whilst monitoring.
8. Select the Start pushbutton to start monitoring. The Start pushbutton becomes a Stop pushbutton.
9. Select the Stop pushbutton to cancel monitoring. Select the Close pushbutton to exit the dialog.
10. Select the Toggle PLC Monitoring button from the toolbar to stop monitoring.

**Instruction Editing**

The Edit Instruction dialog allows an instruction to be selected and entered into the Ladder program.

The dialog can be displayed in two forms, either: simple dialog mode or detailed dialog mode. The default mode can be set in the Diagram tab in the Options dialog. To change the simple dialog mode to a detailed dialog mode, select Detail pushbutton.
Use the following procedure to edit instructions in **simple dialog mode**.

1. Double-click on the instruction field in the Ladder program. The Edit Instruction dialog is displayed.

2. Enter an instruction, either by name or by number. When a correct number has been entered (of the correct number of digits for the PLC type), the instruction name is automatically substituted. To insert an instruction with immediate Refresh properties, apply an exclamation mark ('!') to the beginning of the instruction. To insert a differentiated instruction, apply a '@' symbol to differentiate up or a '%' symbol to differentiate down at the beginning of the instruction. When the **Show with comment dialog** option is selected in the Options dialog, a comment dialog will appear after entering an address or a symbol name.

**Note:** Check the **Show with comment dialog** option in the **Diagram** tab of the **Options** dialog to display a comment dialog. The dialog is displayed after the OK pushbutton is selected on the **Contact** or **Coil** dialog.

3. Enter operands in the same text box with a space between the instruction and each operand (see below for more details about entering operands).

4. Select the **OK** pushbutton to complete the operation. Select the **Cancel** pushbutton to abort the operation.

**Note:** When inputting operands for special instructions using CX-Programmer version 5.0 or higher, symbols can be filtered using symbol names and I/O comments and displayed in a list. Click the **Filter Symbol** Button and enter a text string in the Filter Symbol Dialog Box to limit the search to symbols with symbol names or I/O comments that contain the specified text string. A list of these **address_comment** or **name_address_comment** combinations will be displayed in the drop-down list. Input the required item by selecting it from the list. Use this procedure to increase input efficiency when inputting symbols or comments that have been input before.

This procedure can be used when inputting both programs and function block definitions.

**Example:**

1. Click the **Filter Symbol** Button.
2. Enter a user-specified text string in the Symbol/Address Input field in the Filter Symbol Dialog Box. Example: Enter `temp` in the Symbol/Address Input field.

3. Click the button to display the drop-down list.

4. A list of all `address_comment` followed by `name_address_comment` combinations with symbol names or I/O comments containing the specified text string will be displayed.
Note: If the drop-down list is displayed without any search item input in the Symbol/Address Input field, all symbols that can be used will be listed.

5 Select one of the symbols from the drop-down list and click the Enter Key or the OK Button to input the selected symbol in the Symbol/Address Input field.

- When a symbol or address containing a symbol name is selected, the symbol is entered in the Symbol/Address Input field.
- When an address _comment without a symbol name is selected, the address is entered in the Symbol/Address Input field.

Symbol Filtering Targets

Target Symbol Table: Provides the symbols/addresses registered in the global symbol table and the local symbol table for the current program.

Note: When a symbol with the same symbol name is registered in both the local symbol table and global symbol table, only the symbol registered in the local symbol table will be displayed in the drop-down list.

Target Symbol (Data Type): The target symbols are BOOL type ones for BOOL type operands and ones with data types other than BOOL for CHANNEL type operands.

Target Data: Select Tools – Options, and select the target data for filtering text strings from the following options in the Symbol filtering field of the Diagrams Tab (the default is to filter (search) both symbol names and I/O comments.)

- Name: Only symbol names are searched.
- Comment: Only I/O comments are searched.
- Both: Both symbol names and I/O comments are searched (default).

Use the following procedure to edit instructions in _detailed dialog mode._

1. Double-click on the instruction field in the Ladder program. The Edit Instruction dialog is displayed.
2. Enter an instruction, either by name or by number. When a correct number has been entered (of the correct number of digits for the PLC type), the instruction name is automatically substituted. To insert an instruction with Immediate Refresh properties, apply an exclamation mark (!) to the beginning of the instruction. To insert a differentiated instruction, apply a ‘@’ symbol to differentiate up or a ‘%’ symbol to differentiate down at the beginning of the instruction.

Alternatively, click the Find Instruction pushbutton. The Find Instruction dialog is displayed providing a list of possible instructions. Those instructions not available for the selected PLC are displayed in brackets. Select an Instruction by using the Groups and Instruction fields and select the OK pushbutton to return to the Edit Instruction dialog.

The Availability pushbutton on the Find Instruction dialog displays the PLC Instruction Support dialog that lists all PLCs for which the selected instruction in the Find Instruction dialog is available. Select the Close pushbutton to remove the PLC Instruction Support dialog.

The Expansion Table pushbutton on the Edit Instruction dialog displays the Expansion Instruction Mapping dialog and is only available to certain PLCs. This dialog allows certain instructions to be assigned to an expansion slot.

Select an Expansion Slot, select an Instruction and select the Set pushbutton. To remove an instruction, select the Expansion Slot and select the Remove pushbutton. Alternatively, select the Set Defaults pushbutton to apply default instruction assignments. Select the OK pushbutton to return to the Edit Instruction dialog.

3. If required, use the Instruction Help button, which shows a help topic for the chosen instruction.

4. Enter the instruction operands (see below).

5. Select the OK pushbutton from the Edit Instruction dialog to complete the operation. Select the Cancel pushbutton to abort the operation.

Modifiers can be set for contact instructions (LD, AND, OR and NOT) – either differentiate up or differentiate down. Contact and coil instructions OUT and OUT NOT can be set to immediate update. The availability of modifiers depends upon the type of PLC being used.

Non-differentiated instructions execute each time they are scanned, but differentiated instructions execute only once after their execution condition switches from OFF to ON or from ON to OFF.

Entering Operands
An instruction operand can either be entered as a symbol, address or literal value. When entering an operand in the detailed dialog mode, the dialog shows the valid address ranges and types of operands that are allowed.

When entering an operand, a prefix character may be used to add a meaning:

- An indirect address (the contents of the given address are used as the address to find the data). Can be used in front of a symbol name.
- # A hexadecimal value. Also used for operands that must take a BCD number.
- & A decimal or BCD-format number.
- + or - A signed, decimal, floating point value.

Note that a symbol can hold a value – the NUMBER data type is used.

It is possible to search for a symbol from the operand box by pressing the ‘…’ button to its right (or by pressing F2). This presents a dialog that allows a symbol to be selected or created.

Symbol Information
Whenever CX-Programmer finds a symbol associated with the typed operand, (except number types) symbol information is displayed in this box. The name, address/value and comment are shown, together with the data type of the symbol and its scope, global or local.

Specifying Address Offsets
When using a CJ2 CPU Unit, offsets can be set for addresses when specifying operand addresses for input conditions, output instructions, or special instructions in ladder diagrams. The offset is placed into brackets [ ]
after the address being offset. The offset can be an integer or an address or symbol that specifies integer data. Offsets can be set be set for bit addresses and word addresses.

The format to specify an offset is as follows:

```
A[B]
```

Address being offset
Offset

The above example specifies that address (A) is offset by the value specified by the offset (B) (see note). If the address being offset is a bit address, then the offset specifies the number of bits. If the address being offset is a word address, then the offset specifies the number of words.

An array variable that uses a word address or symbol to specify the subscript cannot be used as an operand in an instruction for which immediate refreshing is specified.

**Note:** Observe the following precaution when specifying a symbol or word address for an offset in a ladder program. When using a symbol or address to indirectly specify an offset for a memory address, be sure that the resulting address is not outside the memory area that contains original address. For example, use a symbol comparison instruction to ensure that processing is performed only when the memory area is not exceeded. If the final address (i.e., the original address plus the specified offset) exceeds the memory area, data in another memory area will be read or written, possibly resulting in unexpected operation.

### Adding Comments to a Program

It is recommended that commenting be used as part of good programming practice. When *Show Program/Section Comments* is selected on the *Ladder Information* tab of *Options* dialog, the comment of the program and section will be shown at the top of the ladder diagram view. Double-click the comments to edit.

Comments should be added to rungs as they are written, so that it is easier to understand their functions when reviewing the program later. Select the *Properties* of the rung to apply a comment to a ladder rung. Select the *Properties* of a program element (contact/coil/instruction) to set a text comment to the element of the Ladder program.

Text can be added as comments to the Ladder program either as notes that are not compiled or as rung comments that are compiled with the code (setting the *Use Comment Instructions* property of a PLC). Rung comments are typically used for introducing and explaining chapters of code.

Comments can also be entered against symbol names and addresses via the elements associated edit or properties dialogs. Symbol comments are downloaded to the Memory Card, if one is present or to allocated EM memory.

**Note:** Unlike the Ladder programs for most PLCs, the Ladder programs for CV-series PLCs show a step offset number for the rung comment (this is because this series has a rung comment instruction).

### I/O Comment View

In the I/O Comment View, you can enter comments by addresses of selected area type. This view is for users who prefer to use addresses and comments when creating a ladder program. Therefore, for users who use symbols for ladder programming, Symbol Table will be preferable to enter comments. If there are any comments already defined in the symbol table, these will also be displayed in the I/O Comment view. When either I/O Comment or Symbol Table view, is edited, the changes will be reflected in the other view. This view can only be edited whilst offline. The pre-defined symbols will be grayed out and cannot be edited.
Use the following procedure to edit the address comments on I/O Comment window.

1. Open the I/O Comment view by selecting the I/O Comment button from the toolbar Edit option.
2. Select the appropriate memory area in which the comments are to be edited from the Area Type.
3. Enter an address in the Start Address and press Enter key.
4. With the selected comment now highlighted click the right mouse button and select the appropriate function. i.e. Edit, Cut, Copy, Paste or Delete. To move to another comment field, enter the appropriate Start Address and press Enter or use the scroll function.

Note that when comments are deleted, symbol(s) defined without a name will also be deleted from the symbol table. For symbol(s) defined with a name on the symbol table, only comment will be deleted.

Note that when editing comments of TIM/CNT Instructions, use I/O Comment view in order to link comments for all BOOL, CHANNEL, and NUMBER type of TIM/CNT instructions. When TIM/CNT comments are entered in this view, the comments for all types of the TIM/CNT instruction will display the same comments.

Setting Multiple I/O Comments for a Single Address

Multiple I/O comments (up to 16) can be registered for a single address symbol. By selecting the comment group to be displayed from the multiple I/O comment groups (up to 16 groups), the I/O comments on the ladder diagram screen can be changed all at once. This function allows multilingual development of a single program or attachment of comments according to the development step.

Block Programs

CX-Programmer supports the ability to enter a rung in statement list format – useful for block programs.

The statement list view of a rung can be used instead of the Mnemonics editor but does not support program monitoring.

Use the following procedure to edit a rung in statement list format.

1. Select a rung. Choose the Show as Rung Statement List option from the context menu of the rung.

   The rung is shown in statement list format.
   Move the cursor to a line on the list, and press ‘Enter’. It is then possible to edit the instructions. Move up and down with the cursor keys, and amend the text. There is no restriction on the length of a statement list program apart from that which Windows may apply.

2. Entries in the statement list block are compiled continuously and the rung may be shown in error (the error bar on the rung margin).

3. To complete the editing, press ‘Escape’ which will exit from editing mode.

4. It may be possible to show the rung back in ladder format. Choose the Show as Rung Ladder option to toggle back to ladder format. It may not be possible to show the instructions in a ladder form.

Program Reusability

Parts of the program (single or multiple rungs, or a single program section) can be saved as a file (.cxr: text file) by selecting File – Reusable File – Save As (CX-Programmer Ver. 4.0 or later). The file can then be read and inserted in a user-set location in the program of another project by selecting File – Reusable File – Add to Project. In the same way, specified variables in a symbol table can be saved as files, and then read and inserted in a symbol table of another project. Multiple reusable files can also be inserted all together in a specified order. The order used to insert multiple reusable files can also be saved in the list of reusable files added to the project. This allows the group of reusable files to be managed as a single unit of data.
Compile

When a program is completed, a full program check is performed and object code is produced.

In addition to allowing the inclusion of multiple programs in a PLC, CX-Programmer also allows all programs to be compiled at the same time. Individual programs can also be selected and compiled separately. Use the following procedure to compile programs.

1, 2, 3...
1. Select the PLC object in the project workspace.
2. Select the Compile PLC Programs button from the toolbar. Alternatively, select the Compile Program button from the toolbar to compile one program.

A dialog is displayed showing the compilation status. The results are shown in the Compile tab of the Output window.

Note: For a CS/CJ/CP-series PLC, a check is made for duplicates of SBN, MCRO and BPRG numbers.

The checks that are performed during compilation can be set by selecting Program Check Options option from the PLC menu. The Program Check Options dialog is displayed.

It is possible to choose between three levels of checking (‘A’ is the most strict, ‘C’ is the least strict), or to define a custom set of checks. Select the appropriate Check Level setting.

For the Custom setting, the Checks field is enabled, allowing each individual check to be set or cleared. The scroll bar reveals further checks. Select the OK pushbutton to complete the operation. Select the Cancel pushbutton to abort the operation.

Note: When performing program checks for Pre-Ver. 2.0 CPU Units, select None from the Unit Ver. pull-down list.

Memory View

Use the Memory View to check the amount of Used and Free program memory in the PLC together with the Total program memory size of the PLC. To show the correct amount of the program memory sizes of the connected PLC, upload the program from the PLC in advance.

The program memory sizes of CS/CJ/CP series PLCs will be shown in Steps and Words for other PLCs.
Note: When function blocks are used with CS/CJ-series CPU Unit Ver.3.0 or later or CP-series CPU Unit, the size of the function block definition and the number of function block definitions is displayed in addition to the Used UM, Free UM, and Total of the UM.

- The Used FB, Free FB, and Total boxes in Function Block field refer to the size of the function block definitions. The values are displayed in step units. 1 step = 4 bytes, so the function block program memory capacity (K bytes) in the CPU Unit's internal flash memory is the value multiplied by 1,024 and divided by 4.
- The Used #, Free #, and Max # fields under Function Block refer to the number of function block definitions.

**Mnemonic Program Editing**

The mnemonic view of a program allows mnemonic instructions to be typed directly. This feature is for advanced users who wish to bypass the more structured programming available in the Ladder program.

Whenever mnemonic instructions are entered, the Ladder program of the program is updated. When a complete rung has been formed by the entered mnemonics, CX-Programmer normalizes the new mnemonics and redraws the rung.

It is possible that during the entry of the mnemonics, the rung can not be drawn in ladder form. In this case, it is shown as a statement list box on the Ladder program.

In order to enter a comment for a rung into the Mnemonics view, enter the character `'' followed by the text. This type of comment must go at the start of a rung’s mnemonics.

In order to enter a comment against a ladder element, enter a comment statement following it - enter the characters `//` followed by the text.

In order to enter a rung annotation (unattached comment), enter the instruction type ‘A’ followed by the text. This type of comment must be at the end of a rung’s mnemonics.
Simulation

Work Online to at Simulator

A program can be monitored or debugged by using a simulator rather than connecting to a PLC.

Use the following procedure to go on-line to a simulator.

1, 2, 3...

1. Select the Program object in the project workspace to display the Ladder program in the Diagram Workspace.

2. Select the Work Online Simulator button from the toolbar. The simulator starts and CX-Programmer goes on-line. Transferring the program is started.

   Note: When a program is on-line to a Simulator, the program will not be able to connect to a PLC and other programs will not be able to go on-line to this Simulator.

   Note: CX-Simulator must be installed to operate this function. CX-Simulator is supported for CS/CJ/CP-series PLCs.

Select the Work Online Simulator button again to go offline with the Simulator.

Select the Exit Simulator option from the PLC menu to close the simulator.

Simulator Function

When the CX-One Ver 1.1 (CX-Programmer Ver. 6.1 and CX-Simulator Ver. 1.6) is being used, the Step Run, Continuous Step Run, Scan Run, and Set/Clear Break Point functions can be executed as CX-Programmer functions (see notes 1 and 2). These functions can also be used with the ladder programs and ST programs within function blocks.

Note 1: The CX-Simulator Ver. 1.6 (sold separately) must be installed in order to use these functions.

Note 2: I/O break conditions cannot be set.

Previously, it was necessary to start the CX-Simulator by selecting Work Online Simulator from the CX-Programmer's PLC Menu, transfer the program to the CX-Simulator in the computer, and execute the debugging operation from the CX-Simulator’s debugging console. With the CX-Programmer Ver. 6.1, the debugging operation can be executed from the CX-Programmer’s toolbar.

The display can be made to scroll automatically during Step Run or Continuous Step Run operation. Also, the break points can be displayed in a list and the display can be made to jump to a specified break point in the list.

Procedure for Simulation Function Operation

1, 2, 3...

1. Open the program that you want to debug.

2. Select View - Toolbars and select the Simulator Debug Option in the Toolbars Tab.

3. Select Work Online Simulator from the CX-Programmer's PLC Menu and transfer the program to the CX-Simulator in the computer.

   Note: Steps 2 and 3 can be done in the opposite order.

   The following icons will be displayed in the toolbar:

   ![Toolbar Icons]

   Note: For details on the Step In and Step Out commands, refer to the CX-Programmer Ver. 6.1 Operation Manual: Function Blocks (catalog number W447). For details on the Step Run, Continuous Step Run, Scan Run, and Set/Clear Break Point commands, refer to the CX-Simulator Operation Manual (catalog number W366).

4. Each debugging operation can be executed by clicking the corresponding icon in the toolbar or selecting the corresponding menu command from the menu.

   Note: Set the duration of the step execution during Continuous Step Run operation by selecting Tools - Options - Continuous Step Interval in the CX-Programmer.
Automatic Scrolling for Step Run Operation
The Simulator can be set to automatically scroll the display to the paused point in the program when performing Step Run or Continuous Step Run operation. To set scrolling, select **Tools - Simulation - Always Display Current Execution Point**.

Break Point List/Jump Function
A break point is a point in the ladder program where execution is paused temporarily. With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1 and CX-Simulator Ver. 1.6), it is possible to list the break points set for the active project’s PLC and jump to a specified break point position in that list.

1. Select **Tools - Simulation – Break Point List**.
2. The Break Point List Dialog Box will be displayed.
3. Click the **Jump**, **Delete**, or **Delete All** Button to jump to a point in the list or delete break points.

PLC-PT Integrated Simulation
When using CX-Programmer Ver. 7.2 or higher (CX-One version 2.1 or higher), the CX-Designer’s offline test function can be used to debug the interactive operation between a CS/CJ/CP/NSJ-series CPU Unit program and NS-series PT touch panel screen data.

**Note 1:** The PLC – PT integrated simulation can operate only with the combination of a CS/CJ-series, CP-series, or NSJ-series PLC and an NS-series PT.

2: This function cannot be used unless the CX-Designer and CX-Simulator are installed when the CX-One Integrated tool Package is installed.

Select **Simulation – PLC-PT Integrated Simulation**. It is also possible to select the CX-Programmer project’s first PLC in the project workspace, right-click to display the pop-up menu, and select **PLC-PT Integrated Simulation**.

**Note:** The PLC-PT Simulation can also be started from the CX-Designer. Refer to the **CX-Designer Operation Manual** (Cat. No. V099) for details on starting the simulation program from the CX-Designer.

PLC Error Simulator
During simulation of ladder programs with CX-Programmer Ver. 7.2 or higher (CX-One version 2.1 or higher), fatal and non-fatal PLC errors can be generated in a special window to debug ladder program sections that detect errors.

The error-processing programs can be debugged easily in a separate window.

1. Connect the simulator online in the CX-Programmer, or start the integrated simulation.
2. If the CX-Programmer is used, select **Simulation – PLC Error Simulator** to start the PLC error simulator program.
3. The PLC Error Simulator Window will be displayed. Select the errors that you want to generate, and press the General Error Button or Clear Error Button to change the status.

**Note:** When the simulator program is stopped, the errors generated up to that point will be cleared.

Working On-line
CX-Programmer permits the connection of the PLC to the computer through the project, and subsequent additional features once the PLC is on-line. Select the **Work On-line** button from the toolbar to connect to the PLC.

Auto Online to a PLC
When maintaining a PLC, CX-Programmer can start monitoring the program of the connected PLC with a toolbar button, after CX-Programmer is started. A PC must be connected to a PLC.

Use the following procedure to go on-line to the PLC automatically.
PART 1: CX-Programmer
CHAPTER 4 – Reference

1. Select the **Auto Online** button from the toolbar. A dialog is displayed showing the PLC type and the network settings of the connected PLC, which CX-Programmer is searching. When CX-Programmer successfully finds the PLC information, it automatically goes online and transfers all the data from the PLC, for example, programs, expansion function (if available), PLC settings, IO table (if available), symbol tables and comments.

2. Select the **Select Serial Port** option from the PLC Auto Online menu to change the serial port when Auto Online. The default serial port is set to COM1.

**Note:** When the Auto Online connection is executed using CX-Programmer Ver.7.2 (CX-One Ver.2.1) or higher, the available personal computer serial ports are automatically detected (automatic detection of computer serial ports function). If a serial port than can be connected online is found, the automatic connection is made from that serial port.

**Auto online - EtherNet/IP Node Online**

You can automatically and easily connect online to a PLC when using CJ2 CPU Units connected to nodes on an EtherNet/IP network.

**Connection Types**
- Connecting to the Target PLC When Connected to a PLC through a USB Cable
- Connecting to the Target PLC through an Ethernet Port on a Computer

**Note:** When running the CX-Programmer on Windows XP (SP2 or higher) or Windows Vista and connecting online to a PLC via EtherNet/IP for the first time, the settings of the Windows Firewall will need to be changed. Refer to Appendix B EtherNet/IP Connections from Windows XP (SP2 or Higher) or Windows Vista in Part 1: CX-Programmer for details on making the changes.

**Procedure**
1. Select **Auto online - EtherNet/IP Node Online** from the PLC Menu. Alternatively, click the EtherNet/IP Node Online Button on the toolbar. After doing either of these, the EtherNet/IP Node Online Dialog Box will be displayed.

2. Select the connection type.
   - Connecting to the Target PLC Using a USB Cable:
     Select the **USB Connection** Option, and set the unit number of the EtherNet/IP Unit or the built-in EtherNet/IP port of the CJ2H-CPU6-EIP to which the USB cable is connected.
Example: Using the Built-in EtherNet/IP Port of the CJ2H-CPU6□-EIP with a Unit Number of 0

♦ Connecting from the Ethernet Port on a Computer to the Target PLC:
   Select the EtherNet/IP Connection Option.
3. Enter the IP address of the target PLC in the IP Address Field in the Connecting PLC Area.

Example: 192.168.250.1 (default IP address for the built-in EtherNet/IP port of the CJ2H-CPU6□-EIP)

The Browse Button can be used to select a PLC from a list if the IP address of the PLC to be connected to is not known.

4. Click the Connect Button to connect online to the target PLC. After connecting, it will be possible to download programs.

**Browsing the Network**

If the IP address of the PLC to be connected is not known, the target PLC can be selected from a list of connectable PLCs.

1. Click the Browse Button in the Connecting PLC Area
   A list of PLCs on the EtherNet/IP network that can currently be connected to will be displayed in the EtherNet/IP Node List Dialog Box.

2. Select the PLC to connect to from the list.
   Select the PLC to connect to, and then click the OK Button.

**Route Path**

When saving a project that was created by connecting to an EtherNet/IP node, the route path to the target PLC can be saved. Saving the route path will allow an easier connection via the same route path the next time you need to connect.
PLC Operating Mode

The PLC can be set to one of four operating modes: Program, Debug (for CV-series PLCs only), Monitor and Run.

♦ **Program Mode.** In this mode, the PLC does not execute its program/s. It is used to download programs/data.

♦ **Debug Mode.** This mode is available on CV-series PLCs and enables basic debugging of user programs.

♦ **Monitor Mode.** This mode allows a running program to be edited and monitored while connected during development. On-line editing must be performed in this mode.

♦ **Run Mode.** This mode sets the PLC to execute the current program as a live operation. This mode is generally used for final testing, after a program has been thoroughly tested and debugged. CX-Programmer cannot write to the PLC while it is in this mode.

Some software operations are possible only in certain modes.

Use the following procedure to change the PLC operating mode.

1. Select the PLC object from the project workspace.
2. Select the **Work On-line** button from the toolbar. A confirmation message is displayed: select the **Yes** pushbutton to connect to the PLC.
3. Select the **Program Mode** button, the **Debug Mode** button, the **Monitor Mode** button or the **Run Mode** button from the toolbar.

Show in RungWrap

Show in RungWrap allows you to monitor long rungs, which exceeds the right bus-bar, in the length of the initial position number of the right bus-bar.

This function is used when CX-Programmer is on-line, or in the read-only mode. While online-editing rungs, the RungWrap will be released and after online-edit is finished, the rungs will be shown as RungWrap again.

CX-Programmer should meet all the following conditions of monitoring rungs in RungWrap.

♦ Show in RungWrap menu is toggled ON.
♦ Show right bus-bar is checked ON (in Options dialog).
♦ The number of Initial position (cells) is set to more than three (do not set Expands to widest rung) in Options dialog.
♦ The length of rungs in the diagram is exceeding the right bus-bar.
♦ CX-Programmer is online to a PLC or is in read-only mode.
♦ The program is shown as Ladder diagram (not in Mnemonics view or shown as Statement List).
♦ No error is found in the program. (Left bus-bar is not shown in red.)
♦ The program is not online-editing.

**Note:** When the right bus-bar is not displayed or the number of initial position of the right bus-bar is less than two, programs cannot be monitored in RungWrap.

Use the following procedure to show the rungs in RungWrap.

1. Select the PLC object from the project workspace.
2. Select the **Work On-line** button from the toolbar. A confirmation message is displayed: select the **Yes** pushbutton to connect to the PLC.
3. Select the **Show in RungWrap** button from the toolbar. The rungs are cut into the size of the right bus-bar and arranged to show long rungs in the view.
Programming On-line

Once a program has been created and the project and PLC settings are satisfactory, the PLC can be connected to allow on-line operations to be performed.

It is usual to have the PLC running in Monitor mode while using on-line editing functions. On-line editing is not possible in Run mode.

Use the following procedure to program whilst on-line.

1, 2, 3...

1. Select the PLC object in the project workplace.
2. Select the **Work On-line** button from the toolbar (see note). A confirmation message is displayed: select the **Yes** pushbutton to connect to the PLC. The icon in the project workspace changes. The background color of the Ladder program changes to show that it is now an editable area.
3. Select the **On-line Edit Rungs** button from the toolbar. The selected area is compared against the same area on the PLC to ensure that they are the same. On-line edit cannot continue until the versions are identical. More than one rung can be selected by keeping the left-mouse button depressed and dragging the mouse over the required rungs.
4. The background color of the selected rungs changes to show that it is now an editable area. Whilst surrounding rungs cannot be edited, they or individual items within these rungs, can be copied into the editable area.

**Note:** If a checkmark has been placed by **Prohibit the online operations until the PC and PLC data matches**, the following **Online Action** dialog box will appear so that you can select either verifying or transferring data will be displayed.

If **Compare with PLC** is selected, the program will be verified between the CX-Programmer and the PLC before going online.

If **Transfer from PLC** is selected, the program will be uploaded from the PLC before going online.

If **Transfer to PLC** is selected, the program will be downloaded to the PLC before going online.

On-line editing can now take place, as it would be accomplished offline. The final END instruction cannot be edited on-line.
Once normal editing is completed, select the **Send On-line Edit Changes** button from the toolbar. The changes are committed to the PLC. If the changes are successful, the edited area of the Ladder program returns to read-only mode.

The on-line edit can be cancelled at any point prior to committing the changes by selecting the **Cancel On-line Edit Changes** button from the toolbar. The program is restored to prior to starting on-line editing.

Select **Go to on-line edit rung** to go to the top of the on-line editing rung.

Working on rungs while the PLC is connected, and being able to easily change the program is one of the quickest ways to complete and check a project. With the PLC running in Monitor mode it is possible to make changes as if the PLC were not connected. The difference is that once a rung has been completed, it can be downloaded to the PLC while the program is running.

When performing on-line editing, all rungs must be complete and valid before they can be transferred, whereas in offline editing, an invalid rung and program can be saved at any time.

After forced setting/resetting of a bit online, a dialog box is displayed when status returns to offline to allow the forced set/reset status of addresses to be displayed (CX-Programmer Ver. 4.0 or later). The forced set/reset status can also be cancelled. Enable this function by selecting **Tools – Options** and **Check forced status after online connection** in the PLCs Tab Page (the default setting is OFF: no confirmation). This function prevents going offline unprepared when the CPU Unit is still in forced set/reset status.

### Uploading Program/s from the PLC

A program can be uploaded from the currently connected PLC into the open project. All associated program data (for example symbol details and IO table) are uploaded.

Use the following procedure to transfer a program from the PLC.

1. Select the PLC object in the project workspace.
2. Select the **Work On-line** button from the toolbar. A confirmation message is displayed; select the **Yes** pushbutton to connect to the PLC.
3. Select the **Transfer from PLC** button from the toolbar. A warning dialog is displayed indicating that the current program in the project is overwritten. The Upload Options dialog is displayed allowing individual components to be selected for transfer from the PLC, for example, programs, expansion functions (if available), memory allocation, settings, IO table and memory.

**Note:** It is possible to upload a single program or section for online-editing, if section markers have been included in the program. When a single section has been uploaded, it can only be online-edited, or copied to another, complete program.

**Note:** It is possible to load symbol definitions from the PLC, if it has a file-card (CS/CJ/CV PLCs), file memory or comment memory. Loading symbols from comment memory is for backward compatibility with the OMRON SSS package: the symbols contained in the memory will be unnamed, global symbols.

**Note:** When **Start Auto Decompiling** is checked CX-Programmer automatically starts to decompile after uploading the program from the PLC.

4. Set the settings as required and select the **OK** pushbutton.

5. The Uploading dialog indicates the success (or not) of the transfer operation. Any errors are written to the Error Log. Select the **OK** pushbutton to complete the operation.

### Downloading Programs to the PLC

Programs can be downloaded to the PLC from the project when the PLC is in Program mode. If the PLC is not already in this mode, CX-Programmer changes the mode automatically.

Use the following procedure to transfer a program to the PLC.

1. Select the PLC object in the project workspace.

2. Select the **Work On-line** button from the toolbar. A confirmation message is displayed; select the **Yes** pushbutton to connect to the PLC.

3. Select the **Transfer To PLC** button from the toolbar. The Download Options dialog is displayed allowing the download of programs, settings and IO table individually or together.

**Note:** It is possible to save symbol definitions to the PLC, if it has a file-card (CS/CJ/CV PLCs), file memory or comment memory. Saving symbols to comment memory is for backward compatibility with the OMRON SSS package: only global symbols without names are downloaded.

3. Set the settings as required and select the **OK** pushbutton. The items that can be downloaded vary according to PLC series.

The program is compiled and then a confirmation dialog is displayed. The Ladder program is out-out, preventing any further editing. The operating mode and the cycle time of the task is displayed in the status bar.

It is not possible to download a single program or selection of programs to the PLC – all programs are downloaded together. However, any programs that have ‘unassigned’ tasks (set in the program properties) will not be included.

Programs can be downloaded to CS/CJ-series PLCs Ver. 2.0 or later or CP-series PLCs, and downloading by task (program) instead of the whole user program is possible (CX-Programmer Ver. 4.0 or later). Select **Partial Transfer – Task Transfer to PLC** from the **PLC** Menu, and download a specified single task or multiple tasks. This function enhances the efficiency of program development by multiple personnel. Particularly, by downloading to the PLC by task (program), only the parts to be changed are reflected in the PLC, resulting in fewer working errors.

**Note:** When the CX-Programmer version 5.0 is used to download projects with a CS/CJ-series CPU Unit with Ver. 3.0 or later or CP-series CPU Unit, I/O comments, symbol names, rung comments, and other data can be transferred either to the Memory Card, EM file memory, or comment memory (within CPU Unit’s flash memory). Therefore, even if a Memory Card or EM file memory is not available, the I/O comments, symbol names, rung comments, or other data can be stored in the CPU Unit’s comment memory.

**Note:** This functionality is not supported for CP1E CPU Units.

The following option will be displayed for a CJ2 CPU Unit: Clear automatic allocation area and forced status. If this option is selected when downloading programs, all automatic allocation area data and forced status will be cleared. Select this option when it is necessary to change the automatic allocation area.
Canceling the Program Transfer
While transferring a program to or from a PLC it is possible to cancel the transfer by clicking the Cancel button. However depending on when the button is pressed different functionality will occur.

If the Cancel button is pressed before or during the Memory Clear phase the memory clear will be completed but the data transfer will not take place. If the button is pressed during the Transfer phase the transfer will be stopped and the PLC memory will be cleared. The transfer will not be completed.

Comparing Programs
The project PLC program data can be compared with the data inside the PLC.

The following comparisons may be performed, depending on PLC type:
♦ Program step number and instructions;
♦ PLC data;
♦ Expansion Instruction Table (CQM1, C200HE, C200HG, C200HS and C200HX only);
♦ UM allocation data (CQM1, C200HE, C200HG, C200HS and C200HX only).

Use the following procedure to compare programs on the computer and on the PLC.

1. Select the PLC object in the project workspace.
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; select the Yes pushbutton to connect to the PLC.
3. Select the Compare with PLC button from the toolbar. The Compare Options dialog is displayed allowing comparisons of programs, settings and IO table individually or together.
4. Set the settings as required and select the OK pushbutton. The items that can be downloaded vary according to PLC series.

Details regarding comparisons between computer and PLC programs are displayed in the Compare Result dialog box.

The results of verification can be saved to a file in CSV format.

Two methods can be used to display the comparison results.
♦ Overview display: Program lists are displayed of the compare programs.
♦ Mnemonic display: The specified program is displayed in mnemonic form with differences displayed in color.

The comparison results are displayed by section and mnemonic, including added instructions. You can also jump from the mnemonic comparison results to the corresponding position in ladder view. The comparison results can be saved in a file by selecting Save As from the File menu in the Compare Result dialog box. If the file is saved from the overview display, the comparison results for all programs will be saved in CSV format. If the file is saved from the mnemonic display, the comparison results for the currently displayed program will be saved in CSV format.

The following abbreviations will be displayed between program addresses and mnemonics and will be in the CSV file.
*: Mismatch, D: Difference, M: Moved, N: Missing

Transferring Programs, Symbols, Comments and Index to and from File/File-card
It is possible to write a combination of program code, program comments and symbol definitions to a set of files. It is possible to read these files back.

If a file-card can be attached directly to the computer (via a PCMCIA controller, for example), then it can be used as a disk device like a floppy drive, and files may be directly transferred with it.

1. Select the PLC object in the project workspace.
2. Select the Transfer/To File or Transfer/From File options from the PLC menu. Or select Load Comment/Program or Save Comment/Program options from the File menu. A dialog is presented which allows the filename to be set or browsed. Choose whether to include Programs, Comments, Symbols or Index in the transfer on this dialog.
   For programs, a short Comment may also be given for inclusion in the file.
Note: When loading comments, text within the program comments (for the project’s PLC) is overwritten. When loading symbols, the local and global symbols for the PLC and programs are first emptied.

If the file-card cannot be attached directly to the computer
When the file-card cannot be attached to the computer, it is possible to transfer comments and symbols to the PLC file-card directly using the Transfer to PLC option above. To write the program to the file-card, use the above steps to produce the program file on one of the computer’s disks. It is then possible to transfer the file between the disk drive and the file-card on a PLC using the CX-Server memory-card component – please refer to the CX-Server PLC Tools user-manual.

Program Monitoring
Program monitoring allows the power flow of a PLC program to be displayed whilst the PLC program is running. Power flow is displayed by a thick line across items in the Ladder program that currently have power flowing through them.

Note: The data from several PLCs can be monitored at the same time. Ensure the program has been downloaded and the PLC mode set to Monitor.

Use the following procedure to monitor a program.

1, 2, 3…
1. Select the Program object in the project workspace to display the Ladder program in the Diagram Workspace.
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; select the Yes pushbutton to connect to the PLC.
3. Select the Monitor Mode button or Run Mode button from the toolbar. Monitoring can only be accomplished in these PLC operating modes.
4. Select the Toggle PLC Monitoring button from the toolbar to start monitoring power flow in the Ladder program.
5. Select the Toggle PLC Monitoring button from the toolbar to stop monitoring.

Note: The PLC Monitoring function can be activated whilst in Mnemonics view. The display format for the present values of operands of special instructions when monitoring on the Ladder Section Window can be selected from the following data types. The same display format must be used globally. To select the display format, click the desired button or select Monitoring Data Type from the View menu.

- Decimal
- Signed Decimal
- Monitor in Hex

The default display formats will be as follows if none of the above display formats is selected.

- Named symbol will be monitored in the symbol data type.
- Unnamed symbol will be monitored in the operand data type.
- Two-word operations, such as for the MOVL instruction, will be monitored in 2-word hexadecimal.
- For present values displayed in formats other than hexadecimal, “D” is attached for 2-word data and “L” is attached for 4-word.

Note: The user can confirm whether a task (program) is executing or stopped (CS/CJ/CP-series CPU Units only; CX-Programmer Ver. 4.0 or later). The following executing/stopped status is displayed for every task (see note) in the project space.

Note: Cyclic tasks only. Interrupt tasks not included.
- Running: Indicated as READY (execution enabled) or RUN (executing status).
- Stopped: Indicated as INI (not executing status) or WAIT (standby status).
This function improves debugging efficiency when using multiple tasks.

The background color of the Ladder Section Window for the task being executed can be specified by the user.

**Pause Monitoring**

Pause Monitoring is an online function that allows the normal monitoring display to be frozen at a point in time, so that the logic of a program can be examined. The pause can be triggered either manually or by a trigger condition.

**Note:** Due to the speed at which a PLC operates and the slow speed of some network communications, a trigger condition on a PLC may not always be found, especially if the trigger condition is a transient and only occurs for brief moment in time.

Use the following procedure to Pause monitor a program.

1. To enable pause monitoring, first select 'PLC Monitoring', so that monitoring is working normally.
2. Select a range of rungs that are of interest to monitor. This is necessary to allow the monitoring to be as fast as possible (the less values to monitor, the faster the data can be obtained through communication with the PLC).
3. Select the 'Pause Upon Trigger' command. This will present a dialog allowing the choice of trigger. Select either Manually or Triggered. **Triggered:** When the pause is triggered, a trigger condition is necessary. A trigger condition happens when the contents of an address reaches a certain value or makes a transition. 

   It is possible to enter an address or a symbol name into the dialog, or browse for a symbol. Select the type of condition, supplying the value or transition type.

Manually: This option means that monitoring will only be paused when told to do so. Select ‘Manually’ in the dialog and press ‘OK’. Monitoring then begins. To operate the pause, wait until the monitoring screen is interesting, then select 'Pause' from the toolbar or from the PLC/Monitor menu. The monitoring function is paused (the 'Pause' button on the toolbar is shown as down). To resume monitoring, press the 'Pause' button again, and monitoring will resume, waiting for another trigger.

If a condition is being used for pausing, the monitoring display will continue until the condition has been met, at which point the 'Pause' button will be shown as down and monitoring freezes. To resume monitoring, and wait for another instance of the condition, press 'Pause' again. Note that it is possible to manually pause the monitoring by pressing 'Pause' even when using the ‘Triggered’ type of condition. To resume full monitoring, press the 'Pause Upon Trigger' button again, so that it is shown as out.

**Stopping Pause Monitoring**

Pause monitoring may be stopped either by taking the PLC off-line, taking the PLC out of monitor or run mode, or by selecting pause monitoring again – This is effectively a toggle button.

On stopping pause monitoring, the hatched areas are removed and the PLC is either taken off-line, returned to a normal on-line state or returned to normal monitoring or run mode.

The trigger condition that has been set is remembered should it be required to restart pause monitoring again in the same session.

**PLC Cycle Time**

The PLC Cycle Time dialog allows the PLC’s cycle times to be measured. The PLC Cycle Time is always displayed in the status bar.
The minimum cycle time and the Change Button are displayed only for CJ2H CPU Units with unit version 1.1 or later.

For certain CV-series PLCs if the ladder program contains Mark instructions, the PLC Cycle Time dialog permits the measurement between the Start Mark and Stop Mark instructions.

Use the following procedure to measure PLC cycle time.

1. Select the PLC object in the project workspace.
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; select the Yes pushbutton to connect to the PLC.
3. Open the cycle time dialog using the Cycle Time command in the PLC/Edit menu.
   The mean, minimum and maximum cycle time is shown in the Cycle Time fields.
   Select the Reset button to empty the PLC’s history buffer for these fields – the values will then be calculated and updated by the PLC using the latest values only.
4. To measure the time to execute between two points in a program, enter the Start mark and stop mark numbers in the Start Mark # field and Stop Mark # field. Note that only certain PLCs have this feature. Also, MARK instructions must have been placed in the program/s and downloaded to the PLC. Select the Measure pushbutton – a measurement will then be taken and displayed in the Time field. Select the Abort pushbutton to cancel the measurement.
5. Select the Close pushbutton to complete the operation.

### Changing the Minimum Cycle Time Online

With CJ2H CPU Units with unit version 1.1 or later, the minimum cycle time can be changed to a specified value even during PLC operation in MONITOR Mode when the cycle time is set to “constant” in the cycle time settings in the Timings/Synchronous Tab Page in the PLC Setup.

1. Click the Change Button in the PLC Cycle Time Dialog Box. The Constant Cycle Time Setting Dialog Box will be displayed so that you can set a minimum cycle time.
2. Change the minimum cycle time (ms).
3. Click the OK Button. The Constant Cycle Time Setting Dialog Box will be closed and the minimum cycle time will be updated.
Note: The set value that is changed here will not be updated in the Timings/Synchronous Tab Page in the PLC Setup. To update the PLC Setup, transfer the PLC Setup to the personal computer.

Monitoring Synchronous Unit Operation (CJ2H CPU Units with Unit Version 1.1 or Later)

The operating status of synchronous unit operation can be monitored. The status of errors and warnings related to sending and receiving synchronous refresh data can be displayed, along with the maximum and present values for the synchronous processing time. This makes it possible to check whether synchronous unit operation is functioning correctly, to check whether operation is within the set range for the synchronous operation cycle, and to make adjustments.

For details on the Synchronous Operation Status Window, refer to the CJ2 CPU Unit Software Manual (Cat. No. W473).

The Synchronous Operation Status Dialog Box will be displayed to enable confirming the status of synchronous unit operation.

PLC Program Assignments

The Project PLC Program Assignments dialog lists all tasks and their associated program names for the selected PLC in the project. The list can then be printed.

Use the following procedure to print PLC program assignments.

1. Select the PLC object in the project workspace.
2. Select Program Assignments from the PLC menu.
3. Select the Print pushbutton to print the program assignments.
4. Select the Close pushbutton.
PLC Information

The PLC Information dialog displays information associated with the PLC device, including:

♦ Device type;
♦ Program memory (usable/size and whether protected);
♦ Memory type;
♦ File/memory card presence;
♦ Data memory size;
♦ Extension memory size;
♦ IO memory size;
♦ Timers/counters memory size.

Note: Different PLC devices are capable of reporting different types of information.

To access the PLC Information dialog, select Information from the PLC menu. Select the Close pushbutton to exit the PLC Information dialog. (Note that the PLC must be on line).

Setting the PLC’s Clock

When a PLC is on-line, its clock (if it has one) can be synchronized to the computer clock or the PLC clock can be set to a specific time.

Use the following procedure to set the PLC’s clock.

1. Select the PLC object in the project workspace to display the Ladder program in the Diagram Workspace.
2. Select the Work On-line button from the toolbar. A confirmation message is displayed; select the Yes pushbutton to connect to the PLC.
3. If the PLC has a clock, the project workspace will show a PLC Clock icon. Double-click this to show the CX-Server clock dialog.

Refer to the CX-Server PLC Tools User Manual for further information on setting the PLC clock.

Applying a Password to the PLC

The C-series PLCs and CS/CJ/CP-series PLCs support use of a single password to protect an individual PLC. The CV-series PLC supports two passwords that provide either system (overall) or partial protection (protecting specific programs on a PLC). For password information relating to a specific PLC, refer to that PLC’s user manual.

When enabled, the password is required every time the protected program or PLC is accessed.

The password can be released if necessary, for example, if a new PLC is being created and details need to be uploaded from a protected PLC/program to be copied into the new PLC.

Use the following procedure to apply a password to the PLC. This facility is only available when the PLC is on-line. Note that for the C-Series PLCs this is done via FUN(49) and after the program is protected, select Protection Write Protect from the Transfer menu to set and release the protect.

1. Select the PLC object in the project workspace.
2. Select the Show Properties button from the toolbar. The PLC Properties dialog is displayed.
3. Display the Protection tab of the PLC Properties dialog.
4. Enter a password; this has a maximum of eight characters for CS/CJ/CP-series PLCs or entered as an operand of FUN(49) instruction.
5. To release the password, delete the entry from this field.
6. Select the Close button from the title bar to close the dialog.
7. Select the Set Password button from the toolbar to enable protection for the PLC. The Set Program Protection dialog is displayed. Select the items to apply protection to in the Items to Set field. Select the OK pushbutton to accept the settings or select the Cancel pushbutton to abort the operation.
8. Select the Release Password button from the toolbar to disable protection for the PLC. The Release Program Protection dialog is displayed. Select the items to release protection.
to in the Items to Release field. Select the OK pushbutton to accept the settings or select the Cancel pushbutton to abort the operation.

Refer to Chapter 5 - Advanced Topics for further information.

Note: The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to initialize the CPU Unit by selecting Clear All Memory Areas from the CX-Programmer’s PLC menu or selecting Clear All Memory Areas from the Options menu of the PLC Errors dialog box.

These operations are possible even if a memory error has not occurred in the PLC (the same as they are for a Programming Console).

Flash ROM Backup

CX-Programmer supports the Monitoring function of Flash ROM Backup for the CS1x-H, CJ1x-H, or CP1H series of PLCs. When a backup is started for a CS1x-H, CJ1x-H, or CP1H PLC the Backup Monitor dialog is displayed automatically in online mode, when the option 'Display Backup Monitor Dialog automatically' is selected on the PLC Properties dialog. It can also be invoked manually from the View | Windows | PLC Memory Backup Status option.

The dialog is an information only dialog (or modeless) thereby enabling other operations to be executed during the backup process.

CX-Programmer always monitors the backup status while operating in online mode.

---

**PLC Memory Backup Status – NewPLC1**

**Title Bar**

This shows the name of the dialog and the name of the connected PLC.

**Warning**

In this example the PLC memory backup is in progress and the warning indicates that the PLC must not be powered off if the backup is to be successful. If the power is removed the memory will be cleared.

Other warnings are:

- Storing Program Area….
  - WARNING: DO NOT POWER OFF PLC DURING BACKUP
- Backing up Parameter Area….
  - WARNING: DO NOT POWER OFF PLC DURING BACKUP

**Message**

Other messages are:

- Clearing Program Area….
- Storing Program Area….
- Backup Complete….

**Program Backup status**

These status bars show the progress of Clearing and Storing the program.

Sectors are memory blocks within the PLC memory. The sector number information is only displayed when clearing the program and indicates the number of sectors to be cleared and the sector currently being cleared.

**Close Dialog when complete**

Checking this box will cause the Backup Monitor dialog to close when the backup is complete (default – unchecked).
Displaying Backup status in Status Bar

Displaying the Backup status indicator in the status bar, from the toolbar menu View|Windows|PLC Memory Backup Status:

Whenever the connected PLC is backing up data to the Flash ROM, the backup status indicator will be displayed as follows:

```
[Backup] New PLC: Master Mode 1:00m 100%
```

The indicator will flash during the backup operation. When the backup has been completed no indicator is displayed.

**Note:** With the C-series PLCs, any of the following methods can be used for data transfer and verification with a ROM Writer.

- Using the CX-Programmer, transfer the program from the computer to the ROM Writer.
- Transfer to program from the ROM Writer to a CX-Programmer project.
- Verify programs between CX-Programmer and ROM Writer.
- Create Intel Hex format files from CX-Programmer programs.
- Input from an Intel Hex format file to the CX-Programmer project.

**Note:** The data transferred for each PLC is listed below.

<table>
<thead>
<tr>
<th>PLC Data</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1000H/2000H Program, I/O tables, SYSMAC NET data link tables, battery error detection method</td>
<td></td>
</tr>
<tr>
<td>C200H Program, I/O tables, Fixed DM, battery error detection method</td>
<td></td>
</tr>
<tr>
<td>C200HS Program, I/O tables, PLC Setup, Expansion DM, expansion instructions</td>
<td></td>
</tr>
<tr>
<td>CQM1, CQM1H Program, PLC Setup, expansion instructions</td>
<td></td>
</tr>
<tr>
<td>C200HX/HG/HE (-Z) Program, I/O tables, PLC Setup, Expansion DM, expansion instructions</td>
<td></td>
</tr>
</tbody>
</table>

Data Trace/Time Chart Monitoring

Once a program has been downloaded into a PLC and is being executed, the program and any associated data can be graphically traced providing an analytical tool for monitoring program performance.

During the execution of a Data Trace, the PLC records the data values and holds them in an internal buffer. When the trace is complete, the values are uploaded from the PLC and displayed on the screen.

Select the **Data Trace** button from the toolbar or **Time Chart Monitoring** from the **PLC** menu. Refer to the **CX-Server PLC Tools User Manual** for further information.

CX-Net Network Configuration Tool

The CX-Net Network Configuration tool provides procedures for establishing communications to PLCs for direct and gateway connections. It allows the creation and editing of local and network Routing Tables, and the creation and editing of Data Link Tables.

To open the CX-Net Network Configuration tool, select **Network Configuration Tool** from the **Tools** menu. A temporary project file (CXP Project.cdm) will be created with the same PLC types in the CX-Programmer project.

Refer to the **CX-Server PLC Tools User Manual** for further information.
IO Table

The IO table enables the map of racks and units needed by the PLC programs to be edited. It also allows the desired map to be compared with the actual map of the connected PLC when online. See the CX-Server PLC Tools User manual for details on editing the table.

Some (usually smaller) PLCs do not have configurable IO, and so do not have an IO table.

Once IO assignments have been made, affected addresses are shown prefixed in CX-Programmer’s program editors. An ‘I: ’ prefix indicates that the address is mapped to an input unit. A ‘Q: ’ prefix indicates that the address is mapped to an output unit. Select Show actual I/O bit in XY in the Diagrams tab of Options dialog to change the prefix to ‘X: ’ and ‘Y: ’.
CHAPTER 5
Advanced Topics

This chapter discusses features and topics associated with CX-Programmer for use by advanced programmers.

Writing More Maintainable Programs

CX-Programmer contains features that allow better-documented, more maintainable programs to be developed. The following paragraphs discuss the topics associated with those features.

Symbols

Symbols give readability to a program by adding a meaningful name and/or comment to an address or value. Symbols should be defined locally to a program and rarely at PLC global scope, unless it is necessary to share an address between a PLC’s programs. Keeping symbols local means that the symbol set for the program is as small and maintainable as possible, and stops modifications of one program from affecting others. Other benefits include the ability to easily cut/paste a program between PLCs or projects, keeping the correct symbol set.

It is possible to override the definition of a global symbol at local level, by redefining the symbol at the local level. CX-Programmer gives a warning when performing a program check, but the practice is allowed.

It may improve readability and maintainability by defining ‘work’ type addresses automatically. Any address that is automatically assigned is indicated as such each time it is used. The allocation of addresses is controlled at the PLC level – CX-Programmer ensures that all addresses are unique within the assigned address range.

Data Types

A symbol’s data type allows CX-Programmer to check correct usage of the address – for example, a symbol can indicate that an address is for Binary Coded Decimal encoded values. CX-Programmer checks that the address is not used incorrectly in binary instructions.

Although the CHANNEL data type is available for symbols, it does not give protection against incorrect encoding usage. The CHANNEL data type is for use when the data within an address is of an indeterminate format. It can also be used to mark the start of an array.

The NUMBER data-type makes it possible to create a symbol for a constant value, further helping readability.

Copying Information between Projects

CX-Programmer can only open a single project at a time. However, it is possible to copy parts of the project information to another project. To do this, it is necessary to have two CX-Programmer applications running at the same time.

Data that can be copied includes the following:

♦ PLCs;
♦ Programs;
♦ Symbol tables;
♦ Symbols;
♦ Parts of a Ladder program.

It is thus possible to integrate programs and information from several projects. This is useful, for example, where each person on a team is responsible for writing a single program. The person responsible for integration can then copy each program produced, from its own project into a single PLC on the master project.

Both cut/paste and drag/drop techniques can be used to copy data. For cut/paste, copy the data to the clipboard in one application, and paste into the other application.

Note: When a program is pasted from one PLC type to another, it does not undergo program conversion. To correctly assemble programs from different PLC types, it is necessary to first change the PLC types of the source programs to the target type before copying.
Using CX-Programmer with Other Applications

CX-Programmer can be utilized effectively with other applications within the Microsoft Windows environment.

Converting Projects

It is possible to convert data from other applications to CX-Programmer. A file conversion utility is provided with CX-Programmer that allows files from other packages to be converted to a CX-Programmer project.

SYSWIN, CVSS, SSS and SYSMAC-CPT projects can all be converted to CX-Programmer projects. The simplest way to convert a project is to start CX-Programmer, select Open from the ‘File’ menu, change the ‘Files of Type’ combo to point to the appropriate project type (e.g. ‘SYSWIN 3.x Project (*.SWP)’ for SYSWIN 3.x projects) and then navigate to the appropriate (SYSWIN) project to be converted.

Alternatively, the following procedure can be followed to run the converter manually for other project types.

1. Activate the File Conversion Utility from the Start pushbutton on the Microsoft Windows taskbar.
2. Select Import from the File menu. The Select Import File dialog is displayed.
3. Choose the file type that is to be imported in the Files of type field.
4. Select the file that is to be converted from the File name field.
5. Select the Open pushbutton to open the file. Select the Cancel pushbutton to abort the operation.

The conversion process begins. Depending upon the file type chosen, messages or choices may appear. Follow the instructions on the screen.

A CX-Programmer project is created, usually with the same name as the original file, but with the file extension of ‘CXT’ (the text version of the CXP file type). This can be opened from within CX-Programmer as normal, ensuring that the Files of type field within the Open CX-Programmer File dialog is set to ‘CX-Programmer Text Files (*.cxt)’.

It is possible to show details of the available converters by showing the File Conversion Utility’s About dialog. This lists the converters – details of a converter can be displayed by selecting the Info pushbutton, after first selecting a converter.

Sharing Symbols

CX-Programmer supports a mechanism for sharing symbol definitions with other, compliant applications. This could allow, for example, the symbols declared within CX-Programmer to be linked to a SCADA package so that the definitions and changes of addresses are synchronized.

Note: The sharing is not active – changes in the shared symbols are not instantly broadcast to the other applications.

A CX-Server file is used as the medium for transferring symbol definitions between applications.

Use the following procedure as an example of how particular symbols are linked between CX-Programmer and a fictional SCADA application AppX.

1. In CX-Programmer, create a new CX-Server file through the Project Properties dialog. This ‘.CDM’ type file will hold the definitions of all linked symbols. Refer to Chapter 3 Project Reference for further information.
2. For each symbol required to be shared, set its Link the definition to the CX-Server file setting. Only global, named symbols can be shared.
3. Save the project. At this time, the CX-Server file is created with a copy of the definitions of the shared symbols.
4. In AppX, a similar process is followed, linking the CX-Server file to its CX-Server project file. When the CX-Server project is then opened, the shared symbols are loaded into its symbol definitions.
5. Whenever linked symbols are changed within CX-Programmer and the project is saved, the CX-Server file is updated. When AppX opens its CX-Server project again, its definition of the changed symbols is updated.
Note: The linkage between CX-Programmer and another application operates both ways. It is possible for the other application to change the definitions of linked symbols, and to create them. When CX-Programmer opens its project again, the ‘.CDM’ file is checked for any changes made to the linked symbols within CX-Programmer. Optionally (depending upon the PLC Confirm Changes in Linked Global Symbols setting), each change is indicated and confirmed. Any new symbols present in the linked file are also read into the PLC’s global symbol table.

CX-Programmer stores the necessary PLC definitions inside the CX-Server file as well as the linked symbols. Therefore, the other application also has a PLC object of the same name in order to share the information.

Note: When the name of a linked symbol is changed, the link to it in the other application is lost. The name is used as the link between the definitions. The other application actually treats it as a new symbol. Similarly, if the PLC name is changed, the linkage to its symbols is lost.

Importing and Exporting Symbols

CX-Programmer has the ability to import and export symbol definitions to or from another package, such as a spreadsheet. The information is transferred in a text format, so it is also possible to use a word processor to define a set of symbols and use them within CX-Programmer.

Exporting

Use the following procedure to export a set of symbol definitions to a spreadsheet or word-processor:

1. Select a set of symbols in a symbol table, or select a complete symbol table from the project workspace.
2. Perform a copy operation.
3. Activate the other application.
4. Perform a paste operation (this may be done differently according to the application, but is generally done using the Paste command under the Edit menu).

Note: For the paste to work successfully, it may be necessary to indicate to the other application what the format of the data is. See below for the format information.

Importing

Use the following procedure to import a set of symbol definitions from a spreadsheet or word-processor:

1. Select the information in the source application - ensure that it is of the correct format (see Information Format below).
2. Perform a copy operation.
3. Activate CX-Programmer.
4. Paste the information into the correct symbol table by either opening the table or pasting when a symbol table is selected in the project workspace.

Note: If errors are encountered in the information when pasting symbols, a dialog is shown which allows the information to be modified. This dialog lists all symbols in the information that contain errors (i.e. Symbol with invalid names or invalid addresses). Each symbol may be modified or removed from the list before retrying the operation.

Importing Network Symbols

CSV files can be used to import network symbols created on the Network Configurator. The Network Configurator is the software application used to set data links in EtherNet/IP networks.

Procedure:
1. Select the symbol table and then select Insert – Import Network Variable from the menus.
2. Select a network tag file that was saved from the Network Configurator.

Information Format

The information is in a tabbed format of text.
**Column Format**

For supplying symbols complete with data-type, use format of 4 columns, which consists of:

```
<Symbol Name> tab <Symbol Data-type> tab <Symbol Address> tab <Comment>
```

The items in <> brackets are the data. e.g. A supplied piece of text such as:

"Name  BOOL  1.1      this is a comment" is valid (without the ").

Each item should be on a new line.

**Note:** It is possible to have a blank address in this format, in which case the address will be automatically allocated by CX-Programmer.

**Spreadsheets**

When using a spreadsheet to create the data, use a table of the relevant number of columns and rows in the format above. Ensure that the host application is set to produce tabbed text when pasting (this maybe the default).

**Rules for Symbol Linking / Unlinking**

**Order of Precedence**

Whenever an operation is performed that requires a symbol to be linked or re-linked there is an order of precedence that the symbol tables are searched in. The order of precedence of searching is as follows,

- Search in the local symbol table.
- Search in the global symbol table.

**Note:** Where symbols within the same table have the same address then the Symbol used will be determined by alphanumeric order.

**Inserting Symbols**

When a new symbol is added to a symbol table the ladder diagrams will be searched, looking for an address or symbol name to match using the order of precedence specified above.

When a new symbol is created without an address and Auto Allocation has been enabled then a new address is allocated to the symbol. If however Auto Allocation has not been enabled then the symbol’s address is shown as N/A [Auto] and any operand that uses that symbol will be in error.

**Modification of symbols**

A symbol may be renamed in the symbol table. Following this the change in name is reflected to the ladder diagram for any operands that are linked to that symbol. Note that no change in the linkage occurs.

A symbol may have its address modified in the symbol table. Any operands linked to this symbol will remain linked, however if there are ladder elements with physical addresses that match the symbols new address, these will now be linked to the symbol.

**Deleting Symbols**

When a symbol is deleted from the symbol table any operands that are currently linked to that symbol will be re-linked to new symbols. The symbols are searched for using the order of precedence rule. If a new match is found then the operand will be linked to the new symbol. If however no new match is found then the operand reverts to the physical address of the deleted symbol.

**Entering Contact or Coils into Ladder Diagrams**

When a contact or coil is entered into a ladder diagram the user may enter an address, or symbol name.

If an address is entered then the address is searched for in the symbol tables in the order of precedence. If a symbol with the address is found then it is linked to the contact. If an address is not found then the contact has a physical address.

If the user enters a symbol name then the symbol tables are searched in order and if a symbol is found with the same name the contact is linked to that symbol. If no match is found in the symbol tables then a new symbol is created in the local symbol table and the contact is linked to the new symbol. A new symbol is not created for instruction operands, as it is not known what data type to create.
If an operand is linked to a symbol in the global symbol table, this link may be overridden by creating a new symbol in the local symbol table with either the same name or the same address. The operand will then be linked to the local symbol.

**Converting Programs between PLC Types**

It is possible to automatically convert a program written for one type of PLC into another. CX-Programmer attempts to change addresses and mnemonic instructions from the source PLC type to equivalent addresses and instructions on the new type of PLC.

Use the following procedure to convert program to PLC types.

1. Double-click the PLC object in the project workspace. The Change PLC dialog is displayed, part of the CX-Server application. Change its CPU and PLC device to the new type.
2. A program check is performed to ensure there are no errors. It is not possible to convert a program that contains errors.
3. The programs are converted before replacing them. Any addresses and instructions that cannot be directly replaced are listed in the Compile tab of the Output window.
4. CX-Programmer displays a confirmation dialog to replace the old programs with the new. If there are conversion errors (listed in the output window), it is best to select the Cancel pushbutton to abort the conversion and change the original programs to remove the conversion problems. If the conversion is acceptable, select the Ok pushbutton to replace the programs.

CX-Programmer’s program conversion process is not capable of making all program adjustments automatically. If an instruction from the old PLC does not have a direct equivalent in the new PLC then CX-Programmer produces a warning that the conversion is not available. In addition, some addresses cannot be converted.

**Note:** When a program is copied and pasted from one PLC type to another, it does not undergo program conversion. It is good practice to ensure that programs are already converted before copying them to another PLC (by first changing the source PLC type to the target PLC type).

As a general rule, it is easier to convert upwards from C-series PLCs to CV-series PLCs to CS/CJ/CP-series PLCs.

**Applying a Password to the PLC Programs**

It is possible to apply protection to a PLC or the program(s) it contains. This protection stops CX-Programmer from uploading or comparing a program, and so provides commercial copyright security. It also stops unwanted editing of guarded programs.

Generally all passwords are set on the Protection tab of the PLC Properties dialog and are activated or deactivated by selecting the corresponding Set Password button or Release Password button from the toolbar.

The protection that is provided, and the mechanism for protection, depends upon the series of the PLC.

**Functions for CS/CJ-series CPU Unit Ver. 2.0 or Later, or CP-series CPU Unit with CX-Programmer Ver. 4.0 or Later**

**Note:** This functionality is not supported for CP1E CPU Units.

Password protection (reading/editing prohibited) can be set for a single user-set task or multiple tasks (programs). This function provides security and prevents the loss of intellectual property for specific tasks (programs).

When a password is registered for the whole user program or individual tasks, the following optional settings can also be selected at the same time.

(a) Allow/prohibit creation (backup) of the program file (.OBJ). This function prevents copying of user programs to Memory Cards.

(b) Allow/prohibit program overwriting. Set the option in the PLC properties. This function uses a password to prohibit overwriting of the program by a third party.
C-Series PLCs
For certain C-series PLCs the password is embedded in the program using a specific ladder construct and is not specified on the PLC properties page. The password must be entered as four hexadecimal digits as shown below. Check the availability of password protection in the appropriate manual for the PLC.

The program must first be set up with an open contact with the address ‘AR10.01’ applied. The password protection can then be applied. The password can be any four-digit number. To set the password, select the Protection tab within the PLC Properties dialog. The following example illustrates the functionality of the password protection, with the password of ‘1111’.

```
AR10.01
576 (96)
000
000
#1111
```

When enabled, the password is required every time the program is accessed. To set and release the protection after the program is protected, select Protection Write Protect from the Transfer menu.

CV-Series PLCs
Two levels of password protection are provided for CV-series PLCs, ‘System protection password’ and ‘Partial protection password’, both of which are set on the PLC Properties dialog.

The ‘System protection password’, specified as a four-digit hexadecimal value, provides overall protection for the whole of program memory.

It is possible to protect several programs or chapters of programs using the ‘Partial protection password’. For each program that needs to be protected check the Protect program option and specify a range of steps on the protection tab of the Program Properties dialog.

When setting or releasing the protection, it is possible to select the programs to affect in the Program Protection dialog.

CS/CJ/CP-Series PLCs
CS/CJ/CP-series PLCs support a single eight-digit alphanumeric System protection password option for all CS/CJ/CP-series PLCs. This provides read protection for the whole of program memory, accessed from the PLC Properties dialog.
CHAPTER 6
Converting a C500/C120/C**P Program to CS/CJ/CP/CVM1 Format

This section describes the following functions, their operation, and relevant precautions.

- Backing up of programs and I/O memory data from C500/C120/C**P PLCs.
- Restoring data from backup files to C500/C120/C**P PLCs.
- Verifying programs and I/O memory data between C500/C120/C**P PLCs and backup files.
- Converting C500/C120/C**P programs and I/O memory data to CS/CJ/CVM1 format.
- Making host link communications settings for C500/C120/C**P PLCs.

C500/C120/C**P Program Conversion

It is possible to convert C500/C120/C**P programs to CS/CJ/VC-series programs. Also, it is possible to read programs and DM/HR area data from C500/C120/C**P PLCs to save in a file and write the saved programs and DM/HR areas data to C500/C120/C**P PLCs.

C500/C120/C**P Program Conversion

Programs can be read from C500/C120/C**P and converted to a CXT-format project file to be saved in a file. The source and destination devices are as follows:

The source: C500/C120/C20/C28/C40/C60P

The destination: CS1G-H/CJ1G-H/CS1H-H/CJ1H-H/CS1D-S/CS1D-H/CJ1M/CP1H/CP1L/CP1E/CVM1-V2

Set the following Host Link communications settings and program conversion conditions, and then execute program conversion.

A backup file (.c5b) is required to execute conversion. Refer to C500/C120/C**P Program Backup for information on how to create backup files.

Host Link Communications Settings

To make the host link communications settings for communications with the C500/C120/C**P, select Tools – C500/C120/CxxP Support – Host Link Comms Settings. The Host Link Comms Settings Dialog Box will be displayed. Make the Host Link Unit number, COM port settings, and response timeout settings.

The following tables show the Units and Cables that can be connected to C500/C120/C**P.

C500 and C120 PLCs:

<table>
<thead>
<tr>
<th>Unit</th>
<th>Port on Unit</th>
<th>Port on personal computer</th>
<th>Network type (serial communications mode)</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Unit</td>
<td>Built-in peripheral port</td>
<td>9-pin, D-sub male connector</td>
<td>Host Link (SYSWAY)</td>
<td>C200H-IP007 + CQM1-CIF02</td>
</tr>
<tr>
<td>Host Link Unit C500:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C500-LK203/LK201-V1 or</td>
<td>RS-232C port,</td>
<td>9-pin, D-sub male</td>
<td>Host Link (SYSWAY)</td>
<td>XW22Z-200P-V/500P-V</td>
</tr>
<tr>
<td>C120-LK201-V1</td>
<td>25-pin, D-sub female connector</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C120: C120-LK201-V1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
PART 1: CX-Programmer
CHAPTER 6 – Converting a C500/C120/C**P Program to CS/CJ/CP/CVM1 Format
OMRON

C**P:

<table>
<thead>
<tr>
<th>Unit</th>
<th>Port on Unit</th>
<th>Port on personal computer</th>
<th>Network type (serial communications mode)</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Link Unit C20-LK201-V1</td>
<td>RS232-C port, 25-pin, D-sub, female connector</td>
<td>9-pin, D-sub, male connector</td>
<td>Host Link (SYSWAY)</td>
<td>XW2Z-200P-V/500P-V</td>
</tr>
</tbody>
</table>

**Change Model**

Convert backed-up C500/C120/C**P programs or C500/C120/C**P program files (.c5B extension) stored in the computer.

Select **Tools – C500/C120/CxxP Support – Change Model** to display the Change Model Dialog Box. The following items can be set in the Change Model Dialog Box.

- **Backup File**: Specify the program file to be converted.
- **Target File**: Specify a file in which to save the converted program.
- **Conversion range**: The program conversion range can be selected from the following.
  - Converts to the END instruction: Converts the program until the first END instruction appears.
  - Converts all program: Converts the program until the last instruction except for NOP appears.
- **Destination PLC/CPU**: Specify the conversion destination PLC device.

**Saving The Mnemonics Text File Before Conversion**:

When converting models, programs prior to conversion can be saved as mnemonics text. Check the **Save the mnemonics text file before conversion** checkbox and click the **OK** Button in the Change Model Dialog Box. The program will be saved under the file name **destination file name.txt** in the same folder as the post-conversion destination file. (If a file with the same name already exists, the mnemonic text file will be saved as a txt file with the same name with a number added.)

Press the **OK** Button to start program conversion.

The converted project file will be loaded if the conversion process has been completed correctly. If there are conversion warnings, they will be displayed in annotated comments (comments attached to instructions).

**C500/C120/C**P **Program Backup**

**C500/C120/C**P **Data Backup**

Data from the UM (user program area) and DM/HR areas can be read from C500/C120/C**P PLCs and saved in a binary backup file (*.c5b). The areas to be saved are as follows.

- **UM**: All
- **DM0 to DM511**
- **HR0 to HR31**

To execute backup, select **PLC – Tools – C500/C120/CxxP Support – Backup** to display the dialog box. Specify the target file and click the **OK** Button. The file will be backed up.

**C500/C120/C**P **Data Restore**

Data in the UM and DM/HR areas of a C500/C120/C**P backup file (*.c5b) can be written to the UM and DM/HR areas of the PLC.

To restore files, select **Tools – C500/C120/C**P **Support – Restore to PLC** to display the dialog box. Specify the file to be restored and click the **OK** Button.
PART 1: CX-Programmer

OMRON

CHAPTER 6 – Converting a C500/C120/C**P Program to CS/CJ/CP/CVM1 Format

C500/C120/C**P Compare

It is possible to compare UM and DM/HR area data saved in a file and data in a C500/C120/C**P PLC. Select Tools – C500/C120/CxxP Support – Compare PLC and File.

C500/C120/C**P Operating Mode Change

It is possible to change the operating mode of the connected PLC to RUN, MONITOR, or PROGRAM mode. Select Tools – C500/C120/CxxP Support – Operating Mode.

Conversion Table for C500/C120/C**P Instructions

When the PLC model is changed using the C500/C120/C**P utility, the programs are automatically converted. The instructions (mnemonics) and operands are converted so that they function the same way as before conversion. However, there are some exceptions.

Refer to the Instruction Conversion Table below for the conversion details and the constants used in the operands. Refer to the Memory Area Conversion Table and Auxiliary Area Conversion Table for the memory addresses used in the operands.

“CS/CJ Series” in the tables indicates the CJ2H, CS/CJ-H, CJ1M, CS1D, and CP1 PLCs. “CV Series” indicates CVM1-V2 PLCs.

<table>
<thead>
<tr>
<th>Before conversion</th>
<th>After conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>C500/C120 C**P</td>
<td>Example</td>
</tr>
<tr>
<td>LD</td>
<td>LD 001</td>
</tr>
<tr>
<td>LD NOT</td>
<td>LD NOT 0001</td>
</tr>
<tr>
<td>AND</td>
<td>AND 0001</td>
</tr>
<tr>
<td>AND NOT</td>
<td>AND NOT 0001</td>
</tr>
<tr>
<td>OR</td>
<td>OR 0001</td>
</tr>
<tr>
<td>OR NOT</td>
<td>OR NOT 0001</td>
</tr>
<tr>
<td>AND LD</td>
<td>AND LD</td>
</tr>
<tr>
<td>OUT LD</td>
<td>OUT LD</td>
</tr>
<tr>
<td>OUT</td>
<td>OUT 0100</td>
</tr>
<tr>
<td>OUT NOT</td>
<td>OUT NOT 0100</td>
</tr>
<tr>
<td>TIM</td>
<td>TIM 00 #100</td>
</tr>
<tr>
<td>CNT</td>
<td>CNT 10 #0003</td>
</tr>
<tr>
<td>NOP</td>
<td>NOP</td>
</tr>
<tr>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>IL</td>
<td>IL</td>
</tr>
<tr>
<td>ILC</td>
<td>ILC</td>
</tr>
<tr>
<td>JMP</td>
<td>JMP</td>
</tr>
<tr>
<td>JME</td>
<td>JME</td>
</tr>
<tr>
<td>FAL (None)</td>
<td>FAL 01</td>
</tr>
<tr>
<td>FAL 00</td>
<td>FAL 00</td>
</tr>
<tr>
<td>FALS</td>
<td>FALS 01</td>
</tr>
<tr>
<td>SFT</td>
<td>SFT 00 01</td>
</tr>
<tr>
<td>KEEP</td>
<td>KEEP 0000</td>
</tr>
<tr>
<td>CNTR</td>
<td>CNTR 000 #1000</td>
</tr>
<tr>
<td>DIFU</td>
<td>DIFU 0000</td>
</tr>
</tbody>
</table>
## Before conversion

<table>
<thead>
<tr>
<th>C500/C120</th>
<th>C**P</th>
<th>Example</th>
<th>CS/CJ Series</th>
<th>Example</th>
<th>CV Series</th>
<th>Example</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIFD</td>
<td></td>
<td>DIFD 0000</td>
<td>DIFD 000000</td>
<td>DIFD 000000</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIMH</td>
<td>TIMH 002 #0150</td>
<td>TIMH 2 #0150</td>
<td>TIMH 002 #0150</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WSFT</td>
<td>WSFT 01 02</td>
<td>WSFT 0000 0001 0002</td>
<td>WSFT #0000 0001 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- This instruction has only two operands for the C500/C120/C**P. After conversion, a fixed value of #0000 is added as the first operand.
- After conversion, the first operand of the old instruction is moved to the second operand.
- After conversion, the second operand of the old instruction is moved to the third operand.

<table>
<thead>
<tr>
<th>C500/C120</th>
<th>C**P</th>
<th>Example</th>
<th>CS/CJ Series</th>
<th>Example</th>
<th>CV Series</th>
<th>Example</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMP</td>
<td>CMP 00 #0012</td>
<td>CMP 0001 #0012</td>
<td>CMP 0001 #0012</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOV</td>
<td>MOV #0100 05</td>
<td>MOV #0100 0005</td>
<td>MOV #0100 0005</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MVN</td>
<td>MVN #0100 05</td>
<td>MVN #0100 0005</td>
<td>MVN #0100 0005</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIN</td>
<td>BIN 10 20</td>
<td>BIN 0010 0020</td>
<td>BIN 0010 0020</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCD</td>
<td>BCD 10 20</td>
<td>BCD 0010 0020</td>
<td>BCD 0010 0020</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASL</td>
<td>ASL 01</td>
<td>ASL 0001</td>
<td>ASL 0001</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASR</td>
<td>ASR 01</td>
<td>ASR 0001</td>
<td>ASR 0001</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROL</td>
<td>ROL 01</td>
<td>ROL 0001</td>
<td>ROL 0001</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROR</td>
<td>ROR 01</td>
<td>ROR 0001</td>
<td>ROR 0001</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM</td>
<td>COM 00</td>
<td>COM 0000</td>
<td>COM 0000</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMP</td>
<td>ADD 00 #1100 02</td>
<td>+BC 0000 #1100 0002</td>
<td>+BC 0000 #1100 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOV</td>
<td>SUB 00 #1100 02</td>
<td>-BC 0000 #1100 0002</td>
<td>-BC 0000 #1100 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MVN</td>
<td>MUL 00 #1100 02</td>
<td>*B 0000 #1100 0002</td>
<td>*B 0000 #1100 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIN</td>
<td>DIV 00 #1100 02</td>
<td>/B 0000 #1100 0002</td>
<td>/B 0000 #1100 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCD</td>
<td>ANDW 10 #1001 02</td>
<td>ANDW 0010 #1001 0002</td>
<td>ANDW 0010 #1001 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASL</td>
<td>ORW 10 #1001 02</td>
<td>ORW 0010 #1001 0002</td>
<td>ORW 0010 #1001 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASR</td>
<td>XORW 10 #1001 02</td>
<td>XORW 0010 #1001 0002</td>
<td>XORW 0010 #1001 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROL</td>
<td>XNRW 10 #1001 02</td>
<td>XNRW 0010 #1001 0002</td>
<td>XNRW 0010 #1001 0002</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROR</td>
<td>INC 00</td>
<td>++B 0000</td>
<td>++B 0000</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM</td>
<td>DEC 00</td>
<td>--B 0000</td>
<td>--B 0000</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMP</td>
<td>STC</td>
<td>Same as before conversion</td>
<td>STC</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOV</td>
<td>CLC</td>
<td>Same as before conversion</td>
<td>CLC</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MVN</td>
<td>FUN70 #0003 01 10</td>
<td>XFERC 0000 0003 0001 0010</td>
<td>XFER 0000 0003 0001 0010</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIN</td>
<td>FUN71 #1000 00 10</td>
<td>BSET 0000 0100 0000 0010</td>
<td>BSET 0000 0100 0000 0010</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCD</td>
<td>FUN72 00 10</td>
<td>ROOT 0000 0010</td>
<td>ROOT 0000 0010</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASL</td>
<td>FUN73 00 10</td>
<td>XCHG 0000 0010</td>
<td>XCHG 0000 0010</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASR</td>
<td>FUN74 00 10</td>
<td>SLD 0000 0010</td>
<td>SLD 0000 0010</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROL</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROR</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMP</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MOV</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MVN</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIN</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCD</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASL</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASR</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ROR</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ADD is converted to its corresponding instruction, +BC.
- SUB is converted to its corresponding instruction, -BC.
- MUL is converted to its corresponding instruction, *B.
- DIV is converted to its corresponding instruction, /B.
- For CS/CJ-H PLCs, INC is converted to its corresponding instruction, ++B.
- For CS/CJ-H PLCs, DEC is converted to its corresponding instruction, --B.
- For CS/CJ-H PLCs, FUN70 is converted to its corresponding instruction, XFERC.
- For the CV Series, FUN70 is converted to its corresponding instruction, XFER.
- For CS/CJ-H PLCs, FUN71 is converted to its corresponding instruction, BSET.
- For CS/CJ-H PLCs, FUN72 is converted to its corresponding instruction, ROOT.
- For CS/CJ-H PLCs, FUN73 is converted to its corresponding instruction, XCHG.
- For CS/CJ-H PLCs, FUN74 is converted to its corresponding instruction, SLD.
### Before conversion | After conversion

<table>
<thead>
<tr>
<th>C500/C120</th>
<th>C**P</th>
<th>Example</th>
<th>CS/CJ Series</th>
<th>Example</th>
<th>CV Series</th>
<th>Example</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>FUN75</td>
<td>FUN75 00 10</td>
<td>SRD</td>
<td>SRD 0000 0010</td>
<td>SRD</td>
<td>SRD 0000 0010</td>
<td>FUN75 is converted to its corresponding instruction, SRD.</td>
<td></td>
</tr>
<tr>
<td>FUN76</td>
<td>FUN76 00 #0021 10</td>
<td>MLPX</td>
<td>MLPX 0000 #0021 0010</td>
<td>MLPX</td>
<td>MLPX 0000 #0021 0010</td>
<td>FUN76 is converted to its corresponding instruction, MLPX.</td>
<td></td>
</tr>
<tr>
<td>FUN77</td>
<td>FUN77 00 10 #0012</td>
<td>DMPX</td>
<td>DMPX 0000 0010 #0012</td>
<td>DMPX</td>
<td>DMPX 0000 0010 #0012</td>
<td>FUN77 is converted to its corresponding instruction, DMPX.</td>
<td></td>
</tr>
<tr>
<td>FUN78</td>
<td>FUN78 00 #0013 10</td>
<td>SDEC</td>
<td>SDEC 0000 #0013 0010</td>
<td>SDEC</td>
<td>SDEC 0000 #0013 0010</td>
<td>FUN78 is converted to its corresponding instruction, SDEC.</td>
<td></td>
</tr>
<tr>
<td>FUN79</td>
<td>FUN79 00 05 10</td>
<td>FDIV</td>
<td>FDIV 0000 0005 0010</td>
<td>FDIV</td>
<td>FDIV 0000 0005 0010</td>
<td>FUN79 is converted to its corresponding instruction, FDIV.</td>
<td></td>
</tr>
<tr>
<td>FUN80</td>
<td>FUN80 #0010 05 #1010</td>
<td>DISTINCT</td>
<td>DISTINCT #10 5 #1010</td>
<td>DISTINCT</td>
<td>DISTINCT #10 5 #1010</td>
<td>For CS/CJ-H PLCs, FUN80 is converted to its corresponding instruction, DISTINCT. For the CV Series, FUN80 is converted to its corresponding instruction, DIST.</td>
<td></td>
</tr>
<tr>
<td>FUN81</td>
<td>FUN81 10 #10 20</td>
<td>COLLCC</td>
<td>COLLCC 10 #0010 20</td>
<td>COLL</td>
<td>COLL 0010 #0010 0020</td>
<td>For CS/CJ-H PLCs, FUN81 is converted to its corresponding instruction, COLLCC. For the CV Series, FUN81 is converted to its corresponding instruction, COLL.</td>
<td></td>
</tr>
<tr>
<td>FUN82</td>
<td>FUN82 #0537 #1515 00</td>
<td>MOVBC</td>
<td>MOVBC #0537 #1515 0</td>
<td>MOVB</td>
<td>MOVB #0537 #1515 0000</td>
<td>For CS/CJ-H PLCs, FUN82 is converted to its corresponding instruction, MOVBC. For the CV Series, FUN82 is converted to its corresponding instruction, MOVB.</td>
<td></td>
</tr>
<tr>
<td>FUN83</td>
<td>FUN83 #0100 #0201 10</td>
<td>MOVVD</td>
<td>MOVD #0100 #0201 10</td>
<td>MOVD</td>
<td>MOVD #0100 #0201 0010</td>
<td>FUN83 is converted to its corresponding instruction, MOVD.</td>
<td></td>
</tr>
<tr>
<td>FUN84</td>
<td>FUN84 35 10 20</td>
<td>SFTR</td>
<td>SFTR 35 10 20</td>
<td>SFTR</td>
<td>SFTR 0035 0010 0020</td>
<td>FUN84 is converted to its corresponding instruction, SFTR.</td>
<td></td>
</tr>
<tr>
<td>FUN85</td>
<td>FUN85 #1000 40 50</td>
<td>TCMP</td>
<td>TCMP #1000 40 50</td>
<td>TCMP</td>
<td>TCMP #1000 0040 0050</td>
<td>FUN85 is converted to its corresponding instruction, TCMP.</td>
<td></td>
</tr>
<tr>
<td>FUN87</td>
<td>FUN87 #0050 10 05</td>
<td>IOWR</td>
<td>IOWR 10 &amp;0050 0005</td>
<td>WRIT</td>
<td>WRIT #0050 0010 0005</td>
<td>The following message will appear for CS/CJ-H PLCs: CONVERT WARNING: The instruction specification is different. Check the instructions. Check the specifications of CPU Unit after conversion. For CJ/CS-H PLCs, FUN87 is converted to its corresponding instruction, IOWR. For CJ/CS-H PLCs, the first and second operands are interchanged. For CS/CJ-H PLCs, the second operand is converted from BCD data (#0050) to unsigned decimal data (#0050). For the CV Series, FUN87 is converted to its corresponding instruction, WRIT.</td>
<td></td>
</tr>
</tbody>
</table>
### Before conversion | After conversion
--- | ---
**C500/C120** | **C****P** | **CS/CJ Series** | **Example** | **CV Series** | **Example** | **Remarks**
**FUN88** | FUN88 #0030 15 40 | IORD | IORD 40 15 &0030 | READ | READ #0030 0015 0040 | - The following message will appear for CS/CJ-H PLCs: `CONVERT_WARNING: The instruction specification is different. Check the instructions.` Check the specifications of CPU Unit after conversion.
- For CJ/CS-H PLCs, **FUN88** is converted to its corresponding instruction, **IORD**.
- For CJ/CS-H PLCs, the first and third operands are interchanged.
- For CS/CJ-H PLCs, the third operand is converted from BCD data (#0030) to unsigned decimal data (&0030).

**FUN90** | FUN90 01 10 20 | SEND | SEND 10 20 | SEND | SEND 0001 0010 0020 | - The following message will appear: `CONVERT_WARNING: The instruction specification is different. Check the instructions.` Check the specifications of CPU Unit after conversion.
- **FUN90** is converted to its corresponding instruction, **SEND**.

**FUN94** | FUN94 02 | WDT | WDT &0020 | WDT | WDT #0020 | - **FUN94** is converted to its corresponding instruction, **WDT**.
- In the instructions for C500/C120/C**P**, the unit of the operands is 100 ms. After conversion, the unit is changed to 10 ms.
- For CS/CJ-H PLCs, the operand is converted from NUMBER data (02) to unsigned decimal data (#0020).
- For the CV Series, the operand is converted from NUMBER data (02) to BCD data (#0020).

**FUN97** | FUN97 10 14 | IORF | IORF 10 14 | IORF | IORF 0010 0014 | - **FUN97** is converted to its corresponding instruction, **IORF**.

**FUN98** | FUN98 01 10 20 | RECV | RECV 10 20 | RECV | RECV 0001 0010 0020 | - The following message will appear: `CONVERT_WARNING: The instruction specification is different. Check the instructions.` Check the specifications of CPU Unit after conversion.
- **FUN98** is converted to its corresponding instruction, **RECV**.

**FUN98** | FUN98 10 | | | | | - The following message will appear: `CONVERT_ERROR: The instruction is not supported in the target PLC. Check the instruction.` Check the specifications of CPU Unit after conversion.
# Memory Area Conversion Table

The memory addresses used in the operands are automatically converted.

<table>
<thead>
<tr>
<th>Memory area</th>
<th>Before conversion</th>
<th>After conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IR Area/SR Area (CIO Area)</strong></td>
<td>00 to 63</td>
<td>00 to 04</td>
</tr>
<tr>
<td><strong>C500/C120</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>C</strong>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CS/CJ Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>CV Series</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Remarks</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Temporary Relay Area</strong></td>
<td>TR0 to TR7</td>
<td>TR0 to TR7</td>
</tr>
<tr>
<td><strong>HR Area (Holding Area)</strong></td>
<td>HR00 to HR31</td>
<td>HR0 to 9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LR Area (Link Area)</strong></td>
<td>LR00 to LR31</td>
<td>(None)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Timer Area</strong></td>
<td>TIM0 to TIM127</td>
<td>TIM0 to T127</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Counter Area</strong></td>
<td>CNT0 to CNT127</td>
<td>CNT0 to CNT47</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Memory Area</strong></td>
<td>DM000 to DM511</td>
<td>DM0 to DM63</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Data Memory Area (indirect addressing)</strong></td>
<td>*DM000 to *DM511</td>
<td>*D0 to *D511</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Hexadecimal constant</strong></td>
<td>#0000 to #FFFF</td>
<td>#0 to #FFFF</td>
</tr>
<tr>
<td><strong>BCD constant</strong></td>
<td>#0000 to #9999</td>
<td>#0 to #9999</td>
</tr>
<tr>
<td><strong>Decimal constant</strong></td>
<td>#0000 to #9999</td>
<td>#0 to &amp;65535</td>
</tr>
</tbody>
</table>
## Auxiliary Area Conversion Table

The addresses of the special auxiliary relays used in the operands are automatically converted as shown below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Before conversion</th>
<th>After conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC Link Level 1, Units 8 to 15 Run Flags</td>
<td>58.00 to 58.07</td>
<td></td>
</tr>
<tr>
<td>PC Link Level 1, Units 8 to 15 Error Flags</td>
<td>58.08 to 58.15</td>
<td></td>
</tr>
<tr>
<td>Remote I/O Error Flags</td>
<td>59.00 to 59.15</td>
<td></td>
</tr>
<tr>
<td>SYSMAC NET Error Flag</td>
<td>60.03</td>
<td>Same as before conversion</td>
</tr>
<tr>
<td>SYSMAC NET Run Flag</td>
<td>60.04</td>
<td></td>
</tr>
<tr>
<td>SYSMAC NET Data Link Run Flag</td>
<td>60.05</td>
<td></td>
</tr>
<tr>
<td>CPU-mounting Host Link Error Flag</td>
<td>60.08</td>
<td></td>
</tr>
<tr>
<td>CPU-mounting Host Link Restart Bit</td>
<td>60.09</td>
<td></td>
</tr>
<tr>
<td>Data Retention Flag (IOM Hold Bit)</td>
<td>60.12</td>
<td>A500.12 A0.12</td>
</tr>
<tr>
<td>Rack-mounting Host Link Restart Bit</td>
<td>60.13</td>
<td>Same as before conversion</td>
</tr>
<tr>
<td>Load-off control (Output OFF Bit)</td>
<td>60.15</td>
<td>A500.15 P_Output_Off_Bit A0.15 P_Output_Off_Bit</td>
</tr>
<tr>
<td>1 FAL code</td>
<td>61.00</td>
<td>A400.00</td>
</tr>
<tr>
<td>2 FAL code</td>
<td>61.01</td>
<td>A400.01</td>
</tr>
<tr>
<td>4 FAL code</td>
<td>61.02</td>
<td>A400.02</td>
</tr>
<tr>
<td>8 FAL code</td>
<td>61.03</td>
<td>A400.03</td>
</tr>
<tr>
<td>1×10 FAL code</td>
<td>61.04</td>
<td>A400.04</td>
</tr>
<tr>
<td>2×10 FAL code</td>
<td>61.05</td>
<td>A400.05</td>
</tr>
<tr>
<td>4×10 FAL code</td>
<td>61.06</td>
<td>A400.06</td>
</tr>
<tr>
<td>8×10 FAL code</td>
<td>61.07</td>
<td>A400.07</td>
</tr>
<tr>
<td>Battery alarm flag (Battery Error Flag)</td>
<td>61.08 18.08</td>
<td>A402.04 P_Low_Battery</td>
</tr>
<tr>
<td>Scan Time Error Flag</td>
<td>61.09 18.09</td>
<td>A401.08 P_Cycle_Time_Error</td>
</tr>
<tr>
<td>I/O Verification Error Flag</td>
<td>61.10</td>
<td>A402.09 P_IO_Verify_Error</td>
</tr>
<tr>
<td>High-speed Counter Hardware Reset Flag (ON for 1 scan only)</td>
<td>18.10</td>
<td>Same as before conversion</td>
</tr>
<tr>
<td>Rack-mounting Host Link Unit Error Flag</td>
<td>61.11</td>
<td></td>
</tr>
<tr>
<td>Remote I/O Error Flag</td>
<td>61.12</td>
<td>A402.05</td>
</tr>
<tr>
<td>Always ON Flag</td>
<td>61.13 18.13</td>
<td>CF113 P_On A500.13 P_On</td>
</tr>
<tr>
<td>Always OFF Flag</td>
<td>61.14 18.11 18.12 18.14</td>
<td>CF114 P_Off A500.14 P_Off</td>
</tr>
<tr>
<td>First Scan Flag (ON for 1 scan only)</td>
<td>61.15 18.15</td>
<td>A200.15 P_First_Cycle A500.15 P_First_Cycle_Task</td>
</tr>
<tr>
<td>PC Link level 0, Units 0 to 7 Run Flags</td>
<td>62.00 to 62.07</td>
<td>Same as before conversion</td>
</tr>
<tr>
<td>PC Link level 0, Units 0 to 7 Error Flags</td>
<td>62.08 to 62.15</td>
<td></td>
</tr>
<tr>
<td>0.1-second clock pulse</td>
<td>63.00 19.00</td>
<td>CF100 P_0_1s A501.00 P_0_1s</td>
</tr>
<tr>
<td>0.2-second clock pulse</td>
<td>63.01 19.01</td>
<td>CF101 P_0_2s A501.01 P_0_2s</td>
</tr>
<tr>
<td>1.0-second clock pulse</td>
<td>63.02 19.02</td>
<td>CF102 P_1s A501.02 P_1s</td>
</tr>
<tr>
<td>Error (ER) flag</td>
<td>63.03 19.03</td>
<td>CF003 P_ER A500.03 P_ER</td>
</tr>
<tr>
<td>Carry (CY) Flag</td>
<td>63.04 19.04</td>
<td>CF004 P_CY A500.04 P_CY</td>
</tr>
<tr>
<td>Greater Than (GR) Flag</td>
<td>63.05 19.05</td>
<td>CF005 P_GT A500.05 P_GT</td>
</tr>
<tr>
<td>Equals (EQ) Flag</td>
<td>63.06 10.06</td>
<td>CF006 P_EQ A500.06 P_EQ</td>
</tr>
<tr>
<td>Less Than (LE) Flag</td>
<td>63.07 19.07</td>
<td>CF007 P_LT A500.07 P_LT</td>
</tr>
</tbody>
</table>
APPENDIX A

Toolbars and Keyboard Shortcuts

The following tables summarize the toolbars and keyboard shortcuts available from CX-Programmer. The F1 function key provides context help.

It is possible to redefine the toolbars. It is also possible to drag/drop the toolbar buttons between toolbars, or drag buttons off the toolbars to remove them. To do this, hold down the ‘Alt’ key and drag the button.

It is also possible to redefine the keyboard shortcuts.

**Standard Toolbar**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New" /></td>
<td>New – creates a new document.</td>
</tr>
<tr>
<td><img src="image" alt="Open" /></td>
<td>Open – opens an existing document.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save – saves the project.</td>
</tr>
<tr>
<td><img src="image" alt="Compare" /></td>
<td>Compare – compare the current program to the program in a program file.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print – prints the active document.</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td>Print Preview – previews the printout of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut – cuts the selection and moves it to the Clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy – copies the selection to the Clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste – pastes the contents of the Clipboard at the insertion point.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo – undoes the last action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo – redoes the previously undone action.</td>
</tr>
<tr>
<td><img src="image" alt="Find" /></td>
<td>Find – finds the specified text.</td>
</tr>
<tr>
<td><img src="image" alt="Replace" /></td>
<td>Replace – replaces specified item text with different text.</td>
</tr>
<tr>
<td><img src="image" alt="Change All" /></td>
<td>Change All – replaces specified address(es) with different address(es) in the PLC.</td>
</tr>
<tr>
<td><img src="image" alt="About" /></td>
<td>About – displays program information.</td>
</tr>
<tr>
<td><img src="image" alt="Context Help" /></td>
<td>Context Help – displays help for clicked on buttons and menu items.</td>
</tr>
</tbody>
</table>
Diagram Toolbar

- **Zoom Out** – zooms out the display of the ladder editing window.
- **Zoom To Fit** – zooms the display to fit ladder program width into the window.
- **Zoom In** – zooms in the display of the ladder editing window.
- **Zoom Reset** – Reset the zoom display of the window.
- **Grid** – toggles the display of the diagram grid.
- **Show Comments** – toggles the symbol comments On and Off.
- **Show Rung Annotations** – toggles the rung annotation On and Off.
- **Monitor in RungWrap** – Wraps the runs when monitoring.
- **Show Program/Section Comments** – shows comments on top of the ladder view.
- **Multi-Interlock Map** – shows the nesting of interlocks.
- **Selection Mode** – returns to normal mouse selection mode.
- **New Contact** – creates a new normally open contact.
- **New Closed Contact** – creates a new normally closed contact.
- **New Contact OR** – creates a new normally open OR contact.
- **New Closed Contact OR** – creates a new normally closed OR contact.
- **New Vertical** – creates a new vertical connection.
- **New Horizontal** – creates a new horizontal connection.
- **New Coil** – creates a new normally open coil.
- **New Closed Coil** – creates a new normally closed coil.
- **New PLC Instruction** – creates a new PLC instruction call.
- **New Function Block Call** – creates a new Function Block call in the program.
- **New Function Block Parameter** – creates a new Function Block parameter of a Function Block cell.
- **Line Connect Mode** – enables creating connection lines.
- **Line Delete Mode** – enables deleting lines.

Insert Toolbar

- **New PLC** – inserts a new PLC into the project.
- **New Program** – inserts a new program into the PLC program list.
- **Insert SFC Program** – Creates a new SFC Program.
- **Insert ST Program** – Creates a new Structured Text Program.
- **New Section** – inserts a new section into program section list.
- **New Symbol** – inserts a new symbol into the symbol table.
- **New Ladder Function Block** – inserts a new Ladder Function Block into the Function Block list.
- **New Structured Text Function Block** – inserts a new Structured Text Function Block into the Function Block list.
- **Function Block (ladder) generation** – Generate Function Block (ladder)
Symbol Table Toolbar

Large Icons – displays items using large icons.
Small Icons – displays items using small icons.
List – displays items as a list.
Details – displays items as a report.
Validate Symbols (Selected Item) – checks the current symbol table.
Validate Symbols (All) – checks all symbol tables in the PLC.

PLC Toolbar

Work Online – toggles the connection to the selected PLC.
Toggle PLC Mounting – toggles monitoring for this PLC.
Work Online Simulator – toggles the connection to the Simulator.
Auto Online – toggles the connection to the PLC automatically.
Pause Upon Trigger – begins a pause monitoring operation.
Pause – toggles monitoring On and Off.
Transfer to PLC – writes program information into the PLC.
Transfer from PLC – reads program information from the PLC.
Compare with PLC – compares program information with the PLC.
Task Transfer to PLC – writes individual tasks to the PLC.
Task Transfer from PLC – reads individual tasks from the PLC.
Compare Task with PLC – compares individual tasks with the PLC.
Program Mode – switches the PLC into program operation mode.
Debug Mode – switches the PLC into debug operation mode.
Monitor Mode – switches the PLC into monitor operation mode.
Run Mode – switches the PLC into run operation mode.
Differential Monitor – monitors for a change in a bit.
Data Trace – traces PLC memory contents.
Set Password – sets password protection in the PLC.
Release Password – releases password protection in the PLC.
SFC Toolbar

- Add Step – Add SFC Step.
- Add Subchart Step – Add SFC Subchart Step.
- Add Entry Step – Add SFC Entry Step.
- Add Return Step – Add SFC Return Step.
- Add Transition – Add SFC Transition.
- Add Divergence – Add SFC Divergence.
- Add Convergence – Add SFC Convergence.
- Add Simultaneous Divergence – Add SFC Simultaneous Sequence Divergence.
- Add Simultaneous Convergence – Add SFC Simultaneous Sequence Convergence.
- Add Connector – Add SFC Connector.

Program Toolbar

- Toggle Monitor Window – toggles monitoring on the active window.
- Compile Program – performs a program check on the program.
- Compile PLC Programs – performs a program check on the PLC programs.
- Begins Online Edit – starts an online-edit operation on the selected rungs.
- Cancel Online-Edit – stops the online-edit, canceling any changes.
- Send Online Edit Changes – transfers the changes made in the online-edit.
- Go to Online Edit Rung – jumps to the top of the online-editing rung.
- Section/Rung Manager – shows a dialog to edit sections and rungs.
- Read Only Mode – sets the program to read-only mode.
- Start Edit (F2) – starts editing in read-only mode.
- Discard the Changes – discharges the changes.
- Store the Changes (Shift + F2) – stores the change.
Views Toolbar

- Toggle Project Workspace – toggles whether period workspace is on view.
- Toggle Output Window – toggles whether the output window is on view.
- Toggle Watch Window – toggles the watch window On and Off.
- Show Address Reference Tool – toggles the add. ref. tool On and Off.
- Show Properties – shows the item properties window.
- View Local Symbols – shows the local symbol table for the program.
- View Diagram – shows the ladder representation of the program.
- View Mnemonics – shows the mnemonics representation of the program.
- I/O Comment – shows a view to edit comments of addresses.
- Monitor in Decimal – toggles whether monitoring values are shown in decimal.
- Signed Decimal – toggles whether monitoring values are shown in signed decimal.
- Monitor in Hex – toggles whether monitoring values are shown in signed decimal.
- Display Upper Layer – Displays upper layer of FB.
- Display Lower Layer – Displays lower layer of FB.
- Monitor FB Instance – Monitor FB Instance.
Keyboard Shortcuts

Using the Keyboard Mapping feature it is possible to reassign, add or add new keyboard keys used as short-cuts for any of the menu/tool bar commands. It is also possible to assign several different keys to action a particular command.

The default keyboard mapping can be changed to another major support software.

Select Keyboard Mapping... from Tools menu and click Remap All button. A selection of support software to remap the keyboard will be displayed.

Selection of support software: CX-Programmer, SYSMAC Support Software, SYSWIN, GPPQ (CX-Programmer version 9.0 only (bundled with CX-One Lite version 4.0))

Default CX-Programmer Keyboard Mapping

### Basic Operations

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Help Topics</td>
<td></td>
<td>[F1]</td>
</tr>
<tr>
<td>Move cursor up</td>
<td>Move cursor up</td>
<td>[Up]</td>
</tr>
<tr>
<td>Move cursor down</td>
<td>Move cursor down</td>
<td>[Down]</td>
</tr>
<tr>
<td>Move cursor right</td>
<td>Move cursor right</td>
<td>[Right]</td>
</tr>
<tr>
<td>Move cursor left</td>
<td>Move cursor left</td>
<td>[Left]</td>
</tr>
<tr>
<td>Move cursor beginning of rung</td>
<td>Move cursor beginning of rung</td>
<td>[Home]</td>
</tr>
<tr>
<td>Move cursor end of rung</td>
<td>Move cursor end of rung</td>
<td>[End]</td>
</tr>
<tr>
<td>View project workspace</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Output window</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Watch window</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Address Reference Tool</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>Show Rung Annotations</td>
<td>[View]</td>
<td>[Show Rung Annotations]</td>
</tr>
<tr>
<td>Show Symbol Comments</td>
<td>[View]</td>
<td>[Show Symbol Comments]</td>
</tr>
<tr>
<td>Next docked window</td>
<td>Next docked window</td>
<td>[Alt]+[0]</td>
</tr>
<tr>
<td>Previous docked window</td>
<td>Previous docked window</td>
<td>[Alt]+[Shift]+[0]</td>
</tr>
<tr>
<td>Move next page</td>
<td>Move next page</td>
<td>[Page Down]</td>
</tr>
<tr>
<td>Move previous page</td>
<td>Move previous page</td>
<td>[Page UP]</td>
</tr>
<tr>
<td>Delete char/ladder on the left</td>
<td>Delete char/ladder on the left</td>
<td>[Back space]</td>
</tr>
<tr>
<td>Cancel, quit or close function</td>
<td>Cancel, quit or close function</td>
<td>[Esc]</td>
</tr>
<tr>
<td>Close Output window</td>
<td>None</td>
<td>[Esc]</td>
</tr>
<tr>
<td>Select menu</td>
<td>None</td>
<td>[Alt]+[(underscored letter)]</td>
</tr>
<tr>
<td>New project</td>
<td>[File]</td>
<td>[New]</td>
</tr>
<tr>
<td>Open Project</td>
<td>[File]</td>
<td>[Open]</td>
</tr>
<tr>
<td>Close project</td>
<td>[File]</td>
<td>[Close]</td>
</tr>
<tr>
<td>Save project</td>
<td>[File]</td>
<td>[Save As...]</td>
</tr>
<tr>
<td>Print</td>
<td>[File]</td>
<td>[Print]</td>
</tr>
<tr>
<td>Undo</td>
<td>[Edit]</td>
<td>[Undo]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Edit]</td>
<td>[Redo]</td>
</tr>
<tr>
<td>Cut</td>
<td>[Edit]</td>
<td>[Cut]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Edit]</td>
<td>[Copy]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Edit]</td>
<td>[Paste]</td>
</tr>
<tr>
<td>Delete</td>
<td>[Edit]</td>
<td>[Delete]</td>
</tr>
<tr>
<td>Select All</td>
<td>[Edit]</td>
<td>[Select All]</td>
</tr>
</tbody>
</table>

### Edit Program

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit instructions</td>
<td>[Edit]</td>
<td>[Edit]</td>
</tr>
<tr>
<td>Delete a row</td>
<td>[Edit]</td>
<td>[Delete Row]</td>
</tr>
<tr>
<td>Delete a column</td>
<td>[Edit]</td>
<td>[Delete Column]</td>
</tr>
<tr>
<td>Invert (NOT) contacts/coils</td>
<td>[Edit]</td>
<td>[Invert (NOT)]</td>
</tr>
<tr>
<td>Zoom in</td>
<td>[View]</td>
<td>[Zoom in]</td>
</tr>
<tr>
<td>Zoom out</td>
<td>[View]</td>
<td>[Zoom Out]</td>
</tr>
<tr>
<td>Zoom to Fit</td>
<td>[View]</td>
<td>[Zoom to Fit]</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show properties [View] [Properties]</td>
<td>[Alt]+[Enter]</td>
</tr>
<tr>
<td>Insert Rung Below [Insert] [Rung] [Below]</td>
<td>[R]</td>
</tr>
<tr>
<td>Insert Rung Above [Insert] [Rung] [Above]</td>
<td>[Shift]+[R]</td>
</tr>
<tr>
<td>Insert Row [Insert] [Row]</td>
<td>[Ctrl]+[Alt]+[Down]</td>
</tr>
<tr>
<td>Insert Column [Insert] [Column]</td>
<td>[Ctrl]+[Alt]+[Right]</td>
</tr>
<tr>
<td>Insert Open Contact [Insert] [Contact] [Normally Open]</td>
<td>[C]</td>
</tr>
<tr>
<td>Insert Closed Contact [Insert] [Contact] [Normally Closed]</td>
<td>[I]</td>
</tr>
<tr>
<td>Insert Open Contact OR [Insert] [Contact] [Normally Open OR]</td>
<td>[V]</td>
</tr>
<tr>
<td>Insert Closed Contact OR [Insert] [Contact] [Normally Closed OR]</td>
<td>[X]</td>
</tr>
<tr>
<td>Insert Horizontal Right [Insert] [Horizontal Right]</td>
<td>[Ctrl]+[Right], [H], [-]</td>
</tr>
<tr>
<td>Insert Horizontal Left [Insert] [Horizontal Left]</td>
<td>[Ctrl]+[Left]</td>
</tr>
<tr>
<td>Insert Vertical Down [Insert] [Vertical] [Vertical Down]</td>
<td>[Ctrl]+[Down], [V], [I]</td>
</tr>
<tr>
<td>Insert Vertical Up [Insert] [Vertical] [Vertical Up]</td>
<td>[Ctrl]+[Up], [L]</td>
</tr>
<tr>
<td>Insert Open Coil [Insert] [Coil] [Normally Open]</td>
<td>[O]</td>
</tr>
<tr>
<td>Insert Closed Coil [Insert] [Coil] [Normally Closed]</td>
<td>[Q]</td>
</tr>
<tr>
<td>Insert Instruction [Insert] [Instruction...]</td>
<td>[I]</td>
</tr>
<tr>
<td>Compile all PLC programs [PLC] [Compile All PLC Programs]</td>
<td>[F7]</td>
</tr>
<tr>
<td>Compile program [Programs] [Compile]</td>
<td>[Ctrl]+[F7]</td>
</tr>
<tr>
<td>Find [Edit] [Find]</td>
<td>[Ctrl]+[F]</td>
</tr>
<tr>
<td>Replace [Edit] [Replace]</td>
<td>[Ctrl]+[H]</td>
</tr>
<tr>
<td>Change All [Edit] [Change All]</td>
<td>[Ctrl]+[R]</td>
</tr>
<tr>
<td>Go to Rung/Step [Edit] [Go To] [Rung /Step Number...]</td>
<td>[Ctrl]+[G]</td>
</tr>
<tr>
<td>Go to Rung Comment [Edit] [Go To] [Commented Rung]</td>
<td>[L], [Ctrl]+[Shift]+[R]</td>
</tr>
<tr>
<td>Go to next address reference [Edit] [Go To] [Next Address Reference]</td>
<td>[N], [Ctrl]+[Shift]+[N]</td>
</tr>
<tr>
<td>Go to Input [Edit] [Go To] [Next Input]</td>
<td>[Space], [Ctrl]+[Shift]+[I]</td>
</tr>
<tr>
<td>Go to Output [Edit] [Go To] [Next Output]</td>
<td>[Space], [Ctrl]+[Shift]+[O]</td>
</tr>
<tr>
<td>Go to Previous Jump Point [Edit] [Go To] [Previous Jump Point]</td>
<td>[B], [Ctrl]+[Shift]+[Space], [Alt]+[Shift]+[B]</td>
</tr>
<tr>
<td>Start Edit at Read Only Mode [Edit][Read Only Mode Edit][Start Edit]</td>
<td>[F2]</td>
</tr>
<tr>
<td>Store at Read Only Mode [Edit][Read Only Mode Edit][Store]</td>
<td>[Shift][F2]</td>
</tr>
</tbody>
</table>

### Find and Replace

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>[Edit] [Find]</td>
<td>[Ctrl]+[F]</td>
</tr>
<tr>
<td>Replace</td>
<td>[Edit] [Replace]</td>
<td>[Ctrl]+[H]</td>
</tr>
<tr>
<td>Change All</td>
<td>[Edit] [Change All]</td>
<td>[Ctrl]+[R]</td>
</tr>
<tr>
<td>Go to Rung/Step</td>
<td>[Edit] [Go To] [Rung /Step Number...]</td>
<td>[Ctrl]+[G]</td>
</tr>
<tr>
<td>Go to Rung Comment</td>
<td>[Edit] [Go To] [Commented Rung]</td>
<td>[L], [Ctrl]+[Shift]+[R]</td>
</tr>
<tr>
<td>Go to next address reference</td>
<td>[Edit] [Go To] [Next Address Reference]</td>
<td>[N], [Ctrl]+[Shift]+[N]</td>
</tr>
<tr>
<td>Go to Input</td>
<td>[Edit] [Go To] [Next Input]</td>
<td>[Space], [Ctrl]+[Shift]+[I]</td>
</tr>
<tr>
<td>Go to Output</td>
<td>[Edit] [Go To] [Next Output]</td>
<td>[Space], [Ctrl]+[Shift]+[O]</td>
</tr>
<tr>
<td>Go to Previous Jump Point</td>
<td>[Edit] [Go To] [Previous Jump Point]</td>
<td>[B], [Ctrl]+[Shift]+[Space], [Alt]+[Shift]+[B]</td>
</tr>
</tbody>
</table>

### Online

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work on-line [PLC] [Work Online]</td>
<td>[Ctrl]+[W]</td>
<td></td>
</tr>
<tr>
<td>Work on-line to Simulator [PLC] [Work Online Simulator]</td>
<td>[Ctrl]+[Shift]+[W]</td>
<td></td>
</tr>
<tr>
<td>Program mode [PLC] [Operating Mode] [Program]</td>
<td>[Ctrl]+[1]</td>
<td></td>
</tr>
<tr>
<td>Debug mode [PLC] [Operating Mode] [Debug]</td>
<td>[Ctrl]+[2]</td>
<td></td>
</tr>
<tr>
<td>Monitor (PLC execution-mode) [PLC] [Operating Mode] [Monitor]</td>
<td>[Ctrl]+[3]</td>
<td></td>
</tr>
<tr>
<td>Run mode [PLC] [Operating Mode] [Run]</td>
<td>[Ctrl]+[4]</td>
<td></td>
</tr>
<tr>
<td>Monitoring (PLC level toggle) [PLC] [Transfer] [Monitoring]</td>
<td>[Ctrl]+[M]</td>
<td></td>
</tr>
<tr>
<td>Transfer to PLC [PLC] [Transfer] [To PLC...]</td>
<td>[Ctrl]+[T]</td>
<td></td>
</tr>
<tr>
<td>Transfer from PLC [PLC] [Transfer] [From PLC...]</td>
<td>[Ctrl]+[Shift]+[T]</td>
<td></td>
</tr>
<tr>
<td>Force on [PLC] [Force] [On]</td>
<td>[Ctrl]+[J]</td>
<td></td>
</tr>
<tr>
<td>Force off [PLC] [Force] [Off]</td>
<td>[Ctrl]+[K]</td>
<td></td>
</tr>
</tbody>
</table>
Default SYSMAC Support Soft Keyboard mapping

Basic operations

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>View project workspace</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Output window</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Watch window</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>View Address Reference Tool</td>
<td>[View]</td>
<td>[Window]</td>
</tr>
<tr>
<td>Show Rung Annotations</td>
<td>[View]</td>
<td>[Show Rung Annotations]</td>
</tr>
<tr>
<td>Show Symbol Comments</td>
<td>[View]</td>
<td>[Show Symbol Comments]</td>
</tr>
<tr>
<td>Undo</td>
<td>[Edit]</td>
<td>[Undo]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Edit]</td>
<td>[Redo]</td>
</tr>
</tbody>
</table>

Edit Program

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete a column</td>
<td>[Edit]</td>
<td>[Delete Column]</td>
</tr>
<tr>
<td>Invert (NOT) contacts/coils</td>
<td>[Edit]</td>
<td>[Invert (NOT)]</td>
</tr>
<tr>
<td>Insert Column</td>
<td>[Insert]</td>
<td>[Column]</td>
</tr>
<tr>
<td>Insert Open Contact</td>
<td>[Insert]</td>
<td>[Contact]</td>
</tr>
<tr>
<td>Insert Closed Contact</td>
<td>[Insert]</td>
<td>[Contact]</td>
</tr>
<tr>
<td>Insert Open Contact OR</td>
<td>[Insert]</td>
<td>[Contact]</td>
</tr>
<tr>
<td>Insert Closed Contact OR</td>
<td>[Insert]</td>
<td>[Contact]</td>
</tr>
<tr>
<td>Create a new SET function</td>
<td>None</td>
<td>[Shift]+[F8]</td>
</tr>
<tr>
<td>Create a new RSET function</td>
<td>None</td>
<td>[Shift]+[F9]</td>
</tr>
<tr>
<td>Insert Horizontal Right</td>
<td>[Insert]</td>
<td>[Horizontal Right]</td>
</tr>
<tr>
<td>Insert Vertical Up</td>
<td>[Insert]</td>
<td>[Vertical]</td>
</tr>
<tr>
<td>Insert Open Coil</td>
<td>[Insert]</td>
<td>[Coil]</td>
</tr>
<tr>
<td>Insert Closed Coil</td>
<td>[Insert]</td>
<td>[Coil]</td>
</tr>
<tr>
<td>Insert Instruction</td>
<td>[Insert]</td>
<td>[Instruction...]</td>
</tr>
<tr>
<td>Edit rung comment</td>
<td>[Edit]</td>
<td>[Edit Rung Comment]</td>
</tr>
<tr>
<td>Compile all PLC programs</td>
<td>[PLC]</td>
<td>[Compile All PLC Programs]</td>
</tr>
<tr>
<td>Edit Section/Rung Manager</td>
<td>[Program]</td>
<td>[Section/Rung Manager]</td>
</tr>
<tr>
<td>Store at Read Only Mode</td>
<td>[Edit]</td>
<td>[Read Only Mode Edit]</td>
</tr>
</tbody>
</table>
Online

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.

### Function Menu Shortcut keys

<table>
<thead>
<tr>
<th>Monitor in RungWrap</th>
<th>[View]</th>
<th>[Monitor in RungWrap]</th>
<th>[Shift]+[F11]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor in Hex</td>
<td>[View]</td>
<td>[Monitor In Hex]</td>
<td>[Alt]+[F10]</td>
</tr>
<tr>
<td>Force on</td>
<td>[PLC]</td>
<td>[Force]</td>
<td>[On]</td>
</tr>
<tr>
<td>Force off</td>
<td>[PLC]</td>
<td>[Force]</td>
<td>[Off]</td>
</tr>
<tr>
<td>Cancel (Forced on or off)</td>
<td>[PLC]</td>
<td>[Force]</td>
<td>[Cancel]</td>
</tr>
<tr>
<td>Cancel All Forces</td>
<td>[PLC]</td>
<td>[Force]</td>
<td>[Cancel All Forces]</td>
</tr>
</tbody>
</table>

### Default SYSWIN Keyboard Mapping

#### Basic Operations

<table>
<thead>
<tr>
<th>Function Menu Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Project</td>
</tr>
<tr>
<td>Save project</td>
</tr>
</tbody>
</table>

#### Edit Program

<table>
<thead>
<tr>
<th>Function Menu Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete a row</td>
</tr>
<tr>
<td>Zoom to Fit</td>
</tr>
<tr>
<td>Insert Open Contact</td>
</tr>
<tr>
<td>Insert Closed Contact</td>
</tr>
<tr>
<td>Insert Horizontal Right</td>
</tr>
<tr>
<td>Insert Vertical Down</td>
</tr>
<tr>
<td>Insert Open Coil</td>
</tr>
<tr>
<td>Insert Closed Coil</td>
</tr>
<tr>
<td>Insert Instruction</td>
</tr>
<tr>
<td>Compile all PLC programs</td>
</tr>
<tr>
<td>Open Section/Rung Manager</td>
</tr>
<tr>
<td>Edit Rung Comment</td>
</tr>
<tr>
<td>Show as Statement List</td>
</tr>
</tbody>
</table>

#### Find and Replace

<table>
<thead>
<tr>
<th>Function Menu Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit rung comment</td>
</tr>
</tbody>
</table>

### Online

<table>
<thead>
<tr>
<th>Function Menu Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work on-line</td>
</tr>
<tr>
<td>Monitoring (PLC level toggle)</td>
</tr>
</tbody>
</table>

### Default GPPQ Keyboard Mapping

(CX-Programmer Ver. 9.0 Only (Bundled With CX-One Lite Ver. 4.0))

#### Basic Operations

The shortcuts for all basic operations are the same as the defaults for the CX-Programmer.

#### Edit Program

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.
# PART 1: CX-Programmer

## Keyboard Shortcuts – CX-Programmer

### Function Menu Shortcut keys

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Row Comment</strong></td>
<td>[Edit]</td>
<td>[Row Comment]</td>
</tr>
<tr>
<td><strong>Insert Open Contact</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Closed Contact</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Open Contact OR</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Closed Contact OR</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Insert Horizontal Right</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Vertical Down</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Delete Horizontal Connection</strong></td>
<td>---</td>
<td>[Ctrl]+[F9]</td>
</tr>
<tr>
<td><strong>Delete Vertical Connection</strong></td>
<td>---</td>
<td>[Ctrl]+[F10]</td>
</tr>
<tr>
<td><strong>Insert Open Coil</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Insert Instruction</strong></td>
<td>Classic Style</td>
<td>[Insert]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Compile all PLC programs</strong></td>
<td>Classic Style</td>
<td>[PLC]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Compile program</strong></td>
<td>[Programs]</td>
<td>[Compile]</td>
</tr>
<tr>
<td><strong>Show Symbols Comments</strong></td>
<td>Classic Style</td>
<td>[View]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>[View]</td>
<td>[Ladder Information]</td>
</tr>
<tr>
<td><strong>Show Rung Annotations Lists</strong></td>
<td>Classic Style</td>
<td>[View]</td>
</tr>
<tr>
<td><strong>Smart Style</strong></td>
<td>[View]</td>
<td>[Ladder Information]</td>
</tr>
</tbody>
</table>

### Find and Replace

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Go to Rung Comment</strong></td>
<td>[Edit]</td>
<td>[Go To]</td>
</tr>
</tbody>
</table>

### Online

Shortcuts for all functions except for the following are the same as the defaults for the CX-Programmer.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Force ON</strong></td>
<td>[PLC]</td>
<td>[Force]</td>
</tr>
<tr>
<td><strong>Force OFF</strong></td>
<td>[PLC]</td>
<td>[Force]</td>
</tr>
<tr>
<td><strong>Cancel Force</strong></td>
<td>[PLC]</td>
<td>[Force]</td>
</tr>
<tr>
<td><strong>Cancel All Forces</strong></td>
<td>[PLC]</td>
<td>[Force]</td>
</tr>
<tr>
<td><strong>Monitor in Hex</strong></td>
<td>[View]</td>
<td>[Monitoring Data Type]</td>
</tr>
<tr>
<td><strong>Monitor in Decimal</strong></td>
<td>[View]</td>
<td>[Monitoring Data Type]</td>
</tr>
<tr>
<td><strong>Monitor in Signed Decimal</strong></td>
<td>[View]</td>
<td>[Monitoring Data Type]</td>
</tr>
</tbody>
</table>
APPENDIX B
EtherNet/IP Connections from Windows XP (SP2 or Higher) or Windows Vista

Better firewall security for Windows XP (SP2 or higher) and Windows Vista has increased the restrictions for data communications on Ethernet ports. When using an EtherNet/IP connection*1 to one of the following PLCs from an Ethernet port on a computer, you must change the settings of the Windows Firewall to enable using CX-Programmer communications.

Applicable PLCs:  
• CJ2H-CPU6/EIP
• CS1W/CJ1W-EIP

Note1:  
An EtherNet/IP connection includes the following cases:
• An online connection with the network type set to EtherNet/IP
• An automatic online connection to a PLC on an EtherNet/IP network when Auto Online - EtherNet/IP Node Online is selected from the PLC Menu

Note:  
The Windows Firewall is mainly designed to prevent inappropriate access from external devices (e.g., via the Internet). The changes to the Windows Firewall settings described in this document enable EtherNet/IP connections to be used by the CX-Programmer. If the same computer is being used on a company network or other network, confirm that the changes will not create security problems before proceeding with the changes. The changes described in this document are required only when you connect using EtherNet/IP through an Ethernet port. No changes are necessary if you are connecting through any other port, such as a USB port.

Changing Windows Firewall Settings

Windows XP

1. When you attempt to connect the CX-Programmer to a PLC on an EtherNet/IP network through an Ethernet port, the Windows Security Alert Dialog Box will be displayed.

2. Click the Unblock Button.

An EtherNet/IP connection will be accepted from CX-Programmer and EtherNet/IP connections will be enabled in the future as well.

Windows Vista

Use the following procedure to change the settings before attempting to connect from the CX-Programmer.

The User Account Control Dialog Box may be displayed during this procedure. If it appears, click the Continue Button and continue with the procedure.

1. Select Control Panel from the Windows Start Menu and change the display to Classic View.

2. Open the Administrative Tools and select Windows Firewall with Advanced Security from the dialog box that is displayed.

4. Select New Rule under Inbound Rules in the Actions Area on the right side of the dialog box.

5. Make the following settings for each step in the New Inbound Rule Wizard Dialog Box, clicking the Next Button to move between steps.

<table>
<thead>
<tr>
<th>Rule Type</th>
<th>Select Custom.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Select All Programs.</td>
</tr>
<tr>
<td>Protocol and Ports</td>
<td>Select ICMPv4 as the protocol type.</td>
</tr>
<tr>
<td>Action</td>
<td>Select Allow the connection.</td>
</tr>
<tr>
<td>Scope</td>
<td>Select Any IP address for everything.</td>
</tr>
<tr>
<td>Profile</td>
<td>Select Domain, Private, and Public.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter any name, e.g., Omron_EIP.</td>
</tr>
</tbody>
</table>

6. Click the Finish Button. The rule that you defined will be registered in the Inbound Rules (e.g., Omron_EIP).

7. Close the Windows Firewall with Advanced Security Dialog Box.

8. When you attempt to connect the CX-Programmer to a PLC on an EtherNet/IP network through an Ethernet port, the Windows Security Alert Dialog Box will be displayed.

9. Click the Unblock Button.

An EtherNet/IP connection will be accepted from CX-Programmer and EtherNet/IP connections will be enabled in the future as well.
APPENDIX C
Functions Supported Only for CX-Programmer Version 9.□
(Bundled with CX-One Lite)

The following functions are supported for CX-Programmer version 9.□. (CX-Programmer version 9.□ comes bundled with CX-One Lite version 4.0.)

- Smart Input Mode
- Address Incremental Copy
- Smart Style
- GPPQ Shortcut Keys
  Refer to Appendix A – Toolbars and Keyboard Shortcuts.

Smart Input Mode

In Smart Input Mode, instructions are input using mnemonics.

When the first character of a mnemonic is input, a list of the instructions that start with the same character will be automatically displayed as candidates. Candidates are also displayed for operands.

With CX-Programmer version 9.□, either of the following input modes can be selected for programming.

- Smart Input Mode: The input mode in which candidate instructions and addresses are automatically displayed
- Classic Mode: The input mode of the previous CX-Programmer

Changing the Input Mode

The input mode can be changed from the tool bar or with a menu command.

- Selecting an Icon in the Tool Bar

- Selecting with a Menu Command
  Select Change Input Mode and then either Smart Input Mode or Classic Mode from the Tools Menu.
Input Procedure in Smart Input Mode

The following example shows how to input instructions in Smart Input Mode. (I/O comments are not input in this example. For details on how to input I/O comments, refer to Displaying and Selecting from Candidate Operands below.)

**Inputting Bits**

Example: Inputting LD 0.00

1. Press the **L** Key.
   
   ![List of instructions starting with “L”](image)
   
   A list of the instructions starting with “L” will be displayed.

2. Press the **Enter** Key or the **Space** Key.
   
   ![Top instruction in the list](image)
   
   The top instruction in the list (LD) will be entered, and a candidate operand will be displayed.

3. Select a candidate operand or input the operand and then press the **Enter** Key. Address 0.00 will be entered, and “LD 0.00” will be input in the ladder diagram.
Inputting Special Instructions

Example: Entering MOV D0 D100

1. Press the **M** Key.
   A list of the instructions starting with “M” will be displayed.

   ![Instruction List]

2. Press the **Enter** Key or the **Space** Key.
   The top instruction in the list (MOV) will be entered, and the first operand will be displayed.

   ![Source Word]

3. Enter “D0” and press the **Enter** Key or the **Space** Key.
   “MOV D0” will be entered, and the second operand will be displayed.

   ![Destination 1]

4. Enter “D100.”
   “MOV D0 D100” will be entered.
   (If necessary, you can go back one character at a time by pressing the **Back Space** Key.)

   ![Destination 2]

5. Press the **Enter** Key
   “MOV D0 D100” will be entered in the ladder diagram.

   ![Ladder Diagram]
Displaying and Selecting from Candidate Operands

Displaying Candidate Operands
The display of candidate operands for inputs in the Smart Input Mode is divided into three areas, as shown below.

1. This is the area for selecting, inputting, and entering instructions and addresses. The displayed address is incremented by one from the previous address that was input. (For example, after W0.01 is input, W0.02 is automatically displayed.) Bit inputs are incremented from 0.00 (word: 0), and bit outputs are incremented from 100.00 (word: 100).

2. When a bit address is input, "Auxiliary Relay Area" is displayed here. If you move the cursor to "Auxiliary Relay Area" and press the Enter Key, a Condition Flag or a list of previously registered Auxiliary Bits will be displayed in area 3 as candidates.

3. When a bit address is input, the symbols that were previously registered in the symbol table by the user will be displayed in order of addresses (or in alphabetical order by name).

Selecting from Candidate Operands

- Selecting a Condition Flag or Auxiliary Bit
  1. Press the ↓ Key to move the cursor to “Auxiliary Relay Area” in area 2.
  2. Press the Enter Key.
  3. Move the cursor to an item in the list to select it.

- Selecting a Symbol or Address Registered by the User
  1. Press the ↓ Key to move the cursor to “Auxiliary Relay Area” in area 2.
  2. Move the cursor to an item in the list in area 3 to select it.

  If the order of candidate operands is Symbol name – Address – Comment, the range of candidate symbol names will be automatically narrowed down when the first character of symbol name is input.

The display of candidate operands for inputs in the Smart Input Mode is divided into three areas, as shown below.

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>This is the area for selecting, inputting, and entering instructions and addresses. The displayed address is incremented by one from the previous address that was input. (For example, after W0.01 is input, W0.02 is automatically displayed.) Bit inputs are incremented from 0.00 (word: 0), and bit outputs are incremented from 100.00 (word: 100).</td>
</tr>
<tr>
<td>2</td>
<td>When a bit address is input, &quot;Auxiliary Relay Area&quot; is displayed here. If you move the cursor to “Auxiliary Relay Area” and press the Enter Key, a Condition Flag or a list of previously registered Auxiliary Bits will be displayed in area 3 as candidates.</td>
</tr>
<tr>
<td>3</td>
<td>When a bit address is input, the symbols that were previously registered in the symbol table by the user will be displayed in order of addresses (or in alphabetical order by name).</td>
</tr>
</tbody>
</table>

For example, when "L" is input, the range of possible symbols will be automatically narrowed down to symbol names starting with "L," and only those symbols will be displayed in the list of user-registered symbols.
Changing the Display of Candidate Operands

You can change the display of candidate operands in the Options - Diagrams Dialog Box, as shown below. (Select Options from the Tools Menu to display the Options - Diagrams Dialog Box)

Selecting Displays with or without I/O Comments

The following dialog box for inputting an I/O comment is displayed by default after an address is input.

To program without inputting I/O comments, clear the I/O Comments Option in the Ladder Diagram Options Dialog Box. The dialog box for inputting comments will then be hidden.

Order of Display of Candidate Operands

In the Parameter List in the Ladder Diagram Options Dialog Box, you can select any of the following orders for displaying candidate operands.

- Symbol name – Address – Comment
- Address – Symbol name – Comment (default)
- Address – Comment

List of Shortcut Keys

<table>
<thead>
<tr>
<th>Program Editing</th>
<th>Input Item</th>
<th>Smart Input Mode</th>
<th>Classic Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Open Contact</td>
<td>L (LD), A (AND)</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Insert Closed Contact</td>
<td>L (LDNOT) A (ANDNOT)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Insert Open Contact OR</td>
<td>O (OR)</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Insert Closed Contact OR</td>
<td>O (ORNOT)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Insert Open Coil</td>
<td>O (OUT)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>Insert Closed Coil</td>
<td>O (OUTNOT)</td>
<td>Q</td>
<td>Q</td>
</tr>
<tr>
<td>Insert Rung Below</td>
<td>Press &quot;R&quot; and select Insert Rung Below.</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Insert vertical connecting line above</td>
<td>Shift+U</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>Insert vertical connecting line below</td>
<td>Shift+V</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>Insert horizontal connecting line</td>
<td>Shift+H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Differentiate Up</td>
<td>@</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Differentiate Down</td>
<td>%</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Immediate Refreshing</td>
<td>!</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Clear Differentiation</td>
<td>Shift+0</td>
<td>Not supported.</td>
<td></td>
</tr>
</tbody>
</table>

Shortcut Keys That Differ from Classic Mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Smart Input Mode</th>
<th>Classic Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Rung Comment</td>
<td>Shift+L</td>
<td>L</td>
</tr>
<tr>
<td>Go to error</td>
<td>Shift+J</td>
<td>J</td>
</tr>
<tr>
<td>Go to Next Address Reference</td>
<td>Shift+N</td>
<td>N</td>
</tr>
<tr>
<td>Go to Previous Jump Point</td>
<td>Shift+B</td>
<td>B</td>
</tr>
</tbody>
</table>
Address Incremental Copying

Overview
Address Incremental Copying makes it easy to make multiple copies of a ladder program section when the only differences between multiple program sections are the addresses. By specifying the offsets for the addresses in the copied program section, the specified number of program sections can be created with the addresses incremented.
Symbol names and I/O comments will be created automatically.

Operation
In Ladder View, select the program section that is to be copied. Select *Address Incremental Copy* from the Edit Menu to display the dialog box. Input the data in the dialog box, and press the *Paste* Button. A program section will be created with the addresses incremented automatically, and it will be inserted in the next program location.

Example
In this example, two copies are made of the following program section, bit offset is set to 16, the word (CH) offset is set to 10, and then the program section is pasted.

1, 2, 3...

1. Select the program section to be copied.
2. Select *Address Incremental Copy* from the Edit Menu.
   The Address Incremental Copy Dialog Box will be displayed.
3. In the Offset Field, input 16 in the Bit Box and 10 in the CH Box.
4. Click the **Paste** Button.
The addresses will be automatically incremented and the program section will be automatically pasted. The I/O comments will be automatically created.
By default, symbol names and I/O comments are created automatically according to the following rules.

<table>
<thead>
<tr>
<th>Item</th>
<th>Rule for automatic creation</th>
<th>Contents</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol name</td>
<td>Increment the numbers found from tail.</td>
<td>Symbol names are searched for numbers from the end and the first number that is found is incremented. If a number is not found, a serial number is added following an underscore character.</td>
<td>If Name1_1 is found, then Name1_2 is automatically created.</td>
</tr>
<tr>
<td>I/O comment</td>
<td>Increment the numbers found from tail.</td>
<td>I/O comments are searched for numbers from the end and the first number that is found is incremented. If a number is not found, a serial number is added following an underscore character.</td>
<td>If Cmt1_1 is found, then Cmt1_2 is automatically created.</td>
</tr>
</tbody>
</table>

To change the automatic generation rule from the default, click the Advanced Button in the Address Incremental Copy Dialog Box and change the setting as shown below.

**Smart Style**

Smart Style is a user interface style in which functions that are frequently used, from menus or option settings, are changed to a more convenient arrangement.

To change the display to Smart Style, select **Tools – Options** and then select an option for the **Menu/Options Style** on the General Tab Page.
• Smart Style: A style that simplifies menu and option settings.
• Classic Style (default): The same menu and option settings as before.

Smart Style differs from Classic Style in the following ways.

• **Main Menu**
  • The Main Menu configuration is different.
  • Functions that can be executed using shortcut keys or pop-up menus are omitted from the Main Menu.

• **Tools – Options Settings**
The differences between Smart Style and Classic Style are listed in the following table.

<table>
<thead>
<tr>
<th>Classic Style</th>
<th>Smart Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagrams Tab Page</td>
<td>Diagrams Tab Page plus the advanced settings accessed from that page</td>
</tr>
<tr>
<td>PLCs Tab Page</td>
<td>PLCs Tab Page plus the advanced settings accessed from that page</td>
</tr>
<tr>
<td>Symbols Tab Page</td>
<td>Symbols Tab Page plus the advanced settings accessed from that page</td>
</tr>
<tr>
<td>Appearance Tab Page</td>
<td>Appearance Tab Page plus the advanced settings accessed from that page</td>
</tr>
<tr>
<td>Ladder Information Tab Page</td>
<td>Diagrams Tab Page plus the ladder display settings accessed from that page</td>
</tr>
<tr>
<td>General Tab Page</td>
<td>General Tab Page plus the advanced settings accessed from that page</td>
</tr>
<tr>
<td>SFC Tab Page</td>
<td>SFC Tab Page plus the advanced settings accessed from that page</td>
</tr>
</tbody>
</table>
Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>A location in memory where data or programs are stored. It can also identify a location of a node on a network.</td>
</tr>
<tr>
<td>Application</td>
<td>A software program that accomplishes a specific task. Examples of applications are CX-Programmer, CX-Server, CX-Protocol and Microsoft Excel.</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange.</td>
</tr>
<tr>
<td>BCD</td>
<td>Binary Coded Decimal.</td>
</tr>
<tr>
<td>Binary Coded Decimal</td>
<td>A data format supported by CX-Programmer: each group of four bits in the data is a representation of a digit (0-9).</td>
</tr>
<tr>
<td>Binary</td>
<td>A data format supported by CX-Programmer. A number system format to the base 2, i.e. employing the digits 0 and 1.</td>
</tr>
<tr>
<td>Bit</td>
<td>A digit used in binary notation, which can take the value 0 or 1. The value of a bit, or combination of bits, can represent the status of a device or can be used in programming.</td>
</tr>
<tr>
<td>Boolean</td>
<td>A type of point or symbol where the value can be one of two states. Essentially the two states are '0' and '1', but these states can be assigned a meaningful designation.</td>
</tr>
<tr>
<td>Central Processing Unit</td>
<td>The part of the PLC that can store programs and data, execute the instructions in program, and process input and output signals in order to communicate with other, external, devices.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>An area within the windows environment where data can be stored temporarily or transferred between applications.</td>
</tr>
<tr>
<td>Components</td>
<td>The CX-Server application, as utilized by CX-Programmer, is made up of six components accessible from an invoking application.</td>
</tr>
<tr>
<td>CPU type</td>
<td>The type of CPU available to a specific device, the amount of memory available to a PLC varies according to the CPU involved.</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit.</td>
</tr>
<tr>
<td>CS/CJ/CP-series</td>
<td>Indicates any one of the following types of PLC: CS1G, CS1G-H, CS1H, CS1H-H, CJ1G, CJ1G-H, CJ1H-H, CJ1M, CP1H, CP1E.</td>
</tr>
<tr>
<td>C-Series</td>
<td>Indicates any one of the following types of PLC: C2000H, C200H, C200HE, C200HE-Z, C200HG, C200HE-Z, C200HS, C200HX, C200HX-Z, C1000H, C<strong>H, C</strong>K, C**P, CQM1, C500, C120, C20, CPM1 (CPM1A), CPM2*, CPM2*-S*.</td>
</tr>
<tr>
<td>CV-Series</td>
<td>Indicates any one of the following types of PLC: CVM1, CVM1-V2, CV500, CV1000 or CV2000. When using SYSMAC NET, CV series PLCs can operate in either CV mode (where the datagrams contain FINS commands) or C mode (where the datagrams contain C SYSNET commands).</td>
</tr>
<tr>
<td>CVSS</td>
<td>A file format supported by CX-Programmer.</td>
</tr>
<tr>
<td>CX-Net Network Configuration tool</td>
<td>A of a suite of programs allowing the management of Routing Tables and Data Link Tables in OMRON PLCs.</td>
</tr>
<tr>
<td>CX-Programmer</td>
<td>A PLC programming application for the creation, testing and maintenance of programs associated with the OMRON CS/CJ/CP-series PLCs, CV-series PLCs and C-series PLCs. It provides facilities for the support of PLC device and address information and for communications with OMRON PLCs and their associated network types.</td>
</tr>
<tr>
<td>CX-Server</td>
<td>An advanced communications management system for OMRON PLCs providing facilities for software to maintain PLC device and address information and to communicate with OMRON PLCs and their supported network types.</td>
</tr>
<tr>
<td>CX-Server Project</td>
<td>A definition of an OMRON PLC network configuration. It identifies all devices and networks within a particular configuration including the areas of PLC memory (points) that can be read from or written to.</td>
</tr>
<tr>
<td>Data area</td>
<td>An area of PLC memory allocated to the storage of data (not programs).</td>
</tr>
<tr>
<td>Data Trace/Time Chart Monitor component</td>
<td>The CX-Server application, as utilized by CX-Programmer, displays data obtained from the PLC’s memory areas during program execution.</td>
</tr>
<tr>
<td><strong>Data Type</strong></td>
<td>A type that describes the internal data format within a programming symbol (e.g. BCD v binary).</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>DDE</strong></td>
<td>Dynamic Data Exchange. A channel through which correctly prepared programs can actively exchange data and control other applications within Microsoft Windows. See also Item, Server, server application and Topic.</td>
</tr>
<tr>
<td><strong>Debug mode</strong></td>
<td>A mode of PLC operation during which any errors arising from the currently active program will be flagged. For CV-series PLC only.</td>
</tr>
<tr>
<td><strong>Decimal</strong></td>
<td>A data format supported by CX-Programmer – base 10 (i.e. digits 0-9).</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>A value automatically set by a program in the absence of user input or on initial entry to an application; such values can be overwritten.</td>
</tr>
<tr>
<td><strong>Device group</strong></td>
<td>A class of devices that share similar properties, each group can be sub-divided into device types.</td>
</tr>
<tr>
<td><strong>Device type</strong></td>
<td>A type of OMRON PLC.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>A type of OMRON automation device, either a PLC, Temperature Controller, Memory Card Writer or PROM Writer.</td>
</tr>
<tr>
<td><strong>Dialog</strong></td>
<td>A window asking for some form of response from the user, usually in the form of either entering requested information, selecting displayed data, or confirming an operation.</td>
</tr>
<tr>
<td><strong>DLL</strong></td>
<td>Dynamic Link Library. A program file that although cannot be run stand-alone as an executable, can be utilized by one or more applications or programs as a common service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone functions.</td>
</tr>
<tr>
<td><strong>Download</strong></td>
<td>Refer to Transfer to PLC.</td>
</tr>
<tr>
<td><strong>Drag</strong></td>
<td>The act of moving an item on the screen by selecting it with the mouse, and keeping the mouse button depressed, moving the mouse until the item has reached the required location. The mouse button is then released.</td>
</tr>
<tr>
<td><strong>Driver</strong></td>
<td>The software that controls the communications between a computer and PLC, translating any information passed between them into a format that the receiving Device can understand.</td>
</tr>
<tr>
<td><strong>Dynamic Data Exchange</strong></td>
<td>The method of transferal of data (and possibly instructions) between applications via the establishment of reference links between them.</td>
</tr>
<tr>
<td><strong>Expansion memory</strong></td>
<td>The memory available to a CPU in addition to conventional memory.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td>A structure which organizes the files in computer memory or on disk. Also known as a ‘directory’.</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface. Part of a program that interacts with the user and takes full advantage of the graphics displays of computers. A GUI employs pull-down menus and dialog boxes for ease of use. Like all Microsoft Windows based applications, CX-Programmer has a GUI.</td>
</tr>
<tr>
<td><strong>Hard disk</strong></td>
<td>A disk permanently mounted on its drive.</td>
</tr>
<tr>
<td><strong>Hexadecimal</strong></td>
<td>A data format supported by CX-Programmer – base 16 (i.e. digits 0-F).</td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td>Pictorial representations of computer resources and functions. Many icons are used by CX-Programmer as part of the GUI.</td>
</tr>
<tr>
<td><strong>Input device</strong></td>
<td>A device that sends signals to a PLC.</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Hardware or software employed to link the elements within a system, including networks, programs and computers.</td>
</tr>
<tr>
<td><strong>IO Table</strong></td>
<td>A part of a PLC set up which contains definitions of the physically connected input-output boards attached to the PLC (i.e. racks and units). The IO table is edited via a CX-Server application.</td>
</tr>
<tr>
<td><strong>IO type</strong></td>
<td>Input/Output type. An attribute of a symbol that shows how the address is mapped to physical hardware. CX-Programmer can show an address mapped to an input or output card with a ‘I’ or ‘Q’ prefix respectively.</td>
</tr>
<tr>
<td><strong>IO</strong></td>
<td>Input /Output.</td>
</tr>
<tr>
<td><strong>LSS</strong></td>
<td>A file format supported by the CX-Programmer.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Memory Card component</td>
<td>The CX-Server application, as utilized by CX-Programmer, manages the file storage to and from PLC memory cards.</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>A spreadsheet application.</td>
</tr>
<tr>
<td>Microsoft Windows Explorer</td>
<td>A file handling application part of the Microsoft Windows suite.</td>
</tr>
<tr>
<td>Microsoft Windows</td>
<td>A windowing environment that is noted for its GUI, and for features such as multiple typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and the capability of moving text and graphics from one application to another via a clipboard.</td>
</tr>
<tr>
<td>CX-Programmer</td>
<td>The CX-Server application, as utilized by CX-Programmer, manages the file storage to and from PLC memory cards.</td>
</tr>
<tr>
<td>Monitor mode</td>
<td>A PLC operational mode that allows the device, during normal execution, to review the condition of the Data Link (including the PLCs/nodes on that link).</td>
</tr>
<tr>
<td>Network</td>
<td>1. Part of the PLC configuration, based on the device type. The number of Networks available is dependant on the device type.</td>
</tr>
<tr>
<td></td>
<td>2. A number of computers linked together with a central processing point known as a server that is accessible to all computers. Networks affect CX-Programmer in that further Network associated options are available if the computer is Network connected.</td>
</tr>
<tr>
<td>Offline</td>
<td>The status of a device when it is not being controlled by a computer (although it may be physically connected to it).</td>
</tr>
<tr>
<td>OLE</td>
<td>Object Linking and Embedding. Used to transfer and share information between Microsoft Windows based applications and accessories.</td>
</tr>
<tr>
<td>Online</td>
<td>The status of a device when it is under the direct control of a computer.</td>
</tr>
<tr>
<td>Output</td>
<td>The signal sent from a PLC to an external device.</td>
</tr>
<tr>
<td>Output instruction</td>
<td>A type of PLC instruction that appears at the right of a ladder rung – it cannot be connected to the right.</td>
</tr>
<tr>
<td>Output window</td>
<td>An area of the CX-Programmer display reserved for compilation messages and search results.</td>
</tr>
<tr>
<td>PLC Error component</td>
<td>The CX-Server application, as utilized by CX-Programmer, displays and manages PLC errors.</td>
</tr>
<tr>
<td>PLC Memory component</td>
<td>The CX-Server application, as utilized by CX-Programmer, allows the user to view, edit and monitor either channels (words) or individual bits in areas of the PLC.</td>
</tr>
<tr>
<td>PLC Setup component</td>
<td>The CX-Server application, as utilized by CX-Programmer, permits the configuration of PLC settings.</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller.</td>
</tr>
<tr>
<td>Point</td>
<td>A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The contents of a point may be controlled by an object or IO mechanism such as DDE. The contents of a point may control the action or appearance of an object, or be used for output via an IO mechanism.</td>
</tr>
<tr>
<td>Program</td>
<td>A set of instructions that are performed by a computer or PLC.</td>
</tr>
<tr>
<td>Program memory</td>
<td>An area of PLC memory reserved for the storage of programs.</td>
</tr>
<tr>
<td>Program mode</td>
<td>PLC mode of operation during which the device can be programmed.</td>
</tr>
<tr>
<td>Project</td>
<td>Projects consist of ladder program(s), address and network details, memory, IO, expansion instructions (if applicable) and symbols. Each CX-Programmer project file is separate and is similar in concept to a document.</td>
</tr>
<tr>
<td>project workspace</td>
<td>An area of the CX-Programmer reserved for displaying and selecting project content.</td>
</tr>
<tr>
<td>Rack</td>
<td>The apparatus to which a unit is fixed.</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory.</td>
</tr>
<tr>
<td>Reset</td>
<td>Turning a bit or signal OFF or changing it to its set value or to zero.</td>
</tr>
<tr>
<td>Run Mode</td>
<td>PLC mode of operation during which device information is typically read-only.</td>
</tr>
<tr>
<td>Rung</td>
<td>A logical circuit of a ladder program (a connection from the left to the right bus-bars). A rung can encompass one or more columns and rows.</td>
</tr>
<tr>
<td>Section</td>
<td>A part of a PLC program, like a chapter is to a book. The sections are combined in order to form a program, and scanned in order by the PLC.</td>
</tr>
<tr>
<td><strong>Server application</strong></td>
<td>An application that can be used to view or interact with. Refer also to DDE and OLE.</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Server</strong></td>
<td>1. Server is used in DDE functions to contain a link to an outside application. Refer also to Server application.</td>
</tr>
<tr>
<td></td>
<td>2. A Server is the central processing point of a Network that is accessible to all computers.</td>
</tr>
<tr>
<td><strong>Signed Decimal</strong></td>
<td>A data format supported by CX-Programmer.</td>
</tr>
<tr>
<td><strong>Slots</strong></td>
<td>Free areas within a rack to which units can be fixed.</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td>An address that has been given a name to make the address information more flexible.</td>
</tr>
<tr>
<td><strong>Target PLC</strong></td>
<td>The PLC to which information or instructions are directed.</td>
</tr>
<tr>
<td><strong>Taskbar</strong></td>
<td>An integral part of Microsoft Windows that allows Microsoft Windows based applications to be started. CX-Programmer is run from the Taskbar.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>1. A file format supported by the CX-Programmer.</td>
</tr>
<tr>
<td></td>
<td>2. A data format supported by CX-Programmer.</td>
</tr>
<tr>
<td><strong>Transfer from PLC</strong></td>
<td>The transfer of a program or data to a host (either a computer or a programming device) from a lower-level (or slave) device.</td>
</tr>
<tr>
<td><strong>Transfer to PLC</strong></td>
<td>The transfer of a program or data from a host (either a computer or a programming device) to a lower-level (or slave) device.</td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td>A component of an OMRON PLC system configuration.</td>
</tr>
<tr>
<td><strong>Upload</strong></td>
<td>See Transfer from PLC.</td>
</tr>
<tr>
<td><strong>Watch window</strong></td>
<td>An area of the CX-Programmer display that is reserved for monitoring PLC addresses.</td>
</tr>
</tbody>
</table>
INDEX

A

About CX-Programmer - 18
About this Manual - 1
Access
Address Reference tool - 45
Cross Reference Report - 44
Global symbol table - 28
Ladder program - 25, 45, 61, 82
Local symbol table - 28, 75
Mnemonics view - 26, 95
Output window - 46
PLC - 37, 38, 61, 71, 72, 76, 83, 84, 94, 100, 101, 102, 103, 104, 107, 108, 109, 110, 140, 141, 142, 144
Program - 31, 36, 83, 84, 87, 105, 106
Project workspace - 24, 41
Watch window - 46, 93
Address
Ladder Information - 52
Address Reference tool - 23, 36, 45
Access - 45
Advanced Topics - 113
Writing more Maintainable Programs - 113
Application - 149
Applying Passwords to PLC Programs - 117
Arrays
Specifying - 74
Attaching Comments to Elements - 38
Auto Online to a PLC - 97
Automatically Transfer Program to Simulator - 50

B

Bit - 149
Block Programs - 93

C

C Series PLCs - 118
Cancelling the program Transfer - 104
Change All - 59
Check duplicated output and TIM/CNT No. - 49
Clear All Memory Areas - 110
Comment
Ladder information - 52
Commented Rung – Go To - 66
Compatible with SYSMAC Support Software, SYSWIN, SYSMAC-CPT - 54
Context sensitive menus - 23
Converting Programs between PLCs - 117
CPT File Loading - 62
Cross Reference Report - 23, 44
Access - 44
Address information - 44
Detailed usage - 44
Print - 45
Usage overview - 44
CS/CJ/CP-Series PLCs - 118
CS1x-H PLC-Flash ROM Backup - 110
Customer support for CX-Programmer - 18
Cut, Copy and Paste - 64
CV-Series PLCs - 118
CVSS File Loading - 62
CX-Net Network Configuration tool -
CX-Programmer
About - 18
Customer support - 18
Exit - 24
Getting started - 21
Licensing - 16, 21
Other applications - 114
Preferences - 48
Quick start - 21
System requirements - 3
Tutorial - 29
CX-Server - 149
CX-Net Network Configuration tool -
Data Trace/Time Chart Monitoring component -

D

Data Trace/Time Chart Monitoring component -
Data-Types - 27
DDE - 150
Server - 152
Deleting Items - 65
detailed dialog mode - 84, 86, 90
Diagram Toolbar - 128
Diagram Workspace - 23, 24
DLL - 150
Download program to PLC - 36, 103
Downloading / Uploading in program sections - 44
Drag and Drop - 64

E

Entering Operands - 91
Exiting CX-Programmer - 24
Exporting and importing Symbols
Information Format - 115
Exporting and Importing Symbols - 115

F

File Conversion tool - 62, 63, 114
File Loading - 62
Find - 56, 57
Find in area - 56
Find Report - 57
Finding and Replacing - 55
Rules for: - 56
Values - 59
Flash ROM Backup-CS1x-H PLC - 110
PART 1: CX-Programmer

INDEX — CX-Programmer

G

- General - 54
- Getting started with CX-Programmer - 21
- Glossary of Terms - 149

Go To - 66
  - Commented Rung - 66
  - Next Address Reference - 67
  - Next Input - 67
  - Next Output - 67
  - Previous - 67
  - Rung / Step Number - 66
- Go to Commented Rung - 67
- Go to online-edit rung - 38

H

- Help - See on-line help. See on-line help
- Help and how to access it - 17
  - Context Sensitive Help - 18
  - Help Topics - 17
  - Instruction Reference - 17
- How to Input - 56, 58

I

- I/O Comment View - 38, 60, 62, 92
- IME auto start - 54
- Importing and Exporting Symbols - 115
  - Information Format - 115
- Insert Toolbar - 128
- Inserting a New Program - 31
- Introducing CX-Programmer Projects - 22
- IO Table - 112

K

- Keyboard mapping
  - CX-Programmer - 132
  - SYSMAC Support Soft - 134
  - SYSWIN - 135
  - Keyboard Mapping Reference - 18
  - Keyboard Shortcuts - 127, 132
  - Availability of instructions - 91
  - Busbars - 25
  - Closed coil - 83
  - Closed contact - 33, 35, 83
  - Colour schemes - 25, 51
  - Creating a ladder program - 33, 84
  - Cursor - 25, 30
  - Delete elements - 65
  - Differential monitor - 87
  - Differentiate - 86, 88, 91
  - Edit program on-line - 101
  - Editing coils - 84
  - Editing contacts - 84
  - Editing instructions - 87
  - Example - 33
  - Expansion table - 91
  - Find and replace - 55
  - Find instruction - 91
  - Forced bits - 86
  - Grid - 25, 83
  - Horizontal - 35, 83
  - Instruction - 33, 34, 83
  - Instruction availability - 91
  - Invert (NOT) - 86
  - Invert state of contact or coil - 86
  - Modifiers - 91
  - Monitor, differential - 87
  - New ladder program - 33, 84
  - Open coil - 35, 83
  - Open contact - 33, 34, 35, 83
  - PLC power flow - 25
  - Preferences - 48
  - Print - 62
  - Remove elements - 65
  - Reverse state of contact or coil - 86
  - Rung comment - 33, 83, 92
  - Rung margin area - 25
  - Rungs - 25
  - Search instruction - 91
  - Selection mode - 83
  - Text comment - 33, 34, 92
  - Vertical - 35, 83
  - Licensing - 21
  - Demo Mode - 22
  - Full Version - 22
  - Junior Mode - 21
  - Trial Mode - 21
  - Line Connect Mode - 35, 83
  - Line Delete Mode - 35, 83
  - Linking/Unlinking Symbols – Rules for - 116
  - Load Comment/Program - 104

L

- Ladder information
  - Address - 52
  - Ladder Information
  - Comment - 52
  - Name - 52
  - Ladder program - See also program
    - Access - 25, 45, 61, 82
    - Adding Comments - 92
    - Amending coils - 84
    - Amending contacts - 84
    - Amending instructions - 87
    - Auto error detection - 25, 83
  - Magnification - 55
  - Manipulating Views - 63
  - Max.No.of Windows - 54
  - Memory View - 94
  - Microsoft Windows Features
    - In CX-Programmer - 61
    - Opening and Saving Projects - 62
  - Mnemonics - See also program
    - Access view - 26, 95
    - Delete entries - 65
    - Find and replace - 55
    - Program editing - 95, 96
Remove entries - 65
Rung comment - 95
Statement list block - 36
Text comment - 95
View - 23, 26
Monitor in RungWrap - 100
Monitoring Data Type - 105
Moving an address range - 59
Multiple rung online edit - 38
Multiple User - 16
Multiple User (Junior) - 16

Name
Ladder information - 52
New Closed Contact OR - 83
New Open Contact OR - 83
Next Reference - 65

Offline Program Verification - 37
Omron CX-Programmer - 1
Online Action - 101
Online editing - 38
On-line help - 1, 16, 17
Options - See preferences
Options and Preference
Ladder information - 52
Options and Preferences - 48
Appearance - 51
Diagrams - 48
PLCs - 50
Symbols - 51
Output window - 23, 36, 37, 46, 72, 94, 104
Access - 46
Clear - 46
Close - 46
Compile - 46
Find report - 46
Go to error - 46
Load from file - 46

Paste rungs to another PLC with unaddressed symbols - 51
Pause Monitoring - 106
PLC -
   Access - 37, 38, 61, 71, 72, 76, 83, 84, 94, 100, 101, 102, 103, 104, 107, 108, 109, 110, 140, 141, 142, 144
   Adding to a project - 71
   Changing a PLC in a project - 71
   Clock setting - 109
   Connect to PLC - 36, 61, 87, 97, 100, 101, 102, 103, 104, 105, 106, 107, 109, 140, 141, 142, 144, 145
   Copy definition - 64
   Cut definition - 64
   Cycle time - 106
   Delete PLC - 65
   Deleting a PLC in a project - 72
   Editing a PLC in a project - 71
   Expansion table - 91
   File-card Transfer - 104
   Information - 109
   Instruction availability - 91
   Memory - 30
   Monitoring multiple PLCs - 38
   Move definition - 64
   Operating mode - 36, 61, 100
   Passwords - 109, 117
   Paste definition - 64
   Power flow - 25
   Preferences - 50
   Program assignments - 108
   Properties - 61
   Remove PLC - 65
   Removing a PLC in a project - 72
   Settings - 30
   Support - 2
   Transferring Programs to/from File - 104
   Verify connection - 61
   PLC Toolbar - 130
   PLCs and Projects - 71
   Points
   Address - 149
   Preferences - 48
   Appearance - 51
   Font - 52
   Ladder program - 48
   PLC - 50
   Preferences
      Ladder information - 52
   Symbols - 51
   Zoom - 55
   Previous window environment - 54
   Print
      Page setup - 62
      Pages - 63
      Preview - 63
      Program assignments - 108
      Setup - 63
   Printing Projects - 62
   Program
      Access - 31, 36, 83, 84, 87, 105, 106
      Adding a new program - 84
      Attaching Comments to Elements - 38
      Cancel on-line edit changes - 38, 43, 102
      Cancelling Transfer - 104
      Check options - 94
      Commit on-line edit changes - 38, 43, 101, 102
      Compare Computer and PLC programs - 37, 104
      Compilation check options - 94
      Compile all programs - 94
      Compile one program - 94
      Compile program - 36, 94
      Converting programs - 117
      Copy elements from a program - 64
      Cut elements from a program - 64
      Delete program - 65
      Diagram Workspace - 24
      Download to PLC - 36, 105
      Edit program on-line - 38, 97, 101
      Inserting - 31
      Inserting a program - 84
      Mnemonics - See Mnemonics
      Monitor program during execution - 37, 105
      Move elements from a program - 64
      New program - 84
      Passwords - 117
### PART 1: CX-Programmer

#### INDEX – CX-Programmer

**Paste elements to a program** - 64  
**Pause Monitoring program** - 106  
**Properties** - 31, 61, 84  
**Remove program** - 65  
**Rungs** - 25  
**Send on-line edit changes** - 38, 43, 101, 102  
**Statement list block** - 36  
**Stopping Pause Monitoring** - 106  
**Task type** - 31, 61, 84  
**Transfer from PLC** - 37, 102  
**Transfer to PLC** - 36, 103  
**Upload from PLC** - 37, 102  
**Program Editing** - 82  
**Program Sections** - 41  
**Downloading / Uploading** - 44  
**Program Toolbar** - 130  
**Project**  
- **Access Global symbol table** - 28  
- **Access ladder program** - 25, 45, 61, 82  
- **Access local symbol table** - 28, 75  
- **Access Mnemonics view** - 26, 95  
- **Access PLC** - 37, 38, 61, 87, 97, 100, 101, 102, 103, 104, 107, 108, 109, 110, 140, 141, 142, 144  
- **Access program** - 31, 36, 83, 87, 105, 106  
- **Access project workspace** - 24, 41  
- **Adding a PLC** - 71  
- **Changing a PLC** - 71  
- **Connect to PLC** - 36, 61, 87, 97, 100, 101, 102, 103, 104, 105, 106, 107, 109, 140, 141, 142, 144  
- **Converting projects** - 114  
- **Copying information between projects** - 113  
- **Create a new CX-Server file** - 61  
- **Creating a project** - 30  
- **Deleting a PLC** - 72  
- **Editing a PLC** - 71  
- **Finding and replacing** - 55  
- **Ladder program** - See Ladder program  
- **Link to CX-Server file** - 61, 77  
- **New project** - 30  
- **Opening a project** - 62  
- **Planning** - 29  
- **PLC program assignments** - 108  
- **Program** - 84  
- **Properties** - 60  
- **Removing a PLC** - 72  
- **Renaming a project** - 65  
- **Saving a project** - 36, 62  
- **Symbols** - See symbols  
- **Workspace** - 23, 24, 30, 41  
**Project Reference** - 41  
**Project workspace** - 23, 24, 30, 41  
- **Access** - 24, 41  
- **Close** - 24, 41  
- **Collapsing the project view** - 24, 41  
- **Expanding the project view** - 24, 41  
- **Find and replace** - 55  
- **Properties** - 23, 60  
- **PLC** - 61  
- **Program** - 31, 61, 84  
- **Project** - 60  

#### Quick Start Guide - 21

#### R

- **Racks** - 151  
- **Redo an operation** - 64  
- **Renaming an Object** - 65  
- **Replace** - 57  
- **ROM Writer** - 111  
- **Rules for Finding** - 56  
- **Rung / Step Number – Go To** - 66  
- **RungWrap** - 100

#### S

- **Save Comment/Program** - 104  
- **Search** - 56  
- **Search and Replace** - 57  
- **Addresses** - 59  
- **F3 Searching** - 60  
- **Moving Addresses** - 59  
- **Operands** - 59  
- **Rules for:** - 56  
- **Scope of the search** - 57  
- **Symbols** - 59, 60  
- **Text** - 58  
- **Section/Rung Manager** - 43  
- **Sections** - 41  
- **Select All** - 67  
- **Show actual I/O bit in XY** - 49  
- **Show in simple dialog mode** - 49  
- **Show ladder only** - 54  
- **Show Program / Section Comments** - 53  
- **Show Window** - 54  
- **Show with comment dialog** - 49  
- **simple dialog mode** - 84, 88  
- **Slots** - 152  
- **SSS File Loading** - 62  
- **Standard Toolbar** - 127  
- **Starting a New Project** - 30  
- **Starting CX-Programmer** - 21  
- **Statement list rungs** - 93  
- **Status bar** - 18, 24  
- **Stopping Pause Monitoring** - 106  
- **Summary of Concepts** - 39  
- **Symbol Information** - 91  
- **Symbol Table Toolbar** - 129  
- **Symbols** - 72, 152  
- **Access Global symbol table** - 28  
- **Access local symbol table** - 28, 75  
- **Adding a symbol** - 76  
- **Amending symbols** - 77, 78  
- **Auto Generation** - 77  
- **Automatic Allocation** - 80  
- **Automatically allocating addresses** - 86  
- **Changing symbols** - 77, 78  
- **Copy symbols** - 64, 75  
- **Copying and Pasting Symbols** - 75  
- **Creating a symbol** - 32  
- **Creating symbols and addresses** - 32  
- **Cross Reference Report** - See Cross Reference Report  
- **Cut symbols** - 64, 75  
- **Delete symbols** - 65

**Q**

- **Quick start guide** - 21

---

*CX-Programmer Page 156*
Delete Unused Symbols - 76
Deleting symbols - 80
Editing symbols - 78
Find and replace - 55
Global symbol table - 30
Global symbols - 74
Introduction to - 26
Local symbol table - 7, 23, 30
Local symbols - 23, 75
Move symbols - 64, 75
New symbol - 32, 76
Paste symbols - 64, 75
Pasting Symbols with Errors - 79
Preferences - 51
Print - 62
Rack Location - 26
Remove symbols - 65
Removing symbols - 80
Rename symbols - 65
Rules for Linking/Unlinking - 116
Sharing with other applications - 61, 76, 114
Timer/counters - 74
Usage - 26, 44
Validating Symbols - 76
Synchronize ladder and mnemonic cursors - 49
System requirements - 3
SYSWIN File Loading - 62

T

Technical Specification - 1
The CX-Programmer Environment - 22
Toolbars - 127
Toolbars - Viewing and Hiding - 67
  Creating a New Toolbar - 69
  Customizing a Toolbar - 68
Transfer
Cancelling - 104
Program from PLC - 37, 102
Program to PLC - 36, 103
Tutorial - 29

U

Undo an operation - 64
Units - 152

Unlinking / Linking Symbols – Rules for - 116
Upload program from PLC - 37, 102
Uploading / Downloading in program sections - 44
Using CX-Programmer - 28
Using Program Sections - 41

V

Version 2.0 Features - 1
Viewing and Hiding Toolbars - 67
  Creating a New Toolbar - 69
  Customizing a Toolbar - 68
Views
  Dock - 63
  Field descriptions - 65
  Float - 63
  Hide - 63
  Zoom - 55, 63
Views Toolbar - 131

W

Watch window - 23, 38, 46
  Access - 46, 93
  Close - 46, 93
Watch Window
  Differential Monitoring - 48
  Dragging and Dropping Items - 47
  Pasting Items - 48
Window Environment - 54
Window Features in CX-Programmer - 61
  Opening and Saving Projects - 62
Work Online to a Simulator - 96, 97
Writing A Ladder Program - 32
Writing more Maintainable Programs
  Data Types - 113
  Symbols - 113

Z

Zoom - 55, 63
Zoom to Fit - 55
PART 2:
CX-Server
PLC Tools
Notice

OMRON products are manufactured for use according to proper procedures by a qualified operator and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed the information provided in them. Failure to heed precautions can result in injury to people or damage to the product.

⚠️ **DANGER** Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury. Additionally, there may be severe property damage.

⚠️ **WARNING** Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. Additionally, there may be severe property damage.

⚠️ **Caution** Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury, or property damage.

**OMRON Product References**

All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything else.
Visual Aids

The following headings appear in the left column of the manual to help you locate different types of information.

1. Indicates information of particular interest for efficient and convenient operation of the product.

2, 3… Indicates lists of one sort or another, such as procedures, checklists etc.

Represents a shortcut on the Toolbar to one of the options available on the menu of the same window.

Other manual conventions are as follows:

- Windows-based applications provide users with a number of different ways to perform one operation. These are normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; using the right-mouse button to display a context-sensitive menu; dragging and dropping. Whilst recognising this, the manual provides user instructions employing the Toolbar and right-mouse button only. Use of the application menu bar or keyboard shortcuts are only included if no such alternatives exist.

- Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer or CX-Protocol. This is noted in the manual by the term “invoking application”.

- This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-Server project is defined in this manual. An application project is defined by the software application invoking CX-Server.

© OMRON, 2005

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of OMRON.

All copyright and trademarks acknowledged.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.
About this Manual

This manual describes the CX-Server application and its ability to control and monitor a range of OMRON PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the commercial manual for the device must be consulted.

This manual contains the following chapters:

- **Chapter 1 Technical Specification.** This chapter describes CX-Server in general terms and introduces the user to the relationship between CX-Server and associated products. It also provides details of the operating environment, minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server.

- **Chapter 2 PLC Memory Component.** This chapter describes the PLC Memory Component and its ability to allow the user to view, edit and monitor PLC Data Areas, bits and symbols.

- **Chapter 3 IO Table Component.** This chapter describes the IO Table Component and its ability to edit PLC IO Table and SIOU Settings on a PLC.

- **Chapter 4 PLC Setup Component.** This chapter describes the PLC Setup Component and the procedures involved in the configuration of PLC settings.

- **Chapter 5 Data Trace/Time Chart Monitor Component.** This chapter describes the Data Trace/Time Chart Monitor Component and the procedures involved when viewing Data Trace and Time Chart Monitoring information in either Histogram or Trend Graph mode.

- **Chapter 6 PLC Error Component.** This chapter describes the PLC Error Component and the procedures involved in reading and clearing PLC CPU errors, error log entries and messages.

- **Chapter 7 Memory Card Component.** This chapter describes the Memory Card Component and the procedures required to format, access and edit a PLCs memory card/compact flash and to transfer data between the computer or PLC and memory card/compact flash.

- **Chapter 8 CX-Net Network Configuration Tool.** This chapter describes the procedures for establishing communications between PLCs across a network and ensuring that information is routed correctly to the target devices.

- **Chapter 9 PLC Clock Tool.** This chapter describes the PLC Clock Tool and the procedures involved when adjusting the PLC clock.

- **Chapter 10 Data Links.** This chapter describes how the Data Link Editor enables a PLC to be configured so that it can participate in one, or more automatic data sharing schemes, over SYSMAC LINK and Controller Link networks, without the need for special programming.

- **Chapter 11 Routing Tables.** This chapter describes how Routing tables allow networked PLCs to be configured so that they can communicate with each other via gateways; across remote networks.

- **Appendix A Network Availability.** The tables in this appendix indicate the network available to each PLC device group. FinsGateway has no network availability and is not described.

- **Appendix B PLC Memory Area.** The tables in this appendix provide memory area details for each device group.

- **Appendix C Toolbars and Keyboard Shortcuts.** The tables in this appendix summarize the toolbars and keyboard shortcuts available from each component tool.

A Glossary of Terms and Index are also provided.
# TABLE OF CONTENTS

## PART 1: Technical Specification

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Technical Specification</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CX-Server PLC Tools Software</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>About this Manual</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CX-Server PLC Tools: New Features</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>System Requirements</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Communications Requirements</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Installation</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Starting CX-Server PLC Tools</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Help and How to Access it</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Help Topics</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Technical Support</td>
<td>4</td>
</tr>
</tbody>
</table>

## PART 2: CX-Server PLC Tools

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>PLC Memory Component</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>PLC Data Area</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Editing Data</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>PC to PLC Communications</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Monitoring Data</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Clearing and Filling Data Areas</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>PLC Address Area</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Monitoring</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Forced Settings</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>PLC Memory Management</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>PLC Memory Preferences</td>
<td>16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>IO Table Component</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>I/O Table Window Variations</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Auto-selection of the I/O Table Window</td>
<td>19</td>
</tr>
<tr>
<td></td>
<td>Distinguishing between the CS/CJ/CP and C/CV I/O Table Windows</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>I/O Table Window Functions</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Special I/O Unit and CPU Bus Unit Settings</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>CPS File Overview</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Specialized Tool Startup Overview (Supported when CX-Programmer Is Installed from CX-One)</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Displaying an I/O Table</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Displaying the CS/CJ/CP I/O Table Window</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Displaying the C/CV I/O Table Window</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Unit Settings</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Settings for the CS/CJ/CP I/O Table Window</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Settings for the C/CV Series I/O Table Window</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Unit Setup</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>Software Switches</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Displaying Unit Error Log in the IO Table</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>IO Table Management</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>PC to PLC Communications</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Transfer an IO Table from a PLC</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Transfer an IO Table to a PLC</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Comparing an IO Table</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Starting Specialized Support Tools</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>PLC Specific Features</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Hot Swapping</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Setting Rack Start Addresses</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Units Profile Information</td>
<td>35</td>
</tr>
<tr>
<td>4</td>
<td>PLC Setup Component</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>CS/CI/CP-Series PLC Settings</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>PLC Startup</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Timings</td>
<td>38</td>
</tr>
</tbody>
</table>
# Part 2: CX-Server PLC Tools

## Chapter 5: Data Trace/Time Chart Monitor Component

### Types of Data Trace Window

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling Ranges</td>
<td>50</td>
</tr>
<tr>
<td>CS/CJ/CP-series PLC Sampling Range (Except for CJ2 CPU Units)</td>
<td>50</td>
</tr>
<tr>
<td>CV-series PLC Sampling Range</td>
<td>51</td>
</tr>
<tr>
<td>C-series PLC Sampling Range</td>
<td>51</td>
</tr>
<tr>
<td>For CS/CJ/CP-series</td>
<td>52</td>
</tr>
<tr>
<td>Convenient Functions of Data Trace Window for CS/CJ/CP.</td>
<td>64</td>
</tr>
<tr>
<td>For C/CV-series</td>
<td>64</td>
</tr>
<tr>
<td>Managing the Data Trace/Time Chart Monitor</td>
<td>65</td>
</tr>
<tr>
<td>Saving Data Trace Settings</td>
<td>66</td>
</tr>
<tr>
<td>Retrieving Data Trace/Time Monitor Settings</td>
<td>66</td>
</tr>
<tr>
<td>Displaying a Data Trace/Time Chart</td>
<td>66</td>
</tr>
<tr>
<td>SYSWIN Data Trace and Time Chart Monitor Files</td>
<td>68</td>
</tr>
</tbody>
</table>

## Chapter 6: PLC Error Component

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors</td>
<td>69</td>
</tr>
<tr>
<td>Error Log</td>
<td>69</td>
</tr>
<tr>
<td>Messages</td>
<td>70</td>
</tr>
<tr>
<td>Error Log Settings</td>
<td>70</td>
</tr>
<tr>
<td>Time Monitoring</td>
<td>70</td>
</tr>
<tr>
<td>Manually Updating the Error Log</td>
<td>71</td>
</tr>
<tr>
<td>Customising the Layout of the Error Log</td>
<td>71</td>
</tr>
<tr>
<td>Enabling and Disabling the Error Log</td>
<td>71</td>
</tr>
<tr>
<td>Overwriting Error Log Entries</td>
<td>71</td>
</tr>
<tr>
<td>Displaying the Error Log</td>
<td>72</td>
</tr>
</tbody>
</table>

## Chapter 7: Memory Card Component

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Card Operation</td>
<td>73</td>
</tr>
<tr>
<td>Memory Card Display</td>
<td>74</td>
</tr>
<tr>
<td>Memory Card Properties</td>
<td>75</td>
</tr>
<tr>
<td>Transferring Data between the PLC and Memory Card</td>
<td>75</td>
</tr>
<tr>
<td>Possible Memory Card Errors</td>
<td>75</td>
</tr>
</tbody>
</table>
CHAPTER 8 CX-Server Network Configuration Tool (CX-Net) ............ 77
  CX-Net and CX-Server Projects ............................................................... 78
  Creating a New CX-Server Project ............................................................ 78
  Opening an Existing CX-Server Project ...................................................... 78
  Adding a Device .................................................................................... 78
  Editing a Device List ............................................................................ 79
  PLC Settings ........................................................................................ 79
  Opening a PLC .................................................................................... 79
  Closing a PLC .................................................................................... 79
  Configuring a PLC’s System Settings ...................................................... 80
  Scanning for PLC Connections .............................................................. 80
  Dragging Device Information into a CX-Server Project .................................. 80
  Displaying PLC Device Information ........................................................ 80
  Setting the PLC Mode .......................................................................... 81
  Clearing PLC Errors ........................................................................... 81
  Creating an IO Table ........................................................................... 81
  Displaying the PLC Unit Status ............................................................ 81
  Testing the Network Connection ........................................................... 82
  Communications Unit Setup ................................................................... 82
  SYSMAC LINK Settings ......................................................................... 82
  Network Status .................................................................................. 82
  Network Settings ................................................................................ 82
  Controller Link Settings ....................................................................... 83
  Network Status .................................................................................. 83
  Network Settings ................................................................................ 83
  Routing Tables ................................................................................... 83
  Data Link .......................................................................................... 83
  Data Link Setup ................................................................................ 84
  Offline SYSMAC NET Data Link Editor .................................................. 85

CHAPTER 9 PLC Clock Tool .................................................................... 87

CHAPTER 10 Data Links ............................................................................ 89
  What Are Data Links? ........................................................................ 89
  Overview ......................................................................................... 89
  User Interface Overview ..................................................................... 91
  Datalink Component .......................................................................... 91
  Manually Setting Data Links ............................................................... 94
  Procedure through Data Link Startup ................................................. 95
  Creating Data Link Tables .................................................................. 95
  System Configuration Example ............................................................ 97
  Creating Data Link Tables Offline ........................................................ 99
  Procedure Using Setup Example .................................................... 110
  Checking Data Link Tables ............................................................... 112
  Printing Data Link Tables ................................................................. 112
  Saving Data Link Tables .................................................................... 113
  Creating, Reading, and Writing CSV Files (Saving) ............................ 113
  Connecting Online ........................................................................... 118
  Reading and Transferring Data Link Tables (Including Status Displays) 119
  Starting and Stopping Data Links (Including Status Displays) ............... 122
  Automatically Set Data Links ............................................................... 124
  Procedure Through Data Link Startup ................................................. 124
  Controller Link Automatic Setup ....................................................... 125
  SYSMAC LINK Automatic Setup .......................................................... 127
  Transferring Automatic Data Link Setup Parameters to the Startup Node 129
  Monitoring Data Link Status ............................................................... 130

CHAPTER 11 Routing Tables .................................................................... 133
  Opening an existing Routing Table ..................................................... 133
  Creating a new Routing Table ............................................................ 133
  Adding a Local Network ................................................................... 134
Adding a Remote Network .......................................................................................................................... 135
Editing the Routing Table.............................................................................................................................. 136
Error Checking................................................................................................................................................ 136
Additional Features......................................................................................................................................... 136
The Network View Screen ............................................................................................................................. 136
The Overview Screen ...................................................................................................................................... 137
Table View Screen ......................................................................................................................................... 137
Gateway Counter Settings ............................................................................................................................... 138
Transferring a Routing Table to a PLC ........................................................................................................... 140
Transferring a Routing table from a PLC .......................................................................................................... 140

CHAPTER 12 PLC Backup Tool ....................................................................................................................... 141
Overview .......................................................................................................................................................... 141
PLC Backup Tool Operations......................................................................................................................... 142
Starting the PLC Backup Tool....................................................................................................................... 142
Communications Settings for the Target PLC............................................................................................... 143
Backing Up PLC Data to the Computer ........................................................................................................ 147
Comparing Data............................................................................................................................................... 152
Restoring Data................................................................................................................................................ 157

APPENDIX A Toolbars and Keyboard Shortcuts .......................................................................................... 165
Toolbars.......................................................................................................................................................... 165
Keyboard Shortcuts......................................................................................................................................... 165
Data Trace/Time Chart Monitor Component.................................................................................................. 166
Toolbars Keyboard Shortcuts........................................................................................................................ 166
Memory Card Component ............................................................................................................................... 167
Toolbars Keyboard Shortcuts........................................................................................................................ 167
CX-Net Network Configuration Tool........................................................................................................... 167
Toolbars Keyboard Shortcuts........................................................................................................................ 167
Import/Export Tool........................................................................................................................................... 168
Toolbars Keyboard Shortcuts........................................................................................................................ 168
Data Link Editor.............................................................................................................................................. 168
Toolbars Keyboard Shortcuts........................................................................................................................ 169
Routing Table Editor...................................................................................................................................... 170
Toolbars Keyboard Shortcuts........................................................................................................................ 170

GLOSSARY OF TERMS................................................................................................................................. 171
INDEX............................................................................................................................................................... 181
CHAPTER 1
Technical Specification

This chapter describes the CX-Server PLC Tools software in general terms and introduces the user to the relationship between CX-Server PLC Tools and the associated products. It also provides details of the operating environment, minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server PC Tools.

CX-Server PLC Tools Software

PLC Tools are a collection of utilities and programs that provide configuration and control for OMRON PLCs and Networks.

CX-Server PLC Tools consists of the following components:

♦ **PLC Memory** component. This component allows the user to view, edit and monitor either channels (words) or individual bits in areas of the PLC.
♦ **IO Table** component. This component retrieves and configures PLC rack and address data.
♦ **PLC Setup** component. This component retrieves and configures PLC setting data.
♦ **Data Trace/Time Chart Monitor** component. This component records and displays data obtained from the PLC’s memory areas during program execution.
♦ **PLC Error** component. This component displays and manages PLC errors.
♦ **Memory Card** component. This component manages the file storage to and from PLC memory cards.
♦ **PLC-Clock** component. This component configures and displays the PLC clock.
♦ **Routing Table** component. This component manages the routing tables, which allow PLC internode communications.
♦ **DataLink Editor** component. This component allows configuration and modification of the datalink tables, which allows data to be transferred between PLCs without any other programming.
♦ **CX-Net Network Configuration** tool. This tool consists of a suite of programs allowing the management of Networks for OMRON PLCs.

CX-Server PLC Tools utilities form part of other CX-Automation suite applications (CX-Programmer, CX-Server).

CX-Server PLC Tools have a close relationship with CX-Server Runtime which is the communications middleware software for OMRON PLCs. For further information see CX-Server Runtime manual.

About this Manual

This User Manual acts as a reference for CX-Server PLC Tools by describing its various concepts and abilities, and provides the basics of using its dialogs and supplied utilities.

**Caution:** This manual is referred to from other software applications that utilise CX-Server, for instance, CX-Programmer, CX-Protocol or SYSMAC-SCS. Subsequently, some topics contained in this user manual may not be relevant.

The CX-Server PLC Tools come with a context-sensitive online help system which is designed to complement this manual and to provide a quick reference at any point while using CX-Server PLC Tools when the manual is not to hand. This general help system uses a fast hypertext system which allows progressively detailed information about any topic to be obtained by selecting keywords within the descriptive text.

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows, and knows how to:

♦ use the keyboard and mouse;
♦ select options from Microsoft Windows menus;
♦ operate dialog boxes;
♦ locate, open and save data files;
♦ edit, cut and paste text;
CX-Server PLC Tools: New Features

This version of the CX-Server PLC Tools offers significant functionality for communication with OMRON PLCs and management of their associated settings information.

System Requirements

The system requirements of CX-Server are the same as those of the CX-Programmer. Refer to page 3 in Part 1: CX-Programmer for details.

Communications Requirements

In order to use serial communication types SYSMAC WAY and Toolbus a RS232 connections via a standard serial port on the PC (COM1 etc.) or a RS422 connections to a 422 serial board is required.

When using SYSMAC LINK directly from a PC, a SYSMAC LINK network service board and FinsGateway version 3.12 must be installed.

When using Controller Link, a Controller Link network service board (wired or optical and FinsGateway version 3.12 are required.

In order to use an Ethernet net, an Ethernet card, Windows Sockets software and TCP/IP must be installed and correctly configured.

Refer to the appropriate hardware system manuals for detailed information about connecting and configuring these devices for the environment.

Note: If FINS Gateway is to be used with a CLK/SLK PCI board in the Windows 2000 or higher operating system the appropriate drivers must be installed. These drivers can be found on the CX-Server CD under: CX-Server\WDM\CLK (PCI) or CX-Server\WDM\SLK (PCI).

Installation

CX-Server and CX-Server PLC Tools can be installed from the CX-One Package CD-ROM or the individual CX-Programmer CD-ROM. Refer to one of the following manuals for details.

♦ Installing from CX-One: Refer to the CX-One Setup Manual.
♦ Installing from the individual CX-Programmer CD-ROM: Refer to page 4 of Part 1: CX-Programmer.

Starting CX-Server PLC Tools

CX-Server PLC Tools components are normally accessed from the invoking application. However, a number of tools can be accessed stand-alone from the Start pushbutton on the Microsoft Windows taskbar.

Help and How to Access it

The CX-Server PLC Tools come with a detailed context-sensitive help system. At any time while using the software, it is possible to get help on the particular point that is currently being worked on, or on general aspects of the CX-Server PLC Tools. This system is intended to complement the manual, by providing online reference to specific functions of the software and how to use them. The manual is designed to provide more tutorial information and discuss the various facilities offered by the CX-Server PLC Tools.

♦ Context-sensitive help;
Help Topics

For any of the PLC Tools select the Help Contents option on the Help menu. The Help system provides a standard look-up dialog under the Contents tab showing the contents of the PLC Tools Help file. Click on an item to read the associated information.

Index

Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog.

1. Select the Help Index option from the Help menu.

2. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field.

3. Select an entry in the second step field and select the Display pushbutton, or double-click on the index entry.

4. If an entry is linked to two or more topics, the names of the topics are displayed in the Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on the topic.

Find

Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog.

1. Select the Help Index option from the Help menu.

2. Select the Find tab.

3. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field. Previous text queries can be retrieved by selecting from the drop-down list in the first step field.

4. Select a word that matches the query – some words may be automatically selected. More than one word can be selected by pressing Shift and selecting another word to extend the selection, or by pressing Ctrl and selecting another word to add to the selection. The third step field is refreshed according to the word or words selected. The number of topics found are shown at the bottom of the dialog.

5. Select a topic from the third step field and select the Display pushbutton, or double-click on the topic from the third step field. Select the Clear pushbutton to restart the find operation.

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to Microsoft Windows documentation for further information.

Context-sensitive Help

The CX-Server PLC Tools support the use of context-sensitive help. The relevant online help topic is provided automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 function key to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be accessed.

About CX-Server PLC Tools

Each CX-Server PLC Tools dialog contains an About option on the Help menu. The About dialog supplies technical reference information about that dialog such as version and copyright information. It also contains essential version number information that is required for obtaining technical support.

Use the following procedure to view the About CX-Server dialog.

1. Select About from the Help menu.

2. The About box is displayed. It provides a copyright statement and version number of the component or tool within CX-Server.
Status Bar
The Status Bar is displayed at the bottom of many of the CX-Server dialog and PLC Tool windows. It provides several helpful pieces of information while programming:

♦ Instant Help. A brief message appears in the Status Bar as menu commands and buttons are selected.
♦ Online Status. The online or offline status of the PLC. (i.e. connected to PLC or not).
♦ PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are also displayed here.
♦ Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be referenced in the status bar.

The Status Bar can be enabled and disabled from many components and tools by selecting the Status Bar option from the View menu.

Technical Support
If the installation instructions for this application have been followed (refer to Installation in this Chapter), no difficulties should be encountered. However, if there is a problem, contact Customer Services.

If a problem occurs, check that it does not relate to a fault outside CX-Server or the PLC Tools. Check the following:

♦ The PC is working correctly.
♦ The PLC is working correctly.
♦ The communications system is set up correctly.
♦ The errors are cleared in the PLC.

When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear and concise description of the problem is required, together with the exact text of any error messages.

Note: Use the About box to obtain the version number of the component.
## Customer Services Required Information Table

| Version number of CX-Server component or tool: |  |
| Serial number of the software: |  |
| Operating system and version number: |  |
| Language of operating system: |  |
| PLC type, model and CPU details: |  |
| Type of communications in use: |  |
| Serial Number |  |
| Toolbus |  |
| SYSMAC LINK |  |
| SYSMAC NET |  |
| Device Net |  |
| Controller Link |  |
| Ethernet |  |
| Nature of the problem: |  |
| Steps taken to reproduce problem: |  |
| Other comments: |  |
CHAPTER 2
PLC Memory Component

This chapter describes the PLC Memory component and its ability to allow the user to view, edit and monitor either channels (words) or individual bits in areas of the PLC.

The PLC Memory component allows viewing, editing and monitoring of PLC memory areas, monitoring and forcing of bit addresses and symbols and forced status information.

The PLC Memory component displays the values of the memory area being accessed within the PLC. Areas to be monitored are selected from the memory area workspace. The address workspace shows individual bits, individual channel symbols and forced status information by selecting or entering specific PLC addresses or symbol names. The current values of these areas are displayed in the PLC Memory component. There are no values displayed when the PLC is offline.

The PLC Memory component can be forced to stay as the top window by selecting Always on top from the View menu.

For moving, resizing, tiling, maximising, minimising and closing windows, refer to Microsoft Windows online help for further information.

Access to the PLC Memory component is from the invoking application.

To close the PLC Memory window, select the Close button in the title bar.

The left pane, known as the Data Area Workspace, displays the current PLC in terms of its data areas and addresses. The data areas that form part of the PLC memory differ depending on the PLC type. The status bar provides instant help, displays the PLC and CPU type and describes the operating mode of the PLC.

To expand the hierarchy in the left pane, select this icon.
To collapse the hierarchy in the left pane, select this icon.

To view the content of a particular branch in the hierarchy, double-click on the item in the Data Area Workspace: a window is displayed within the PLC memory component. The associated icon in the Data Area Workspace changes to denote that a window has been opened. Multiple windows can be opened at the same time.

Select the Close button in the window’s title bar to close the window.

Columns can be resized using the Resize Column button from the toolbar to fit the visible display area. These options are useful when changing data format, for instance to Binary.

The display of the Data Area Workspace can be controlled by selecting Data Area Workspace from the View menu.

The toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the display of the status bar. Select Toolbar from the View menu to control the display of the PLC Memory toolbar.
PLC Data Area

The Memory tab of the PLC Memory component allows monitoring and editing of complete memory areas as channel data.

When the content of a memory area is opened, a window is displayed. It is possible to Zoom in and out of the window by selecting the Zoom In button or Zoom Out button from the toolbar. Select the Restore Zoom/Zoom to Fit button from the toolbar to return the window to the original zoom setting.

Editing Data

Data can be entered or amended in the data area displayed provided the associated PLC or memory area allows read/write operations. Use the following procedure to edit data in the Memory tab.

1. Double-click on the required data area name in the Memory tab of the Data Area Workspace to open it. A window containing a grid representing that data area is opened.

2. Select an appropriate format for the data to be entered from the associated button from the toolbar: Binary, Binary Coded Decimal, Decimal, Signed Decimal, Floating Point, Hexadecimal, Double Floating Point or Text.

3. Type in valid values directly into the cells and press Return.

Note: Once a format has been selected a keyboard filter is applied so that non-valid keystrokes are ignored.

When in either Debug mode (for CV-series PLCs only) or Monitor mode: it is not possible to edit a read-only value.

PC to PLC Communications

The PLC Memory component permits the transfer of data to and from the PLC and allows comparisons to be made between data stored on the computer and the PLC. Use the following procedure to retrieve data from the PLC.

1. Ensure the PLC is online before activating the PLC Memory component.

2. Open a data area by double-clicking a data area from the Data Area Workspace in the Memory tab.
3. Select the **Transfer from PLC** button from the toolbar to read information from the PLC.

4. The Transfer from PLC dialog is displayed. Transfer can be performed on the memory areas that have been opened in the PLC Memory component. Select the associated setting to monitor that area.

5. Select the **Visible Area Only** option to transfer the area visible to the window, the **Selection** option to transfer the area highlighted by the cursor or the **All** option to transfer all of the selected memory area from the PLC. Alternatively, use the **Select All** pushbutton to transfer all opened memory areas from the PLC.

6. Select the **Upload** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.

**Note:** By clicking an associated data area’s settings in its greyed state, the PLC Memory component automatically identifies the data area words to be monitored.

Use the following procedure to write data back to the PLC.

1. Ensure the PLC is online before activating the PLC Memory component.

2. Open a data area by double-clicking a data area from the Data Area Workspace in the **Memory** tab.

3. Select the **Transfer to PLC** button from the toolbar to transfer information to the PLC.

4. The Transfer to PLC dialog is displayed. Transfer can be performed on the memory areas that have been opened in the PLC Memory component. Select the associated setting to monitor that area.

5. Select the **Visible Area Only** option to transfer the area visible to the window, the **Selection** option to transfer the area highlighted by the cursor or the **All** option to transfer all of the selected memory area to the PLC. Alternatively, use the **Select All** pushbutton to transfer all opened memory areas to the PLC.

6. Select the **Download** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.

**Note:** By clicking an associated data area’s settings in its greyed state, the PLC Memory component automatically identifies the data area words to be monitored.

The PLC Memory component allows the values stored on the PLC and the current displayed values to be compared. Use the following procedure to compare PLC and PC values.

1. Ensure the PLC is online before activating the PLC Memory component.

2. Select the **Compare with PLC** button from the toolbar to compare information between the PC and the PLC.

3. The Compare with PLC dialog is displayed. Comparisons can be performed on the memory areas that have been opened in the PLC Memory component. Select the associated setting to compare that area.

4. Select the **Visible Area Only** option to compare the area visible to the window, the **Selection** option to compare the area highlighted by the cursor, or the **All** option to compare all of the selected memory area to the PLC. Alternatively, use the **Select All** pushbutton to compare all opened memory areas.

5. Select the **Compare** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.

Whilst comparing, all values resident on the PLC that are different to those on the PC are annotated in brackets. Further editing to the data area causes further differences between PC and PLC versions, and these are also annotated.

**Importing Cam Data (CJ2 Series Only)**

This function reads to PLC memory CSV-format cam data that was created using the CAM Data Creation Software (WS02-MOPC2). You can then transfer the data from the PLC memory component to the PLC.

The import procedure is given below.
1, 2, 3...

1. Select **File – Import – Import CAM data file** in the PLC Memory Window. The following dialog box will be displayed.

2. Specify the file that is to be imported and click the **Open** Button.

3. Set the import destination and the decimal point position for the import data.

4. Click the **OK** Button.

The import operation will be started. After it has been normally completed, the result will be displayed as follows:

**Timer/Counter Memory areas**

Whether online or offline the PLC Memory component enables the data in the Timer (TIM) and Counter (CNT) memory areas to be formatted using either Binary Coded Decimal (BCD), Hexadecimal or Decimal data types.

When an Online transfer to PLC operation is executed, the PLC Memory Component will read the TIM/CNT mode setting from the PLC. If the TIM/CNT mode is set to BCD, then the command will be actioned only if the
current data type is also BCD. If the data type is not BCD, then a warning message will be displayed, and the command will be aborted.

If the TIM/CNT mode is set to Binary, the command will only be actioned if the current data type is Decimal or Hexadecimal. If the current data is neither Decimal or Hexadecimal, then a warning message will be displayed, and the command will be aborted.

When an Online Transfer from a PLC, Compare or Monitor operation is executed, the PLC Memory Component will read the data from the PLC and display it in the currently selected data format. If the data can not be displayed in the currently selected format, then an error message will be displayed.

**Note:** The Timer (TIM) and Counter (CNT) memory areas are only available in the following PLCs: CS1G-H, CS1H-H, CJ1G-H, CJ1H-H, CJ1M, and CP1H.

**Monitoring Data**

Use the following procedure to monitor the data in PLC memory:

1. Ensure the PLC is online before activating the PLC Memory component.
2. Select the **Monitor** button from the toolbar to monitor the PLC.
3. The Monitor dialog is displayed. Monitoring can be performed on the memory areas that have been opened in the PLC Memory component. Select the associated setting to monitor that area.
4. Select the **Visible Area Only** option to monitor the area visible to the window or the **Selection** option to monitor the area highlighted by the cursor.
5. Select the **Monitor** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.

Once monitoring, all changes to the data area are viewed. By navigating around the data area window, the visible area of the monitoring set by the **Visible Area Only** option changes to compensate.

**Note 1:** In the PLC Memory Window, individual values (cells) can be selected and the following operations can be performed to change present values during monitoring.

- For BIN (binary) displays, click the On, Off, ForceOn, ForceOff, ForceCanc, **SetValue** button to change the value of a bit.
  
  The value can also be changed by right-clicking and then selecting Force | On, Force | Off, Force | Cancel, or Set | On, Set | Off, Set | Value from the pop-up menu.

- For other displays (e.g., decimal, BCD, or HEX), click the **SetValue** button to change the present value.
  
  The present value can also be changed by right-clicking and then selecting **Set | Value** from the pop-up menu.

**Note 2:** Continuous addresses can be monitored in the PLC Memory window by specifying the start address to be monitored. Set the start address in the Start Address field shown below and the display in the window will jump to the specified address for monitoring.
PART 2: CX-Server PLC Tools
CHAPTER 2 – PLC Memory Component

• In the PLC Memory window, both individual bits for each word and the hexadecimal value of the word can be monitored at the same time if the display format is set to BIN (binary).

Clearing and Filling Data Areas

A whole data area can be cleared by clicking on the Clear Data Area button from the toolbar.

A whole data area can be populated with a particular value. Use the following procedure to fill a data area with a single value.

1. Open a data area by double-clicking a data area from the Data Area Workspace in the Memory tab.

2. Select the Fill Data Area button from the toolbar. The Fill Data Area dialog is displayed.

3. The Fill operation can be performed on the memory areas that have been opened in the PLC Memory component. Select the associated setting to fill that area.

4. Supply the value in the Value field.

5. Select the appropriate Fill Range option, either All, Visible Area Only or the selection currently highlighted by the cursor.

6. Select a Value option, either Binary, Binary Coded Decimal, Decimal, Signed Decimal or Hexadecimal.

7. If required, select a Set Status Value setting and the appropriate On or Off option.

8. Select the Fill pushbutton to accept the settings or the Cancel pushbutton to abort the operation.
PLC Address Area

The Address tab of the PLC Memory dialog allows monitoring and forcing the status of individual bits.

Monitoring

Use the following to monitor an address or a symbol from an invoking application.

1, 2, 3...
1. Ensure the PLC is online before activating the PLC Memory component.
2. Click on the Address tab of the PLC Memory component.
3. Open the Monitor area by double-clicking the Monitor branch from the Data Area Workspace in the Address tab.
4. Enter an address in the Address field or select a Symbol to be retained from the invoking application:

   - In a Symbol field, type in a Symbol name or select the Browse button to select a Symbol to be retained from the invoking application. The corresponding Address field automatically detects and contains the address associated with the Symbol.
   - If a Symbol has not been selected, in an Address field, type in a direct word or bit address to monitor.

Note: Address notation for CS/CJ/CP-series PLCs and CV-series PLCs is, for instance ‘D0’, ‘0’, ‘E0.0’ to monitor a word, ‘0.0’, ‘cf100’ to monitor bits.

When monitoring starts, data from the PLC is displayed in the Value field, in the format specified in the Format field. The display format of the address or symbol to be monitored can be changed by selecting an appropriate button from the toolbar: Binary, Binary Coded Decimal, Decimal, Signed Decimal, Hexadecimal or Text.

Any special address information is shown in the Attribute field. The attribute of a bit can be forced. It is not possible to force bit addresses that are read-only. Use the following procedure to apply a forced setting.

1, 2, 3...
1. Ensure a bit is currently being monitored and is not read-only.
2. Select the Attributes setting for the bit.
3. Select the forced state of the bit. A bit can be forced on by selecting the Force On button from the toolbar. A bit can be forced off by selecting the Force Off button from the toolbar. Forced settings can be cancelled by selecting the Force Cancel button from the toolbar.

The update rate is shown in the Properties field.
Further rows can be inserted into the Address Monitor window by selecting Insert from the Address menu. Rows can be removed by selecting Remove from the Address menu. All rows can be removed by selecting Remove All from the Address menu.

**Forced Settings**

It is possible to specify the state of an address regardless of its actual (physical) state, this is particularly useful for testing certain conditions or rungs in a ladder program.

Once scanned, the Forced Status window displays the address, value and attributes for all forced bits.

It is not possible to force bit addresses that are read-only.

**Displaying Forced Status**

The forced status of bits can be retrieved from the PLC. Use the following procedure to retrieve the forced status of bits from the PLC.

1. Ensure the PLC is online before activating the PLC Memory component.
2. Click on the Address tab of the PLC Memory component.
3. Click the right-mouse button on the Forced Status branch and select Scan Forced Status.
4. All bit areas in the PLC are scanned to find all forced bits (Forced On and Forced Off). The Forced Status window is displayed showing all forced bits and their associated value and attributes.

**Copying a Forced Bit**

A forced bit can be copied from the Force Status window to the Address Monitor window. Use the following procedure to copy a forced bit.

1. Ensure the PLC is online before activating the PLC Memory component.
2. Click on the Address tab of the PLC Memory component.
3. Open the Forced Status area by double-clicking the Forced Status branch from the Data Area Workspace in the Address tab.
4. Select the address to be copied with the right-mouse button in the Forced Status window and select Copy to Symbol Monitor Address.

**Clearing Forced Bits**

All forced bits can be cleared. Use the following procedure to clear forced bits.

**Caution:** This operation will clear all forced bits in the PLC.

1. Ensure the PLC is online before activating the PLC Memory component.
2. Click on the Address tab of the PLC Memory component.
3. Open the Forced Status area by double-clicking the Forced Status branch from the Data Area Workspace in the Address tab.
4. Click the right-mouse button in the Forced Status window and select Clear All Forced Addresses.
5. Select the Yes pushbutton to confirm the operation.

**Updating the Forced Status Window**

Use the following procedure to refresh the Force Status window.

1. Ensure the PLC is online before activating the PLC Memory component.
2. Click on the Address tab of the PLC Memory component.
3. Open the Forced Status area by double-clicking the Forced Status branch from the Data Area Workspace in the Address tab.
4. Click the right-mouse button in the Forced Status window and select Refresh.

**Note:** Enabling Force-setting/resetting Bits in the EM Area

With CX-Programmer version 8.3 or higher and a CJ2H CPU Unit with unit version 1.2 or later, you can specify a bank in the EM Area to enable force-setting/resetting bits in the...
specified bank and all banks following it. This is called the EM Area force-setting/resetting function.

Use the following procedure.

1. Select **Memory Allocate → EM Memory Settings** from the PLC Menu. The following EM Memory Settings Dialog Box will be displayed. Select the **Enables the Force On/Off setting of EM banks** Check Box in the EM Force On/Off Area, select the starting back from the pull-down menu in the **EM Start File No.** Box, and then click the **OK** Button.

2. Go online with the CPU Unit, select **Transfer → Transfer to PLC** from the PLC Menu, and transfer the program to the CPU Unit.

**Note:** With CJ2H CPU Units with unit version 1.0 or 1.1, force-setting/resetting bits in the EM Area is supported only for areas specified for automatic address assignment. With CJ2H CPU Units with unit version 1.2 or later, force-setting/resetting bits in the EM Area is supported both for areas specified for automatic address assignment and for the EM Area force-setting/resetting function described above.

### PLC Memory Management

A number of features of the PLC Memory Component are common to both the **Memory** tab and **Address** tab.

PLC Memory component files can be saved to the CX-Server project. Use the following procedure to save PLC Memory component details to the CX-Server project.

1. 2. 3…
   1. Select the **Save in Project** button from the toolbar. The Save dialog is displayed.
   2. Select the required data areas to include in the file from the **Areas to Save:** field.
   3. Enter a comment in the **File Comment** field.
   4. Select the **OK** pushbutton to proceed.

PLC Memory component files can be saved via a standard File Save dialog. Use the following procedure to save a PLC Memory component file.

1. 2. 3…
   1. Select **Save to File** from the **File** menu. The Save dialog is displayed.
   2. The Save dialog is displayed. Select the required data areas to include in the file from the **Areas to Save:** field.
   3. Enter a comment in the **File Comment** field.
   4. Select the **OK** pushbutton to proceed.
   5. A standard File Save dialog is displayed. Enter a file name in the **File name** field and select the **Save** pushbutton. PLC Memory files have a .MEM extension.

Information saved to a file can be supplemented with header information set as a preference. Refer to **Chapter 2 - PLC Memory Component** for details of setting header information to a file.

PLC Memory component files can be retrieved via a standard File Open dialog. Use the following procedure to open a PLC Memory component file.

1. 2. 3…
   1. Select the **Open File** button from the toolbar to open a PLC Memory component file. A confirmation message box may appear if the file is already open. Select the **Yes** pushbutton to save the currently open details. Select the **No** pushbutton to discard the currently open details. Select the **Cancel** pushbutton to abort the operation.
   2. A standard File Open dialog is displayed. Select a file from the Open PLC Memory File dialog, followed by the **Open** pushbutton. PLC Memory files have a .MEM extension.

PLC Memory component data can be printed. Use the following procedure to print details.

1. 2. 3…
   1. Open the Address Monitor window from the **Address** tab or a data area window from the **Memory** tab.
   2. Select the **Print Preview** button from the toolbar. A preview window is displayed.
3. Select the appropriate pushbutton to view the printout.
   ♦ Select the Next Page pushbutton to view the next page of the printout;
   ♦ Select the Prev Page pushbutton to view the next page of the printout;
   ♦ Select the Two Page pushbutton to view two pages of the printout at once;
   ♦ Select the Zoom In pushbutton to zoom in to the page;
   ♦ Select the Zoom Out pushbutton to zoom out from the page;
   ♦ Select the Print pushbutton to print from the preview.
   ♦ Select the Close pushbutton to close the preview window.

4. Select the Print button from the toolbar. A standard Print dialog is displayed.

5. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory details or the Cancel pushbutton to abort the operation.

   **Note:** Printer specific settings can be applied prior to printing the PLC Memory details, by selecting Print Setup from the File menu.

Use the following procedure to copy or move information from or in the PLC Memory component.

1. Select an item or items in a window.
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar to move the item.
3. Select an area to move the items to, for instance copying data area values into another data area.
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be performed several times without copying again.

**PLC Memory Preferences**

PLC Memory component preferences permits the setting of display properties for data monitoring.

The Display tab defines the preferred display format. Use the following procedure to change the display format preference:

1. Select the Preferences option from the View menu.
2. Select the appropriate word display format option, either Binary, Binary Coded Decimal, Decimal, Signed Decimal, Floating Point, Hexadecimal, Double Floating Point or Text.
3. Select the appropriate bit display format option, either Text or Numeric.
4. If required, select the appropriate font using the Change Font pushbutton.
5. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the operation.

The Monitoring tab allows the monitor update interval preference to be amended. Use the following procedure to change the monitor update interval preference.

1. Select the Preferences option from the View menu.
2. Select the Monitoring tab.
3. Select a Monitor Update Interval and an associated Unit from the fields.
4. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the operation.

The General tab permits the setting of general preferences. Use the following procedure to change the general preferences.

1. Select the Preferences option from the View menu.
2. Select the General tab.
3. Select the Automatically Resize Column Widths option to ensure that all values remain visible within the data area window irrespective of their display format. It is best practise for this option to be set OFF when monitoring large data areas.
4. Select the *Prompt Before Closing an Active Monitor Window* option if confirmation is required before closing a data area window that is being monitored.

5. Select the *Beep on Invalid Input* option to receive an audible beep when an invalid input to the PLC Memory component has been made.

6. Select the *Fast Window Update* option to reduce the affect of flickering when monitoring.

7. Select the **OK** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.

The *File* tab permits the setting of header information into PLC memory component files. Use the following procedure to change the file information.

1. Select the **Preferences** option from the *View* menu.
2. Select the **File** tab.
3. Insert a file name in the *File Name* field.
4. Insert a comment in the *Comment* field.
5. Select the **OK** pushbutton to accept the settings or the **Cancel** pushbutton to abort the operation.
CHAPTER 3
IO Table Component

This chapter describes the IO Table component available to C-series, CV-series, CS/CJ series PLCs and its ability to create, retrieve and edit a configured PLC’s rack and address data.

The IO Table component allows configuration of racks, slots and units within a PLC, using available hardware as reference. Within a PLC there are three versions of an IO Table, all of which should ideally have the same contents. IO Table component editing allows manipulation of the internal version of the table, and modification of the PLC’s view of how the hardware is configured. The three versions are:

♦ Actual IO Table. The real hardware configuration of the PLC units and slots on power-up.
♦ Registered IO Table. The internal PLC table: this is the one used by the PLC when running, regardless of the state of the actual hardware. It can be read and, for C2000 PLCs, CV-series PLCs and CS/CJ series PLCs, written to by the CX-Server software.
♦ CX-Server IO Table. The IO configuration understood by CX-Server. It can be created and modified directly, independently from the PLC, and can be transferred with a program (for CV-series and CS/CJ series PLCs). The Registered Table and CX-Server’s table can be changed from the PC, but the actual configuration requires the physical manipulation of the PLC hardware. It is only possible to transfer the Registered IO Table in C2000, CV and CS/CJ series PLCs to the PLC. Editing of individual IO units in the Registered IO Table is only available in C1000H, C2000H, CS/CJ series and CV-series PLCs.

The IO Table component is displayed as a hierarchical structure. The IO Table view can be expanded to show entries for all Remote Terminals (RTs) and the IO. All possible racks and unit numbers for the active PLC are displayed although these may not all be in use. An address and IO string are displayed against each rack slot or unit; this is used to indicate the input and output characteristics of the unit.

The status bar displays the selected PLC and CPU type, and the current operating mode of the PLC.

When a Remote Terminal (RT) is added, it can be expanded to provide the Terminals view, showing entries for all slots on that remote rack.

Icons to the left of a rack indicate units fitted to expansion racks, SYSBUS/SYSBUS2 remote racks or IO Terminals. To view the content of the IO Table, double-click on a rack. The unit address is displayed in brackets for each slot.

For CV-series PLCs, SIOU units are shown on the IO Table tree as a separate rack. For CS/CJ series PLCs, SIOU units are all integrated into the main rack.

Whilst in online mode operations can be selected that affect the PLC, for instance creating an IO Table. These options are only available when the PLC is in the correct mode of operation for programming.

The IO Table component can be forced to be displayed in focus by selecting Always on top from the Options menu.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for further information.

Access to the IO Table component is from the invoking application or via the CX-Net Network Configuration Tool. Refer to Chapter 8 - CX-Net Network Configuration Tool for further details.

To close the IO Table dialog, select the Close button in the title bar.

I/O Table Window Variations

CX-Programmer Versions 6.0 and later have the following two kinds of I/O Table Windows.

1. I/O Table Window for the CS/CJ/CP Series (known as the CS/CJ/CP I/O Table Window)
2. I/O Table Window for the C Series and CVM1/CV Series (known as the C/CV I/O Table Window)

Auto-selection of the I/O Table Window

The following table shows which I/O Table Window will be selected automatically, based on the PLC model and computer operating system.
### Distinguishing between the CS/CJ/CP and C/CV I/O Table Windows

The I/O Table Windows can be identified by the names in the project directory tree and the colors of icons, as shown in the following table.

<table>
<thead>
<tr>
<th>I/O Table Window variation</th>
<th>Names in project directory tree</th>
<th>Colors of icons in project directory tree</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) CS/CJ/CP I/O Table Window</td>
<td>I/O Table and Unit Setup</td>
<td>Grey and yellow</td>
</tr>
<tr>
<td>2) C/CV I/O Table Window</td>
<td>I/O Table</td>
<td>Sky blue</td>
</tr>
</tbody>
</table>

### I/O Table Window Functions

The following table describes the functions of the two I/O Table Windows.

<table>
<thead>
<tr>
<th>I/O Table Window variation</th>
<th>Existing functions</th>
<th>New functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) CS/CJ/CP I/O Table Window</td>
<td>Creating a registered I/O table (Displays Unit type, number of Units occupied, and number of I/O words occupied.)</td>
<td>• Special I/O Unit and CPU Bus Unit parameter settings</td>
</tr>
<tr>
<td></td>
<td>• Software switch settings (See note 1.)</td>
<td>• Specialized Support Tool startup function (See note 2.)</td>
</tr>
<tr>
<td></td>
<td>• Unit settings (See note 1.)</td>
<td>• Display a Rack’s current consumption (CS/CJ Series only) and Rack width (CJ Series only)</td>
</tr>
<tr>
<td></td>
<td>• Replace Unit online.</td>
<td>• Monitor CPU DIP Switch settings online. Note 2. When the CX-Programmer is installed from the CX-One.</td>
</tr>
<tr>
<td></td>
<td>• Display Unit production information.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Register/display Unit comment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Register/display Unit profile.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Monitor Unit error log.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note 1.</strong> The software switch settings and Unit settings are included in the Special I/O Unit and CPU Bus Unit parameter settings.</td>
<td></td>
</tr>
</tbody>
</table>

| 2) C/CV I/O Table Window          | Creating a registered I/O table (Displays Unit type, number of Units occupied, and number of I/O words occupied.) | None |
|                                   | • Software switch settings                                                      |                                   |
|                                   | • CPU Bus Unit settings                                                         |                                   |
|                                   | • Replace Unit online.                                                          |                                   |
|                                   | • Display Unit production information.                                          |                                   |
|                                   | • Monitor Unit error log.                                                       |                                   |
|                                   | • When editing the I/O table offline, words can be reserved by installing Dummy Units. |                                   |
Special I/O Unit and CPU Bus Unit Settings

One of the new CS/CJ/CP I/O Table Window functions sets the allocated DM area, allocated CIO area, and CPU Bus Unit Area (Ethernet Units only) for CS/CJ/CP-series Special I/O Units and CPU Bus Units without requiring the parameter addresses. (This function is supported by the CS/CJ/CP I/O Table Window only.) Even if new Special I/O Units and CPU Bus Units are purchased, the new Units parameters can be set just by installing the Unit’s CPS (Component and network Profile Sheet), so it isn’t necessary to upgrade the CX-Programmer.

CPS File Overview

The term CPS is short for the “Component and network Profile Sheet”, which is a CX-One file containing definition information for a CS/CJ/CP-series Unit or other component. The CPS files are provided in XML file format.

The CX-Programmer uses the information in the CPS files to identify CS/CJ/CP-series Units in the I/O Table. Special I/O Unit and CPU Bus Unit settings are also based on these CPS files.

The CPS files are composed of the following CS/CJ/CP-series Unit/Component information:

- ID information (such as the model number, name, Unit type, and Unit version)
- Parameter information (offset address, setting parameter name, and setting range or selection options)

Specialized Tool Startup Overview (Supported when CX-Programmer Is Installed from CX-One)

The Specialized Tool Startup function is a new CS/CJ/CP I/O Table Window function that can start the Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) directly from the I/O Table Window. (This function is supported by the CS/CJ/CP I/O Table Window only.) This function is supported when the CX-Programmer or other Support Tool is installed from the CX-One. The appropriate Programming Support Tool can start with the necessary PLC model information, Unit type, and online/offline status information.

Displaying an I/O Table

Displaying the CS/CJ/CP I/O Table Window

The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC.
Note: In the CS/CJ I/O Table Window, the current consumption and width for each PLC Rack can be displayed as shown below by selecting **Options - Consumption and Width.**

When Units which do not have CPS are registered in the I/O tables, the current consumption and width cannot be calculated correctly. In this case, estimated values marked with "*" are displayed for the current consumption and width as shown below. Specifically, when a previous model of a Unit (such as C200H I/O Units) is used, estimated values may be displayed.

In this case, check the current consumption and width in the *Operation Manual* of the Unit.

Online, the current status of the DIP switches on the target PLC (CPU Unit) can be checked by selecting **Options - DipSwitch Information.**
Displaying the C/CV I/O Table Window

The C/CV I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC.

Unit Settings

Settings for the CS/CJ/CP I/O Table Window

The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC.

Creating an IO Table

Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed when designing a PLC’s IO Table.

To create an IO Table, select Create from the Options menu.

Slot Allocation

The following procedure shows how to edit the I/O table in the I/O Table Window.

1, 2, 3…

1. Right-click the slot where the Unit will be allocated and select Add Unit (or just double-click the desired slot). The Select Unit Dialog Box will be displayed.
2. Select the desired Unit (Unit to be allocated) from the directory tree menu and click the OK Button.

Setting Parameters for CS/CJ/CP-series CPU Bus Units and Special I/O Units

After the I/O table has been created, the I/O table and Special I/O Unit/CPU Bus Unit parameters can be transferred from the PLC and edited in the computer, as shown in the following example.

1, 2, 3…

1. Connect the CX-Programmer online and open the I/O Table Window.
2. Select Options – Transfer from the PLC from the I/O Table Window’s menu. The Transfer from the PLC Dialog Box will be displayed. At this point, the I/O Table and SIO Unit Parameters Options can be selected.
3. Select the options (check the boxes) for the data that you want to transfer and click the Transfer Button. In this case, both options have been selected. The I/O table and Unit parameters data will be transferred from the PLC and the transfer results will be displayed.
4. Check the transfer results and click the OK Button. The I/O table transferred from the PLC will be displayed.
5. To edit the parameters of a Special I/O Unit or CPU Bus Unit, select the Unit and either double-click the Unit or select Edit – SIO Unit Parameters from the menu. The selected Unit’s Edit Parameters Dialog Box will be displayed.
In this case, a Controller Link Unit’s Edit Parameters Dialog Box has been displayed to edit the Unit’s CPU Bus Unit Allocation DM Settings.

6. Edit the parameters and, if necessary, click the Compare Button. If the Compare Button is clicked while the PLC is online, the software immediately checks whether the I/O table settings match the Unit settings (such as the allocated DM area and CIO area) actually in the PLC’s CPU Unit. If the contents do not match, the settings read from the actual Unit will be displayed in orange.

7. When you want to download the parameters set for each Unit to the PLC’s CPU Unit, click the Download to Unit Button.

8. Click the Reset Button to enable the parameter settings that have been transferred.

**Note 1:** When Special I/O Unit or CPU Bus Unit settings are edited in the I/O Table Window, the parameters allocated in the DM Area or CPU Bus Unit Setup Area for the Unit are only transferred to the actual PLC when the Transfer PC to Unit Button is clicked in the Edit Parameters Dialog Box. They are not automatically enabled, i.e., the new parameter settings will not be used. Click the Reset Button to enable the parameter settings that have been transferred. When the Reset Button is clicked, however, unexpected operation may result. Always confirm system safety before clicking the Reset Button.

**Note 2:** When the CX-Programmer creates the Special I/O Unit or CPU Bus Unit settings in the I/O Table Window, it automatically uses the latest version of the CPS file that is available in the computer.

- If the actual Unit’s version number is older than the latest CPS file in the computer, a warning will be displayed when the settings are downloaded to the Unit. A Dialog Box will ask whether to change the computer’s settings. In general, click the Yes Button to change the computer’s settings. When the Yes Button is clicked, the Unit version in the computer’s Unit settings will be changed to the actual Unit’s version number. (If the No Button is clicked, the version number in the computer will be newer than the actual Unit’s version number, and the newer version number will be displayed.)

- Similarly, if the actual Unit’s version number is newer than the latest CPS file in the computer when the Unit’s settings are transferred from the PLC to the computer, the computer’s earlier Unit version number will be displayed. In this case, install the Unit’s correct (newer) CPS file in the computer. For details, refer to **Installing a CPS File** below. If the newer CPS File is not installed, the newer version’s Unit settings cannot be set and only the older Unit settings (in the older CPS file) can be set.
Note 3: Storing the Parameter Settings Data File

- The data set in the Edit Parameters Dialog Box can be saved in a parameter settings file with a .xml filename extension. To save the parameter settings, right-click the desired Special I/O Unit or CPU Bus Unit in the I/O table and select Save Parameters from the pop-up menu.

- The saved parameter settings can also be read from a parameter settings file (.xml filename extension), but the settings must be for the same model Special I/O Unit or CPU Bus Unit.

Note 4: Contents of Parameter Settings Data Files

The structure of a parameter settings data file is based on the parameter settings in the CPS file. Parameter settings data files contain the following data:

- Model number, Unit version number, unit number, rack number, and slot number
- Name of the original CPS file used to create the parameter settings data
- Parameter names and data

Note 5: When Special I/O Unit or CPU Unit settings are performed in the I/O Table Window and then transferred from the PLC Memory Window, the following warning will be displayed if the allocated DM Area/CIO Area addresses set for Special I/O Units or CPU Bus Units in the I/O Table Window on the computer overlap with the PLC data table addresses.

Unless the CPU Bus Unit or Special I/O Unit settings have been previously transferred to the CPU Unit and the allocated DM Area/CIO Area data in the PLC data table for Special I/O Units or CPU Bus Units is to be overwritten, always click the No Button, shift the address, and repeat the transfer procedure.

Note 6: CPU Bus Unit and Special I/O Unit settings are not checked for logical consistency. Be very careful of the logical consisting of the overall settings when making any setting that affects other settings, e.g., settings that enable or disable other settings. Transfer the Special I/O Unit or CPU Bus Unit settings to the PLC and then start operation, being aware that any logical inconsistencies may produce unexpected operation. For example, if one setting selects either user settings or default settings and is set to use the default settings, it will not automatically change to enable user settings even if the related user settings are made. To use the user settings, they will have to be enabled manually and specifically in the setting that selects either user settings or default settings.

Note 7: If Create I/O Table is selected when setting Special I/O Units or CPU Bus Units in the I/O Table Window, the settings in the Special I/O Units or CPU Bus Units on the computer will be initialized. To maintain the same settings, save the Special I/O Unit or CPU Bus Unit settings to a file by right-clicking the Unit in the I/O table and selecting Save Parameters from the pop-up menu. Then, after creating the I/O tables, read the settings back from the file by right-clicking the Unit in the I/O table and selecting Load Parameters from the pop-up menu.

Installing a CPS File

CPS files are automatically installed in the following directory when CX-One or CX-Programmer is installed. A CPS file is created for each unit version of each Special I/O Unit and CPU Bus Unit.

Program Files\Common Files\Omron\Profiles\CPSFiles

The CX-Programmer uses the CPS File for the most recent unit version. If a backup indicates that a newer unit version exists, the newer version’s CPS file must be installed. Use the following procedure to install the new CPU File.

1. Select File – CPS Install. The Installation of Cps files Dialog Box will be displayed.
2. Specify the CPS file to be installed.
3. Restart the CX-Programmer.

Printing the I/O Table or Unit Parameter Settings
The following procedure explains how to print the I/O table or a parameter list of Special I/O Unit and CPU Bus Unit settings.

1. Select the desired Special I/O Unit or CPU Bus Unit in the I/O table and select `File – Print` from the pop-up menu. The Print Dialog Box will be displayed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O Table</td>
<td>Prints the I/O table.</td>
</tr>
<tr>
<td>Special Unit Settings</td>
<td>Prints a parameter list of the Special I/O Unit or CPU Bus Unit settings.</td>
</tr>
<tr>
<td>I/O Table + Special Unit Settings</td>
<td>Prints the I/O table and a parameter list of the Special I/O Unit or CPU Bus Unit settings.</td>
</tr>
</tbody>
</table>

2. Select the desired print option and click the OK Button. The Print Dialog Box will be displayed.
3. To preview a print job, select `File – Print Preview`, select the desired print option in the Print Dialog Box, and click the OK Button.

**Note:**
When making parameter settings for a Special I/O Unit or CPU Bus Unit in the I/O Table Window and transferring data from the PLC Memory Window, a warning will be displayed if the addresses in the transferred PLC data file overlap the allocated DM Area or allocated CIO Area addresses set for the Special I/O Unit or CPU Bus Unit in the computer’s I/O Table Window.
Always click the No Button if you do not want to overwrite the actual PLC’s (CPU Unit’s) allocated DM Area or allocated CIO Area address data with the PLC data table data after the Unit settings data has been transferred to the PLC (CPU Unit). After cancelling the write operation, remove the PLC data table’s allocated DM/allocated CIO area from the areas that will be transferred and then transfer the data again.

Settings for the C/CV Series I/O Table Window
The C/CV Series I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC.

Creating an IO Table
Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed when designing a PLC’s IO Table.

To create an IO Table, Select `Create` from the `Options` menu.

Slot Allocation
Use the following procedure to allocate a unit to a slot.

1. Select an empty slot in the IO Table component.
2. Click the right-mouse button and select a unit. For Single and Multiple IO Units a secondary selection is required from the right-mouse button menu. The type of PLC series and individual rack configurations determine the units that can be installed and therefore the content of the right-mouse button menu. The types of unit that can be selected are described in following paragraphs.
Slots can also be allocated by transferring the rack information from the PLC. Refer to *IO Table Component* in this chapter for information regarding transferring IO Table information from the PLC.

For CS/CJ/CP series PLCs, the IO fields for racks, slots and units information can be edited directly in the IO Table tree.

Only those units in the Registered IO Table for CS/CJ/CP series PLCs, C200H (including C200HS/X/G/E) PLCs and CV/CVM1-series PLCs can be edited.

**Note:** Any slots allocated must be verified to ensure that the Real IO Table has been setup up correctly.

**Single and Multiple Units**

Points with an IO Type of Input, Output or Input/Output can be applied to the IO Table component. Each point contains a name and an address indicating its position in PLC memory. The information contained within a point can be read or updated by the controlling system and its status and content stored in the system’s database. An application accesses this point data by establishing a link between the application and the database. A point can have the same address as another and any comment entered against this address applies to all points at that location.

All PLC series support 8-point, 16-point, 32-point and 64-point Units. CV-series PLCs and CS/CJ/CP-series PLCs also support 128-point and 256-point Units.

Refer to the Run Time manual for an introduction to points.

**Counters, Position Controller, Numerical Control and ASCII Units**

Use the following procedure to apply unit settings to Counters, Position Controllers, Numerical Control and ASCII units.

1, 2, 3…

1. Allocate a slot to be a Counter unit, Position Controller unit, Numerical Control unit or ASCII unit. The Enter SIOU Details dialog is displayed.

2. Enter valid settings for the *Unit Number* field, *Address per Unit* field, *Input Words* field and *Output Words* field. Valid settings exclude those settings that have already been used.

3. Select the **OK** pushbutton to complete the operation or the **Cancel** pushbutton to abort the operation.

Additionally for Counters, Numerical Control and ASCII units, for CV-series PLCs and CS/CJ/CP-series PLCs, the CIO and DM Address range need to be specified; refer to *Chapter 3 - Software Switches* for further information.

**Interrupt Units**

Interrupt units are automatically assigned until the maximum number of units has been reached.

**Sysmac-Bus Master Unit and Remote Terminals**

If the *Sysmac-Bus Master* option is selected from the context menu, the hierarchy in the IO Table component can be further expanded to expose the Remote Terminals and IO Terminals that form part of the SYSMAC-BUS option. Use the following procedure to apply unit settings to Sysmac-Bus Master.

1, 2, 3…

1. Allocate a slot to be a Sysmac-Bus Master unit. The Enter RM Number dialog is displayed.

2. Select a unit number from the *Unit Number* field, either 0 or 1.

3. Select the **OK** pushbutton to complete the operation or the **Cancel** pushbutton to abort the operation.

The Sysmac-Bus Master unit provides two types of slave units that can be applied to the slave rack in the same manner as a normal rack:

- **C500H Remote Terminal (RT);**
- **C200H Remote Terminal (RT).**

Any units on the slave racks or other Remote IO Units connected to the master are allocated IO words according to the slot where the master is located.

For C1000H and C2000H PLCs, Word multipliers are required to set the base address of IO Terminals on each SYSMAC-BUS Remote Master.
SIOU/Communications Units

SIOU/Communications Units can only be set up for CV-series PLCs and CS/CJ/CP series PLCs.

For CV-series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can be performed:

♦ Basic (Software Switches setup only);
♦ DeviceNet Master (Software Switches setup only);
♦ Controller Link;
♦ Ethernet;
♦ Host Link;
♦ ISA Board Unit (Software Switches setup only);
♦ ME-Net (Software Switches setup only);
♦ Mini-map (Software Switches setup only);
♦ M-Net (Software Switches setup only);
♦ Motion Controller (Software Switches setup only);
♦ PC (Software Switches setup only);
♦ Syslink;
♦ Sysmac-Bus Master;
♦ SysNet.

For CS/CJ series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can be performed:

♦ Controller Link Unit;
♦ Device Net and Open Network controllers;
♦ Ethernet Unit;
♦ Serial Communications Unit (Software Switches setup only).

Most of the settings for SIOU/Communications Units should have been set via the PLC setup component. Refer to Chapter 4 - PLC Setup Component for further details.

Refer to Chapter 3 - Unit Setup and Software Switches for further information.

Caution: Setup to SIOUs that have already been registered should be applied carefully.

Verifying Correct Configuration

If a change is made to the IO configuration that affects a type of IO word or the number of words required by a unit, for instance adding or removing units, an IO verification error occurs. Select Verify from the Options menu to ensure that an IO verification error has not occurred. If an error has occurred, use the procedures explained in Chapter 3 - Creating an IO Table, Chapter 3 - Slot Allocation and Chapter 3 - Transfer an IO Table to rectify any error.

Unit Setup

The Unit Setup for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs only. For C-series PLCs, refer to Chapter 8 - CX-Net Network Configuration Tool. Use the following procedure to edit the Unit Setup.

1. Highlight the rack/unit in the IO Table tree.
2. Click the right-mouse button and select Unit Setup.
3. Set the required unit setup options for the specified rack/unit.

Note: The availability of the Unit Setup option depends on the rack/unit selected. The SIOUs attached to a PLC are shown in the IO Table component.

The PLC Communications Unit Setup dialog allows both the system and software switch memory areas associated with a mounted Special Input/Output unit (SIOU) to be configured.
Software Switches

The Software Switch settings for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs. For CV-series PLCs, the Software Switch settings appear in the IO Table tree as SIOU Units. For CS/CJ/CP series PLCs, the Software Switch settings appear in the IO Table tree as part of the Main Rack information.

The dialog which is presented for software switch setup depends upon the type of the SIOU and allows the software switch memory area associated with a mounted SIOU to be configured. Software switches provide status information on each SIO unit on the PLC.

**Note:** It is also possible to edit the Inner Board software switches for the CS/CJ series PLC if fitted by selecting Inner Board Software Switches option from the PLC’s context menu.

The Software Switch dialog is displayed allowing the network unit system memory area to be configured and transferred to the PLC. Software switches can be defined for the following:

- **SYSMAC LINK.** Allows set up of Data Link (on/off) and Internode Test (on/off) and setting of response monitor time;
- **SYSMAC NET.** Allows set up of Data Link (on/off) and Internode Test; (on/off);
- **Ethernet.** Allows set up of Internode Test (on/off) and setting of response monitor time.
- **Controller Link.** Allows the polling status of the node to be set (whether it is a polling or polled unit) and whether to clear the Controller Link unit EPROM.

Use the following procedure to edit the Software Switch Setup.

1. Highlight the rack/unit in the IO Table tree.
2. Click the right-mouse button and select **Software Switches**.
3. Set the required software switch setup options for the specified rack/unit.

**General**

The General tab of the Software Switches dialog provides the complete software switches settings for a Basic unit, PC unit, Mini-map unit, Host Link unit, Motion Control unit, ME-Net unit, DeviceNet Master unit and ISO Baud unit. It also serves as partial software switches settings for other units.

1. Access the Software Switch dialog for an appropriate rack/unit.
2. Set the required CIO and DM area address in the **CIO Address** field and **DM Address** field.

**Data Link Area**

The Data Link tab is used to control whether Data Link is generated automatically or by a specific Data Link table for SYSMAC LINK, SYSMAC NET and Controller Link. This setup is only used if the Node Type is Master. The list box at the bottom of the chapter is only used when Data Link is set to one of the automatic options (i.e. not specific).

1. Select **Transfer from PLC** from the Options menu to transfer the current system area settings from the unit.
2. Select the required unit and click the right-mouse button. Select the **Software Switches** setting.
3. Adjust the settings as required.
4. Select **Transfer to PLC** from the Options menu to transfer the network parameters to the unit.
5. Select the **Reset Unit** setting to restart the unit - the written settings are activated in the unit.

**Note:** If the unit which is being set is the one on which the current communication to the PLC is being made, the PLC needs to be closed and opened before communications can continue.

**Ethernet**

The Ethernet setup differs from SYSMAC LINK, SYSMAC NET and Controller Link by not having a Data Link Area setup and by having two further dialog boxes, the IP Address Table and IP Router Table. This particular interface requires that each device attached to the network has an IP address, and that routing information for directing data across the network is also included (where necessary); such address information ensures that data is transmitted correctly between two nodes.
PART 2: CX-Server PLC Tools
CHAPTER 3 – IO Table Component

Note: Table information is only used if the IP Address Conv. Method radio button is not set to Auto.

The File Transfer Protocol (FTP) allows access to a file card on the PLC. If a FTP login name and password are entered then these are used to start an FTP session. For more information, refer to the Ethernet User’s Manual.

The IP Address Table dialog allows the IP address of a network node to be entered.

1. Select the Ethernet Unit from the IO Table and click the right-mouse button.
2. Select the Unit Setup option.
3. Click on the Insert pushbutton.
4. Enter the IP Address for the node in the IP Address field; each of the four fields must take a value in the range 0 to 255.
5. Select the OK pushbutton to proceed.
6. Click on the Delete pushbutton to remove the address from the table.
7. Select Transfer from PLC from the Options menu to write the changes back to the table.

The IP Router Table establishes communications between different networks by maintaining the IP address for each interface and is created by clicking on the Insert pushbutton above the IP Router table dialog. Procedures are the same as for the IP Address Table described above.

Syslink Unit and Controller Link Specific Settings
A Syslink unit Software Switches dialog includes a General tab and Data Link tab described previously.

The Error Information tab provides read-only information regarding the errors that the PLC can detect and raise an error flag.

The Network Status tab provides network status information. It also activates the PLC to perform internode tests. Select the Start option to set the PLC to check for errors and report them. Select the Stop option to stop the PLC from detecting errors. The Network Node List field lists the network nodes and whether they are participating in the network operations.

Sysmac-Bus2 Unit Specific Settings
A Sysmac-Bus2 unit Software Switches dialog includes a General tab described previously.

The Slave tab provides specific status information to the Sysmac-Bus2 unit. There are various types of slave that may be connected to a Remote IO Master unit. These slaves include IO Terminals, Programmable Displays and Remote IO Slave units.

To view the slaves connected for a group, select the Group required from the field at the top of the Slaves tab. The remainder of the Slaves tab displays the Node and Status for each category.

If the hierarchy of the IO Table has been expanded, the three groups can be populated with other units:
- Group 1. 16-point and 32-point IO units.
- Group 2. 16-point, 32-point, 64-point and 128-point IO units and 256-point dummy.

Serial Communications Unit Specific Settings
Serial Communications unit specific software switches settings can only be set for CS/CJ/CP series PLCs.

A Serial Communications unit Software Switches dialog includes a General tab described previously.

The Port 1 tab and Port 2 tab are identical. Settings can be specified for the Format field, Mode field and Hardware field.

Displaying Unit Error Log in the IO Table
By selecting a CPU Bus Unit or Special IO Unit in the IO table tree and clicking the right mouse button to select the Unit Error Log Menu, the error log for the selected Unit can be displayed (CX-Programmer Ver. 4.0 or later).
IO Table Management

Changes made to an IO Table can be done by simply editing particular fields in the table. Basic information can be changed by displaying the configuration, selecting the rack or unit that needs to be changed and editing or selecting the new IO address or configuration information.

All slot allocations in the IO Table can be cleared. Select Clear from the Options menu.

An IO Table unit in the PLC’s Registered IO Table in the PLC can be deleted. Use the following procedure to delete an IO Table Unit.

1, 2, 3...
1. Highlight the rack/unit in the IO Table to be deleted.
2. Click the right-mouse button and select Delete.

The CX-Server IO Table component can be examined to determine if it has a valid configuration. To check an IO Table, select the Check option from the Options menu. A message is displayed indicating whether the operation was successful or not.

The CX-Server IO Table component can compare the local IO Table on the PC with the CX-Server project settings and displays any differences or errors. Select the Compare with Project option from the Options menu.

PC to PLC Communications

The IO Table component permits the transferring of data to and from the PLC and allows comparisons to be made between data stored on the PC and the PLC.

Note: If the CX-Programmer is Ver. 6.0 or later and the PLC is a CS/CJ/CP-series PLC, the Special I/O Unit and CPU Bus Unit parameter settings can be transferred as well as the I/O table.

Transfer an IO Table from a PLC

The Transfer from PLC option loads the Registered Table into the CX-Server IO Table, replacing the currently displayed setup. The IO Table can also be part of a general transfer which may, for example, include transferring program and memory data from the PLC. Use the following procedure to transfer an IO Table from the PLC.

1, 2, 3...
1. Ensure the PLC is online before activating the IO Table component.
2. Select Transfer from PLC from the Options menu to transfer an IO Table from the PLC.

The IO Table component is refreshed with the details from the PLC.

Note: If only I/O Table is selected and only the I/O tables are uploaded from the actual PLC to the computer, the settings in the Special I/O Units or CPU Bus Units on the computer will be initialized. To maintain the same settings, save the Special I/O Unit or CPU Bus Unit settings to a file by right-clicking the Unit in the I/O table and selecting Save Parameters from the pop-up menu. Then, after uploading the I/O tables, read the settings back from the file by right-clicking the Unit in the I/O table and selecting Load Parameters from the pop-up menu.

Transfer an IO Table to a PLC

The Transfer to PLC option loads the CX-Server IO Table into the Registered Table: this is only available to C2000, CV and CS1-series PLCs. The table can be transferred to the PLC at any time (when the PLC is online) but the operation can be delayed until other configuration settings have been made and then the complete configuration can be transferred to the PLC via the PLC Setup component. Use the following procedure to transfer an IO Table to the PLC.

1, 2, 3...
1. Ensure the PLC is online before activating the IO Table component.
2. Select Transfer to PLC from the Options menu to transfer an IO Table to the PLC.

Note: If the PLC Setup area is either written to the PLC or to the IO Table area the PLC may need to be powered down and powered up in order for settings take effect. If the settings need to be changed without switching off the PLC, write the PLC Setup data first, then either generate or write the IO Table. Refer to Chapter 4 - PLC Setup Component.
Comparing an IO Table
The Registered IO Table can be compared with the CX-Server IO Table and displays any differences. This option is helpful to confirm that a table that has been set up in CX-Server and has been transferred to the PLC, agrees with how the hardware is set up. Use the following procedure to compare a Registered IO Table with the CX-Server IO Table.

1. Ensure the PLC is online before activating the IO Table component.
2. Select Compare with PLC from the Options menu.

Any differences (if any) are displayed in the IO Table component.

Starting Specialized Support Tools
Starting Specialized Programming Support Tools (Supported When Support Tools Were Installed from CX-One)
When the CX-Programmer and other Programming Support Tools have been installed from the CX-One, the Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) can be started directly from the CS/CJ/CP I/O Table Window by right-clicking the desired Unit in the I/O table and selecting Start Special Application from the pop-up menu.

♦ If the Unit is right-clicked in the I/O table and Start Special Application - Start with Settings Inherited is selected, the PLC model information, Unit model, and online/offline status information will be passed to the Programming Support Tool automatically when it starts.

♦ If the Unit is right-clicked in the I/O table and Start Special Application - Start Only is selected, the Programming Support Tool will be started in the same way as it is from the Windows Start Menu.

The following diagram shows how each Programming Tool can be started and how the I/O Table Window can be opened from the Programming Tool.
Note: With some of the Programming Tools (CX-Integrator, CX-Protocol, and CX-Process Tool), the I/O Table Window can be opened from the Programming Tool as shown by the dotted lines above, but only when the PLC is online.
PLC Specific Features

A number of features specific to types of PLC are described in the following paragraphs.

Hot Swapping

Hot swapping is permitted for C1000H/C2000H PLCs and allows modules to be changed without having to power down. The modules swapped must be identical. To Hot Swap, select the Hot Swap option from the Options menu.

Note: With a CS1D or CVM1D CPU Unit, hot swapping (i.e., online replacement) is possible during operation for Basic I/O Units and, for the CS1D, Special I/O Units and CPU Bus Units as well. Open the I/O tables for the project, select the Unit to be replaced, and select Hot Swap from the Options menu. Click the Start Hot Swap button, remove the old Unit, mount the new Unit and click the End Hot Swap button. Perform this operation for each Unit to be replaced.

Note: Online replacement is possible for a CS1D or CVM1D CPU Unit in any operating mode.

Use the following settings in the Change PLC dialog box.

<table>
<thead>
<tr>
<th>CPU Unit being used</th>
<th>PLC type selection list</th>
<th>CPU Unit model</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS1D</td>
<td>CS1H-H</td>
<td>CPU65 or CPU67</td>
</tr>
<tr>
<td>CVM1D</td>
<td>CVM1-V2</td>
<td>CPU21</td>
</tr>
</tbody>
</table>
Setting Rack Start Addresses

This option is only available to CV-series PLCs and CS1-series PLCs. Use the following procedure to set Rack Start Addresses.

1, 2, 3…
1. Select **Rack Start Addresses** from the **Option** menu. The Rack Start Addresses dialog box is displayed.
2. Enter the addresses for each rack as required. Select the **OK** pushbutton to accept the settings or select the **Cancel** pushbutton to abort the operation.

**Note:**
1. For CS1-H, CJ1-H, CJ1M, and CS1D CPU Units in the CS- and CJ-series PLCs, select **Options | Rack/Slot Start Address** and the following dialog box will appear.

![Select Start Addresses Type Dialog Box](image)

**Note:**
2. Select **Slot Start Address Settings** and click the **OK** button. The Slot Start Addresses Settings dialog box shown below will appear.

![Slot Start Addresses Settings Dialog Box](image)

**Note:**
3. The start address for a Rack and slot number can be specified. This can be used, for example, to allocate fixed addresses to Input Units and Output Units. Note: The start address information set for Racks and slots can be downloaded and uploaded for the CPU Unit.

4. For CS/CJ-series CPU Unit Ver. 2.0 or later with CX-Programmer Ver. 4.0 or later, up to 64 sets of rack/slot numbers and start addresses can be set.

Units Profile Information

For CS1-series PLCs, SIOU’s, CPU SIOU’s and other units, unit manufacturing information can be retrieved, the data read and comments saved against each unit to a Compact Flash disk when fitted. Use the following procedure to view the unit manufacturing details:

1, 2, 3…
1. Highlight the PLC name and click the right-mouse button.
2. Select **Unit Manufacturing Information** and then either **CPU Unit** or **Inner Board**

**Note:** An error is displayed if the unit does not support manufacturing information. The unit version for CS/CJ/CP-series Units can be checked in the **Unit Manufacturing Information** (CX-Programmer Ver.4.0 or later only).
CHAPTER 4
PLC Setup Component

This chapter describes the PLC Setup component and the procedures involved in changing a PLC’s settings both offline and online.

The PLC Setup component allows the PLC settings to be entered for individual C-series PLCs, CV-series PLCs or CS1 PLCs. More than one PLC Setup component can be opened at any one time allowing a number of PLCs to be configured simultaneously.

Once a PLC has been defined in a project in terms of name, device type and network type, changing various settings allows the PLC behavior to be altered. Options can also be selected to check the PLC is functioning correctly.

The tabbed PLC settings component shows only options available for the selected PLC. Some options will be greyed out in instances where they are not applicable to the PLCs current state.

The status bar displays the PLC and CPU type and the operational mode of the PLC.

Note: When configuring a PLC it is advisable to have the PLC operational manual available for reference. A warning is displayed before any changes are made to a PLC’s current state. This gives the option of cancelling the procedure.

Note: The information provided in this chapter is not definitive because of the wide variety of PLCs and their differing nature - even within the same PLC series. Consult the relevant PLC operating manual for specific PLC settings information.

The PLC Setup component can be forced to stay as the top window by selecting the Always on top option from the Options menu.

For Moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help.

Access to the PLC Setup component is from the invoking application and also via the CX-Net Network Configuration Tool, refer to Chapter 8 - CX-Net Network Configuration Tool for further information.

To close the PLC Setup dialog, select the Close button in the title bar.

CS/CJ/CP-Series PLC Settings

The following paragraphs describe the features of the PLC Setup component associated with CS/CJ/CP-series PLCs. Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the PLC.

The common Set Default option resets PLC Setup component values to the default settings.

PLC Startup

The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take effect on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC Startup tab.

Startup Hold

The Hold area in the PLC’s Work Area Memory retains the status when either the operating mode is changed, power is interrupted or the PLC operation is stopped. You can select one or all the following options for the hold area to retain.

1. Force Status Hold Bit - Specifies that the status of the forced status hold bit is to be maintained (ticked) or reset to OFF when power is next turned on.
2. IOM Hold Bit - Specifies that the status of the IOM hold bit is to be maintained (ticked) or reset to OFF when power is next turned on.

Mode

This selects the default PLC operation mode when the PLC is powered on:

Program - Select this for online programming when the PLC is powered on.
Monitor - Select this to start monitoring the running program when the PLC is powered on.

Run - Select this to run the PLC’s program when the PLC is powered on.

Use Programming Console - This is the default setting that allows you to select the operating mode when online.

In addition to the above, the following settings are available for CJ1-H, CS1-H, and CP1H PLCs.

Execution Settings

For the CJ1-H, CS1-H, and CP1H PLCs series PLCs set the Execution Setting options as appropriate.

1, 2, 3…
1. Run program when initialize unit/board. Check the tick box to select this option.
2. Service for units when Inner Board recognition. Check the tick box to select this option.

Settings

The Settings tab of the PLC Setup component allows execution processes and controls to be defined and EM allocation to be enabled.

Note: For CS1-H, CJ1-H, and CP1H PLCs only, this tab is called CPU Settings.

Execute Process

Use the following procedure to apply Execute Process settings.

1, 2, 3…
1. Low Battery Enabled - Select (tick) this option to flag when CPU Unit battery errors are detected.
2. Interrupt Task Enabled - When this option is selected interrupt task errors will be detected.
3. Stop CPU Error Enabled - Select this option to determine if instruction errors (instruction processing errors (ER) and illegal access errors (AER)) are to treated as non-fatal or fatal errors.
4. Don’t register FAL to error log - Select this option (tick) to stop registering FAL to error log.

Memory Allocation

CS/CJ-series PLCs can select either Memory Card or EM (Expansion Memory) specified file area. Each time EM is selected, the EM is reformatted automatically.

To use EM rather than Memory Card, select the EM File Setting enabled setting and enter the EM Start File No.

CS/CJ-series PLCs can use EM as file memory, either as or as well as Compact Flash disk. When transferred to the PLC, EM is formatted.

In addition to the above, the following settings are also available for CJ2, CJ1-H, and CS1-H PLCs.

Note: With a CJ2 CPU Unit, select PLC - Memory Allocation - EM Memory Settings from the menus to set EM file memory.

Background Execution

1, 2, 3…
1. Table data process instructions. Check the tick box enable Table date process instructions.
2. String data process instructions - Select (tick) this option to enable String data process instructions.
3. Data shift process instructions - Select (tick) this option to enable Data shift process instructions.
4. Com port number - Enter a number between 1 and 7 inclusive, to set the Com port you wish to connect by.

Caution: Entering a com port number higher than the number of ports actually available will prevent future connections to that PLC.

Timings

The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event timings to be defined. Use the following procedure when applying settings in the PLC Timings tab for standard CS/CJ/CP-series PLCs. When setting the timings for other PLC types follow the on-screen instructions.
1. Check the *Watch Cycle Time* setting and set the watch cycle time if enabled for the PLC; the default is 0 ms.
2. Deselect the *Set Time to all Events* setting to enter a time period for all event processes; this is entered as a percentage of the total cycle time.
3. Check the *Power Off Interrupt* setting, and set if enabled for the PLC; the default is 0 ms.
4. Set the *Cycle Time* setting to define the time interval for cycles.
5. Set the *Scheduled Interrupt Interval* setting to schedule interrupts to occur at regular intervals; either every 10 ms or a specific value can be set.

**SIOU Refresh**

The *SIOU Refresh* tab of the PLC Setup component allows SIOU Status to be enabled. Check the required *Enable SIOU Status* setting for each SIOU in the field.

**Unit Settings**

The *Unit Settings* tab of the PLC Setup component allows timings for the individual rack slots associated with the PLC to be set. Select the required slot(s) from the rack field and the required unit setting; the default is 8 ms.

**Host Link Port**

The *Host Link Port* tab of the PLC Setup component defines the protocol which allows transferring data between the PLC and the host PC. The default settings may be used or an alternative communications protocol defined. Some of the options may not be applicable depending on the device type selected. Use the following procedure to apply settings in the *Host Link Port* tab.

1. The *Port Settings* default is 9,600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. Customised port settings can be entered by deselecting the *Default* setting.
2. Select the *CTS Control* setting to enable use of CTS.
3. Set the *Unit Number* setting for the selected PLC.
4. Set the *Delay* value; a pre-set transmission delay in the range 0000 to 9999 (for BCD this is in 10 ms units).

The following entries cannot be amended:

- **Link Words.** These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315).
- **Start Code and End Code.** The message start and end codes.
- **NT Link Max.**

**Peripheral Port**

The *Peripheral Port* tab of the PLC Setup component defines the connection between the PC and PLC. The default settings may be used or an alternative communications protocol defined. Use the following procedure to apply settings in the *Peripheral Port* tab.

1. The *Port Settings* default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. Customised port settings can be entered by deselecting the *Default* setting.
2. Set the *Unit Number* setting for the selected PLC.

The *NT Link Max* setting cannot be amended.

**Peripheral Service**

Note that this tab is only available for the CS1-H and CJ1-H PLCs (CS1G-H, CS1H-H, CJ1G-H and CJ1H-H).

The tabbed dialog is split into three sections as follows:

**Sync/Async Comms**

*Execution Mode* - The default for this option is *Not Specified*, and as such means that all other parts are disabled except for *Set time to all events*.

Select one option from the list to set the execution mode. Choosing *Not Specified* will disable all the options within the Peripheral Service dialog, except for 'Set time to all events'. *Not Specified* is the only way of setting the Peripheral Service Execution Time to zero.
If Peripheral Service is chosen, editing Peripheral Service Execution Time is possible, and the system sets the default to 0.1. See also Instruction Processing (Peripheral Service Execution Time).

Specifying Asynchronous will disable the same options as Not Specified, and set the Execution mode to Asynchronous processing. Synchronous likewise sets the Execution Mode to Synchronous processing.

**Peripheral Service Mode**

*Instruction Execution Time* - A value within and including the range of 5 to 255 or 0 can be entered as a valid setting.

*Peripheral Service Execution Time* - A value within and including 0.1 to 25.5 can be entered as a valid setting. For more information on when this option is available, see Sync/Async Comms, Execution Mode, above.

*Target Unit (1, 2, 3, 4, 5) and SIOU* - The default for this setting is Not Specified. There are five possible options for this setting. After Not Specified, the next option is CPU SIOU. If this option is selected, the SIOU number should be entered in the box to the right marked 'SIOU'. The next option is SIOU, and likewise with the CPU SIOU option, the SIOU number should be entered in the box to the right marked 'SIOU'. The three remaining options allow either the Inner Board, Host Link Port or Peripheral Port to be set as the 'Target Unit'.

**Set time to all events**

*Set time to all events (default 4%)* - By ticking the checkbox, the default as stated above will be set. If the checkbox is not ticked, then a value between 0 and 255 inclusive can be entered, making a maximum setting of 25.5 (255 *0.1). This option is found in the Timings tab for all other CS/CJ-series PLCs.

**Duplex Settings**

The Duplex Setting tab is activated by selecting the Duplex Settings option from the PLC Settings Options menu.

![PLC Settings NewPLC1](image)

With this option checked, use the Tabs scroll buttons to scroll to the right and click on the Duplex Settings tab to bring it to the front. The options in this dialog can now be set to provide the appropriate communications setup within the selected Communications Units. The dialog is divided into five sections as follows:

**Note:** The Duplex Setting tab is available for CS1H-H 65 & 67 PLCs but is only applicable to the CS1D series PLCs.

**Operation Settings**

*Run under Duplex Initial* – This option should be selected if it is required to run two Units in parallel with Duplex Initial execution. Note that this setting only takes effect at startup or at the start of an operation. It cannot be changed during an operation.

*Return Automatically* – Select this option when it is required to execute a process that returns to Duplex Operation automatically.

**Communications Unit Duplex Setting**

From the list of Communications Units select those that are to be run in duplex mode. If more than one Unit is set to duplex mode the options selected will be applied to each Unit. It is not possible to set different options for different Communications Units. To execute the Communication Duplex operation an IO table must be created or transferred. Note that this setting only takes effect at startup or at the start of an operation. It cannot be changed during an operation.

**Hot Swap**

*Allow Plural Units* - Selecting this option enables Units operating in Parallel or Duplex mode to be replaced while online. The Units, which can be exchanged while online are, Basic IO Units, SIOUs, and CPU SIOUs of the CS-Series PLCs. Note that this option can be selected while online.
STB Serial Settings

*Allow STB-COMM* – Selecting this option will enable the Host Link Port of the Standby CPU. This option should not be selected if it is required to continue with communications when changing from Duplex operation to Standby operation.

CPU Unit Duplex Transfer Settings

*Transfer Program* – This option should be selected if it is required to skip the Transferring Program area at Duplex Initial operation after exchanging CPU units, (Verify will be executed). If programs can be matched beforehand, use this setting to reduce the Duplex Initial Operation time.

*EM Division Transmission* – This option should be selected when it is required to transfer Duplex Initial data in specified EM sizes. If the option is not selected the complete EM area will be transferred at once. Note that this may cause the cycle time to be expanded for a short time.

*Division Size* – If the EM Division Transmission option has been selected the value entered for the division size will determine the size of the EM area to transfer. Note that this setting only takes effect at startup or at the start of an operation. It cannot be changed during an operation.

*Transfer Parameter Area of Inner board* – Select this option when it is required to transfer the Parameter Area of the inner board between Units.

*Transfer Variable Area of Inner board* – Select this option when it is required to transfer the Variable Area of the inner board between Units.

Saving the PLC Setup to a CSV File (CJ2 CPU Units Only)

The values set in the PLC Setup in all of the tab pages can be saved in CSV file format. CSV files are convenient for operations such as creating specification sheets, because they can be edited using commercially available applications.

**Note:** Once data has been saved as a CSV file, it cannot be read again by the CX-Programmer.

1. In the PLC Setup Window, select *Save To CSV File* from the File Menu.

2. Click the *Save* Button. The CSV file will be saved.
CV-Series PLC Settings

The following paragraphs describe the features of the PLC Setup component associated with CV-series PLCs. Refer to *Chapter 4 - PC to PLC Communications* for details of transferring PLC setup information to and from the PLC.

The common Set Default option resets PLC Setup component values to the default settings.

PLC Startup

The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always takes effect on startup (until they are explicitly altered). Some of the options may not be applicable depending on the device type selected. Use the following procedure to apply settings in the PLC Startup tab.

1. The status of the Force Status Hold setting, IOM Hold Bit setting and Restart Continuation Bit setting in the Startup Hold area of the PLC’s Work Area memory can be set so that they are either maintained or reset to OFF on power up.
2. When power is restored after an interruption, the IO Bits setting and Power-On Status setting must be selected and the PLC startup mode must be set to Run or Monitor.
3. Set the Mode setting to either Program, Monitor, Run, Debug or Use Programming Console. The default mode is Program.
4. Set the Display Mode setting. The 7-segment display of the IO Interface units, IO Control unit and SYSMAC BUS/2 Remote IO Slave units can be set to one of three modes. The mode is indicated by the position of the decimal point.
   - Mode 1. Displays the first IO word allocated to the rack (000 indicates an error). This is the default mode.
   - Mode 2. Displays the CPU operating status (A or -) and error status (E, F or -), peripheral connection and rack number.
   - Mode 3. Displays a 4-character message when the IODP (189) instruction is executed in the unit’s program.
5. Check the Automatically Transfer User Program setting to automatically transfer the user program from one of the PLCs memory cards when the PLC starts-up.
6. Check the Display modes at startup setting to display all selected modes on startup.

Error Log

The Error Log tab permits certain settings to be applied to error logging. Either Data Memory (DM) or Extended Memory (EM) areas can be selected to hold the PLC’s Error Log. Refer to *Chapter 6 - PLC Error Component* for a description of the Error Log. Use the following procedure to apply settings in the Error Log tab.

1. Check the Enable Error Log setting to enable error logging. If this is not selected, the default log auxiliary memory is assigned.
2. Enter the Start Address setting for the error log. This is only enabled if the Enable Error Log setting has been selected.
3. Enter the EM Bank Number setting if the Error Log is to be stored on an installed Extended Memory Card. The Start Address setting needs to be set to the relevant area of EM. This is only enabled if the Enable Error Log setting has been selected.
4. Enter the Number of Records setting for the number of records to be held in the PLC Error component.

**Note:** An Error Log in the Auxiliary Area (words A100-A199 for CV1000) can contain up to 20 error records. To increase the size of the log (to 2047 records), move it to either the DM or EM areas.

Execution Controls

Instructions can be executed and peripheral servicing performed by either using:

- Event driven (asynchronous) processing mode. The peripheral servicing process interrupts the execution process cycle by sending IO refresh requests.
- Synchronised processing mode. The execution and peripheral servicing processes wait for each other to complete the task in hand.
Consult the PLC operational manual for details when defining the execution controls. Use the following procedure to apply settings in the Execution Controls tab.

1, 2, 3…

1. An operand can be indirectly addressed via the DM area in either Binary or BCD. Select the Binary setting or the BCD setting as required.
2. Set the Step Timer setting for the SFC step instructions. The default is 0.1 s.

Note: For CV1000, CV2000 and CVM1/CPU21-EV2 PLCs, EM can be used for indirect addressing of an operand.

Note: The Step Timer setting is not available to CVM1 PLCs.

**Execution Controls 1**

Use the following procedure to apply settings.

1, 2, 3…

1. Check the Measure CPU-Bus Unit Cycle setting for the CPU to measure the service cycle.
2. Check the Detect Low Battery setting to flag PLC and Memory Card low battery.
3. Check the CPU standby on initialisation of bus units setting to ensure the CPU remains in standby until SYSMAC BUS/2 terminators are detected. If this is not checked, PLC operation begins regardless of the presence of terminators.
4. Check the Error on power off interrupts setting to ignore a momentary power interruption (and not generate an error) or leave unchecked to generate an error on power off.

**Execution Controls 2**

Check the following settings as required.

- The Duplication action error setting.
- The Multiple JMP000 use setting.
- The Run program on IO verify error setting.
- The Startup trace setting.
- The Nest IO interrupts setting.
- The IO Interrupt setting.

**Host Link Port**

The Host Link Port tab of the PLC Setup component defines the protocol which allows transferring data between the PLC and the host PC. The default settings may be used or an alternative communications protocol defined.

Use the following procedure to apply settings in the Host Link Port tab.

1, 2, 3…

1. The Port Settings default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity.
2. Select a Unit Number setting for the Host Link port setting. This has a maximum value of 31.

**IO Refresh**

The IO Refresh tab of the PLC Setup component allows the specification of refreshes and their definition as either timed or immediate refreshes. Some of the options may not be applicable depending on the device type selected. Use the following procedure to apply settings in the IO Refresh tab.

1, 2, 3…

1. Check the Zero-cross setting to ensure output devices accurately switch on/off high power devices when minimum current is flowing (when the AC power supply crosses zero).
2. Check the Cyclic setting to generate a cyclic refresh at the end of program execution.
3. Check the Scheduled setting to specify a time interval between interrupt refreshes. This is in the range 0 ms to 120 ms.
4. Check the Immediate Refresh setting to allow program instructions to be set to interrupt for immediate refreshing. The Scheduled refresh setting must be set to 00 ms.

Note: Scheduled refreshing is not available if the PLC is set for synchronous operation.
Address Enable

The Address Enable tab of the PLC Setup component allows addresses to be entered for selected local racks. Some of the options may not be applicable depending on the device type selected. Use the following procedure to apply settings in the Address Enable tab.

1. Enter an address for each required Local rack setting. The first word can be set between 0 and 511. Word allocations must not overlap. The default for the CPU rack is zero. If word allocations overlap, they are ignored and the address returns to zero. Racks selected without a designated first word is allocated words automatically beginning from CIO 0000.

2. Enter the Group 1 and Group 2 values. This is the first word between CIO 0000 and CIO 0999 for each SYSMAC BUS/2 Group 1 and 2 Masters.

3. Enter the Group 3 values. These are the first word for each SYSMAC BUS/2 Group 3 Slave between CIO 0000 and CIO 0999 for each SYSMAC BUS/2 Group 1 and 2 Masters and the first word for each SYSMAC BUS/2 Slave rack between CIO 0000 and CIO 2555.

4. Enter the RT Terminals, SIOU and IO terminals addresses as required.

Note: Each group (Group 1, 2 and 3) has pre-set values assigned as a default. Group 1 and Group 2 supports 32 and 16 IO units respectively. Group 3 is reserved for racks and supports eight racks, each of which supports eleven slots.

PLC Timings

The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event times to be set. Use the following procedure to apply settings in the PLC Timings tab.

1. Check the Watch Cycle Time setting and set the watch cycle time if enabled for the PLC; the default is 1000 ms.

2. Check the Power Off Interrupt setting, and set if enabled for the PLC; the default is 0 ms.

3. Set the Cycle Time setting to define the time interval for cycles.

4. Set the Scheduled Interrupt Interval setting to schedule interrupts to occur at regular intervals; either every 10 ms or a specific value can be set.

Hold

The Hold tab of the PLC Setup component allows the Hold area of the PLC’s Work Area memory to be defined. Use the following procedure to apply settings in the Hold tab.

1. Check the Enable Hold Area setting to enable the Hold area and select its Start and End Address settings.

2. Check the required racks from the CPU field.

3. Check the required Sysbus/2 remote master from the Sysbus/2 Remote Master field.

4. Check the required Sysbus remote master from the Sysbus Remote Master field.

C-Series PLC Settings

The following paragraphs describe the features of the PLC Setup component associated with C-series PLCs. Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the PLC.

The common Set Default option resets PLC Setup component values to the default settings.

PLC Startup

The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take effect on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC Startup tab.

Mode

This option selects the default PLC operation mode when the PLC is powered on.

1. Program – Select this for online programming when the PLC is powered on.

2. Monitor – Select this to start monitoring the running program when the PLC is powered on.

3. Run – Select this to run the PLC’s program when the PLC is powered on.
4. Pre-Powerdown mode – In this mode the PLC uses the operating mode last used before the power was turned off.

5. Use Programming Console – This is the default setting that allows you to select the operating mode when online.

**SIOU**

The SIOU Area DM settings are highly PLC specific and are dependent upon PLC selected and the SIOU mode. Refer to the online help for detailed information.

**IOM**

This option specifies that the status of the IOM hold bit is to be reset to OFF (ticked) or maintained when power is next turned on.

**Forced Status**

This option specifies that the status of the forced status hold bit is to be reset to OFF (ticked) or maintained when power is next turned on.

**Console Language**

Select the Console language to either English or Japanese as appropriate (CPM1/1A only).

**Expansion Instructions**

Set to either Default or User Settings. This option is only available for SRM1, CPM2* PLCs.

**CompoBus/S Devices (CPM2*-S*)**

Select the Maximum number of CompoBus and S Devices to either 16 or 32.

**Communications Mode (CPM2*-S*)**

Sets the communications mode to either High-Speed or Long-distance.

**Memory Error on Capacitor Failure**

Select this option if a memory error on capacitor failure is to be recorded.

### Cycle Time

The **Cycle Time** tab of the PLC Setup component allows the total cycle time for the CPU unit to be defined. This period is the time taken to complete monitoring, program execution and IO port servicing. Use the following procedure to apply settings in the **Cycle Time** tab.

1. **Cycle Monitor Time** setting. This option sets the time allowed for the CPU unit to cycle through the types of operations indicated above. If it is exceeded, an error is generated and the CPU unit is stopped.

2. **Cycle Time** setting. Use this option to define a minimum cycle time by selecting a time period in the range 1 to 9,999 ms. The default is Variable (with the CPU calculating the cycle time in each cycle).

3. **Servicing Time** setting. This option allows the percentage of the defined cycle time which can be used to service a port to be set. It can be set for the Peripheral Port, RS232C Port, Comms Port A and Comms Port B.

**Note:** The **Cycle Time** setting is ignored if the **Cycle Monitor Time** setting is longer and vice versa (provided a minimum time has been defined). The CPU unit waits until the longer of the two time periods has elapsed before starting the next cycle.

### Interrupt/Refresh

The **Interrupt/Refresh** tab of the PLC Setup component allows certain PLCs to interrupt the main program by input and scheduled interrupts in order to call a subroutine. Use the following procedure to apply settings in the **Interrupt/Refresh** tab.

1. **Interrupt Response** - Set the interrupt mode to High Speed to interrupt immediately or to Normal to wait for the current process to complete.
2. **SIOU Refresh** setting - This option must be set to *Disable Refresh* when the **Interrupt Response** setting is set to *High Speed* (if the *Disable Refresh* setting has been set and the **Interrupt Response** is set to *Normal*, the *Disable Refresh* setting is ignored).

3. **Schedule Interrupt Unit** setting - These are interrupts for which you can select regular intervals of either a fixed 10 ms duration or Set in increments of 1 ms.

4. **SIOU Cyclic Refresh** setting - Set the **SIOU Cyclic Refresh** setting if required. An SIOU Cyclic Refresh Unit(s) must be specified if an SIOU refresh setting has been made.

The CQM1 PLCs support input and scheduled interrupts to stop the main program to run a subroutine. The following Interrupt/Refresh options are available with the CQM1H.

5. **Interrupt Enable** – This option allows you to set the various IR value interrupts to either: Normal (default), Interrupt or Quick.

6. **Input Constant** - This option allows you to set the input constant of IR000 Bits. Select the value in milliseconds as appropriate.

7. **Pulse Output 0/1 Unit** – Set the output pulse 0 and 1 to either Relative or Absolute.

### Port Settings
The **Peripheral Port, Comms Board A, Comms Board B** and **Host Link Port** tabs of the PLC Setup component defines the settings for the connection between the PC and PLC. The default settings may be used or an alternative communications protocol defined. Use the following procedure to apply settings.

1. The **Port Settings** are set to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. Customised port settings can be entered by deselecting the **Default** setting. The **Mode** setting can be set to one of the following connection types:
   - **PC.**
   - **Hostlink 1 to n.** Multiple PLC RS422/485 connections to the PC.
   - **RS232C.** Single PLC RS232 connection to a printer or from a reader.
   - **1-to-1 Link Slave.** Sets PLC as slave in an RS232 PLC to PLC connection.
   - **1-to-1 Link Master.** Sets PLC as master in an RS232 PLC to PLC connection.
   - **NT Link 1:1.** For using NT link commands in an RS232 PLC to PT (Programmable Terminal) connection.
   - **NT Link 1:n.** For using NT link commands in an PLC to RS422/485 multi-PT connection.
   - **Protocol Macro 1:1.** Single PLC RS232 to device connection.
   - **Protocol Macro 1:n.** PLC to RS422/485 multi-device connections.

2. Select the **CTS Control** setting to enable use of the CTS line on the PLC.

3. Set the **Unit Number** setting for the selected PLC.

4. Set the **Delay** setting; a pre-set transmission delay in the range 0000 to 9999 (for BCD this is in 10ms units).

The following entries cannot be amended:
   - **Link Words.** These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315).
   - **Start Code** and **End Code.** The message start and end codes.
   - **NT Link Max.**

### Error Settings
The **Error Settings** tab of the PLC Setup component defaults to the detection and reporting of long cycle times, interrupt errors and low battery condition. Use the following procedure to apply settings in the **Error Settings** tab.

1. **Cycle Time** - Check the Do not detect long cycles option to stop detection and reporting of long cycles.

2. **Styles** - Check the Do not store records option if records are not to be stored.

3. **Battery** - Check the Do not detect low battery option if low battery condition is not to be reported on.
High Speed Counters
The CQM1H-CTB41 high-speed counter board is an Inner Board applicable to units CPU51 and CPU61. A maximum of two boards can be mounted simultaneously in slots 1 & 2 of the PLC. The high-speed counter board counts high-speed pulses from 50 to 500 kHz entering through ports 1 to 4. It performs tasks according to the number of pulses counted.

When the present value of the high-speed counter matches a specified target value or lies within a specified range, the bit pattern specified in the comparison table is stored in internal output bits and external output bits. A bit pattern can be set for each comparison result and the external output bits can be output through an external output terminal.

Up to four external outputs can be produced when either the target value is matched or a range comparison condition is satisfied. The high-speed counter board does not provide high-speed counter interrupts, it simply compares the present value to target values or comparison ranges and produces internal and external bit outputs.

CPM1/CPM1A PLCs have a high-speed counter function that can be used in incrementing mode or up/down mode. The high-speed counter can be combined with input interrupts to perform target value control or zone comparison control that is not affected by the PLCs cycle time. High-speed counter signals can be input to CPU bits 00000 through 00002. In incrementing mode, input 00001 can be used as a regular input.

High Speed Counter/Synchronised Pulse Control
Select the appropriate option to determine the parameters of the high speed counter. If the option ‘Don’t use either function’ is selected the counter is disabled and the Counter Reset and Counter Mode option are disabled.

Counter Reset
Select the counter reset mode of operation, either Z phase and software reset or Software reset only.

Counter Mode
Select the appropriate option to determine the counters mode of operation.

Device Net
I/O Link Refresh Area
Note: This tab is only available for the CPM2*-S* PLCs.

1. Standard - Select this button to set the standard/default settings for the I/O Refresh Area.
2. Custom - Select this button to make your own settings.
3. Write: These setting are the same as Read, but without the option of selecting the 'AR' memory area.
   ♦ Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area.
   ♦ Address - This is the beginning address number.
   ♦ Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or vice versa. Any custom setting's maximum value is determined by what the Area and Address values before it were set to. For example, if IR area 1 is selected, and the maximum address is specified (in this case max = 49), then the maximum size is 1. (The size value is specified in Words).
4. Read: These setting are the same as Write, but with the additional option of being able to selecting the 'AR' memory area for reading.
   ♦ Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area.
   ♦ Address - This is the beginning address number.
   ♦ Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or vice versa. Any custom setting's maximum value is determined by what the Area and Address values before it were set to. For example, if IR area 1 is selected, and the maximum address is specified (in this case max = 49), then the maximum size is 1. (The size value is specified in Words).
PLC Status
These options determine the status of the PLC.

*Append PLC Status on top of IN data* - Select this button to Append PLC Status on top of IN data, or choose 'Do not append PLC Status'.

*Do not append PLC Status* - Select this button to not append PLC Status on top of IN data, or choose 'Append PLC Status on top of IN data'.

PC to PLC Communications
The PLC Setup component permits the transferring of data to and from the PLC and allows comparisons to be made between data stored on the PC and the PLC.

Uploading PLC Settings
The *Transfer from PLC* option loads the settings from the PLC into the PLC Setup component. Use the following procedure to upload PLC settings.

1. Ensure the PLC is online before activating the PLC Setup component.
2. Select *Transfer from PLC* from the *Options* menu. A confirmatory dialog is displayed.

The PLC Setup component is refreshed with the details from the PLC.

Downloading PLC Settings
The *Transfer to PLC* option loads the settings to the PLC. Use the following procedure to download an IO Table.

1. Ensure the PLC is online before activating the PLC Setup component.
2. Select *Transfer to PLC* from the *Options* menu. A confirmatory dialog is displayed.

Comparing PLC Settings
The *Verify* option compares the settings on the PLC with those on the PLC. This option is helpful to confirm that a table that has been set up in CX-Server and has been downloaded to the PLC, agrees with how the hardware is set up. Use the following procedure to compare PLC settings.

1. Ensure the PLC is online before activating the IO Table component.
2. Select *Verify* from the *Options* menu.

Any differences (if any) are displayed in the PLC Setup component.
CHAPTER 5
Data Trace/Time Chart Monitor Component

This chapter describes the Data Trace/Time Chart Monitor component and its ability to display either the PLCs uploaded data trace buffer or monitored data obtained from the PLC’s memory areas during program execution.

Data held in a PLC’s memory areas can be monitored and traced during program execution. When displayed, this information provides a valuable tool for analysing the program’s performance.

The Data Trace/Time Chart Monitor component has two separate modes of operation:

♦ **Data Trace.** The PLC can be configured to trace a number of channels and bits and can sample these when a trigger condition is activated. When the PLC trace buffer is full or the user stops the trace, the trace buffer can be uploaded and viewed – the trace however, is complete. Values do not change on the screen, all sampling is achieved in the PLC and displayed when finished.

  **Note:** This functionality is not supported for CP1E CPU Units.

♦ **Time Chart Monitor.** A number of channels and bits can be configured and monitored online. The changing values are displayed in the monitoring view as either a trend graph or histogram. A trigger condition can also be set which resets the sampled amount of data. Monitoring continues until stopped by the user.

![Data Trace/Time Chart Monitor Component](image)

With the CX-Programmer version 6.0 and later versions, data collected by the Data Trace and Time Chart Monitor functions can be saved in standard CSV files (with .csv filename extension). The data saved in standard CSV files can be analysed and printed in programs such as Microsoft Excel.

The status bar provides instant help, the PLC and CPU type, the current operating mode of the PLC and the status of the Data Trace/Time Chart Monitor component.

The Toolbar and status bar can both be turned on or off. Select **Status Bar** from the **View** menu to control the display of the status bar. Select **Toolbar** from the **View** menu to control the display of the Data Trace/Time Chart Monitor toolbar.

The Data Trace/Time Chart Monitor component can be forced to stay as the top window by selecting the **Always on top** option from the **Options** menu.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help.

Access to the Data Trace/Time Chart Monitor dialog is from the invoking application.

To close the Data Trace/Time Chart Monitor dialog, select the **Close** button in the title bar.

**Continuous Trace function for CJ2 CPU Units Only**

Saving the result of Data Trace to a personal computer enables continuous and long operation on CJ2 CPU Unit. CPU Unit reads the status of specified bit or the present value of specified channel according to the sampling conditions and save it to Trace Memory in CPU Unit. CX-Programmer reads the data stored in CPU Unit and display it on the monitor in Time Chart format. CX-Programmer continues to partially read the contents of Trace Memory and display them on the monitor till Trace Memory on CPU Unit becomes full. Collecting the data of longer period is possible.
Note: Setting trigger conditions is not possible on the Data Trace of continuous and long operation.

Types of Data Trace Window
CX-Programmer Ver.8.0 or later have two types of Data Trace window as follows.

1) The Data Trace window for CS/CJ/CP (hereinafter referred to as “Data Trace window for CS/CJ/CP).
2) The Data Trace window of the previous version (Ver.7.2 or before) (hereinafter referred to as “Data Trace window for C/CV”).

The Conditions of Automatic Selection
PLC Model automatically selects the type of Data Trace window and Data Trace starts.

<table>
<thead>
<tr>
<th>PLC Series</th>
<th>PLC Model</th>
<th>Type of Data Trace window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series</td>
<td>Other than the above</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CP Series: CP1E</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CVM1/CV Series: CVM1, CVM1-V2, CV1000, CV2000, CV500</td>
<td></td>
</tr>
</tbody>
</table>

The Functions of Data Trace Window
The functions of two types of Data Trace window are as follows.

<table>
<thead>
<tr>
<th>Type of Data Trace window</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Data Trace window for</td>
<td>• Including 2ch data and 4ch data, Trace is executable on all data</td>
</tr>
<tr>
<td>CX/CJ/CP</td>
<td>types (of CJ2 CPU only).</td>
</tr>
<tr>
<td></td>
<td>• Continuous Trace is executable (CJ2 CPU only)</td>
</tr>
<tr>
<td></td>
<td>• Enlarge rate and offset is settable per Trace Object.</td>
</tr>
<tr>
<td></td>
<td>• Print of Trace result, Save in CSV format and Bit Map format</td>
</tr>
<tr>
<td></td>
<td>• Import/ Export of Trace Settings is possible.</td>
</tr>
<tr>
<td></td>
<td>• Enlarged view of the selected area with mouse is possible to display.</td>
</tr>
<tr>
<td>2) Data Trace window for</td>
<td>• Trace with or without code of 1ch data and 2ch data and Trace in</td>
</tr>
<tr>
<td>C/CV</td>
<td>Hexadecimal are possible.</td>
</tr>
<tr>
<td></td>
<td>• Saving the Trace result in CSV format is possible.</td>
</tr>
</tbody>
</table>

Sampling Ranges
The following paragraphs discuss sampling ranges specific to PLC series.

CS/CJ/CP-series PLC Sampling Range (Except for CJ2 CPU Units)
The CS/CJ-series PLC can trace a maximum of 31 bits and 6 words and performs data tracing using one of the following methods:

♦ Setting a timer interval. The trace can be performed in increments of 5ms during a 5-2550 ms cycle. To sample data only once each cycle, set the interval to 0 ms.
♦ Including the TRSM (170) instruction in the PLC’s program. This instruction identifies the points in program execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’.

Note: The buffer for Data Trace is 4K words.
The CJ2 CPU Unit PLC can trace a maximum of 31 bits and 16 words and performs data tracing using one of the following methods:

♦ **Setting a timer interval.** The trace can be performed in increments of 1ms during a 1-2550 ms cycle. To sample data only once each cycle, set the interval to 0 ms.

♦ **Including the TRSM (170) instruction in the PLC’s program.** This instruction identifies the points in program execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’.

**Note:** The buffer for Data Trace is 32K, 16K, or 8K words depending on model.

The CV-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the following methods:

♦ **Setting a timer interval.** The trace can be performed in increments of 5 ms during a 5-2550 ms cycle.

♦ **Including the TRSM(170) instruction in the PLC’s program.** This instruction identifies the points in program execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’.

The C-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the following methods:

♦ **Setting a timer interval.** A Data Trace can be performed at regular, independent intervals by setting a timer interval from the peripheral device.

♦ **Including the TRSM(45) instruction in the PLC’s program.** This instruction identifies the points in program execution where specified data is to be stored in Trace Memory.

**Note:** Data Tracing cannot be performed from a Programming Console.
For CS/CJ/CP-series

Trace

**Parameter Settings of Data Trace for CS/CJ/CP**

Following is the Parameter setting method of Data Trace for CS/CJ/CP.

**Display [Data Trace Configuration] dialog box.**

1. Select [Data Trace] from [PLC] menu on main window (in the case that Data Trace Window is already open and Time Chart Monitor is selected, [Operation][Mode][Data Trace]).
2. Select [Operation][Settings] on Data Trace window.
   [Data Trace Configuration] dialog box will appear as follows.

   ![Data Trace Configuration dialog box]

   **Table:**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Import]</td>
<td>For reuse of the parameters of Data Trace used in the past.</td>
</tr>
<tr>
<td>[Export]</td>
<td>Save the parameters of the present Data Trace in a file (*.csv).</td>
</tr>
<tr>
<td>[Transfer (PC to PLC)]</td>
<td>Write parameters of Data Trace to PLC and execute the trace. When [Start Executing Automatically After Download] is checked, Write is enabled.</td>
</tr>
<tr>
<td>[Transfer (PLC to PC)]</td>
<td>Click on to read parameters of Data Trace already set in PLC. Use for Re-executing Data Trace under the same setting conditions.</td>
</tr>
<tr>
<td>[Compare]</td>
<td>Compare parameters of Data Trace set in PC and PLC.</td>
</tr>
<tr>
<td>[OK]</td>
<td>End Parameter Edit. Use for finishing Edit without starting Data Trace.</td>
</tr>
<tr>
<td>[Cancel]</td>
<td>Delete Parameters of Data Trace after Edid.</td>
</tr>
</tbody>
</table>

3. Click on the items to be set.
4. Click on [Transfer(PC to PLC)] or [OK] after all settings are done.

The setting details of each tab will be discussed later.
Settings on [Settings] tab

Set operation conditions of Data Trace. Select [Settings] Tab on [Data Trace Configuration] dialog box.

**Data Trace Configuration**

- **Trace Type**
  - [Trace]
  - [Trace(Continuous)]

- **Sampling Setting**
  - [Fixed Interval] 100 ms (1-2550ms in 1ms increments)
  - [Once Per Cycle]
  - [Once Per Synchronous Operation Cycle]
  - [On TRSM Instruction]

- **Trace Setting**
  - **Trigger**
    - Manual Trigger
  - **Left Operand**
  - **Edge**
    - [Browse]
    - [Falling Edge]
  - **Delay (No. of Trace Samples)**
    - 0
  - **Auto Repeat**
  - **No. of Trace Execution**
  - **No. of Trace Samples** 1333

- **Start Executing Automatically After Transfer (PC To PLC)**
- **Trace Start on Monitor/Run Mode**

### Item | Function
--- | ---
**[Trace Type]** | Select Data Trace type. The above screen displays the settings when [Trace] is selected. +Please refer to “Settings of Continuous Data Trace” for the settings when [Trace(Continuous)] is selected.

**[Sampling Settings]** | Select sampling conditions of Data Trace. [Fixed Interval] Sample with fixed interval. Set sampling cycle in milliseconds. I/O data per sampling cycle will be sampled. [Once Per Cycle] 1 Sample per scan. I/O data will be sampled after END instruction is executed. [Once Per Synchronous Operation Cycle] 1 Sample per synchronous operation cycle. I/O data will be sampled after END instruction of synchronous operation cycle is executed. [On TRSM Instruction] Sample when TRSM Instruction is executed. I/O data at TRSM Instruction will be sampled.

**[Trigger Settings]** | [Left Operand] Input Symbol or the address to be trigger object. Select data type from Combobox. 1ch data, 2ch data and 4ch data can be set on CJ2 CPU. 1ch data can be set on PLC of CS/CJ/CP Series other than CJ2 CPU.
- [Browse] Search trigger object from Symbol Table.
<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Trigger Settings]</td>
<td>Select the conditions of Trigger completion.</td>
</tr>
<tr>
<td>[Formula]</td>
<td>When [Left Operand] is a bit (data type is BOOL).</td>
</tr>
<tr>
<td></td>
<td>↑ Falling Edge</td>
</tr>
<tr>
<td></td>
<td>↓ Rising Edge</td>
</tr>
<tr>
<td></td>
<td>[Left Operand] is other than the above:</td>
</tr>
<tr>
<td></td>
<td>= Equal</td>
</tr>
<tr>
<td></td>
<td>≠ Not equal *1</td>
</tr>
<tr>
<td></td>
<td>&lt; Less than~ *1</td>
</tr>
<tr>
<td></td>
<td>&gt; More than~ *1</td>
</tr>
<tr>
<td></td>
<td>≤ Maximum *1</td>
</tr>
<tr>
<td></td>
<td>≥ Minimum *1</td>
</tr>
<tr>
<td>[Right Operand]</td>
<td>Input the value to be Trigger. Input is enabled when [Left Operand] is</td>
</tr>
<tr>
<td></td>
<td>other than a bit (data type is except for BOOL).</td>
</tr>
<tr>
<td>[Delay]</td>
<td>Input delay value in sample number. Input in slider is possible.</td>
</tr>
<tr>
<td>[No. of Trace Samples]</td>
<td>When using all trace memory CPU Unit is not necessary, input sampling</td>
</tr>
<tr>
<td></td>
<td>number to be traced. Time per trace execution time will be shorter. *1</td>
</tr>
<tr>
<td>[Auto Repeat] Check, Box</td>
<td>Check the box when executing trace on auto repeat under the same</td>
</tr>
<tr>
<td></td>
<td>conditions.</td>
</tr>
<tr>
<td>[No. of Trace Execution]</td>
<td>Input the number of trace to be executed repeatedly. When [Auto Repeat]</td>
</tr>
<tr>
<td></td>
<td>check box is checked, input is enabled.</td>
</tr>
<tr>
<td>[Trace Start on Monitor/Run Mode] Check Box</td>
<td>Start trace automatically at the timing when PLC mode changes to Monitor mode, or Run Mode (includes Power on). *1</td>
</tr>
<tr>
<td>[Trace Start Executing Automatically After Download] Check Box</td>
<td>Check the box when starting Data Trace automatically after transferring the execution conditions of Data Trace to PLC.</td>
</tr>
</tbody>
</table>

*1: Settable Only on CJ2 CPU.
Setting on [Trace Object] Tab

Set trace object.

1. Select [Trace Object] tab on [Data Trace Configuration] dialog box.
   The following screen will appear.

2. Input trace object. The methods of trace object input are the three of the following. Input trace object with the combination of 1ch data, 2ch data, 4ch data, and bit.

<table>
<thead>
<tr>
<th>Input methods</th>
<th>Details</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>[Insert] on right click menu [Insert] button on tool bar</td>
<td>Input symbol or address. Input is possible with search from Symbol Table.</td>
</tr>
<tr>
<td>Paste</td>
<td>[Paste] on right click menu. [Paste] on tool bar [Ctrl]+[V] key</td>
<td>Copy and paste from Symbol Table, Ladder View or Watch Window. Multiple trace objects can be inserted at the same time.</td>
</tr>
<tr>
<td>Drag &amp; Drop</td>
<td>Select the object for trace, right click on it and hold the click for drag. Drag and drop it to trace object tab.</td>
<td>Drag can be done from Symbol Table or Ladder View. Multiple trace objects can be inserted at the same time.</td>
</tr>
</tbody>
</table>

3. Select data type of trace object.
   **Note:** Click on [↑] or [↓] on tool bar to change the order of trace object. Trace result will be displayed in order of the setting of trace objects.
   **Note:** Select the trace object and [Delete] on right click menu to delete trace object or click on [Delete] on tool bar or press [Del] key.

**Execute Data Trace with Data Trace Window for CS/CJ/CP**

Operation procedure of Data Trace will be discussed.

Setting parameters is necessary prior to Data Trace execution.
Data Trace Execution

1. Select [Operation] [Operation] on Data Trace Window. (Or click on )
   Trigger can be completed with [Execute] [Trigger] (or ).
2. When Data Trace starts and trigger conditions are completed, sampling will start. Trace data will be saved to trace memory of CPU Unit.
   When trace memory is full, sampling automatically stops. Trace data will be read from trace memory of CPU Unit. Data trace screen will be displayed in Data Trace window.
3. When stopping Data Trace before trace memory is full, select [Operation] [Stop] (Or click on ).
   When Data Trace is interrupted, select [Operation] [Read] (Or click on ). Data Trace screen will appear.

Operation of Data Trace Window for CS/CJ/CP

Following is the operation procedure of Data Trace.

- Check on [Show] of the data to be shown on [Legend View] tab. Uncheck will be Hide.
  - Check on [Select] of [Legend View] or click on a graph. Trace data is selected.
    - Graph tool bar will appear to the selected data. Move up and down (offset change), scale in and out (scale change) and input of graph show units are possible with tool bar operation.
    - Move up and down (offset change) is possible with dragging a graph directly.
  - Select [Trace Settings] tab to check trace settings.
  - Select [Properties] tab to refer to trace properties.
  - Right click on trace screen and select [Copy to Clipboard]. Paste the graph screen to the paint and so on is possible.
  - Right click on trace screen and select [Save to Bitmap]. Save as a bit map file is possible.
Trace (Continuous)

Parameter Settings of Continuous Data Trace

The following is the procedure for Parameter settings of long and continuous Data Trace.

Show [Data Trace Configuration] dialog box.

1. Select [Data Trace] from [PLC] menu on main window. (when Data Trace window is already open and Time Chart Monitor is selected, select [Operation] [Mode] [Data Trace])
2. Select [Operation] [Settings] on Data Trace window.
   [Data Trace Configuration] dialog box will appear as follows.

```
Refer to “Parameter Settings of Data Trace for CS/CJ/CP” for the functions of the buttons located at the bottom.
3. Click on the tab of items to be set.
4. Click on [Transfer (PC to PLC)] or [OK] after all settings are done.
   The setting details of each tab are described hereinafter.
```
Settings on [Settings] Tab

Set execution conditions of continuous Data Trace. Select [Settings] tab on [Data Trace Configuration] dialog box.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Trace Type]</td>
<td>Select [Trace (Continuous)].</td>
</tr>
<tr>
<td>[Sampling Setting]</td>
<td>Select sampling conditions of Data Trace.</td>
</tr>
<tr>
<td></td>
<td>[Fixed Interval] Operate sampling with fixed interval. Sampling cycle is set in millisecond increments. I/O data per sampling cycle will be sampled.</td>
</tr>
<tr>
<td></td>
<td>[Once Per Cycle] Sampling per one scan. I/O data will be sampled after END operation is executed.</td>
</tr>
<tr>
<td></td>
<td>[Once Per Synchronous Operation Cycle] 1 Sample per synchronous operation cycle. I/O data will be sampled after END instruction of synchronous operation cycle is executed.</td>
</tr>
<tr>
<td></td>
<td>[On TRSM Instruction] Sampling is performed when TRSM Instruction is executed. I/O data on TRSM Instruction is sampled.</td>
</tr>
<tr>
<td>[Number of Samples]</td>
<td>Set number of samples in obtained data to be saved per file.</td>
</tr>
<tr>
<td>[Maximum Time Span]</td>
<td>Set how long the collected data will be kept in PC. Select the unit from [Minutes], [Hours], and [Date].</td>
</tr>
<tr>
<td>[Folder Path]</td>
<td>Select a folder to save the collected data. The result will be automatically saved to the selected folder with the folder name automatically assigned as “(PLC name) Trace data (Year Month Date)-(Hour).csv”. (See note.)</td>
</tr>
<tr>
<td>[Trace Start on Monitor/Run Mode] Check Box.</td>
<td>Check on the box to start trace automatically at the timing when PLC mode changes to Monitor mode or Run mode (including Power ON).</td>
</tr>
<tr>
<td>[Trace Start Executing Automatically After Download] Check Box.</td>
<td>Check on the box to start logging automatically after transferring execution conditions of logging to PLC.</td>
</tr>
</tbody>
</table>

Note: Under certain conditions, a continuous data trace may not run continuously for the specified maximum time span, especially for long time spans.
Settings on [Trace Object] Tab

Set trace object. The operation procedure is as same as the one on “Parameter Settings of Data Trace for CS/CJ/CP”.

Operations at Executing Continuous Data Trace

Continuous Data Trace enables the following operations in addition to usual trace.

- Performance Monitor screen is displayed. Whether all trace data is obtained or not can be confirmed with the screen. When not all trace data is obtained, the speed at which CPU saves the sampling data to trace memory possibly exceeds the communications speed between PC and PLC. Adjust sampling intervals and the size of trace object accordingly.
- Performance Monitor Screen displays the following items.

<table>
<thead>
<tr>
<th>Items</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>[No. of IDs on CPU]</td>
<td>Show the number which CJ2 CPU Unit sampled.</td>
</tr>
<tr>
<td>[IDs Obtained]</td>
<td>Show the number of sampling data which are collected in PC.</td>
</tr>
<tr>
<td>[Obtained Percentage]</td>
<td>Show the obtained rate of the data collected to PC in percentage.</td>
</tr>
</tbody>
</table>

- When any missing occurs, reduce the number of logging objects or extend the sampling intervals. The missing will be eliminated.

  **Note:** A straight line will be displayed for any data that cannot be obtained.

  **Note:** The size per 1 sampling data is [the size of trace object except for bit data] + 6ch.

  (Adjustment example)
  Obtained percentage is 80%, logging object except for bit data is 10ch, sampling intervals is 10ms:

  1. Adjustment with reducing the number of logging objects: the following formula is applied.

     \[
     \text{[Size per 1 sampling after adjustment]} = \frac{\text{[Size per 1 sampling before adjustment]} \times \text{[Obtained percentage]}}{100}
     \]

     \[
     (10+6) \times 0.8 = 16 \times 0.8 = 12.8 = 12
     \]

     Reducing 4ch trace objects (becoming 6ch as trace objects) makes the obtained percentage 100%.

  2. Adjustment with extending sampling intervals: the following formula is applied.

     \[
     \text{[Sampling cycle after adjustment]} = \frac{\text{[Size of trace object]} + \text{[Size allows sampling in 1ms]} \times \text{[Obtained percentage]}}{\text{[Present sampling cycle]} \times \text{[Obtained percentage]}}
     \]

     \[
     10/0.8 = 12.5 = 13
     \]

     Changing sampling cycle to 13 ms makes the obtained percentage 100%.
Save of the Data Collected from Data Trace Window for CS/CJ/CP

The result data collected from Data Trace or Time Chart Monitor can be saved to a general-purpose CSV file.

Following is the format of CSV file to be saved.

<table>
<thead>
<tr>
<th>File Version</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>PLC Model</td>
<td>OMRON CJ2H-CPU38-BP</td>
<td></td>
</tr>
<tr>
<td>File Content</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PLC Comments</td>
<td>Trace Mode: Data Trace, Date &amp; Time: 10:52:009/5/28, Left Operand Address: A20011, Left Operand Symbol: P, Right Operandum Type: Value, Right Operandum Value: 0, Sampling Type: Once per cycle</td>
<td></td>
</tr>
<tr>
<td>Number Of Trace Object</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Number of Samples</td>
<td>3200</td>
<td></td>
</tr>
<tr>
<td>Trace Start on Monitor/Run Mode</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Delay</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

### Trace Objects

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbol</th>
<th>Data Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>INT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0143.15</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Trace Data

<table>
<thead>
<tr>
<th>Seconds</th>
<th>0</th>
<th>0143.15</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>1</th>
<th>1</th>
<th>1</th>
<th>-32768</th>
<th>-25035</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25036</td>
<td>-25035</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25035</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25034</td>
<td>-25034</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25033</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25032</td>
<td>-25032</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25031</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25030</td>
<td>-25030</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25029</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25028</td>
<td>-25028</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25027</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25026</td>
<td>-25026</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25025</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>0</td>
<td>000000</td>
<td>0</td>
<td>0</td>
<td>-25024</td>
<td>-25024</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>111111</td>
<td>1</td>
<td>-32768</td>
<td>-25023</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Time Chart Monitor

Parameter Settings of Time Chart Monitor for CS/CJ/CP

Parameter settings of Time Chart Monitor for CS/CJ/CP will be discussed.

Display [Time Chart Monitor Configuration] dialog box

1. Select [Time Chart Monitor] from [PLC] menu on main window. (when Data Trace window is already open and Data Trace or logging is selected, select [Operation] [Mode] [Time Chart Monitor])
2. Select [Operation] [Settings] on Data Trace window.
   [Time Chart Monitor Configuration] dialog box will appear as follows.

![Time Chart Configuration dialog box]

Refer to “Parameter Settings of Data Trace for CS/CJ/CP” for the functions of the buttons located at the bottom.

3. Click on the items to be set.
4. Click on [Transfer (PC to PLC)] or [OK] when all settings are done.
   The setting details of each tab are described hereinafter.
Settings on [Settings] Tab
Set the execution conditions of logging. Select [Settings] tab on [Time Chart Monitor Configuration] dialog box.
### Chapter 5 – Data Trace/Time Chart Monitor Component

#### Part 2: CX-Server PLC Tools

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Trace Type]</td>
<td>Select [Trace].</td>
</tr>
</tbody>
</table>
| [Sampling Setting] | Select the sampling conditions of Time Chart Monitor.  
  [Fixed Interval]  
  Sampling with fixed intervals. Set sampling cycle in milliseconds.  
  I/O data per sampling cycle is sampled.  
  [Buffer Size]  
  Operate sampling with the specified sample number. The old sampling data will be destroyed automatically.  
  [Stop When Buffer is Full]  
  Check on the box. Sampling will stop when the set buffer size is reached. |
| [Trigger Setting] | [Left Operand] Input Symbol for trigger object or the address. Select data type from ComboBox.  
  [Browse] Search trigger objects from Symbol Table.  
  [Formula] Select the conditions of trigger completion.  
  [Left Operand] is a bit (data type is BOOL):  
  ↑ Falling Edge  
  ↓ Rising Edge  
  [Left Operand] is other than above:  
  = Equal |
| [Right Operand] | Input the value of trigger. Input is enabled when [Left Operand] is except for a bit (data type is except for BOOL). |
| [Delay] | Input delay value in sample number. Input in slider is possible. |
| [Trace Start Executing Automatically After Download] Check Box | Check on the box to start Time Chart Monitor automatically after transferring the execution conditions of Time Chart Monitor to PLC. |

**Settings on [Trace Object] Tab**

Set the object of Time Chart Monitor. The operation procedure is as same as the one on the previous topic: ”Parameter Settings of Data Trace for CS/CJ/CP”. Refer to settings on [Trace Object] tab on the previous topic.

**Execute Time Chart Monitor with Data Trace Window for CS/CJ/CP**

Execution operation of Time Chart Monitor will be discussed. Parameter settings are necessary prior to executing Time Chart Monitor.

**Operation of Time Chart Monitor**

1. Select [Operation] [Operation] on Data Trace Window (or click on ). Time Chart Monitor screen will appear in Data Trace window.

2. Select [Operation] [Trigger] (or click on ) and trigger completion can be done.

3. Sampling starts when trigger conditions are completed.

4. Select [Operation] [Stop] to stop Time Chart Monitor (click on ).

5. In case that [Sampling] tab [Stop When Buffer is Full] is checked in [Time Chart Monitor Configuration] dialog box, sampling automatically stops when buffer is full and Time Chart Monitor screen stops. Refer to the previous topic: “Parameter Settings of Time Chart Monitor” for [Time Chart Monitor Configuration] dialog box.
Convenient Functions of Data Trace Window for CS/CJ/CP

Show Cursor/Trigger Position

- Select [Option]| [Measure]| [Value] on menu or click on $ on tool bar. The value will be displayed. The value of X axis (time axis) on cursor position will appear at the bottom of graph. The value of Y axis (present value axis) will appear on Legend.

- Change of cursor position is possible with dragging cursor.
  To show the value on the point of the specified time axis, input the value into $ on tool bar and press [Enter] key or click on $ on tool bar.

- Select [Options]| [Measure]| [Difference] on menu or click on $ on tool bar. Measure Difference will appear. Each value on X axis (time axis) of two cursors and the difference value will appear at the bottom of graph. Each value on Y axis (present value axis) and difference value will appear on Legend.

- Dragging each cursor or located on the top of cursor enables to change each cursor position separately.
  Dragging located between two cursors enables to change cursor position while the interval of the two is kept.

- Click on $ on tool bar and the value will appear at trigger position. The value of X axis (time axis) at trigger position will appear at the bottom of graph. The value of Y axis (present value axis) will appear on Legend.

Zoom Select

- Select [View]| [Zoom Select] or click on $ on tool bar. Zoom Select mode will be on. Select the graph area to be enlarged by drag. The selected area only will be displayed on graph area. Only selected view will appear on graph area when more areas to be enlarged are selected by drag. This operation is executable repeatedly.

- Select [View]| [Zoom Unselect] on menu or click on $ on tool bar. The enlarged view after Zoom Select will return to the previous one. To return the status prior to Zoom Select mode, select [View]| [Zoom Fit] or click on $ on tool bar.

For C/CV-series

Setting Monitoring Conditions

The Data Trace or Time Chart Monitor must be activated before the settings can be configured. To select Data Trace or Time Chart Monitoring mode, select the Mode option from the Operation menu followed by either Data Trace or Time Chart Monitor.

Note: The mode of the Data Trace/Time Chart monitor component is identified prior to activation from the invoking application.

The Time Chart Monitor/Data Trace Configuration dialog allows the conditions for the Data Trace or Time Chart Monitor to be set, i.e. specifying the data to be monitored, the intervals at which this is to occur and the trigger conditions.

Use the following procedure to set conditions for the Data Trace or Time Chart Monitor modes.

1. Select the Configure Trace/Time Chart button from the toolbar.
2. Set the trigger condition that causes the data trace to start by selecting a Symbol/Address and Value on the Trigger tab. Use the Browse pushbutton to insert a known symbol from the invoking application. If a bit address is selected, the trigger is based on a falling or rising edge as opposed to a particular value for a word address: the Value field changes to the Edge field.

3. For Time Chart Monitor only, establish the sampling time and Buffer Size on the Sampling tab.

4. Apply a delay value in the Delay field. A negative value in this field advances the start of the trace before the trigger condition by the supplied interval value. A positive value in this field delays the trace after the trigger condition by the supplied value in sampling.

5. Select the Word Addresses field on the Word Addresses tab and/or Bit Addresses on the Bit Addresses tab to be monitored.

6. Once all conditions have been set as required, click the OK pushbutton. Select the Cancel pushbutton to abort the configuration operation.

Use the following procedure to select the Word addresses or Bit addresses. It is possible to set only word addresses, bit addresses, or a mix of both.

1. Select a free area in the Address or Symbol columns with the right-mouse button and click New. The Address Selection dialog is displayed.

2. Insert an address in the Address/Symbol field, or select the Browse pushbutton to locate a symbol from the invoking application.

3. Click the OK pushbutton in the Address Selection dialog to accept the settings or select the Cancel pushbutton to abort the operation. The address or symbol is displayed in the Data Trace Configuration dialog. Multiple addresses or symbols can be applied.

4. To delete an existing address or symbol, select an address or symbol with the right-mouse button and click Delete.

When in the Data Trace mode of operation, the data trace configuration in the PLC can be uploaded and viewed/edited for re-use. Select the Upload pushbutton from the Data Trace Configuration dialog.

Managing the Data Trace/Time Chart Monitor

Use the following functions to manage the Data Trace or Time Chart Monitor.

- Select the Execute button from the toolbar to execute a data trace/time chart monitor.
- Select the Trigger button from the toolbar to set the trigger condition so that execution will end normally.
- Select the Stop button from the toolbar to stop a data trace/time chart monitor.
- Select the Read button from the toolbar to upload the data trace. This may take a few moments; the status of the Read function can be verified by the information supplied in the status bar. The Read button is not used for the Time Chart Monitor mode of operation.
PART 2: CX-Server PLC Tools
CHAPTER 5 – Data Trace/Time Chart Monitor Component

Saving Data Trace Settings
Results data collected by the Data Trace and Time Chart Monitor functions can be saved as special CX-Programmer data files (.cdt filename extension) or standard CSV files (.csv filename extension).

♦ Saving Data in a CX-Programmer Data File
To save the data in a special CX-Programmer data file (.cdt filename extension), select File – Save or File – Save As.

♦ Saving Data in a CSV File
To save the data in a standard CSV file, select File – Save CSV.

Retrieving Data Trace/Time Monitor Settings
Data Traces can be stored on file and retrieved for later analysis. Settings may be retrieved from a project from an invoking application. Select the Open option from the File menu. A standard open window is displayed.

Data Trace/Time Chart Monitoring component files can be retrieved via a standard File Open dialog. Use the following procedure to open a Data Trace/Time Chart Monitoring component file.

1, 2, 3…
1. Select the Open File button from the toolbar to open a Data Trace file.
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by the Open pushbutton. PLC Memory files have a .CDT extension.

Note: It is possible to open a file type that is not applicable to the current mode, e.g. opening a Data Trace file when in Time Chart Mode.

To close a currently open file, select the Close button from the file’s title bar. Recently opened files can be directly selected for opening via the File menu.

Displaying a Data Trace/Time Chart
Once uploaded, the Data Trace/Time Chart Monitor component is populated with the required details.

The top graph illustrates the word addresses or symbols. The bottom graph illustrates the bit addresses or symbols. Each word address is colour coded. The word and bit addresses are listed in the left pane; the splitter bar can be
moved by placing the mouse cursor over the splitter bar and dragging it to its new position to show more or less of the displayed numbers.

The slider position, used to analyze the data returned by the data trace, can be moved by placing the mouse cursor over the graph slider and dragging it to its new position. Both sliders can be moved together by selecting Synchronise Cursors from the View menu. When moving the slider, it snaps to the sampled intervals. Moving and holding the slider left and right scrolls the view window left and right.

The Data Trace/Time Chart Monitor component permits the zooming and scaling of the Data Trace/Time Chart view. Use the following procedure to zoom and scale the Data Trace/Time Chart view.

1. Select the Zoom In button from the toolbar to zoom in on the word graph.
2. Select the Zoom Out button from the toolbar to zoom out from the word graph.
3. Select the Restore Zoom button from the toolbar to return the graph to the original view.
4. Select the Scale In button from the toolbar to zoom in on a particular graph against the vertical axis.
5. Select the Scale Out button from the toolbar to zoom out from a particular graph against the vertical axis.
6. Select the Restore Scale button from the toolbar to return the graph to the original scale.

This can be modified to switch between Histogram and Trend Graph when in Word Display Mode or to switch between Outline and Block when in Bit Display Mode. Use the following procedure to switch display modes.

1. Select the Word Display Mode option or the Bit Display Mode option from the Options menu.
2. For Word Display Mode, select either Histogram or Trend Graph.
3. For Bit Display Mode, select either Block or Outline.

The Word values shown on the screen can be displayed in one of four formats:

- Binary;
- Decimal;
- Signed Decimal;
- Hexadecimal.

Use the following procedure to select a Bit value format.

1. Select Word Value Format from the Options menu.
2. Select either Binary, Decimal, Signed Decimal or Hexadecimal.

The Bit values shown on the screen can be displayed in one of two formats:

- Boolean (1 or 0);
- Text (On or Off).

Use the following procedure to select a Bit value format.

1. Select Bit Value Format from the Options menu.
2. Select either Boolean or Text.

The Data Trace/Time Chart view can be toggled to display either PLC addresses or symbol names. Select the Options menu and then Show Symbol Names. If a symbol name is not available then the PLC address is shown.

The colours associated with the Data Trace/Time Chart view can be customised. Use the following procedure to change the colours on the Data Trace/Time Chart view.

1. Select Colours from the Options menu. The Trace Colour Selection dialog is displayed.
2. Select a Change pushbutton associated with a colour to be applied to a Word or Bit address. A standard Microsoft Windows Colour dialog is displayed.
3. Select a colour from the Colour dialog and click the OK pushbutton. Select the Cancel pushbutton from the Colour dialog to abort the operation.
4. If required, Select a Change pushbutton for another colour and repeat step 3.
5. Select the **Apply** pushbutton from the Trace Colour Selection dialog to apply the change colour settings. Select the **OK** pushbutton to apply the change colour settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

The display of the Data Trace or Time Chart Monitor can be further refined by displaying a grid over the window. Select *Grid* from the *Options* menu to control the display of the grid.

Any symbol names inherited from the invoking application can be displayed on Data Trace or Time Chart Monitor by selecting *Show Symbol Names* from the *Options* menu.

**SYSWIN Data Trace and Time Chart Monitor Files**

SYSWIN 3.x Data Trace Files (*.SDT) and Time Chart monitoring files (*.STC) can be opened directly into CX-Server. Use the following procedure to import these files:

1. Select the **Open** button from the toolbar. The Open dialog is displayed.
2. Select an alternative file type from the Files of Type field, either SYSWIN version 3 Data Trace Files (.SDT) or SYSWIN version 3 Time Chart Monitor Files (.STC).
3. Select a file to open.
4. Select the **Open** pushbutton to import the file. Select the **Cancel** pushbutton to abort the operation.
CHAPTER 6

PLC Error Component

This chapter describes the PLC Error component and its ability to display and clear PLC errors, the PLC Error Log and messages.

The PLC Error component is only available when the PLC is online.

The PLC Error component provides a view of current errors occurring in the PLC’s CPU and allows them to be cleared when the cause of the PLC error has been removed (providing the PLC is in the correct mode). Errors occurring are also written to the PLC Error Log and displayed in the PLC Error component automatically although, if set to Manual Refresh, the error history is only updated when the Refresh button is selected.

Messages are displayed when a user-defined MSG instruction in the ladder program is encountered; these messages may have been defined as part of an error trap or to provide more general information. Messages may also be generated by the system in certain circumstances.

When a number of errors have occurred on the PLC, the most serious error is displayed automatically. For detailed information concerning a PLC error, refer to the relevant PLC manual.

The status bar displays the connected device and PLC mode and the PLC Clock (if one is present and clock monitoring has been enabled from the Options menu).

The Error Log is always available for CV and CS1/CJ1-series PLCs but can be selectively enabled or disabled for C-series PLCs.

The PLC Error component can be forced to stay as the top window by selecting the Settings option from the Options menu and checking the Always on Top setting on the General tab.

Access to the PLC Error component is from the invoking application. If a serious error has occurred, the PLC Error component is displayed automatically.

To close the PLC Errors dialog, select the Close button in the title bar.

Errors

The Errors tab of the PLC Error component displays the current error status of the PLC, when an error is detected in the PLC it is shown with the item identifier, code position, error status level and error details. The icon next to the item number indicates the type of error detected and reflects the error status in the Status column.

Errors may be cleared but this is dependent upon removal of the cause of the error in the PLC and the PLC’s operating mode.

When the PLC is in Program Mode, all errors can be cleared; when in Monitor mode, only the last error can be cleared. It is not always possible to clear an error when the PLC is in Run mode; in this instance, a dialog is displayed which allows an attempt to be made at clearing the error. Providing the cause of the error has been rectified, the error can be cleared, although the PLC mode may need to be switched to achieve this.

Use the following procedure to clear errors.

1. Select the Errors tab in the PLC Error component.
2. Select the Clear All pushbutton.
There are three types of errors that can be recorded.

- **Fatal error**: Program execution is halted and the PLC error indicator is constantly illuminated.
- **Warning error (non-fatal)**: The PLC error indicator flashes.
- **No errors**: PLC is operating normally.

**Note:** The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to initialize the CPU Unit by selecting *Clear All Memory Areas* from the Options menu of the PLC Errors dialog box.

### Error Log

The *Error Log* tab of the PLC Error component displays the error history of the associated PLC including entry number, date and time of occurrence (if date and time stamping is supported by the PLC), code position and error details. The icon shown against the Entry number indicates the error status (unlike the *Errors* tab, there is no Status column).

Use the following procedure to clear the Error Log.

1. Select the *Error Log* tab in the PLC Error component.
2. Select the *Clear All* pushbutton.

**Note:** The Error Log cannot be cleared in Run mode.

There are three types of Error Log entries recorded.

- **Fatal Error Log entry**: Program execution is halted by this error occurrence.
- **Warning Error Log (non-fatal) entry**.
- **No Error Log entries**.

The maximum number of Error Log entries allowed by the PLC is displayed beneath the Error Log.

**Note:** With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the error log displayed in the PLC error window’s Error Log Tab can be saved as a CSV file by clicking the *Save* Button. The saved data can be analyzed or printed later with programs such as MS Excel.

### Messages

The *Messages* tab of the PLC Error component displays the messages set by a ladder program. These are user-defined messages which have been inserted into the PLC program, they do not have to be error messages. Messages can either be selectively cleared or all cleared at the same time.

Use the following procedure to clear a message.

1. Select the *Messages* tab in the PLC Error component.
2. Highlight the message to be cleared and select the *Clear* pushbutton. Alternatively, select the *Clear All* pushbutton or remove a selection by keeping the [SHIFT] key depressed when highlighting messages.

### Error Log Settings

The Error Log Options dialog allows the Error Log to be activated, time monitoring to be set and automatic update of the Error Log to be performed. When the component is initially opened, it activates settings saved previously.

### Time Monitoring

Some PLC types support a clock which can also be monitored. Use the following procedure to invoke time monitoring against the PLC Clock.
1. Select the **Settings** option from the **Options** menu.
2. Select the **Clock** tab.
3. Check the **Monitor the PLC Clock** setting. The current clock time from the PLC is then displayed in the status bar so the user can verify the current time against the error log entries.
4. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

**Note:** Where PLCs do not support a clock, ‘No Clock’ is displayed in the Status Bar and the information on the **Clock** tab is greyed-out.

### Manually Updating the Error Log

Manual refresh of the Error Log is useful if it is desired to prevent other users from clearing the displayed error history. Use the following procedure to enable manual refresh of the error log.

1. Select the **Settings** option from the **Options** menu.
2. Select the **Error Log** tab.
3. Check the **Update Error Log Entries Automatically** setting. If not checked, a **Refresh** pushbutton is displayed next to the **Clear** pushbutton to manually refresh the Error Log content (in the PLC Error component).
4. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

Use the following procedure to refresh the Error Log automatically.

1. Select the **Settings** option from the **Options** menu.
2. Select the **Error Log** tab.
3. Deselect the **Update Error Log Entries Automatically** setting.
4. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

### Customising the Layout of the Error Log

Some PLCs do not support time stamps, date stamps or clocks. The layout of the Error Log can be changed to remove the time and date columns as necessary and make the display more relevant to the PLC. Use the following procedure to customise the layout of the PLC Error component.

1. Select the **Settings** option from the **Options** menu.
2. Select the **Error Log** tab.
3. Error Log time and date information can be hidden from view by checking the **Hide Error Log Time Column** and the **Hide Error Log Date Column** settings.
4. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

### Enabling and Disabling the Error Log

For C-series PLCs only, the error log can be enabled and disabled as required. Use the following procedure to enable or disable the error log.

1. Select the **Settings** option from the **Options** menu.
2. Select the **Error Log** tab.
3. Check the **Error Log Enabled** setting to manually monitor errors.
4. Deselect the **Error Log Enabled** setting to stop monitoring errors.
5. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

### Overwriting Error Log Entries

For C-series PLCs only, the overwrite mode depends upon the CPU type. It may either overwrite the last entry in the Error Log each time or cycle through the Error Log and start to overwrite it from the beginning. Overwriting is
only performed when the maximum number of records in the Error Log has been reached. Again this is PLC dependent.

1. Select the Settings option from the Options menu.
2. Select the Error Log tab.
3. Check the Error Log Overwrite Mode setting to allow the PLC to overwrite Error Log entries.
4. Select the **Apply** pushbutton to activate the settings. Select the **OK** pushbutton to apply the settings and close the dialog. Select the **Cancel** pushbutton to abort the operation.

### Displaying the Error Log

The PLC Error component can be set so that it is only activated when an error in the PLC actually occurs (providing it is already open); for example, if the PLC Error component has been minimised it automatically returns to full size as the top window when an error is generated in the PLC.

1. Select the Settings option from the Options menu.
2. Select the General tab.
3. Check the **Activate only when Error detected** setting.
CHAPTER 7
Memory Card Component

This chapter describes the Memory Card component available to CV-series PLCs and CS/CJ-series PLCs and its ability to store and transfer data. File storage is achieved by a File memory card for a CV-series PLC and a Compact Flash or EM memory configured as 'file memory' for a CS1-series PLC.

Information can be transferred from the PLC to the memory card or from the memory card to the PLC. A saved program can be transferred from the memory card to the program area during operation. Extended PLC setup and program files can be automatically transferred at PLC startup if they are named autoexec.std and autoexec.obj respectively.

It is possible to run the Memory Card component whilst the PLC is offline.

The Memory Card component can be forced to be displayed in focus by selecting the Always on top option from the Options menu.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for further information.

Access to the Memory Card component is from the invoking application.

Memory Card Operation

The appearance and behavior of the Memory Card component is similar to Microsoft Windows Explorer. Differences between the Microsoft Windows Explorer exist within the Memory Card component when certain functions are accessed. Refer to Microsoft Windows Explorer help, part of the standard Microsoft Windows documentation for options and functions not described in this chapter but available within the Memory Card component.

Caution: Memory cards must be formatted prior to use.

The status bar provides instant help, the PLC and CPU type, and quick reference information describing how much space is available on a particular device for the selection in the left pane.

In addition to the devices and folders supported by the PC, the Memory Card component also displays the connected PLC device. In terms of the device/folder structure of Microsoft Windows Explorer, the PLC contains a Memory Card folder if available (i.e. if fitted), Program Area, IO Memory Area and Parameter Area. For a CS/CJ-series PLC, a Memory Card folder can contain subfolders.

Note: In order to view or execute on the PLC a file from the memory card, the file must be copied back to the PC folder. Double clicking on the files in the list has no action associated with it since files cannot be opened across the communications connected to the PLC.

A memory card can be displayed for each connected PLC and allows their contents to be moved between destinations. The operation is aborted if there is not enough space. Snapshots of PLC Memory areas can be taken by transferring information from the Program Area, IO Memory Area or Parameter area to the Memory Card folder.
For CV-series PLCs memory cards can be either RAM, EPROM, or EEPROM. EPROM and EEPROM cards can only be written to using the Memory Card Writer.

For CS1-series PLCs memory cards can be either Compact Flash disk or configured EM memory.

There are three ways in which memory cards can be accessed:

- They can be read from/written to during an online operation using programming software;
- By instruction via a program in the PLC;
- Using the Memory Card component;

Refer to the associated PLC manual for further information.

The Memory Card component automatically detects whether the memory card is in place or not. An error message is displayed if it is detected that the memory card has been removed whilst the Memory Card component is active.

Files held on the memory card can be compared with data in the PLC. File formats can be one of four types:

- .LDP indicates partial program area files;
- .OBJ indicates full program area files;
- .STD indicates PLC setup area files;
- .IOM indicates any other type of file.

The CS/CJ-series PLC also supports the configuration of EM memory as file memory. Providing the EM Table Setting Enabled option from the Settings menu is set within the PLC Setup component whilst in Program mode. Refer to Chapter 4 - PLC Setup Component for further details.

A fitted memory card on CV-series PLCs or Compact Flash card on CS/CJ-series PLCs must be formatted to be used as a file storage device. Setting a CS1-series PLC as file memory in the PLC Setup component automatically formats EM file memory for use in the Memory Card component.

### Memory Card Display

The Memory Card component can be manipulated in the same manner as most Microsoft Windows displays to control what is displayed; for example, expansion of the file storage hierarchy.

The left pane displays the content, in terms of Devices, Networks and Points.

- To expand the hierarchy in the left pane, select this icon.
- To collapse the hierarchy in the left pane, select this icon.
- To view the content of a particular branch in the hierarchy, double-click on the item in the left pane.
- Select the Large Icons button from the toolbar to display the content of the right pane as large icons.
- Select the Small Icons button from the toolbar to display the content of the right pane as small icons.
- Select the List button from the toolbar to display the content of the right pane as a list.
- Select the Details button from the toolbar to display the content of the right pane with associated details.

Use the following procedure to copy or move information from or in the PLC Memory component.

1. Select an item, or items, in a window. More than one item can be selected by pressing Shift and selecting another item to extend the selection, or by pressing Ctrl and selecting another item to add to the selection.
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar to move the item.
3. Select an area to move the items to, for instance copying data area values into another data area.
4. Select the **Paste** button from the toolbar to paste the item. A Paste operation can be performed several times without copying again.

A file or label (if at top level) can be renamed. Use the following procedure to rename memory card data.

1. Highlight the required document or folder.
2. Select the **Rename** button from the toolbar. The document/folder name can now accept input. Enter the new name and press Return.

A file or folder can be deleted. Use the following procedure to delete a file or folder.

1. Highlight the required document or folder.
2. Select the **Delete** button from the toolbar. A Confirm Folder Delete dialog is displayed.
3. Select the **Yes** pushbutton to continue with the deletion or the **No** pushbutton to abort the operation.

The Toolbar and status bar can both be turned on or off. Select **Status Bar** from the **View** menu to control the display of the status bar. Select **Toolbar** from the **View** menu to control the display of the PLC Memory toolbar.

If the display of a PLC device takes a few moments to refresh, ensure the **Auto Refresh PLC View** option from the **Options** menu is turned off. This then allows the PLC to be refreshed manually by selecting **Refresh** from the **View** menu.

Extended PLC setup and program files can be transferred to the Memory Card as autoexec files so they can be automatically transferred at PLC startup. Select the **Transfer as AutoExec Files** from the **Options** menu.

### Memory Card Properties

Use the following procedure to view memory card properties.

1. Highlight the required document or folder. Multiple devices, folders and files can be selected if required.
2. Select the **Properties** button from the toolbar.
3. View the details. Some options may be amended, for instance the read-only attribute for a file; in this instance, amend settings as appropriate. Select the **OK** pushbutton to complete the operation or the **Cancel** pushbutton to abort the operation.

### Transferring Data between the PLC and Memory Card

Use the following procedure to transfer data between the PLC and memory card.

1. Select the Files on the PLC to be copied and click the right-mouse button.
2. Select **Transfer To** option followed by either **Memory Card** or **EM File Area**.

### Possible Memory Card Errors

The following list provides a brief overview of the possible errors that could arise with the memory card when operating in Program Mode. Refer to the associated PLC manual for further information.

- The PLC Program is protected and cannot be written to;
- The file card does not contain enough free space to transfer the PLC data required;
- The source file name specified to transfer data from does not exist;
- The file on device already exists;
- The file device is read only and cannot be written to;
- The file device does not exist, insert the memory card;
- Cannot transfer data from the file device to the PLC’s area when the PLC is in Run mode;
- To transfer data from the file device to the PLC’s IO area, the PLC must be in Program mode;
- The data cannot be transferred to the PLC as the PLC is password protected or access rights have not been granted.
Note: With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the following functions can be executed if the PLC model is set to CP1H.

1, 2, 3...

1. Memory Cassette Transfer function
   Data can be transferred and verified between the Memory Cassette and CP1H CPU Unit.
   ♦ Applicable Data
   The following table lists the kinds of data that can be selected for transfer/verification.

<table>
<thead>
<tr>
<th>Applicable data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program, parameters, Data Memory, variable tables, comments, program index, and Data Memory initial values</td>
</tr>
</tbody>
</table>

   ♦ Procedure
   Select PLC – Edit – Memory Cassette/DM and click the Transfer to Memory Cassette, Transfer to PLC, or Verify All Areas Button.

2. Data Memory to Flash Memory Backup function
   All of the Data Memory in the CP1H CPU Unit’s internal RAM can be backed up as DM initial values in the CPU Unit’s internal flash memory. The backed up data is known as Backup DM (DM initial values).
   ♦ Procedure
   Select PLC – Edit – Memory Cassette/DM and click the Backup Button in the Backup to Flash Memory Field.
CHAPTER 8
CX-Server Network Configuration Tool (CX-Net)

This chapter describes the CX-Server (CX-Net) Network Configuration tool, the procedures for establishing communications to PLCs for direct and gateway connections. The Network Configuration Tool hosts tools that assist in the creation and editing of local and network Routing Tables and the creation and editing of Data Link Tables.

To successfully establish communications between CX-Server and a network PLC, an intermediary or gateway PLC has to contain a valid Routing table to allow the correct routing of packets. The CX-Net Network Configuration tool allows communications to PLCs with a CX-Server project and configuration of the PLC. The CX-Net Network Configuration tool allows the following:

♦ Hosts the Routing Table editor to provide routing table support at a network level, enabling PLCs to act as gateways across networks;
♦ Hosts the Data Link table editor to provide Data Link table support at a network level;
♦ Setup of PLC devices and their communication units;
♦ Network diagnostics;
♦ Control of Data Link operation.

Note: The availability, format and content of the facilities within the CX-Net Network Configuration tool depend upon the device type of the PLC being considered (C-series, CS1-series or CV-series) and the network to which that PLC is connected (SYSMAC LINK, SYSMAC NET, Ethernet or Controller Link).

Refer to the specific OMRON System and Operation manuals for details of the operation of the various network units and their available settings and options.

The status bar provides instant help, the status of the current connection and the operating mode of the PLC.

When the CX-Net is initially loaded, the Project Devices field is empty. Opening or creating a CX-Server project populates the Project Devices list with all the devices in that CX-Server project. Selecting each device in turn causes the right-hand side of the dialog to display a graphical representation of that connection (either direct or through a gateway connection), together with node and network information.

Note: Offline connections are shown as a red line whilst for online connections this changes to green. Other aspects also change when online, refer to Chapter 8 - Opening a PLC for further information.

Any operations (e.g. network unit setup, Data Link and routing table editing) which are carried out affect the physical connection PLC which is currently connected, not the CX-Server project PLC.

Routing Tables contain the information necessary to allow communications between different networks including local and remote network address details; they are held in a specific area of PLC memory. Refer to Chapter 11 - for information regarding Routing Tables.

CS/CJ/CP-series PLCs linked to either a Controller Link or Ethernet network also use FINS routing tables.
CV-series PLCs also have routing tables which, unlike the C-series, are not dependent upon the networks (SYSMAC LINK, SYSMAC NET or Ethernet or Controller Link) to which they are connected. These tables are known as FINS routing tables. A direct connection is known as a Local Routing Table. A network connection is known as a Network Routing Table.

C-series PLCs linked to a SYSMAC LINK network are unable to communicate with a different network and therefore do not have a routing table; however, C-series PLCs linked to a SYSMAC NET or Controller Link network do have this capability and so have an associated routing table. These tables are known as SYSMAC NET and FINS routing tables respectively.

Data Link Tables provide a means of allowing a network of devices to share information. The manner in which this information is distributed in a system depends upon the network to which the table relates. The SYSMAC NET network contains one node acting as the ‘parent’ node or Data Link server (containing the Data Link table), unlike the SYSMAC LINK network where a copy of the Data Link table is sent to all nodes on that network. The Controller Link network operates in a similar manner to SYSMAC LINK except that the network is split into two areas with each node being associated with one or other of these areas. Data is then copied to each node in the related area. Refer to Chapter 10 - Data Links for further information regarding Data Link Tables.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for further information.

Access to the CX-Net Network Configuration tool is either from the invoking application or from the Start pushbutton on the Microsoft Windows taskbar.

To close the CX-Net Network Configuration tool, select the Close button in the title bar.

**CX-Net and CX-Server Projects**

All device information is contained within a CX-Server project file. Once the file has been opened, the PLCs listed in that CX-Server project can be opened and the devices on their networks manipulated. CX-Server projects can be manipulated from the CX-Net Network Configuration tool.

**Creating a New CX-Server Project**

A new CX-Server project can be created from the CX-Net Network Configuration tool. Use the following procedure to create a new CX-Server project.

1. Select New from the Project Menu. The Create Project dialog is displayed.
2. The CX-Server project must be saved before it can be edited. Enter a file name in the File name field. An existing CX-Server project can be overwritten by selecting a .CDM file displayed in the Create project dialog.
3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the operation. CX-Server files have a .CDM extension.

**Opening an Existing CX-Server Project**

CX-Server project files can be retrieved using a standard File Open dialog. To close a currently open file, create a new CX-Server project or select Close from the Project menu.

Use the following procedure to open a CX-Server project file.

1. Select the Open button from the toolbar to open a CX-Server project file.
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by the Open pushbutton. PLC Memory files have a .CDM extension.

A list of the most recently opened CX-Server project files is displayed in the Project menu.

**Adding a Device**

To add a device to a CX-Server project, select the Add Device option from the Project menu. The Add PLC dialog is displayed. The Add PLC dialog is identical to the Change PLC dialog.
To change a device within a CX-Server project, select the Change Device option from the Project menu. The Change PLC dialog is displayed.

**Editing a Device List**

The Device List dialog, (see Runtime User manual) can be used to change the settings of the PLCs in the currently opened CX-Server project, and to add new PLCs.

The CX-Server project Device List can only be edited when a device is not currently open – the option is disabled when a connection is active.

Select the Edit Project button from the toolbar to edit a CX-Server project, or select the Edit option from the Project menu.

**PLC Settings**

The PLC menu contains options that operate on a single PLC device within the open CX-Server project, including the setup of its units. It also contains the options for opening and closing a PLC device.

**Opening a PLC**

A PLC can be opened for communications once the associated CX-Server project file has been opened. Use the following procedure to open a PLC.

1. Select a device from the PLC Devices list. If required, add a device to the CX-Server project by selecting Add Device from the Project menu and edit the CX-Server project by selecting the Edit Project button from the toolbar.
2. Select the Open / Project Device button from the toolbar.

**Note:** The Open option does not become available until a device name has been selected from the Project Devices list.

It may take several seconds to establish a connection. If a connection cannot be made with the PLC's settings, then a message appears showing this. In this case it may be necessary to change the PLC's settings before trying again, or checking that the physical connection (e.g. wiring) is possible.

For SYSMAC LINK end connections a new SYSMAC LINK menu is added allowing specific SYSMAC LINK network operation.

For Controller Link end connections a new Controller Link menu is added allowing specific Controller Link network operation.

When a physical connection has been made the status of the PLC in the status bar changes to Online with the current mode of the PLC. The connection lines change colour to green to also denote the PLC is online. In addition, the actual values for Node and Network are displayed, together with details of the device actually connected (rather than what is defined in the CX-Server project for that setting). When a connection is made to an Ethernet network the Node box changes to a drop-down list, allowing the node to be changed in order to connect to a new PLC. If a node is selected but there is nothing there, then no information is shown. Returning to offline operation causes a return to the original (CX-Server project) configuration settings in the Node and Network fields.

Upon connection, certain menu options are made available, depending upon the connection type.

The current operating mode (Run) of the connected PLC is shown in the status bar of the tool – when making a connection, or when a connection is broken, the mode indicator shows Unknown. The indicator shows Run, Stop or Monitor when a connection is properly completed. CV-series PLCs also support a Debug mode. This mode indicator changes whenever a change is made in the operating mode of the PLC.

**Note:** The mode in which the PLC runs on startup is set in the PLC Setup Component, refer to Chapter 4 - PLC Setup Component.

**Closing a PLC**

The Open / Project Device button on the toolbar acts as a toggle switch. To close a device, simply reselect the Open / Project Device button on the toolbar (i.e. when the menu option shows a tick against it and the toolbar button is depressed).
When the device is closed, the details displayed in the Connection part of the CX-Net Network Configuration tool are removed.

**Configuring a PLC’s System Settings**

The PLC Setup Component can be selected to define the settings which govern the PLC’s behavior; for example, connection mode. Select the **Configure PLC System Settings** button from the toolbar. Refer to Chapter 4 - PLC Setup Component for further information. Alternatively, select PLC Setup from the PLC menu.

**Scanning for PLC Connections**

A serial scan can be performed which searches all PC COM ports to see if there are any currently attached PLCs and, if found, what communication settings are being employed by those PLCs. This procedure is useful when the configuration of the PLCs communication settings (i.e. baud rate) are unknown. Device information from the results of the scan can then be copied into the CX-Server project, if required. Refer to Chapter 8 - Dragging Device Information into a CX-Server Project.

When the Scan Serial Ports for PLCs dialog is first displayed, it shows the results of the last scan to be performed until the Refresh pushbutton has been clicked. Use the following procedure to scan for PLC connections.

1. Open a CX-Server project by selecting the **Open** button from the toolbar or create a new project. If required, add a device to the CX-Server project by selecting **Add Device** from the Project menu and edit the CX-Server project by selecting the **Edit Project** button from the toolbar.

2. Select **Scan Serial Ports for PLCs** from the Project menu. The Scan Serial Ports for PLCs dialog is displayed.

3. Select either individual ports or select the **Select All** pushbutton to scan all ports from the Available Ports field.

4. Select either individual baud rates or select the **Select All** pushbutton to scan all baud rates from the Baud Rates field.

5. Select either individual cable types or select the **Select All** pushbutton to scan all cable types from the Cable types field.

6. Select the **Next** pushbutton; the Scan Serial Ports For PLCs dialog starts the scan. The Status field indicates the current progress. On completion, all currently connected PLCs are listed in the Drag and Drop Device Units field.

**Note:** If changes are made to PLC connections after a scan has been made, select the Refresh pushbutton to update the displayed list.

**Dragging Device Information into a CX-Server Project**

The scan operation described in Chapter 8 - Scanning for PLC Connections, picks up device information from the physically connected serial port devices. Once a scan has been performed, the Scan Serial Ports for PLCs dialog can remain open alongside the CX-Net Network Configuration tool. Dragging a device or network unit from the Drag & Drop Device Units field into the Project Device field in the CX-Net Network Configuration tool allows this device information to be added into the CX-Server project.

Use the following procedure to utilise a convenient shortcut for entering PLC details into a CX-Server project.

1. Open a CX-Server project by selecting the **Open** button from the toolbar or create a new project. If required, add a device to the CX-Server project by selecting **Add Device** from the Project menu and edit the CX-Server project by selecting the **Edit Project** button from the toolbar.

2. Perform a scan by selecting **Scan Serial Ports for PLCs** from the Project menu.

3. Select the required device in the Drag and Drop Device Units field.

4. Drag the device across to the Project Devices field in the CX-Net Network Configuration tool.

**Displaying PLC Device Information**

The PLC Device Information dialog displays the selected CX-Server project PLC’s device and connection details. To display PLC device information, select the **Display PLC Information** button.
Setting the PLC Mode

The main window of the CX-Net Network Configuration tool shows the current operating mode of the connected PLC. The PLC Set Mode dialog allows this to be changed. The run modes available to a PLC depend upon the PLC device type. Use the following procedure to set the PLC Mode.

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new project. If required, add a device to the CX-Server project by selecting Add Device from the Project menu and edit the CX-Server project by selecting the Edit Project button from the toolbar.
2. Select the Open / Project Device button from the toolbar to open connections to the device.
3. Select the Set PLC Operating Mode button from the toolbar or select the Set Mode command from the PLC menu.
4. Click on the required Operating Mode setting. Select the Set pushbutton. A confirmation dialog appears – confirm the operation.
5. Select the Close pushbutton to remove the dialog.

Clearing PLC Errors

Errors, error logs and messages generated by a PLC can be examined and cleared (if possible) via the PLC Error Component. Select the Display PLC Error Status button on the toolbar or, select the PLC Error Status command from the PLC menu. Refer to Chapter 6 - PLC Error Component for more information.

Creating an IO Table

The PLCs IO Table can also be manipulated by the CX-Net Network Configuration tool by activating the IO Table component. The IO Table allows Unit Setup and Software Switch setup of SIOU units as well as IO configuration and creation. Before editing the PLCs IO Table it must be transferred from the PLC into the IO Table component. Select the Configure IO Table button from the toolbar or select the I/O table Setup commend from the PLC menu. Refer to Chapter 3 - IO Table Component for further details. Use the following procedure to activate the IO Table component.

Displaying the PLC Unit Status

The Unit Status option is only available for those nodes where the end connection to the PLC is either SYSMAC LINK, SYSMAC NET, Ethernet or Controller Link; in each instance the type of information displayed differs but the pushbuttons available are identical.

- SYSMAC LINK. Displays Communications Test, Line Status, Data Link Status, Controller Errors, Backup Status Errors, Error Status, Error Log, Status, Error Details;
- SYSMAC NET. Displays Data Link Status, Operating Status, Errors;
- Ethernet. Displays General Status, Error Flags and Error Logs;
- Controller Link. Displays Data Link Status, nodes, Errors and Error Logs.

The information displayed is for viewing only. However, the Error Log can be cleared. Use the following procedure to display the PLC Unit Status.

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new project. If required, add a device to the CX-Server project by selecting Add Device from the Project menu and edit the CX-Server project by selecting the Edit Project button from the toolbar.
2. Select the Open/Close Project Device PLC button from the toolbar to open connections to the device.
3. Select the Show Unit Status button from the toolbar or select Unit Status from the PLC menu.
4. Select the Clear Log pushbutton to delete the entries in the error log.
5. Select the **Close** pushbutton to remove the dialog.

**Note:** Unit status and error log data for Communications Units (e.g., Controller Link Units and SYSMAC LINK Units) can be written to files in CSV format. Click the **Save** button in the PLC Unit Status dialog box and the Save As dialog box will appear. Select the CSV format and the folder in which to save, input the file name, and click the **Save** button. The status of the Communications Unit and the error log data will be saved in a CSV file.

This function allows network errors to be analysed from CSV files.

**Note:** With a C-series PLCs, the error log for a Communications Unit (e.g., Controller Link Unit or SYSMAC LINK Unit) can be saved using PLC | Unit Status/Error Log.

### Testing the Network Connection

Once network connections have been created, the network should be tested to ensure that all nodes are responding properly. The following tests are available:

- **Internode Echo-Back Test.** This test checks the condition of a number of specific network and node address and whether communications can be established;

- **Broadcast Nodes Test.** This test examines all nodes on the network and is available for Ethernet, Controller Link and SYSMAC LINK only. This test may take some time for an Ethernet network which is not subject to the same size restrictions as Controller Link and SYSMAC LINK. The results show all nodes found and the PLC type if possible;

- **Ping Node Test.** Allows echo testing of a specific TCP IP address.

Select the required test from the associated button in the toolbar, either the **Echo Back Test** button, the **Broadcast Test** button or the **Ping Test** button.

### Communications Unit Setup

The **Configure Communications Unit** button from the toolbar is used for SYSMAC LINK, SYSMAC NET and Controller Link setup options on SIOU units for C-series PLCs. These options only describe settings that cannot be accessed via the IO Table component.

For CS1-series PLCs and CV-series PLCs, the setup allows SYSMAC NET, SYSMAC LINK and Controller Link setup. This information is defined via the IO Table component; refer to Chapter 3 - IO Table Component for further information.

Select a unit type from the **Unit Type** field. If provided, select the **Setup** pushbutton to further configure communications setup. Select the **Close** pushbutton to close the dialog.

### SYSMAC LINK Settings

The **SYSMAC LINK** menu only appears when the end connection is the SYSMAC LINK network. It allows settings specific to a SYSMAC LINK network to be made.

### Network Status

The SYSMAC LINK Network Status dialog shows the nodes present on the network. It also indicates the controlling server node. Use the following procedure to setup SYSMAC LINK Network Status settings.

1. Select the **Network Status** option from the **SYSMAC LINK** menu.
2. Select the **Close** pushbutton to remove the dialog.

### Network Settings

The Network Settings dialog allows parameter settings for a SYSMAC LINK network to be defined; this includes the maximum number of nodes on a network, the maximum number of polling units per communications cycle, and the maximum number of frames per communications cycle.

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to setup SYSMAC LINK Network Settings.

1. Select the **Network Setup** option from the **SYSMAC LINK** menu.
2. Adjust the settings as required (or select the **New** pushbutton to return to the default values for the network).
3. Select the **Write** pushbutton to download the network parameters to the SYSMAC LINK network controller. Note that this is only possible when the connected node is the polling (server) node – otherwise the **Write** pushbutton is disabled. The status display indicates whether the write operation was successful.
4. Select the **Close** pushbutton to remove the dialog.

**Controller Link Settings**

The **Controller Link** menu only appears when the end connection is the Controller Link network. It allows settings specific to a Controller Link network to be made.

**Network Status**

The Controller Link Network Status dialog shows the nodes present on the network. It also indicates the controlling server node. Use the following procedure to setup Controller Link Network Status settings.

1, 2, 3…
1. Select the **Network Status** option from the **Controller Link** menu.
2. Select the **Close** pushbutton to remove the dialog.

**Network Settings**

The Network Setup dialog allows parameter settings for a Controller Link network to be defined; this includes the maximum number of nodes on a network, the maximum number of polling units per communications cycle, and the maximum number of frames per communications cycle.

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to setup Controller Link Network Setup settings.

1, 2, 3…
1. Select the **Network Setup** option from the **Controller Link** menu.
2. Adjust the settings as required (or select the **New** pushbutton to return to the default values for the network).
3. Select the **Write** pushbutton to download the network parameters to the SYSMAC LINK network controller. Note that this is only possible when the connected node is the polling (server) node – otherwise the **Write** pushbutton is disabled. The status display indicates whether the write operation was successful.
4. Select the **Close** pushbutton to remove the dialog.

**Routing Tables**

Routing tables allow networked PLCs to be configured so that they can communicate with each other via gateways; across remote networks. These tables contain the network and unit number information required. It is only necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC as a gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different types of PLC and networks have different capabilities for routing.

For details about using routing tables refer to *Chapter 11 – Routing Tables*.

**Data Link**

Data Link tables allow a PLC to be configured so that it can participate in one or more automatic data sharing schemes, over SYSMAC LINK, SYSMAC NET and Controller Link networks, without the need for special programming. Words of IO and DM can be set aside for use as data link words, which are allocated to various nodes in the network. Limits on the amount of data and number of nodes varies with the type of network and the type of PLC. The allocation of words to nodes is defined by two or more Data Link tables.

Data can only be shared on a single physical network. A gateway cannot be used to pass information from one network to another.
SYSMAC NET data links can be configured so that both C-Series and CV-Series PLCs can share data. However, it is a limitation that in these mixed configurations, the master must be a C-Series PLC. There are no such restrictions on a SYSMAC LINK or Controller Link network.

The Data Link menu includes options to setup the SYSMAC NET, SYSMAC LINK and Controller Link Data Links.

The DataLinks Editor is used to configure SYSMAC LINK and Controller Link data links, Refer to Chapter 10 – Data Links.

A separate datalink editor is utilised for configuration of SYSMAC NET datalinks, Refer to Chapter 8 - Offline SYSMAC NET Data Link Editor for further details.

**Data Link Setup**

The Data Link Setup dialog varies in title and content according to the type of network connected to the current PLC; however, the pushbutton functions on each dialog are the same.

The dialog lists the contents of the Data Link table associated with the PLC; initially the Data Link table displayed is empty, or set to zero, until a table has been opened or read.

**SYSMAC NET Data Link Setup**

The setup dialog first needs to know whether the Data Link table is written for CV-Series or C-Series PLC type SYSMAC NET this information is requested using the SYSMAC NET Table Type dialog.

Use the following procedure to setup the SYSMAC NET Data Link.

1. Select the **Online Edit Data Link** button from the toolbar.
2. Select a setting to indicate the type of SYSMAC NET which is used in the Data Link.
3. Select the **OK** pushbutton to continue (the Data Link Setup dialog is displayed), or the **Cancel** pushbutton to abort the operation.

**Opening a Table**

Use the following procedure to open a table.

1. Select the **Open** pushbutton to open a Data Link table from disk (alternatively select the **Read** pushbutton to view the table in the PLC).
2. Select the appropriate table and select the **OK** pushbutton.
3. The Data Link Setup dialog is now populated with the contents of the Data Link file.
4. Select the **Write** pushbutton to transfer the table to the PLC.
5. Select the **Verify** pushbutton to compare the contents in the dialog with those in the PLC.

**Note:** Data Link tables have a ‘.SL3’ (SYSMAC LINK), ‘.SN3’ (SYSMAC NET) or ‘.CL3’ (Controller Link) filename extension.

**Editing a Table**

To edit the displayed Data Link table, click on the **Edit** pushbutton; the associated offline table editor is used, refer to Chapter 10 – for SYSMAC LINK / Controller Link Data Link Editor and Chapter 8 - Offline SYSMAC NET Data Link Editor for further details.

**Updating Table Status**

After an editing session using the offline editor (i.e. after pressing the **Edit** pushbutton), the dialog can be updated using the **Update** pushbutton.

**Saving a Table**

The Save As dialog allows the displayed table to be saved to disk with a given name. Use the following procedure to save a table.

1. Click on the Save As pushbutton in the Data Link Setup dialog. The Save As dialog is displayed.
2. Enter the new file name for the data link table (ensure that the file type is correct) in the File name field.
3. Either select the Save pushbutton to save the new file and return to the previous dialog or select the Cancel to abort the operation.

**Deleting a Table in a PLC**

The current Data Link table held in the PLC can be deleted by selecting the Delete pushbutton.

**Viewing Table Information**

The Table Information dialog displays basic information relating to the selected Data Link table indicating the author, associated network and file name. The information displayed on this screen cannot be edited whilst online. Use the following procedure to view table information.

1. Select the Info pushbutton on the Data Link Setup dialog.
2. Select the Close pushbutton to remove the dialog from the screen. The Data Link Table dialog is redisplayed.

Select the New pushbutton in the dialog to clear the dialog information.

**Offline SYSMAC NET Data Link Editor**

The SYSMAC NET Data Link Table Editor is available to both CV-series and C-series PLCs linked to a SYSMAC NET unit.

The status bar provides instant help.

Access to the SYSMAC NET Data Link Editor dialog is achieved in a number of ways:

- From the CX-Net Network Configuration tool. Select Editor from the Data Link menu. The Select New File type dialog is displayed. Select the SYSMAC NET file type from the File Type field and select the OK pushbutton.
- From the Data Link Setup dialog. Select the Edit pushbutton.
- From the Start pushbutton in the Microsoft Windows taskbar. The Select New File type dialog is displayed. Select the SYSMAC NET file type from the File Type field and select the OK pushbutton.

**Creating and Editing a SYSMAC NET Data Link Table Item**

Use the following procedure to creates SYSMAC NET Data Link Table Item.

1. Select the New button from the toolbar in the SYSMAC NET Data Link Table Editor dialog.
2. Select the Insert Table Item option from the Table menu. Address information can also be edited by double-clicking on the required node.

The Add SYSMAC NET Data Link Table Item dialog allows the memory area at the node to be configured. Use the following procedure to configure the node.

1. Enter the node number in the Node No field; this must be in the range 1 to 126.
2. Enter the memory size; this must be in the range 0 to 127.
3. Select the OK pushbutton to redisplay the Data Link Table Editor.

**Note:** The above example applies to CV-Series, but C-Series operates in exactly the same manner although the information displayed differs slightly.

To edit a Data Link table, double-click on a table item or select the **Edit Table Item** button from the toolbar; the Edit Data Link Table dialog is displayed (this is identical to the Add Data Link Table Item dialog shown above).

**Deleting an Item from the SYSMAC NET Data Link Table**

Use the following procedure to delete an item from the SYSMAC NET Data Link Table.

*1, 2, 3…*
1. Select the node to delete an item and select the **Delete Item** button from the toolbar.
2. A confirmation dialog is displayed. Select the **Yes** pushbutton to confirm the deletion of the item. Select the **No** pushbutton to abort the operation.

**Opening an Existing SYSMAC NET Data Link Table**

Use the following procedure to open an existing SYSMAC NET Data Link Table.

*1, 2, 3…*
1. To open a table from disk, select the **Open** button from the toolbar in the Data Link Editor dialog. A standard File Open dialog is displayed.
2. Select a file from the Open dialog and select the **Open** pushbutton. The SYSMAC NET Data Link Table Editor is automatically populated with the contents of the selected file.

**Note:** SYSMAC NET Data Link table files are identified by the ‘.SM3’ extension.

**Logical Error Checking**

The SYSMAC NET Data Link Table Check dialog displays any errors resulting from validation of the address details entered in the table; it is identical in appearance to the SYSMAC LINK Data Link Table Check dialog shown earlier and is obtained in the same way.

**Old Format Tables**

Data Link tables were previously held in ‘.SNT’ and ‘.SN2’ file format. The File Open dialog allows these file types to be opened in the CX-Net Network Configuration tool. Use the following procedure to open ‘.SNT’ and ‘.SN2’ formatted files.

*1, 2, 3…*
1. Select the **Add (old)** option from the **Table** menu in the SYSMAC NET Data Link Table Editor dialog.
2. Select a file from the Open dialog and select the **Open** pushbutton.

**Table Information**

The Data Link Table Information dialog allows the recording of comments against a particular table and is the same both in operation and appearance, as that for the routing table comments described earlier.
CHAPTER 9
PLC Clock Tool

The PLC Clock tool provides a facility to monitor and set the PLC Clock and synchronise the PLC clock to the PC clock.

The PLC Clock tool dialog can be set so that it remains ‘on top’ and is not obscured by other windows by clicking the right mouse button in the task bar and selecting the Always on Top option.

To close the PLC Clock dialog, select the Close button in the title bar.

The PLC Clock tool displays two clock images that represent the time for the computer (PC) on the left and the PLC on the right. The time and date are also represented in a digital format for both the computer and the PLC.

The times for both the Computer and the PLC are updated once a second.

A synchronise button is located centrally between the two clock images. This button once pressed, will synchronise the PLC clock to the computer clock. The same effect can also be evoked from the Options – Synchronise Clocks menu.

The File menu allows the PLC Clock tool to be closed by use of the Exit menu item.

The Options – Set PLC Clock allows the time and date within the PLC to be set.

If the PLC Clock window is minimised the PLC clock time will be displayed in digital format in the task bar.
CHAPTER 10
Data Links

What Are Data Links?

Overview
Data links automatically exchange data in preset areas between nodes (PLCs and/or computers) on a network. Settings can be made either manually or automatically.

CX-Net operations can be used for all operations from setting up the PLC network to controlling data exchange.

Manual Settings
Manual settings enable more flexible allocations, including the send size for each node, the sequence of nodes for sending and receiving, and the setting of nodes for sending only or receiving only. Use manual settings to create flexible data links to meet the requirements of the individual system (e.g., efficient utilization of memory, restrictions on allocated addresses, etc.).

Data link tables (i.e., tables that define data link area allocations) are generated by CX-Net or network support software (such as Controller Link Support Software), and sent to all nodes for use.

Note: The following table provides a general comparison of manual setup between Controller Link and SYSMAC LINK.

<table>
<thead>
<tr>
<th>Item</th>
<th>Controller Link</th>
<th>SYSMAC LINK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node sequence</td>
<td>Free</td>
<td>Can be specified.</td>
</tr>
<tr>
<td>Send size</td>
<td>Can be specified.</td>
<td>Supported</td>
</tr>
<tr>
<td>Receive-only nodes</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Reception only is enabled by setting the send area size at the local node to 0.)</td>
</tr>
<tr>
<td>Send-only nodes</td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>Memory area</td>
<td>Can be specified.</td>
<td>Cannot be specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fixed as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CS/CJ/CV Series: Area 1: CIO; Area 2: DM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C Series: Area 1: LR; Area 2: DM</td>
</tr>
<tr>
<td>Receive size</td>
<td>Can be specified.</td>
<td>All or none</td>
</tr>
<tr>
<td>Reception offset (reception from start address + specified number of words)</td>
<td>Can be specified.</td>
<td>No (From start address only)</td>
</tr>
<tr>
<td>Communications cycle time</td>
<td>Cannot be set.</td>
<td>Can be set.</td>
</tr>
</tbody>
</table>
Automatic Settings

Automatic settings can be used for simple data exchanges involving fixed allocations, when all nodes are set for the same send size and the same data is to be shared among all nodes in order of node address.

Using a Programming Device (such as the CX-Programmer or a Programming Console), set the data exchange method in the DM parameter area of the startup node.

Note: The following table provides a general comparison of automatic setup between Controller Link and SYSMAC Link.

<table>
<thead>
<tr>
<th>Item</th>
<th>Controller Link</th>
<th>SYSMAC LINK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node sequence</td>
<td>Fixed at ascending order.</td>
<td></td>
</tr>
<tr>
<td>Receive-only nodes</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Send-only nodes</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Memory area</td>
<td>Can be specified. (Area 1: CIO Area or LR Area; Area 2: DM Area or EM Area)</td>
<td>Cannot be specified. Fixed as follows: CS/CJ/CV Series: Area 1: CIO; Area 2: DM C Series: Area 1: LR; Area 2: DM</td>
</tr>
<tr>
<td>Start address</td>
<td>Can be specified.</td>
<td>Cannot be specified.</td>
</tr>
<tr>
<td>Send size</td>
<td>Same size for all nodes can be specified.</td>
<td>Same size for all nodes can be selected from specific patterns.</td>
</tr>
</tbody>
</table>

This section describes how to perform Controller Link and SYSMAC LINK operations from creating data link tables to starting up the data links.
User Interface Overview

Datalink Component

The following illustration shows the window used when constructing Controller Link or SYSMAC LINK data links manually.

Data Link Component Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-menus/Commands</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New</td>
<td>Creates new data link tables.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Opens data link tables. Files with any of the file name extensions shown below can be opened. When a file is opened, the proper editor starts up.</td>
</tr>
</tbody>
</table>
|            | Controller Link    | - cl2 – CX-Net Controller Link/CLKSS data link tables  
- cl3 – CX-Net Controller Link data link tables  
- clk – CLKSS data link tables  
- csv – CX-Net Controller Link data link tables (tab-delineated text file)  |
|            | SYSMAC LINK        | - .sl3 – SYSMAC LINK data link tables  
- .slk – SYSMAC LINK data link tables for SYSMAC Support Software  
- .csv – SYSMAC LINK data link tables (tab-delineated text file)  |
|            | Save               | Saves the data link tables that are being edited.                                                                                                                                                       |
|            | Save As            | Saves data link tables. Files with any of the file name extensions shown below can be saved.                                                                                                            |
|            | Controller Link    | - .cl2 – CX-Net Controller Link/CLKSS data link tables  
- .cl3 – CX-Net Controller Link data link tables  
- .clk – CLKSS data link tables  
- .csv – CX-Net Controller Link data link tables (tab-delineated text file)  |
|            | SYSMAC LINK        | - .sl3 – CX-Net SYSMAC LINK data link tables  
- .csv – CX-Net SYSMAC LINK data link tables (tab-delineated text file)  |
| Print      |                    | Prints data link information.                                                                                                                                                                           |
| Print Preview |                 | Previews the data to be printed.                                                                                                                                                                         |
## CHAPTER 10 – Data Links

<table>
<thead>
<tr>
<th>Menu</th>
<th>Sub-menus/Commands</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Exit</td>
<td>Exits the Datalink Component window.</td>
</tr>
<tr>
<td>View</td>
<td>Move Right</td>
<td>Moves the cursor to the right in the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Move Left</td>
<td>Moves the cursor to the left in the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Move Up</td>
<td>Moves the cursor up in the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Move Down</td>
<td>Moves the cursor down in the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Change Window</td>
<td>Changes the active window.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td>Zooms out from within the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Zoom In</td>
<td>Zooms in within the Data Link Configuration window.</td>
</tr>
<tr>
<td></td>
<td>Zoom Original</td>
<td>Returns the Data Link Configuration window to its initial scale.</td>
</tr>
<tr>
<td></td>
<td>Show in List</td>
<td>Shows the Data Link Area settings in list format.</td>
</tr>
<tr>
<td></td>
<td>Show in Table</td>
<td>Shows the Data Link Area settings in table format.</td>
</tr>
<tr>
<td></td>
<td>Show Func Bar</td>
<td>Shows function key guides at the bottom of the Datalink Component window. (Enabled for table format only.)</td>
</tr>
<tr>
<td></td>
<td>Show Offset</td>
<td>Shows the specified offset value on the Node Editing window.</td>
</tr>
<tr>
<td>Table</td>
<td>Wizard</td>
<td>Executes the Datalink Wizard.</td>
</tr>
<tr>
<td></td>
<td>Add Source Link</td>
<td>Adds a node to the data links.</td>
</tr>
<tr>
<td></td>
<td>Add Destination</td>
<td>Adds the receive area of a participating node to the data links.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes nodes.</td>
</tr>
<tr>
<td></td>
<td>Validate Table</td>
<td>Checks data link tables.</td>
</tr>
<tr>
<td></td>
<td>Table Information</td>
<td>Edits data link table information.</td>
</tr>
<tr>
<td></td>
<td>Show Node List</td>
<td>Displays a list of nodes.</td>
</tr>
<tr>
<td></td>
<td>Redraw</td>
<td>Resets colored displays.</td>
</tr>
<tr>
<td>Online</td>
<td>Transfer from PLC</td>
<td>Uploads online data link tables to the computer.</td>
</tr>
<tr>
<td></td>
<td>Transfer to PLC</td>
<td>Downloads online data link tables from the computer to a PLC.</td>
</tr>
<tr>
<td></td>
<td>Verify Node</td>
<td>Compares data link tables generated by CX-Net with data link tables stored in the PLC. If they do not match, an error dialog box is displayed.</td>
</tr>
<tr>
<td></td>
<td>Data Link Operation/Status</td>
<td>Displays the operation and data link status of manually set data links.</td>
</tr>
<tr>
<td></td>
<td>Automatic Data Link Setup</td>
<td>Sets parameters for automatically set data links, and transfers them to the startup node.</td>
</tr>
<tr>
<td></td>
<td>Set All Nodes for Network Operation</td>
<td>Executes transfer, verify, and delete operations for all nodes.</td>
</tr>
<tr>
<td></td>
<td>Show All Network Nodes</td>
<td>Reads data link tables from all nodes.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes data link tables.</td>
</tr>
<tr>
<td>Options</td>
<td>Cycle Time</td>
<td>Sets the communications cycle time (for SYSMAC LINK data link tables only).</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td>Displays help.</td>
</tr>
</tbody>
</table>
### Toolbar

<table>
<thead>
<tr>
<th>No.</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td><img src="image" alt="New Icon" /></td>
<td>New creates new data link tables.</td>
</tr>
<tr>
<td>(2)</td>
<td><img src="image" alt="Show All Network Nodes Icon" /></td>
<td>Shows all network nodes.</td>
</tr>
<tr>
<td>(3)</td>
<td><img src="image" alt="Open Icon" /></td>
<td>Opens a data link tables. Files with any of the file name extensions shown below can be opened. When a file is opened, the proper editor starts up.</td>
</tr>
<tr>
<td></td>
<td>Controller Link</td>
<td>.cl2 – CX-Net Controller Link/CLKSS data link tables. .cl3 – CX-Net Controller Link data link tables. .clk – CLKSS data link tables. .csv – CX-Net Controller Link data link tables (tab-delineated text file).</td>
</tr>
<tr>
<td></td>
<td>SYSMAC LINK</td>
<td>.si3 – SYSMAC LINK data link tables. .slk – SYSMAC LINK data link tables for SYSMAC Support Software. .csv – SYSMAC LINK data link tables (tab-delineated text file).</td>
</tr>
<tr>
<td>(4)</td>
<td><img src="image" alt="Save Icon" /></td>
<td>Saves the data link tables that are being edited.</td>
</tr>
<tr>
<td>(5)</td>
<td><img src="image" alt="Toggle Network/Single Node Operation Icon" /></td>
<td>Specifies either all nodes or a single node for data transfers.</td>
</tr>
<tr>
<td>(6)</td>
<td><img src="image" alt="Transfer to PLC Icon" /></td>
<td>Downloads online data link tables from the computer to a PLC.</td>
</tr>
<tr>
<td>(7)</td>
<td><img src="image" alt="Transfer from PLC Icon" /></td>
<td>Uploads online data link tables to the computer.</td>
</tr>
<tr>
<td>(8)</td>
<td><img src="image" alt="Delete Icon" /></td>
<td>Deletes data link tables.</td>
</tr>
<tr>
<td>(9)</td>
<td><img src="image" alt="Verify Node Icon" /></td>
<td>Compares data link tables generated by CX-Net with data link tables stored in the PLC. If they do not match, an error dialog box is displayed.</td>
</tr>
<tr>
<td>(10)</td>
<td><img src="image" alt="Data Link Operation/Status Icon" /></td>
<td>Displays the operation and data link status of manually set data links.</td>
</tr>
<tr>
<td>(11)</td>
<td><img src="image" alt="Automatic Data Link Setup Icon" /></td>
<td>Sets parameters for automatically set data links, and transfers them to the startup node.</td>
</tr>
<tr>
<td>(12)</td>
<td><img src="image" alt="Validate Table Icon" /></td>
<td>Checks data link tables.</td>
</tr>
<tr>
<td>(13)</td>
<td><img src="image" alt="Wizard Icon" /></td>
<td>Executes the Datalink Wizard.</td>
</tr>
<tr>
<td>(14)</td>
<td><img src="image" alt="Add Source Link Icon" /></td>
<td>Adds a node to the data links.</td>
</tr>
<tr>
<td>(15)</td>
<td><img src="image" alt="Add Destination Icon" /></td>
<td>Adds the receive area of a participating node to the data links.</td>
</tr>
<tr>
<td>(16)</td>
<td><img src="image" alt="Set Source or Destination Link Area Properties Icon" /></td>
<td>Displays the Node Settings dialog box. This dialog box is used to modify the node properties.</td>
</tr>
<tr>
<td>(17)</td>
<td><img src="image" alt="Delete Link Destination Service Area Icon" /></td>
<td>Deletes nodes selected in the Data Link Configuration window, or deletes a receive area.</td>
</tr>
<tr>
<td>(18)</td>
<td><img src="image" alt="Zoom In/Zoom Out/Zoom Original Icon" /></td>
<td>Zooms the Data Link Configuration window in or out, or returns it to the initial scale.</td>
</tr>
<tr>
<td>(19)</td>
<td><img src="image" alt="Print Icon" /></td>
<td>Prints data link information.</td>
</tr>
<tr>
<td>(20)</td>
<td><img src="image" alt="Help Icon" /></td>
<td>Displays help.</td>
</tr>
</tbody>
</table>
PART 2: CX-Server PLC Tools
CHAPTER 10 – Data Links

Function Bar

<table>
<thead>
<tr>
<th>No.</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>F1: Help</td>
<td>Displays help.</td>
</tr>
<tr>
<td>(2)</td>
<td>F2: Node&lt;-&gt;Table</td>
<td>Moves the focus between nodes and tables.</td>
</tr>
<tr>
<td>(3)</td>
<td>F3: Link Start Address</td>
<td>Moves the focus between settings for the link start addresses   (status, Area 1, Area 2).</td>
</tr>
<tr>
<td>(4)</td>
<td>F4: Move Up Area</td>
<td>Moves a node up the node refresh sequence.</td>
</tr>
<tr>
<td>(5)</td>
<td>F5: Move Down Area</td>
<td>Moves a node down the node refresh sequence.</td>
</tr>
<tr>
<td>(6)</td>
<td>F6: Show/Hide Offset</td>
<td>Shows or hides the offset for the node being displayed.</td>
</tr>
<tr>
<td>(7)</td>
<td>F7: Insert Area</td>
<td>Inserts a new receive area (new node).</td>
</tr>
</tbody>
</table>
| (8) | F8: Delete Node | Deletes a node or communications area.  
To delete a node or link area from a node list, select the item from the list and then click **F8: Delete Node**. 
To delete a node or link area from a table, select the item from the table and then click **F8: Delete Node**. |
| (9) | F9: Show Prev Node | Shows the previous node.                                                |
| (10)| F10: Show Next Node | Shows the next node.                                                   |

Manually Setting Data Links

Follow the procedure described below to create data link tables manually for Controller Link or SYSMAC LINK data links.

**Note:** There is no need to create a data link tables when data links are set automatically. For details on automatic setup, refer to Automatically Set Data Links.
PART 2: CX-Server PLC Tools

CHAPTER 10 – Data Links

Procedure through Data Link Startup

Start the software.
Open the Datalink Component window (Data Link | Setup | Controller Link or SYSMAC LINK or SYSMAC NET).

Creating Data Link Tables Online
1) Datalink Wizard Settings (Table | Wizard). Use the manual setting function if the data link tables are to be created manually.
2) Node Edit Window Settings

Check the data link tables (Datalink Component window: Table | Validate Table).

Save the data link tables (Datalink Component window: File | Save).

Creating a CX-Server File (*.CDM) for Online Connection.
1) Select New from the Project menu, and save the file under a filename.
2) Select Add Device from the Project menu, and register the PLC.

Connect Online (CX-Net: PLC | Open).

Reading the Data Link Tables, and Transferring Them to the PLC from Datalink Component window
1) Data Link | Setup
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit mounted to the PLC. (For the local network only, i.e., when the network address is 0.)
3) File | Open
4) Online | Transfer to PLC

Starting the Data Links from the Datalink Component Window
1) Data Link | Setup
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit mounted to the PLC. (For the local network only, i.e., when the network address is 0.)
3) Online | Data Link Operation/Status
4) Select the Run option in the Operation field, and click the Set button.

Reference: Create data link tables manually when any of the following conditions is present:
1) The send area size differs for nodes participating in the data link.
2) The sequence of send nodes differs from the sequence of node addresses.
3) There are nodes that receive only part of the send data (Controller Link only).
4) There are nodes that receive data with an offset specified (Controller Link only).
5) There are nodes that do not send data (Controller Link only).
6) There are nodes that do not receive data.

Creating Data Link Tables
Create a data link table for each node registered in the CX-Server file that is read.
Make the settings for (1) to (8) below.

To create a data link table, make the following settings in order.

1. **Datalink Wizard Settings**

   1. Set participating data link nodes.
   2. Set the PLC type.
   3. Set the areas.
   4. Set the send size.
   5. Set the status area.
   6. Set the refresh node sequence.
   7. Set receive sizes from remote nodes.

2. **Node Editing Window Settings**

   1. Set offsets.

**Note 1:** It is possible to add or delete nodes from the participating data link nodes (1) using the Datalink Wizard.
PART 2: CX-Server PLC Tools

CHAPTER 10 – Data Links

Adding nodes
Select Table | Add Source Link.

Adding link words
Select Table | Add Destination.

Delete
Deleting specified nodes or link areas
Select the node from the node list, and then click F8: Delete Node.

Deleting link areas from specified nodes
Select the node from the table, and then click F8: Delete Node.

Note 2: It is possible to change the following items set by the Datalink Wizard for each node:
(2) PLC type, (3) Area (memory area and start address), (4) Send size, (5) Node refresh sequence (see note 3), and (6) Status area.

Note 3: The node refresh sequence is set using F4: Move Up Area and F5: Move Down Area.

Reference: The operations differ for Controller Link and SYSMAC LINK when creating data links. The following table shows the points on which the manually set data link functions are different.

<table>
<thead>
<tr>
<th>Function</th>
<th>Controller Link</th>
<th>SYSMAC LINK</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Offset setting</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>(2) Receive size setting</td>
<td>Supported</td>
<td>Not supported. (It is only possible to specify whether all of none of the data sent is to be received.)</td>
</tr>
<tr>
<td>(3) Memory area</td>
<td>Area 1: Can be selected. Area 2: Can be selected. (CIO, LR, DM, EM, etc., according to PLC type)</td>
<td>Area 1: CIO Area 2: DM (Fixed.)</td>
</tr>
<tr>
<td>(4) Communications cycle time setting</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

These four differences apply even to data link setup operations using the CX-Net. Aside from these points, other operations are basically the same.

System Configuration Example
The procedure is described below, from data link creation through startup, taking a Controller Link data link system as an example.

CX-Net

Peripheral Bus or Host Link

Controller Link network

<table>
<thead>
<tr>
<th>PLC type</th>
<th>CS1G-CPU45</th>
<th>CS1G-CPU45</th>
<th>C200HX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>
The refresh sequence for nodes 1 and 2 is as follows: #1, #2, #3. For node 3, the order is #2, #1, #3. Node address 03 does not receive all of the data sent from node address 02. Rather, data from the 20 words (CIO 1240 to CIO 1259) beginning from the start address +10 words (i.e., the offset) is received in IR 300 to IR 319. Other data is received with no offset.
Creating Data Link Tables Offline
First create manually set data link tables offline.

Datalink Wizard Operations
1. While offline, select Setup from the Data Link menu in CX-Net. The Data Link dialog box will be displayed.

2. Select either Controller Link or SYSMAC LINK, and then click the OK button. The Datalink Component window will be displayed.
3 Select Table | Wizard. If data link tables have already been input, the following dialog box will be displayed. (It will not be displayed if these are the first data link tables being created.)

4 Click the Yes button. The Datalink Wizard dialog box will be displayed for setting the participating data link nodes.

5 Set the addresses of the nodes that are to participate in the data links. In this case, input 1-3 to set node addresses 01 to 03. (To set node addresses 01, 02, and 04, for example, input 1, 2, 4.)

6 Click the Next button or press the Enter key. The following dialog box will be displayed.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Node</td>
<td>Displays node number to set.</td>
</tr>
<tr>
<td>(2)</td>
<td>PLC</td>
<td>Sets the PLC type.</td>
</tr>
<tr>
<td>(3)</td>
<td>Memory area</td>
<td>Area 1 memory area</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Area 2 memory area</td>
</tr>
</tbody>
</table>
### PART 2: CX-Server PLC Tools

### CHAPTER 10 – Data Links

#### No. Item Function

1. **Start Address**
   - Area 1 start address
   - Area 2 start address

2. **Size**
   - Area 1 local node send size (in words)
   - Area 2 local node send size (in words)

3. **Status**
   - Data link status memory area (See note.)

4. **Ordered Destination Nodes**
   - Node Refresh Sequence
     
     Beginning with the data link start address above, specify which nodes are to have data refreshed at the local node address and the order in which data is to be refreshed (i.e., the node refresh sequence). This order will be the same for Area 1 and Area 2.

     (For the local node address, data is sent from the local node area. For a remote node address, data is received from the remote node address to the local area.)

     **Note:**
     - The local node must be included in the refresh nodes.
     - If the address of any node participating in the data links is not entered here, data will not be received from that node.

     Example: If 1, 2, 3 is input, node addresses 1, 2, and 3 will be allocated in order, beginning with the start address.

5. **Make Default**
   - Click this button to make the values set for the above items the default values for new data link settings.

6. **Next >>**
   - Click to proceed to the next dialog box.

### Note:

- The default setting for data link status depends on the PLC being used. For details, refer to the Controller Link Units Operation Manual (W309).

<table>
<thead>
<tr>
<th>PLC</th>
<th>Data link status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS/CJ Series</td>
<td>The data link status is contained in the 16 words (fixed) from CIO 1500 +25 × unit number + 7 to 22 in the CPU Bus Unit Area.</td>
</tr>
<tr>
<td>CVM1/CV Series</td>
<td>The data link status for node addresses 1 to 6 only is contained in the words from SR 239 to SR 241, and SR 241 to SR 245.</td>
</tr>
<tr>
<td>C200HX/HG/HE</td>
<td>The data link status for node addresses 1 to 6 only is contained in the words from IR 91 to IR 93.</td>
</tr>
<tr>
<td>CQM1H Series</td>
<td>The data link status for node addresses 1 to 6 only is contained in the words from IR 91 to IR 93.</td>
</tr>
</tbody>
</table>

7. Set node address 01 as shown in the following table, and then click the Next button or press the Enter key. Set node addresses 02 and 03 in the same way.

<table>
<thead>
<tr>
<th>Item</th>
<th>Data set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PLC type</td>
<td>CS1G-CPU45</td>
<td></td>
</tr>
<tr>
<td>Area 1</td>
<td>Memory area</td>
<td>CIO</td>
</tr>
<tr>
<td></td>
<td>Start address</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>Send size</td>
<td>30</td>
</tr>
<tr>
<td>Area 2</td>
<td>Memory area</td>
<td>D</td>
</tr>
<tr>
<td></td>
<td>Start address</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>Send size</td>
<td>30</td>
</tr>
</tbody>
</table>
Ordered destination nodes | 1, 2, 3 | Specifies the node refresh sequence. Beginning with the start addresses, nodes 01, 02, and 03 are set in order. (The local node address is 1, so transmission is first, followed by reception from node 02, and finally reception from node 03.)

Status
Memory area | CIO | Sets CIO 1100 as the data link status start address.
Start address | 1100 |

8. Set node address 02 as shown in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Data set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>2</td>
<td>–</td>
</tr>
<tr>
<td>PLC type</td>
<td>CS1G-CPU45</td>
<td>–</td>
</tr>
<tr>
<td>Area 1 Memory area</td>
<td>CIO</td>
<td>Sets CIO 1200 as the data link start address for the Area 1 local node.</td>
</tr>
<tr>
<td>Start address</td>
<td>1200</td>
<td></td>
</tr>
<tr>
<td>Send size</td>
<td>30</td>
<td>Sets 30 words as the send size (unit: words) for the Area 1 local node.</td>
</tr>
<tr>
<td>Area 2 Memory area</td>
<td>D</td>
<td>Sets D00600 as the data link start address for the Area 2 local node.</td>
</tr>
<tr>
<td>Start address</td>
<td>600</td>
<td></td>
</tr>
<tr>
<td>Send size</td>
<td>30</td>
<td>Sets 30 words as the send size (unit: words) for the Area 2 local node.</td>
</tr>
<tr>
<td>Ordered destination nodes</td>
<td>1, 2, 3</td>
<td>Specifies the node refresh sequence. Beginning with the start addresses, nodes 01, 02, and 03 are set in order. (Reception from node 01 is first, followed by transmission from the local node address.)</td>
</tr>
<tr>
<td>Data link status start address Memory area</td>
<td>CIO</td>
<td>Sets CIO 1300 as the data link status start address.</td>
</tr>
<tr>
<td>Start address</td>
<td>1300</td>
<td></td>
</tr>
</tbody>
</table>

9. Set node address 03 as shown in the following table, and then click the Next button or press the Enter key.

<table>
<thead>
<tr>
<th>Item</th>
<th>Data set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node address</td>
<td>3</td>
<td>–</td>
</tr>
<tr>
<td>PLC type</td>
<td>C200HX</td>
<td>–</td>
</tr>
<tr>
<td>Area 1 Memory area</td>
<td>IR</td>
<td>Sets IR 300 as the data link start address for the Area 1 local node.</td>
</tr>
<tr>
<td>Start address</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Send size</td>
<td>40</td>
<td>Sets 40 words as the send size (unit: words) for the Area 1 local node.</td>
</tr>
<tr>
<td>Area 2 Memory area</td>
<td>DM</td>
<td>Sets DM 700 as the data link start address for the Area 2 local node.</td>
</tr>
<tr>
<td>Start address</td>
<td>700</td>
<td></td>
</tr>
<tr>
<td>Send size</td>
<td>40</td>
<td>Sets 40 words as the send size (unit: words) for the Area 2 local node.</td>
</tr>
<tr>
<td>Ordered destination nodes</td>
<td>2, 1, 3</td>
<td>Specifies the node refresh sequence. Beginning with the start addresses, nodes 02, 01, and 03 are set in order. (Reception from node 02 is first, followed by reception from node 01, and finally transmission from the local node address.)</td>
</tr>
<tr>
<td>Data link status start address Memory area</td>
<td>LR</td>
<td>Sets LR 0 as the data link status start address.</td>
</tr>
<tr>
<td>Start address</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
Reference: Fast Datalink Wizard Settings
It is possible to generate a table with all nodes set for the same PLC type and the same
areas (using Fast Default Table Generation), and then to modify individual nodes in the
Node Editing window as required.
Make the settings as follows:

1. Click the **Defaults** button and then set the default values in the following
dialog box.

2. Select the **Fast Default Table Generation** option, and then click the **Next**
button or press the Enter key.
The settings for all participating nodes will be generated at the above
default values.

- PLC type
- Memory area, data link start address, communications data size
- Status memory area
Node Editing Window Settings

10 The following Datalink Component window will be displayed.

Data Link Configuration Window

Send areas are indicated by ovals in order of the addresses of nodes participating in the data links. The same color indicates that data is shared among nodes. Therefore, with the number of participating nodes represented by n, one oval and n-1 rectangles are shown for each node.

This window can be used to check the data sent and received between nodes.
**Node Editing Window Settings**

Set the data link details for each node (i.e., send size, receive size, reception offset) in the Node Editing window.

**Note:** The Node Edit window appears in table format by default, as shown below. To convert it back into the earlier list format, select View | Show in List.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Node</td>
<td>Selects the address of the node to be edited. The settings for an active node (selected with [ ] ) are displayed to the right.</td>
</tr>
<tr>
<td>(2)</td>
<td>PLC</td>
<td>The PLC type set by the Datalink Wizard is displayed and can be changed here.</td>
</tr>
<tr>
<td>(3)</td>
<td>Status</td>
<td>The status memory area and start address set by the Datalink Wizard are displayed and can be changed here.</td>
</tr>
<tr>
<td>(4)</td>
<td>Area 1/Area 2</td>
<td>The Area 1 and Area 2 classifications and start addresses set by the Datalink Wizard are displayed and can be changed here.</td>
</tr>
<tr>
<td>(5)</td>
<td>Node (Display only. Order can be changed.)</td>
<td>Node addresses are displayed from top to bottom, in order of node refreshing at the local node (in order of allocated node address). To change the refresh sequence set by the Datalink Wizard, click either F4: Move Up Area or F5: Move Down Area in the Function Bar, or press the corresponding Function key.</td>
</tr>
<tr>
<td>(6)</td>
<td>Link Addr. (Automatic display)</td>
<td>For the local node send area, the start address of the data sent from the local node is automatically displayed. For the receive area from remote nodes, the local node start address for storing data received from remote nodes is automatically displayed.</td>
</tr>
<tr>
<td>(7)</td>
<td>Size (Setting/Display)</td>
<td>For the local node send area, the send size set by the Datalink Wizard is displayed and can be changed here. For the receive area from remote nodes, the receive size from remote nodes is set here in word units. (It can only be set here.) The default is the entire send size from remote nodes.</td>
</tr>
<tr>
<td>(8)</td>
<td>Offset (Setting/Display)</td>
<td>The reception offset from the source start address displayed at “Src. Addr.” is set here. (The default is 0.)</td>
</tr>
<tr>
<td>(9)</td>
<td>Src. Addr. (Automatic display)</td>
<td>For the local node send area, “Send” is automatically displayed. For the receive area from a remote node, the remote node’s source start address (the value before the offset) is automatically displayed.</td>
</tr>
<tr>
<td>(10)</td>
<td>F4: Move Up Area, F5: Move Down Area</td>
<td>Changes the node refresh sequence.</td>
</tr>
</tbody>
</table>
Node Editing Window (Edited Node Address: Node 01)

<table>
<thead>
<tr>
<th>Node</th>
<th>Link Addr</th>
<th>Size</th>
<th>Offset</th>
<th>Src Addr</th>
</tr>
</thead>
<tbody>
<tr>
<td>03</td>
<td>01000</td>
<td>20</td>
<td>0</td>
<td>000000</td>
</tr>
<tr>
<td>01</td>
<td>01020</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>01050</td>
<td>40</td>
<td>0</td>
<td>00200</td>
</tr>
</tbody>
</table>

Function

1. Indicates that 20 words (D00000 to D00019) from a remote node (node 03) are received into the area starting from CIO 01000 (i.e., CIO 01000 to CIO 01019) at the local node (node 01).

2. Indicates that 30 words starting from CIO 01020 (i.e., CIO 01020 to CIO 01049) from the local node (node 01) are sent to a remote node.

3. Indicates that 40 words (CIO 00200 to CIO 00239) from a remote node (node 02) are received into the area starting from CIO 01050 (i.e., CIO 01050 to CIO 01089) at the local node (node 01).

Reference: It is also possible to display the Node Editing window in list format, as before. Select View | Show in List from the menu. The change will go into effect the next time the window is opened.

Setting Size (Send or Receive) and Offset

- The send size can be set for the local node row by double-clicking in the Size cell. (The default is the size set by the Datalink Wizard.) For remote node rows, the receive size can be set. (The default is the entire send size from remote nodes.)
- The reception offset can be set by double-clicking the Offset cell. (The default is 0.)

Automatically displayed.
Reference: Size modifications and offsets can be set in the Area Specify dialog box that is displayed by double-clicking on the data link configuration icon (oval for send area or rectangular for receive area).

Area Specify Dialog Box (Send Area)

Area Specify Dialog Box (Receive Area)

Note: With SYSMAC LINK, the send size can be set, but the receive size and the reception offset cannot. Therefore, the Area Specify dialog boxes are as shown in the following example diagrams.

- **Send Area**
  - Can be set.

- **Receive Area**
  - Cannot be set.
**Changing Node Refresh Sequences**

The node refresh sequence set for each node by the Datalink Wizard can be changed in the Node Editing window. In the Node Editing window, select the node for which the refresh sequence is to be changed.

Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in the Function Bar, or pressing the F4 or F5 function keys.

**Reference:** The node refresh sequence for individual nodes cannot be checked in the Data Link Configuration window. Node refresh sequence checking and changes must be performed in the Node Editing window.

**Adding Participating Nodes to Data Links**

In the Node Editing window, it is possible to add nodes aside from the participating nodes set by the Datalink Wizard’s Network Nodes setting.

The following window is displayed by selecting Table | Add Source Node from the Datalink Component menu or by clicking the button in the Toolbar.

Specify the node address, PLC type, and the Area 1 and Area 2 memory areas, and then click the OK button.
The node will be added.

Deleting Nodes Added to the Data Links
Select the node to be deleted from the Node Editing window.
Delete the node by clicking the F8: Delete Node button in the Function Bar.

Caution: If the node is deleted by clicking the button in the Toolbar, the deletion will be executed immediately.

Setting to Not Receive Data
Set the receive size to 0 in the Node Editing window.

Setting to Not Send Data
Set the send size to 0 in the Node Editing window.
Procedure Using Setup Example

Set Area 1 for each node, based on the data link setup example in the example system configuration.

**Note:** The receive size and reception offset can only be set for Controller Link, and not for SYSMAC LINK.

**Setting Node Address 01**

1. Select node address 01 from the node address list on the left. Node 01 will be highlighted.

The data link table for node address 01, the node to be edited, is displayed as a list in the Node Editing window on the right.

Reference: With node address 01, the node refresh sequence matches the default (order of addresses), so no change is required. With node address 01, the size and offset are both automatically displayed as the defaults, so no changes are required.

2. With node address 01, the node refresh sequence matches the default (order of addresses), so no change is required. With node address 01, the size and offset are both automatically displayed as the defaults, so no changes are required. Settings for area 2 are made using the same method.
**Setting Node Address 02**

Node address 02 is set in the same way as node address 01.

<table>
<thead>
<tr>
<th>Node</th>
<th>Link Addr</th>
<th>Size</th>
<th>Offset</th>
<th>Src Addr</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>01 240</td>
<td>30</td>
<td>0</td>
<td>01000</td>
</tr>
<tr>
<td>02</td>
<td>01 230</td>
<td>30</td>
<td>----</td>
<td>Send</td>
</tr>
<tr>
<td>03</td>
<td>01 260</td>
<td>10</td>
<td>0</td>
<td>00350</td>
</tr>
</tbody>
</table>

**Setting Node Address 03 (Setting an Offset)**

For node address 03, the procedure for setting the node refresh sequence and the offset is as follows:

1. Select node address 03 from the node address list on the left.
2. With node address 03, the node refresh sequence does not match the default, so the order of addresses must be changed. Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in the Function Bar, or pressing the F4 or F5 function keys.
3. Double-click on the Offset cell, and input the data size to be offset. In this example, set the offset size to 10 words.

With this setting, 20 words sent from node 01 will be received, starting from CIO 1000, and with an offset of 10 words (i.e., CIO 1010 to CIO 1030).
Checking Data Link Tables

1. Select Table \(\text{Validate Table}\) in the Data Link Editor (Controller Link or SYSMAC LINK). The results of the check will be displayed as shown in the following illustration.

Printing Data Link Tables

Follow the procedure below to print data link tables that have been generated.

1. Select File \(\text{Print}\) in the Data Link Editor (Controller Link or SYSMAC LINK).

Printing Example:
Saving Data Link Tables

Follow the procedure below to save data link tables that have been generated. Data link tables are saved with a .cl3 file name extension as the default. It is also possible to save them in .csv format.

1. Select **File | Save As** in the Data Link Editor (Controller Link or SYSMAC LINK). The Save As dialog box will be displayed.
2. Input the file name (“Sample” in this example), and specify the location where the file is to be saved. Then click the **Save** button. The data will be saved to a file with a .cl3 extension added to the file name (i.e., “Sample.cl3” in this case).

Creating, Reading, and Writing CSV Files (Saving)

Creating CSV Files

Based on the CSV-format template file (Sample1.csv) provided with this software, it is possible to create files in CSV format for data link tables created manually using spreadsheet software (such as MS Excel).

Including the Sample1.csv file, there are three types of files provided as reference material. The other two, in addition to Sample1.csv, are Sample1.xls (which describes tags and data), and Sample1.cl2 (data link table file format).

(Sample1.xls window)

Reading CSV Files

Files in CSV format can be read to data link tables.

1. Select **Controller Link** or **SYSMAC LINK** in the main CX-Net window (**Data Link | Setup** in the CX-Net PLC Network Configuration Tool dialog box). The Datalink Component dialog box will be displayed.
2. Select **Open** from the **File** menu, and then select *.*.csv from the File of Type field.
Writing CSV Files (Saving)

Once data link tables have been created, they can be written to CSV-format files.

1. Select **Save As** from the **File** menu in the Datalink Component dialog box, and then select *.csv from the File of Type field.

The following illustration provides an example of a written CSV file.

![Example CSV File](image)

**Note:** When displayed by spreadsheet software (such as MS Excel).

### Types of Data Written to CSV Files

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Description</th>
<th>Set value</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) &lt;network-param&gt;</td>
<td>&lt;network-type&gt;</td>
<td>The network type (CLK/SLK).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CLK network: CLK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLK network: SLK</td>
</tr>
<tr>
<td></td>
<td>&lt;cycletime&gt;</td>
<td>The communications cycle time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 to 255. Enabled only when &lt;network-type&gt; is set to SLK, and ignored when &lt;network-type&gt; is set to CLK.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>An error will be generated if an out-of-range value is set when a file is loaded.</td>
</tr>
<tr>
<td></td>
<td>&lt;author&gt;</td>
<td>The name of the author</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLK: (Table information) author</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set any text string (with up to 30 characters). Enabled only when &lt;network-type&gt; is set to SLK.</td>
</tr>
<tr>
<td></td>
<td>&lt;information&gt; (Title or node information)</td>
<td>Input file information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CLK: Node information</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLK: (Table information) title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set any text string (with up to 30 characters).</td>
</tr>
<tr>
<td></td>
<td>&lt;comment&gt;</td>
<td>Comment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SLK: (Table information) comment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set any text string (with up to 255 characters). Enabled only when &lt;network-type&gt; is set to SLK, and ignored when &lt;network-type&gt; is set to CLK.</td>
</tr>
<tr>
<td>Tag name</td>
<td>Description</td>
<td>Set value</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;node-param&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;node&gt;</td>
<td>The node No. for the link.</td>
<td>1 to 62. An error will be generated if an out-of-range value is set when a file is loaded.</td>
</tr>
<tr>
<td>&lt;status-start-type&gt;</td>
<td>The status start address and the memory area.</td>
<td>Any of the following memory areas can be specified, regardless of the PLC type.</td>
</tr>
<tr>
<td>&lt;status-start-ch&gt;</td>
<td>The start address for the status area.</td>
<td>The range differs depending on the status area type.</td>
</tr>
</tbody>
</table>
### Tag name

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>Set value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(3) &lt;area1&gt;</strong>&lt;br&gt;(Link Area 1 type)</td>
<td>Specify the area type for Link Area 1.</td>
<td>Same as for status area type.</td>
</tr>
<tr>
<td><strong>&lt;start-type&gt;</strong></td>
<td>(Link Area 1 start address)</td>
<td>The beginning word for Link Area 1.</td>
</tr>
<tr>
<td><strong>&lt;start-ch&gt;</strong></td>
<td>Node address</td>
<td>The node address for linking at Link Area 1.</td>
</tr>
<tr>
<td><strong>&lt;link-area&gt;</strong></td>
<td>Link start address</td>
<td>Link word</td>
</tr>
<tr>
<td></td>
<td>Link size</td>
<td>Size (Unit: words)</td>
</tr>
<tr>
<td></td>
<td>Offset size</td>
<td>Offset</td>
</tr>
<tr>
<td><strong>(4) &lt;area2&gt;</strong>&lt;br&gt;(Link Area 2 type)</td>
<td>The area type for Link Area 2.</td>
<td>Same as for status area type.</td>
</tr>
<tr>
<td><strong>&lt;start-type&gt;</strong></td>
<td>(Link Area 2 start address)</td>
<td>The beginning word for Link Area 2.</td>
</tr>
<tr>
<td><strong>&lt;start-ch&gt;</strong></td>
<td>Node address</td>
<td>The node address for linking at Link Area 2.</td>
</tr>
<tr>
<td><strong>&lt;link-area&gt;</strong></td>
<td>Link start address</td>
<td>Link word</td>
</tr>
<tr>
<td></td>
<td>Link size</td>
<td>Size (Unit: words)</td>
</tr>
<tr>
<td></td>
<td>Offset size</td>
<td>Offset</td>
</tr>
</tbody>
</table>
An example text data configuration for a CSV file is shown below.

```xml
<net-param>
<network-type>SLK
<net-time>0
<author>,
<comment>,
</net-param>
</node-param>
</node>
<interval>1,...,2,...,3,...
<cpu>CS/CJ,..CS/CJ,..CS/CJ,..</interval>
<status-start-type>,.........
<status-start-ch>,00000...,00000...,00000...
</node-param>
</area>
<area>
<start-type>,...........
<start-ch>,00000...,01200...,00300...
</link-area>,1,01000,30,1,01200,30,1,00300,30.
</link-area>,2,01000,30,2,01200,30,2,00300,30.
</link-area>,3,01000,10,3,01200,10,3,00300,10.
</area>
</area2>
<start-type>,D,...,D,...
<start-ch>,00500...,00600...,00700...
</link-area>,1,00500,30,1,00600,30,1,00700,30.
</link-area>,2,00500,30,2,00600,30,2,00700,30.
</link-area>,3,00500,40,3,00600,40,3,00700,40.
</area2>
</area>
```

**Note:** Commas are used for delineation. (They are added when there are blank cells.)
Connecting Online

After the PLC has been registered, select either of the following types of registered PLCs for connecting online, depending on the CX-Net function used.

1) PLCs registered for direct connection
2) PLCs registered as nodes on a network

<table>
<thead>
<tr>
<th>CX-Net function</th>
<th>PLC registered for online connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controller Link</td>
<td>Not supported. (See note.) Supported</td>
</tr>
<tr>
<td>SYSMAC LINK</td>
<td>Not supported. (See note.) Supported</td>
</tr>
<tr>
<td>SYSMAC NET</td>
<td>Supported Not supported.</td>
</tr>
</tbody>
</table>

**Note:** If there is a routing table, node address 0 is possible.

When transferring Controller Link or SYSMAC LINK data link tables, therefore, online connection is required for PLCs registered as nodes on a network.

**Example: Connecting PLC1 (Registered as a Node on a Network) Online**

1. In the CX-Net project workspace, select the PLC to be connected online.
2. In the project workspace, select PLC1, and then select Open from the PLC menu. PLC1 will be connected online, and the display will change as follows:

   ![Example: Connecting PLC1 (Registered as a Node on a Network) Online]

   To go back offline, again select Open from the PLC menu.
Reading and Transferring Data Link Tables

After a data link table has been created, follow the procedure below for reading it and transferring it to all nodes participating in the data links.

Reading the Data Link Table
1. Select **Data Link | Setup** from the CX-Net. The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)

2. Select **Controller Link** or **SYSMAC LINK**, and then click the **OK** button. Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC LINK) window will be displayed.

3. Select **File | Open**. The Open dialog box will be displayed.

4. Select the data link table file (Sample.cl3 in this example,) and then click the **Open** button.
The data link tables will be read as shown below.

Note: Before selecting Data Link Setup, make sure that the PLC can be connected online.

Transferring the Data Link Table

Transferring to All Nodes on the Network

1. Select Set All Nodes for Network Operation from the Datalink Component’s Online menu. Selecting this operation allows the data link tables to be transferred simultaneously to multiple PLCs.
2. Select Online | Transfer to PLC. The following dialog box will be displayed.

   ![Dialog box image]

3. Click the Yes button.
4. An error list will be displayed.
5 The data link tables will be transferred.
6 The transfer results will be displayed.

**Note:** As long as all the data link tables can be transferred to all of the PLCs attempted, Set All Nodes for Network Operation can be selected to transfer the data link tables simultaneously to multiple PLCs. If there are any PLCs with the power turned OFF, or with disconnected cables, use the following method to transfer the data link table to one PLC at a time.

**Note:**
- CX-Programmer (CX-Net) Ver. 3.2 or later is required to use the Controller Link Support Board as a Network Support Board (NSB).
- When using a SYSMAC Link Support Board or CX-Programmer (CX-Net) Ver. 3.1 or earlier, data link tables can be transferred only to a single Network Support Board (NSB) node. Always use the following method to transfer data link tables to all the nodes on the network.
  1. Use the mouse to select any node other than the Network Support Board in the Data Link Configuration window or the Node Editing window of the Datalink Component window.
  2. Select **Set All Nodes for Network Operation** from the Online menu in the Data Component window.
  3. Select **Transfer to PLC** from the Online menu.
  4. The data link tables are transferred after the check is completed.

**Transferring to Individual Nodes on the Network**

1. Select the transfer destination node address from the Node list in the Datalink Component.

Make sure that **Set All Nodes for Network Operation** is not selected in the Online menu.

2. Select **Online | Transfer to PLC**. The following dialog box will be displayed.
3 Click the **Yes** button.
4 An error list will be displayed.
5 The data link tables will be transferred.
6 The transfer results will be displayed.

### Starting and Stopping Data Links (Including Status Displays)

Before performing the operations described below, connect online to a node where the data link table has been transferred. As long as the data link table is stored there, data link starting and stopping can be executed from any node.

**Note:** When starting data links with manual setup, the data link mode for the startup node must be set to manual.

#### Starting Data Links

1 Select **Data Link | Setup** from the CX-Net.

   The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)

2 Select **Controller Link** or **SYSMAC LINK**, and then click the **OK** button.

   Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC LINK) window will be displayed.
3 Select Datalink Operation/Status from the Online menu. The Datalink Status dialog box will be displayed. As shown below, the status of various items is displayed. The communications cycle time and refresh cycle time are updated only when this window is opened or when the PLC operating status is changed.

![Datalink Status dialog box]

4 Select either the Run or Stop option and then click the Set button.

5 Select the Run option in the Operation field. Click the Set button. The data links will start, and the Operational Status box will be displayed.

![Operational Status]

Note:
- The data link mode (manual/automatic) and data link operation are determined by the data link setup at the startup node. With manual setting the links, it is necessary to set, for the startup node, the data link table and the data link mode (manual setting) in the DM parameter area. If these are not set correctly, the data links will not start.
- Check the following points before starting the data links. With manual setting, the appropriate data link table must be set for each node executing the data links. Data link tables must be deleted for nodes that are not participating in the data links. Also, even when the correct data link tables are set, make sure that there will be no effect on the equipment before starting or stopping the data links.

Stopping Data Links
1 Click the Stop option in the Operation field of the Datalink Status dialog box.
2 Click the Set button. The data links will be stopped.
Automatically Set Data Links

This section explains how to make the settings for automatically set data links.

Make the settings in the Automatic Datalink (Controller Link) or Automatic Datalink (SYSMAC LINK) dialog box.

First make the settings for data link operation at PLC startup, and for the automatic data link setup parameters, and then transfer the data to the startup node.

When using automatically set data links, there is no need to create data link tables with the Data Link Editor.

Procedure Through Data Link Startup

1. Create a CX-Server file (*.CDM) for connecting online.
   1) Select New from the Project menu and save the setting under a file name.
   2) Select Add Device from the Project menu, and register the PLC (as a node on the network).

2. Connect online to the startup node PLC (registered as a node on the network).
   (Select the startup node PLC and then select PLC | Open from the CX-Net.)

3. Set the automatic data link setup parameters.
   1) Select Data Link | Setup.
   2) Select Controller Link Unit or SYSMAC LINK Unit as the Communications Unit mounted to the PLC. (For the local network only, i.e. when the network address is 0.)
   3) Select PLC | Setup in the Datalink Component window.
   4) Select Automatic in the Generation Type field in the Automatic Datalink dialog box, and make the settings for the automatically set data link areas (start word, size, and nodes participating in data links, for Area 1 and Area 2).

4. To have the data links started when the PLC is started, set Start for the status at startup.

5. Transfer the automatic data link setup parameters to the startup node. (Click the Write button.)

6. Turn ON the power to the PLC.

7. Start the data links.
   Datalink Component Data Link Status operation
   1) Online | Status
   2) Select the Run option in the Operation field, and then click the Set button.
Controller Link Automatic Setup

1. Before executing the following operations, connect online to the PLC that is serving as the startup node.
2. Select **Data Link | Setup** from the CX-Net. (For local network only, i.e., when network address is 0.)

   ![Data Link Setup (Local)](image)

   Clicking on this down arrow will display the Communications Units mounted to the PLC, as shown below.

3. Select **Controller Link**, and then click the **OK** button.
   The Datalink Component (Controller Link) window will be displayed.

   ![Datalink Component](image)

4. Select **Automatic Datalink Setup** from the Online menu.
   The Automatic Datalink (Controller Link) dialog box will be displayed.

   ![Automatic Datalink Setup](image)
Controller Link

Select Automatic. (If Manual is selected, data link tables created by the user will be used.)

If Automatic is selected, data link parameters can be set.

When Read or Write is executed, the results are displayed here.

5 Select Start or Stop in the Power Up Run State field.
   **Note:** Selecting Start causes the data links to start when the PLC is powered up, without having to perform any other data link startup operation.
   When Automatic is selected, the automatic data link setup parameters can be set, as shown below.

Controller Link

Make the settings for Area 1. Set the area for executing the data links, the start word, and the size.

Make the settings for Area 2. Set the area for executing the data links, the start word, and the size.

7 Set the automatic data link setup parameters.
SYSMAC LINK Automatic Setup

1. Before executing the following operations, connect online to the PLC that is serving as the startup node.
2. Select **Data Link** | **Setup** from the CX-Net. (For local network only, i.e., when network address is 0.)

3. Select **SYSMAC LINK**, and then click the **OK** button.
   The Datalink Component (SYSMAC LINK) window will be displayed.

4. Select Automatic Datalink Setup from the Online menu.
   The Automatic Datalink (SYSMAC LINK) dialog box will be displayed.
Select the memory area for automatic setup (CIO Area only, DM Area only, or CIO and DM Areas), and select the area and word settings from the following list.

### Word Allocations for SYMASC LINK Automatic Setup (Example: CS/CJ Series, CVM1/CV Series)

<table>
<thead>
<tr>
<th>CIO Area (words)</th>
<th>DM Area (words)</th>
<th>Area and word settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO 1000 to CIO 1003</td>
<td>D00000 to D00007</td>
<td>#1</td>
</tr>
<tr>
<td>CIO 1004 to CIO 1007</td>
<td>D00008 to D00015</td>
<td>#2</td>
</tr>
<tr>
<td>CIO 1008 to CIO 1011</td>
<td>D00016 to D00023</td>
<td>#3</td>
</tr>
<tr>
<td>CIO 1012 to CIO 1015</td>
<td>D00024 to D00031</td>
<td>#4</td>
</tr>
<tr>
<td>CIO 1016 to CIO 1019</td>
<td>D00032 to D00039</td>
<td>#5</td>
</tr>
<tr>
<td>CIO 1020 to CIO 1023</td>
<td>D00040 to D00047</td>
<td>#6</td>
</tr>
<tr>
<td>CIO 1024 to CIO 1027</td>
<td>D00048 to D00055</td>
<td>#7</td>
</tr>
<tr>
<td>CIO 1028 to CIO 1031</td>
<td>D00056 to D00063</td>
<td>#8</td>
</tr>
<tr>
<td>CIO 1032 to CIO 1035</td>
<td>D00064 to D00071</td>
<td>#9</td>
</tr>
<tr>
<td>CIO 1036 to CIO 1039</td>
<td>D00072 to D00079</td>
<td>#10</td>
</tr>
<tr>
<td>CIO 1040 to CIO 1043</td>
<td>D00080 to D00087</td>
<td>#11</td>
</tr>
<tr>
<td>CIO 1044 to CIO 1047</td>
<td>D00088 to D00095</td>
<td>#12</td>
</tr>
<tr>
<td>CIO 1048 to CIO 1051</td>
<td>D00096 to D00103</td>
<td>#13</td>
</tr>
<tr>
<td>CIO 1052 to CIO 1055</td>
<td>D00104 to D00111</td>
<td>#14</td>
</tr>
<tr>
<td>CIO 1056 to CIO 1059</td>
<td>D00112 to D00119</td>
<td>#15</td>
</tr>
<tr>
<td>CIO 1060 to CIO 1063</td>
<td>D00120 to D00127</td>
<td>#16</td>
</tr>
</tbody>
</table>
Transferring Automatic Data Link Setup Parameters to the Startup Node

The automatic data link parameters that have been set are then sent to the connected startup node PLC. It is also possible to read the automatic data link parameters that have been set for the PLC.

Transferring Data to the Startup Node PLC

1. Click the **Write** button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup dialog box.
   The following dialog box will be displayed for confirmation.

2. Click the **Yes** button.
   The set data will be transferred to the startup node PLC.

   **Note:**
   - The data link mode (manual/automatic) and data link operation are determined by the data link setup at the startup node. With automatic setup, it is necessary to set, for the startup node, the data link mode (automatic) and the number of data link words in the Automatic Datalink Setup dialog box. If these are not set correctly, the data links will not start.
   - Before starting the data links with automatic setup, make sure that the correct automatic data link setup parameters are set for the data link startup node. If incorrect automatic data link setup parameters are set, it may cause the equipment to operate unpredictably. Even when the correct parameters are set, make sure that there will be no adverse effect on the equipment before starting or stopping the data links.

Reading Data from the Startup Node

Perform this operation to check or change settings.

1. Click the **Read** button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup dialog box.
   The following dialog box will be displayed for confirmation.

2. Click the **Yes** button.
   The set data will be transferred from the PLC and displayed at the Automatic Datalink (Controller Link) or the Automatic Datalink Setup dialog box.
Monitoring Data Link Status

Monitoring Data Link Status, Such as Communications Cycle Time
1 Select the startup node PLC in the Project workspace.
2 Select Open from the PLC menu to connect online.
3 Select Data Link | Setup.
4 Select Controller Link or SYSMAC LINK, and then click the OK button. The Datalink Component dialog box will be displayed.
5 Select Online and then Datalink Operation/Status. The Data Link Status dialog box will be displayed.
6 The following items will be displayed in the Network Properties field:
   - Data link start word, polling node number, communications cycle time, and data link refresh cycle time
   - PV/maximum value.
   The following items will be displayed in the Operational Status field for each node:
   - CPU Unit error status, data link operation status, CPU unit operation mode, and communications status

Monitoring Data Link Status and Network Error Status from CX-Net
1 While online, open the I/O table window and select either Controller Link or SYSMAC LINK. Right-click and select the software switch.
2 The following items can be monitored for a particular Controller Link Unit.

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Displays the words allocated in the CIO and DM Areas.</td>
</tr>
<tr>
<td>Error Information</td>
<td>Network parameter errors, data link table errors, routing table errors, PLC setup errors, EEPROM write errors, node address duplication errors, network parameter verification errors, communications controller transmission errors, communications controller errors, and error log</td>
</tr>
<tr>
<td>Data Link</td>
<td>Startup node address, polling node address, and local node data link participation status</td>
</tr>
<tr>
<td></td>
<td>Data link status as seen from each node (PLC operation status, PLC errors, communications errors, data link participation status, offset errors, and reception area insufficient or surplus space)</td>
</tr>
<tr>
<td>Network Status</td>
<td>Network participation status for each node</td>
</tr>
<tr>
<td>Status</td>
<td>Termination resistance status, power ON status</td>
</tr>
</tbody>
</table>
The following items can be monitored for a particular SYSMAC LINK Unit.

<table>
<thead>
<tr>
<th>Tag name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Displays the words allocated in the CIO and DM Areas.</td>
</tr>
<tr>
<td>Error Information</td>
<td>Data link errors, node setting errors, routing table errors, communications controller errors, communications setting errors, data verification errors, duplicate No. errors, parameter errors, error logs, and EPROM write errors</td>
</tr>
<tr>
<td>Network Status</td>
<td>Local node address, local network address, polling node local address, unit number, power supply, internode test, and network node address</td>
</tr>
<tr>
<td>Data Link</td>
<td>Data link status (PLC operation status, PLC errors, communications errors, data link participation status, offset errors, and reception area insufficient space or surplus space)</td>
</tr>
<tr>
<td>Internode Test (Parameters) (See note.)</td>
<td>Test beginning and end, test destination node address, test destination network address, number of bytes sent, and response monitor timer values</td>
</tr>
<tr>
<td>Internode Test (Results) (See note.)</td>
<td>Test destination address, test destination network address, number of bytes sent, response monitor timer values, number of resend errors, number of non-responses, number of frame overruns, number of tests, number of errors, number of token timeouts, number of relay node routing failures, number of local node routing failures, routing error MRES, routing error node address, number of times local node failed to participate, number of times data did not match, number of times test destination node busy, routing error SRES, routing error network address, and test status</td>
</tr>
</tbody>
</table>

**Note:** Supported for CVM1 and CV-series SYSMAC LINK Units only.
CHAPTER 11
Routing Tables

Routing tables allow networked PLCs to be configured so that they can communicate with each other via gateways; across remote networks. The routing tables contain the network, unit number information required. It is only necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC as a gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different types of PLC and networks have different capabilities for routing.

<table>
<thead>
<tr>
<th>PLC</th>
<th>Network</th>
<th>Routing Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-series</td>
<td>SYSMAC LINK</td>
<td>N/A</td>
</tr>
<tr>
<td>C-series</td>
<td>SYSMAC NET</td>
<td>C-SYSMAC NET</td>
</tr>
<tr>
<td>C-series</td>
<td>Controller Link</td>
<td>FINS</td>
</tr>
<tr>
<td>C-series</td>
<td>Ethernet</td>
<td>N/A</td>
</tr>
<tr>
<td>CV-series</td>
<td>SYSMAC LINK, SYSMAC NET, Ethernet or Controller Link</td>
<td>FIN</td>
</tr>
<tr>
<td>CS1-series</td>
<td>SYSMAC LINK, Device Net, Controller Link or Ethernet</td>
<td>FIN</td>
</tr>
<tr>
<td>CJ1-series</td>
<td>SYSMAC LINK, Device Net, Controller Link or Ethernet</td>
<td>FIN</td>
</tr>
</tbody>
</table>

The Routing Table menus are accessed from the PLC Network Configuration Tool dialog and contain options allowing the editing and setup of routing tables both offline and online. The routing tables which are being used in a network, can be viewed online.

Different online Routing Table Setup dialogs are used, depending upon the protocol associated with the routing table. The way in which they are displayed and operate is similar in each case.

The PLC Network Configuration Tool dialog, visually displays the structure of the routing table associated with the PLC (including the destination node and network gateway employed in directing data across the network). Initially the visual representation of the routing table is empty, or set to zero, until a routing table file has been opened. An overview of the routing table can also be viewed and edited in a graphical or tabular format.

Opening an existing Routing Table

Use the following procedure to open an existing routing table in a project.

1. Open the PLC Network Configuration Tool dialog from the Routing Table menu, select Editor, and then the type of table.
2. From the Routing Table File menu select Open Routing Table File.
3. From the list of possible files, select the file to be opened.

The following procedure can also be used as a shortcut to opening an existing routing table.

1. Open the PLC Network Configuration Tool dialog and from the Project menu options select Open.
2. In the Open Project dialog select the File Type as All Files(*.*)
3. In the Open Project dialog select the appropriate device type and click the Open button.
4. From the list in the Project Devices window select the network to be opened.
5. From the Routing Table menu, select Editor and then the required network type.

Note: Routing tables have an ‘.RT2’ (SYSMAC NET), ‘.RTG’ for FinsLocal or ‘.RT3’ (FINS) Network filename extension.

Creating a new Routing Table

Use the following procedure to create a new routing table within a project.

1. Open the PLC Network Configuration Tool dialog from the Project menu options and select New.
2. In the Create Project dialog enter a file name for the new table, navigate to the folder where the file is to be saved and click the **Save** button.

3. From the PLC Network Configuration Tool Project menu select **Add Device**.

4. In the Add PLC dialog Enter a Device Name and select a Device Type and Network Type from the dropdown menu. And click **OK**.

5. From the PLC Network Configuration Tool click on the device name in the Project Device window.

6. From the Routing Table menu, select **Editor** and then the required network type.

### Adding a Local Network

Use the following procedure to add a local network to a routing table.

1, 2, 3...

1. Open the PLC Routing Table window and select the SIOU tab in the left hand pane and the Main View tab in the right hand pane.

2. Select the Unit from the SIOU list to which the local network is to be added then right click on the that unit and select the **Insert CPU SIOU** option.

3. From the Enter SIOU Details dialog enter the:

   **Local Network Number.** This is the ID number that uniquely identifies the local network in the routing table. Each new network must be given a unique ID number in the range of 1 to 127.

   **Local Network Type.** Select the type of local network from the drop down menu. The network type selected will be displayed in the diagram.

4. Click **OK** to close the SIOU dialog and add the local network to the selected unit.

**Note:** The serial port of the CPU Unit and the serial port of the Serial Communications Board/Unit (unit version 1.2 or later) are displayed in the Unit directory in the SIOU Tab on the left. Right-click and select **Insert CPU SIOU** to set the local network address in the serial port and register in the local network table.

The serial port’s unit number as a CPU Bus Unit or Special I/O Unit are automatically allocated and cannot be changed.

The Unit and the Unit’s serial port cannot be registered in the local network table at the same time.
Adding a Remote Network

Use the following procedure to add a remote connection to a local network.

1, 2, 3...

1. Open the PLC Routing Table dialog and select the SIOU tab in the left hand pane and the Main View tab in the right hand pane.

2. With the cursor positioned over the local network click the right mouse button.

3. From the pop up menu select the **Add connection to Remote Network** option. (selecting the Change Local Network option enables the local network number to be changed).

4. In the Enter Relay Node Details dialog enter the:
   - **Relay node number**. This is the ID number of the relay node. Relay Nodes can be given any ID number in the range 1 to 254.
   - **Remote Network number**. This is the ID number that will uniquely identify the remote connection. Each new remote connection must be given a unique ID number in the range 1 to 127.

   Note that a remote network can not be given the same ID number as an existing Local Network.

5. Click **OK**. This will add the remote connection with the specified ID number (shown in red) to the Local Network. A maximum of 20 remote connections can be added to a network.

6. Finally from the Options menu check the table for Errors
Editing the Routing Table

Open the appropriate routing table from the Network Configuration Tool dialog then use the following procedure to edit the table.

1. Local Network:
   - In the Routing Table dialog right click on the Unit to be edited and select the appropriate option from the pop up menu.
   - To save the changes select the Save option from the File menu
2. Relay Node:
   - Right click on the Relay node and select the appropriate option from the pop up menu.
3. Remote Network:
   - Right click on the remote network and select the appropriate option from the pop up menu.

Error Checking

Use the following procedure to view any validation errors.

1. Either:
   - Select Check routing table for errors from the Edit menu in the Routing Table Editor dialog box.
   - Click the ✓ in the toolbar. A message box will be displayed indicating success or failure.

Additional Features

The Network View Screen

The Network tree view is used to display the nodes on the locally connected network and is only available when the local connection network is an OMRON proprietary network, such as a Controller Link, Sysmac link, Sysmac Net or SYSWAY.
This icon is used to indicate that a node is present at this node number.
This icon is used to indicate that node is not present at this node number.
This icon is used to represent the currently selected node.
This icon is used to indicate that a node is present at this node number but there are errors reading the routing table.

The Overview Screen
Selecting the Overview tab will show all the routing tables in an graphical format. The relay node numbers are shown in the whites boxes and the remote network numbers in the red boxes. The numbers on the right are the Local Network numbers.

Note that the tables can not be edited in this view.

Table View Screen
The Table View screen provides a method of setting the routing table by means of a tabular view.
The screen is comprised of two main sections:

♦ The local settings (Left hand side)
♦ The remote settings (right hand side)

The local settings section allows a series of entries for the SIOU (Special Input/Output Unit) and it’s corresponding Local Network number.

The remote settings section allows a series of entries for the Remote Network number, it’s corresponding Relay Network number and it’s corresponding Relay Node number.

The slider control to the right of each section can be used to bring any more than the eight entries into view if so required.

Each of the data entry fields have their own individual set of spin buttons, which when pressed will increment or decrement the value. The number can also be entered normally using the number keypad on the user keyboard.

Three control buttons can be found at the bottom of the screen:

♦ Ok button: Once all data entry has been completed, selecting the ‘Ok’ button will check the table entries for errors. If the check fails, an error description dialog will be displayed. If the check does not detect any errors the Main Screen will be displayed.
♦ Restore button: If during data entry, the user wished to revert back to the table state that was in effect before the Table View was displayed; The user should select the Restore button.
♦ Cancel button: This button will cancel any changes made whilst the Table View was being displayed and then display the Main View screen.

Note: For CS/CJ-series PLC of Ver. 2.0 or CP-series PLC or later with CX-Programmer Ver. 4.0 or later, FINS commands can be used to access nodes up to eight network levels away, including the local network.

Gateway Counter Settings

Gateway Counter Framework

When sending FINS commands or returning FINS responses in a FINS network, the GCT (Gateway counter: Permissible number of times a network bridge can be crossed) is set in the FINS header of the FINS command frame. When the FINS response is received, the GCT is automatically reduced by the number of network levels that were accessed. Therefore, the GCT setting corresponds to the number of network levels that can be accessed, as follows:

• GCT = 02 hex: Access to up to three network levels away.
• GCT = 07 hex: Access to up to eight network levels away (the network configuration, however, must use PLCs for which the Gateway counter (GCT) is set to 07 hex).

Gateway Counter Setting

When using CX-Programmer Ver.5.0 or later, the GCT (Gateway counter) value contained in the FINS header can be set under Set Gateway Counter in the Routing Table Dialog Box.

Note: CX-Programmer Ver.4.0 or earlier do not provide the GCT (Gateway counter) setting option.
Setting the Gateway Counter Value for Each PLC

The GCT value setting range depends on the CPU Unit being used, as follows:

- **CS/CJ-series CPU Unit Ver. 3.0 or CP-series CPU Unit**
  The GCT (Gateway counter) value can be set to 02 hex or 07 hex.
  Set the GCT value under *Set Gateway Counter* during routing table setup using the following procedure.

1. **Setting the Gateway Counter Offline:**
   - Open the PLC Routing Table window, select the Unit Tab in the directory list, and then right-click the icon for the local PLC node.

2. **Setting the Gateway Count Online:**
   - Open the PLC Routing Table window, select the Network Tab in the directory list, and then right-click the icon for a PLC node in the network.

   The following Gateway Counter Setting Dialog Box will be displayed.

2. Select either **Standard** or **Expand(7)**, and then click the OK Button.

| **Standard**: Communications across up to three network levels (GCT = 02 hex) |
| **Expand(7)**: Communications across up to eight network levels (GCT = 07 hex) |

The GCT value will be displayed in the Main View, Overview, and Table View Screens.

- **CS/CJ-series CPU Units with Unit Ver. 2.0 or CP-series CPU Units**
  The GCT (Gateway counter) is always 07 hex. The number of network levels that can be accessed is always a maximum of eight network levels and cannot be set to a maximum of three network levels.

When CX-Programmer (CX-Net) Ver.5.0 or later is used, the **Standard** and **Expand(7)** options in
the Gateway Counter Setting Dialog Box in the Routing Table Setup are both ignored. When
routing tables are transferred to a CS/CJ-series CPU Unit with unit Ver. 2.0 or CP-series CPU Unit,
the GCT (Gateway counter) is always 07 hex, and therefore uses the Expand mode.

- Pre-Ver. 2.0 CS/CJ-series CPU Units and CVM1/CV-series CPU Units
  The GCT (Gateway counter) is always 02 hex. Therefore, access to a maximum of three network
  levels away is possible.
  When CX-Programmer (CX-Net) Ver.5.0 or later is used, always select the Standard option in the
  Gateway Counter Setting Dialog Box during the routing table setup. If Expand(7) is selected, the
  routing tables cannot be transferred.

Transferring a Routing Table to a PLC
Once a routing table has been created or edited, the routing table may be transferred to the PLC using the
following steps:

1. If the Network Configuration Tool is ‘on-line’ to a PLC, skip to 4.
2. Save the current routing table using the Routing Table Edit menu: File – Save
   Routing Table. (Add Author and comment if required).
3. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for
details of this operation.
4. From the CX-Net menu select: Routing Table - Setup
5. From the Routing Table menu select: File – Open Routing Table.
6. Select the previously created filename and select open. Or, alternatively the
   routing table can be created.
7. From the Routing Table Editor menu select: Options – Transfer to PLC.

Transferring a Routing table from a PLC
The routing table held within a PLC may be transferred from the PLC using the following steps:

1. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for
details of this operation.
2. From the CX-Net menu select: Routing Table - Setup
3. From the Routing Table Editor menu select: Options – Transfer from PLC.
4. The routing table may then be saved to file by: From the Routing Table menu
   select: File – Save Routing Table.
5. Enter a suitable filename and select Save.
CHAPTER 12
PLC Backup Tool

Overview
The PLC Backup Tool can be used to back up, compare, and restore data, such as programs and unit parameters, of all the Units or of only specified Units in a PLC that is connected online.

Applications
The PLC Backup Tool can be used for the following applications.
♦ Backing up all of the data that has been transferred to the PLC
♦ Comparing all of the data in the PLC with the data backed up in the computer
♦ Transferring onsite all of the data to a PLC that has the same system configuration as another PLC
♦ Transferring data to a Unit that has been replaced, e.g., when the Unit has failed

Applicable Units
CS/CJ/CP-series PLCs, all models and all versions
Data in the following Units is not backed up: SYSMAC SPU Unit data, Customizable Counter Unit data, and screen data for an NSJ Controller

Units That Can Be Backed Up
Refer to the list of Units provided in help for the PLC Backup Tool.

Applicable Data

<table>
<thead>
<tr>
<th>CPU Unit:</th>
<th>User program, symbols table, rung comments, program indexes, parameters (PLC Setup, registered I/O tables, routing tables, Ethernet settings, and all of the data in the initial setting areas), I/O memory, force-set/reset bit status (backup and comparison only), and EM file memory data (backup only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special I/O Units and CPU Bus Units:</td>
<td>Parameter settings and data stored inside the Unit (e.g., programming created with special software)</td>
</tr>
</tbody>
</table>

Restrictions
The following restrictions apply.
♦ Force-set/reset Status
Force-set/reset status cannot be restored.
If you attempt to restore force-set/reset status, the address of the force-set/reset bit will be displayed in the log display area. Use the CX-Programmer or Switch Box to manually force-set/reset the displayed address.

♦ Data Stored in EM File Memory (Part of the EM Area Converted to File Memory)
EM file memory cannot be compared or resorted.
EM file memory backups are saved in the CPU\EM_FILES Folder that will be created within the backup file
destination folder. Restore EM file memory manually by using the PLC Memory Card Window in the
CX-Programmer to write the data to memory.

♦ Restrictions in Comparing and Restoring I/O Memory
The CIO Area and Auxiliary Area data in the I/O memory cannot be compared or restored even if all of the
I/O memory is backed up.

PLC Backup Tool Operations

Starting the PLC Backup Tool

1, 2, 3... 3. Select PLC Backup Tool from the CX-Programmer Tools Menu. Alternatively, select
Programs – OMRON – CX-One – CX Programmer – PLC Backup Tool from the
Windows Start Menu.
The PLC Backup Tool Dialog Box will be displayed.

♦ Backup Menu

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup from PLC</td>
<td>Click this button to back up data. The data in the connected PLC will be backed up as a batch.</td>
</tr>
<tr>
<td>Compare</td>
<td>Click this button to compare data. The data in a backup file can be compared to the data in the connected PLC or to the data in another backup file.</td>
</tr>
<tr>
<td>Restore to PLC</td>
<td>Click this button to restore data. The data in a backup file can be transferred to the connected PLC to restore the data that was backed up.</td>
</tr>
</tbody>
</table>

♦ Communication Settings

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Settings</td>
<td>Click this button to change the communications settings for the target PLC. Current Settings: The PLC model and network type are displayed here. The FINS network address and node address of the connected PLC are displayed below the network type in the following format. (Net n, Node m) n: FINS network address, m: FINS node address</td>
</tr>
</tbody>
</table>

Communications Settings for the Target PLC

♦ If the PLC Backup Tool is started from the CX-Programmer Tools Menu, the communications of the
CX-Programmer will be inherited.
If the PLC Backup Tool is started from the Windows Start Menu, click the Communication Settings Button and specify the PLC to connect to.

**Direct Connection to PLC**
A direct connection can be made for either a serial or network connection.

**Connection to PLC via Gateway PLC**
Setting Flow

1. Select the connection path to the PLC.
2. Select the target PLC.
3. Connecting directly to PLC
4. Connecting to the PLC via a different PLC
5. Select the gateway PLC.

Setting Procedure

1. Click the Communication Settings Button in the PLC Backup Tool Dialog Box. The following Communication Settings Dialog Box will be displayed.
2. Select either the **PLC Direct Connection** or **Connection via Gateway** Option and click the **Change Settings** Button. The following Change PLC Dialog Box will be displayed.

![PLC Direct Connection Dialog Box](image)

1. Set the **PLC Model** and **Network Type** of the target PLC.  
   **Note**: you can select any network type.
2. Click the **OK** Button.  
The PLC Backup Tool Dialog Box will return and the communications settings will be applied.
1. Set the **PLC Model and Network Type** of the gateway PLC and click the **OK** Button.

2. The Change PLC Dialog Box for the target PLC will be displayed.

3. Select **Gateway** as the network type.

4. Set the **PLC Model** of the target PLC, and click the **OK** Button. The PLC Backup Tool Dialog Box will return and the new communications settings will be applied.
Back up PLC Data to the Computer

The data in the connected PLC can be backed up to the computer as a batch.

**Note:** When the Backup from PLC Button is clicked, the Tool will connect to the PLC that is specified in the current communications settings. Check that the target PLC and network type are correct before performing the backup procedure.

**Overview of Procedure**

1. **Start**  
   - Select PLC Backup Tool from the Tools Menu of the CX-Programmer.

2. **Communications settings**  
   - Click the Communication Settings Button in the PLC Backup Tool Dialog Box.
   - Select the PLC Direct Connection or Connection via Gateway Option and click the Change Settings Button.
   - Set the target PLC in the Change PLC Dialog Box.
   - The communications settings are inherited from the CX-Programmer.

   (The PLC Backup Tool Dialog Box will return.)

3. **Backup**  
   - Click the Backup from PLC Button.
   - Check the target PLC in the Confirm Connection Dialog Box and click the OK Button.
   - (The PLC Backup Tool will connect online to the PLC and the Backup from PLC (1/2) Dialog Box will be displayed.)
   - Select the check boxes for the Units to be backed up and then click the Next Button.
   - Specify the backup file in which to save the data.

   (The PLC Backup Tool will connect online to the PLC and the Backup from PLC (2/2) Dialog Box will be displayed.)

   - Click the Start Button.

   Backup operation executed.
Procedure

1. Click the **Backup from PLC** Button in the PLC Backup Tool Dialog Box. The following Confirm Connection Dialog Box will be displayed.

   ![Confirm Connection Dialog Box]

   The following Confirm Connection Dialog Box will be displayed.

   **PLC Model**
   - CS1H-CPU66

   **Network Type**
   - ToolBus

2. Check that the target PLC is correct and click the OK Button. The following Backup from PLC (1/2) Dialog Box will be displayed after an online connection is made to the PLC.

   ![Backup from PLC (1/2) Dialog Box]

   The registered I/O tables will be read from the connected PLC and all Units in the PLC will be displayed in the list.
### Dialog Box Description

#### Backup from PLC (1/2)

**PLC Configuration Information**

The model of the connected PLC.

<table>
<thead>
<tr>
<th>No.</th>
<th>Model Name</th>
<th>Unit V.</th>
<th>R.</th>
<th>S.</th>
<th>Unit No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C50H-CPU66H</td>
<td>3.0</td>
<td>-</td>
<td>-</td>
<td>CPU Unit</td>
<td>CPU Unit</td>
</tr>
<tr>
<td>2</td>
<td>C50W-DLDS24V1</td>
<td>1.2</td>
<td>00</td>
<td>06</td>
<td>01</td>
<td>Coiled Communication Unit</td>
</tr>
<tr>
<td>3</td>
<td>C50W-DI24VH1</td>
<td>1.2</td>
<td>00</td>
<td>07</td>
<td>15</td>
<td>Analog Input Unit</td>
</tr>
<tr>
<td>4</td>
<td>C50W-DIO24H1</td>
<td>00</td>
<td>00</td>
<td>-</td>
<td></td>
<td>Digital Input Unit</td>
</tr>
<tr>
<td>5</td>
<td>C50W-OD24V1</td>
<td>00</td>
<td>09</td>
<td>-</td>
<td></td>
<td>Digital Output Unit</td>
</tr>
</tbody>
</table>

#### Information:

When you select a unit in the list, the information of the selected unit is shown below.

All Units in the PLC are displayed here along with the model number, unit version, rack number, slot number, unit number, and comment. The color will indicate whether the Unit can be backed up.

- **(White)** Units that can be backed up.
- **(Yellow)** Units for which there are backup restrictions. If one of these Units is selected, the restrictions will be displayed in the Information Area.
- **(Gray)** Units with data that cannot be backed up, such as Basic I/O Units or Units that are not supported by the Backup Tool.

#### WARNING

- Some Special I/O Units and CPU Bus Units operate with parameters that are stored in the CPU Unit. If one of these Units is selected for backup, restrictions will be displayed in the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and always select the Special I/O Unit or CPU Bus Unit together with the CPU Unit when backing up or restoring data. If the data from both Units is not backed up or restored together, unexpected operation may occur in the controlled system.
3. Select the Units that you want to back up by selecting the boxes in the number column, and then click the **Next** Button.

The Backup from PLC (2/2) Dialog Box will be displayed so you can enter attributes for the backup file.

- **Destination Folder**: Shows the destination folder where the backup file will be saved. As a default, a folder with the current date and time as the folder name (YYMMDD_HHMMSS) will be automatically created. Example: If the file was created on January 31st 2008, at 11:28:17, the folder name will be 080131_112817.

- **User Name**: Input the name of the user.

- **Backup Date/Time**: The current date and time from the computer are displayed here.

- **Enter comments for the backup procedure.**

4. Specify where to save the backup file.

   The default is C:\Backup.

   Click the button next to the backup folder field to change the backup folder or edit the folder name directly.

5. Enter the user name and comments.

6. Click the **Start** Button.

   An Uploading Dialog Box will be displayed to indicate that the backup operation is being executed.

**Note:** If the read protection has been set for the connected PLC, the protection must be cleared before the data can be backed up.

Refer to *Clearing UM and Task Read Protection*, below, for details.
7. When the backup operation has been completed, the following Backup Completed Dialog Box will be displayed.

![Backup Completed Dialog Box](image)

8. Click the **OK** Button to complete the backup process. The backup files will have been created in a folder named with the current time (ymmd – hhmss) in the specified folder as shown below.

![Example Folder Structure](image)

**Note 1:** The PLC Backup Tool will automatically create a subfolder in the folder that was automatically created in the specified destination folder and save all of the PLC configuration information and data in the subfolder.

**Note 2:** Do not change the folder structure or move files in the backup folder. If any changes are made, it will become impossible to read the data for the comparison and restore operations.

**Note 3:** If you copy the backup data to another computer, copy the entire folder named with the current time in the destination folder, as shown below.

**Example**

When the Destination Folder Is C:\Backup\080131_112817 Copy the entire folder called 080131_112817.
Comparing Data

Data in backup files can be compared with data from other backup files or data from connected PLC, and the results shown.

Backup files can be restored after the comparison results have been displayed. Also, the comparison results can be saved in a CSV file.

**Overview of Procedure**

1. **Start**
   - Select PLC Backup Tool from the Tools Menu of the CX-Programmer.

2. **Communications settings**
   - Click the Communication Settings Button in the PLC Backup Tool Dialog Box.
   - Select the PLC Direct Connection or Connection via Gateway Option and click the Change Settings Button.
   - Set the target PLC in the Change PLC Dialog Box.
   - (The PLC Backup Tool Dialog Box will return.)

3. **Verify**
   - Click the Compare Button.
   - Select the source backup file and the destination backup file or PLC.
   - Not Selecting the Units to Compare
   - Selecting the Units to Compare
   - Click the Compare Button.
   - Check the target PLC in the Confirm Connection Dialog Box and click the OK Button.
   - Select the Units to compare in the Selects Comparison Target Dialog Box
   - Click the Compare Button.
   - (Data compared.)
**Procedure**

1. Click the **Compare** Button in the PLC Backup Tool Dialog Box. The Compare Dialog Box will be displayed.

   **Compare**
   - **Comparison source and target:**
     - **Comparison Source:**
       - Folder where backup files are stored: `OMBackup0800422_113319`
       - User Name: `OMRON`
       - Comments: `CPU1H-CPUJ66`
   - **Comparison Target:**
     - **Connecting PLC:**
       - CPU1H-CPUJ66

   Select this check box to select the Units to compare. If this check box is not selected, data will be compared for all Units.

   Specify the source backup file on the computer.

   Specify the target PLC or backup file to compare.

   PLC: The currently connected PLC will be displayed as the target.

   File: Specify another backup file on the computer as the target.

2. Select the comparison source backup file and the target PLC or backup file and click the **Compare** Button.

3. A Confirm Connection Dialog Box will be displayed if the backup file is being compared to a PLC. Check that the target PLC is correct and click the **OK** Button.

4. To compare data from specific Units, select the **Selects the comparison target** Checkbox and click the **Compare** Button.

   The following **Select Comparison Target** Dialog Box will be displayed.

   - **Select the check box of Units to compare.**
   - **Configuration:**
     - Indicates whether the configurations match between the backup file and the PLC.
   - **The configuration in the backup file on the computer is displayed here:**
     - Rack No., slot No., model No., unit version, and unit No.
   - The following is displayed for the Unit in the connected PLC:
     - Unit version and unit No.
   - **Source backup file and PLC model on the computer.**
   - **Destination PLC or backup file, and PLC model.**

Select the Units to compare and then click the **Compare** Button.

To not compare specific Units, do not select the check box for the Unit and click the **Compare** Button.
5. A Comparing Dialog Box will be displayed to indicate that the comparison operation is being executed and the comparison status will be displayed in the Log Display Area.

![Comparing Dialog Box](image)

**Note:** If the read protection has been set for the connected PLC, the protection must be cleared before the data can be compared. Refer to *Clearing UM and Task Read Protection*, below, for details.

When the comparison has completed, the following dialog box will be displayed.

![Comparison Completed](image)
6. Click the OK Button. The following Comparison Results Dialog Box will be displayed.

7. The following operations can be carried out with the comparison results.
   - Display details of the comparison results.
   - Save comparison results in a file.
   - Transfer backup file data to PLC.
**Detailed Display of the Comparison Results**

1. Double-click the Unit in the comparison results list. The Details of Unmatched Item Dialog Box will be displayed.

### Example 1: CJ2H-CPU67H CPU Unit

![Details of Unmatched Item (CJ2H-CPU67H) dialog box](image1)

- **Program**: Not inst.
- **Parameters (system settings, input)**: Matched
- **Symbol Table**: Not inst.
- **Comments**: Not inst.
- **Program Index**: Not inst.
- **PLC Memory**: Not inst.
- **Force Status**: Matched
- **EM File Area**: -

- **The data saved in the Unit is displayed.**
- **Whether the data matches is displayed.**

### Example 2: CJ1W-CLK21 CPU Bus Unit

![Details of Unmatched Item (CJ1W-CLK21) dialog box](image2)

- **Parameter defined in CPU**: Not inst.
**Saving Comparison Results Files**

1. Clicking the Save as Button will save the comparison results to a CSV file. The CSV file will contain the following comparison results in the order given below.

<table>
<thead>
<tr>
<th>Comparison Results File Data Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack No., Slot No., Comparison Source Unit Model, Comparison Source Unit Version, Comparison Source Unit No., Comparison Source Lot No., Comparison Target Unit Model, Comparison Target Unit Version, Comparison Target Unit No., Comparison Target Lot No., Configuration Comparison Results, Setting Comparison Results, Data Name, Comparison Results</td>
</tr>
</tbody>
</table>

**Restoring Data**

PLC data can be restored to a previous state by transferring backup file data to a connected PLC.
Overview of Procedure

Procedure

1. Set the communications settings of the target PLC in the PLC Backup Tool Dialog Box.

   Note: When the Restore to PLC Button is clicked, the Tool will connect to the PLC that is specified in the current communications settings. Check that the target PLC and network type are correct before performing the restore procedure.

2. Click the Restore to PLC Button in the PLC Backup Tool Dialog Box.

   The following dialog box will be displayed to confirm the target PLC.
3. Check whether the correct PLC is set as the target and click the OK Button. The following Restore to PLC Dialog Box will be displayed. When the restoration target backup file is selected, data will be automatically compared with the connecting PLC and the results will be displayed.

![Image of Restore to PLC Dialog Box]

The source backup folder in the PLC is displayed here.

Check boxes will appear for Units to which data can be restored.

Configuration: Indicates whether the configurations match between the backup file and the PLC.

The configuration in the backup file on the computer is displayed: rack No., slot No., model No., unit version, and unit No.

Click the Start a Tool Button to check the restore data before executing the restore operation. Refer to Checking Restore Data, below, for details.

**WARNING**

- Sufficiently check the data that is selected for restoring before performing the next step. If the correct data is not restored, unexpected operation may occur in the controlled system after the data is restored.

- Some Special I/O Units and CPU Bus Units operate with parameters that are stored in the CPU Unit. If one of these Units is selected for backup, restrictions will be displayed in the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and always select the Special I/O Unit or CPU Bus Unit together with the CPU Unit when backing up or restoring data. If the data from both Units is not backed up or restored together, unexpected operation may occur in the controlled system.

- If there are any backup restrictions for the Units to which data is being restored, the restrictions will be displayed in the Comments Area of the Backup from PLC Dialog Box. Confirm the restrictions, and always take the required measures. If required measures are not taken, unexpected operation may occur in the controlled system after the data is restored.
4. Select the check boxes in the number column to set the target Units, and then click the Start Button. The following Confirm Restore to PLC Dialog Box will be displayed.

![Confirm Restore to PLC Dialog Box]

Select this check box to select the data for the Unit.

5. Execute the following steps to select the data for each Unit.
   1. Select the Select the unit data Check Box.
   2. Click the OK Button. The Select Data to be Restored Dialog Box will be displayed. The displayed data will depend on the unit type.

![Select Data to be Restored Dialog Box]

3. Select the check boxes for the data to be restored.
4. Click the Start Button.
   To restore all of the data, do not select the Select the unit data Check Box and click the OK Button.

6. If the CPU Unit is not in PROGRAM mode, the following dialog box will be displayed to confirm that it is OK to change the operating mode. If it is OK to change the operating mode, click the Yes Button.

![PLC Backup Tool Dialog Box]

Make sure that there is no problem even if PLC’s operation is stopped. Are you sure to enter the Program mode?
**WARNING**

- Confirm that stopping PLC operation will not create any problems before restoring data during PLC operation. If the PLC stops at an unanticipated time, unexpected operation may occur in the controlled system.

7. A Downloading Dialog Box will be displayed and the restore status will be displayed in the Log Display Area.

![Downloading Dialog Box](image)

**Note:** If the read protection has been set for the connected PLC, the protection must be cleared before the data can be restored.

Refer to *Clearing UM and Task Read Protection*, below, for details.

8. When restoration has been completed, the following Restoration Completed Dialog Box will be displayed.

![Restoration Completed Dialog Box](image)

**WARNING**

- Always turn the power supply to the PLC OFF and then ON after restoring data. If the power supply is not turned OFF and then ON, memory in the PLC may not be updated to the restored data, which may cause unexpected operation of the controlled system.

- Forced status can be backed up, but it cannot be restored. If you restored data that contained forced status, use the CX-Programmer after restoring the data to force-set or force-reset bits as required. If required bits are not force-set or force-reset, differences in the forced status in memory may cause unexpected operation of the controlled system.
Checking Restore Data

When the configuration information in the backup file is displayed in the Restore to PLC Dialog Box, you can start the Support Software for specific Units to check the data before restoring it to the Unit. This function is supported for the following Units.

♦  Applicable Units and Support Software

<table>
<thead>
<tr>
<th>Unit</th>
<th>Data</th>
<th>Support Software</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Unit</td>
<td>Program Parameters</td>
<td>CX-Programmer</td>
<td>The routing tables are not displayed.</td>
</tr>
<tr>
<td>Controller Link Unit, SYM-</td>
<td>Unit parameters</td>
<td>View Parameters Dialog Box (Select displaying Special I/O Units and CPU Bus Units.) (See note.)</td>
<td>The routing tables are not displayed.</td>
</tr>
<tr>
<td>LINK Unit, Ethernet Unit, or EtherNet/IP Unit</td>
<td>Protocol macros</td>
<td>(Select displaying Special I/O Units and CPU Bus Units.) CX-Protocol</td>
<td>---</td>
</tr>
<tr>
<td>Serial Communications Unit/Board</td>
<td>Unit parameters</td>
<td>View Parameters Dialog Box (See note.)(Select displaying Special I/O Units and CPU Bus Units.)</td>
<td>---</td>
</tr>
<tr>
<td>FL-net Unit</td>
<td>Unit parameters</td>
<td>CX-FLnet</td>
<td>---</td>
</tr>
<tr>
<td>Other Special I/O Units</td>
<td>Unit parameters</td>
<td>View Parameters Dialog Box (See note.) (Select displaying Special I/O Units and CPU Bus Units.)</td>
<td>---</td>
</tr>
</tbody>
</table>

Note: Parameters can only be checked. They cannot be edited or transferred.

Procedure

1. If you select the target Unit and click the Start a tool Button, the following Confirm Tool Startup Dialog Box will be displayed.

2. Click the OK Button. The View Parameters Dialog Box or Start a Tool Dialog Box will be displayed, depending on the target Unit that was selected. If the Start a Tool Dialog Box was displayed, a list of Support Software will be displayed. Select the Support Software to start and click the OK Button.
Clearing UM and Task Read Protection

If read protection is set for the UM area or any tasks in the CPU Unit, the protection must be cleared before you can back up, compare, or restore data for the Unit. Before you can begin any of these procedures, a dialog box will be displayed to allow you to clear protection.

To clear the protection, enter the UM read protection or task read protection password for the current CPU unit, and then click the OK Button. The operation will continue when the protection has been cleared.

Note: The read protection password will not be stored as part of the backup process. For better security, store the password separately.
APPENDIX A
Toolbars and Keyboard Shortcuts

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. The F1 function key is common across all components and tools and provides context help.

### Toolbars

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Open</td>
</tr>
<tr>
<td>Open File</td>
<td>Open File</td>
</tr>
<tr>
<td>Save in Project</td>
<td>Save in Project</td>
</tr>
<tr>
<td>Print</td>
<td>Print</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Cut</td>
<td>Cut</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste</td>
</tr>
<tr>
<td>Fill Data Area</td>
<td>Fill Data Area</td>
</tr>
<tr>
<td>Clear Data Area</td>
<td>Clear Data Area</td>
</tr>
<tr>
<td>Transfer to PLC</td>
<td>Transfer to PLC</td>
</tr>
<tr>
<td>Transfer from PLC</td>
<td>Transfer from PLC</td>
</tr>
<tr>
<td>Compare with PLC</td>
<td>Compare with PLC</td>
</tr>
<tr>
<td>Monitor</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+O</td>
<td>Open</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save in Project</td>
</tr>
<tr>
<td>Ctrl+P</td>
<td>Print</td>
</tr>
<tr>
<td>Ctrl+X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl+PgUp</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl+PgDn</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Alt+B</td>
<td>Binary</td>
</tr>
<tr>
<td>Alt+C</td>
<td>Binary Coded Decimal</td>
</tr>
<tr>
<td>Alt+D</td>
<td>Decimal</td>
</tr>
<tr>
<td>Alt+S</td>
<td>Signed Decimal</td>
</tr>
<tr>
<td>Alt+O</td>
<td>Double Word</td>
</tr>
<tr>
<td>Alt+Q</td>
<td>Quad Word</td>
</tr>
<tr>
<td>Alt+P</td>
<td>Floating Point</td>
</tr>
<tr>
<td>Alt+H</td>
<td>Hexadecimal</td>
</tr>
<tr>
<td>Alt+T</td>
<td>Text</td>
</tr>
<tr>
<td>Alt+L</td>
<td>Real</td>
</tr>
</tbody>
</table>
Data Trace/Time Chart Monitor Component

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Ctrl+O ............ Open</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+PgUp ...... Zoom In</td>
</tr>
<tr>
<td>Configure Trace/Time Chart</td>
<td>Ctrl+PgDn ...... Zoom Out</td>
</tr>
<tr>
<td>Zoom Out</td>
<td></td>
</tr>
<tr>
<td>Restore Zoom</td>
<td></td>
</tr>
<tr>
<td>Zoom In</td>
<td></td>
</tr>
<tr>
<td>Scale Out</td>
<td></td>
</tr>
<tr>
<td>Restore Scale</td>
<td></td>
</tr>
<tr>
<td>Scale In</td>
<td></td>
</tr>
<tr>
<td>Stop Trace/Time Chart</td>
<td></td>
</tr>
<tr>
<td>Trigger the Trace/Time Chart</td>
<td></td>
</tr>
<tr>
<td>Execute Trace/Time Chart</td>
<td></td>
</tr>
<tr>
<td>Read Trace/Time Chart</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td></td>
</tr>
</tbody>
</table>
### Memory Card Component

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Ctrl+X............. Cut</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C............. Copy</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V............. Paste</td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl+A............. Select All</td>
</tr>
<tr>
<td>Rename</td>
<td>F5................... Refresh device</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
</tr>
<tr>
<td>Large Icons</td>
<td></td>
</tr>
<tr>
<td>Small Icons</td>
<td></td>
</tr>
<tr>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Details</td>
<td></td>
</tr>
</tbody>
</table>

### CX-Net Network Configuration Tool

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Project</td>
<td>Ctrl+N............. New</td>
</tr>
<tr>
<td>Edit Project</td>
<td>Ctrl+O ............ Open</td>
</tr>
<tr>
<td>Open/Close Project Device PLC</td>
<td>Ctrl+S............. Save</td>
</tr>
<tr>
<td>Display PLC Information</td>
<td>Return ............ Edit Item</td>
</tr>
<tr>
<td>Set PLC Operating Mode</td>
<td>Insert.............. Insert Item</td>
</tr>
<tr>
<td>Display PLC Error Status</td>
<td>Delete ............ Delete Item</td>
</tr>
<tr>
<td>Show Unit Status</td>
<td></td>
</tr>
<tr>
<td>Configure PLC System Settings</td>
<td></td>
</tr>
<tr>
<td>Configure IO Table</td>
<td></td>
</tr>
<tr>
<td>Configure C-Series Comms. Units</td>
<td></td>
</tr>
<tr>
<td>Online Edit Routing Table</td>
<td></td>
</tr>
<tr>
<td>Online Edit Data Link</td>
<td></td>
</tr>
<tr>
<td>Echo Back Test</td>
<td></td>
</tr>
<tr>
<td>Broadcast Test</td>
<td></td>
</tr>
<tr>
<td>Ping Test</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td></td>
</tr>
</tbody>
</table>
Import/Export Tool

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Keyboard shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N............. New</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O ............ Open</td>
</tr>
<tr>
<td>Edit Project</td>
<td>Ctrl+E............. Edit Project</td>
</tr>
<tr>
<td>Import CVSS</td>
<td>Ctrl+C............. Import CVSS</td>
</tr>
<tr>
<td>Import LSS</td>
<td>Ctrl+L ............. Import LSS</td>
</tr>
<tr>
<td>Import Text</td>
<td>Ctrl+T............. Import Text</td>
</tr>
<tr>
<td>Import Tagged Database</td>
<td>Ctrl+V............. Import from FinsGateway</td>
</tr>
<tr>
<td>Export Text</td>
<td>Alt+T .............. Export Text</td>
</tr>
<tr>
<td>Export to FinsServer TagDB</td>
<td>Alt+V .............. Export to FinsGateway TagDB</td>
</tr>
<tr>
<td>Clear Screen</td>
<td>Ctrl+R............. Clear screen</td>
</tr>
<tr>
<td>Print Screen</td>
<td>Ctrl+P............. Print screen</td>
</tr>
</tbody>
</table>
Data Link Editor

### Toolbars

- New
- Show All Network Nodes
- Open
- Save
- Toggle Network/Single Node operation
- Transfer to PLC
- Transfer from PLC
- Delete
- Verify Node
- Status
- Automatic Datalink Setup
- Validate Table
- Wizard
- Add source link
- Add Destination
- Set properties
- Delete link destination service area
- Zoom in
- Zoom out
- Zoom original
- Print
- About Datalink Component

### Keyboard Shortcuts

- Ctrl+N............. New
- Ctrl+O............. Open
- Ctrl+S............. Save
- Ctrl+P............. Print
- Ctrl+<space.... Change Window
## Routing Table Editor

<table>
<thead>
<tr>
<th>Toolbars</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+P ............ Print</td>
</tr>
<tr>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
</tr>
<tr>
<td>Always on top</td>
<td></td>
</tr>
<tr>
<td>Transfer to PLC</td>
<td></td>
</tr>
<tr>
<td>Transfer from PLC</td>
<td></td>
</tr>
<tr>
<td>Check routing table</td>
<td></td>
</tr>
<tr>
<td>Activate C-Series Control Link routing Table</td>
<td></td>
</tr>
</tbody>
</table>
## GLOSSARY OF TERMS

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual IO Table</td>
<td>The real hardware configuration of the PLC units and slots on power-up.</td>
</tr>
<tr>
<td>Address</td>
<td>A location in memory where data or programs are stored. It can also identify a location of a node on a network.</td>
</tr>
<tr>
<td>Application</td>
<td>A software program that accomplishes a specific task. Examples of applications are CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.</td>
</tr>
<tr>
<td>ASCII</td>
<td>American Standard Code for Information Interchange.</td>
</tr>
<tr>
<td>Auxiliary Area</td>
<td>An area of PLC memory which normally contains transmission Counters, flags and control bits. It also retains the status of the device during power failure.</td>
</tr>
<tr>
<td>Baud rate</td>
<td>The speed of data transmission in terms of the number of bits per second that are being sent.</td>
</tr>
<tr>
<td>BCD</td>
<td>Binary Coded Decimal.</td>
</tr>
<tr>
<td>Binary Coded Decimal</td>
<td>A data format supported by CX-Server.</td>
</tr>
<tr>
<td>Binary</td>
<td>A data format supported by CX-Server. A number system format to the base 2, i.e. employing the digits 0 and 1.</td>
</tr>
<tr>
<td>Bit</td>
<td>A digit used in binary notation which can take the value 0 or 1. The value of a bit, or combination of bits, can represent the status of a device or can be used in programming.</td>
</tr>
<tr>
<td>Boolean</td>
<td>A type of point or symbol where the value can be one of two states. Essentially the two states are ‘0’ and ‘1’, but these states can be assigned a meaningful designation.</td>
</tr>
<tr>
<td>Bridge</td>
<td>A device connecting local area networks of similar architectures together.</td>
</tr>
<tr>
<td>Broadcast address</td>
<td>An address held in common by all nodes on a network to which the same data is transmitted simultaneously.</td>
</tr>
<tr>
<td>Bus</td>
<td>A communications path along which data can be transmitted or received between the units connected to it.</td>
</tr>
<tr>
<td>Central Processing Unit</td>
<td>The part of the PLC which can store programs and data, execute the instructions in program, and process input and output signals in order to communicate with other, external, devices.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>An area within the windows environment where data can be stored temporarily or transferred between applications.</td>
</tr>
<tr>
<td>Command modifier</td>
<td>An optional part of an address string indicating the modification to be performed on the data at that address (within PLC memory) when it is accessed.</td>
</tr>
<tr>
<td>Common link parameter</td>
<td>The common words used by all PLCs in a Data Link (within a SYSMAC LINK system).</td>
</tr>
<tr>
<td>Compact Flash</td>
<td>A type of memory card fitted to a PLC.</td>
</tr>
<tr>
<td>Components</td>
<td>CX-Server is made up of six components accessible from an invoking application.</td>
</tr>
<tr>
<td>Control bit</td>
<td>A bit assigned a controlling role in the functioning of a device; its status is set via a program to achieve this function.</td>
</tr>
<tr>
<td>Controller Link</td>
<td>A network that can send and receive large data packets flexibly and easily among the OMRON PLCs.</td>
</tr>
<tr>
<td>Counter area</td>
<td>An area of PLC memory containing program counters and their related completion flags.</td>
</tr>
<tr>
<td>Counter</td>
<td>An area of memory reserved for the purposes of counting the number of times an event has occurred.</td>
</tr>
<tr>
<td>CPU bus link area</td>
<td>An area of PLC memory allocated to the CPU bus unit.</td>
</tr>
<tr>
<td>CPU type</td>
<td>The type of CPU available to a specific device, the amount of memory available to a PLC varies according to the CPU involved.</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit.</td>
</tr>
<tr>
<td>CS-series</td>
<td>Indicates either a CS1G-H, CS1H-H, CS1D-S, or CS1D-H.</td>
</tr>
<tr>
<td>CJ-series</td>
<td>Indicates either a CJ1G-H, CJ1H-H, or CJ1M.</td>
</tr>
</tbody>
</table>
C-Series Indicates any one of the following types of PLC: C2000H, C200H, C200HE, C200HE-Z, C200HG, C200HE-Z, C200HS, C200HX, C200HX-Z, C1000H, C**H, C**K, C**P, CQM1, C500, C120, C20, CPM1 (CPM1A/CPM2*).

CV-Series Indicates any one of the following types of PLC: CVM1, CVM1-V2, CV500, CV1000 or CV2000. When using SYSMAC NET, CV series PLCs can operate in either CV mode (where the datagrams contain FINS commands) or C mode (where the datagrams contain C SYSNET commands).

CVSS A file format supported by the CX-Server Import tool. CVSS has several file types which have different information contained in them.

CX-Net Network Configuration tool This CX-Server tool consists of a suite of programs allowing the management of Routing Tables and Data Link Tables in OMRON PLCs.

CX-Server An advanced communications management system for OMRON PLCs providing facilities for software to maintain PLC device and address information and to communicate with OMRON PLCs and their supported network types.

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and networks within a particular configuration including the areas of PLC memory (points) that can be read from or written to.

Cycle time The time interval between read/write cycles at a network node.

Data area An area of PLC memory allocated to the storage of data (not programs).

Data bits Bits representing each character to be transmitted.

Data link A software connection establishing common data areas between PLCs on a network allowing data to be between these devices.

Data Link Editor The data Link Editor allows a PLC to be configured so that it can participate in one, or more automatic data sharing schemes, over Sysmac Link and Controller Link networks, without the need for special programming.

Data link table A table of the common data memory areas used by the PLCs in a Data Link.

Data location An area of memory identified by an address.

Data memory An area of PLC memory holding only word data.

Data Trace/Time Chart Monitor component This CX-Server component displays data obtained from the PLC’s memory areas during program execution.

Datagram A packet of information which can be transmitted across a network containing routing information plus data.

DDE Dynamic Data Exchange. A channel through which correctly prepared programs can actively exchange data and control other applications within Microsoft Windows. CX-Server, through the use of the DDE Manager tool, allows extensive use of DDE functionality.

See also Item, Server, server application and Topic.

DDE management library A dynamic link library within Windows which allows dynamic data exchange to be employed.

DDE Manager tool A CX-Server tool for transferring data between PLCs and a client application using DDE, for example Microsoft Excel.

DDEML Dynamic Data Exchange Management Library.

Debug mode A mode of PLC operation during which any errors arising from the currently active program will be flagged. For CV-series PLC only.

Decimal A data format supported by CX-Server.

Default A value automatically set by a program in the absence of user input or on initial entry to an application; such values can be overwritten.

Destination network address The address of the network to which data is directed.

Destination node number The number identifying the destination node.
<p>| <strong>Destination node</strong> | The node (and therefore device) where transmitted data is to be placed. |
| <strong>Device group</strong> | A class of devices which share similar properties, each group can be sub-divided into device types. |
| <strong>Device type</strong> | A type of OMRON PLC. |
| <strong>Device</strong> | A type of OMRON automation device, either a PLC, Temperature Controller, Memory Card Writer or PROM Writer. |
| <strong>Dialog</strong> | A window asking for some form of response from the user, usually in the form of either entering requested information, selecting displayed data, or confirming an operation. |
| <strong>DLL</strong> | Dynamic Link Library. A program file that although cannot be run stand-alone as an executable, can be utilised by one or more applications or programs as a common service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone functions. |
| <strong>Double Floating Point</strong> | Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E+308/-307) as defined by Microsoft®. |
| <strong>Download</strong> | Refer to Transfer to PLC. |
| <strong>Drag</strong> | The act of moving an item on the screen by selecting it with the mouse, and keeping the mouse button depressed, moving the mouse until the item has reached the required location. The mouse button is then released. |
| <strong>Driver</strong> | The software which controls the communications between a computer and PLC, translating any information passed between them into a format that the receiving Device can understand. |
| <strong>Dynamic Data Exchange</strong> | The method of transferring data (and possibly instructions) between applications via the establishment of reference links between them. |
| <strong>Echo test</strong> | The reflection of a signal along a communications channel in order to check the accuracy of data transmission by comparing the received data against the original data at the sending end. |
| <strong>EEPROM</strong> | Electrically Erasable Programmable Read Only Memory. |
| <strong>Elements</strong> | The number of address units which start at a specified data location. |
| <strong>End Connection</strong> | The final communication link between computer and PLC, or in the case of a Network configuration, gateway PLC to PLC. |
| <strong>End network address</strong> | The address of the destination network to which communications are directed. |
| <strong>Error status</strong> | An indication of an error condition found in a system. |
| <strong>Ethernet</strong> | A 10 MB baseband local area network with each Device attached to the network having equal status and therefore the ability to transmit as, and when, required (provided the line isn’t busy). |
| <strong>Even parity</strong> | The number of 1s in a data transmission is even. |
| <strong>Event frame</strong> | A structure, predetermined by a protocol, containing specific fields for the transmission of data. |
| <strong>Exclusive mode</strong> | PLC mode which allows an application exclusive access to the Device. |
| <strong>Expansion memory</strong> | The memory available to a CPU in addition to conventional memory. |
| <strong>File memory</strong> | An area of CPU memory allocated to the storage of data. |
| <strong>File Transfer Protocol</strong> | Protocol for transferring files between host computers. |
| <strong>FINS</strong> | Factory Intelligent Network Service. |
| <strong>FinsGateway</strong> | An OMRON communication type supported by CX-Server. |
| <strong>Flag</strong> | An indicator representing the condition of a process, data area or Device. |
| <strong>Floating Point</strong> | A data format supported by CX-Server. |
| <strong>Folder</strong> | A structure which organises the files in computer memory or on disk. Also known as a 'directory'. |
| <strong>Frame length</strong> | The waiting time before data is transmitted across the network |
| <strong>FTP</strong> | File Protocol Transfer. |</p>
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Gateway device</strong></td>
<td>A Device connecting two networks of different architectures together.</td>
</tr>
<tr>
<td><strong>Gateway network address</strong></td>
<td>The address of a network acting as a gateway.</td>
</tr>
<tr>
<td><strong>Gateway PLC</strong></td>
<td>A PLC which acts as a link to another network.</td>
</tr>
<tr>
<td><strong>Group</strong></td>
<td>A sub-directory within a CX-Server project hierarchy which contains points and/or further (subsidiary) groups.</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface. Part of a program that interacts with the user and takes full advantage of the graphics displays of computers.</td>
</tr>
<tr>
<td></td>
<td>A GUI employs pull-down menus and dialog boxes for ease of use. Like all Microsoft Windows based applications, CX-Server has a GUI for each component and tool.</td>
</tr>
<tr>
<td><strong>Hard disk</strong></td>
<td>A disk permanently mounted on its drive.</td>
</tr>
<tr>
<td><strong>Hexadecimal</strong></td>
<td>A data format supported by CX-Server.</td>
</tr>
<tr>
<td><strong>Hierarchy</strong></td>
<td>The structure of a CX-Server project from the root directory down through any sub-directories (groups) to individual points contained within those groups.</td>
</tr>
<tr>
<td><strong>High Link</strong></td>
<td>A network driver.</td>
</tr>
<tr>
<td><strong>Host computer</strong></td>
<td>A computer responsible for data management and for overall control of the system. Programs and data are downloaded to a PLC from the host computer.</td>
</tr>
<tr>
<td><strong>Host link system</strong></td>
<td>A system comprising one or more host computers connected to one or more PLCs by host link units; these units facilitate the transfer of data between the PLC(s) and the host computer.</td>
</tr>
<tr>
<td><strong>Host link unit</strong></td>
<td>The interface between a PLC and a host computer.</td>
</tr>
<tr>
<td><strong>Icon</strong></td>
<td>Pictorial representations of computer resources and functions. Many icons are used by CX-Server components and tools as part of the GUI.</td>
</tr>
<tr>
<td><strong>IDSC device type</strong></td>
<td>An OMRON PLC device supported by CX-Server.</td>
</tr>
<tr>
<td><strong>Import tool</strong></td>
<td>This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS products.</td>
</tr>
<tr>
<td><strong>Input bit data area</strong></td>
<td>An area of PLC memory containing the status of an input Device.</td>
</tr>
<tr>
<td><strong>Input bit</strong></td>
<td>The location within memory indicating the status of an input.</td>
</tr>
<tr>
<td><strong>Input device</strong></td>
<td>A Device which sends signals to a PLC.</td>
</tr>
<tr>
<td><strong>Input</strong></td>
<td>The signal sent to a PLC from an external device.</td>
</tr>
<tr>
<td><strong>Instruction</strong></td>
<td>A statement indicating an operation to be performed and identifies any data involved in this operation.</td>
</tr>
<tr>
<td><strong>Intel Hex</strong></td>
<td>A PLC device also known as a PROM Writer.</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Hardware or software employed to link the elements within a system, including networks, programs and computers.</td>
</tr>
<tr>
<td><strong>Internal data type</strong></td>
<td>The format of the data held at an address in PLC memory; for example, bit or signed character binary.</td>
</tr>
<tr>
<td><strong>Internode test</strong></td>
<td>An echo test performed to check the condition of a PLC on a network node.</td>
</tr>
<tr>
<td><strong>Invoking application</strong></td>
<td>An application such as CX-Programmer and CX-Protocol that utilises components and tools belonging to CX-Server.</td>
</tr>
<tr>
<td><strong>IO bit</strong></td>
<td>A bit which can hold data entered into, or received from, the system.</td>
</tr>
<tr>
<td><strong>IO Table component</strong></td>
<td>This CX-Server component retrieves configured PLCs rack and address data.</td>
</tr>
<tr>
<td><strong>IO type</strong></td>
<td>Input /Output type. An attribute of a point or symbol that defines the origin and destination of the data for that point or symbol. The data can originate (be input from) and is destined (is output to) to the internal computer memory, PLC or DDE target application.</td>
</tr>
<tr>
<td><strong>IO</strong></td>
<td>Input /Output.</td>
</tr>
<tr>
<td><strong>IP address table</strong></td>
<td>A table containing the IP addresses for all the devices on the Ethernet.</td>
</tr>
<tr>
<td><strong>IP address</strong></td>
<td>An address for a device on the Ethernet.</td>
</tr>
<tr>
<td><strong>IP router table</strong></td>
<td>A table containing the addresses for each interface on a network.</td>
</tr>
</tbody>
</table>
IP
Item
LAN
Link Relay Area
Link system
Link unit
Link
Load
Local area network
Local network address
Local network number
Local table
LREAL
LSS
Mailbox
Mark parity
Master
Mb
Memory area
Memory Card component
Memory Card Writer
Memory card
MHz
Micro host link
Microsoft Excel
Microsoft Windows Explorer
Microsoft Windows
Modem
Monitor mode
n
Native data format
Network bridge
Network parameters
Network Service Board
Network

Internet Protocol.
A unique name for a data item within a topic.
Local Area Network.
A common data area allowing the transfer of data between PLCs connected by a Data Link; the information held in this area in the memory of each PLC is identical.
A system that links PLCs together.
A unit which connects a device to the network.
A connection between two units established either by software or a hardware device.
Placing a program or data into an area of computer or PLC memory.
A network located within a limited area (normally the user’s premises).
The address of the network to which a PLC is connected.
The number of the unit connecting the PLC to the network.
A table containing the details of the networks to which a PLC belongs.
LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E+308/-307) as defined by Microsoft®.
A file format supported by the CX-Server Import tool.
A communications protocol.
The parity bit is always set to 1.
A controlling device which sends data and/or instructions to a slave device.
Megabytes – A means of defining computer memory size.
Addressable area of storage space in a device.
This CX-Server component manages the file storage to and from PLC memory cards.
A device which writes data to a memory card.
A data storage medium which can hold both programs and data.
Megahertz.
A link to a ‘micro’ device acting as a host.
A spreadsheet application.
A file handling application part of the Microsoft Windows suite.
A windowing environment that is noted for its GUI, and for features such as multiple typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and the capability of moving text and graphics from one application to another via a clipboard.
CX-Server runs only under Microsoft Windows. DDE functions communicating with other applications supported by CX-Server use Microsoft Windows as a basis.
A device with the ability to convert digital data from a computer into analogue form and transmit it over a telecommunications line and also to convert received analogue signals into digital form.
A PLC operational mode which allows the device, during normal execution, to review the condition of the Data Link (including the PLCs/nodes on that link).
A variable number.
The format in which data is handled by a communications protocol; for example, ASCII or binary.
A unit that connects two or more networks together.
Network settings including information such as the maximum number of nodes permitted on a network and the waiting times between transmissions.
An interface which connects devices (not PLCs) to the network.
Part of the PLC configuration, based on the device type. The number of Networks available is dependant on the device type.
2. A number of computers linked together with a central processing point known as a Server which is accessible to all computers. Networks affect CX-Server in that further Network associated options are available if the computer is Network connected.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node number</td>
<td>Number identifying the device located at a particular node on the network. The number can be between 1 and 126, the maximum number of nodes available on an OMRON network.</td>
</tr>
<tr>
<td>Node</td>
<td>A position at which a device can be located on the network, consisting of a link unit mounted to a device or PLC which in turn interfaces with a peripheral device or a computer.</td>
</tr>
<tr>
<td>NSB</td>
<td>Network Service Board.</td>
</tr>
<tr>
<td>Odd parity</td>
<td>The number of 1s in a data transmission is odd.</td>
</tr>
<tr>
<td>Offline</td>
<td>The status of a device when it is not being controlled by a computer (although it may be physically connected to it).</td>
</tr>
<tr>
<td>OLE</td>
<td>Object Linking and Embedding. Used to transfer and share information between Microsoft Windows based applications and accessories.</td>
</tr>
<tr>
<td>Online</td>
<td>The status of a device when it is under the direct control of a computer.</td>
</tr>
<tr>
<td>Output Bit data area</td>
<td>An area of PLC memory reserved for output bits.</td>
</tr>
<tr>
<td>Output bit</td>
<td>The location within memory indicating the status of an output device.</td>
</tr>
<tr>
<td>Output device</td>
<td>A device which receives signals from a PLC.</td>
</tr>
<tr>
<td>Output</td>
<td>The signal sent from a PLC to an external device.</td>
</tr>
<tr>
<td>Packet</td>
<td>A unit of information transmitted across the network containing source and destination address information together with the actual data.</td>
</tr>
<tr>
<td>Parity bit</td>
<td>A bit transmitted with a packet of data indicating the type of parity check to be performed.</td>
</tr>
<tr>
<td>Parity</td>
<td>A type of validation check performed on transmitted information; data can be tested for either even, odd, none, mark or space parity. The type of parity check involved is indicated by the status of the parity bit.</td>
</tr>
<tr>
<td>Path</td>
<td>The location of a file including the drive, directory name plus any subdirectories and the file name together with its associated extension.</td>
</tr>
<tr>
<td>Peripheral</td>
<td>A device which aids system operation rather than being central to its functioning.</td>
</tr>
<tr>
<td>Performance Monitor tool</td>
<td>A CX-Server tool for monitoring communications throughput and for displaying CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming overloaded).</td>
</tr>
<tr>
<td>Ping test</td>
<td>A standard Ethernet communications test.</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller.</td>
</tr>
<tr>
<td>PLC Clock tool</td>
<td>The PLC Clock Tool provides a facility to monitor and set the PLC clock and synchronise the PLC clock to the PC clock.</td>
</tr>
<tr>
<td>PLC Error component</td>
<td>This CX-Server component displays and manages PLC errors.</td>
</tr>
<tr>
<td>PLC Memory component</td>
<td>This CX-Server component allows the user to view, edit and monitor either channels (words) or individual bits in areas of the PLC.</td>
</tr>
<tr>
<td>PLC Setup component</td>
<td>This CX-Server component permits the configuration of PLC settings.</td>
</tr>
<tr>
<td>Point</td>
<td>A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The contents of a point may be controlled by an object or I/O mechanism such as DDE. The contents of a point may control the action or appearance of an object, or be used for output via an I/O mechanism.</td>
</tr>
<tr>
<td>Polling</td>
<td>Interrogating a device to check its operational status or whether it is ready to send or receive data.</td>
</tr>
<tr>
<td>Port</td>
<td>A device connection point allowing data entry and exit.</td>
</tr>
<tr>
<td>Program</td>
<td>A set of instructions which are performed by a computer or PLC.</td>
</tr>
</tbody>
</table>
Program memory: An area of PLC memory reserved for the storage of programs.

Program mode: PLC mode of operation during which the device can be programmed.

Programmable Read Only Memory: An area of memory which can be updated with programs and data only once after manufacture; once this area has been written to, it can only be read, not modified.

Project: OMRON configuration file inherited from the invoking application. Refer also to CX-Server Project.

PROM writer: A device which writes the programs and data into PROM.

PROM: Programmable Read Only Memory.

Protocol: A set of rules governing the transmission of data.

PSTN: Public Switched Telephone Network.

Public Switched Telephone Network: A communications network carrying voice and data communications over switched lines.

Rack: The apparatus to which a unit is fixed.

RAM: Random Access Memory.

Read mode: PLC mode which allows data from the PLC to be read but not modified.

Read/write mode: PLC mode which allows data to be read from and written to the device.

Refresh parameter table: A table identifying the words in a Data Link to be refreshed for an individual PLC.

Registered IO Table: The internal PLC table; this is the one used by the PLC when running, regardless of the state of the actual hardware. It can be read and, for CV-series PLCs, written to by the CX-Server software.

Relay network address: The end network address which a PLC communicates.

Relay node number: The number of the network node through which a transmission must pass to reach another network.

Relay table: A table containing the relay network addresses, node numbers and end network addresses used within a FINS system.

Remote network: A network beyond the LAN to which access must be gained through a gateway or bridge.

Remote Terminals: Further units that can be supported by CX-Server via the Sysmac-Bus Master unit.

Reset: Turning a bit or signal OFF or changing it to its set value or to zero.

Root: The highest level of a directory.

Root group: The highest level group in a CX-Server project.

Rotary switch: Indicates the method of calling a device by generating a series of pulses.

Routing table: A table containing the information necessary to allow communications between different networks including local and gateway network address details.

Routing: The direction of data across a network from its source to its destination.

RS232: Industrial interface standard for serial communications.

RS422: Industrial interface standard for serial communications employing balanced line circuits.

RTs: Remote Terminals.

Run Mode: PLC mode of operation during which device information is typically read-only.

Serial Connection: A direct connection between computer and PLC.

Server application: An application that can be used to view or interact with.

Server: 1. Server is used in DDE functions to contain a link to an outside application. Using DDE functions, CX-Server allows the manipulation of an outside application as specified as the Server.
2. A Server is the central processing point of a Network which is accessible to all computers. Networks affect CX-Server in that further associated options are available if the computer Network is connected.

Signed Decimal  
A data format supported by CX-Server.

SIOU  
Special Input /Output Unit.

Slave  
A device which receives data or instructions from a master device.

Slots  
Free areas within a rack to which units can be fixed.

Software switches  
Areas of memory employed by an SIO unit used to set operating parameters (similar in manner to a hardware switch).

Space parity  
The parity bit is always set to 0.

Special Input /Output Unit  
A unit designed for a specific purpose.

SRM1 device type  
An OMRON PLC device supported by CX-Server.

Step Area  
An area of PLC memory containing a flag indicating the status of steps used within a program.

Stop bits  
Bits indicating the end of transmission of each set of data bits; normally one or two bits, they indicate the delay time between sending successive characters down the line.

Symbol  
An address that has been given a name to make the address information more flexible. Symbols are inherited by CX-Server by the invoking application.

SYSMAC LINK  
OMRON high speed industrial network (either co-axial or fibre optic).

SYSMAC NET  
OMRON high speed optical LAN which can be of type C SYSMAC NET or CV SYSMAC NET.

SYSMAC WAY  
OMRON network.

System area  
An area of memory used for controlling and managing a unit.

System configuration  
An arrangement of units, for example network, computers and PLCs.

Tagged database  
A file format supported by the CX-Server Import tool. The Tagged database is also an export format of the CX-Server Import tool.

TAPI  
Telephony Application Programming Interface.

Target PLC  
The PLC to which information or instructions are directed.

Taskbar  
An integral part of Microsoft Windows which allows Microsoft Windows based applications to be started. CX-Server tools are run from the Taskbar.

TCP/IP  

Temperature Controller  
An OMRON device.

Temporary Relay Area  
An area of PLC memory containing instructions which can be loaded at a later point for use with other instructions.

Text  
1. A file format supported by the CX-Server Import tool. The Text is also an export format of the CX-Server Import tool.

2. A data format supported by CX-Server.

Timer area  
An area of PLC memory containing program timers and their related completion flags.

Toolbus  
A network, either C-Toolbus or CV-Toolbus, allowing communications with a device via the serial COM port of a personal computer (in a similar manner to SYSMAC WAY). Data is transmitted along the network in binary format.

Tools  
CX-Server is made up of four tools.

Topic  
The name of an aspect of a service application which identifies where a reference link is to be incorporated; for example, within Excel the topic would be the name of the worksheet to be used.

Transceiver  
A device which can receive and transmit data.

Transfer from PLC  
The transfer of a program or data to a host (either a computer or a programming device) from a lower-level (or slave) device.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer to PLC</td>
<td>The transfer of a program or data from a host (either a computer or a programming device) to a lower-level (or slave) device.</td>
</tr>
<tr>
<td>Transition Area</td>
<td>Contains flags indicating when a transition is ON or OFF</td>
</tr>
<tr>
<td>Transmitter</td>
<td>A device which sends out signals.</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol.</td>
</tr>
<tr>
<td>Unit number</td>
<td>A number identifying an individual component of an OMRON PLC system configuration.</td>
</tr>
<tr>
<td>Units</td>
<td>A component of an OMRON PLC system configuration.</td>
</tr>
<tr>
<td>Unknown</td>
<td>The operating mode of a PLC that cannot be connected to.</td>
</tr>
<tr>
<td>Upload</td>
<td>See Transfer from PLC.</td>
</tr>
<tr>
<td>User Datagram Protocol</td>
<td>Protocol which directs information across a network to port numbers rather than to IP addresses.</td>
</tr>
<tr>
<td>Word</td>
<td>A 16 bit unit of data memory.</td>
</tr>
</tbody>
</table>
INDEX

A

About CX-Server · 1, 3, 172
access
Routing Table Editor · 133, 134
Access
Change PLC dialog · 78
CX-Net Network Configuration tool · 2
Data Link Editor · 85
Data Trace/Time Chart Monitor component · 49
Edit Project dialog · 79
IO Table component · 19
Memory Card component · 73
PLC Memory component · 7
SYSMAC NET Data Link Editor · 85
Adding a Device · 78
Adding a Local Network · 134
Adding a Remote Network · 135
Additional Features - Routing Table · 136
Appendix C
   Toolbars and Keyboard Shortcuts · 165
Application · 171

B

Baud rate · 171
Bit · 171

C

Checking Data Link Tables · 112
Clear All Memory Areas · 70
Clearing and Filling Data Areas · 12
Clearing PLC Errors · 81
Closing a PLC · 79
Communication Unit Setup · 82
Communications
   End connections · 173
   Gateway connections · 174
   Host Link · 39, 43, 46
   Modem · 175
   Peripheral Port · 39, 46
   Requirements · 2
   Testing network connections · 82
   Configuring a PLC’s System Settings · 80
Controller Link
   Network settings · 83
   Network setup · 83
   Network status · 83
   Software switches · 30
Creating a New CX-Server Project · 78
Creating a new Routing Table · 133
Creating and IO Table · 81
CS1-Series PLC Settings · 37
C-Series PLC Settings · 44
CSV format (Unit Status and Error Log) · 82
CSV-format (Data Link Table) · 113
Customer support for CX-Server · 4
CV-Series PLC Settings · 42

CX-Net and CX-Server Projects · 78
CX-Net Network Configuration tool
   Access · 2
   Access Change PLC dialog · 78
   Access Edit Project dialog · 79
   Adding a device to a CX-Server project · 78
   Adding a PLC to a CX-Server project · 78
   Broadcast nodes test · 82
   Changing a device in a CX-Server project · 79
   Changing a PLC in a CX-Server project · 79
   Clearing PLC errors · 81
   Closing a PLC · 79
   Controller Link settings · 83
   Creating a new CX-Server project · 78
   Creating an IO table · 81
   CX-Server project · 78
   CX-Server project devices · 77
   Data link tables · See Data link tables
   Device information · 80
   Device List dialog · 79
   Displaying unit status · 81
   Dragging device information into a CX-Server project · 80
   Editing a CX-Server project · 79
   Editing PLC list · 79
   Internode Echo-Back test · 82, 173, 174
   Introduction · 77
   Opening a PLC · 79
   Opening an existing CX-Server project · 78
   Ping node test · 82
   Ping test · 176
   PLC settings · 79
   Project · 78
   Routing tables · See Routing tables
   Scanning for connections · 80
   Setting the operating mode · 81
   Status bar · 77
   SYSMAC LINK settings · 82
   System settings · 80
   Testing network connections · 82
   Unit status · 81
   User interface · 77

CX-Programmer
   System requirements · 2

CX-Server
   About · 1, 3, 172
   Customer support · 4
   Installation · 2
   Starting · See Access
   CX-Server 1.5 Features · 2
   CX-Server project
      Access Edit Project dialog · 79
      Adding a device to a CX-Server project · 78
      Adding a PLC to a CX-Server project · 78
      Changing a device in a CX-Server project · 79
      Changing a PLC in a CX-Server project · 79
      Creating a new CX-Server project · 78
      Device List dialog · 79
      Dragging device information · 80
      Editing a CX-Server project · 79
      Editing PLC list · 79
      Opening an existing CX-Server project · 78
      CX-Server project file · 78
      CX-Server Software · 1
Data Link · 83
Data link tables
  Access · 85
  Access to SYSMAC NET Data Link Editor · 85
  Common link parameter · 171
Creating a SYSMAC NET data link table · 85
Data Link Editor · 85
Deleting a table · 85
Deleting an item from a SYSMAC NET data link table · 86
Editing a SYSMAC NET data link table · 85
Editing a table · 84
Import tables · 86
Introduction · 78
Logical error checking · 86
Offline Data Link Editor · 85
Offline SYSMAC NET Data Link Editor · 85
Opening a table · 84
Opening an existing SYSMAC NET data link table · 86
Saving a table · 84
Setup · 84
Status bar · 85
SYSMAC NET · 84
SYSMAC NET Data Link Editor · 85
SYSMAC NET table information · 86
Table information · 85
  Updating table status · 84
Data Link Tables · 95
Data Trace · 52, 57, 61
Data Trace/Time Chart · 49
Data Trace/Time Chart Monitor component
  Access · 49
  Bit addresses · 65, 67
  Block mode · 67
  Close · 49
  Colour configuration · 67
  Display formats · 67
  Execute data trace/time chart · 65
  Grid · 68
  Histogram mode · 67
  Importing SYSWIN files · 68
  Inserting a TRSM ladder instruction · 50, 51
  Introduction · 49
  Modes of operation · 64
  Open a data trace file · 66
  Outline mode · 67
  Sampling ranges · 50
  Scale · 67
  Set trigger condition · 65
  Setting a timer interval · 50, 51
  Setting conditions · 64
  Status bar · 49
  Stop data trace/time chart monitor · 65
  Trend graph mode · 67
  Trigger conditions · 64
  Upload data trace · 65
  User interface · 49
  Word addresses · 67
  Zoom · 67
Data Trace/Time Chart Monitor Component · 49
DDE · 172, 173
Item · 175
Server · 178
Topic · 178

Displaying a Data Trace/Time Chart · 66
Displaying PLC Device Information · 80
Displaying the PLC Unit Status · 81
DLY · 173
Download
  IO Table component · 31
  PLC Memory component · 9
  PLC Setup component · 48
Dragging Device Information into a CX-Server Project · 80

Editing a Device List · 79
Editing Data · 8
Editing the Routing Table · 136
Error Checking · Routing Table · 136
Ethernet
  Software switches · 29
Execution Controls · 42

Force
  Bits · 13
  Clearing all bits · 14
  Copying bits · 14
  Deleting all bits · 14
  Display status · 14
  Hold bits · 41, 42
  Scan status · 14
  Set value · 13
  Updating bits · 14
  Forced Settings · 14

Glossary of Terms · 171

Help · See Online help
Help and how to access it · 2
Help topics · 3
Help topics
  Find · 3
  Index · 3
Help Topics
  Context sensitive help · 3
Host Link
  Communications · 39, 43, 46
Hot Swap · 34

I/O Table Component · 19
I/O Table Memory Component
Verifying Correct Configuration · 28
Import
  Data link tables · 86
  SYSWIN data trace/time chart files · 68
Installing CX-Server · 2
IO Table component
  Access · 19
  Actual IO Table · 19, 171
  Allocating slots in a rack · 26
  ASCII unit settings · 27
  Checking the IO table · 31
  Clearing the IO table · 31
  Close · 19
  Comparing an IO table · 31, 32
  Counter unit settings · 27
  Creating an IO table · 19, 20, 21, 23, 26, 81
  CX-Server IO Table · 19
  Deleting an IO table unit · 31
  Editing software switches · 29
  Editing units · 27
  Hot swapping · 34
  Interrupt unit settings · 27
  Introduction · 19
  Multiple units · 23, 25, 26, 27
  Numerical control unit settings · 27
  Position Controller unit settings · 27
  Rack start address setting · 35
  Registered IO Table · 19, 177
  Remote Terminals · 27
  Single units · 23, 25, 26, 27
  SIOU units · 19
  SIOU/Communications unit settings · 28
  Software switches · 28, 29
  Software switches, Controller Link · 30
  Software switches, data link area settings · 29
  Software switches, Ethernet · 29
  Software switches, general settings · 29
  Software switches, serial communications unit settings · 30
  Software switches, SYSMAC LINK · 29, 30
  Software switches, SYSMAC NET · 29
  Software switches, Sysmac-Bus2 settings · 30
  Status bar · 19
  Sysmac-Bus Master and Remote Terminal unit settings · 27
  Timer unit settings · 27
  Transfer from PLC · 31
  Transfer to PLC · 31
  Unit manufacturing information · 35
  Unit settings · 23
  Unit setup · 28
  Units profile information · 35
  Units, SIOU · 19
  User interface · 19
  Verifying correct IO configuration · 28
IO Table Management · 31

EM memory as file memory · 74
Errors · 75
Extended PLC setup files · 75
Formatting prior to use · 73, 74
Introduction · 73
Paste · 74
Properties · 75
Renaming a file · 75
Snapshots · 73
Status bar · 73
Transfer to EM file area · 75
Transfer to memory card · 75
User interface · 73
Viewing a file from the memory card · 73
Memory Card Component · 73
Memory Card Display · 74
Memory Card Operation · 73
Monitor
  Address areas · 13
  PLC data areas · 11
  Monitor Component · 49
  Monitoring Data Link Status · 130

N
Network Configuration tool · See CX-Net Network Configuration tool

O
Online help · 1, 2
Opening a PLC · 79
Opening an Existing CX-Server Project · 78
Opening an existing Routing Table · 133

P
Peripheral Port
  Communications · 39, 46
PLC
  Access Change PLC dialog · 78
  Address enable settings · 44
  Addresses · 13
  Clearing errors · 81
  Closing a PLC · 79
  Creating an IO table · 81
  Cycle time settings · 45
  Data areas · 8
  Default settings · 37, 42, 44
  Deleting errors · 81
  Device information · 80
  Dragging into a CX-Server project · 80
  Duplex Settings · 40
  EM memory as file memory · 42
  Error log settings · 42
  Error settings · 46, 47
  Execution control settings · 43
  Execution process processing · 38
  Extended setup files · 75
  Hold settings · 44

M
Managing the Data Trace/Time Chart Monitor · 65
Manually Setting Data Links · 94
Memory Card component
  Access · 73
  Compact Flash · 171
  Copy · 74
  Cut · 74
  Deleting a file · 75
<table>
<thead>
<tr>
<th>Information · 80</th>
<th>Deleting data areas · 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interrupt settings · 45</td>
<td>Deleting forced bits · 14</td>
</tr>
<tr>
<td>IO refresh settings · 43</td>
<td>Deleting rows · 14</td>
</tr>
<tr>
<td>Memory allocation settings · 38</td>
<td>Display formats · 8, 12, 13, 16</td>
</tr>
<tr>
<td>Offline PLC · 79</td>
<td>Displaying forced status · 14</td>
</tr>
<tr>
<td>Online PLC · 79</td>
<td>Editing Data · 8</td>
</tr>
<tr>
<td>Opening a PLC · 79</td>
<td>Editing data areas · 8</td>
</tr>
<tr>
<td>Operating mode · 42, 79</td>
<td>Filling data areas · 12</td>
</tr>
<tr>
<td>Operating mode, setting · 81</td>
<td>Forced settings · 14</td>
</tr>
<tr>
<td>PC communications · 31, 32, 48, 65, 75</td>
<td>Forcing data · 13</td>
</tr>
<tr>
<td>PLC Specific Features · 34</td>
<td>Inserting rows · 14</td>
</tr>
<tr>
<td>Refresh settings · 45</td>
<td>Introduction · 7</td>
</tr>
<tr>
<td>Scanning for connections · 80</td>
<td>Monitoring address areas · 13</td>
</tr>
<tr>
<td>Setting the operating mode · 81</td>
<td>Monitoring data areas · 11</td>
</tr>
<tr>
<td>Settings · 37, 79</td>
<td>Opening files · 15</td>
</tr>
<tr>
<td>SIOU refresh settings · 39</td>
<td>Paste · 16</td>
</tr>
<tr>
<td>Startup settings · 37, 42, 44</td>
<td>Preferences · 16</td>
</tr>
<tr>
<td>System settings · 80</td>
<td>Print preview · 15</td>
</tr>
<tr>
<td>Testing network connections · 82</td>
<td>Print setup · 16</td>
</tr>
<tr>
<td>Timing settings · 38, 44</td>
<td>Printing data areas · 15</td>
</tr>
<tr>
<td>Unit settings · 39</td>
<td>Removing rows · 14</td>
</tr>
<tr>
<td>Unit status · 81</td>
<td>Resize columns · 7</td>
</tr>
<tr>
<td>PLC Clock tool</td>
<td>Resize rows · 7</td>
</tr>
<tr>
<td>Introduction · 87</td>
<td>Saving data to a CX-Server project · 15</td>
</tr>
<tr>
<td>Setting the time · 87</td>
<td>Saving data to file · 15</td>
</tr>
<tr>
<td>Synchronise · 87</td>
<td>Status bar · 7</td>
</tr>
<tr>
<td>PLC Clock Tool · 87</td>
<td>Transfer from PLC · 8</td>
</tr>
<tr>
<td>PLC Error component</td>
<td>Transfer to PLC · 9</td>
</tr>
<tr>
<td>Activating the error log following error detection · 72</td>
<td>Updating forced status · 14</td>
</tr>
<tr>
<td>Clearing errors · 69, 81</td>
<td>User interface · 7</td>
</tr>
<tr>
<td>Clearing messages · 70</td>
<td>Viewing PLC memory · 7</td>
</tr>
<tr>
<td>Clearing the error log · 70</td>
<td>Zoom · 8</td>
</tr>
<tr>
<td>Clock settings · 71</td>
<td>PLC Memory Component · 7</td>
</tr>
<tr>
<td>Customising component layout · 71</td>
<td>PLC Memory components</td>
</tr>
<tr>
<td>Deleting errors · 69, 81</td>
<td>PC to PLC communications · 8</td>
</tr>
<tr>
<td>Deleting messages · 70</td>
<td>Timer/Counter Memory areas · 10</td>
</tr>
<tr>
<td>Deleting the error log · 70</td>
<td>PLC Memory Management · 15</td>
</tr>
<tr>
<td>Disabling the error log · 71</td>
<td>PLC Memory Preferences · 16</td>
</tr>
<tr>
<td>Displaying the Error Log · 72</td>
<td>PLC Setting - CS1-Series · 37</td>
</tr>
<tr>
<td>Enabling the error log · 71</td>
<td>PLC Settings · 79</td>
</tr>
<tr>
<td>Error log · 70</td>
<td>PLC Settings - C-Series · 44</td>
</tr>
<tr>
<td>Error log entry types · 70</td>
<td>PLC Settings - CV-Series · 42</td>
</tr>
<tr>
<td>Error log settings · 70</td>
<td>PLC Setup component</td>
</tr>
<tr>
<td>Error types · 70</td>
<td>Address enable settings · 44</td>
</tr>
<tr>
<td>Errors · 69</td>
<td>Communications board settings · 46</td>
</tr>
<tr>
<td>Introduction · 69</td>
<td>Comparing PLC settings · 48</td>
</tr>
<tr>
<td>Manual updates to the error log · 71</td>
<td>Cycle time settings · 45</td>
</tr>
<tr>
<td>Messages · 70</td>
<td>Default settings · 37, 42, 44</td>
</tr>
<tr>
<td>Overwriting error log entries · 71</td>
<td>error log settings · 42</td>
</tr>
<tr>
<td>PLC settings · 42</td>
<td>Error settings · 46, 47</td>
</tr>
<tr>
<td>Refreshing the error log · 71</td>
<td>Execution control settings · 43</td>
</tr>
<tr>
<td>Status bar · 69</td>
<td>Execution process settings · 38</td>
</tr>
<tr>
<td>Time monitoring settings · 70</td>
<td>Hold area settings · 44</td>
</tr>
<tr>
<td>User interface · 69</td>
<td>Host Link Port settings · 39, 43, 46</td>
</tr>
<tr>
<td>PLC Error Component · 69</td>
<td>Interrupt settings · 45</td>
</tr>
<tr>
<td>PLC Memory · 11</td>
<td>Introduction · 37</td>
</tr>
<tr>
<td>PLC Memory component</td>
<td>IO Refresh settings · 43</td>
</tr>
<tr>
<td>Access · 7</td>
<td>Memory allocation settings · 38</td>
</tr>
<tr>
<td>Address area · 13</td>
<td>Peripheral Port settings · 39, 46</td>
</tr>
<tr>
<td>Clearing and Filling Data Areas · 12</td>
<td>Refresh settings · 45</td>
</tr>
<tr>
<td>Clearing data areas · 12</td>
<td>SIOU refresh settings · 39</td>
</tr>
<tr>
<td>Clearing forced bits · 14</td>
<td>Startup settings · 37, 38, 40, 42, 44</td>
</tr>
<tr>
<td>Close · 7, 37, 69, 87</td>
<td>Status bar · 37</td>
</tr>
<tr>
<td>Comparing PLC and PC values · 9</td>
<td>Timing settings · 37, 38, 44</td>
</tr>
<tr>
<td>Copy · 16</td>
<td>Transfer from PLC · 48</td>
</tr>
<tr>
<td>Copying forced bits · 14</td>
<td>Transfer to PLC · 48</td>
</tr>
<tr>
<td>Cut · 16</td>
<td></td>
</tr>
</tbody>
</table>
Part 2: CX-Server PLC Tools

Index – CX-Server – PLC Tools

- Unit settings · 39
- User interface · 37
- Verifying PLC settings · 48
- PLC Setup Component · 37

Points
- Address · 171
- Command modifier · 171
- Data location · 172
- Groups · 174
- IO types · 23, 24, 25, 26, 27

Print
- PLC Memory component · 15
- Preview PLC Memory component · 15
- Setup PLC Memory component · 16
- Procedure Through Data Link Startup · 124

Rack/Slot Start Address · 35
Racks · 177
Reading and Transferring Data Link Tables · 119
Reading the Data Link Table · 119
Retrieving Data Trace/Time Settings · 66
Routing Table · 83
route tables
- access Routing Table Editor · 133, 134
Routing tables
- Adding a Local Network · 134
- Adding a Remote Network · 135
- Additional Features · 136
- Creating a new Routing Table · 133
- Editing the Routing Table · 136
- Error Checking · 136
- Introduction · 77
- Opening an existing Table · 133
- Table View Screen · 137
- The Network View Screen · 136
- The Overview Screen · 137
- Transferring a Routing table from a PLC · 140
- Transferring a Routing table to a PLC · 140
Routing Tables · 133

Saving Data Trace Settings · 66
Scanning for PLC Connections · 80
Setting the PLC Mode · 81
Settings · 38
Slots · 178
Software switches · 28, 29
- Controller Link · 30
- Data link area settings · 29
- Editing · 29
- Ethernet · 29
- General settings · 29
- Serial communications unit settings · 30
- SYSMAC LINK · 29, 30
- SYSMAC NET · 29
- Sysmac-Bus2 settings · 30

Starting and Stopping Data Links (Including Status Displays) · 122
Starting CX-Server · See access
Status bar · 4
- CX-Net Network Configuration tool · 77
- Data Link Editor · 85
- Data Trace/Time Chart Monitor component · 49
- IO Table component · 19
- Memory Card component · 73
- PLC Error component · 69
- PLC Memory component · 7
- PLC Setup component · 37
Symbols · 178
SYSMAC LINK
- Network settings · 82
- Network setup · 82
- Network status · 82
- Software switches · 29, 30
- SYSMAC LINK Automatic Setup · 127
SYSMAC NET
- Access to Data Link Editor · 85
- Creating a data link table · 85
- Data Link Editor · 85
- Data link table information · 86
- Data link tables setup · 84
- Deleting an item from a data link table · 86
- Editing a data link table · 85
- Logical error checking · 86
- Offline Data Link Editor · 85
- Opening an existing data link table · 86
- Software switches · 29
System requirements · 2
SYSWIN Data Trace and Time Chart Monitor Files · 68

Technical Specification · 1
Testing the Network Connection · 82
Toolbars and Keyboard Shortcuts · 165
Transferring the Data Link Table · 120

Unit setup · 28, 82
Unit Status/Error Log · 82
Units · 179
Upload
- Data Trace/Time Chart Monitor component · 65
- IO Table component · 31
- PLC Memory component · 8
- PLC Setup component · 48

Words · 179
PART 3:
CX-Server
Runtime
Notice

OMRON products are manufactured for use according to proper procedures by a qualified operator and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed the information provided in them. Failure to heed precautions can result in injury to people or damage to the product.

⚠️ **DANGER** Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury. Additionally, there may be severe property damage.

⚠️ **WARNING** Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. Additionally, there may be severe property damage.

⚠️ **Caution** Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury, or property damage.

**OMRON Product References**

All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything else.
Visual Aids

The following headings appear in the left column of the manual to help you locate different types of information.

- Indicates information of particular interest for efficient and convenient operation of the product.
- Indicates lists of one sort or another, such as procedures, checklists etc.
- Represents a shortcut on the Toolbar to one of the options available on the menu of the same window.

Other manual conventions are as follows:

- Windows-based applications provide users with a number of different ways to perform one operation. These are normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; using the right-mouse button to display a context-sensitive menu; dragging and dropping. Whilst recognising this, the manual provides user instructions employing the Toolbar and right-mouse button only. Use of the application menu bar or keyboard shortcuts are only included if no such alternatives exist.

- Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer or CX-Protocol. This is noted in the manual by the term “invoking application”.

- This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-Server project is defined in this manual. An application project is defined by the software application invoking CX-Server.

© OMRON, 2005

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of OMRON.

All copyright and trademarks acknowledged.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained in this manual is subject to change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.
About this Manual

This manual describes the CX-Server application and its ability to control and monitor a range of OMRON
PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the
commercial manual for the device must be consulted.

This manual contains the following chapters:

- **Chapter 1 - Technical Specification.** This chapter describes CX-Server in general terms and introduces the user to
  the relationship between CX-Server and associated products. It also provides details of the operating environment,
  minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server.

- **Chapter 2 - Introduction to CX-Server.** This chapter describes the concepts on which CX-Server is based including
  the definition of PLCs, points and groups.

- **Chapter 3 - Communications.** This chapter describes the communications supported by CX-Server

- **Chapter 4 - Import/Export Tool.** This chapter describes the Import/Export Tool and its ability to add data from
  CVSS and LSS files to a CX-Server project.

- **Chapter 5 - DDE Manager Tool.** This chapter describes the DDE Manager and its ability to read and update point
  data via CX-Server.

- **Chapter 6 - Performance Monitor Tool.** This chapter describes the Performance Monitor Tool and the procedures
  involved when monitoring communications.

- **Chapter 7 – Driver Management Tool.** This chapter describes the Driver Management Tool and how to manage
  your device drivers within CX-Server.

- **Appendix - A Network Availability.** The tables in this appendix indicate the network available to each PLC device
  group. FinsGateway has no network availability and is not described.

- **Appendix B - PLC Memory Area.** The tables in this appendix provide memory area details for each device group.

- **Appendix C - Toolbars and Keyboard Shortcuts.** The tables in this appendix summarise the toolbars and keyboard
  shortcuts available from each component tool.

A Glossary of Terms and Index are also provided
## TABLE OF CONTENTS

**CHAPTER 1 Technical Specification** ................................................................. 1
- CX-Server Software .............................................................................................................. 1
- About this Manual .............................................................................................................. 1
- Features ................................................................................................................................. 2
- System Requirements ......................................................................................................... 2
- Communications Requirements ............................................................................................ 2
- Installation ............................................................................................................................. 3
- Starting CX-Server ................................................................................................................ 3
- Help and How to Access it ..................................................................................................... 3
- Technical Support ................................................................................................................. 4

**CHAPTER 2 Introduction to CX-Server Projects** .................................................. 7
- CX-Server Projects ............................................................................................................. 7
- CX-Server Project Concepts ............................................................................................. 7
- Editing a CX-Server Project PLC List ............................................................................... 8
- Editing CX-Server Project ................................................................................................. 10

**CHAPTER 3 Communications** .............................................................................. 15
- Supported Communications .............................................................................................. 15
- Device Setup ....................................................................................................................... 15
- Defining Connections and Gateway PLCs ........................................................................ 18
- Serial Communications (Direct Connection) ..................................................................... 18
- Network Communications (End Connection) ...................................................................... 24
- DeviceNet .......................................................................................................................... 25
- Connecting Using EtherNet/IP ......................................................................................... 29
- Connecting through an NV-series PT ................................................................................ 36

**CHAPTER 4 Import/Export Tool** ......................................................................... 39
- Supported Import/Export Data ........................................................................................ 39
- CX-Server Project Selection ............................................................................................ 40
- Import ................................................................................................................................. 40
- Export ................................................................................................................................. 42

**CHAPTER 5 DDE Manager Tool** ......................................................................... 45
- Establishing DDE Links .................................................................................................... 45
- Defining Update Intervals ............................................................................................... 48
- Special Data Types ............................................................................................................. 48

**CHAPTER 6 Performance Monitor Tool** ............................................................... 49

**CHAPTER 7 Driver Management Tool** ................................................................. 51

**APPENDIX A Network Availability** ................................................................. 53
- C***H Device Group ........................................................................................................ 53
- C***K Device Group ........................................................................................................ 53
- C***P Device Group ........................................................................................................ 53
- C1000H Device Group ..................................................................................................... 53
- C20 Device Group ............................................................................................................ 53
- C2000H Device Group .................................................................................................... 54
- C200H Device Group ....................................................................................................... 54
- C200HE Device Group ................................................................................................... 54
- C200HE-Z Device Group ............................................................................................... 54
- C200HG Device Group .................................................................................................. 54
- C200HG-Z Device Group ............................................................................................... 55
- C200HS Device Group ................................................................................................... 55
- C200HX Device Group .................................................................................................. 55
- C200HX-Z Device Group ............................................................................................... 55
- C500 Device Group ......................................................................................................... 55
- CJ2H Device Group ......................................................................................................... 56
APPENDIX B PLC Memory Areas

CJ1G Device Group.................................................................56
CJ1G-H Device Group...........................................................56
CJ1H-H Device Group...........................................................56
CJ1M Device Group.............................................................56
CP1H Device Group.............................................................56
CP1L Device Group.............................................................56
CP1E Device Group.............................................................57
CPM1 (CPM1A/CPM2*) Device Group.................................57
CPM2*-S* Device Group.......................................................57
CQM1 Device Group............................................................57
CQM1H Device Group.........................................................57
CS1G/CS1G-H Device Group..............................................58
CS1H/CS1H-H Device Group..............................................58
IDSC Device Group............................................................58
SRM1 – SRM1 V2 Device Group............................................58
CV1000 Device Group.........................................................58
CV2000 Device Group.........................................................58
CV500 Device Group...........................................................58
CVM1 Device Group...........................................................59
CVM1-V2 Device Group....................................................59

PART 3: CX-Server Runtime
CHAPTER 1
Technical Specification

This chapter describes the CX-Server software in general terms and introduces the user to the relationship between CX-Server and associated products. It also provides details of the operating environment, minimum configuration and installation procedures necessary for the satisfactory operation of CX-Server.

CX-Server Software

CX-Server is a communications management system in Microsoft Windows for OMRON PLCs. It provides facilities to maintain PLC device and address information and to communicate with OMRON PLCs and their supported network types.

CX-Server consists of the following components:

As well as acting as a server for other OMRON software, CX-Server includes other customer tools:

♦ **CX-Server DDE Manager** tool. A tool for allowing transference of data between PLCs and a client using DDE, for example Microsoft Excel.
♦ **CX-Server Import** tool. This tool is used for addresses and PLCs defined using the CVSS and LSS products. It allows definitions of addresses and PLCs to be used by importing them into a CX-Server project file.
♦ **CX-Server Performance Monitor** tool. A tool for monitoring communications throughput and for displaying CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming overloaded).
♦ **CX-Server Driver Manager** tool. A tool for installing and un-installing new software drivers for support of hardware devices.

CX-Server comprises various executables, Dynamic Link Libraries (DLLs) and components. In order to use certain communication types (i.e. Ethernet, SYSMAC LINK, SYSMAC NET), some settings must be configured prior to use – separate to the software installation. Refer to Chapter 3- Communications for further details.

About this Manual

This User Manual acts as a reference for CX-Server by describing its various concepts and abilities. It also provides the basics of using its dialogs and supplied utilities.

⚠️ **Caution** This manual is referred to from other software that utilises CX-Server, for instance, CX-Programmer, CX-Protocol, CX-Supervisor or CX-Server OPC and CX-Server Lite. Subsequently, some topics contained in this user manual may not be relevant.

CX-Server comes with a context-sensitive online help system which is designed to complement this manual and to provide a quick reference at any point while using CX-Server when the manual is not to hand. This general help system uses a fast hypertext system, which allows progressively detailed information about any topic to be obtained by selecting keywords within the descriptive text.

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows and know how to:

♦ use the keyboard and mouse;
♦ select options from Microsoft Windows menus;
♦ operate dialog boxes;
♦ locate, open and save data files;
♦ edit, cut and paste text;
♦ use the Microsoft Windows desktop environment.

If the installed version of Microsoft Windows has not been used before, it is recommended that the reader spends some time working with it using the Microsoft documentation before using CX-Server.
Features

CX-Server is the cornerstone of the suite of applications collectively known as the CX-Automation Suite. The CX-Automation Suite is not one system but software that has been designed to dynamically evolve with every direction a manufacturer would like to take and to accommodate any implementation, improvement, adaptation or extension of any form of control or data acquisition in a manufacturing industry.

The software suite has been developed to serve you with powerful yet comprehensible software that builds and runs networks that simply control one machine or an entire manufacturing process. It comprises the following:

♦ CX-Programmer
♦ CX-Server Lite
♦ CX-Server OPC
♦ CX-Protocol
♦ CX-Motion
♦ CX-Supervisor

The CX-Automation suite is in itself highly adaptive. It completes the integration of process control and business information systems, by applying one and the same basic network architecture. For the user it means that data from both sources of information can be jointly reported in familiar applications such as spreadsheets, in which they can be recalculated in existing layouts or processed along usual spreadsheet procedures.

The architecture is based on standards that are widely maintained such as ActiveX and OPC (OLE for Process Control) and standard interfaces such as COM, DCOM and ODBC/ADO. This conformity also means that you can use standard interfaces and standard software.

System Requirements

Refer System Requirements on page 3 in PART 1 CX-Programmer.

Use of a mouse is highly recommended, although all operations can be performed using the keyboard. Refer to Appendix C for a list of keyboard shortcut commands.

The amount of RAM and hard disk space used depends upon the size of the PLC programs written – approximately 1K per step.

Communications Requirements

In order to use serial communication types SYSMAC WAY and Toolbus the following is required:

♦ RS232 connection via a standard serial port on the PC (COM1 etc.) or RS422 connection to a 422 serial board.
♦ In order to use SYSMAC LINK directly from the PC a SYSMAC LINK Network Service Board and FinsGateway Version 3 or higher is required.
♦ In order to use Controller Link directly from the PC a Controller Link Network Service Board (wired or optical) and FinsGateway Version 3 or higher are required.
♦ In order to use Ethernet an Ethernet card, Windows Sockets software and TCP/IP must be installed and configured.
♦ In order to use an ISA board FinsGateway Version 3 or higher is required.
♦ Controller link PC NSB is supported using FinsGateway Version 3 or higher.
♦ SYSMAC LINK PC NSB is supported using FinsGateway Version 3 or higher.

In order to use FINSGateway with the CLK/SLK PCI board in the Windows 2000 operating system the appropriate drivers must be installed. These drivers can be found on the CX-Server CD under: CX-Server\WDM\CLK (PCI) or CX-Server\WDM\SLK (PIC).

Refer to Chapter 3 - Communications for more information and the appropriate hardware system manuals for full information about connecting and configuring these devices for the environment.
Installation

This describes the procedures involved in the installation of CX-Server on a standard workstation running Microsoft Windows 2000 or XP, or Vista.

The software is supplied on CD-ROM and is installed easily from within Microsoft Windows. The installation can be terminated at any point during the installation process.

If CX-Server is being installed as part of the CX-Programmer installation then on completion of the CX-Programmer installation a number of dialogs will prompt for information concerning the installation of CX-Server and its components.

Note: Internet Explorer 5.0 or higher is required for the correct operation of CX-Server.

Starting CX-Server

CX-Server components are normally accessed from the invoking application. However, a number of tools can be accessed as stand-alone tools from the windows Start menu (on the Microsoft Windows taskbar).

- Performance Monitor tool.
- DDE Manager tool.
- CX-Server Import / Export tool.

Help and How to Access it

CX-Server comes with a detailed context-sensitive help system. At any time while using the software, it is possible to get help on the particular point that is currently being worked on, or on general aspects of CX-Server. This system is intended to complement the manual, by providing online reference to specific functions of the software and how to use them. The manual is designed to provide more tutorial information and discuss the various facilities offered by CX-Server.

- Context-sensitive help;
- Help Index (available on the Help menu);
- Help Contents (available on the Help menu);
- About (available on the Help menu);
- Status Bar tool button tips.

Help Topics

Select the Help Contents option on the Help menu. The Help system provides a standard look-up dialog under the Contents tab showing the contents of the CX-Server Help file. Click on an item to read the associated information.

Index

Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog.

1. Select the Help Index option from the Help menu.
2. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field.
3. Select an entry in the second step field and select the Display pushbutton, or double-click on the index entry.
4. If an entry is linked to two or more topics, the names of the topics are displayed in the Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on the topic.

Find

Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog.

1. Select the Help Index option from the Help menu.
2. Select the Find tab.
3. Enter a text query into the first step field. The second step field is refreshed according to the query entered in the first step field. Previous text queries can be retrieved by selecting from the drop-down list in the first step field.
4. Select a word that matches the query – some words may be automatically selected. More than one word can be selected by pressing Shift and selecting another word to extend the selection, or by pressing Ctrl and selecting another word to add to the selection. The third step field is refreshed according to the word or words selected. The number of topics found are shown at the bottom of the dialog.
5. Select a topic from the third step field and select the Display pushbutton, or double-click on the topic from the third step field. Select the Clear pushbutton to restart the find operation.

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button.

Context-sensitive Help
CX-Server supports the use of context-sensitive help. The relevant online help topic is provided automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 function key to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be accessed.

About CX-Server
Each CX-Server component contains an About option on the Help menu. The About CX-Server dialog supplies technical reference information about that component such as version and copyright information. It also contains the version number which is required for obtaining technical support.

Use the following procedure to view the About CX-Server dialog.

1. Select About from the Help menu.
2. The About box is displayed. It provides a copyright statement and version number of the component or tool within CX-Server.

Status Bar
The Status Bar is displayed at the bottom of many of the CX-Server component and tool windows. It provides several helpful pieces of information while programming:

- **Instant Help.** A brief message appears in the Status Bar as menu commands and buttons are selected.
- **Online Status.** The online or offline status of the PLC.
- **PLC Mode.** When connected to a PLC, this shows the current PLC mode. Connection errors are also displayed here.
- **Connected PLC and CPU Type.** The currently connected PLC and associated CPU can always be referenced in the status bar.

The CX-Server Status Bar can be enabled and disabled from many components and tools by selecting the Status Bar option from the View menu.

Technical Support
If the installation instructions for this have been followed (refer to ‘Installation’ above), no difficulties should be encountered. However, if there is a problem, contact Customer Services.

If a problem occurs, check that it does not relate to a fault outside CX-Server. Check the following:

- The PC is working correctly.
- The PLC is working correctly.
- The communications system is set up correctly.
- The errors are cleared in the PLC.

When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear and concise description of the problem is required, together with the exact text of any error messages.

**Note:** Use the About box to obtain the version number of the component.
## Customer Services Required Information Table

<table>
<thead>
<tr>
<th>Version number of CX-Server component or tool:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial number of the software:</td>
<td></td>
</tr>
<tr>
<td>Operating system and version number:</td>
<td></td>
</tr>
<tr>
<td>Language of operating system:</td>
<td></td>
</tr>
<tr>
<td>PLC type, model and CPU details:</td>
<td></td>
</tr>
<tr>
<td>Type of communications in use:</td>
<td></td>
</tr>
<tr>
<td>Serial</td>
<td></td>
</tr>
<tr>
<td>Toolbus</td>
<td></td>
</tr>
<tr>
<td>SYSMAC LINK</td>
<td></td>
</tr>
<tr>
<td>SYSMAC NET</td>
<td></td>
</tr>
<tr>
<td>Device NET</td>
<td></td>
</tr>
<tr>
<td>Controller Link</td>
<td></td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
</tr>
<tr>
<td>Nature of the problem:</td>
<td></td>
</tr>
<tr>
<td>Steps taken to reproduce problem:</td>
<td></td>
</tr>
<tr>
<td>Other comments:</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 2
Introduction to CX-Server Projects

This chapter describes how data is identified within CX-Server projects (in terms of PLCs, points and groups). It also describes the CX-Server functions available for the purposes of configuring PLCs and points within a CX-Server project.

CX-Server Projects

CX-Server is a middleware package which allows other software to access OMRON automation devices (PLCs, temperature controllers, Memory Card Writer and PROM Writer) through various connection types. In order to co-ordinate these communications, it handles information detailing the PLC devices attached to the PC and the information being accessed on each device.

Such information is held in a CX-Server project file with a .CDM extension. This file contains all of the information about the PLCs, which CX-Server can connect to and the addresses of interest in each PLC which may be accessed.

Each CX-Server project file is separate and is similar in concept to a document. CX-Server can deal with many CX-Server project files at a time, although often only one CX-Server project is used by the client software at any time.

A number of steps are involved in the setting up of a CX-Server project. At a high-level, these can be regarded as:

♦ Identifying the PLCs which the PC is to communicate with;
♦ Identifying the addresses (points) within the PLC which are to be accessed during communications;
♦ Establish the type of network to be used.

CX-Server Project Concepts

CX-Server projects consist of PLCs, Connected Devices, Networks and Points. The following paragraphs describe the of PLCs, Networks and Points into a CX-Server project and introduce the Project Editor. Specific setup of PLCs and Networks are described in Chapter 3 - Communications.

PLCs

A CX-Server project file contains a list of PLCs which are (potentially) connected to the PC. These PLCs do not really have to be connected unless communications with them are to occur.

Each PLC has the following attributes:

♦ Device Name. A unique name with the CX-Server project file so that the PLC can be easily referenced (for example, ‘PumpRoom1’).
♦ Comment. A free-form long comment which is only used for information by the user that is attached to the unique device name.
♦ Device Type. The PLC device type (for example, CV500).
♦ Connection Type. How to connect to the PLC and the address of the PLC on the chosen network (for example, direct one-to-one connection or via a gateway PLC, one that is already defined in the CX-Server project).
♦ Type Options. A list of options which may be present on the PLC (for example, the amount of user-memory, clock, EM configuration and CPU type).
♦ Connection Options. A list of options which may be available on the chosen network (for example, the speed of communication on SYSMAC WAY, Toolbus, Modem configuration, or Network or Node configuration details).

A full description of the communications possibilities for C-series PLCs, CV-series PLCs and CS/CJ/CP-series PLCs is provided in Chapter 3 - Communications. Host Link Port and Peripheral Port settings are made via the PLC Setup Component, refer to PLC Tools User Manual Chapter 4 - PLC Setup Component. Once the network has been defined and configured, it can be tested to ensure that messages are being transmitted correctly.

The PLCs selected also affect which other setup procedures need to be performed; for example, the CV-series and CS/CJ/CP-series requires setting up the IO Table and using the PLC Setup Component to establish specific PLC characteristics. In addition it is possible to set up to three levels of networks and to communicate with these networks, the initial, direct connection must be to a PLC acting as a gateway. To ensure that messages from the
PC reach the end connection PLC, the gateway PLC must contain the routing information which identifies this PLC. Procedures for configuration of the network is provided in the Chapter 8 CX-Server Network Configuration Tool, Chapter 10 Data Links, Chapter 11 Routing Tables in the PLC Tools User Manual.

Connection to the PLC requires the specification of the type of communications interface to be used to connect to the PLC. CX-Server supports two methods of communication: serial communications and network communications. Serial and network communications can be made using the Connection Type dialog although these are dependent upon the type of PLC being communicated with.

Points
The CX-Server project file also contains a list of addresses which may be accessed in the defined PLCs, each address being contained inside a point. Each point has the following attributes:

- **Name.** A unique label within its group so that the point can be easily referenced, similar to folders in Microsoft Windows Explorer (for example, ‘Conveyor Position’).
- **Comment.** A free-form long comment used only for reference by the user.
- **Address.** The location of the information inside the configured PLC:
  - including the PLC (by name, matching the label of the defined PLC),
  - address (for example, ‘D0’),
  - the number of elements (for example, ten elements for ten channels) and type (for example, bit, channel, floating point).

Points are stored within the CX-Server project file in a hierarchical group structure. New groups may be added to the CX-Server project at any level of the hierarchy tree. Groups act as container objects (as folders contain files) for relevant points within a CX-Server project. Similar points may be banded together and stored within these groups.

Editing a CX-Server Project PLC List
The Edit Project dialog allows the PLC or Points information in the currently opened CX-Server project to be modified, deleted or added. A CX-Server Project PLC list can be edited from either the Import/Export tool or the CX-Net tool by selecting the appropriate .cdm file and then selecting Edit from the Project menu. Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties from the File menu.

Alternatively from the Project Editor right click on Devices and select the Properties option or select Properties from the File menu.

Click on the PLCs Setup pushbutton in the edit project dialog to edit the CX-Server project PLC list.

The Device List dialog is subsequently displayed; this is the central point for adding and setting up PLCs and lists all currently defined PLCs in the open CX-Server project file, their type, network details and any comments associated with each device.
This icon denotes a PLC.

This icon denotes a PLC also used as a gateway PLC.

This icon indicates that the device is open for communications. A device list cannot be opened whilst open for communications.

A PLC device cannot be deleted or have its network or device settings altered if it is open for communication (i.e. active). It cannot be modified in any way if the CX-Server project has been opened as read-only. It cannot be deleted or its device type changed if it is acting as a gateway.

Adding a PLC

The Device List dialog also permits addition of new PLCs to the open CX-Server project. Use the following procedure to add a PLC.

1. Click on the **Add** pushbutton in the Device List dialog. An entry is made in the list of Configured Devices.

2. Enter a name in the **PLC Name** field. This has a maximum length of 32 characters and must be unique within the currently open CX-Server project file; it must not contain any of the following characters: : / \ ; , ? * & ! “ but can contain spaces and international characters. The **PLC Name** field is case sensitive, i.e. if a name is entered in upper case which already exists in lower case (and vice versa), a new PLC is created.

3. Select options for the **Device** field and **Network** field for the new PLC. The list of Configured Devices is updated. Clicking outside this new entry results in a confirmation dialog being displayed. If required select the associated **Settings** pushbutton to refine the Device Type Settings and Network Settings. Refer to Chapter 3 - Communications for further information.

4. If the **Close** pushbutton or another PLC name is selected, a dialog appears asking for confirmation of the changes just performed; select the **Yes** pushbutton to remove the dialog and save the new PLC. Select the **Cancel** pushbutton to abort the operation.

**Note:** The default device name selected from the **Add** pushbutton in the Device List dialog is unique within the CX-Server project, for instance ‘NewPLC1’.

Deleting a PLC

The Device List dialog also permits deletion of a PLC from an open CX-Server project. Use the following procedure to remove a PLC.

1. Highlight the required PLC name in the Device List dialog and select the **Delete** button. A dialog is displayed asking for confirmation of the deletion.
2. Select the **Yes** pushbutton to confirm the deletion or the **No** pushbutton to cancel the operation.

⚠️ It is not possible to delete a device that is open for communications, indicated by the Device Open icon, as it cannot be opened.

⚠️ It is not possible to delete a device being used as a gateway device, indicated by the Gateway Device icon.

### Renaming a PLC

The Device List dialog allows the name of a PLC to be altered. Use the following procedure to rename a PLC.

1. Highlight the required PLC name in the Device List dialog and click on the **Rename** pushbutton.

2. Type in the new name, to a maximum length of 32 characters.

If the **Close** pushbutton or another PLC name be selected, a dialog appears asking for confirmation of the changes just performed; select the **Yes** pushbutton to remove the dialog and save the new name. Select the **Cancel** pushbutton to abort the operation.

### Editing CX-Server Project

Points and groups within a CX-Server project can be edited via the CX-Server Project Editor which is accessed from the Import/Export tool or the DDE Manager. The Project Editor allows new points, groups and devices to be added, modified to and/or deleted from the CX-Server project.

A CX-Server Project can be edited by selecting *Edit* from the *Project* option on the menu bar of the Import / Export tool or by opening / editing a project in the DDE Manager. The option is not available to all tools and components and is further unavailable unless a CX-Server project has been opened or created.

Click on the Points **Setup** pushbutton in the edit project dialog to edit the CX-Server project. The information displayed includes the following:

- A ‘devices’ view showing all devices configured in the CX-Server project and each device available memory areas. The complete group hierarchy of the CX-Server project, and details of the points (in their memory areas) within the CX-Server project.

- A ‘points’ view showing details of the points (within their groups).

Comments (name and address comments) relating to a point are displayed when the appropriate element is highlighted.

A point represents an input or output data area within a PLC; it can refer to a single bit of data (representing for example, “Hopper empty”, “Activate Reject Solenoid”), or to a multiple bit word (representing for example, “Process Temperature”).

Associated with each point is a name and address indicating its position within a PLC and a PLCs memory; comments can also be entered against a point’s name and address.

The information held at a point can be read or updated by CX-Server. A third party can also access this point data by establishing a link between that and the PLC.

**Note:** More than one point can have the same address, any comment entered against this address applies to all points at this location. Comments entered against the point name are unique to that point only. Points do not have to have a name, however, if a name is supplied it must be unique.

To access the Project Editor, open the CX-Server Import/Export tool and open or create a project. Then from the Project menu select Edit, this opens the Edit Project dialog. In Edit Project click the Points: Setup button.
The status bar provides instant help.

The Project Editor can be manipulated in a similar manner to Microsoft Windows Explorer. The left pane displays the content of the project in terms of Devices, Networks and Points. The right pane provides detailed information on the selected item, such as Name, Type and Address etc.

- To expand the hierarchy in the left pane, select this icon.
- To collapse the hierarchy in the left pane, select this icon.

To view the content of a particular branch in the hierarchy, double-click on the item in the left pane.

- Select the **Up One Level** button from the toolbar to traverse back through the hierarchy toward the root.
- Select the **Large Icons** button from the toolbar to display the content of the right pane as large icons.
- Select the **Small Icons** button from the toolbar to display the content of the right pane as small icons.
- Select the **List** button from the toolbar to display the content of the right pane as a list.
- Select the **Details** button from the toolbar to display the content of the right pane with associated details.

The Toolbar and status bar can both be turned on or off. Select **Status Bar** from the **View** menu to control the display of the status bar. Select **Toolbar** from the **View** menu to control the display of the Project Editor toolbar.

If points are displayed in the right pane, the view can further be modified by setting certain preferences.

- Showing invalid points;
- Showing open points / PLCs;
- Automatic resizing of list column.

Use the following procedure to set point preferences.

1. Click on the Points icon in the left pane to open the points view of the editor in the right pane.
2. Select **Options** from the **View** menu. The options dialog is displayed.
3. Amend point preferences from the General tab. Select the **OK** pushbutton to complete the operation. Select the **Cancel** pushbutton to abort the operation.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help.

- To save changes and close the Project Editor, select the **Close** button in the title bar.
Adding a Group
Points are saved within groups in a CX-Server project. When a CX-Server project is initially created it contains the root level group only. Groups can be created within a CX-Server project in hierarchical order from the root level. Points are saved within the root group or specified subsidiary groups within the hierarchy, similar to folders and files within the Microsoft Windows Explorer.

The Add Group dialog adds a new group under the currently selected group.

1. Open the Project Editor, click on the branch of the CX-Server project hierarchy to which the group is to be added; for instance the Points root branch and add a group.
2. Select the Add Group button from the toolbar. The New Group ‘n’ will be added to the tree structure in the appropriate position.

Renaming a Group
To rename a group, select the group followed by the Rename button in the toolbar. Alternatively select Rename from the File menu option. or right click on the group and select the Rename option.

The new group name has a maximum length of 32 characters and must be unique within the group that it is being created. It must not contain any of the following characters: /\;:, ? * & ! ".

The group name field is case sensitive. For example, if a name is entered in upper case which already exists in lower case a new group name will be allowed.

Adding a Point
The Add Point dialog allows a new point within the currently open CX-Server project to be created and its name and address to be entered. Use the following procedure to add a point.

1. Open the Project Editor, click on the Points branch in the tree.
2. Select the Add Point button from the toolbar. The Add Point dialog is displayed.
3. Select the Logical Tab and enter the new name in the Name field; this has a maximum length of 32 characters, it must be unique, and must not contain any of the following characters: /\;:,: ? * & ! " but can include an existing path to indicate the group to which it belongs (if it is to be added to a group other than that indicated above the name). A name is optional, but if supplied must be unique.
4. A comment can only be added to a point if a point name has been supplied. Enter text in the Comment field to be associated with the point name. This field is optional and is used simply for reference purposes.
5. Select the Physical Tab and select the PLC to be associated with the point in the PLC field. This field is mandatory but can be set to ‘None’ until a correctly configured PLC is added to the CX-Server project.
6. Enter the data location in the Data Location field identifying the area of memory to which this address applies; this value is dependent upon the type and configuration of the PLC and is mandatory if a PLC has been selected. Memory Area and Start Address must be supplied, for instance, ‘D0’ for a CV-series and CS/CJ/CP-series PLC or ‘DM0’ for a C-series PLC. Refer to Appendix B PLC Memory Areas for a complete list of valid PLC memory areas and ranges.
7. Enter the number of elements indicating the number of address units which start at the specified data location (i.e. the size of an array of addresses, for instance, ten for ten channels) in the Elements field. This field defaults to 1.
8. Select the Internal Data Type in the Internal Data Type field, identifying the format of the data held at the PLC address (e.g. BCD or binary, WORD or double WORD). This allows CX-Server to automatically convert the PLC specific format of the data to a common format which the PC can use.
9. Select the Command Modifier required to access this address in the Command Modifier field. The modifiers available depend upon the data location chosen. An example of a modifier is Forced Set which forces a data location to be held with given data, overriding the PLC program’s usage.
10. Select the **OK** pushbutton to save the point details or the **Cancel** pushbutton to discard the new point.

**Note:** The fields in the *Address* chapter of the dialog are only enabled when a PLC has been selected and the values available in these fields (if any) also depend upon the PLC chosen.

If several points are to be added at a time, the *Leave Box* setting should be checked, this allows the dialog to stay active after the **Add** pushbutton is pressed. The fields remain populated with the previous point’s settings allowing further modification. Select the **Close** pushbutton to remove the dialog.

A point can have a name and/or an address. It does not need to have both.

Points with valid addresses assigned are marked by an icon according to the Internal Data Type set as follows:

<table>
<thead>
<tr>
<th>Internal Data Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>No type defined</td>
<td>![No type defined icon]</td>
</tr>
<tr>
<td>Bit</td>
<td>![Bit icon]</td>
</tr>
<tr>
<td>Signed Character Binary</td>
<td>![Signed Character Binary icon]</td>
</tr>
<tr>
<td>Unsigned Character Binary</td>
<td>![Unsigned Character Binary icon]</td>
</tr>
<tr>
<td>Raw Character Binary</td>
<td>![Raw Character Binary icon]</td>
</tr>
<tr>
<td>Single Word Unsigned Binary</td>
<td>![Single Word Unsigned Binary icon]</td>
</tr>
<tr>
<td>Double Word Unsigned Binary</td>
<td>![Double Word Unsigned Binary icon]</td>
</tr>
<tr>
<td>Quad Word Unsigned BCD</td>
<td>![Quad Word Unsigned BCD icon]</td>
</tr>
<tr>
<td>Single Word Signed Binary</td>
<td>![Single Word Signed Binary icon]</td>
</tr>
<tr>
<td>Double Word Signed Binary</td>
<td>![Double Word Signed Binary icon]</td>
</tr>
<tr>
<td>Quad Word Signed BCD</td>
<td>![Quad Word Signed BCD icon]</td>
</tr>
<tr>
<td>Double Word Float</td>
<td>![Double Word Float icon]</td>
</tr>
<tr>
<td>IEEE Float</td>
<td>![IEEE Float icon]</td>
</tr>
<tr>
<td>Complex</td>
<td>![Complex icon]</td>
</tr>
<tr>
<td>LReal</td>
<td>![LReal icon]</td>
</tr>
</tbody>
</table>

Points with an invalid PLC address assigned to them are indicated by the associated icon.

**Editing a Point**

The Edit Point dialog displays the current configuration for a selected point allowing these details (including the name) to be amended. The Edit Point dialog operates in the same manner as the Add Point dialog described above.

1. Select the point to be edited.
2. Select the **Properties** button from the toolbar. The Edit Point dialog is displayed. This is identical to the Add Point dialog.

A point’s address or PLC cannot be modified if it is currently active, i.e. open for communications, indicated by the Device Open icon in the Project Editor.

**Deleting a Point or Group**

Use the following procedure to delete a point or a group.

1. Highlight the point or group to be deleted.
2. Select the **Delete** button from the toolbar to delete the point or group.

A confirmation dialog is displayed provided this option has been set in the Options dialog.

Any points or groups contained within a group being deleted are also removed, unless any points within the group or children of the group are open for communications, in which case the points and the groups they are contained within are not deleted.

Points which are currently active cannot be deleted.

**Note:** The root group cannot be deleted.

**Moving and Copying Points and Groups**

The Project Editor allows standard Microsoft Windows drag and drop procedures permitting points and groups to be copied or moved within the Points group.
Moving is achieved by clicking on an item and then dragging the mouse to the item’s new position. A confirmation dialog is displayed. Copying is similar except that the Ctrl key must be kept depressed.

Use the following procedure to copy or move information from or in the Project Editor.

1, 2, 3…

1. Select an item in the right pane of the Project Editor, for example a point. More than one item can be selected by pressing Shift and selecting another item to extend the selection, or by pressing Ctrl and selecting another item to add to the selection.

2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar to move the item.

3. Select an area in the Project Editor to copy or move the items to, for instance copying a point into a new group.

4. Select the Paste button from the toolbar to paste the item. A Paste operation can be performed several times without copying again.

Adding a Device

The Project Editor also permits devices to be added into the CX-Server project as an alternative to the Device List (refer to Chapter 2 - Adding a PLC for details). Use the following procedure to add a device.

1, 2, 3…

1. Open the Project Editor, click on the Devices branch in the tree.

2. Select the Add PLC button from the toolbar. The Change PLC dialog is displayed. Refer to Chapter 3 - Communications for details regarding device setup.
CHAPTER 3
Communications

This chapter describes the communications options available to CX-Server and is confined to software aspects and the associated CX-Server interface; more detailed information relating to each hardware product is to be found in its associated OMRON commercial manual.

Supported Communications

Communications between CX-Server and target PLC’s are achieved by a combination of different network connection types. SYSMAC WAY, SYSMAC LINK, SYSMAC NET, Controller Link, Toolbus, Ethernet, Memory Card Writer, PROM Writer, Modem and Device Net. Each network connection has different capabilities. SYSMAC NET is specially suited for medium to large scale systems where connecting PLCs to computers is included. SYSMAC LINK provides the necessary capabilities of an industrial network: SYSMAC WAY operates at a much simpler level, its primary functions are for monitoring and diagnostics. SYSMAC WAY and Toolbus both provide Modem connection facilities.

The combination employed depends upon the requirements of the system. The network connection types used will determine the maximum speed of data transfer rates and frame lengths that can be used. When the PLC network is first set, the default connection should be used to determine the maximum frame length and baud rates.

CX-Server controls communications with target PLCs, formats messages into the correct protocol and then transmits them to the device (normally a PLC but it can be a memory card); messages are also received from the PLC containing data to be transmitted to applications, for example CX-Programmer, CX-Protocol and CX-Net Network Configuration tool. The type of messages transmitted include requests to update point data or to download programs.

When a PLC is being configured, as discussed in Chapter 2 - Introduction to CX-Server Projects, CX-Server automatically provides a list of the possible network types associated with the selected device; PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool describes how to create the actual PLC/network communications links (including the creation and modification of associated Routing and Data Link Tables).

Device Setup

PLC Settings

Each CX-Server project can contain a list of devices. A device can be a PLC which can be configured to map on to a physical connection (either directly or via an existing gateway connection). A correctly configured connection allows connections to the PLC.

Each device added to the CX-Server project must be given a unique name within the CX-Server project file; the device type and network connection should also be given, for example: ‘CV500’, ‘SYSMAC WAY’.

The Change PLC dialog allows a new PLC to be added to the CX-Server project and its device type and network settings to be defined. It is also used to edit existing PLC details. It is accessed from the invoking application or from CX-Server CX-Net tool. It can also be accessed from the Project editor by expanding the device list, selecting the appropriate PLC and then clicking the properties button in the toolbar or selecting Properties from the File menu.

Note: A PLC cannot be created unless a CX-Server project has been opened. Whilst PLCs are added to the CX-Server project via this dialog, the CX-Net Network Configuration Tool must be used to set up routing tables for those PLCs acting as a gateway. Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool for further information.
Use the following procedure to change the PLC settings:

1. Enter a name in the **Device Name** field. A device name must consist of no more than 32 characters and must be unique.

2. Select the device type of the PLC in the **Device Type** field. If the device requirement does not appear in the list then CX-Server does not support it.

3. Further configure the device type (e.g. CPU number) by selecting the **Device Type Settings** pushbutton. Refer to *Chapter 3 - Device Type Settings* for further details.

4. Select the network type of the PLC in the **Network Type** field. This list may include other PLCs in the CX-Server project that can be used as gateway devices, depending upon the device type chosen. A full list of connection types are provided below.

5. Further configure the network settings (e.g. node number) if applicable by selecting the **Network Type Settings** pushbutton. Refer to *Chapter 3 - Network Communications (End Connection)* for further details.

6. Optionally, enter a comment relating to this unique PLC in the **Comment** field.

7. Select the **OK** pushbutton to save the new PLC or the **Cancel** pushbutton to abort the operation.

**Note:** The Device Name must not contain any of the following characters: / \ ; ; ? * & ! . “ but may include spaces and international characters. The Device Name is case sensitive, i.e. if a name is entered in upper case which already exists in lower case, a new PLC is created. The contents of the Network field depend upon the device type settings of the new PLC. The Device Type **Settings** pushbutton is disabled for the following devices: C20, FinsGateway, Memory Card Writer and Programmable Read Only Memory (PROM) Writer, since these devices do not have options. Any PLCs which have been set up and can act as a gateway device appear in the **Device Type** field.

A full list of connection methods is as follows:

- **SYSMAC WAY.**
- **Toolbus.** Toolbus on the CS/CJ/CP-series PLCs allows CX-Server auto-baud rate detection up to 115,200 bps. Toolbus on the CS/CJ/CP-series PLCs supports full n clients and n destinations.
- When the PLC model is set as a CP1H CPU Unit equipped with a USB port, a computer’s USB port can be connected directly to the PLC’s built-in USB port with a standard USB cable.
- With a CP1E CPU Unit, the Toolbus and SYSMAC WAY connections cannot be used for serial communications. Connect via USB.
- **Modem via SYSMAC WAY.** Modem is supported through SYSMAC WAY communications via Windows TAPI configuration.
- **Modem via Toolbus.** Modem is supported through Toolbus communications via Windows TAPI configuration.
- **Ethernet via TCP/IP.** Ethernet is only supported for CS/CJ/CP-series PLCs, CV-series PLCs and C200HE/G/X/E-Z/G-Z/X-Z series PLCs. All Ethernet connections now also support full n clients and n destinations via CX-Server Ethernet driver. CX-Server also utilises FinsGateway Version 3 Ethernet driver if the required PLC connection UDP port is locked open by FinsGateway active running services.
Controller Link for OMRON NSB. Controller Link is supported through FinsGateway Version 3 when installed via CX-Server installation and services are activated. CS-series PLC Optical Controller Link is supported via FinsGateway Version 3 when Controller Link is installed.

SYSMAC LINK for OMRON NSB. SYSMAC LINK is supported through FinsGateway Version 3 when installed via CX-Server installation and services are activated.

SYSMAC NET for OMRON NSB. SYSMAC NET communications are supported on Windows NT only through FinsGateway Version 3 when installed via CX-Server installation and services are activated.

FinsGateway CPU unit connection and Gateway connection combinations.

DeviceNet The unit for Device Net Communications is available for all CS1/CJ1 series PLCs and the CPM2*-S* PLCs.

CSI Board for OMRON CS1 PCI board. PCI Board is supported through FinsGateway version 3.12 when installed via CX-Server installation and services are activated.

USB: USB can be selected when using a CP-series PLC or CJ2 PLC. Toolbus communications using a USB cable are possible with a CP-series PLC. EtherNet/IP communications using a USB cable are possible with a CJ2 PLC.

Toolbus (using the USB port): Uses the same communications settings as for the CS1/CJ1 Toolbus. Toolbus communications can be used with the CJ2 PLCs.

EtherNet/IP: EtherNet/IP communications can be performed using the Ethernet port. EtherNet/IP communications can be used only with CJ1 or CJ2 PLCs.

Device Type Settings

The Device Type Settings dialog allows further configuration of the selected PLC. This is important since the behavior of the PLC depends upon details such as CPU type (e.g. the network options available to a C200HS require CPU31 or CPU33 setting to be specified). Device type settings cannot be adjusted for an open PLC or a gateway PLC.

The General tab of the Device Type Settings dialog allows:

- Selection of CPU Type;
- Allocation of Program Memory or protection from writing;
- Allocation of Expansion Memory or protection from writing;
- Allocation of File Memory or protection from writing;
- Installation of a Timer/Clock.

When settings cannot be selected, the PLC is fitted with the standard settings as shown on the Device Type Settings dialog and cannot be reconfigured. Similarly, if Expansion Memory cannot be selected for CV-Series PLCs, EM memory cannot be configured.
In each instance, availability of CPU Type and memory depends upon the device type selected (and also the amount of expansion memory purchased for the PLC). Changing CPU type automatically changes the amount of memory available on some devices.

For SRM1 PLCs, only CPU Type can be selected.

For CV-series PLCs, CS-series PLCs and IDSC, File Memory allows selection of the amount of EPROM or EEPROM. A Timer/Clock can be installed.

**Defining Connections and Gateway PLCs**

It is possible to communicate with PLCs which are not directly connected to the computer via PLC network configuration and gateway abilities of PLCs. Generally, a directly connected PLC or the network NSB as a gateway is used to route to the required PLC by use of its routing table and networking capability. In order to specify the link information, a network type (e.g. SYSMAC LINK) and PLC addressing information is needed (i.e. target network, node and unit).

Connection can be directly made to any PLC type. Direct connections are established with SYSMAC WAY, Toolbus, Modem, Ethernet through a network card or SYSMAC NET, Controller Link or SYSMAC LINK via an OMRON NSB.

It is also possible to gateway from a direct connection on to another type of network that cannot be connected to directly.

Use the following procedure to define a gateway connection.

1. Open the Change PLC dialog.
2. Select the Gateway PLC (i.e. the direct connection). If necessary configure the CPU type by selecting the associated Settings pushbutton.
3. Select the Network type and click on the associated Settings pushbutton. The above example uses Ethernet as the network.
4. The Network Settings dialog is displayed. Set up the address and Node number. For Ethernet, also enter the IP address.
5. Select the OK pushbutton to proceed from the Network Settings dialog.
6. Select the OK pushbutton to proceed from the Change PLC dialog.

Use the following procedure to define a target connection.

1. Add a PLC Device to the CX-Server project. The Change PLC dialog is reopened. Select the PLC type for the target PLC. If necessary configure the CPU type by selecting the associated Settings pushbutton.
2. Select the PLC to be used as the Gateway PLC from the list in the Network Type field and click on the Settings pushbutton.
3. The Network Settings dialog is displayed. Set up the Source Network and Destination Network and Node number.
4. Select the OK pushbutton to proceed from the Network Settings dialog.
5. Select the OK pushbutton from the Change PLC dialog to complete the operation or the Cancel pushbutton to abort the operation.

**Serial Communications (Direct Connection)**

The computer involved in establishing communications has at least one serial (RS232) port; the first port is normally called COM1. If in doubt check the configuration of your PC. Only a single PLC can be connected to an RS232 port.

For CS/CJ/CP-series PLCs, if Toolbus is being used as the direct connection, multiple destinations are permitted.
To establish a serial connection to several PLCs, Link Adapters are required that convert from RS232 to RS422. Link Adapters would be connected in the serial line between the computer and the PLC or between the remote Modem and the PLC. Multiple connections are permitted from an RS422 port.

If problems are experienced when making a serial connection, check the serial port on the computer is enabled and that a mouse driver is not loaded or connected to the same port.

For PLCs with direct serial connections on the CPU, default communications settings can also be set by changing the DIP switches on the front of the CPU. The default protocol settings are 9,600 baud, 7 data bits, even parity and 2 stop bits. Older PLCs have a default baud rate of 2,400. For PLCs not supporting this feature, settings are configured via the PLC Setup component. Refer to the *PLC Tools User Manual Chapter 4 - PLC Setup Component* for details of the PLC Setup component.

**SYSMAC WAY**

SYSMAC WAY provides a simple means of connecting a computer to a PLC for monitoring and diagnostic purposes. It has a slower transmission path than SYSMAC LINK, SYSMAC NET, Controller Link or Ethernet.

*Note:* SYSMAC WAY is not supported for CJ2 PLCs.

Communications are achieved by either:

- Employing the RS232 serial communications interface for communicating with individual PLCs.

- Employing the RS422 interface for communicating with multiple PLCs.

The following connections are required:

- RS232 connection via a standard serial port on the computer (COM1 etc.)

or

- RS422 connection to a 422 serial board.

These connections can also be made via a Modem. Refer to standard Microsoft Windows documentation for details on Modem configuration and setup.

The *Driver* tab of the Network Settings dialog allows the configuration information to be entered; this information ensures that data is transmitted correctly over the network.

**Network Settings [SYSMAC WAY]**

![Network Settings Dialog](image)

Use the following procedure to apply Network Settings.

1. Click on the associated *Settings* pushbutton in the Change PLC dialog.

2. In the *Network* tab, check the Unit No, usually 0 for connecting to a single PLC or the multi drop number for an RS422 connection.

3. In the *Driver* tab, check the port on the computer for connection to the PLC and enter it in the *Port Name* field.
4. Select the **Baud Rate**, **Parity**, **Data Bits** and **Stop Bits** from the drop-down lists available for the selected port.

5. For the **Modem** tab, refer to Microsoft Windows documentation.

6. Select the **OK** pushbutton to save these settings, or select the **Cancel** pushbutton to abort the operation.

**Note:** For CS/CJ/CP-series PLCs, SYSMAC WAY dip switch five on the front panel must be set to ‘OFF’.

**Toolbus**

Toolbus operates in a similar manner to SYSMAC WAY. The connection is made to a PLC using its peripheral port.

The following connection is required:

- RS232 connection via a standard serial port on the computer (COM1 etc.) using either CIF01 or CIF02 cable.

The **Driver** tab is similar to that belonging to SYSMAC WAY; however, for some PLCs fixed values are entered and these cannot be altered (see table below). The CS/CJ/CP-Series PLC Toolbus configuration ensures successful connection to the PLC every time, independently of the rate specified by the user provided the **Auto Baud Rate Detection** setting has been checked.

<table>
<thead>
<tr>
<th>PLC</th>
<th>Fixed</th>
<th>Data Bits</th>
<th>Parity</th>
<th>Stop Bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>CS/CJ/CP Series</td>
<td>Yes</td>
<td>8</td>
<td>None</td>
<td>1</td>
</tr>
<tr>
<td>CV/CVM Series</td>
<td>Yes</td>
<td>8</td>
<td>Odd</td>
<td>1</td>
</tr>
<tr>
<td>C Series</td>
<td>No</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPM1/CPM1A</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>SRM1/SRM1-V2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPM*/CPM2*-<em>S</em></td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CQM1/CQM1H</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Serial Networks**

When connecting a computer to a serial network of PLCs, each PLC needs to be configured so that it has a different Unit number. The Unit number for C-series PLCs should be configured as follows:

<table>
<thead>
<tr>
<th>CPU-mounted Host Link unit:</th>
<th>DIP switches on back of unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack-mounted Host Link unit:</td>
<td>Rotary switches on front of unit</td>
</tr>
<tr>
<td>Direct CPU RS232 port:</td>
<td>Internal DM settings</td>
</tr>
<tr>
<td>Direct CPU Peripheral port:</td>
<td>Internal DM settings</td>
</tr>
</tbody>
</table>

The Unit number for CV-series PLCs and CS/CJ-series PLCs should be configured as follows:

<table>
<thead>
<tr>
<th>Rack-mounted Host Link unit:</th>
<th>Unit Setup dialog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct CPU RS232 port:</td>
<td>Host Link settings dialog</td>
</tr>
<tr>
<td>Direct CPU Peripheral port:</td>
<td>Fixed as Unit 0</td>
</tr>
<tr>
<td>Remote SYSBUS/2 Peripheral port:</td>
<td>Fixed as Unit 0</td>
</tr>
</tbody>
</table>

**Note:** The unit number rotary switches on the top of CV-series SIO units are the unit number of that Special I/O Unit on that PLC rack and not the Unit number of the PLC on the serial network.

Online connection is possible through a Serial Communications Board or Unit with unit version 1.2 or later mounted to a PLC directly connected via the peripheral bus (Toolbus) or Host Link (or to a PLC on the network) to a PLC connected serially with Host Link FINS.
1. Register the PLC to be connected serially (using Host Link FINS) in the project gateway (e.g., PLC2).

2. In the Change PLC Dialog Box of the target PLC (e.g., PLC1), select the relay PLC (gateway PLC) in the Network Type pull-down menu (e.g., [PLC2] (See note.)) and click the Settings Button to the right of the Network Type pull-down menu.

   Note: The PLC name enclosed in square brackets (e.g., [PLC2]) indicates the gateway PLC.

3. The Network Settings Dialog Box will be displayed. Click the Guide for Serial Gateway Button.

4. The Serial Gateway Guide Dialog Box will be displayed. Select the unit and the port number under the Calculate Address Area.
- Select the Units from the UNIT pull-down menu as follows:
  - CPU: CPU Unit (See note.)
  - SCB: Serial Communications Board
  - SCU (Unit 0 to 15): Serial Communications Unit numbers 0 to 15
  - Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so connection is not possible even if CPU is selected from the CX-Programmer.

- Select the port from the PORT pull-down menu in the as follows:
  - CPU:Peripheral: CPU Unit’s peripheral port (See note.)
  - CPU:COMM: CPU Unit’s built-in RS-232C port (See note.)
  - SCB:Port1_/SCB:Port2_: Serial Communications Board’s port No. 1/2
  - SCU:Port1_/SCU:Port2_: Serial Communications Unit’s port No. 1/2
  - Note: The Host Link FINS Serial Gateway is not currently supported for the CPU Unit, so connection is not possible even if a CPU port is selected from the CX-Programmer.

- The serial port number address is automatically calculated in the Calculated Address field on the right.

  5. Select the *Use SYSWAY with the port* option in the *Hostlink SYSWAY Setting* field, and enter the actual Host Link unit number for the target (communications partner) PLC in the *Host Link Unit Number* field.

- When using the CX-Programmer, enter the actual Host Link unit number. Do not add 1 to the value. The CX-Programmer will automatically add 1 internally.

  6. Click the **Apply** Button.
Connecting Directly to a CJ2 CPU Unit Using a USB Cable

Connecting the CX-Programmer to a CJ2 CPU Unit using a USB Cable makes it possible to perform communications faster than when using the conventional Toolbus connection.

Perform the following procedure to make the communications settings.

1. The Change PLC Dialog Box will appear when you create a new project.

2. Select CJ2H in the Device Type Field.

3. Select USB in the Network Type Field. (USB is the default connection method.)

4. Click the Settings Button next to the Network Type Field. The following Network Settings [USB] Dialog Box and System Configuration Image will be displayed.

Select the Direct Connection Option on the Network Tab Page, and click the OK Button.
5. Click the OK Button in the Change PLC Dialog Box.

Note: If a FINS Network Communications Unit (see note 1) is mounted to the PLC connected via the USB cable, the CX-Programmer cannot connect to the other node PLCs of the network to which the FINS Network Communications Unit is connected. To connect to the other node PLCs of the network to which the FINS Network Communications Unit is connected, use the following method to change the network type. Select the Show All Check Box for the Network Type Field in the Change PLC Dialog Box to display all possible network types that can be selected, including those that are not given above.

Use the following table as a guide to select the network type according to the conditions.

<table>
<thead>
<tr>
<th>Condition: FINS Network Communications Unit (See note 1.) of the target PLC</th>
<th>Network type to select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications Unit not mounted.</td>
<td>The default can be selected. USB</td>
</tr>
<tr>
<td>Communications Unit is mounted.</td>
<td>Display by selecting the Show All Check Box. Toolbus (USB port)</td>
</tr>
</tbody>
</table>

Note 1: FINS Network Communications Units include the following: a Controller Link Unit, SYSMAC LINK Unit, Ethernet Unit, DeviceNet Unit, or FL-net Unit. It also includes using the serial gateway for serial communications and routing tables. The CompoNet Unit is not a FINS Network Communications Unit.

**Network Communications (End Connection)**

Each network supports a protocol (or set of rules) determining the manner in which a message is transmitted. Requests sent are formatted into the relevant protocol with each message being validated and prioritised according to the rules associated with that protocol.

Once a connection has been established between a device and CX-Server, a set of routing rules and tables are defined which organise the connection between these two processes. The manner of routing depends upon the protocol (identified with each network type) involved in communicating with the PLC.

The Routing Tables are created via offline table editors but they can also be manipulated online using the CX-Net Network Configuration tool. These tables, although they vary in format, contain the network, memory and node address information required to ensure that information is directed correctly across the relevant network. They also allow the connections to be defined for PLCs which are to act as gateways. *Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool for further information.*

When employing SYSMAC LINK, Controller Link and SYSMAC NET networks, each PLC must be configured on each network to have different Node numbers. If two or more networks are joined together, Routing Tables must be created and each network given a unique Network number in order to establish communications between them.

FinsGateway is also needed to establish Controller Link, SYSMAC LINK and SYSMAC Net on NT; refer to the FinsGateway Manual for further information.

When the Routing Tables have been set up, communications are possible from all the computers to all PLCs. Although each network is given a specific number, the local network can always be addressed as network 0. If a serial connection has been made to a CV-series PLC, network 0 refers to the network that is connected to the lowest numbered Special I/O Unit and the local PLC can be addressed as Node 0.

Note: Remember that the Unit number that is specified in the communications dialog is not related to the Special I/O Unit number as set by the rotary switches on the top of CV-series SIO units.
DeviceNet

The DeviceNet conforms to the DeviceNet open field network specification, which means that devices (Master and Slave) produced by other manufacturers can be connected to the Network. A wide range of field-level applications can thus be supported by combining valve devices, sensors, and other devices.

Two types of communications are supported: 1. Remote I/O master communications that automatically transfer I/O between Slaves and the CPU Unit without any special programming in the CPU Unit and 2. Message communications that read/write messages, control operations, or perform other functions for Master Units, CPU Units to which a Master Unit is mounted.

Differences between DeviceNet Network as FINS Network and other PLC Networks are as follows:

1. Maximum Node number and Maximum number of Nodes are 63.
2. No Datalink functionality.
3. There are specific system setting areas and values for DeviceNet Network. Other application software (DeviceNet Configurator) will support these settings so CX-Net /CX-P does not need to support the system setting.

The following diagram illustrates the connection options available to the C-series PLC.

Possible Network Combinations - C-series PLC

**Note:** Only the following C-series PLCs can be used as a gateway: C200H/HX/E/G/E-Z/G-Z/X-Z, C1000H/HX/E/G/E-Z/G-Z/X-Z, C2000H. The C200HS PLC cannot be used as a gateway connection. For Ethernet, multiple destination access is possible.
The following diagram illustrates the connection options available to the CV-series PLC.

Possible Network Combinations - CV-series PLC

Note: For Ethernet, multiple destination access is possible.
The following diagram illustrates the connection options available to the CS1-series PLC.

**Possible Network Combinations – CS1-series PLC**

**Note:** For Toolbus (Modem) and Ethernet, multiple destination access is possible.
PART 3: CX-Server Runtime
CHAPTER 3 – Communications

OMRON

SYSMAC LINK

SYSMAC LINK is a high speed (2 Mbits/sec) industrial network supporting the connection of multiple C-series, CV-series, CS series and CJ series PLCs and one or more computers (so enabling the interchange of information between these devices).

Communications are achieved by either Co-axial or Fibre Optic cabling and employing a SYSMAC LINK Network Service Board (NSB), and Microsoft Windows device drivers.

Use the following procedure to configure SYSMAC LINK.

1. Ensure the Network Type is SYSMAC LINK.
2. Click on the associated Settings pushbutton in the Change PLC dialog.
3. In the Network tab, define the FINS Destination Address by entering the Network and Node.
4. Set the Response Timeout(s) to adjust for a slow network as necessary.
5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC LINK documentation for further information.
6. In the Driver field, select the appropriate options from the Shared RAM address and Interrupt level fields. Refer to SYSMAC LINK documentation for further information.
7. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the operation.

SYSMAC NET

SYSMAC NET is a high speed (2 Mbits/sec) LAN employed within medium/large scale systems (C-series PLCs and CV-series PLCs only).

Connections between the various PLCs and computers is achieved by fibre optics in a ring or loop configuration allowing the exchange of data between the attached devices. The link is achieved by an NSB and employment of Microsoft Windows device drivers. Refer to the SYSMAC NET Network Support Board manual for details on installation.

Use the following procedure to configure SYSMAC NET.

1. Ensure the Network Type is SYSMAC NET.
2. Click on the associated Settings pushbutton in the Change PLC dialog.
3. In the Network tab, define the FINS Destination Address by entering the Network and Node.
4. Set the Response Timeout(s) to adjust for a slow network as necessary.
5. Enter the Frame Length in the Frame Length field. Refer to SYSMAC NET documentation for further information.
6. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the operation.

Controller Link

The Controller Link is an Factory Automation network that can send and receive large data packets flexibly and easily among the PLCs and IBM PC/AT or compatible computers.

The Controller Link supports data links that enable data sharing and a message service that enables sending and receiving data when required. Data link areas can be freely set to create a flexible data link system and effectively use data areas using the CX-Net Network Configuration tool. Refer to the PLC Tools User Manual Chapter 8 - CX-Net Network Configuration Tool for further details.

The network is connected using shielded twisted-pair cable and high-volume data transmissions at high speed enable construction of a wide range of networks, from low level systems to high. The link between attached devices and the network is achieved by an OMRON Controller Link NSB (PCI and ISA) and FinsGateway Version 3. Refer to the Controller Link operation manual for further details on installation.

CS/CJ/CP-Series PLCs support the wired Controller Link and the new optical Controller Link network.

Use the following procedure to configure Controller Link.

1. Ensure the Network Type is Controller Link.
2. Click on the associated Settings pushbutton in the Change PLC dialog.
3. In the Network tab, define the FINS Destination Address by entering the Network and Node.
4. Set the Response Timeout(s) to adjust for a slow network as necessary.
5. Enter the Frame Length in the Frame Length field. Refer to Controller Link documentation for further information.
6. In the Driver tab, set the appropriate setting for the Shared RAM Address, Interrupt Level and Baud Rate fields. Refer to Controller Link documentation for further information.
7. Select an appropriate Node and Unit for the Network address.
8. Select the OK pushbutton to save the settings or select the Cancel pushbutton to abort the operation.

Ethernet

Ethernet is a commonly used network capable of achieving a high rate of data transmission. An NIC board must be installed inside the computer and TCP/IP protocols must be added and configured. Use the following procedure to configure Ethernet.

1. Ensure the Network Type is Ethernet.
2. Click on the associated Settings pushbutton in the Change PLC dialog.
3. In the Network tab define the FINS Source Address: Network field by entering the Network Address.
4. Check the Network and Node addresses for the PLC and enter them in the FINS Destination Address: Network field and Node field respectively.
5. Set the Response Timeout(s) to adjust for a slow network.
6. Enter the Frame Length in the Frame Length field.
7. In the Driver tab, check the Workstation Address and enter it in the Workstation: Node Number field. Alternatively, select the Auto Detect setting to automatically determine the workstation address.
8. Check the PLC IP address and enter it in the PLC: IP Address field.
9. Check the FINS UDP Port Number and enter it in the PLC: Port Number field.
10. Select the OK pushbutton to accept the settings. Select the Cancel pushbutton to abort the operation.

Note: If using a subnet mask which is not 255.255.255.0 you will need to add the IP Address of the PC wishing to connect, into the Ethernet unit. Do this using the I/O table.

Connecting Using EtherNet/IP

The CJ2 CPU Units support EtherNet/IP to enable high-speed and high-capacity data links between PLCs through Ethernet cables. This section describes the two methods that can be used to connect a PLC on a EtherNet/IP network.

♦ Directly connect to the gateway PLC using a USB cable, and connect to the PLC on the network through the gateway PLC.

♦ Connect to the EtherNet/IP network using an Ethernet cable, and connect to the PLC through the network.
PART 3: CX-Server Runtime

CHAPTER 3 – Communications

OMRON

Note: When running the CX-Programmer on Windows XP (SP2 or higher) or Windows Vista and connecting online to a PLC via EtherNet/IP for the first time, the settings of the Windows Firewall will need to be changed. Refer to Appendix B EtherNet/IP Connections from Windows XP (SP2 or Higher) or Windows Vista in Part 1: CX-Programmer for details on making the changes.

Setting Procedure

Perform one of the following procedures to make the communications settings.

♦ Directly Connecting to the Gateway PLC Using an USB Cable, and Then Connecting to the PLC on the Network through the Gateway PLC.

1. When you create a new project, select CJ2H in the Device Type Field.
2. Select USB in the Network Type Field. (USB is the default connection method.)
3. Click the Settings Button next to the Network Type Field. The following Network Settings [USB] Dialog Box and System Configuration Image will be displayed.

Select the USB -> Network Connection Option on the Network Tab Page, and click the OK Button.

4. Input the unit number of the EtherNet/IP Unit or the built-in EtherNet/IP port of the CJ2H-CPU6□-EIP that is connected to the gateway PLC side that is connected by USB and the IP address of the PLC that is on the network and is to be connected to and then click the OK Button.
5. Click the **OK** Button in the Change PLC Dialog Box.

- Connecting to the EtherNet/IP Network Using an Ethernet Cable, and Then Connecting to a PLC on the Network

1. When you create a new project, select CJ2H in the Device Type Field.
2. Select EtherNet/IP in the Network Type Field.
3. Click the Settings Button next to the Network Type Field. The following Network Settings [EtherNet/IP] Dialog Box and System Configuration Image will be displayed.

4. Input the IP address of the PLC on the network to be connected, and then click the **OK** Button.
5. Click the **OK** Button in the Change PLC Dialog Box.

**PROM Writer**

PROM Writer is a device allowing Programmable Read Only Memory (PROM) to be written to. The following connection is required:

- RS232 connection via a standard serial port on the computer (COM1 etc.).

The **Driver** tab of the Network Settings dialog is similar to that belonging to SYSMAC WAY, however, the transmission conditions should be set to:

- Baud Rate = 9600
- Data Bits = 8
- Parity = none
- Stop Bits = 1
- or those of the particular PROM writer unit being used.
Connecting via an NS-series PT

Overview
An online connection from the CX-Programmer through an NS-series PT to a PLC connected to the PT is possible.

System Configuration
The CX-Programmer can be connected through an NS-series PT to a PLC across two network layers.

1. Connection between computer and PT

<table>
<thead>
<tr>
<th>Connection method</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>Yes</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Controller Link</td>
<td>Yes</td>
</tr>
<tr>
<td>Serial</td>
<td>No</td>
</tr>
<tr>
<td>Modem</td>
<td>No</td>
</tr>
</tbody>
</table>

2. Connection between PT and PLC

<table>
<thead>
<tr>
<th>Connection method</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>Yes</td>
</tr>
<tr>
<td>Controller Link</td>
<td>Yes</td>
</tr>
<tr>
<td>Serial 1:N NT Link</td>
<td>No</td>
</tr>
<tr>
<td>1:1 NT Link</td>
<td>No</td>
</tr>
<tr>
<td>Host Link</td>
<td>No</td>
</tr>
<tr>
<td>Memory Link</td>
<td>No</td>
</tr>
</tbody>
</table>

Note 1: When connecting an NSJ Controller to a computer or PLC, always use the serial port or Ethernet port on the Display Section. The above connection method is not possible if the NSJ Controller is connected to an Expansion Unit or serial port on the Controller Section.

Note 2: If you connect the PT to PLC 1 using a serial connection, you will not be able to connect online to PLC 2 or PLC 3 across the network layers.

Note: The CX-Integrator cannot be used if the computer is connected to the PLC through a PT.

Note: Screen display refresh speed and touch panel response may be slower when the CX-Programmer is connected through a PT.
### Applicable PLCs

<table>
<thead>
<tr>
<th>Series</th>
<th>Model</th>
<th>Communications ports that can be connected to the PT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP Series (See note 5.)</td>
<td>CP1L-□□□□□□□□□-□□□□ (See note 1.)</td>
<td>RS-232C board CP1W-CIF01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS-422A/485 board CP1W-CIF11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet board CP1W-CIF12</td>
</tr>
<tr>
<td></td>
<td>CP1H-□□□□□□□□□-□□□□</td>
<td>RS-232C board CP1W-CIF01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS-422A/485 board CP1W-CIF11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet board CP1W-CIF12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit (See note 2.) CJ1W-ETN11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit (See note 2.) CJ1W-ETN21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Controller Link Unit (See note 2.) CJ1W-CLK21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit (See note 2.) CJ1W-SCU21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit (See note 2.) CJ1W-SCU41-V1</td>
</tr>
<tr>
<td>CP1E-□□□□□□□□□ (See note 5.)</td>
<td>Built-in RS-232C port on CPU Unit ---</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS-232C board CP1W-CIF01</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS-422A/485 board CP1W-CIF11</td>
</tr>
<tr>
<td></td>
<td>CJ Series</td>
<td>Built-in RS-232C port on CPU Unit ---</td>
</tr>
<tr>
<td></td>
<td>CJC2H-CPU□□□□□□□□□</td>
<td>CJC1H-CPU□□□□□□□□□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJC1G-CPU□□□□□□□□□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJC1M-CPU□□□□□□□□□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CJC1G-CPU□□□□□□□□□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Built-in RS-232C port on CPU Unit ---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit (See note 4.) CJ1W-ETN11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit (See note 4.) CJ1W-ETN21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit (See note 4.) CJ1W-EIP21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Controller Link Unit CJ1W-CLK23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Controller Link Unit CJ1W-CLK21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit CJ1W-SCU21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit CJ1W-SCU41-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit CJ1W-SCU31-V1</td>
</tr>
<tr>
<td>CS Series</td>
<td>CS1H-CPU□□□□□□□□□</td>
<td>Built-in RS-232C port on CPU Unit ---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Board CS1W-SCB21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Board CS1W-SCB41</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit CS1W-ETN21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ethernet Unit CS1W-EIP21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Controller Link Unit CS1W-CLK23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Controller Link Unit CS1W-CLK21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit CS1W-SCU21-V1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Serial Communications Unit CS1W-SCU31-V1</td>
</tr>
</tbody>
</table>

**Note 1:** Connection via an NS-series PT is not possible to the CP1L-L10D□□□□ because an Option Board cannot be mounted.

**Note 2:** A CP1W-EXT01 CJ Unit Adapter is required to use a CJ-series CPU Bus Unit.
PART 3: CX-Server Runtime
CHAPTER 3 – Communications

Note 3: If the CP1W-CIF41 is used, the PLC containing it cannot be used as a gateway PLC to cross network layers.

Note 4: Use FINS/UDP for communications with the NS-series PT when using an EtherNet/IP Unit or built-in EtherNet/IP port on the CPU Unit.

Note 5: An Option Board can be mounted only to a CPU Unit with 30 or 40 Points. The CP1E-E-D-A cannot be connected via an NS-series PT because it has no built-in RS-232C port and an Option Board cannot be mounted.

Setting Procedures

Specifying the PLC to Connect to via the PT
The procedures for connecting the CX-Programmer to a PLC via an NS-series PT are given below. Be sure that normal communications are possible between the PT and PLC before performing any of these procedures.

Downloading Ladder Programs or Other Data to a PLC with an Ethernet Connection between the Computer and PT and a 1:N NT Link Serial Connection between the PT and PLC

1. Start the CX-Programmer.
2. Set the network type in the Change PLC Dialog Box to Ethernet and click the Set Button.
3. Input the IP address of the PT to connect to on the Driver Tab Page of the Network Settings Dialog Box.
4. Click the Network Tab and set the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINS Source Address</td>
<td>Input the local network address of the PT.</td>
</tr>
<tr>
<td>FINS Destination Address</td>
<td>Input 111 if the PLC is connected to serial port A on the PT. Input 112 if the PLC is connected to serial port B on the PT.</td>
</tr>
<tr>
<td>Node</td>
<td>Input 1 (fixed). (See note.)</td>
</tr>
</tbody>
</table>

Note: Data cannot be transferred normally if any value other than 1 is set.
5. After completing the settings, connect online and transfer the ladder programs or other data.

Downloading Ladder Programs or Other Data to a PLC with an Ethernet Connection between the Computer and PT and a Controller Link Connection between the PT and PLC

1. Start the CX-Programmer.
2. Set the network type in the Change PLC Dialog Box to Ethernet and click the Set Button.
3. Input the IP address of the PT to connect to on the Driver Tab Page of the Network Settings Dialog Box.
4. Click the **Network** Tab and set the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINS Source Address</td>
<td>Input the network number of the network connecting the computer and PT.</td>
</tr>
<tr>
<td>FINS Destination Address</td>
<td>Input the network number of the network connecting the PT and PLC.</td>
</tr>
<tr>
<td>Node</td>
<td>Input the node number of the Controller Link Unit connected to the PLC.</td>
</tr>
</tbody>
</table>

5. After completing the settings, connect online and transfer the ladder programs or other data.

### Downloading Ladder Programs or Other Data to a PLC with a USB Connection between the Computer and PT and a 1:N NT Link Serial Connection between the PT and PLC

**CX-Programmer** → **NS-series PT** → **PLC**

1. Start the CX-Programmer.
2. Set the network type in the Change PLC Dialog Box to NS-Thru (USB) port and click the Set Button.
3. Click the **Network** Tab in the Network Setting Dialog Box and set the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINS Destination Address</td>
<td>Input 111 if the PLC is connected to serial port A on the PT.</td>
</tr>
<tr>
<td></td>
<td>Input 112 if the PLC is connected to serial port B on the PT.</td>
</tr>
<tr>
<td>Node</td>
<td>Input 1 (fixed). (See note.)</td>
</tr>
</tbody>
</table>

**Note:** Data cannot be transferred normally if any value other than 1 is set.

4. After completing the settings, connect online and transfer the ladder programs or other data.

### Connecting Online Automatically

You can connect the computer and NS-series PT online automatically without making the above settings in the Change PLC Dialog Box.

1. Start the CX-Programmer.
   - Select **Auto Online – Direct Online** from the PLC Menu.
2. Select the **USB Connection** Option from the Direct Online Dialog Box, and then click the **Connect** Button.
3. The Select the connecting target PLC Dialog Box will be displayed. Select the CPU Unit of the PLC to connect to from under Serial port A, and then click the Connect Button.

4. An online connection will be made. Download the ladder programs or other data.

**Connecting through an NV-series PT**

The CX-Programmer can be connected through an NV-series PT to a PLC that is connected to that PT.

**System Configuration**

This function can be used when the NV-series PT is connected to both the computer and the PLC. For details on this connection method, refer to the *NV Series PT Setup Manual* (Cat. No. V103).
Note:  
- This function can be used only with CS/CJ-series or CP-series PLCs. It cannot be used with other PLCs, such as the C-series or CVM1/CV-series PLCs.
- To use this function, you must use CX-One version 3.2 or higher (i.e., CX-Programmer version 8.21 or higher).
- The same port is used for both the CX-Programmer and the NV-Designer. Only one of these applications can be connected online to the PT at the same time.
- Do not use this function during recipe operations.

Connection Procedure

Use the one of the following procedures to specify the PLC to which the CX-Programmer is to be connected through the NV-series PT.

• Computer and the PT Connected with RS-232C Cable
  1, 2, 3...  
  1. Start the CX-Programmer. 
     In the Change Model Dialog Box, set the network type to NV-Thru (Serial Port).
     Note: Set the Host Link unit number of the PLC to 0 in advance. Connection will not be possible if the unit number is set to any other value.
  2. Click the Set Button and set the Host Link unit number to 0.
  3. Connect online.

• Personal Computer and PT Connected with USB Cable
  1, 2, 3...  
  1. Start the CX-Programmer. 
     In the Change Model Dialog Box, set the network type to NV-Thru (USB Port).
  2. Connect online.

• Connecting Automatically
  1, 2, 3...  
  1. Start the CX-Programmer. 
     Select Auto Online – Direct Connection from the PLC Menu
  2. The Direct Connection Dialog Box will be displayed. Select either a serial connection or USB connection, depending on the type of connection between the computer and the PT.
  3. The online connection will be made, and the ladder program or other data will be transferred.
CHAPTER 4
Import/Export Tool

This chapter describes the use of the CX-Server Import/Export tool, which allows FinsServer database files and CVSS and LSS definitions of addresses and PLCs to be imported into CX-Server project files. SYSWIN Text files can also be imported.

A CX-Server project file contains definitions of addresses and PLCs which may be accessed. The concept of address and PLC definitions is not unique to CX-Server – the OMRON products CVSS and LSS have similar concepts.

The Import/Export tool allows these definitions to be used by importing them into a CX-Server project file.

Once these definitions of the PLCs and points (addresses) have been imported for use with CX-Server, they may be used by a CX-Server client. For example, the addresses used in a CVSS program could be used by the supervisory program SYSMAC-SCS.

The status bar provides instant help.

The Import/Export tool main window provides all the menu options for importing CVSS, LSS, text and FinsServer files into a CX-Server project file.

The main window shows the status of any import or export event which occurs. It shows any decision which the Import/Export tool makes about importing into a CX-Server project.

The main window is continually updated with information as import and export procedures are performed. This information can be cleared by selecting the Clear Screen button from the toolbar.

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for further information.

To access the Import/Export tool click the Start pushbutton on the Microsoft Windows taskbar and select Programs/Omron/CX-Server/Import/Export from the menu.

To close the Import/Export tool, select the Close button in the title bar.

Supported Import/Export Data

Data which can be imported/exported varies according to the method used to create it.

CVSS creates information about PLCs and addresses. There are many types of file generated by CVSS which have different filename suffixes and have different uses:

- **PCN.** This is a definition of a PLC, containing a name, network number and node number.
- **SBL.** This is a table of names with addresses, similar to a CX-Server point definition.
- **CMT.** This is a table of address comments. The addresses listed usually match those used in the SBL file.
♦ CUS. This contains the definitions of custom prefixes for data-areas and CIO groups which are defined for the program.

LSS generates a single file (with the suffix .DAT) which contains details about many PLC programs. The file’s information is organised into records about a single program. The only information stored about the program which is useful in CX-Server is a table of address comments. Both LSS v3 and LSS v6 files can be imported.

Text files are similar to Microsoft Windows ‘.INI’ files in structure. Headers within this file identify a chapter of addresses and a chapter of PLC information. Addresses can be imported from the text file for a CX-Server project PLC. Address definitions (points) inside a chosen CX-Server project PLC that are contained in a single CX-Server project point group can be exported.

FinsServer files are tagged database files (with the suffix ‘.MDB’) containing node, PLC and network details.

Note: FinsServer tagged database utilities must be installed on the PC to import/export ‘.MDB’ files.

**CX-Server Project Selection**

In order to import information you must first open an existing CX-Server project file. The Project menu contains options for selection and editing of a CX-Server project. The importing operations then affect this CX-Server project. Only one CX-Server project is selected at any one time.

Use the following procedure to create a new CX-Server project.

1, 2, 3...

1. Select the New button in the toolbar. The Create Project dialog is displayed.
2. The CX-Server project must be saved before it can be edited. Enter a file name in the File name field. An existing CX-Server project can be overwritten by selecting a .CDM file displayed in the Create project dialog.
3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the operation. CX-Server files have a .CDM extension.

Use the following procedure to open an existing CX-Server project.

1, 2, 3...

1. Select the Open button from the toolbar to open a CX-Server project file.
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by the Open pushbutton. PLC Memory files have a .CDM extension.
3. Select the Edit option from the Project menu to edit a CX-Server project. Refer to Chapter 2 - Introduction to CX-Server Projects for further details.
4. Select Close from the Project menu to close the currently open CX-Server project.

The content of the Import/Export tool can be printed. Use the following procedure to print details.

1, 2, 3...

1. Select the Print button from the toolbar. A standard Print dialog is displayed.
2. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory details or the Cancel pushbutton to abort the operation.

**Import**

The following paragraphs describe the methods available for importing data into a CX-Server project.

**Importing from CVSS**

Use the following procedure to import from CVSS.

1, 2, 3...

1. Select the Import CVSS button from the toolbar. A standard File Open dialog is shown; select a CVSS file to import and select the Open pushbutton or select the Cancel pushbutton to abort the operation. Specific CVSS file types can be selected from the Files of Type field: either CVSS PLCs, CVSS Memory, CVSS IO Names or CVSS IO Comments. Once the Open pushbutton has been selected, the CVSS Import Options dialog is displayed.
2. To import points, (i.e. any addresses and address comments contained in the selected files) select a destination PLC from the Destination PLC field for the new addresses to use. The device type and CPU of the currently selected PLC is shown below the Destination PLC field. Alternatively, select a PLC from the Default Type field. Once imported, a message is displayed indicating that conversion is complete.

**Note:** The Imported Points option or the Imported PLCs option is only available if the relevant type of object is found in the files chosen.

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - Introduction to CX-Server Projects.

### Importing from LSS

Use the following procedure to import from LSS.

1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: select a LSS file to import and select the Open pushbutton or select the Cancel pushbutton to abort the operation. The LSS Import Options dialog is displayed, listing the programs detailed in the file.

2. Select a program from the Imported Program field.

3. Select the destination PLC from the Destination PLC field to which any addresses and comments found in the chosen program are to be added. The type of PLC that has been selected (device and CPU number) is shown below the drop-down list box.

4. Once imported, a message is displayed indicating that conversion is complete.

PLC details can be edited via the Edit pushbutton. The procedure for doing this is described in Chapter 2 - Introduction to CX-Server Projects.

### Importing from Text Files

Use the following procedure to import from Text.

1. Select the Import LSS button from the toolbar. A standard File Open dialog is shown: select a text file to import and click on OK or select the Cancel pushbutton to abort the operation. The Import Text File dialog is displayed.

2. Select a PLC for which the address definitions in the file can be linked. The PLC type that is given in the file is shown.

3. Select a matching device type from the list of PLCs which are contained in the current CX-Server project. This ensures that any imported addresses are valid on the chosen PLC. Once a file has been selected, the Import Text File dialog is displayed. Once imported, a message is displayed indicating that conversion is complete.

PLC details can be edited via the Edit pushbutton. A PLC can be added if none are suitable for the import operation. Refer to Chapter 2 - Introduction to CX-Server Projects for further information.

### Importing from FinsServer

Use the following procedure to import from FinsServer.

1. Select the Import from TagDB button from the toolbar. Provided FinsServer tagged database utilities has been correctly installed, the FinsServer Import Option dialog is displayed.

2. Select the TagDB PLC name in the Node in TagDB field. Details of tags, device type and network nodes are displayed below the list box.

   • The plus icon indicates that tagged data is assigned to the PLC listed in the Node in TagDB field.

   • The minus icon indicates that there is no tagged data assigned to the PLC listed in the Node in TagDB field. It is not possible to import a node which has no tag data.

1. If required, enter a CX-Server project group name in the Group Name field ensuring that the name does not exceed 64 characters. By default, the field is set to ‘FinsServer’.

2. Enter a PLC comment to be written to each imported tag data in the Comment field. By default, the field is set to ‘Imported by FinsServer’.

Revision 2.0
3. Set the *Import to same name PLC* field to ON to use the PLC in the current CX-Server project. Deselect the *Import to same name PLC* field to select a specific PLC from the *PLC in Project* field. If necessary, PLC details can be edited via the *Edit Project* pushbutton. Refer to Chapter 2 - *Introduction to CX-Server Projects* for further information.

4. Select the Import Tag pushbutton, an ‘Imported’ message is displayed once the operation has concluded.

5. Select the *Close* pushbutton. The success or failure of the import operation is displayed in the Import/Export tool status dialog. Select the *OK* pushbutton to proceed.

**Note:** The *Import Tag* pushbutton is disabled if the destination and source PLC types are different. If there are other differences (apart from PLC type), the import can proceed but no Export Log is generated.

The maximum size of a TagDB is as follows:
- Network: 20;
- Node: 100;
- Tag: 200 per Node.

The maximum size of a CX-Server project is as follows:
- PLC: 100;
- Points: 200 per PLC.

**Export**

PLC data can be exported to either text or FinsServer files, for example symbol definitions can be exported as a FinsServer (’.MDB’) file which can be read by Microsoft Excel (text files can also be imported into Microsoft Excel).

**Exporting Data to Text Files**

Use the following procedure to export all of the points from a particular point group, which are linked to a particular PLC (i.e. the point addresses refer to the PLC) to text file.

1. Select the *Export Text* button from the toolbar. The Export Text File dialog is displayed.

2. Select a PLC from the *Source PLC* field.

3. It is possible to extract only partial data by inserting a path for a particular point by entering a pathname in *Source Point Group* field.

4. Select the *OK* pushbutton to accept the settings. Select the *Cancel* pushbutton to abort the operation. Select the *Edit Project* button to edit the CX-Server project's PLC. Point definitions can also be added to the CX-Server project if desired, before export from this function. Refer to Chapter 2 - *Introduction to CX-Server Projects* for further information. Once the OK pushbutton has been selected, the Export Data File dialog is displayed. This is a standard Microsoft Windows File Open dialog.

5. Insert a filename to export in the *File name* field and click on *OK* or select the *Cancel* pushbutton to abort the operation.

6. A message is displayed in the Import/Export tool that the export is beginning. Another message is shown indicating the success of the export. The device details of the chosen PLC are copied to the selected file if the export is successful.

**Exporting Data to FinsServer Files**

Use the following procedure to export data to FinsServer files.

1. Select the *Export to TagDB* button from the toolbar. The FinsServer Export Option dialog is displayed.
2. Select the PLC from the *PLC in Project* field. Details of tags, device type and network nodes are displayed below the list box.

- The plus icon indicates that tagged data is assigned to the PLC listed in the *Node in TagDB* field.
- The minus icon indicates that there is no tagged data assigned to the PLC listed in the *Node in TagDB* field.

3. Set the *Export to same name PLC* field to use the PLC in the current CX-Server project. Deselect the *Export to same name PLC* field to select a specific PLC from the *PLC in Project* field. If necessary, tag details can be edited via the *Edit TagDB* pushbutton. Details of device type and network nodes are displayed below the drop-down list.

4. Select the *Export Point* pushbutton. The *Export Point* pushbutton is disabled if the destination and source PLC types are different. If there are other differences (apart from PLC type) the export can proceed but no Export Log is generated.

5. Select the *Close* pushbutton. The success or failure of the import operation is displayed in the Import/Export tool status dialog. Select the *OK* pushbutton to proceed.
CHAPTER 5
DDE Manager Tool

This chapter introduces the CX-Server DDE Manager tool and describes its use in providing the interface to other Microsoft Windows-based applications.

The DDE Manager tool permits CX-Server to communicate with other Microsoft Windows programs via the Microsoft Windows Dynamic Data Exchange Management Library (DDEML) facility. The links established by the DDE Manager tool allows a Microsoft Windows application, such as Microsoft Excel or Lotus 123, to transmit instructions to CX-Server in order to update points or to obtain information about a PLC address. This functionality is achieved without the necessity of additional programming (although macro programming may be required in order to update information in a PLC address, depending on the used).

The creation of such a link establishes a client/server relationship between the application and the CX-Server project, where the application is (usually) the client and CX-Server is the server.

The dialogs available via the DDE Manager tool are the same as those illustrated in Chapter 2 - Introduction to CX-Server Projects; this chapter should be referred to for further information.

The Restore option and Maximise option from the DDE Manager menu are not used.

The DDE Manager tool is accessed from the Start pushbutton on the Microsoft Windows taskbar and appears as only a pushbutton in the taskbar.

To close the DDE Manager tool, select the DDE Manager tool in the taskbar with the right-mouse button and click on Close.

Establishing DDE Links

For an application to obtain information from a PLC, a CX-Server project must first be set up via the DDE Manager tool. The project file should contain details of the PLC and the points which are to be referenced (an existing CX-Server project can also be used); the application references the CX-Server project via the point names within the project.

When this information has been configured, the application which is requesting the point data must be opened in order to link it with CX-Server. The link can either be manually entered in the application or the reference can be copied from the CX-Server project. The manner in which such links are established within a Microsoft Windows application (supported by the DDE facility) varies according to the application used and so the appropriate reference manual must be consulted.

Defining a Link

The information contained within the link reference required by the DDE Manager tool must include service, topic and item identifiers.

Service

The service name indicating where the data is held is identified by the application specifier. Within CX-Server this is always 'CDMDDE'.
**Topic**

The CX-Server project name and the path by which it is accessed in CX-Server is identified by the topic specifier. The CX-Server project name is identified by the `.cdm` extension; for example, “C:\CX-Server\factory.cdm” identifies the CX-Server project ‘factory’ in the “C:\CX-Server” directory.

**Item**

The point to be referenced by the CX-Server project is identified by the item specifier, (this must also include the group path); for example “pump1”.

The complete reference for this point (defined by ‘factory.cdm’) would include the following information:

- **Service** = “CDMDDE”
- **Topic** = “C:\CX-Server\factory.cdm”
- **Item** = “pump1”

Its interpretation into a link reference and the format this takes depends upon the application requesting the information (in which case it is necessary to refer to the appropriate application user manual); for example in Microsoft Excel the link would be entered in a cell as:

```
"=CDMDDE!'C:\CX-Server\factory.cdm'!'pump1'"
```

**Note:** The address information for a point is held in the CX-Server project file indicated by the topic identifier.

**Copying a Point**

Although it is possible to enter details of a link in a client manually, it may be quicker to use the DDE Manager tool facility to format the link details automatically.

The Project Editor (DDE Manager) allows a point to be linked to an application so that the contents of the point can be displayed within that application; it is obtained via the *Copy Selection* option on the *DDE Manager* menu.
Use the following procedure to copy a point:

1. Into another application, i.e. Microsoft Excel.
   (a) Open the DDE Manager and navigate to the appropriate location.
   (b) Select the point from the list displayed. If necessary select the required group from the Group hierarchy.
   (c) Select the Edit/Copy option or click the copy button to copy the selected point to the Microsoft Windows Clipboard.
   (d) Open the required application and position the cursor at the point in the application where this information is to be pasted; for example a Microsoft Excel cell.
   (e) Select the Paste option in the application to insert the copy. The exact nature of the Paste option varies according to the application and may takes the form of a Paste Special option.

2. Into another Device or Group:
   (a) Open the DDE Manager and navigate to the appropriate location.
   (b) Select the point from the Tree view. If necessary select the required group from the Group hierarchy.
   (c) Select the Edit/Copy option or click the Copy Selection button in the toolbar.
   (d) Navigate to the point where the information is to be pasted and select Edit/Paste or click the Paste Selection button.
   
   Note that attempting to paste a copied point into the same location will warn you that a point of the same description already exists.

Details about a point can be displayed by right clicking on the point and selecting the Properties option from the menu.

Automatic versus Manual Updates

The links created between an application and the CX-Server project can be defined as ‘active’, in which case the entry in the application file referencing that point is updated automatically with point data, or the link can be ‘manual’, i.e. the user controls when and if point data in an application is updated.

Automatic Updates

The application requesting data relating to a specific point is updated by the DDE Manager tool whenever the point data changes; this occurs at defined time intervals when the DDE Manager tool examines the PLC address associated with the point to see whether the information it contains has changed or not. The update rate can be specified when the CX-Server project is created, alternatively the DDE Manager tool uses a default update rate if one has not been set.

Update rates can be included when defining the item specifier chapter of the DDE link; for example, a time interval of 5 seconds for the item specified by “pump1” is expressed as “pump1,5”. The full DDE link becomes: “=CDMDDE1‘C:/CX-Server/factory.cdm!’”pump1,5””
An update rate indicated in this manner overrides the default rate.

**Manual Updates**

If a manual link has been specified between an application and the CX-Server project, the information contained within the application is not updated until the appropriate action is taken by the user.

Within Microsoft Excel, this would be achieved by highlighting the cell containing the link and selecting *Calculate Now* from the *Options* menu to update the displayed contents of the cell.

### Defining Update Intervals

The Update Interval dialog allows a default update rate (in seconds) to be assigned to new data requests. Use the following procedure to define an update interval:

1. Select the *Update Interval* option from the *DDE Manager* menu.
2. Enter the required update rate (in seconds) in the *Interval* field; this has a maximum value of 65535.
3. Select the *OK* pushbutton to save the setting and close the dialog.

The new rate applies to those points which are activated after this rate has been set. Currently active points are not affected.

**Note:** The default time interval for the DDE Manager tool (when it is initially installed) is set to 15 seconds.

### Special Data Types

The LREAL data type is now supported by the Points Editor for the CS1H-H and CJ1H-H PLCs. Support for the LREAL type is as the IEEE754 Double precision (\(1.7E +308/-307\)) as defined by Microsoft®.
CHAPTER 6
Performance Monitor Tool

The Performance Monitor tool provides a facility to monitor system performance of active connections and can also display the limits of performance against user instructions.

Particularly, it allows monitoring of communications. For example, a SYSMAC WAY connection configured at 9,600 baud, 7 data bits, even parity and 2 stop bits, transmits 10 bits per byte at 9,600 bits per second; this means that the absolute maximum throughput of the cable is 960 bytes per second. Requesting or transmitting data at this rate results in slow response times. The Performance Monitor tool has been engineered to show this throughput figure for PLC connections.

The Performance Monitor tool can be set so that it is not obscured by other windows by selecting *Always on top* from the Options menu.

To access the Performance Monitor tool select the CX-Server Performance Monitor tool from the **Start** pushbutton on the Microsoft Windows taskbar.

To close the Performance Monitor tool, select the **Close** button in the title bar.

The **Performance** tab displays an automated performance history and performance load for the selected active connection in the **Component** option or for the overall performance. Details of activity are described in terms of the number of open PLCs, active messages and open points in the **Totals** field.

The **Statistics** tab displays the number of bytes being transmitted and received by the selected active connection. The limit to the number of characters that can be processed per second is described by the **Theoretical CPS** field. The number of characters currently active is described by the **Active CPS** field. The **PLC Average Latency (ms)** option shows how long it is taking the PLC to process the information in milliseconds.

Watching the Performance Monitor tool fluctuate between for example, 0% and 135%, indicates that it is actually not possible to retrieve all the data requested in the time required according to the connected baud rate.

If the actual characters per second is greater than the theoretical maximum characters per second then performance decreases. The performance load will fluctuate and the PLC average latency will increase. At this point attention is required to the user instructions that are responsible for slowing performance.

The taskbar setting provides an at-a-glance indication of performance. The more the icon is filled green, the greater the performance load. If the icon begins to fill red, then the actual characters per second is greater than the theoretical maximum characters per second load.
To refresh the Performance Monitor tool details, select the *Refresh Now* option from the *View* menu.

The performance Monitor tool can be hidden from the desktop by minimising the window, and can be hidden from the taskbar in its minimised state by selecting *Hide on Minimise* option from the *Options* menu. Once hidden, the Performance Monitor tool can be restored by clicking the taskbar pushbutton or click the right-mouse button and from the menu select restore.
CHAPTER 7
Driver Management Tool

The Driver Management Tool provides a simple method of installing and removing device drivers which support CX-Server 2.0 and higher. Device Drivers are essential parts of CX-Server version 2, and provide the support for a family of devices, or a single device.

This tool is not compatible with versions of CX-Server earlier than version 2.0.

The tool allows adding and removing of devices, and also providing some basic information about which Drivers are present on a system along with their description.

To access the Driver Management Tool select the ‘Programs->Omron->Driver Management tool’ from the Start pushbutton on the Microsoft Windows taskbar.

Alternatively, access to the Driver Management Tool is also possible from the Windows Control Panel.

To close the Driver Management Tool, select the Close button in the title bar.

A list of available drivers will be shown on the left pane of the main window. The list is generated when the Driver Management Tool is first opened, and obtained by performing a scan of your computer. When drivers are found, they are shown on the left pane, and once selected, the information about the selected driver is shown in the right pane.

If nothing appears in the left pane, then it means that no drivers were found; however, many device types do not require drivers, and thus a device driver absence does not necessarily mean an absence of support. Devices that do not require drivers include all PLCs released before 2003 (except CS/CJ/CP-Series) that CX-Server version 1.7 supported.

Drivers can be installed onto a machine from any form of media, for example a CD. To add a driver, press the ‘Add’ button. A standard open file window will be shown. Select the media from which a driver is to be sourced, from the pull-down menu at the top of the window. Now select a driver (file) which will contain information to support a specific group of PLCs, and press open.

Use the following procedure to add a driver support to your computer.

1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel.
2. Select the Add button on the screen. A standard File Open dialog is shown: Select the driver file to be installed. The driver is usually called ‘Setup.exe’. Refer to your driver provider for exact details of the driver.

3. Click on Open or select the Cancel pushbutton to abort the operation.

4. The Driver Management Tool will now automatically update the computer, making it possible to use a larger range of devices via CX-Server.

In the future, as device families are extended, existing drivers may require updating, however the process for this modification remains the same as for adding anew.

**Note:** It is possible to add drivers through a variety of other means, which do not require the Driver Management Tool to be active.

It is possible to remove drivers if they are no longer required.

Use the following procedure to remove a driver from your computer

1. Open the Driver management Tool from Start->Omron->CX-Server-> or Control panel
2. Select the Driver to be removed in the left hand pane.
3. Select the Remove button on the screen.
4. Follow the driver uninstaller screen prompts for each driver.
APPENDIX A

Network Availability

The following tables indicate the network available to each PLC device group. FinsGateway has no network availability and is not described.

Note: Modem connection is also available by Toolbus or SYSMAC WAY if a Modem device has been configured in Microsoft Windows. Any device supporting Toolbus or SYSMAC WAY also supports Modem connections. Refer to standard Microsoft Windows documentation for details on configuring a Modem device.

Note: Where DeviceNet is indicated as an available network type for a given PLC, direct connection from a PC is not possible (No NSB support). Instead, connect via a Serial Port (COM1 etc.), or another network type.

### C**H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C20H</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C28H</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C40H</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C60H</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C**K Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C20K</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C28K</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C40K</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C60K</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C**P Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C20P</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C28P</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C40P</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C60P</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C1000H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C20 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C20</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### C2000H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU2000</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C200H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU02</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU03</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU21</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU21</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU22</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU23</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU31</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### C200HE Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU11</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU32</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU42</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

### C200HE-Z Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU32</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU42</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

### C200HG Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU33</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU43</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU53</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>
## C200HG-Z Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU33</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU43</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU53</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

## C200HS Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU03</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU13</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

## C200HX Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU34</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU54</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU64</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

## C200HX-Z Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU34</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU54</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>CPU64</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

## C500 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C500</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C250</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C120</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C50</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### CJ2H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Tool bus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Ether Net/IP</th>
<th>Device Net</th>
<th>FinsGate way</th>
<th>USB</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU68</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU67</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU66</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU65</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU64</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU68-EIP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU67-EIP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU66-EIP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU65-EIP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU64-EIP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CJ1G Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Toolbus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU45</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CJ1G-H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Toolbus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU45</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU43</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU42</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CJ1H-H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Toolbus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU66</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU65</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CJ1M Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Toolbus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU12</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU13</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU22</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU23</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CP1H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYMAC WAY</th>
<th>Toolbus</th>
<th>SYMAC NET</th>
<th>SYMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Ether Net/IP</th>
<th>Device Net</th>
<th>FinsGate way</th>
<th>USB</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>XA</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Y</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### CP1L Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Ether Net/IP</th>
<th>Device Net</th>
<th>FinsGate way</th>
<th>USB</th>
</tr>
</thead>
<tbody>
<tr>
<td>L10</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>L</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>M</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CP1E Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Ether Net/IP</th>
<th>Device Net</th>
<th>FinsGate way</th>
<th>USB</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>N</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CPM1 (CPM1A/CPM2*) Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU10</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU20</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU30</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### CPM2*-S* Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CQM1 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU21</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU41</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU42</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU43</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### CQM1H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU21</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU51</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>CPU61</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
### CS1G/CS1G-H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU45</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU44</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU43</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU42</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### CS1H/CS1H-H Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU67</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU66</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU65</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU64</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU63</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### IDSC Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C01</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C02</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### SRM1 – SRM1 V2 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>C01</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C02</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### CV1000 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

### CV2000 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

### CV500 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>
## CVM1 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

## CVM1-V2 Device Group

<table>
<thead>
<tr>
<th>Device Type</th>
<th>SYSMAC WAY</th>
<th>Toolbus</th>
<th>SYSMAC NET</th>
<th>SYSMAC LINK</th>
<th>Controller Link</th>
<th>Ethernet</th>
<th>Device Net</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU01</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU11</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CPU21</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
APPENDIX B
PLC Memory Areas

The following tables provide memory area details for each device group. Some tables indicate special addresses. These can be as follows:

- **CLOCK.** This allows reading/writing of a PLC's real-time clock.
- **BANKNO.** This allows reading/writing of a PLC's extended memory bank number.
- **MODE.** This allows reading/writing of a PLC's run-mode.

### C**H** Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>1999</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>247</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Special addresses CLOCK, MODE.

### C**K** Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>0</td>
<td>47</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>9</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>18 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>18 (bit 8)</td>
<td>19 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### C**P** Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>0</td>
<td>47</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>9</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>18 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>18 (bit 8)</td>
<td>19 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
### C1000H Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>4095</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>236</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>237</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: MODE.

### C20 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>0</td>
<td>47</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>9</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>18 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>18 (bit 8)</td>
<td>19 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### C2000H Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>236</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>237</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: MODE.
### C200H Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>1999</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.

### C200HE Device Group

#### General Memory Areas

Memory Areas for any CPU.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>4095</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>6000</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

#### CPU 32/42 Memory Areas

Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>4096</td>
<td>5999</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.
## C200HE-Z Device Group

### General Memory Areas
Memory Areas for any CPU.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>4095</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>6000</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

### CPU 32/42 Device Group
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>4096</td>
<td>5999</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.

## C200HG Device Group

### Prefix | Start Channel | End Channel | Word Addressing | Bit Addressing | Read Write | Modifiers |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>FC</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE, BANKNO.
### C200HG-Z Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE, BANKNO.

### C200HS Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>Present Value</td>
<td>Status</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.
## C200HX Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE, BANKNO.

## C200HX-Z Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>235</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>300</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>236</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SR (opt)</td>
<td>256</td>
<td>299</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
CPU 65 Memory Areas
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 8</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 85 Memory Areas
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 16</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE, BANKNO.

C500 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>0</td>
<td>127</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>31</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>57</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>31</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>58</td>
<td>60</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>61</td>
<td>63 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

CJ2H Device Group

General Memory Areas
General Memory Areas for all CPUs 64, 65, 66, 67 and 68.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>127</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>A</td>
<td>10000</td>
<td>11535</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>1471</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>
CPU64-EIP and CPU65-EIP Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*4</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: Bits in EM bank 3 can be force-set and force-reset (Enable Forced Set/Forced Clear).

CPU66-EIP Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*10</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: Bits in EM banks 6 to 9 can be force-set and force-reset (Enable Forced Set/Forced Clear).

CPU67-EIP Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: Bits in EM banks 7 to E can be force-set and force-reset (Enable Forced Set/Forced Clear).

CPU68-EIP Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*25</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Note: Bits in EM banks 11 to 18 can be force-set and force-reset (Enable Forced Set/Forced Clear).

CJ1G Device Group

General Memory Areas
General Memory Areas for all CPUs 44 and 45.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
## CPU 44 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

## CPU 45 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE.
(CPU 44/45): BANKNO.

## CJ1G-H Device Group

### General Memory Areas
General Memory Areas for all CPUs 42, 43, 44 and 45.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

## CPU 42 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

## CPU 43 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
### CPU 44 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 45 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE, (CPU 44/45): BANKNO.

### CJ1H-H Device Group

#### General Memory Areas
General Memory Areas for CPUs 65 and 66.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO(opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### CPU 65 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 66 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*7</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
CJ1M Device Group

General Memory Areas

General Memory Areas for all CPUs 12, 13, 22 and 23.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CIO(opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

CPM1 (CPM1A) Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>1023</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DM</td>
<td>6144</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>19</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>19</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>200</td>
<td>231</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>232</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>127</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: MODE.
### CPM2*/CPM2*-S* Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>23</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>2047</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DM</td>
<td>6144</td>
<td>6599</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DM</td>
<td>6600</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>19</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>49</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>200</td>
<td>227</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>228</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>127</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

Special addresses: MODE.

### CQM1 Device Group

#### Memory Areas

Memory Areas for all CPUs.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>1023</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DM</td>
<td>6144</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>243</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>244</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

### CPU 41/42/43/44/45 Memory Areas

Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>1024</td>
<td>6143</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.
CQM1H Device Group

Memory Areas
Memory Areas for all CPUs.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>243</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>244</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td></td>
<td>F C</td>
</tr>
</tbody>
</table>

CPU 11/21 Memory Areas
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>0</td>
<td>3071</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DM</td>
<td>6144</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.

CPU 51 Memory Areas
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.

CPU 61 Memory Areas
Memory Areas in addition to general memory areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM</td>
<td>0</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EM</td>
<td>0</td>
<td>6143 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.
CS1G Device Group

General Memory Areas

General Memory Areas for all CPUs 42, 43, 44 and 45.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

CPU 44 Memory Areas

Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 45 Memory Areas

Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE. (CPU 44/45): BANKNO.
CS1G-H Device Group

General Memory Areas

General Memory Areas for all CPU 42, 42, 44 and 45

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

CPU 42 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 43 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 44 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
### CPU 45 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CS1D-H Device Group

#### General Memory Areas

General Memory Areas for all CPU 65 and 67

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### CPU 65 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 67 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*13</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
CS1D-S Device Group

General Memory Areas
General Memory Areas for all CPU 42, 44, 65 and 67

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

CPU 42 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 44 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 65 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

CPU 67 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*13</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
CS1H Device Group

General Memory Areas
General Memory Areas for all CPUs 63, 64, 65, 66 and 67.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>f c</td>
<td></td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>448</td>
<td>959</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f c</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

CPU 64 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 1</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
<td></td>
</tr>
</tbody>
</table>

CPU 65 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 3</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
<td></td>
</tr>
</tbody>
</table>

CPU 66 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767 * 7</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
<td></td>
</tr>
</tbody>
</table>

CPU 67 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read</th>
<th>Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32765 * 13</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
<td></td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE. (CPU 64/65/66/67): BANKNO.
## CS1H-H Device Group

### General Memory Areas

General Memory Areas for all CPU 63, 64, 65, 66 and 67

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>6143</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>TK</td>
<td>0</td>
<td>31</td>
<td>Status</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>447</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>0</td>
<td>448</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>f</td>
</tr>
<tr>
<td>H</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>fc</td>
</tr>
<tr>
<td>W</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>4095</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>15</td>
<td>Yes (double)</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>0</td>
<td>11</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>100</td>
<td>104</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>CF</td>
<td>113</td>
<td>114</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### CPU 63 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 64 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*1</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 65 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*3</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

### CPU 66 Memory Areas

Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*7</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>
CPU 67 Memory Areas
Memory Areas in addition to General Memory Areas

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0</td>
<td>32767*13</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

IDSC Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>27</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>1023</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>99</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>243</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>63</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>244</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: CLOCK, MODE.

SRM1 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>2047</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>19</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>0</td>
<td>23</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR (opt)</td>
<td>200</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>232</td>
<td>252</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR (opt)</td>
<td>253</td>
<td>255 (bit 7)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>127</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: MODE.
### SRM1 V2 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>127</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>0</td>
<td>2047</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>DM</td>
<td>6144</td>
<td>6655</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>HR</td>
<td>0</td>
<td>19</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>23</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR</td>
<td>200</td>
<td>239</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>LR</td>
<td>0</td>
<td>15</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR</td>
<td>240</td>
<td>253</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>SR</td>
<td>253</td>
<td>254</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SR</td>
<td>254</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>TC</td>
<td>0</td>
<td>127</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: MODE.

### CV1000 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>A</td>
<td>256</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AC</td>
<td>0</td>
<td>2047</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>2555</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>24575</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td>0</td>
<td>1023</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TN</td>
<td>0</td>
<td>1023</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>E</td>
<td>0</td>
<td>32765 * 2/4/8</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>- n</td>
</tr>
</tbody>
</table>

Special addresses: BANKNO, CLOCK, MODE.
### CV2000 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>A</td>
<td>256</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AC</td>
<td>0</td>
<td>2047</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>2555</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>24575</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td>0</td>
<td>1023</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TN</td>
<td>0</td>
<td>1023</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>E</td>
<td>0</td>
<td>32765 * 2/4/8</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>- n</td>
</tr>
</tbody>
</table>

Special addresses: BANKNO, CLOCK, MODE.

### CV500 Device Group

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>A</td>
<td>256</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AC</td>
<td>0</td>
<td>1023</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>2555</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>8191</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>ST</td>
<td>0</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TN</td>
<td>0</td>
<td>511</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>FC</td>
</tr>
</tbody>
</table>

Special addresses: MODE, CLOCK
CVM1 Device Group

General Memory Areas
Memory Areas for any CPU.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>A</td>
<td>256</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>2555</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>G</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

CPU 01 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>8191</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

CPU 11 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>24575</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE.

CVM1-V2 Device Group

General Memory Areas
Memory Areas for any CPU.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>A</td>
<td>256</td>
<td>511</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>F C</td>
</tr>
<tr>
<td>DR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>2555</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>G</td>
<td>0</td>
<td>255</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>IR</td>
<td>0</td>
<td>2</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>TR</td>
<td>0</td>
<td>0 (bit 7)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>
### CPU 01 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>8191</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>511</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

### CPU 11 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>24575</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
</tbody>
</table>

### CPU 21 Memory Areas
Memory Areas in addition to General Memory Areas.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>24575</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td>0</td>
<td>1023</td>
<td>Present Value</td>
<td>Status</td>
<td>Yes</td>
<td>F C</td>
</tr>
<tr>
<td>E</td>
<td>0</td>
<td>32765 * 2^4/8</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>-n</td>
</tr>
</tbody>
</table>

Special addresses: (all CPUs): CLOCK, MODE. (CPU 21): BANKNO.

### FinsGateway CPU Unit

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Start Channel</th>
<th>End Channel</th>
<th>Word Addressing</th>
<th>Bit Addressing</th>
<th>Read Write</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIO (opt)</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>0</td>
<td>32767</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX C
Toolbars and Keyboard Shortcuts

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. The F1 function key is common across all components and tools and provides context help.

Project Editor

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up One Level</td>
<td>Delete</td>
</tr>
<tr>
<td>Add PLC</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Add Group</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Add Point</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Paste</td>
<td>F5</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Rename</td>
<td>Close</td>
</tr>
<tr>
<td>Properties</td>
<td>Cut</td>
</tr>
<tr>
<td>Large Icons</td>
<td>Copy</td>
</tr>
<tr>
<td>Small Icons</td>
<td>Paste</td>
</tr>
<tr>
<td>List</td>
<td>Select All</td>
</tr>
<tr>
<td>Details</td>
<td>Refresh</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F</td>
</tr>
</tbody>
</table>
GLOSSARY OF TERMS

Actual IO Table  
The real hardware configuration of the PLC units and slots on power-up.

Address  
A location in memory where data or programs are stored. It can also identify a location of a node on a network.

Application  
A software program that accomplishes a specific task. Examples of applications are CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.

Baud rate  
The speed of data transmission in terms of the number of bits per second that are being sent.

BCD  
Binary Coded Decimal.

Binary  
A data format supported by CX-Server. A number system format to the base 2, i.e. employing the digits 0 and 1.

Bit  
A digit used in binary notation which can take the value 0 or 1. The value of a bit, or combination of bits, can represent the status of a device or can be used in programming.

Bus  
A communications path along which data can be transmitted or received between the units connected to it.

Command modifier  
An optional part of an address string indicating the modification to be performed on the data at that address (within PLC memory) when it is accessed.

Components  
CX-Server is made up of six components accessible from an invoking application.

Controller Link  
A network that can send and receive large data packets flexibly and easily among the OMRON PLCs.

CPU type  
The type of CPU available to a specific device, the amount of memory available to a PLC varies according to the CPU involved.

CPU  
Central Processing Unit.

CVSS  
A file format supported by the CX-Server Import tool. CVSS has several file types which have different information contained in them.

CX-Net Network Configuration tool  
This CX-Server tool consists of a suite of programs allowing the management of Routing Tables and Data Link Tables in OMRON PLCs.

CX-Server  
An advanced communications management system for OMRON PLCs providing facilities for software to maintain PLC device and address information and to communicate with OMRON PLCs and their supported network types. CX-Server supports CS1-series PLCs.

CX-Server Project  
A definition of an OMRON PLC network configuration. It identifies all devices and networks within a particular configuration including the areas of PLC memory (points) that can be read from or written to.

Data area  
An area of PLC memory allocated to the storage of data (not programs).

Data bits  
Bits representing each character to be transmitted.

Data link  
A software connection establishing common data areas between PLCs on a network allowing data to be between these devices.

Data link table  
A table of the common data memory areas used by the PLCs in a Data Link.

Data location  
An area of memory identified by an address.

DDE  
Dynamic Data Exchange. A channel through which correctly prepared programs can actively exchange data and control other applications within Microsoft Windows. CX-Server, through the use of the DDE Manager tool, allows extensive use of DDE functionality.

See also Item, Server, server application and Topic.

DDE management library  
A dynamic link library within Windows which allows dynamic data exchange to be employed.

DDE Manager tool  
A CX-Server tool for transferring data between PLCs and a client application using DDE, for example Microsoft Excel.

DDEML  
Dynamic Data Exchange Management Library.
Default
A value automatically set by a program in the absence of user input or on initial entry to an application; such values can be overwritten.

Device group
A class of devices which share similar properties, each group can be sub-divided into device types.

Device type
A type of OMRON PLC.

Device
A type of OMRON automation device, either a PLC, Temperature Controller, Memory Card Writer or PROM Writer.

Dialog
A window asking for some form of response from the user, usually in the form of either entering requested information, selecting displayed data, or confirming an operation.

DLL
Dynamic Link Library. A program file that although cannot be run stand-alone as an executable, can be utilised by one or more applications or programs as a common service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone functions.

Double Floating Point
Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E+308/-307) as defined by Microsoft®.

Download
Refer to Transfer to PLC.

Drag
The act of moving an item on the screen by selecting it with the mouse, and keeping the mouse button depressed, moving the mouse until the item has reached the required location. The mouse button is then released.

Driver
The software unit which controls the communications between a computer and PLC, translating any information passed between them into a format that the receiving Device can understand.

Driver Management Tool
A tool to facilitate the addition of new drivers and removal of drivers from your computer.

Dynamic Data Exchange
The method of transferring data (and possibly instructions) between applications via the establishment of reference links between them.

EEPROM
Electrically Erasable Programmable Read Only Memory.

Elements
The number of address units which start at a specified data location.

End Connection
The final communication link between computer and PLC, or in the case of a Network configuration, gateway PLC to PLC.

Ethernet
A 10 MB baseband local area network with each Device attached to the network having equal status and therefore the ability to transmit as, and when, required (provided the line isn’t busy).

Even parity
The number of 1s in a data transmission is even.

Expansion memory
The memory available to a CPU in addition to conventional memory.

File memory
An area of CPU memory allocated to the storage of data.

FINS
Factory Intelligent Network Service.

FinsGateway
An OMRON communication type supported by CX-Server.

Floating Point
A data format supported by CX-Server.

Folder
A structure which organises the files in computer memory or on disk. Also known as a ‘directory’.

Frame length
The waiting time before data is transmitted across the network.

Gateway device
A Device connecting two networks of different architectures together.

Gateway PLC
A PLC which acts as a link to another network.

Group
A sub-directory within a CX-Server project hierarchy which contains points and/or further (subsidiary) groups.

Hard disk
A disk permanently mounted on its drive.

Hierarchy
The structure of a CX-Server project from the root directory down through any sub-directories (groups) to individual points contained within those groups.

Host link unit
The interface between a PLC and a host computer.

Icon
Pictorial representations of computer resources and functions. Many icons are used by CX-Server components and tools as part of the GUI.
IDSC device type
An OMRON PLC device supported by CX-Server.

Import tool
This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS products.

Input
The signal sent to a PLC from an external device.

Instruction
A statement indicating an operation to be performed and identifies any data involved in this operation.

Intel Hex
A PLC device also known as a PROM Writer.

Interface
Hardware or software employed to link the elements within a system, including networks, programs and computers.

Internal data type
The format of the data held at an address in PLC memory; for example, bit or signed character binary.

Invoking application
An application such as CX-Programmer and CX-Protocol that utilises components and tools belonging to CX-Server.

IO Table component
This CX-Server component retrieves configured PLCs rack and address data.

IO
Input /Output.

IP address table
A table containing the IP addresses for all the devices on the Ethernet.

IP address
An address for a device on the Ethernet.

IP
Internet Protocol.

Item
A unique name for a data item within a topic.

LAN
Local Area Network.

Link system
A system that links PLCs together.

Link unit
A unit which connects a device to the network.

Link
A connection between two units established either by software or a hardware device.

Load
Placing a program or data into an area of computer or PLC memory.

LREAL
LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E+308/-307) as defined by Microsoft®.

LSS
A file format supported by the CX-Server Import tool.

Mb
Megabytes – A means of defining computer memory size.

Memory area
Addressable area of storage space in a device.

Memory Card Writer
A device which writes data to a memory card.

Memory card
A data storage medium which can hold both programs and data.

MHz
Megahertz.

Microsoft Excel
A spreadsheet application.

Microsoft Windows Explorer
A file handling application part of the Microsoft Windows suite.

Microsoft Windows
A windowing environment that is noted for its GUI, and for features such as multiple typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and the capability of moving text and graphics from one application to another via a clipboard.

CX-Server runs only under Microsoft Windows. DDE functions communicating with other applications supported by CX-Server use Microsoft Windows as a basis.

Modem
A device with the ability to convert digital data from a computer into analogue form and transmit it over a telecommunications line and also to convert received analogue signals into digital form.

n
A variable number.

Network Service Board
An interface which connects devices (not PLCs) to the network.

Network
1. Part of the PLC configuration, based on the device type. The number of Networks available is dependant on the device type.

2. A number of computers linked together with a central processing point known as a Server which is accessible to all computers. Networks affect CX-Server in that further Network associated options are available if the computer is Network connected.
Node number
Number identifying the device located at a particular node on the network. The number can be between 1 and 126, the maximum number of nodes available on an OMRON network.

Node
A position at which a device can be located on the network, consisting of a link unit mounted to a device or PLC which in turn interfaces with a peripheral device or a computer.

NSB
Network Service Board.

Offline
The status of a device when it is not being controlled by a computer (although it may be physically connected to it).

OLE
Object Linking and Embedding. Used to transfer and share information between Microsoft Windows based applications and accessories.

Online
The status of a device when it is under the direct control of a computer.

Output
The signal sent from a PLC to an external device.

Packet
A unit of information transmitted across the network containing source and destination address information together with the actual data.

Parity
A type of validation check performed on transmitted information; data can be tested for either even, odd, none, mark or space parity. The type of parity check involved is indicated by the status of the parity bit.

Path
The location of a file including the drive, directory name plus any subdirectories and the file name together with its associated extension.

Peripheral
A device which aids system operation rather than being central to its functioning.

Performance Monitor tool
A CX-Server tool for monitoring communications throughput and for displaying CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming overloaded).

Ping test
A standard Ethernet communications test.

PLC Error component
This CX-Server component displays and manages PLC errors.

PLC Memory component
This CX-Server component allows the user to view, edit and monitor either channels (words) or individual bits in areas of the PLC.

PLC Setup component
This CX-Server component permits the configuration of PLC settings.

PLC
Programmable Logic Controller.

Point
A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The contents of a point may be controlled by an object or I/O mechanism such as DDE. The contents of a point may control the action or appearance of an object, or be used for output via an I/O mechanism.

Port
A device connection point allowing data entry and exit.

Program
A set of instructions which are performed by a computer or PLC.

Program memory
An area of PLC memory reserved for the storage of programs.

Program mode
PLC mode of operation during which the device can be programmed.

Programmable Read Only Memory
An area of memory which can be updated with programs and data only once after manufacture; once this area has been written to, it can only be read, not modified.

Project
OMRON configuration file inherited from the invoking application.

Refer also to CX-Server Project.

PROM writer
A device which writes the programs and data into PROM.

PROM
Programmable Read Only Memory.

Protocol
A set of rules governing the transmission of data.

Rack
The apparatus to which a unit is fixed.

RAM
Random Access Memory.

Registered IO Table
The internal PLC table: this is the one used by the PLC when running, regardless of the state of the actual hardware. It can be read and, for CV-series PLCs, written to by the CX-Server software.

Root
The highest level of a directory.

Root group
The highest level group in a CX-Server project.
Rotary switch  Indicates the method of calling a device by generating a series of pulses.
Routing table  A table containing the information necessary to allow communications between different networks including local and gateway network address details.
Routing  The direction of data across a network from its source to its destination.
RS232  Industrial interface standard for serial communications.
RS422  Industrial interface standard for serial communications employing balanced line circuits.
Serial Connection  A direct connection between computer and PLC.
Server  1. Server is used in DDE functions to contain a link to an outside application. Using DDE functions, CX-Server allows the manipulation of an outside application as specified as the Server.
   Refer also to Server application.
   2. A Server is the central processing point of a Network which is accessible to all computers. Networks affect CX-Server in that further associated options are available if the computer Network is connected.
Slots  Free areas within a rack to which units can be fixed.
Stop bits  Bits indicating the end of transmission of each set of data bits; normally one or two bits, they indicate the delay time between sending successive characters down the line.
Symbol  An address that has been given a name to make the address information more flexible. Symbols are inherited by CX-Server by the invoking application.
SYSCMAC LINK  OMRON high speed industrial network (either co-axial or fibre optic).
SYSCMAC NET  OMRON high speed optical LAN which can be of type C SYSCMAC NET or CV SYSCMAC NET.
SYSCMAC WAY  OMRON network.
System area  An area of memory used for controlling and managing a unit.
System configuration  An arrangement of units, for example network, computers and PLCs.
Tagged database  A file format supported by the CX-Server Import tool. The Tagged database is also an export format of the CX-Server Import tool.
Target PLC  The PLC to which information or instructions are directed.
Taskbar  An integral part of Microsoft Windows which allows Microsoft Windows based applications to be started. CX-Server tools are run from the Taskbar.
Temperature Controller  An OMRON device.
Temporary Relay Area  An area of PLC memory containing instructions which can be loaded at a later point for use with other instructions.
Text  1. A file format supported by the CX-Server Import tool. The Text is also an export format of the CX-Server Import tool.
   2. A data format supported by CX-Server.
Timer area  An area of PLC memory containing program timers and their related completion flags.
Toolbus  A network, either C-Toolbus or CV-Toolbus, allowing communications with a device via the serial COM port of a personal computer (in a similar manner to SYSCMAC WAY). Data is transmitted along the network in binary format.
Tools  CX-Server is made up of four tools.
Transfer from PLC  The transfer of a program or data to a host (either a computer or a programming device) from a lower-level (or slave) device.
Transfer to PLC  The transfer of a program or data from a host (either a computer or a programming device) to a lower-level (or slave) device.
UDP  User Datagram Protocol.
Unit number  A number identifying an individual component of an OMRON PLC system configuration.
Units  A component of an OMRON PLC system configuration.
<table>
<thead>
<tr>
<th><strong>User Datagram Protocol</strong></th>
<th>Protocol which directs information across a network to port numbers rather than to IP addresses.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Word</strong></td>
<td>A 16 bit unit of data memory.</td>
</tr>
</tbody>
</table>
INDEX

A

About CX-Server · 1, 4, 87
Access
  Change PLC dialog · 15
  DDE Manager tool · 3, 45
  Import/Export tool · 3, 39
  Performance Monitor tool · 3, 49, 51
  PLC · 37
  Project editor · 10
Adding a Device · 14
Appendix A
  Network Availability · 53
Appendix B
  PLC Memory Areas · 61
Appendix C
  Toolbars and Keyboard Shortcuts · 85
Application · 87
Automatic versus Manual Updates · 47

B

Baud rate · 87
Bit · 87

C

Communications · 15
  Connection possibilities · 18
  Controller Link · 17, 28
  CS1-Series connection options · 27
  C-Series connection options · 25
  CV-series connection options · 26
  Data link tables · See Data Link tables
  DIP switches · 19
  Direct connection · 18
  End connections · 24, 25, 88
  Ethernet · 16, 29
  FinsGateway · 24
  FinsGateway CPU · 17
  Gateway connections · 17, 18
  Link adapters · 19
  Modem · 16, 89
  Network connections · 24, 25
  Network settings · 19
  Nodes · 24
  PLC · See PLC
  PLC serial network configuration · 20
  PROM Writer · 31
  Requirements · 2
  Routing tables · See Routing tables
  Serial connection · 18
  Supported communications · 15
  SYSMAC LINK · 17, 28
  SYSMAC NET · 17, 28
  SYSMAC WAY · 16
  SYSMAC WAY with Modem · 16
  Toolbus · 16
  Toolbus with Modem · 16
Controller Link
  Communications · 17, 28
  Network settings · 28
  Copying a Point Link · 46
  Customer support for CX-Server · 4

CX-Net Network Configuration tool
  Ping test · 90
CX-Server
  About · 1, 4, 87
  Customer support · 4
  Installation · 3
  Projects · See CX-Server project
  Starting · See Access
  System requirements · 2
CX-Server 1.5 Features · 2
CX-Server project · 7
  Access Project editor · 10
  Closing Project editor · 11
  Concepts · 7
  Creating a new CX-Server project · 40
  Device List dialog · 8
  Edit project dialog · 10
EDC-Server project · 10
EDC-Server project · 10
  Editing PLC project · 10
  Editing PLC list · 8
  Groups · 10
  Import files · 39
  Introduction · 7
  Opening an existing CX-Server project · 40
  PLC · See PLC
  Points · See points
  Project editor · 10
  Project editor, Access · 10
  Project editor, Close · 11
  Saving a CX-Server project · 40
  CX-Server Project Selection · 40
  CX-Server Software · 1

D

DDE · 45, 87, 88
  Automatic updates · 47
  Copying a point link · 46
  Defining a link · 45
  Defining update intervals · 48
  Establishing connection · 45
  Item · 46, 89
  Manual updates · 48
  Server · 45, 91
  Topic · 46
DDE Manager tool
  Access · 3, 45
  Automatic updates · 47
  Close · 45
  Copying a point link · 46
  Defining a link · 45
  Defining update intervals · 48
  Establishing connection · 45
  Introduction · 45
  Item · 46
  Manual updates · 48
  Server · 45
  Topic · 46
DDE Manager Tool · 45
  Defining a Link · 45
  DeviceNet · 25
  Devices · See PLC
  Differences between DeviceNet Network as FINS Network
  and other PLC Networks · 25
  DIP switches · 19
  DLL · 88
| E | Establishing DDE Links · 45  
|   | Ethernet  
|   | Communications · 16, 29  
|   | Network settings · 29  
| Export · 42  
|   | FinsServer files · 42  
|   | Tagged database files · 42  
| Text files · 42 |

| G | Glossary of Terms · 87 |

| H | Help · See Online help  
|   | Help and how to access it · 3  
|   | Help topics  
|   | Find · 3  
|   | Index · 3  
| Help Topics  
|   | Context sensitive help · 4 |

| I | Import · 40  
|   | CVSS files · 39, 40  
|   | CX-Server projects · 39  
|   | FinsServer files · 40, 41  
|   | LSS files · 40, 41  
| Projects · 39  
|   | Tagged database files · 40, 41  
| Text files · 40, 41  
| Import/Export tool  
|   | Access · 3, 39  
|   | Clearing the display · 39  
|   | Creating a new CX-Server project · 40  
|   | CVSS import · 39, 40  
|   | FinsServer export · 42  
|   | FinsServer import · 40, 41  
| Introduction · 39  
|   | LSS import · 40, 41  
| Opening an existing CX-Server project · 40  
| Printing the display · 40  
| Saving a CX-Server project · 40  
| Status bar · 39  
| Tagged database file export · 42  
| Tagged database file import · 40, 41  
| Text export · 42  
| Text import · 40, 41  
| User interface · 39  
| Import/Export Tool · 39  
| Index · 93  
| Installing CX-Server · 3  
| Introduction to CX-Server Projects · 7  
| IO Table component  
|   | Actual IO Table · 87  
|   | Registered IO Table · 90 |

| L | Link adapters · 19 |

| N | Network Availability · 53 |

| O | Online help · 1, 3 |

| P | Performance Monitor tool  
|   | Access · 3, 49, 51  
|   | Close · 49, 51  
|   | Introduction · 49  
|   | Taskbar setting · 49  
|   | User interface · 49  
| Performance Monitor Tool · 49  
| PLC · 7  
|   | Access · 37  
|   | Access Change PLC dialog · 15  
|   | Adding a PLC · 9, 14  
|   | Change PLC dialog · 16  
|   | Changing PLC settings · 16  
|   | Comment · 7  
|   | Connect to PLC · 37  
|   | Connection options · 7  
|   | Connection type · 7  
|   | Connection type options · 7  
|   | CS1-Series connection options · 27  
|   | C-Series connection options · 25  
|   | CV-Series connection options · 26  
|   | Deleting a PLC · 9  
|   | Device List dialog · 8  
|   | Device name · 7  
|   | Device setup · 15  
|   | Device type · 7, 16  
|   | Device type settings · 17  
|   | Editing CX-Server Project PLC list · 8  
|   | Network type · 16  
|   | Renaming a PLC · 10  
|   | Serial network configuration · 20  
| Settings · 15  
|   | PLC Memory Areas · 61  
| Points · 8  
|   | Adding a group · 12  
|   | Adding a point · 12  
|   | Adding multiple points · 13  
|   | Address · 8, 87  
|   | Command modifier · 12, 87  
|   | Comment · 8  
|   | Copy · 13  
|   | Cut · 13  
|   | Data location · 12, 87  
|   | Deleting a group · 13  
|   | Deleting a point · 13  
|   | Editing a point · 13  
|   | Elements · 12  
|   | Groups · 10, 88  
|   | Internal data types · 12, 13  
|   | Moving a group · 13 |
OMRON

PART 3: CX-Server Runtime
INDEX – CX-Server Runtime

Moving a point · 13
Name · 8
Paste · 13
PLC · 12
Preferences · 11
Properties · 13
Renaming a group · 12
Print
Import/Export tool · 40
Project
Access PLC · 37
Connect to PLC · 37
Projects · See CX-Server project. For non-CX-Server projects, refer to the user manual for the invoking application.
PROM Writer
Communications · 31

R

Racks · 90

S

Slots · 91
Special Data Types · 48
Starting CX-Server · See access
Status bar · 4
Import/Export tool · 39
Project editor · 11
Supported Import/Export Data · 39
Symbols · 91

SYSMAC LINK
Communications · 17, 28
Network settings · 28
SYSMAC NET
Communications · 17, 28
Network settings · 28
SYSMAC WAY
Communications · 16, 19
Modem communications · 16, 19
Network settings · 19
System requirements · 2

T

Technical Specification · 1
Toolbars and Keyboard Shortcuts · 85
Toolbus
Communications · 16, 20
Modem communications · 16
Network settings · 19

U

Units · 91

W

Words · 92